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Banana Boehouding Plus Interface

Is Banana Boekhouding Plus nieuw voor u? Geen probleem. Op deze pagina laten we u kort zien welke
elementen u op het hoofdscherm te zien krijgt en hoe deze werken.

Op het eerste gezicht lijkt Banana Boekhouding op Excel gebaseerd op tabellen. Het gebruik is heel
intuïtief en productief .  Maar u zult snel merken dat Banana boekhouding Plus zoveel meer doet.

▶ Video: De Interface van Banana Boekhouding Plus  (Engelstalig)
Tips en commando's voor snelle gegevensinvoer

1. De menubalk
De menubalk verandert afhankelijk van de applicatie die geopend is. Ieder menu heeft specifieke
commando's. De menuitems in boekhoudtoepassingen zijn Bestand, Bewerken, Gegevens,
Opmaak, Extra, Rapporten, Acties, Extensies, Venster, Help.

In het Help menu kunt u het Banana Boekhouding Plus abonnement beheren.

Waarschuwing: in het Mac operating systeem, bevindt de menubalk zich bovenaan aan de
rechterkant van het Apple logo (de appel).

Nieuw: In het Menu Venster vindt u verschillende commando's, waarmee u onder andere kunt:

https://www.banana.ch/nl/node/10754
https://www.banana.ch/nl/node/10754
https://www.banana.ch/en/node/11509
https://www.banana.ch/en/node/11509
https://www.banana.ch/en/node/11509
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De indeling van de gegevensvensters wijzigen (zij-aan-zij of trapsgewijs)
Verschillende instellingen kiezen met het Weergave commando:

Kies welke interface elementen weergegeven moeten worden om deze aan te passen aan
kleine schermen.
Kies het weergave thema.
Maak hetDOntwikkel menu zichtbaar.

2. De knoppenbalk
De knoppenbalk bevat iconen waarmee u de meest gebruikte commando's en dialogen kunt bereiken
Ga gewoon met de muis over een icoon en wacht een moment op de beschrijving van de betekenis.

Nieuw: Wanneer u meerdere bestanden geopend heeft kunt u nu makkelijk zien waarin u aan het
werk bent en naar een ander bestand gaan via de knoppenbalk.

3. Tekst invoergebied
Gewoonlijk wordt tekst direct in de cel ingevoerd. De ingevoerde tekst wordt ook getoond in het
tekstinvoergebied net onder de knoppenbalk, waar ook veranderingen kunnen worden gemaakt. 
Verschillende functies versnellen en automatiseren de invoer.

4. De tabellen
Ieder boekhoudbestand heeft diverse tabellen die verschillende boekhoud of applicatie inhoud tonen.
Sommige zijn altijd aanwezig en andere zijn optioneel. 
Ga van de ene naar de andere tabel door eenvoudig met de muis op de tabelnaam te
klikken.
Tabellen zien er anders uit afhankelijk van de gebruikte toepassing. Door met tabellen te werken
heeft u altijd gegevens die gesorteerd en gegroepeerd zijn op basis van de inhoud.

Er zijn hoofdtabellen (vast) en toegevoegde tabellen (die bij bepaalde verschijnen). Toegevoegde
tabellen (aangemaakt door de gebruiker) moeten worden bijgewerkt als er een verandering is of
gegevens toegevoegd worden. Dit doet u door op het icoontje rechts bovenaan de tabel te klikken 

Als een aanvulling op de verschillende beschikbare overzichten kunt u met Banana Boekhouding Plus
alles, in elke tabel, afdrukken wat u op het scherm ziet.
Voor meer informatie zie de pagina Afdrukken/Afdrukvoorbeelden.
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5. De weergaven
De weergaven zijn manieren om gegevens van dezelfde tabel te laten zien met specifieke kolommen.
Voor iedere tabel zijn er verschillende weergaven en deze zijn erg handig als u uw gegevens op
verschillende manieren wilt weergeven, zonder uw basisinstellingen te veranderen. Ga van de ene
naar de andere weergave door eenvoudig met de muis op de weergavenaam te klikken.
Weergaven staan onder de tabelnamen en kunnen aan persoonlijke wensen aangepast worden met
het commando Tabellen instellen. U kunt ook Nieuwe weergaven aanmaken.

6. Het Filter
Met de functie Rijen filteren, beschikbaar in het Advanced plan  van Banana Boekhouding Plus
kunt u direct naar eerder ingevoerde transacties zoeken en deze aanpassen. Samen met de functie
Rijen tijdelijk sorteren is dit een belangrijke innovatie voor het versnellen van de boekhouding.
Zie voor meer informatie pagina Rijen filteren en tijdelijk sorteren.

7. Contextuele hulp
In Banana Boekhouding Plus biedt context hulp u directe hulp met precies datgene waaraan u werkt.
Dit gebeurt op verschillende elkaar aanvullende manieren:

A - Het foutmelding venster dat het programma laat zien wanneer het een mogelijke fout
ontdekt:

Als u op OK klikt krijgt u iedere melding apart te zien.
Als u op Help klikt wordt u naar de pagina geleid die de foutmelding uitlegt met
mogelijke oplossingen.
Als u op Niet waarschuwen klikt worden alle foutmeldingen opgeslagen in het
Foutmeldingen venster.
 

B - Vraagteken symbool rechtsboven aan de tabel 
Een klik op het vraagteken brengt u naar onze documentatie pagina waar u uitgebreide
informatie kunt vinden over de tabel en alle ander programma functies.
 

C - Vraagteken symbool onderaan het Informatie of Berichten venster
Als u op dit symbool klikt wordt u naar de pagina geleid die de foutmelding uitlegt met
mogelijke oplossingen.
 
D - Help knop in dialoogvensters
Klikken op deze knop laat de online pagina met uitleg over het geopende dialoogvenster of de
foutmelding zien.

https://www.banana.ch/nl/advanced
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8. De kolommen
Kolommen zijn de verticale elementen van de tabellen. Iedere tabel heeft specifieke kolommen met
specifieke kolomkoppen. De manier waarop kolommen weergegeven worden - breedte, stijl, uitlijning,
tekst terugloop, etc. - kan worden ingesteld met de functies van Gegevens→Kolommen instellen.

Sommige kolommen bevatten gegevens die door de gebruiker ingevoerd zijn en andere worden door
het programma gebruikt en kunnen niet veranderd worden door de gebruiker (bijvoorbeeld de
kolommen van de rekeningkaarten).

U kunt nieuwe kolommen toevoegen met het Gegevens→Kolommen instellen maar de gegevens die
daarin gezet worden zullen niet door het programma verwerkt worden.

9. Zoeken en vervangen
De functie Zoeken en vervangen hoort bij het menu Gegevens en blijft zichtbaar totdat deze
gesloten wordt. De functie is erg handig voor het snel en makkelijk zoeken en aanpassen van teksten
in een tabel. De functie moet niet verward worden met het Hernoemen commando (alleen in het
Advanced plan), dat in plaats daarvan in het hele bestand de naam verandert van een rekening, BTW
code of andere elementen.

10. De informatievensters
Dit is een zone aan de onderkant van het scherm waar nuttige informatie weergegeven wordt,
gerelateerd aan de actieve tabel en cel waarin u zich bevindt. Deze zone is verdeeld in drie zeer
handige vensters die directe informatie verschaffen:

Het Infovenster laat de inhoud van de rij en de cel zien waarin u staat (bijvoorbeeld naam en
rekeningsaldo, BTW code en beschrijving van de gebruikte code).
Het Berichtenvenster laat de foutmeldingen zien.
Het Grafiekenvenster laat de grafiek van de inhoud van de cel of rij waarin u staat zien
(bijvoorbeeld als u op een rekening gaat staan verschijnt de grafiek van het verloop van de
rekeningsaldo).

Ga van de ene naar de andere venster door eenvoudig met de muis op de vensternaam te
klikken.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 66

Het Infovenster

Het Infovenster toont altijd informatie over de cel en de rij waarin u zich bevindt. Het biedt
bijvoorbeeld de namen en codes van de rekeningen die bij de verrichting betrokken zijn, de bedragen
en de resterende saldi. Wanneer er een fout is, toont het programma het verschil.

Door te klikken op het vraagteken symbool komt u op de pagina waar de fout wordt uitgelegd.

Het Berichtenvenster

Wanneer het programma fouten tegenkomt, verschijnt er een dialoogvenster om deze te melden:

Klik op de knop OK om iedere afzonderlijke melding te zien.
Door de optie Niet waarschuwen te activeren, worden alle foutmeldingen door het
programma opgeslagen in het Foutmeldingenvenster.
Informatie over de Help-knop is te vinden onder Contextuele hulp.

Het Berichtenvenster bevat een lijst van de fouten die gevonden en aangegeven zijn door het
programma.
Om de berichten te lezen klikt u op de tab Berichten.

Door vanuit het Berichtenvenster te dubbelklikken op de foutmelding, wordt u naar de rij
gebracht waar de fout optrad.

Als u op het vraagteken symbool  naast de foutmelding klikt, wordt u naar de online
documentatie geleid waar de fout wordt uitgelegd en mogelijke oplossingen worden gegeven.
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Het Grafiekenvenster

Door een rekening of een groep te selecteren is het mogelijk een grafiek te tonen in het
grafiekenvenster. Met de grafiek kunt u direct de ontwikkeling van uw situatie zichtbaar maken en
zelfs een vergelijking tussen uw budget en de werkelijke cijfers. U heeft direct zicht op een periode
zonder dat u alle bedragen heeft op te zoeken.
Met het Advanced plan van Banana Boekhouding Plus is het nu mogelijk grafieken te kopiëren, te
exporteren en af te drukken, en ook de gegevens, waarmee de grafiek is gemaakt, naar het klembord
te kopiëren. Meer informatie vindt u in de pagina over grafieken.

11. De statusbalk
De statusbalk is te vinden helemaal onderaan het Banana Boekhouding scherm en bevat de volgende
informatie:

rijnummer van de geselecteerde cel/regel
Als het Filter actief is wordt het aantal zichtbare rijen aangegeven.
Als meerdere cellen van het type bedrag of tijdsaanduiding zijn geselecteerd, wordt het
volgende weergegeven:

Aantal: Aantal geselecteerde cellen met getallen.
Som : Som van de waardes in de geselecteerde cellen.
In bovenstaande afbeelding zijn 3 numerieke cellen geselecteerd (1.500 + 1.500 + 1.800)
en dus is het totaal in de statusbalk 4.800 en het aantal 3. 

Zoom 
Om de weergavegrootte van de tabellen te vergroten of te verkleinen.

https://www.banana.ch/nl/advanced
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Om de lettergrootte van de menu's te veranderen gebruikt u de instellingen van het
operating systeem.
Zie ook Programma opties.
 



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 69

Snelle invoer

In Banana Boekhouding Plus kunt u verschillende handige functies gebruiken om de volgende
bewerkingen te versnellen en te automatiseren:

Invoeren en aanpassen van gegevens
Controleren op fouten

Dit zijn de meest gebruikte functies voor het snel invoeren van gegevens:

Kopiëren, Knippen en Plakken
Gebruik deze functies om gegevens te kopiëren, knippen of plakken van de ene naar de andere cel,
van de ene rij naar de andere, van de ene tabel naar een andere, van Excel naar Banana, etc. Zie de
functies in het menu Bewerken.

Tekst, rekeningen en bedragen automatisch aanvullen
Automatisch aanvullen maakt gegevensinvoer veel makkelijker en sneller. Zodra u de eerste
karakters intypt geeft het programma suggesties welke tekst er volgt gebaseerd op al bestaande
gegevens (rekeningen, BTW codes, data of teksten die u al ingevoerd heeft).
In het menu Extra → Programma Opties → Editor → Rijbeperking in Smart fill, kunt u het aantal
waardes dat gesuggereerd wordt beperken of de functie zelfs deactiveren.
U kunt een van de volgende toetsen gebruiken om de voorgestelde waarde te accepteren:

Enter, accepteer de keuze en ga naar de volgende bewerkbare cel, naar rechts of naar
beneden afhankelijk van de gekozen instellingen.
Ctrl+ pijltje naar beneden, accepteer de gekozen waarde en ga naar de cel eronder.
Tab, accepteer en ga naar de cel rechts.
Shift+Tab, accepteer en ga naar de cel links.
F6 (of Cmd+6 voor Mac) accepteer de tekst en voer het bijbehorende commando uit (zie uitleg
hierna).
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Belangrijk:

Om het automatisch aanvullen vanuit het vorige jaar uit te schakelen moet Smart fill met
transacties van vorig jaar worden gedeactiveerd vanuit het menu Bestand → Bestand en
boekhoudingseigenschappen → Opties.  

Sneltoetsen gebruiken bij invoer
U kunt uw gegevensinvoer versnellen met diverse sneltoetsen of door de punt '.' die verschillende
functies heeft afhankelijk van de kolom waarin u zich bevindt.

Dit zijn de meest voorkomende:

In een Datum kolom voert u met de punt de datum van vandaag in.
In een Tijd kolom voert u met de punt de huidige tijd in (bijvoorbeeld Time Sheet ).
F4 toets (of Cmd+4 op Apple computers): kopieert gegevens van de cel erboven.

U kunt de complete lijst met sneltoetsen vinden in het menu Help → Sneltoetsen.

Terugkerende transacties
Heeft u transacties die zich blijven herhalen of elke maand bijna hetzelfde zijn? U kunt ze opnemen in
de Terugkerende transacties tabel en automatisch oproepen in de transactietabel wanneer u ze
nodig heeft.

Zie hoe Terugkerende transacties ingevoerd worden.

Banktransacties inporteren
Voer automatisch gegevens in van bank, credit card, of PayPal transacties.

Zie alle beschikbare mogelijkheden.

Geïntegreerde rekenmachine
U kent makkelijk formules invoeren in niet beveiligde cellen en dan op Enter drukken. Het programma
voert de berekening uit en vult het eindresultaat in. Met deze functie kunt u snel berekeningen maken
bijvoorbeeld wanneer u een waarde van een papieren document overneemt of een percentage moet
berekenen. De geïntegreerde rekenmachine is te gebruiken in alle tabellen en in alle kolommen van
het type bedrag.

https://www.banana.ch/nl/time-sheet
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Opdracht uitvoeren (F6 toets)
Bij sommige kolommen kunnen bewerkingen uitgevoerd worden met het menu Bewerken →
Opdracht uitvoeren of met de bijbehorende toets (F6 of Cmd+6 op Apple computers) die
aangegeven wordt in het informatie venster. Met deze functie kunnen gegevens of rijen snel
ingevoerd worden zonder de inhoud opnieuw in te typen. Voorbeelden van bewerkingen:

Doc kolom: ophalen van terugkerende transacties of invoeren van het volgnummer.
Beschrijving kolom: ophalen van gelijksoortige rijgegevens.

Wrap textTekst terugloop
Wanneer de tekst voor een cel erg lang is kunt u met het commando Rijhoogte berekenen van het
menu Opmaak ervoor zorgen dat de tekst helemaal zichtbaar wordt doordat de hoogte van de rij
aangepast wordt. Voor meer informatie zie de pagina Menu Opmaak.
 

Dit zijn de functies die het meest gebruikt worden voor het controleren op
mogelijke fouten:

De kolom Saldo
Vanaf Banana Accounting Plus kunt u in de transactietabel de kolom Saldo activeren die
voortdurend het verschil tussen de debet- en creditrekeningen bijhoudt en meteen verschillen laat
zien.

Watch the Balance Column Video  (Engelstalig)
De Saldo kolom pagina

Boekhouding controleren en opnieuw berekenen
Het commando Boekhouding controleren en opnieuw berekenen van het menu Acties, controleert
alle transacties opnieuw en rapporteert direct fouten of verschillen.

Totalen tabel
De Totalen tabel geeft u een beknopt overzicht hoe het gaat met uw bedrijf omdat deze de totalen
van de hoofdgroepen laat zien en gebruikt kan worden om het saldo van de rekeningen te
controleren. Zie ook de pagina met uitleg over de Totalen tabel.

https://www.banana.ch/en/node/11369
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 Tijdelijk filter & rijen sorteren
Met deze dubbele functie kunt u rijen tijdelijk filteren en sorteren. Deze functie sorteert en filtert
tijdelijk tabelrijen zonder de inhoud of volgorde blijvend te veranderen. Dit zijn erg handige functies
om snel naar gegevens, zowel tekst als bedragen, te zoeken.
Zodra het sorteren of filteren is opgeheven gaan de tabelrijen terug in hun originele volgorde.
Meer informatie...
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Rijen filteren en tijdelijk sorteren

Met deze functies Rijen filteren en tijdelijk sorteren kunt u rijen filteren en sorteren zonder de
inhoud of volgorde blijvend te veranderen. Dit zijn erg handige functies om snel naar gegevens, zowel
tekst als bedragen, te zoeken.
Zodra het sorteren of filteren is opgeheven gaan de tabelrijen terug in hun originele volgorde.

Om blijvend te sorteren gebruikt u het commando menu Gegevens > Rijen sorteren .

Rijen filteren en tijdelijk sorteren zijn nieuwe functies. Geeft u alstublieft uw
feedback hoe we ze kunnen verbeteren.
Ze zijn alleen beschikbaar in het Advanced plan van Banana Boekhouding Plus .

De functie tijdelijk Sorteren
Met deze functie kunt u snel de inhoud van een tabel sorteren in de volgorde van de kolom waarin het
sorteren wordt gedaan:

Klik met de rechter muisknop op de kolomkop van de kolom die u wilt gebruiken als
sorteercriterium of klik op het pijltje in de kolomkop.
Kies oplopend of aflopend sorteren.

Voordelen

U kunt de weergegeven rijen sorteren, oplopend of aflopend, in de volgorde van de gekozen
kolom.
In tegenstelling tot Excel keert u terug naar de oorspronkelijke volgorde van de rijen,
 wanneer u de tijdelijk sorteervolgorde opheft, zonder dat u deze bewerking ongedaan
hoeft te maken.

Er verschijnt een pijltje in de kop van de kolom waarvan de gegevens gesorteerd worden.

http://www.banana.ch/doc/nl/node/2676
https://www.banana.ch/nl/advanced
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Let goed op

De functie rijen tijdelijk sorteren is verschillend van het commando rijen sorteren (van het
menu Gegevens):

De functie rijen tijdelijk sorteren is een weergave van een tijdelijke sortering van rijen ,
ontworpen om het bekijken en bewerken van eerder ingevoerde gegevens te versnellen; u kunt
eenvoudig de sortering opheffen om terug te gaan naar de originele rijenvolgorde. Deze functie
is alleen beschikbaar in het Advanced plan .
Het rijen sorteren commando verandert de rijenvolgorde van de tabel blijvend; dit kan alleen
ongedaan gemaakt worden met het commando Ongedaan maken. Dit sorteer commando is
beschikbaar in alle plannen.

De Filter functie
Met de rijen filteren functie kunt u rijen laten weergeven die het sleutelwoord bevatten dat als
zoekcriterium is ingevoerd. Hiermee kunt u aanzienlijk tijd besparen om de volgende redenen:

U kunt de transacties die u zocht in no-time vinden.
U kunt de gefilterde transacties meteen aanpassen.
Het tijdelijke filter is aanwezig in alle tabellen (Rekening, Transacties, Wisselkoersen...) en om
het te gebruiken hoeft u alleen meer uw zoektermen in het filterveld te typen.
U kunt het filter eenvoudig opheffen om terug te gaan naar de oorspronkelijke rijenweergave.

De groen weergegeven tekst is alleen voor uitleg; deze wordt niet in de software gebruikt.

Filter functies en syntax

Met het filter kunt u eenvoudig rijen vinden door tekst gescheiden door spaties in te voeren. Terwijl u
de tekst invoert filtert het programma alle transacties en laat alleen degene zien die de
gespecificeerde, door spaties gescheiden, tekst bevatten.

mario invoice 
Laat de rijen zien die ergens de woorden "mario" en  "invoice" bevatten.
mar inv
Dit levert rijen op met "mario" en "invoice", maar ook met "inverter". Afhankelijk van het aantal
rijen dat u heeft kunt u hetzelfde resultaat krijgen door alleen de afgekorte tekst in te voeren. 
"mario invoice" 
Zoekt naar tekst waarin spaties staan; als u tekst met aanhalingstekens invoert beschouwt het
programma de aangehaalde tekst als een enkel woord. 
"!~Mario"
Normaal is zoeken niet hoofdlettergevoelig.

http://www.banana.ch/nl/advanced
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U kunt aangeven dat het zoeken hoofdlettergevoelig moet zijn met een speciaal commando.

Spatie is een scheidingsteken in de filtertekst.
Gebruik geen spaties in de zoektekst tenzij ze tussen aanhalingstekens staan zoals in
"mario invoice".

Speciale karakters

U kunt bijna elk karakter gebruiken bij het filteren.
Alleen het uitroepteken "!" en het vertikale streepje "|" aan het begin van een tekst heeft een
speciale betekenis.

"|" specificeert OF 
Tenminste één van de elementen die voorafgegaan worden door "|" moeten aanwezig zijn in de
rij.
In het volgende geval laat het filter de rijen zien die "mario" en "invoice" of "fee" bevatten.
mario |invoice |fee
"!" commando.
Iedere tekst voorafgegaan door het uitroepteken wordt beschouwd als een commando en heeft
een speciale betekenins. 
Bijvoorbeeld, om een tekst uit te sluiten gebruikt u het commando "!-", zoals in mario !-
invoice.

Geavanceerde filter commando's

De beschrijving van geavanceerde commando's is alleen in het Engels beschikbaar.
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Menu Bestand

Banana Boekhouding slaat iedere boekhouding in een apart bestand op.
Banana boekhoudbestanden zijn compatibel met versies van alle operating systemen en met
synchronisatie systemen.

Nieuw...
Open...
Sluiten / Alles sluiten
Bestands- en boekhoudingseigenschappen...
Opslaan / Opslaan als... / Alles opslaan
Pdf bestand aanmaken...
Bestand exporteren
Pagina-instelling...
Logo-instelling
Afdrukken/Afdrukvoorbeeld
Pdf aanmaken...
Bestand via e-mail verzenden...
Bestandslocatie openen
Laatst gebruikte bestanden / Favoriete bestanden

Sluiten / Alles sluiten

Met deze commando's sluit u het actieve bestand of alle openstaande bestanden van Banana
Boekhouding.

Pdf bestand aanmaken...

Om alles wat u op het scherm ziet af te drukken als Pdf. Alle boekhoudgegevens kunnen worden
meegenomen. Pdf bestand aanmaken... is een ander commando waarmee u kunt kiezen welke inhoud
van het Banana Boekhoudbestand in de Pdf wordt opgenomen.

Bestand via e-mail verzenden...

Met dit commando opent Banana Boekhouding het e-mail programma op uw computer en maakt een
nieuw bericht aan met uw Banana Boekhouding bestand als bijlage.

https://www.banana.ch/doc10/nl/node/3896#close
http://www.banana.ch/doc/nl/node/3909#salva_file
http://www.banana.ch/doc/nl/node/3904
https://www.banana.ch/doc10/nl/node/3896#crea_pdf
https://www.banana.ch/doc10/nl/node/3896#send mail
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Nieuw bestand aanmaken

Om een nieuw bestand aan te maken gaat u naar het menu Bestand en klikt u op het commando
Nieuw.

Dit commando opent een venster voor het aanmaken van een nieuw bestand. Vanuit dit ene venster
heeft u toegang tot alle beschikbare modellen. We raden u aan te beginnen met een bestaand model
en dat aan te passen met uw gegevens. Met dit venster kunt u op drie verschillende manieren een
nieuw bestand aanmaken:

Een bestaand model gebruiken1.
Gegevens van een bestaand bestand kopiëren2.
Een nieuw leeg bestand gebruiken3.

Begin met één van onze modellen
Dit genereert een nieuw bestand gebaseerd op een van de bestaande modellen. Er is een veelvoud
aan modellen beschikbaar, geschikt voor elke organisatievorm en bedrijf.

Menu Bestand, → Nieuw
Kies uw land/taal
Kies uw categorie
Kies uw Boekhoudmodel
Kies uit de lijst met modellen die verschijnt het model dat het beste voldoet aan uw behoefte.
Als u op het bestand klikt, wordt het automatisch geopend en kan het worden opgeslagen met
een naam.

Alle bestanden met de BTW optie hebben BTW tabellen aangepast aan de nieuwste percentages.
U kunt het rekeningschema aanpassen aan uw wensen (verander beschrijvingen van rekeningen,
verwijder (sub)groepen of voeg deze toe, etc.).

U kunt naar een model zoeken door een zoekterm in het Filteren op vak in te voeren.
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Sla het bestand met een naam op

Wanneer u het model heeft geopend met Banana Boekhouding moet u het commando Opslaan als
van het menu Bestand gebruiken om het op te slaan.

Kies de doelmap
Het kan handig zijn om een aparte map voor ieder jaar aan te maken zodat u andere
documenten die op dat jaar betrekking hebben erin kunt opslaan.
Gebruik een bestandsnaam waarin de bedrijfsnaam voorkomt en het boekjaar (bijvoorbeeld
smit_bedrijf_2020).
De software voegt de .ac2 extensie toe die wordt gebruikt voor Banana Boekhouding
bestanden.

Een model aanpassen

Pas de bestandseigenschappen aan1.
Kopteksten en boekhoudperiode
Adres

Pas uw rekeningschema aan2.
Voer uw bankrekeningen in.
Voer rekeningen in of pas ze aan zodat deze aan uw eisen voldoen.
Terwijl u aan het werk bent kunt u nog steeds rekeningen toevoegen of aanpassen als u
daar behoefte aan heeft.

Beginnen met een Tutorial
Begin met het gebruik van bestaande sjablonen, die al voorbeeldboekhoudgegevens bevatten. Niet
voor alle modellen is een zelfstudie beschikbaar.

De zelfstudiebestanden zijn handig om te begrijpen hoe de boekhouding binnen een bepaalde
sjabloon moet worden gestructureerd. De ingevoerde voorbeeldgegevens zijn alleen voor
demonstratiedoeleinden en kunnen op elk moment worden gewijzigd, verwijderd of vervangen door
uw eigen gegevens.

Als je een sjabloon selecteert met een zelfstudiebestand, verschijnt automatisch de knop Aanmaken
vanuit tutorial naast de beschrijving van de sjabloon.
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Begin met een beschikbaar bestand
Beginnen met een bestand dat al bestaat zonder dit te veranderen.

Er zijn meerdere mogelijkheden om gegevens te kopiëren:

Open het bestand dat uw model moet zijn door op de Bladeren knop te klikken en geef aan
waar het bestand te vinden is.
Maak een kopie van het geopende bestand met het commando Bestand → Opslaan als
command.
Anders, kunt u een kopie van het geopende bestand maken met het commando Extra → Copie
bestand creëren.... Kies in het dialoogvenster welke gegevens u wilt behouden. Als geen va
de drie opties worden geactiveerd, wordt een bestand aangemaakt met alleen het
rekekningschema.

Sla het bestandop in de folder waar u de gegevens wilt bewaren (normaliter in de
documentenmap). Voer de naam van het bedrijf en het boekjaar in als bestandsnaam,
bijvoorbeeld smit_bedrijf_2020.
Als u een bestaand boekhoudbestand overneemt moet u ook de beginsaldi invoeren in de
kolom Opening.
Als u werkt in een vreemde valuta bestand moet u de Openingswisselkoers bijwerken.

Beginnen met een nieuw leeg bestand
U begint met niets, dus u moet de basis boekhoudgegevens opzetten en het hele rekeningschema.
(niet aanbevolen).
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Menu Bestand, → Nieuw
Kies uw land/taal
Kies uw categorie
Kies uw Boekhoudmodel
Onderaan de lijst klik op Nieuw leeg
Stel de parameters nieuw bestand in.

Bestands- en boekhoudingseigenschappen instellen
Sla op met een bestandsnaam.
Maak de structuur van het rekeningschema aan.

Verwante documenten

Inkomsten en uitgaven boekhouding en Cash Manager
Dubbel boekhouden
Dubbel boekhouden met vreemde valuta
Hulpprogramma's
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Overgaan op een nieuw jaar
Bij het overgaan op een nieuw jaar moet er een specifieke procedure gevolgd worden om een
bestand voor het nieuwe jaar aan te maken en automatisch de beginsaldi over te hevelen..

Instellingen nieuw bestand
Als het programma een bestand met nieuwe eigenschappen aanmaakt moet u de parameters nieuw
bestand instellen.
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Parameters nieuw bestand

Taal
De taal die gebruikt wordt voor de kopteksten van de kolommen van de tabellen.

Decimaalpunten voor bedragen
Om eventuele boekhoudverschillen te vermijden, wordt voor elk bestand het aantal decimaalpunten
voor bedragen vastgesteld. Gewoonlijk worden 2 decimaalpunten gebruikt, maar er zijn valuta's waar
decimaalpunten niet gebruikt worden; in dat geval moet het getal "0" gebruikt worden.

Voor andere valuta die meerdere decimaalpunten gebruiken zoals de Tunesische Dinar of crypto
valuta zoals Bitcoin (9 decimale plaatsen) of Ethereum (18 decimale plaatsen) moet het gerelateerde
aantal worden aangegeven.
Banana Boekhouding kan bedragen tot 27 decimale plaatsen verwerken.

Decimaalpunten voor bedragen in vreemde valuta
Wanneer een boekhouding met meerdere valuta's gebruikt wordt, is het nodig ook het aantal
decimaalpunten voor de bedragen in vreemde valuta vast te stellen. Bijvoorbeeld, als de boekhouding
in EUR is en u beheert crypto valuta zoals Ethereum moet u 18 instellen.
In het algemeen moet het aantal decimalen niet kleiner zijn dan het aantal decimalen in de basis
valuta.

Soort afronding
Afronding wordt toegepast op bedragen met een groter aantal decimalen dan het ingestelde aantal.
Als 2 decimalen ingesteld zijn wordt dit type gebruikt om af te ronden:
Afhankelijk van de gebruikte methode worden de volgende bedragen 1.005; 1,015; 1,025; 1,035
verschillend afgerond:

Commercieel (half naar boven) wordt afgerond naar de eerstvolgende hogere eenheid (101
/ 102 / 103 / 104). Meestal wordt deze methode gebruikt in de boekhouding.
Banken (half naar even) wordt afgerond naar de dichtstbijzijnde even waarde (100 / 102 /
102 / 104).
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Adresvelden in de tabel Rekeningen
Indien deze optie geactiveerd wordt, wordt de weergave Adressen gecreëerd in de tabel
Rekeningen. Hierin kan men de adressen van klanten, leveranciers en leden invoeren.

Budget Tabel
Als deze optie actief is wordt een Budget tabel aangemaakt waarin de gebruiker zijn budget
transacties kan invoeren.

De gebruiker kan op deze manier diverse boekhoudbestanden aanmaken, in verschillende talen, en
met verschillende decimaalpunten. Om de taal of de decimaalpunten te wijzigen nà het aanmaken
van het boekhoudbestand, moet het boekhoudbestand geconverteerd worden met het commando
Naar nieuw bestand converteren in het menu Extra.
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Boekhouding in meerdere talen

Met Banana Boekhouding kunt u een boekhouding aanmaken met verschillende talen en de balans en
de winst- en verliesrekening presenteren in de taal van uw keuze.

De beschikbare talen zijn: Nederlands, Italiaans, Duits, Frans, Engels, Spaans, Portugees, Chinees.

De verschillende talen
De taal van het programma.
De taal die gebruikt wordt voor de interface, de dialoogvensters, etc.
U kunt de taal veranderen in menu Extra → Programma opties.
(Zie in de afbeelding hierboven de rode kaders 1 en 3)
Documentatie in verschillende talen.
U heeft complete documentatie in verschillende talen die makkelijk te openen is door op de
knop voor help te klikken.
Taal van het boekhoudbestand. Wanneer u een boekhoudbestand aanmaakt worden de
kolommen ingesteld in de aanmaak taal. (Zie in de afbeelding hierboven het rode kader 2)
De taal van de kolom- en tabelkop.
U kunt deze naar eigen inzicht veranderen. Bijvoorbeeld, in plaats van de term BTW kunt u de
afkorting gebruiken die het beste past bij de voorschriften van uw land.
De inhoud in elke taal.
In de cellen kunt u teksten in elke taal invoeren.
Extra kolommen voor andere talen.
U kunt kolommen toevoegen om de balans en de winst & verliesrekening in andere talen te
presenteren. U kunt kolommen aanmaken voor andere talen de transactietabel en ook in alle
andere tabellen.
Weergave in verschillende talen.
Schakel snel tussen de verschillende talen en druk af in de gewenste taal.
Balans en winst & verliesrekening in verschillende talen.
U kunt de afdruk aanpassen en eenvoudig kiezen welke kolommen u in de eindrapporten wilt
laten zien.

De taal van het bestand veranderen

Iedere boekhouding in Banana Boekhouding Plus is een apart bestand. De taal van het bestand is
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gescheiden van die van het programma en wordt ingesteld als het bestand wordt aangemaakt. (menu
Bestand → Nieuw).

Kolomnamen en koppen worden toegekend op het moment dat het bestand wordt aangemaakt, de
aanmaak taal wordt dan gebruikt.

Om de taal van het bestand en de kolommen te veranderen moet u het bestand opnieuw aanmaken:

Gebruik het commando menu Extra → Naar nieuw bestand converteren
Kies in het geopende dialoogvenster voor een bestandstype gelijkwaardig aan dat van uw
bestaande bestand en klik op OK
Kies in het volgende venster de nieuwe taal van het bestand en het afrondingstype en klik op
OK

Het program maakt een nieuw bestand aan identiek aan uw vorige bestand, met de nieuwe
taalinstellingen. Dit nieuwe bestand moet opgeslagen worden met een nieuwe naam.

De huidige taal van het bestand veranderen
De huidige taal wordt door het programma gebruikt om teksten zoals "Beginsaldo in de
rekeningkaart" te tonen.
Normaliter is dit hetzelfde als de aanmaak taal maar kan veranderd worden in
Bestandseigenschappen → tabblad Andere.

De kolomkoppen veranderen
U kunt de kolomkoppen veranderen met menu Gegevens → Kolommen instellen.

Kolommen toevoegen voor andere talen
In de rekeningentabel en ook in de andere tabellen (Transacties, BTW codes), kunt u extra kolommen
toevoegen waarbij u de beschrijving in andere talen kunt invoeren.

Commando menu Gegevens → Tabellen instellen → Kolommen instellen... → Toevoegen
Gebruik de naam van de taal als de naam van de kolom (bijvoorbeeld Duits, Chinees, etc.).
Vul in de nieuw aangemaakte kolom in iedere rij de beschrijving in de taal die toegevoegd
wordt.
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Weergaven aanmaken voor iedere taal
Maak een aparte weergave aan voor iedere taal om afdrukken te kunnen maken met alleen de
gewenste taal

menu Gegevens → Tabellen instellen commando
Maak een weergave aan voor iedere taal.
In iedere tabel kunt u verschillende weergaven hebben voor verschillende talen, of weergaven
die kolommen hebben voor verschillende talen.
Pas uw afdruk aan in de taal die u nodig heeft. Als u in verschillende talen wilt afdrukken kunt u
een Aanpassing aanmaken zodat u niet steeds opnieuw de instellingen hoeft te veranderen
maar deze al klaar heeft staan.

Uitgebreide balans op groepen voor iedere taal
Als u eenmaal de taalkolom aan de rekeningentabel heeft toegevoegd kunt u deze ook laten
weergeven het Uitgebreide balans op groepen overzicht.

Open de Uitgebreide balans op groepen.
Kies de aanpassing waarmee u wilt afdrukken.
Maak in de sectie compositie een nieuwe compositie aan voor uw taal met het commando
dupliceren.
Geef de compositie de naam van de taal.
Ga naar de kolommen sectie.

Knop geavanceerd voor de kolommen van de balans.
Voeg kolommen toe.
In de rekeningentabel.

Maak de kolom van de taal waar u in geïnteresseerd bent zichtbaar.
Verberg de kolom Beschrijving van de standaard taal.

Herhaal deze bewerking ook voor de kolommen van Winst en Verlies.
Wanneer u de volgende keer de uitgebreide balans op groepen opent is uw taal al ingesteld.
Voer de aanpassing in het menu Favorieten in.
Zo kunt u uw overzicht sneller bereiken.

De standaard teksten van het overzicht (datum, etc.) worden weergegeven in de huidige taal van de
boekhouding. Het kan nodig zijn de huidige taal zo nu en dan te veranderen..

Extensies

Als u specifieke wensen heeft in verschillende talen kunnen deze worden geprogrammeerd als
Extensies (Engelstalig).
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Een bestand openen en opslaan

Een bestand openen
Gegevens worden van een opslagmedium (bijvoorbeeld een harde schijf) in het geheugen geladen
waar ze kunnen worden verwerkt.

Boekhoudbestanden kunnen worden geopend in Banana Boekhouding als ze op een lokale
computer staan of als ze bereikbaar zijn via een netwerk.
Als u ze per email ontvangt moet u ze eerst in een map op uw computer zetten voordat u ze
opent.
Een bestand kan maar door één gebruiker tegelijk bewerkt worden.
Als u een beveiligd bestand bewerkt of een bestand dat al door andere gebruikers in gebruik is,
moet u uw veranderingen opslaan in een bestand met een andere naam.
Het Banana Boekhoud programma waarschuwt u dat u een alleen-lezen bestand hebt geopend
in de volgende gevallen:

het bestand staat op een niet-herschrijfbare schijf (CD-ROM)
het bestand staat in een tijdelijke alleen-lezen map
het bestand is beveiligd of de gebruiker heeft geen rechten om het te veranderen
het bestand is al door een andere gebruiker geopend
het bestand is al door dezelfde gebruiker geopend in een andere sessie.

.ac2 Bestanden terugvinden

Als u zich niet kunt herinneren in welke map uw boekhoudbestanden staan, kunt u de Windows
Explorer of de Mac finder zoekfuncties gebruiken.

Uw boekhoudbestand vinden op een Windows computer

Banana Boekhoudbestanden hebben een .ac2 of een .sba extensie. De manier van zoeken verschilt
per Windows versie.

Windows 10: klik op het zoek icoon in de Taakbalk en voer "ac2" of "sba" of de naam van uw
bestand in en klik op Documenten.
Vanuit Windows Explorer voer in het zoekveld "*.ac2" of "*.sba" in of de naam van uw bestand
en laat Windows ernaar zoeken.
Als u in Banana Boekhouding bezig bent, klik op Bestand → Open,  voer in het zoekveld
rechtsboven "*.ac2" of "*.sba" in en selecteer het in de hele PC zoeken icoon, als dit
aanwezig is, of de map waar u wilt dat Windows naar uw bestand zoekt.

Uw boekhoudbestand vinden op een Mac computer

Voer in Banana Boekhouding in Bestand → Open, in het zoekveld rechtsboven "*.ac2" of
"*.sba" in of een deel van de naam. Selecteer met de icoontjes waar u wilt zoeken naar uw
bestand (in de hele computer of in geselecteerde mappen).
Open de Finder en voer "ac2" of "sba", of een woord dat de bestandsnaam voorkomt, in het
zoekveld in de rechterbovenhoek in.
Klik met de rechtermuisknop op het Finder icoon, klik daarna op Zoeken en voer "ac2" of
"sba", of een woord dat de bestandsnaam voorkomt, in.
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Een bestand opslaan
Met het Opslaan of het Opslaan als... commando worden de gegevens opgeslagen op een
opslagmedium, bijvoorbeeld een harde schijf. Bestaande gegevens worden vervangen door nieuwe
gegevens.

Een enkel bestand kan worden opgeslagen door één gebruiker tegelijk
Het bestand kan worden opgeslagen door de gebruiker als het niet tegelijk door andere
gebruikers gebruikt wordt
Bestanden kunnen overal opgeslagen worden.
U kunt de bestandsnaam en doelmap invoeren als u het bestand voor de eerste keer opslaat of
met het Opslaan als commando van het menu Bestand. Als eerste mogelijkheid stelt Banana
Boekhouding de Documenten map voor als doelmap voor de .ac2 bestanden, maar dit kan
veranderd worden met de Bladeren knop.
We raden aan om aparte mappen te maken  voor ieder bedrijf en voor ieder boekhoudjaar
wanneer u meerdere boekhoudingen beheert.
Ieder bestand kan worden beveiligd met een wachtwoord.

Automatisch opslaan
Banana Boekhouding slaat uw werk automatisch op in een tijdelijk bestand waarvan de naam eindigt
op ".autosave". Wanneer u een bestand opslaat of het programma beëindigt wordt dit bestand
verwijderd. Als uw computer uitvalt of uitgeschakeld wordt terwijl u aan het werk bent kunnen uw
gegevens hersteld worden door dit bestand te openen.

Als het programma opnieuw wordt geopend na een storing controleert het of het autosave bestand
niet is verwijderd en vraagt met de melding Autosave file herstellen of u dit bestand wilt openen.

In de Programmaopties van het menu Extra kan ingesteld worden hoe vaak Banana Boekhouding dit
automatisch opslaan moet uitvoeren.

Boekhoudbestanden (*.ac2)
Bestanden die aangemaakt worden met Banana Boekhouding hebben een .ac2 of .sba extensie,
ongeacht het besturingssysteem dat gebruikt wordt.
Het .ac2 formaat is specifiek voor Banana. Bij het opslaan worden de gegevens gecomprimeerd
en als één geheel opgeslagen.
Ac2 bestanden kunnen op verschillende besturingssystemen (Windows, Mac and Linux) gebruikt
worden.
U kunt een bestand in Windows opslaan, het daarna openen en bewerken op een Mac en het
daarna opnieuw openen op een Linux of Windows computer.
Ieder bestand kan als een email bijlage verstuurd worden, op een ander besturingssysteem
bewerkt worden en daarna teruggestuurd worden naar de afzender.
Boekhoudbestanden zijn helemaal gescheiden van de Banana software, die een .exe extensie
heeft onder Windows.
Installatie-bestanden hebben een .dmg extensie voor Mac en een deb, .rmp, .run of .tgz
extension onder Linux.
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Kopiëren en verplaatsen van boekhoudbestanden
Banana kan uw bestanden opslaan op elke schijfeenheid die gezien wordt door het operating systeem
als een herschrijfbare schijf.
Vanaf niet-herschrijfbare schijven (CDs of DVDs) kan Banana Boekhouding bestanden alleen lezen.

.ac2 bestanden kunnen verplaatst worden:

van de ene map naar een andere:

gebruik Windows Explorer of Mac Finder om de map te bepalen waar uw bestanden staan
kopieer en plak ze in de nieuwe doelmap (als ze eenmaal gekopieerd zijn kunt u ze, indien
nodig, verwijderen uit de oorspronkelijke map)

van de ene naar de andere computer

Door de bestanden op een geheugenstick op te slaan en vanaf deze stick op de nieuwe
computer:

Open het bestand dat verplaatst moet worden
Vanuit menu Bestand → Opslaan als en kies de geheugenstick als doelmap
Deze kopie kan ook gemaakt worden door met Windows Explorer het boekhoudbestand
naar de geheugenstick te slepen

Door ze als e-mailbijlage op te sturen en ze op te slaan op de nieuwe computer

Boekhoudbestanden verwijderen of hernoemen
Banana Boekhouding heeft geen functie voor het verwijderen of hernoemen van bestanden. Hiervoor
moet u de betreffende functie van het besturingssysteem gebruiken (Windows Explorer of Finder op
een Mac).

Dropbox, Google Drive and andere synchronizatie systemen
Banana Boekhouding werkt met systemen zoals Dropbox en Google Drive die bestanden
gesynchroniseerd houden met cloud opslagdiensten.
Banana Boekhouding overschrijft *.ac2 bestanden en verwijdert de *.ac2.bak bestanden. In de lijst
verwijderde bestanden vindt u alle vorige versies van *.ac2.bak bestanden.

Veranderingen bekijken

Banana Boekhouding voor Android werkt direct met Dropbox servers. Wanneer u veranderingen op
uw PC maakt moet u doorgaans een paar seconden wachten voordat u de veranderingen op de server
ziet en dus ook in het Banana Boekhouding bestand.

Om er zeker van te zijn dat het bestand goed is gesynchroniseerd met de server moet het bestand op
uw PC gemarkeerd zijn met het groene vinkje.
Als u de sync symbolen niet ziet (groen, rood, blauw) dan moet u de Dropbox applicatie op uw PC
bijwerken.

Een andere manier om de synchronisatie status op uw PC te controleren is te klikken op het Dropbox
icoon in de Windows Tray.
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Bovendien gebeurt synchronisatie in de Android app niet terwijl u er in aan het werk bent. U moet
deze sluiten en heropenen.

Let op:
Banana Boekhouding kan niet zien dat een bestand tegelijk op meer dan een computer wordt
geopend. Het kan dan gebeuren dat iemand gegevens verwijderd of dat iemand anders nieuwe
gegevens toevoegt. Alleen de meest recente kopie van het opgeslagen bestand wordt bewaard.
Daarom raden we sterk af om met meerdere mensen op dezelfde tijd aan hetzelfde bestand te
werken.

Gerelateerde informatie:

Bestandslocatie openen
Kopiebestand creëren
Veiligheidskopieën  (backups)
Autosave file herstellen
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Wachtwoord invoeren

Wanneer de gebruiker een met een wachtwoord beveiligd bestand opent, verschijnt er een
dialoogvenster om het wachtwoord in te voeren. Dit dialoogvenster wordt ook weergegeven bij de
eerste uitvoering van sommige opdrachten, waarvoor toegang tot een met een wachtwoord beveiligd
bestand vereist is, zoals de boekhouding van het voorgaande jaar.
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Gegevens backup

Veiligheidskopieën (backups)
Met Banana Accounting kunt u het medium en de map kiezen waar u uw boekhoudbestanden wilt
opslaan.  U kunt uw bestanden organiseren op uw lokale computer, de netwerkcomputer of de cloud

. Het omvat geen back-upbeheersysteem.

We raden u aan om externe backup kopieën te maken om gegevensverlies te voorkomen door
bijvoorbeeld een computerstoring, een kapotte harde schijf of andere oorzaken.

Gebruik voor Mac de "Time machine" functie.
Gebruikt voor Windows de "Bestandsgeschiedenis" functie.
Dropbox, OneDrive, iCloud, Google Drive bieden de mogelijkheid om eerdere versies van je
bestanden te bewaren.

Er zijn ook andere programma's op de markt waarmee u automatische backupkopieën van uw
gegevens kunt maken.

.bak bestanden
Als het opslaan van de het bestand goed gegaan is vervangt Banana Boekhouding de inhoud van het
huidige bestand door de meest recente boekhoudgegevens.

De gegevens worden opgeslagen in een tijdelijk bestand.
De gegevens opgeslagen op de schijf worden vervangen door de eerder bestaande gegevens,
alleen als de opslagbewerking correct is voltooid.
De Reservekopie aanmaken (.bak) optie van het menu Extra → Programma Opties →
Bestandsbeheer tabblad, is standaard actief en zorgt ervoor dat het bestaande bestand wordt
hernoemd naar een bestand met dezelfde naam met extensie ".bak".
Er wordt een nieuw bestand aangemaakt met de naam "file name.ac2.bak" dat de oude
gegevens bevat van voordat het opgeslagen wordt.

Als een bestand beschadigd is kunt u de vorige versie herstellen door het .bak bestand te openen,
door het te verslepen naar Banana Boekhouding of door het commando menu Bestand → Open te
gebruiken.

Gegevens herstellen vanuit een *.bak bestand

Wanneer u om een of andere reden uw boekhoudbestand niet kunt vinden kunt u het herstellen van
de backup kopie die het programma automatisch aanmaakt.

Ga als volgt te werk:

Open de map waar het boekhoudbestand is opgeslagen.
Open het bestand met de extensie .bak, als het niet zichtbaar is in de map kies dan voor
"Bestandsnaam" Alle bestanden (*.*) in het uitklapmenu.
Als het bestand is geopend sla het dan op als een .ac2 bestand. Meestal wordt dezelfde naam
gegeven als die van het verloren bestand.

https://www.banana.ch/nl/node/11059
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Automatisch opslaan
Banana Boekhouding maakt automatisch een tijdelijk bestand aan en slaat het werk daarin op.
Wanneer u opslaat of het programma op een normale manier verlaat wordt dit tijdelijke bestand
verwijderd. Als echter de computer plotseling dienst weigert kunnen de gegevens worden hersteld
door dit bestand te gebruiken.

Beschadigde .ac2 bestanden
Computer hebben soms technische problemen of worden geïnfecteerd door visussen. Soms komen
documenten die per e-mail verstuurd zijn beschadigd aan. Het is daarom altijd verstandig backup
kopieën te hebben.
In het geval dat uw bestanden zijn beschadigd door technische problemen kan onze Support
verifiëren, tegen een vergoeding  (Engelstalig), of de gegevens kunnen worden hersteld.

https://www.banana.ch/nl/support
https://www.banana.ch/en/prices
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Autosave file herstellen

Dit venster verschijnt als het programma onverwacht is afgesloten en het niet mogelijk was de
veranderingen in het bestand op te slaan.
Wanneer het programma opnieuw geopend wordt ontdekt het dat het autosave bestand (tijdelijk
bestand) niet verwijderd is en vraagt het of u het bestand wilt herstellen.

U kunt kiezen uit de volgende opties.

Herstel
Het autosave bestand wordt gekopieerd en vervangt het originele bestand
Het originele bestand wordt hernoemd zoals wordt aangegeven in het dialoogvenster

Niet herstellen
Het programma verwijdert het autosave bestand.
Het programma opent het originele bestand.

Negeren
Het programma behoudt het autosave bestand en opent geen enkel ander bestand.
Als u de volgende keer dit bestand opent waarschuwt het programma dat een autosave
bestand met niet opgeslagen veranderingen is gevonden.

Wanneer het programma stopt met werken
Als het programma normaal wordt afgesloten vraagt het om de veranderde gegevens op te slaan en
wordt het autosave bestand verwijderd.

Echter, het programma kan onverwacht afgesloten worden om een aantal redenen:

Een stroomuitval of een andere gebeurtenis veroorzaakte een vastloper van het
besturingssysteem
Een probleem dat leidde tot een crash van het programma

Als gevolg van ander programma of een toestand van het operating systeem of
stuurprogramma dat er voor zorgde dat het programma stopte.
Probeer uw computer te herstarten en gebruik het programma zonder andere
programma's.

Een fout in het besturingssysteem of een foutief programma kan voor een
onderbreking van Banana zorgen

Probleem in sommige Dell computers.
Een computer fout (geheugenfout)
Een virus of een ander probleem

Een probleem in de Banana Boekhouding software
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Dit is het geval als herhaling van hetzelfde commando de crash veroorzaakt
Als het programma stopt in heel verschillende omstandigheden dan is het waarschijnlijk
dat het probleem veroorzaakt wordt door computer of besturingssysteem problemen (zie
hierboven)

U moet eerst ervoor zorgen dat u de laatste versie van het programma heeft
Installeer updates indien nodig. Het probleem zou intussen in updates opgelost
kunnen zijn.

Contact met technische ondersteuning
Bepaal in welke situatie het programma stopt.

Het is belangrijk te begrijpen onder welke omstandigheden het programma stopt zodat technici
het probleem kunnen reproduceren.
Als u contact opneem met technische ondersteuning

Beschrijf het probleem en hoe het gereproduceerd kan worden - beschrijf de fout.
Voer uw systeem details in (u kunt deze kopiëren vanuit Extra -> Programma Opties
-> Systeem informatie)
Als het probleem iets te maken heeft met een bestand, stuur er dan een kopie van (na
het verwijderen van vertrouwelijke informatie)

https://www.banana.ch/nl/contact_form
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Lokale kopie van uw werk

Een van de hoofdzaken van elke desktop applicatie is het opslaan van bestanden. Het werk van de
gebruiker en de ingevoerde gegevens mogen niet verloren gaan. Zelfs in het geval van een
computerstoring moet zo weinig mogelijk werk verloren gaan.

In Banana Boekhouding Plus is een nieuwe strategie voor het opslaan van bestanden geïntroduceerd.
Voor de gebruiker is er niets veranderd maar "onder de motorkap" zijn belangrijke verbeteringen
gemaakt om het opslaan van gegevens veiliger en robuuster te maken en om het te optimaliseren
voor het gebruik in cloudsystemen of mobiele schijven.

Hoe het werkt
Bij de nieuwe implementatie van het opslaan en herstellen van bestanden maakt Banana Accounting
een lokale kopie van het open bestand en werkt dan met de lokale kopie die op het apparaat (pc,
mobiel, tablet) aanwezig is totdat de gebruiker het document opslaat. Op dat moment slaat Banana
Boekhouding de wijzigingen op in het bronbestand. Tussentijds slaat Banana Boekhouding de
gemaakte wijzigingen op in de lokale kopie.

Banana Boekhouding gaat als volgt te werk:

De gebruiker kiest het bestand dat geopend moet worden (bronbestand)
Banana Boekhouding maakt een lokale kopie van het bronbestand
Banana Boekhouding blokkeert het openen van het bronbestand om wijzigingen door meerdere
gebruikers te voorkomen.
Banana Boekhouding leest de lokale kopie
Banana Boekhouding slaat regelmatig (standaard elke 2 minuten) de wijzigingen die aan het
document gemaakt zijn op in de lokale kopie
Zodra de gebruiker op de knop Opslaan klikt slaat Banana Boekhouding de wijzigingen op in het
bronbestand
Als het bestand gesloten wordt geeft Banana Boekhouding het bronbestand vrij en verwijdert de
lokale kopie
Als de applicatie niet afgesloten kan worden of de wijzigingen niet correct kan opslaan in het
bronbestand (onderbreking van de elektriciteit of een andere oorzaak) blijft de lokale kopie op
het apparaat staan en kan de inhoud hersteld worden als Banana Boekhouding een volgende
keer wordt geopend
Als het bestand tijdelijk niet bereikbaar is (het staat bijvoorbeeld op een ontkoppelde
netwerkschijf of een USB stick), kan de gebruiker blijven werken en worden de
documentwijzigingen opgeslagen in een lokale kopie totdat het bronbestand weer beschikbaar
is.

Met andere woorden, de lokale kopie is zowel een werk- als een hersteldocument.

Voordelen
De autorecover functie is altijd actief zodat de hoeveelheid werk die verloren kan gaan overeenkomt
met het werk van de laatste twee minuten (met de standaardinstellingen van autorecover).

U hoeft niet voortdurend toegang te hebben tot het bestand. Zelfs als het bestand tijdelijk niet
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bereikbaar is (het staat bijvoorbeeld op een netwerkschijf of een USB stick), kunt u blijven werken en
worden de documentwijzigingen opgeslagen in een lokale kopie totdat het bronbestand weer
beschikbaar is.

De lokale kopie wordt niet gesynchroniseerd met de cloud met als reden de prestaties van de
applicatie te verbeteren en het dataverkeer met de cloud te minimaliseren.

Dit process is in alle besturingssystemen op dezelfde manier geïmplementeerd : Windows, MacOS,
iOS, Linux, Android en WebAssembly, ongeacht waar het bestand wordt opgeslagen.

Gegevens herstel
In geval van een onderbreking van de applicatie blijft de lokale kopie achter op het apparaat van de
gebruiker. De volgende keer dat Banana Boekhouding wordt gestart laat de applicatie de gebruiker
weten dat er veranderingen gevonden zijn die niet in het bronbestand zijn opgeslagen.

Op dat moment heeft de gebruiker 3 mogelijkheden:

Het herstelde bestand openen
De gebruiker kan besluiten het herstelde bestand op te slaan of de veranderingen te negeren.
De boodschap te negeren
De gebruiker kan later beslissen wat te doen
Het herstelde bestand te verwijderen
Het herstelde bestand wordt verwijderd

De lokale kopie blijft op het apparaat van de gebruiker staan zolang het document in gebruik is of de
veranderingen niet correct opgeslagen zijn in het bronbestand. De lokale kopie wordt verwijderd als
het bestand gesloten wordt.

De lokale kopieën worden opgeslagen in een verborgen map onder de gebruikersgegevens van het
systeem. De gebruiker heeft geen toegang tot deze map nodig, toegang tot deze map wordt niet
aangeraden. In het geval dat onze supportafdeling u vraagt deze map te openen kunt u deze vinden
met menu Extra → Programmaopties → Geavanceerd → Systeeminfo → Working copies path
→ Open path ....
The local copies are saved in a folder hidden under the system's user data. The user does not need to
access this folder, access to this folder is not recommended. In case our support requires you to open
this folder, you can access it through the menu Tools → Program Options → Advanced → System
Info → Working copies path → Pad openen....

Denk eraan
Deze implementatie:

Vervangt niet een goed backup beleid.
Vervangt niet een versie beheersysteem.

Alhoewel deze implementatie heel veilig en robuust is kunnen we niet garanderen dat deze voor
100% soepel werkt in alle gevallen. Daarom moedigen we onze klanten aan over te gaan op een goed
backup beleid en een goed versie beheersysteem te gebruiken.

Verschillende besturingssystemen leveren backup en versie controle functies. Zoek vooral eens in de
documentatie van uw besturingssysteem.....
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Bestandscompatibiliteit met vorige versies

De Banana Boekhouding bestanden zijn compatibel met de vorige versies vanaf versie 5.12.
Dit betekent dat de bestanden kunnen worden gelezen en geschreven door iedere versie van het
programma.

We proberen de compatibiliteit zoveel mogelijk te behouden, zodat bestanden kunnen worden
uitgewisseld met verschillende versies van het programma.

Nieuwere versies implementeren nieuwe functies die niet beschikbaar zijn in eerdere versies.
Het gebruik van deze functies leidt tot incompatibiliteit. Wanneer het bestand met een oudere
versie van het programma wordt geopend, wordt u gewaarschuwd het bestand niet te
gebruiken, omdat er fouten in de berekeningen kunnen optreden en/of gegevens verloren
kunnen gaan.
Nieuwere versies bieden nieuwe toepassingen. Deze kunnen niet worden geopend met oudere
versies.

Hieronder vindt u de lijst van wijzigingen die tot incompatibiliteiten leiden. Als u deze functies
gebruikt dient u het programma te updaten naar de nieuwe versie.

Versie 10 (Banana Plus 2020)
Gebruik van de nieuwe Koppelingen kolom.
De nieuwe versie introduceert de mogelijkheid om een document te linken in elke rij van een
tabel, via het menu Gegevens → Koppelingen.  
In vorige versies bestond deze mogelijkheid alleen in de Transacties tabel. De mogelijkheid
om koppelingen toe te voegen in elke tabel is een functie die veel gevraagd wordt door
gebruikers; helaas was het niet mogelijk om het te implementeren met behoud van de
compatibiliteit van bestanden gemaakt met eerdere versies. Indien koppelingen worden
gebruikt, zijn de bestanden niet langer compatibel met vorige versies. 
In de nieuwe versie wordt, wanneer het bestand wordt geopend, een kolom Koppeling
 toegevoegd aan elke tabel. De gegevens in de DocKoppeling kolom van de tabel
Transacties worden naar de nieuwe kolom gekopieerd, en de DocKoppeling kolom wordt
verwijderd.
Boekhoudkundige toepassingen:       

Gebruik van de nieuwe kolom Segmenten.
Gebruik van de BTW-code voor de Reverse charge
Gebruik van de kolom Betalingen.
Gebruik van de kolom FormuleBegin in de Budget tabel.

Timesheet
Kolommen "TijdWerk", "TijdAfwezigheid" toegevoegd.
Kolom Toeslag    

Toepassingen Facturen en Inventaris
Deze worden niet ondersteund in eerdere versies.

Versie 9
Boekhoudkundige toepassingen:

Items Tabel.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 100

Hoeveelhedenkolommen in de Transacties tabel.
Rekeningen en BTW-codes met omschrijvingen in kleine letters.
Nieuwe functies voor de Uitgebreide Balans op groepen.
Nieuwe functies voor de opdracht PDF bestand
Nieuwe afdrukfunctionaliteit.

Timesheet toepassing
Deze wordt niet ondersteund in eerdere versies.

Versie 8
Boekhoudkundige toepassingen:

Budget tabel
Documenten tabel

Bibliotheek toepassing
Deze wordt niet ondersteund in eerdere versies.

Versie 7
Boekhoudkundige toepassingen:

Wijziging van het BTW basisbedrag in de tabel Transacties.
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Bestandseigenschappen

Wanneer een nieuw bestand wordt aangemaakt moeten de basisgegevens worden ingevoerd met het
Bestands- en Boekhoudeigenschappen commando van het menu Bestand.

De bestandseigenschappen kunnen verschillend zijn afhankelijk van het gekozen boekhouding type.

Voor een uitleg van de diverse tabbladen bezoekt u de pagina's die in de index onder deze pagina
gegroepeerd staan.
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Tabblad Boekhouding

Open dit venster met Bestand → Bestands- en boekhoudingseigenschappen... → tab
Boekhouding.

Koptekst links en koptekst rechts

Dit zijn de twee lege vakken bovenaan waar men elke gewenste tekst kan invoeren; deze teksten
zullen gebruikt worden als kopteksten (links en rechts) bij de afdrukken.

Begindatum

De begindatum is de datum van de aanvang van de boekhouding (kan ook blanco gelaten worden).
Indien er bij het invoeren van de transacties een eerdere datum wordt gebruikt dan die van de
gedefinieerde begindatum, zal het programma een foutmelding geven.

Einddatum

De einddatum is de datum van de afsluiting van de boekhouding (kan ook blanco gelaten worden).
Indien er bij het invoeren van de transacties een latere datum wordt gebruikt dan die van de
gedefinieerde einddatum, zal het programma een foutmelding geven.

Basisvaluta

De initialen van de valuta waarmee de boekhouding gedaan wordt. U kunt elke munteenheid
invoeren, zelfs een die niet in de lijst staat. Wanneer de initialen van de basisvaluta veranderd
worden, verandert het programma de kopteksten van de kolommen, waarin bedragen in basisvaluta
voorkomen, met de nieuwe initialen.

Het is verplicht in de vreemde valuta boekhoudingsbestanden de basisvaluta te kiezen, die werkt als
functionele valuta  (Engelstalig). Deze wordt gebruikt voor de berekening van de Balans en de
Verlies-& Winstrekening. (Functionele valuta: Een valuta-eenheid van een land/regio waar de
bedrijfsactiviteiten van de primaire rechtspersoon zijn gevestigd en waarin deze het merendeel van

https://en.wikipedia.org/wiki/Functional_currency
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de opbrengsten en de onkosten genereert.).

Het basisvalutasymbool veranderen
Het programma verandert de bestaande bedragen niet als u het basisvalutasymbool verandert. We
raden u aan alleen uw basisvalutasymbool te veranderen als u nog geen openingssaldi en transacties
ingevoerd hebt.

Boekhoudingsbestand ZONDER vreemde valuta

U kunt het basisvalutasymbool vervangen door een nieuw symbool.

Boekhoudingsbestand MET vreemde valuta

Informatie over het veranderen van de valuta in de boekhouding met vreemde valuta vindt u op
pagina De basisvaluta veranderen.
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Tabblad Opties

Open dit venster met Bestand → Bestands- en boekhoudingseigenschappen... → tab Opties.

Transactiedatum vereist
Indien deze optie geactiveerd is en er een transactie ingevoerd wordt zonder datum, zal het
programma een foutmelding geven.

Totalen handmatig opnieuw berekenen (F9)
Indien deze optie geactiveerd wordt, wordt de herberekening van de hoofdgroepen van de
boekhouding niet automatisch uitgevoerd, maar door middel van het gebruik van toets F9.

Bestand van vorig jaar
Met het commando Bladeren kan men het bestand van het vorige jaar selecteren.

Indien de optie Smart fill met transacties van vorig jaar geactiveerd wordt, houdt het programma
de transacties van het vorige jaar in het geheugen, en presenteert ze in de Smart Fill tijdens het
invoeren van nieuwe transacties.

Het minteken (-) gebruiken als separator van de segmenten
Indien deze optie geactiveerd wordt, moeten de segmenten in de Transacties-tabel ingevoerd worden
met het minteken, voorafgaand aan de segment-code.
Indien deze optie niet geactiveerd is, moeten de segmenten ingevoerd worden met het dubbele punt
teken (:), zoals in het rekeningschema. De dubbele punt moet altijd voorafgaan aan de segment-code.

Kostenplaatsen volgens de categorie (+/-) vastleggen
Deze functie is alleen actief in het Inkomsten en Uitgaven boekhouding en het Cash manager. Door
deze functie te activeren wordt het bedrag in de kostenplaats geregistreerd (in positief of in negatief)
naar gelang de categorie.
Als echter deze optie niet geactiveerd is, is het noodzakelijk een minteken te plaatsen voor een
kostenplaats (-KP) om een negatieve waarde in te voeren.

Bijbehorend document: Tekst invoer, edit en Smart fill



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 105



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 106

Tabblad Adres

Open dit venster met Bestand → Bestands- en boekhoudingseigenschappen... → tab Adres.
Op dit tabblad kan men de gegevens over het bedrijf of over de persoon, van wie de boekhouding
beheerd wordt, invoeren.
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Tabblad Vreemde Valuta

Open dit venster met Bestand → Bestands- en boekhoudingseigenschappen... → tab Vreemde
valuta.

Voor de uitleg over de diverse velden bezoekt u de pagina Beginnen met een vreemde valuta
boekhouding.
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Tabblad BTW

Open dit venster met Bestand → Bestands- en boekhoudingseigenschappen... → tab BTW.

Voor de uitleg over de diverse velden bezoekt u de pagina Bestandseigenschappen (BTW/Verkopen
belasting tab).
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Tabblad Andere

Open dit venster met Bestand → Bestands- en boekhoudingseigenschappen... → tab Andere.

Huidige taal

Er zijn verschillende teksten eigen aan het bestand die het programma automatisch genereert
(bijvoorbeeld de rijen van de Totalen tabel, de transacties op de rekeningkaart, de afdruk van de
uitgebreide balans); op dit tabblad kan de gebruiker de taal voor deze teksten aangeven (gewoonlijk
is dit dezelfde als de aanmaaktaal).

Aanmaaktaal

Dit is de gekozen en geselecteerde taal bij het aanmaken van het boekhoudbestand; zij wordt
gebruikt voor de kopteksten van de kolommen. Als men de aanmaaktaal wenst te veranderen, is het
noodzakelijk het eigen bestand in een nieuw te converteren met het menu Extra → commando Naar
nieuw bestand converteren.

Extensies

Het is mogelijk om extensies van Banana Boekhouding aan te geven. Wanneer het bestand wordt
geopend, zal het programma de extensies automatisch installeren.  Deze kunnen gebruikt worden
voor modellen of bestanden die gecombineerd worden met extensies. Andere mensen die het
bestand zullen gebruiken zullen de commando's vinden om het programma te installeren.

De lijst toont alle extensies die geïnstalleerd kunnen worden.

Trefwoorden van de extensies

Voer een of meer trefwoorden in die in de Banana Boekhouding extensies staan. Gewoonlijk staan
deze trefwoorden in de installatieinstructies van de extensie; de meeste extensies gebruiken geen
trefwoorden om het bekijken van bepaalde bestanden te beperken.
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Als een script het @docproperties attribuut heeft, zal het commando alleen zichtbaar zijn in het menu
Extensies voor de Banana bestanden die hetzelfde trefwoord hebben ingesteld in het Extensies
veld.Om meerdere trefwoorden in te stellen, moet je ze scheiden met de ; (voorbeeld: datev;
giften).
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Tabblad Wachtwoord

Open dit venster met Bestand → Bestands- en boekhoudingseigenschappen... → tab
Password.

Bestanden kunnen worden beveiligd door een wachtwoord te gebruiken.

Invoeren van een wachtwoord in een bestand dat nog geen
wachtwoord heeft
Oud wachtwoord bevestigen

Laat deze cel leeg.

Nieuw wachtwoord

Voer het wachtwoord in.

Nieuw wachtwoord bevestigen

Voer hetzelfde wachtwoord in dat u in de cel Nieuw wachtwoord gebruikt heeft.

Een bestaand wachtwoord veranderen
Voer het bestaande wachtwoord in.
Voer uw nieuwe wachtwoord tweemaal in.
Bevestig met OK.

Wachtwoord compatibiliteit met oude versies
Vink deze optie aan als u wilt dat uw wachtwoord compatibel is met de versies van Banana
Boekhouding 8 en voorgaand.
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We bevelen deze optie niet aan omdat het wachtwoord in een minder veilige modus wordt
opgeslagen.

Een wachtwoord verwijderen
Voer het bestaande wachtwoord in.
Laat de velden voor het nieuwe wachtwoord leeg.
Bevestig met OK.

Wachtwoord vergeten
Voor informatie over uw vergeten wachtwoord, raadpleegt u de pagina Questions and Answers,
Password unlock  (beschikbaar in het Engels).

Let op

Met het gebruik van een wachtwoord bereikt men geen hoog niveau van beveiliging. Om de gegevens
werkelijk ontoegankelijk te maken voor derden, is het nodig de geschikte cryptografische software te
gebruiken.

https://www.banana.ch/en/node/9340
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Tabblad Teksten

 Open dit venster met Bestand → Bestands- en boekhoudingseigenschappen... → tab Teksten.

Op dit tabblad kan men extra gegevens met betrekking tot het boekhoudbestand inbrengen, zoals de
naam van de boekhouder bijvoorbeeld. Deze toetsen en de daaruit voortvloeiende teksten kunnen
worden overgenomen en gebruikt in scripts.

Sleutel
Voer in dit veld de naam van de sleutel (bijv. : Adres).

Waarde
In dit veld moet de waarde die bij de sleutel hoort ingevoerd worden (bijv.: Oranjestraat, ...).

Toevoegen
Met deze knop slaat u de ingevoerde gegevens op.

Verwijderen
Met deze knop verwijdert u de geselecteerde Sleutel.
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PDF aanmaken

Het commando PDF aanmaken... wordt gegeven vanaf het menu Bestand  > PDF aanmaken...
Het slaat alles wat u op het scherm ziet op in PDF formaat.

Er is ook nog een ander commando vanuit het menu Bestand > PDF bestand aanmaken..., waarmee u
kunt aangeven welke inhoud van uw Banana Boekhoudbestand u wilt opnemen in uw PDF bestand.

Opslaan-opties

Opslaan-opties zijn alleen beschikbaar in het Advanced plan  (Engelstalig) van Banana
Boekhouding Plus.

Bijlagen opnemen

De bijlagen worden opgeslagen in het PDF bestand. Bijlagen zijn lokale bestanden waarvoor een
koppeling is opgenomen in de kolommen Koppeling van de verschillende tabellen. In het
aangemaakte PDF bestand staat een symbool naast iedere regel met een koppeling naar een bijlage.
Door op het symbool te klikken wordt de bijlage geopend en weergegeven. Houd er rekening mee dat
de bijgevoegde bestanden alleen kunnen worden geopend in PDF-lezers zoals Adobe Acrobat Reader,
Foxit en andere. Als het PDF-bestand wordt geopend in een webbrowser, is het mogelijk dat de
bijlagen niet kunnen worden geopend.

Deze optie is alleen zichtbaar als de document(en) koppelingen bevatten.

Technische opmerkingen

Bij het afdrukken en het afdrukvoorbeeld (voor een fysieke en ook virtuele PDF printer van het
operating systeem) zijn alle lettertypen die ondersteund worden door het operating systeem
mogelijk.
Bij het afdrukken naar PDF In Windows zijn alleen TrueType fonts mogelijk die Unicode cmap
mapping hebben en de volgende tabellen bevatten: "OS/2", "cmap", "cvt ", "fpgm", "glyf",
"head", "hhea", "hmtx", "loca", "maxp", "name", "post", "prep".

https://www.banana.ch/en/upgrade


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 115

Als het programma het aangegeven lettertype niet kan laden vervangt het dit door het
standaard lettertype (Helvetica of Arial afhankelijk van het operating systeem) en wordt een
melding aan de gebruiker gegeven dat het geen gebruik kan maken van het PDF font .

 
 

https://www.banana.ch/doc/nl/appmsg_it_err_fontsostituitoinpdf
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Afdrukken/Afdrukvoorbeelden

Afdruk voorbeeld
Alle afdrukken van de diverse boekhoud documenten kunnen opgeslagen worden in PDF, HTML, MS
Excel en gekopieerd naar het Klembord zodat de gebruiker deze nog jaren later kan gebruiken.

Afdrukken
Deze knop roept het Printer Instellingen venster van Windows op. De keuzes zijn alleen geldig voor de
huidige werksessie. Blijvende veranderingen moeten via het Windows Configuratiescherm gemaakt
worden.

Horizontaal of verticaal printen moet ingesteld worden bij Pagina instelling is werkt alleen op
deze ene weergave.
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Boekhouding afdrukken
Op de volgende pagina's vind u informatie over de afdrukken specifiek voor de diverse types
boekhoudingen:

Afdrukken Dubbel boekhouden
Afdrukken Vreemde Valuta boekhouden
Kasboek en Inkomsten & Uitgaven boekhouding
BTW Overzicht
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Pagina instelling

Hiermee kunnen de afdruk eigenschappen ingesteld worden. Iedere weergave heeft zijn eigen
afdrukinstellingen.

Koptekst links
Hier wordt de titel van de actieve weergave getoond. De titel kan gewijzigd worden en verschijnt links
bovenaan op de afgedrukte pagina.

Koptekst rechts
Het is mogelijk hier een andere tekst in te voegen die afgedrukt zal worden rechts bovenaan op de
afgedrukte pagina.

Logo
Druk op de knop Veranderen aan de rechterkant en selecteer vervolgens Toevoegen, zoals we ook
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uitleggen in de pagina Logo-instelling; voeg uw eigen logo toe.
Terug naar het Pagina-instelling venster, kies Logo in plaats van geen.

Marges

In deze zone kan men de marges voor de af te drukken pagina's inbrengen. De meeteenheid is de
centimeter.

Pagina aan afdrukbereik gebied aanpassen
Met deze functie kan men het afdrukbereik aanpassen wanneer de afdruk over de eerder ingestelde
pagina grenzen gaat.

In afdruk opnemen

Wanneer deze functies geactiveerd worden maken ze het afdrukken van de volgende gegevens
mogelijk:

Bestandkoptekst
Dit is de tekst die ingebracht is in de Bestands- en boekhoudingseigenschappen van het menu
Bestand.

Paginakopteksten
De paginakoptekst wordt meegenomen in de afdruk.

Tabelnaam
De tabelkoptekst (bijvoorbeeld Rekeningen, Transacties, etc.) worden afgedrukt.

Kolomkoptekst
Dit zijn de kopteksten van de diverse kolommen in de tabel.

Grote letters
Bij de afdruk van de koptekst worden lettertekens gebruikt die een beetje groter zijn.

Pagina-einde
Deze optie zorgt ervoor dat ingevoerde pagina-eindes afgedrukt worden. Als deze optie niet actief is
worden de pagina-eindes niet afgedrukt, zelfs al zijn ze aanwezig.

Paginanummers
Dient voor het nummeren van de pagina's.

Tijd afdrukken
Deze optie maakt het mogelijk het tijdstip af te drukken.

Datum afdrukken
Deze optie maakt het mogelijk de datum af te drukken.

Rijnummers
Deze optie kan men activeren om aan elke rij een oplopend nummer toe te kennen.

Raster
Het raster kan afgedrukt worden op dezelfde wijze zoals het op het scherm verschijnt.
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Layout

Het programma past automatisch de grootte van de pagina aan.

Tekengrootte %
Geeft de mogelijkheid om, volgens het percentage, de maat van de af te drukken lettertypes te
vergroten of te verkleinen.

Aan paginabreedte aanpassen
Indien enkele kolommen de paginabreedte overschrijden, reduceert het programma de afdruk
(reduceert de zoom), zodat alle kolommen correct op het blad afgedrukt worden.

Zoals op scherm
De afdruk ziet er precies het zelfde uit als op het scherm.

Als de inhoud over de pagina grenzen heengaat:

Als de optie "Pagina aan afdrukbereik gebied aanpassen" geactiveerd is, wordt de teken grootte
verkleind;
Als de optie "Pagina aan afdrukbereik gebied aanpassen" niet geactiveerd is, wordt het
gedeelte dat niet op het papier past niet afgedrukt.

Zwart/Wit afdrukken
Alle kleuren worden weergegeven in grijs-waardes.

Liggend afdrukken
Om de pagina in liggend (landschap) formaat af te drukken.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 121

Exporteren naar PDF vanuit afdrukvoorbeeld

Dit venster wordt weergegeven wanneer u naar PDF moet exporteren vanuit het afdrukvoorbeeld.

Bijvoorbeeld, om PDF bestanden aan te maken van facturen moet:

Vanuit het menu, Rapporten > Klanten > Facturen afdrukken
Specificeer de facturen die afgedrukt moeten worden (bijvoorbeeld 1-10)
Bevestig met OK
Klik in het afdrukvoorbeeld op het PDF icoontje

Bestand en map namen

Voer de naam van het nieuwe bestand in of kies een bestaand bestand met de knop Bladeren. Als de
optie Gescheiden bestanden actief is voert u de naam in van de map waarin de bestanden moeten
worden opgeslagen en controleert u dat er geen spaties staan aan het eind van de naam van
de map.

Opties voor het opslaan (Advanced plan )

Bijlagen insluiten (alleen PDF)

Hiermee worden bijlagen opgeslagen in het PDF bestand. Bijlagen zijn lokale bestanden die gekoppeld
zijn in de kolom Koppeling. 

Deze optie is alleen zichtbaar als het document koppelingen bevat.
In het aangemaakte PDF bestand wordt een symbool toegevoegd bij de regel waarin de bijlage
vermeld staat. Door op het symbool te klikken wordt de bijlage getoond.
Alleen bijlagen uit de map, of submap daarvan, waarin het boekhoudbestand staat worden

http://www.banana.ch/doc/nl/node/8295
https://www.banana.ch/nl/upgrade
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geëxporteerd. Voor bijlagen in andere mappen wordt een "toegang geweigerd" melding
gegeven. 
Deze beperking is opgelegd om te voorkomen dat een koppeling naar een systeem of bestand
met  vertrouwelijke informatie per ongeluk wordt geëxporteerd bij het aanmaken van de PDF.
We adviseren daarom bijlagen op te slaan in een submap van de map met het
boekhoudbestand.
De mogelijkheid om bijlagen te openen bestaat alleen in PDF lezers zoals Adobe Acrobat
Reader, Fox it en anderen. Wanneer het bestand wordt geopend in een browser kunnen bijlagen
mogelijk niet worden geopend.

Meer informatie op pagina PDF aanmaken met digitale bijlagen.

Gescheiden bestanden (alleen PDF)

Hiermee worden de afdrukken opgeslagen in aparte PDF bestanden wanneer verschillende facturen of
overzichten van klanten worden afgedrukt. Zie voor meer informatie de betreffende paragrafen
hierna.

Bestand direct weergeven

Zodra het bestand is aangemaakt wordt de software om het weer te geven gestart. Op deze manier
kan het resultaat van de export meteen bekeken worden.

Druk facturen of klantoverzichten af in gescheiden PDF
documenten
Met deze functie kunnen meerdere facturen of klantoverzichten afgedrukt worden in één enkele
bewerking die aparte PDF bestanden aanmaakt wat veel tijd bespaart.

De functie Afdrukken in aparte bestanden is alleen beschikbaar met het Advanced
plan van Banana Boekhouding Plus .
Om het te kunnen gebruiken moet u de laatste versie van Banana Accounting
(vanaf 10.1.18)  of het Dev Channel  downloaden.
Zie ook alle voordelen van het Advanced plan .

https://www.banana.ch/nl/buy
https://www.banana.ch/nl/buy
https://www.banana.ch/nl/download
https://www.banana.ch/nl/download
https://www.banana.ch/nl/insiderprogram
https://www.banana.ch/nl/advanced
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Bij het afdrukken van aparte bestanden kunt u bepaalde parameters aanpassen:

U kunt de bestandsnaam die gebruikt moet worden aangeven.
U kunt variabelen gebruiken om de individuele documenten te onderscheiden, zoals
<nummer> voor het documentnummer of <naam> voor de standaard bestandsnaam.

Door op het {xy} symbool te klikken kan de hele lijst van variabelen bekeken worden.
In de regel eronder ziet u een voorbeeld van de bestandsnaam die het programma
aanmaakt.

Bij het opslaan vraagt het programma om bevestiging als er al een bestand met dezelfde naam
bestaat in de aangegeven map.
Deze optie is alleen zichtbaar als de afdruk uit meerdere documenten bestaat.

Parameters voor het aangemaakte PDF bestand

Paginagrootte

De paginagrootte van de PDF wordt overgenomen van de printer instellingen.

Zorg ervoor dat de paginagrootte bij de printerinstellingen op A4 staat ingesteld..

PDF/A Formaat

Het bestand wordt geconverteerd naar het PDF/A formaat , dat een archiveringsstandaard is en een
beperkte subset van de PDF standaard. Wanneer bepaalde elementen worden ingesloten kan het PDF
bestand mogelijk niet overeenkomen met de PDF/A standaard.

Het insluiten van elke soort bijlagen is alleen in overeenstemming met de PDF/A-3 standaard.
Koppelingen naar externe documenten zijn niet toegestaan.

Fonts

Het programma genereert de PDF met door de gebruiker gespecificeerde fonts. Als er problemen zijn
met de leesbaarheid of als het zoeken in de PDF niet werkt kunt u True Type fonts uitschakelen met
het menu Extra > Programmaopties > Geavanceerd > Selectievakje True Type lettertypen
inschakelen.

https://nl.wikipedia.org/wiki/PDF/A
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Exporteren Afdrukvoorbeeld

In de werkbalk Afdrukvoorbeeld:

    Klik op het pijltje naast de knop Adobe PDF.
    Kies de optie die bij u past:

        PDF maken.
        Exporteren naar Html.
        Exporteren naar Excel.
        Kopiëren naar klembord.
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Paginanummering

U kunt de paginanummering functie bereiken door op het  icoontje op de Afdrukvoorbeeld
werkbalk te klikken.

In dit dialoog venster staan de instellingen voor paginanummering. Het afdrukken van de
paginanummers wordt aan- of afgezet door de instellingen bij Pagina instellingen te gebruiken.

Beginnen met
Het paginanummer waarmee de paginanummering met beginnen.

Prefix toevoegen
Het voorvoegsel dat voor het paginanummer gezet moet worden.
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Bestand exporteren

Kies het Bestand exporteren commando van het menu Bestand om meer den één tabel te
exporteren. Na een keuze in een uitklapmenu uit het formaat voor de geëxporteerde gegevens vindt
u In het dialoogscherm dat verschijnt de volgende tabbladen:

Base, om de o.a. de naam van het exportbestand en specifieke dingen per formaat op te geven
Opnemen tabblad, om de tabellen en de rapporten te bepalen die meegenomen moeten
worden in de export
Periode, om te bepalen uit welke periode de gegevens geëxporteerd moeten worden
BTW, (in boekhoudbestanden met BTW beheer)
Compositie, om een vooraf bepaalde instellingen te gebruiken
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PDF bestand aanmaken

PDF is een van de meest gebruikte bestandsformaten om naar te exporteren. Met Banana
Boekhouding Plus kunt u het volledige boekhoudbestand, inclusief de rapporten, exporteren naar PDF.

Nieuw! Het is nu ook mogelijk om te exporteren naar PDF te inclusief alle digitale bijlagen

Exporteren naar PDF met digitale bijlagen is alleen beschikbaar in Banana Boekhouding
Plus met het Advanced plan.

Voor de bijlagen in het PDF bestand worden de instellingen overgenomen zoals deze ingesteld waren
met de commando's van het menu Rapporten. Als andere instellingen gewenst zijn moeten deze
aangepast worden met de commando's in het menu Rapporten.

Om een Pdf bestand te maken kiest u menu Bestand > Pdf bestand aanmaken (of klik op het
overeenkomstige icoon op de Taakbalk).

Bestandsnaam

Voer de naam van het nieuwe bestand in of kies een bestaand bestand met de knop Bladeren. (het
programma overschrijft het bestaande bestand met de nieuwe gegevens).

Bestand direct weergeven

Zodra het Pdf bestand is aangemaakt wordt de software waarmee het bekeken kan worden geopend.
Bij het gebruik van browsers zoals Mozilla en Internet Explorer voor de weergave van het
exportbestand is het goed om te bedenken dat deze een cache mechanisme gebruiken om bestanden
weer te geven. Wanneer het exportbestand gemaakt is voor een tweede keer kan het gebeuren dat
de gebruiker de eerste versie ziet. Door de weergegeven pagina te Verversen in de browser wordt de
tweede versie zichtbaar.

Opties voor het aangemaakte bestand
Kopteksten 1, 2 and 3

U kunt tot drie kopteksten invoeren die in het PDF bestand verschijnen.

https://www.banana.ch/nl/buy
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Logo

Als uw logo is ingesteld in het menu Bestand > Logo instelling... kunt u kiezen om het logo in het
PDF bestand weer te geven of het uit te sluiten.

geen: het logo wordt niet gebruikt
Logo: het logo wordt gebruikt.

Zie ook de pagina Logo instelling.

Pagina-opties

Met deze pagina-opties is het mogelijk in de pagina op te nemen:

Pagina nummers
Nummering opnieuw beginnen voor elke sectie
Datum

Pagina grootte

U kunt het paginaformaat instellen

PDF bestand aanmaken met digitale bijlagen
Met de optie Opnemen bijlagen kunt u alle digitale documenten die in de transactietabel ingevoerd
zijn in de kolom Koppeling opnemen in de PDF. Met deze mogelijkheid heeft u in één enkel bestand
uw hele boekhouding met overzichten zoals de balans, resultatenrekening, etc. en alle documenten
(facturen, bonnen, ...).

De mogelijkheid om bijlagen op te nemen in het geëxporteerde PDF bestand is alleen
beschikbaar in het Advanced plan van Banana Boekhouding Plus .
Zie ook alle voordelen van het Advanced plan .

Meer details van de Bijlagen opnemen optie

De bijlagen worden opgeslagen in het PDF bestand. Bijlagen zijn lokale bestanden waarvoor een
koppeling is opgenomen in de kolommen Koppeling columns van de verschillende tabellen. In het
aangemaakte PDF bestand staat een symbool naast iedere regel met een koppeling naar een bijlage.

https://www.banana.ch/nl/buy
https://www.banana.ch/nl/advanced
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Door op het symbool te klikken wordt de bijlage geopend en weergegeven. Houd er rekening mee dat
de bijgevoegde bestanden alleen kunnen worden geopend in PDF-lezers zoals Adobe Acrobat Reader,
Foxit en andere. Als het PDF-bestand wordt geopend in een webbrowser, is het mogelijk dat de
bijlagen niet kunnen worden geopend.

Deze optie is alleen zichtbaar als de document(en) koppelingen bevatten.

Technische opmerkingen
Voor opmerkingen over het PDF formaat of lettertypen raadpleegt u de pagina PDF aanmaken .

Andere Secties

Voor de uitleg van de andere tabbladen kunt u de volgende pagina's bezoeken:

Opnemen
Periode
BTW
Aanpassing

http://www.banana.ch/doc/nl/node/9876
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Bestandslocatie openen

Het commando Bestandslocatie openen van het menu Bestand opent het
bestandsbeheerprogramma van het besturingssysteem (Windows Explorer, Finder Mac) en laat de
map zien waar het bestand waarin u aan het werk bent zich bevindt.

Om het bestand te hernoemen, te verplaatsen of te verwijderen moet het gesloten zijn.

Ga als volgt te werk:

Bestand → Bestandslocatie openen
Zoek in de geopende map het bestand op
Vervolg met de gewenste actie (kopiëren, hernoemen, verplaatsen).

Soms blijft het bestand vergrendeld zelfs al was het gesloten. In die gevallen is het ook nodig het
programma af te sluiten om het bestand helemaal te ontgrendelen.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 131

Logo-instelling
Logo-instelling

Vanaf Banana versie 9.0.3  is het mogelijk een logo te gebruiken en de instellingen (breedte,
hoogte, positie) ervan te definieren via menu Bestand → Logo-instelling... .

Opties tabblad
In het dialoogvenster Logo instelling... → Opties tabblad is het mogelijk een afbeelding toe te
voegen met de knop Toevoegen; u kunt de breedte, hoogte en de uitlijning van de logo afbeelding
instellen. Als het logo al is ingevoegd, kan het worden bewerkt of verwijderd via de knop Bewerken /
Verwijderen.

Tekst

Als dit vakje is aangevinkt worden de koppen van de dialoogvensters voor "Rekeningkaarten",
"Uitgebreide balans op groepen" en "Boekhoudingsoverzicht" toegevoegd aan het logo volgens de
keuze in het drop-down keuzemenu "Relatieve positie ten opzichte van het logo" (dus Onder, Naar
links, Boven, Naar rechts).

Tabblad Aanpassing

Verschillende logo instellingen kunnen worden aangemaakt en opgeslagen, ieder in een verschillende
Aanpassing.

https://www.banana.ch/nl/download_nl
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Om een factuur af te drukken met het logo is het nodig een aanpassing te gebruiken met de Logo
naam, die ingevoerd moet worden in het vakje Naam.

Om een Uitgebreide balans op groepen met een ander logo af te drukken is het nodig een nieuwe
aanpassing aan te maken (bijvoorbeeld de naam Logo_balans), die dan gebruikt moet worden in het
naam veld van de Uitgebreide balans op groepen instelling.

Het logo op alle afdrukken toepassen
Het logo kan op twee manieren worden gebruikt in alle afdrukken:

Menu Bestand → Pagina-instelling....1.
Klik in Print preview op het icoon voor instellingen.2.

Als u het logo enkel in een specifieke afdruk wilt gebruiken moet u het direct invoeren in de
instellingen van die afdruk; bijvoorbeeld in de Rekeningkaarten, de Uitgebreide Balans, de
Uitegebreide Balans op groepen  en Boekhoudingsoverzicht.

Opmerking

De functie Logo instellingen is een eenvoudig alternatief voor het instellen van uw logo met de
tabel Documenten .
 

annelies di, 05/29/2018 - 15:37

http://www.banana.ch/doc/nl/node/8357


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 133

Laatst gebruikte bestanden/ Favorieten

Laatst gebruikte bestanden / Favoriete bestanden

Deze opdrachten laten de lijst van laatst gebruikte bestanden en de lijst van favoriete bestanden zien.

Om de lijst van laatst gebruikte bestanden leeg te maken klikt u op menu Bestand, Laatst
gebruikte bestanden en dan op Lijst laatst gebruikte bestanden wissen.

Om slechts één enkel bestand te verwijderen uit de lijst van Onlangs geopende items in het
Windows Start menu, klikt u met de rechtermuisknop op de bestandsnaam en kiest u Verwijderen.
(Mac gebruikers moeten de toetcombinatie Ctrl + rechtermuisknop)

Om een bestand Favoriet te maken:

Open het gewenste bestand
Klik op Favoriete bestanden
Klik op Aan favorieten toevoegen

Om de Favoriete bestanden lijst aan te passen, klik op:

Favoriete bestanden
Lijst favoriete bestanden bijwerken...
In het venster dat verschijnt kunt u de favorieten aanpassen door te klikken op de knoppen
Toevoegen, Verwijderen, Naar boven verplaatsen, Naar beneden verplaatsen,
Bestandslocatie openen
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Menu Bewerken

 Onder het menu Bewerken vindt u een aantal praktische commando's om gegevens te bewerken.
Zie ook Sneltoetsen.

Ongedaan maken / Opnieuw uitvoeren
Met deze eenvoudige commando's kunt u de laatste bewerkingen ongedaan maken of opnieuw doen.
Het maximum aantal bewerkingen dat ongedaan kan worden gemaakt, wordt ingesteld in het menu
Extra → Programmaopties → Editor → Maximum aantal ongedaan gemaakte bewerkingen.

Knippen, Kopiëren en Plakken
Het is mogelijk om cellen, rijen of geselecteerde tekst (tenzij deze beveiligd is) te kopiëren/plakken,
precies zoals u in Excel doet.

Selecteer de regel of het gebied dat gekopieerd moet worden
Kies in het menu Bewerken het Kopiëren of Plakken commando
Ga naar de rij of het gebied waarnaartoe de informatie gekopieerd moet  worden
Kies Plakken van het menu Bewerken.

De gebruiker kan ook kopiëren/plakken door de icoontjes  te gebruiken of te tikken op
Ctrl+C voor kopiëren, Ctrl+X voor knippen en Ctrl+V voor plakken.
Er zijn ook commando's zoals Rijen kopiëren, Rijen verwijderen en Rijen plakken. Deze
commando's gaan over een hele rij of rijen en niet over een selectie van een cel. Hiervoor moeten de
commando's Kopiëren, Knippen en Plakken niet gebruikt worden.

Kopiëren met kolomkoppen
Gebruik het commando Afdrukvoorbeeld en het Kopiëren naar het Klembord.

Alles selecteren
Dit commando selecteert de hele actieve tabel.

Van boven kopiëren (F4 of Cmd + 4)
Dit is een erg handig commando waarmee u de inhoud van de cel boven de cel waarin u staat kunt
kopiëren.
Te gebruiken voor een enkele of meerdere cellen, of een hele rij.

Opdracht uitvoeren commando (F6 or Cmd + 6)
Dit commando voert diverse handige functies uit afhankelijk van in welke cel u staat. Zie voor meer
informatie de Interface pagina.
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Rijen invoegen... (Ctrl en + toets)
Dit commando voegt lege rijen toe boven de geselecteerde rij:

Zet de cursor onder de regel waar de lege rijen moeten worden ingevoegd
Voor in het menu Bewerken het commando Rijen invoegen... uit
Type in het venster dat verschijnt het aantal rijen dat ingevoegd moet worden in
Bevestig met OK.

Rijen toevoegen...
Om lege rijen toe te voegen onder de geselecteerde rij voert u deze stappen uit:

Zet de cursor boven de regel waar de lege rijen moeten worden ingevoegd
Voor in het menu Bewerken het commando Rijen toevoegen... uit
Type in het venster dat verschijnt het aantal rijen dat ingevoegd moet worden in
Bevestig met OK.

Er is een andere procedure om lege rijen toe te voegen:
 

Zet de cursor boven de regel waar de extra rijen moeten worden toegevoegd

Klik op het volgende icoon  in the Werkbalk voor iedere rij die u wilt toevoegen. Deze
procedure raden we aan als u een beperkt aantal rijen moet toevoegen. De sneltoets is:
Ctrl+Enter.

Rijen dupliceren...
Dit commando dupliceert de geselecteerde rij(en).

Rijen kopiëren... (Ctrl + Shift + C)
Dit commando kopieert de geselecteerde rijen. Wanneer de rijen gekopieerd zijn wordt het
commando Gekopieerde rijen invoegen automatisch actief. Dit commando kan dan gebruikt
worden om de gekopieerde rijen in te voegen voor de rij die u aanwijst met de muis.

Rijen verwijderen... (Ctrl en - toets)
Om één of meer rijen te verwijderen selecteert u de rij of rijen die verwijderd moeten worden en klikt
u in het menu Bewerken op het commando Rijen verwijderen.

Rijen beveiligen / Beveiliging rijen opheffen
Door het Rijen beveiligen commando, van het menu Bewerken, activeert de gebruiker de
beveiliging van rijen om te voorkomen dat per ongeluk veranderingen gemaakt worden.
Beveiligde rijen hebben lichtgrijze rijnummers. De beveiligde rijen kunnen niet bewerkt worden totdat
de beveiliging wordt verwijderd door het Beveiliging rijen opheffen commando.

Om de beveiliging in werking te stellen:
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Selecteer de gewenste rijen om te beveiligen
Kies het Rijen beveiligen commando van het menu Bewerken
Bevestig het aantal rijen dat beveiligd moet worden door op OK te klikken.
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Menu Gegevens

Het menu Gegevens bevat de volgende functies:

Zoeken
Vervangen
Hernoemen
Koppelingen
Ga naar...
Naar oorspronkelijke rij gaan
Rijen ophalen en sorteren...
Rijen sorteren...
Rijen exporteren
Rijen importeren...
Kolommen instellen...
Tabellen instellen...
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Zoeken

De functie Zoeken is onderdeel van het menu Gegevens → Zoeken. De opties voor het zoeken naar
gegevens worden weergegeven onderaan de tabel waarin u zich bevindt.

Tekst zoeken

Voer de tekst die gezocht wordt in. Bedragen moeten ingevoerd worden zonder scheidingsteken voor
de duizendtallen.

Alleen volledige woorden

Alleen zoeken naar volledige woorden. Bijvoorbeeld, als het gezochte woord 'Tot' is, wordt niet het
woord 'Totalen' gevonden.

Identieke hoofdletters/kleine letters

Als deze optie gebruikt wordt maakt het programma een onderscheid tussen hoofd- en kleine letters.

Alleen geselecteerd gebied

Als deze optie gebruikt wordt zoekt het programma alleen in het gebied dat geselecteerd is.
Om het zoeken te beginnen moet men op de knop Zoeken klikken. Het eerste gegeven, dat
overeenkomt met het gevraagde, wordt gevonden; om het zoeken voort te zetten en de volgende
overeenkomende gegevens te vinden, moet men het commando Volgende zoeken selecteren, of de
F3 toets gebruiken.
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Zoeken en vervangen

De functie Vervangen die verbonden is met de functie Zoeken is onderdeel van het menu
Gegevens → Vervangen. De opties voor het zoeken en vervangen van gegevens worden
weergegeven onderaan de tabel waarin u zich bevindt.

De tekst die gezocht wordt en de tekst die gebruikt wordt als vervanging moeten ingevoerde worden
in dezelfde weergave als de tekst in het invoer veld. Bijvoorbeeld, bedragen moeten ingevoerd
worden zonder het scheidingsteken voor de duizendtallen.

Tekst zoeken

Voer de tekst die gezocht wordt in.

Vervangen door

Voer de vervangende tekst in.

Opties

Alleen volledige woorden

Zoek alleen volledige woorden. Bijvoorbeeld, als het gezochte woord 'Tot' is, wordt niet het woord
'Totalen' gevonden.

Hoofdletters / kleine letters

Als deze optie gebruikt wordt maakt het programma een onderscheid tussen hoofd- en kleine letters.

Alleen geselecteerd gebied

Als deze optie gebruikt wordt zoekt het programma alleen in het gebied dat geselecteerd is.

Alles vervangen

Met deze knop worden alle gegevens in één keer vervangen. Dit wordt gebruikt als het nodig is
gegevens te vervangen die meerdere malen voorkomen in de tabellen Rekeningen, Categorieën,
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Transacties of BTW-codes (bijvoorbeeld een rekeningnummer of een BTW-code). Voor het
vervangen van herhalende gegevens kan men ook de functie Hernoemen gebruiken.

Vervangen

Eén gegeven per keer vervangen.

Alles zoeken

Zoekt alle informatie, volgens de ingegeven tekst, en geeft deze weer in het informatievenster
onderaan het scherm.

Volgende zoeken

Zoekt naar het volgende overeenkomstige gegeven.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 141

Koppeling naar een document toevoegen

Door een digitaal document, opgeslagen op uw computer of op het internet, te koppelen aan een
transactieregel, kunt u met een enkele klik een kassabon, factuur of ander document rechtstreeks in
het boekhoudbestand openen. Uw documenten zijn altijd maar één klik van u verwijderd en u kunt
afscheid nemen van papier en overstappen op volledig digitale boekhouding.
Zie ook Boekhoudbestanden organiseren lokaal, online of in de cloud.

Koppeling van een digitaal document aan een regel is kan in all tabellen, ook in de rekeningen,
Items en andere tabellen.
Met het programma kunt u vanuit het afdrukvoorbeeld, met Naar PDF Exporteren, de
gekoppelde digitale documenten in het PDF bestand opnemen. Bij het auditeren kan de
accountant ook bijgevoegde documenten (factuur, bon, ander PDF document) in het
boekhoudbestand openen.

Bestandsnamen en paden 
Er zijn twee soorten paden naar een bestand:

Absoluut pad
Een bestandsnaam met een absoluut pad, of simpel 'absolute bestandsnaam', specificeert
het complete pad naar een bestand, inclusief de disk drive, folders en de naam van het
bestand zelf.
Het beschrijft exact de plaats van het bestand in het bestandssysteem.
Voorbeelden van absolute bestandsnamen:

"C:/Documents/Images/Photo.jpg"
"/Documents/Images/Photo.jpg"

Wanneer de map van het boekhoudbestand wordt verplaatst naar een andere computer
met een ander pad, wordt het bestand niet meer gevonden.

Relatief pad naar de folder van het boekhoudbestand (Aanbevolen).
Relatieve paden of simpel 'relatieve bestandsnamen' verwijzen naar bestandsnamen die
niet absoluut zijn, die NIET beginnen met een '/'. 
Koppelingen met relatieve paden worden beschouwd als relatief tot de map waarin het
boekhoudbestand zich bevindt.
Koppelingen blijven geldig, zelfs als mappen worden verplaatst of gesynchroniseerd naar
andere computers met andere locaties, zolang het bestand op dezelfde locatie blijft ten
opzichte van het boekhoudbestand.
Het pad bevat geen details van de disk drive of root map. De naam begint zonder een
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slash.
Als het bestand zich in dezelfde map bevindt als het boekhoudbestand wordt alleen de
naam 'invoice.pdf' getoond.
Als het bestand zich in de 'attachments'  submap bevindt van het boekhoudbestand wordt
de naam 'attachments/invoice.pdf' getoond.
Als het bestand zich in de bovenliggende map bevindt van het boekhoudbestand wordt de
naam '../invoice.pdf'.
Het symbool '../' betekent bovenliggende map.

"../attachments/invoice.pdf' betekent dat het bestand zich bevindt in de
'attachments' submap van de bovenliggende map.
".../.../attachments/invoice.pdf' betekent dat het bestand zich bevindt in de
'attachments' submap van de twee niveaus hoger gelegen map.

Foutmelding Bestand niet gevonden

Wanner het programma meldt dat het de file niet kan vinden, kan een van de volgende punten de
reden hiervoor zijn:

Het bestand is verwijderd of verplaatst.
Bestanden zijn gekopieerd naar of gesynchroniseerd met een andere computer en het pad naar
het bestand is absoluut.
Het boekhoudbestand is verplaatst en de bestanden hebben relatieve pad namen.
De bestandsnaam bevat ongeldige karakters voor het betreffende operating systeem:

Het programma gebruikt het '/' karakter als scheidingsteken in de pad naam maar
accepteerd ook '\'.
Karakters zoals '*' mogen niet gebruikt worden in bestandsnamen.
Zorg ervoor geen karakters zoals '*&%' te gebruiken; deze zijn geldig op MAC of Linux
maar niet voor Windows.

De kolom Koppeling
In de kolom Doclink (Transactie tabel) en de kolom Koppeling (in alle andere tabellen) kunt u een
koppeling naar een extern bestand invoeren (doorgaans een scan van een bon of een factuur).

De kolom Koppeling is doorgaans niet zichtbaar.
Om deze weer te geven gebruikt u de Kolommen instellen functie van het menu Gegevens.
Zodra de kolom Koppeling zichtbaar is kunt u de koppeling naar het digitale bestand invoeren;
u kunt ook de naam van het bestand direct aanpassen in de cel waar de koppeling was
ingevoerd, zonder iets te veranderen aan het bestand of de map waarin het geplaatst is.
Het is het beste om relatieve bestandsnamen te gebruiken ten opzichte van de map
van het boekhoudbestand (zie de vorige sectie over bestand- en padnamen).
U kunt verschillende soorten koppelingen in de cel Koppeling invoeren:

De relatieve of absolute bestandsnaam.
Een koppeling nar een internet pagina of file, voorafgegaan door 'https://' or 'http://'.
Een aangepast Url schema  (Engelstalig).
Een koppeling naar een bron in de program bronnen, bijvoorbeeld ":/image.png".
Een koppeling naar een bron in de tabel Documenten, bijvoorbeeld ":documents:doc.pdf".
Een tekst die begint met een uitroepteken '!', om in automatisch aanvullen aan te geven
in welk pad gezocht moet worden naar bestanden (zie de volgend sectie Automatisch-
aanvullen in de kolom Koppeling).
Een tekst in vierkante haken [ ], die wordt gebruikt bij zoeken bij het editen in auto-

https://developer.apple.com/documentation/xcode/defining-a-custom-url-scheme-for-your-app


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 143

aanvullen.
Handig bij het aanmaken van regels  waarbij tekst opgegeven moet worden om de
koppeling in te voeren en zoeken mogelijk te maken.

Om het gekoppelde document te openen, klikt u op het menu Gegevens > Koppelingen >
Koppeling openen, of klikt u op het icoontje dat verschijnt in de rechterbovenhoek van de cel
met de koppeling.

Een koppeling naar een bestand invoeren
Er zijn drie manieren om een koppeling naar een document in te voeren:

Het commando Koppeling toevoegen

Ga op de rij in de Transacties tabel staan en activeer het Koppeling toevoegen commando
van het menu Gegevens > Koppelingen > Koppeling toevoegen.
Selecteer het document dat gekoppeld moet worden en klik op de Open knop (het programma
voegt de koppeling dan automatisch toe).
Het programma voert de bestandsnaam in kolom Koppeling in zelfs als deze niet zichtbaar is.
Het pad naar het bestand wordt omgezet in een relatief pad t.o.v. het boekhoudbestand.

Het icoontje Koppeling toevoegen

Maak in de tabel de kolom Koppeling zichtbaar. Zie ook: Kolommen instellen.
Klik op het icoontje rechtsboven in de cel.

Geef het pad aan waar het bestand zich bevindt.

Voer de bestandsnaam direct in de cel in

De bestandsnaam van het digitale document kan direct in de cel in de kolom Koppeling worden

https://www.banana.ch/doc/nl/rules
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ingevoerd zonder het bestand te moeten selecteren in de map waarin het zich bevindt.

Op deze manier kunt u het invoerwerk nog meer versnellen.

Dubbelklik op de cel om deze te editen.
Type de bestandsnaam in of gebruik kopiëren en plakken.
De auto-aanvullen functie laat de bestanden zien van documenten die nog niet gekoppeld zijn.
Om een lijst van beschikbare bestanden te krijgen moet er tenminste één keer een bestand zijn
ingevoerd met de dialoog bestand selecteren.

Auto-aanvullen in de kolom Koppelingen
Wanneer u aan het bewerken bent in de kolom Koppelingen stelt het programma een lijst van
bestanden voor volgens de volgende logica:

Alleen bestanden waarvan de extensie is opgenomen in de lijst van veilige bestand extensies
worden voorgesteld.
De bestandsnaam bevat de tekst ingevoerd in de editor.

Als de tekst woorden bevat gescheiden door een spatie, moet de hele tekst verschijnen in
de bestandsnaam.
Als de tekst tussen vierkante haken [ ] staat wordt alleen de tekst zonder de haken
gebruikt.

Als het bestand al is gebruikt in de kolom wordt het niet meer voorgesteld.
U kunt beginnen met een ster '*' om ervoor te zorgen dat alle bestanden worden voorgesteld,
ook al zijn ze eerder gebruikt.
Op deze manier kunt u toch zoeken naar bestanden die al en de lijst van voorgestelde
bestanden staan.
Bestanden die in zoekmappen staan.
Bestanden die in mappen staan die al gebruikt zijn.
Als u het bestand 'attachments/invoice.pdf' invoert worden documenten voorgesteld die in de
submap 'attachments' zitten.
Bestanden die de tekst die u invoert bevatten.
De map werd niet uitgesloten met de commando's die hierna aangegeven worden.
Bestanden die niet boven de  Smartfill limiet gaan.

Speciale namen voor het auto-aanvullen

U kunt de zoeklogica veranderen door bestandsnamen in te voeren die beginnen met een
uitroepteken '!'.

!-**1
Schakelt auto-aanvullen uit en stelt geen bestanden voor.
Gebruik dit commando als de toegang tot mappen traag is om technische redenen.
!bijlagen
Zoek alleen naar bestanden in de aangegeven submap.
!+bijlagen
Met het '+' teken wordt ook gezocht in de aangegeven map.
!-bijlagen
Met een '-' teken wordt de aangegeven map uitgesloten. Dit heeft voorrang boven andere
commando's.
Dit kan gebruikt worden om een gebruikte folder of de folder van het boekhoudbestand uit te
sluiten.
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Speciale symbolen:
!.
De punt "." geeft de huidige map aan, waarin het boekhoudbestand zich bevindt.
Om de map uit te sluiten gebruikt u het minteken "!-.".
!map1*
 "*" aan het eind van de map naam betekent, ook alle submappen opnemen.
Als er veel submappen met veel bestanden zijn kan het zoeken vertraagd worden.
!*
Neemt de map waar het boekhoudbestand zich bevindt én alle submappen op in het
zoeken.
!map1;map2
De puntkomma ';' wordt gebruikt om meerdere mappen op te nemen in het zoeken.
!../map1
De ".." verwijst naar de bovenliggende map.

Regel voor teksten voor het opnemen of uitsluiten van mappen voor het automatisch aanvullen:

Ze moeten worden ingevoerd in de kolom Koppeling.
Ze kunnen in elke rij ingevoerd worden.
Ze bepalen het zoeken voor alle cellen, zelf voor de cellen die erboven staan.

Een koppeling aanpassen
Ga op dezelfde manier te werk als bij het invoeren van een nieuwe koppeling.

Een koppeling hernoemen
Met deze functie kunt u de koppeling veranderen/hernoemen. Het programma doet automatisch ook
het volgende:

Verandert de bestandsnaam in zijn eigen map
Verandert alle koppelingen naar dat document die voorkomen in het boekhoudbestand.

Op deze manier kunt u bestandsnamen veranderen zonder bestandsbeheer te hoeven gebruiken.

Vereisten

De functie Hernoemen vanuit het menu Gegevens is alleen beschikbaar het
Advanced plan  van Banana Boekhouding Plus > schakel nu over naar het
Advanced plan .

Meer informatie over de functie Hernoemen.

Koppeling openen
Er zijn twee manieren om een koppeling te openen:

Ga op de rij in de Transacties tabel staan en activeer het commando menu Gegevens >
Koppelingen > Koppeling openen
Ga op de Koppeling cel staan en klik op het icoontje om de koppeling te openen.

http://www.banana.ch/nl/update
http://www.banana.ch/nl/upgrade
http://www.banana.ch/nl/upgrade
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Uit veiligheidsoverwegingen opent het programma alleen bestanden die als veilig beschouwd worden,
zie Programma Opties > Bestandsbeheer van het menu Extra.

Koppeling verwijderen
Er zijn twee manieren om een koppeling te verwijderen:

Ga op de rij in de Transacties tabel staan en gebruik menu Gegevens > Koppelingen
> Koppeling verwijderen
Verwijder de inhoud van de Koppeling cel met Delete.

Naar PDF exporteren (inclusief bijlagen)
Bij het exporteren naar PDF biedt het programma de mogelijkheid om ook bijlagen op te nemen.

Zie ook de Export to PDF documentation voor deze functionaliteit en de beperkingen.

Andere nuttige informatie:
PDF bestand aanmaken met digitale bijlagen  
Map voor digitale documenten
Documenten scannen



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 147

Diverse soorten documenten

Aan de basis van de boekhouding staan de boekhoudbescheiden en de bonnen.
De organisatie van de boekhouding hangt af van de omvang van de onderneming en de hoeveelheid
documenten.
De manier waarop men dingen organiseert moet aangepast worden aan wat nodig is.
We geven een lijst van mogelijkheden die bewezen hebben erg nuttig te zijn.

De verschillende soorten documenten
Het is belangrijk de verschillende soorten documenten te onderscheiden en goed te organiseren.

Basis documenten: contracten voor de huur, telefoonabonnementen, statuten,
verzekeringscontracten en alles dat maar één keer ondertekend wordt en meerdere jaren
geldig is. Deze documenten moeten in een aparte map, die alleen dit soort papieren bevat,
bewaard worden. Het kan nuttig zijn om van een aantal van deze belangrijke documenten
(zoals bonnen voor afbetalingen, etc.) een fotokopie te maken en het origineel in een kluis of op
een veilige plaats te bewaren. Maak geen gaten in belangrijke documenten maar stop ze in
transparante kunststof mappen. Deze ordner is de basis van uw activiteit/bedrijf en u dient hier
zorgvuldig mee om te gaan.
Documenten die met werknemers te maken hebben: Contracten,
personeelsverzekeringen, en andere documenten; het is handig deze in een aparte ordner te
houden.
Als er veel documenten zijn adviseren we u een ordner per onderwerp te maken.
BTW Aangiften: Het is goed een speciale ordner met de verschillende aangiften die u
regelmatig (per kwartaal, maand of jaar) indient bij te houden. Uw BTW inschrijving en andere
algemene documenten (Kamer van Koophandel inschrijving) kunt u beter samen bewaren met
de basis documenten.
Boekhoud bonnen en documenten voor het jaar: dit zijn bonnen, facturen of andere zaken
die betrekking hebben op uitgaven of ontvangsten. Deze moeten per jaar gescheiden bewaart
worden, voor ieder jaar een ordner.

Boekhouddocumenten
Een goede dagelijkse routine is nodig om de boekhoudtransacties in te voeren en de toestand van het
bedrijf te beheersen, zoals de cashflow, de totalen van debiteuren en crediteuren, etc.

Alle boekhouddocumenten (kwitanties, facturen, bonnen) moeten 7 tot 10 jaar bewaard worden1.
(Zie deze pagina bij de Belastingdienst)
Categoriseer de boekhouddocumenten en berg ze samen met het gerelateerde bankafschrift op2.
voor betaling van de kwitantie.
De bankafschriften moeten samen met de boekhouddocumenten opgeborgen worden.3.
Nummer de boekhouddocumenten (afschriften en andere) oplopend. Met deze nummers die in4.
de Doc kolom ingevoerd moeten worden kunt u het boekhouddocument vinden met de
boekhouding als startpunt.
Druk aan het eind van het jaar een kopie van het journaal af en bewaar dit samen met de5.
boekhouddocumenten.
Gebruik voor ieder jaar een nieuwe ordner voor de boekhouddocumenten..6.

https://www.belastingdienst.nl/wps/wcm/connect/bldcontentnl/belastingdienst/zakelijk/ondernemen/administratie/administratie_opzetten/hoe_lang_moet_u_uw_administratie_bewaren
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Bij het boekhouden zijn er twee criteria voor het boeken van transacties:

Boekhouding bij levering: facturen worden alleen geregistreerd op het moment van betaling
(leveranciers) en inning (klanten).
Omzetboekhouding: facturen worden geregistreerd op het moment van ontvangst
(leveranciersfacturen) en uitgifte (klantenfacturen).

Boekhouding via het kasstelsel
Uitgaven en ontvangsten worden alleen geboekt als de facturen worden betaald of worden geïnd.

Scheid de verstuurde facturen en de facturen waarvoor u de betaling ontvangen heeft.1.
Controleer regelmatig de facturen waarvoor nog een betaling ontvangen moet worden. Zodra2.
de vervaldatum voorbij is, is het handig om een betalingsherinnering te sturen. Laat er niet
teveel tijd overheen gaan, zorg ervoor dat u de betalingen voor niet betaalde facturen
ontvangt. Dit kost tijd maar dit is belangrijk.
Nadat deze facturen zijn betaald bergt u deze op samen met de andere boekhouddocumenten.3.

Boekhouding via het factuurstelsel
Uitgaven en inkomsten worden geboekt als facturen worden verstuurd naar klanten of als facturen
worden ontvangen van leveranciers.
Zie ook pagina's over: Klanten en Leveranciers registers.

Scheid de verstuurde facturen en de facturen waarvoor u de betaling ontvangen heeft.1.
Controleer regelmatig de facturen waarvoor nog een betaling ontvangen moet worden. Zodra2.
de vervaldatum voorbij is, is het handig om een betalingsherinnering te sturen. Laat er niet
teveel tijd overheen gaan, zorg ervoor dat u de betalingen voor niet betaalde facturen
ontvangt. Dit kost tijd maar dit is belangrijk.
Als u het versturen van de factuur in de boekhouding invoert maakt u een notitie van de3.
boeking op de factuur. Gebruik de kolom Factuur in de transactie om het factuurnummer in te
voeren.
Nadat de facturen zijn betaald verplaats ze dan naar de sectie "betaald" en voer ze in de4.
boekhouding in. Als u ze heeft ingevoerd in de boekhouding maak dan een notitie van de
boekhoudtransactie op de factuur (bijvoorbeeld met een "vinkje").

Transacties / frequentie
Het is goed om de transacties regelmatig in de boekhouding in te voeren (dagelijks, wekelijks,
maandelijks).
Wij raden u ten zeerste aan om het invoeren van de boekhoudtransacties niet te verwaarlozen,
zodat u altijd over bijgewerkte informatie beschikt en de voortgang van uw bedrijf kunt
evalueren.
Door de verschillende rekeningnummers door te nemen, kunt u eenvoudig een overzicht krijgen
van de verschillende uitgaven die u heeft gedaan.
De boekhouding wordt niet alleen voor de belastingdienst gedaan.
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Beheer boekhoudbestanden lokaal, online of
in de cloud

Met Banana Boekhouding bepaalt u waar u uw gegevens opslaat. Het is echter handig om een
duidelijk systeem te hebben waarmee u makkelijk uw gegevens op kunt halen en digitale
boekhouddocumenten kunt beheren.

U kunt uw boekhouding ook in de cloud beheren met Dropbox, iCloud, Ondedrive, GoogleDrive of elk
ander systeem om gegevens te delen. U kunt deze systemen ook gebruiken om de gegevens met uw
accountant te delen.

Gegevens opgeslagen in één enkel bestand
Boekhoudgegevens worden opgeslagen in één bestand.

Gegevens voor iedere boekhouding worden opgeslagen in één bestand.
In de regel wordt een bestand gebruikt per boekjaar.
U kunt het bestand de naam geven die u wilt.
Over het algemeen wordt de bestandsnaam samengesteld uit de bedrijfsnaam en het boekjaar,
gevolgd door de extensie, "bedrijf-2020.ac2".
U kunt het bestand opslaan in de folder die u wenst.

Een lokale map.
Een netwerk map.

Banana Boekhouding is als Excel, er kan één persoon tegelijkertijd aan hetzelfde bestand
werken.
U moet opletten dat er geen andere mensen aan hetzelfde bestand aan het werk zijn.
Als u in een lokaal Windows netwerk werkt en het bestand is in gebruik, krijgt u een melding dat
het bestand alleen beschikbaar is in "alleen lezen" modus.
Voor andere operating systemen zijn er geen meldingen. Let op als u werkt met meerdere
mensen. De persoon die de gegevens opslaat overschrijft de vorige opgeslagen gegevens.

Maak een mappenstructuur
Met een geschikte mappenstructuur kunt u makkelijker uw boekhoudbestanden en gekoppelde
digitale documenten beheren en deze delen met anderen.
Om mappen aan te maken moet u de functies gebruiken die in uw operating systeem van toepassing
zijn.

De volgende overwegingen zijn handig bij het organiseren van uw bestanden:

Als u meerdere boekhoudingen beheert is het aan te raden een map voor ieder bedrijf aan te
maken.
Als u naast de boekhoudbestanden ook digitale documenten gebruikt is het aan te bevelen om
een aparte map voor ieder boekjaar aan te maken.
Iedere boeking kan gekoppeld worden aan een bestand dat bij het digitale boekhouddocument
hoort.
De boekhouding van het jaar kan beter worden opgeslagen in een sub-map van het huidige jaar
zodat het programma relatieve koppelingen aanmaakt die ook werken als u gesynchroniseerde
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bestanden gebruikt op verschillende computers.
Basis documenten die hun waarde blijven behouden worden bij voorkeur opgeslagen in hun
eigen map.

De mappenstructuur kan als volgt zijn:

[Bedrijfsnaam] "Bedrijf"
Maak de mappen voor de verschillende boekjaren aan in deze map.

Basis
Sub-map waar bestanden of gedigitaliseerde documenten die hun waarde nooit verliezen
worden bewaard, zoals huurcontracten en verzekeringen.
U kunt deze map ook gebruiken om het vaste activa register op te slaan.
2022
Sub-map waar het boekhoudbestand van het huidige jaar (bedrijf-2020.ac2) bewaard
moet worden en andere documenten die bij het huidige jaar horen en het pdf bestand,
met het overzicht, aan het eind van het jaar.

Ondersteunende documenten.
Sub-map waar u de bestanden opslaat van documenten die u heeft ontvangen of
opgehaald in elektronische vorm, of die u heeft gescand.

2023
Sub-map waar u het bestand opslaat van het volgende jaar.

Ondersteunende documenten.

Werken in een lokaal netwerk
Als uw bedrijf een lokaal netwerk gebruikt kunt u de mappenstructuur in uw lokale netwerk aanmaken
zodat deze toegankelijk is voor meerdere mensen.

In een lokaal netwerk kunt u in het algemeen toegangsrechten toekennen en daarmee het aantal
mensen beperken die toegang hebben tot de boekhoudgegevens.

Werken met systemen in de cloud
Als u Dropbox, iCloud, OneDrive, GoogleDrive of een andere gelijkwaardige service gebruikt wordt er
een map aangemaakt op uw computer die de gegevens bevat die worden gesynchroniseerd.

Om op meerdere computers te kunnen werken is alles wat u moet doen een sub-map aanmaken met
de bedrijfsgegevens in de gesynchroniseerde map met de structuur zoals aangegeven in de vorige
paragraaf. De boekhoudbestanden en de ondersteunende documenten worden automatisch
gesynchroniseerd tussen de verschillende systemen.

Deel gegevens met uw accountant
Met cloud systemen kunt u gegevens delen met anderen. U moet de mappenstructuur zoals
hierboven aangegeven aanmaken binnen de map die wordt gesynchroniseerd. Gebruik het Dropbox
commando (of een gelijkwaardig commando in een ander cloud systeem) om de map met uw
accountant te delen en hij kan dan uw bestanden bekijken en aanpassen.
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Basis documenten

Een optimale organisatie van uw documenten is een fundamenteel onderdeel van elk bedrijf. U vindt
belangrijke tips op de pagina Verschillende soorten documenten. Hierna richten we ons op de
basisdocumenten van een bedrijf die geldig blijven en daarom voor onbepaalde tijd moeten worden
bewaard.

Hier volgen enkele voorbeelden:

Contracten voor het leasen of verhuren van een object of onroerend goed.
Leasecontracten.
Documenten voor het openen van een bankrekening.
Verzekeringscontracten.
Contracten met telefoon-, gas- en elektriciteitsbedrijven.
Marketingovereenkomsten.
Abonnement op een internetdienst.
Contract voor het inhuren van een werknemer.
Contract voor de aankoop van een vast (grond) of roerend (auto) goed.

Regels voor het archiveren
In principe moeten basisdocumenten tot tien jaar na het einde van het contract worden bewaard,
tenzij de wet een andere termijn voorschrijft.

Een huurcontract moet daarom gedurende de volledige geldigheidsperiode van het contract worden
bewaard. Wanneer het contract is afgelopen, omdat het object niet langer wordt gehuurd of omdat
het is vervangen door een ander contract, moet het document worden bewaard gedurende de
wettelijke bewaartermijn.

De wettelijke of de contractvoorwaarden
Het archiveren van documenten dient om het al dan niet bestaan van een verplichting te bewijzen of
is wettelijk verplicht:

Verplichting om boeken en boekhoudkundige documenten bij te houden. Meestal 10 jaar.
Garantietermijn. Termijn waarbinnen het nodig is om gebreken te melden en de regeling ervan
aan te vragen. Om de vaststelling van gebreken te vragen.
Verjaringstermijn. De maximale tijd die de wet biedt voor een rechtsvordering. Bijvoorbeeld de
termijn waarbinnen de rechtbank om betaling van een niet-geïnde factuur moet vragen.
Verplichtingen die voortvloeien uit speciale regelingen. Specifieke bepalingen zijn bijvoorbeeld
van toepassing in de bank- of notarissector.

Documenten onbeperkt bewaren
De documenten moeten worden gearchiveerd en zorgvuldig worden bewaard in ruimtes die daarvoor
geschikt zijn.

Ze moeten zich in ruimten bevinden waarin de houdbaarheid gegarandeerd kan worden.
Voor belangrijke documenten is het nuttig om kopieën te bewaren, eventueel in digitaal
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formaat.

Bestandsmap voor "Basis documenten"

Use a filing folder for "Basic Documents".
It is also possible to use special boxes for filing. It is important that the documents are easily
available.

If you have many basic documents it is useful to separate them according to the
counterparty (name of the tenant, insurance company) or by type (insurance, banking
contracts).
Insert the original contract in the appropriate section.

More folders
Contracts and other rental documents. For real estate.
Contracts or documents relating to the hiring of staff.
You can also start with just one classifier and then you can add more.

Replacement of documents

If a contract is replaced it is still necessary to keep the previous contract. The document is
indispensable in case there is a subsequent dispute, there is a revision or you need to prove the
expense to the tax authorities.

For archived basic documents it is useful to keep a filing cabinet (or archive box).

These documents will rarely be consulted.

Indicate on the label documents archived from the year 20XX, or rental contracts or archived
personnel files

Place documents in order of archiving date.
When the vault is full, write up to the year 20XX on the label.
Create a new label.

Documents with historical value
It can be interesting to keep track of some historical elements for the company, or which are useful
for getting ideas.
Create a folder of historical documents from the outset.

The first lease
The first invoice you made
The photos of the opening of the store
The DVD with the first promotional video
The photo of the first prototype
A copy of the sales flyers

Document storage in safety deposit boxes
Important documents, which are of great value for the company and are indispensable for proving a
credit, should be kept in safety deposit boxes.
Access to the safety deposit box takes time, so it is helpful to keep a copy of the documents near you,
so that you can easily consult the contents.
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Proceed as follows:

Make a copy before storing the document in the safety deposit box.
Place the copy in the Base Documents, with a note stating that the original document is in the
safe.
Keep a list with important documents in the safe.

Digital preservation

Digitization of paper documents

It is also useful to keep copies of the Basic Documents in digital format.

You can easily make copies and store them in multiple places.

You have to check on a case-by-case basis whether it is possible to replace a paper document with a
digital copy. Before throwing away the paper original you must check that the scanned document has
the same validity and what procedures are to be followed.
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Map voor digitale documenten

Met Banana Boekhouding kunt u zonder papier werken omdat u alle ondersteunende documenten
(facturen, bonnen en meer) digitaal op kunt slaan. De transactierijen kunnen gekoppeld worden aan
de bijbehorende pdf of andere bestandstypes die de bonnen bevatten en met één klik kunt u de
inhoud ervan weergeven.

Het is handig om een speciale map aan te maken waar u alle documenten in digitaal formaat (pdf of
anders) kunt opslaan. Zie ook Uw bestanden beheren voor nuttige tips.
Om documenten makkelijk terug te vinden is het aan te raden altijd dezelfde methode te gebruiken
voor de namen van de digitale bestanden.

Maak in de map waar u het boekhoudbestand bewaart een submap met de naam
"Ondersteuningsdocumenten".

Koppelingen die bij het boekhoudbestand horen. Door een submap te gebruiken
maakt Banana Boekhouding Plus de koppelingen aan relatief t.o.v. het bestand. Zelfs als
u synchronisatiesystemen met verschillende paden op andere computers gebruikt
(bijvoorbeeld DropBox) kunt u altijd uw bestanden openen.
We raden aan om een enkele map te gebruiken voor bonnen in PDF formaat van ieder
jaar. Deze keuze is de meeste effectieve en levert goed georganiseerde documenten op.

Om veiligheidsredenen worden bij het exporteren naar PDF alleen bijlagen die gevonden
worden in dezelfde map of submap van het boekhoudbestand in de PDF opgenomen.

Voorbeeld hoe u uw mappen kunt organiseren om digitale documenten in op te slaan
 
Telkens wanneer u een digitaal document ontvangt of wanneer u dit zelf digitaliseert, zet u het
in deze map.

Het wordt aanbevolen dat de bestandsnaam de vorm heeft van "jaar-maand-dag+klant of
leverancier+document type".
Op deze manier staan de bestanden automatisch in oplopende volgorde en is het
makkelijker om ze te beheren.

2022-01-15-KPN-factuur.pdf
2022-01-31-Pieter Jansen-factuur.pdf

Voor de datum wordt aanbevolen om de datum die op het bijbehorende document
voorkomt te gebruiken.
In de map worden alle documenten gesorteerd op datum en zijn makkelijk te vinden.

Als u een transactie invoert koppel deze dan aan het digitale document via Menu Gegevens →
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Koppelingen → Koppeling toevoegen... .
Om de inhoud van digitale documenten in een bijbehorende applicatie weer te geven:

Ga op de transactieregel staan die bij het document hoort dat u wilt bekijken.
Bekijk de kolom "Koppeling" en klik op het "koppeling openen" icoon.
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Salva i tuoi file Banana anche sul Cloud

Tanti software oggi si basano e lavorano esclusivamente sul Cloud. Questo significa che per utilizzarli
occorre creare un proprio conto utente e inserire le proprie credenziali di accesso, senza necessità di
installazioni locali. Significa anche però che tutto ciò che viene fatto sul Cloud, inclusi i dati e i
documenti dell'utente sono salvati sui server di chi offre il servizio.

Banana Contabilità Plus è un software non-Cloud
Banana Contabilità Plus è un programma NoCloud (o non Cloud): viene installato sul tuo computer e
lavora localmente. Abbiamo optato per questa scelta, forse un po' contro-corrente, perché riteniamo
che i dati contabili siano particolarmente sensibili. La nostra azienda non ha alcun accesso ai dati
degli utenti.

Salva i dati dove vuoi

I tuoi dati e i tuoi file contabili appartengono esclusivamente a te. In Banana Contabilità, di solito ogni
anno contabile costituisce un file a sé, in formato .ac2.
Con Banana Contabilità Plus puoi scegliere liberamente dove salvare i tuoi dati: localmente, su
dispositivi esterni, su sistemi Cloud come Dropbox, iCloud, Onedrive, GoogleDrive, per condividerli
con altri.

In Banana Contabilità il salvataggio dei tuoi file sul Cloud è quindi una possibilità tra le
tante, una libera scelta.

Salva i tuoi file Banana sul Cloud
Banana Contabilità Plus ti permette di salvare i tuoi file anche in Cloud usando qualsiasi sistema di
gestione dei dati. Totale libertà di scelta, senza alcun costo supplementare.

Puoi scegliere il servizio Cloud che preferisci:
Dropbox, Apple iCloud, Microsoft OneDrive, GoogleDrive o qualsiasi altro servizio
pubblico.
Il tuo Cloud privato.
Se hai già un servizio Cloud  attivo non avrai oneri supplementari.

I dati della tua contabilità saranno sempre accessibili. 
Anche se il tuo abbonamento a Banana Contabilità Plus dovesse scadere, i tuoi dati
rimangono sempre in tuo possesso e accessibili.
Con  il piano Free di Banana Contabilità Plus puoi sempre leggere i contenuti dei file.
Puoi tenere delle copie su qualsiasi supporto, così da soddisfare i requisiti di legge di
tenuta e archiviazione dei dati contabili.

Puoi archiviare e condividere qualsiasi tipo di file:
I file della contabilità
I file dei giustificativi o altri documenti che colleghi alle righe di registrazione.
Altri file di Excel, Word, lettere, foto o altro, che sono relativi alla contabilità.

Puoi condividere i dati con altri
Usa le funzionalità di condivisione del tuo Cloud provider.
Puoi avere più persone che accedono ai dati.
Puoi attribuire dei permessi, solo lettura oppure scrittura.
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I dati possono essere accessibili direttamente dal web.
Puoi tenere la contabilità anche se non hai una connessione attiva su internet.

La limitazione che hai con Banana è che solo una persona alla volta può modificare lo stesso file di
contabilità. Se più persone salvano le modifiche vi è un conflitto che può risultare in perdita di dati. È
dunque una soluzione ideale per piccoli teams.

Imposta il servizio di gestione dati in Cloud
Per impostare il servizio Cloud devi seguire le istruzioni fornite dal tuo provider. Di regola il
procedimento è il seguente:

Crea l'account presso il servizio Cloud.
Installa sul tuo computer il programma per l'accesso ai dati Cloud.

Ti verranno chiesti i dati per accedere al tuo conto Cloud.
Questo programma creerà una cartella locale.
In questa cartella il programma sincronizzerà i dati con il sistema Cloud.
Quando fai delle modifiche localmente queste saranno replicate in automatico sul Cloud o
su altri apparecchi con cui ti sei collegato. 
Se non hai un collegamento Cloud puoi comunque lavorare sui tuoi file. Quando ti
ricolleghi, il programma risincronizzerà i file.
Il sistema Cloud ti permette di specificare quali cartelle e file sincronizzare in automatico.
Puoi accedere ai file sia dal tuo computer e sia da dispositivi mobili.

Installa il software Banana Contabilità Plus sul tuo computer.
Nella cartella locale del servizio Cloud:

Crea la cartella per la tua ditta o per la contabilità.
Quando crei un nuovo file di contabilità salvalo sotto la cartella che hai creato.
Crea delle sotto cartelle per organizzare al meglio i dati della contabilità.

I tuoi dati saranno così automaticamente sincronizzati in Cloud.
Puoi creare altre cartelle per altre ditte o organizzazioni.

Condividi la cartella dati con altri
Tutti i sistemi Cloud offrono la possibilità di condividere i dati con altri, funzione che può essere utile
per una piccola ditta o un'associazione. Per condividere i dati con altri la procedura è la seguente:

Crea un account con il servizio Cloud usato (di regola è gratuito).
Vai sulla cartella da condividere.

Con la funzionalità di condivisione indicha l'email dell'utilizzatore a cui deve essere
concesso l'accesso.

Puoi condividere con il numero di persone che desideri.
Puoi attribuire dei permessi di accesso (solo lettura, scrittura).

In automatico verranno anche condivise tutte le sotto cartelle.
L'utilizzatore può accedere ai dati:

Tramite l'interfaccia web
Installando sul suo computer il client di sincronizzazione dei dati

I dati saranno sincronizzati fra i diversi utenti.
Attenzione: non modificare contemporaneamente un file.
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Gestisci più ditte e condividi i dati con i clienti
Se gestisci più ditte è meglio organizzare le cartelle per facilitare la condivisione con altri. Qui ti
proponiamo una possibile organizzazione dei dati, puoi ovviamente scegliere la struttura che ritieni
più adatta.

Nella cartella locale del tuo sistema Cloud crea delle cartelle separate per ciascuno dei tuoi
clienti.
Per ogni cliente crea poi due sotto-cartelle :

Internal
Dove salvare i dati che non vuoi condividere.
Shared-[NomeDitta]

Salva qua i file che vuoi condividere con il tuo cliente.
Indica anche il nome della ditta, perché così il tuo cliente vedrà questo nome.

Condividi la cartella Shared con il tuo cliente, usando il sistema che ti mette a disposizione il
servizio Cloud.

Uso del Cloud da parte dei commercialisti
Se sei un commercialista e collabori con il tuo cliente per la tenuta della contabilità, i sistemi Cloud
possono aiutarti a rendere il processo molto semplice. 

Hai generalmente due possibilità:

Il cliente usa un proprio servizio Cloud e poi condivide i dati con te.
Tu hai un sistema Cloud sul quale salvi i dati dei clienti e condividi la cartella con il cliente.

Importante: servizio di backup dei dati
Lavorare con un sistema di sincronizzazione dei dati, è come lavorare con un sistema di rete. Quando
un utente cancella un file o una cartella dal suo computer locale, in automatico il file o la cartella
viene cancellato  anche dal Cloud. Allo stesso modo se qualcuno sovrascrive i dati, quelli precedenti
sono perduti.

È quindi importante che tu disponga di un servizio di backup:

Verifica per quanto tempo il tuo fornitore Cloud tiene delle copie dei tuoi dati cancellati. La
durata può variare in base al piano che scegli.
Il sistema ti può essere utile anche per premunirti anche da difetti hardware o attacchi
ransomware.
Può essere utile avere un sistema di backup locale, che salva i tuoi dati anche su disco.
È preferibile un sistema che impedisca la cancellazione di dati, con dei semplici comandi.

Altre risorse utili:

Organizzare le cartelle e i file della contabilità
Salvare i documenti e collegarli alle registrazioni
Digitalizzare i documenti cartacei e sincronizzarli automaticamente.
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Scan documenten met de Dropbox of een
andere app

Behalve het delen van bestanden kunt u met de apps voor Dropbox en andere cloud systemen
bonnen scannen en deze direct opslaan in pdf formaat. In vergelijking met alleen maar een foto halen
deze apps de inhoud op, ze gebruiken pdf formaat. Daarnaast kunt u meerdere documenten in
hetzelfde bestand invoegen.



Start de Dropbox app (andere systemen hebben gelijkwaardige functies die u makkelijk op uw
smartphone kunt vinden).
Gebruik het commando "Scan Document".
Maak een foto van het document. Om automatisch bijsnijden mogelijk te maken stopt u de bon
in een transparante hoes waarin een gekleurd of zwart vel papier zit.
U kunt diverse commando's gebruiken bij het voorbeeld

Indien nodig gebruikt u het roteren commando om de afbeelding recht te zetten.
U kunt een andere pagina toevoegen door de scan te herhalen.

Kies pdf formaat.
Type de bestandsnaam in en gebruik de datum die u op het document ziet. Als u niet uw eigen
bestandssysteem heeft gebruikt u het jaar-maand-dag formaat, de naam van de tegenpartij en
eventueel een toevoeging (bijvoorbeeld 2022-01-15-KPN-factuur.pdf).
Als het bestand is gesynchroniseerd op uw computer:

Kopieer het naar de map met boekhouddocumenten.
Ga naar de bijbehorende transactie in voeg de koppeling toe .

http://www.banana.ch/doc/nl/node/3352
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Ga naar...

Dit commando opent een dialoogvenster waarmee u naar de gewenste rij kunt gaan.

Wanneer men zich in een selectie-tabel bevindt, (bijvoorbeeld een rekeningkaart), brengt het
programma de gebruiker automatisch terug naar de overeenkomende rij van de Transactie-tabel door
middel van het commando Naar oorspronkelijke rij gaan.
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Hernoemen

Het commando Hernoemen (Gegevens menu) is een zeer handig hulpmiddel om wijzigingen aan te
brengen in een rekening, een BTW code of een koppeling in uw boekhouding zonder dat u elke match
handmatig hoeft op te zoeken en te vervangen. In Banana Boekhouding Plus is deze functie alleen
beschikbaar met het Advanced plan .

Het commando Hernoemen hernoemt het rekeningnummer, de categorie (Rekeningen- en
Categorieën tabel), de BTW code (BTW Codes tabel) of een link (Koppeling of DocKoppeling
kolommen) met de nieuwe tekst aangegeven in alle tabellen waarin het voorkomt of gebruikt wordt
(alle tabellen en basisgegevens). Bij het hernoemen van koppelingen wordt met deze functie ook de
naam van het gelinkte bestand aangepast in de directory waar het is opgeslagen.
 

Om te hernoemen:

plaats de muis op de cel die veranderd moet worden (rekening- of categorie-nummer, BTW-
code, koppeling)
klik op het menu Gegevens → Hernoemen
In het venster dat verschijnt, voer de nieuwe referentie  in.

Het programma:

controleert dat er geen andere rekening of groep is met het zelfde nummer; als dat zo is geeft
de software een waarschuwing en vraagt of u toch door wilt gaan. Als u doorgaat wordt een
foutmelding gegeven.
controleert waar het rekeningnummer dat hernoemd wordt in gebruik is in de tabellen en dat de
rijen niet beveiligd zijn of geblokkeerd; als dit het geval is waarschuwt het programma dat het
hernoemen niet kan plaatsvinden.
hernoemt het rekeningnummer overal waar het gebruikt wordt, in de tabellen en in de
Bestandseigenschappen, met het nieuw gespecificeerde rekeningnummer.

Let op

Het is niet mogelijk twee gelijke rekeningnummers te hebben in het rekeningschema. Het programma
voert geen herberekening uit, het hernoemt de rekeningnummers eenvoudig.

 

https://www.banana.ch/nl/update
https://www.banana.ch/nl/update
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Rijen importeren

Klik op het Rijen importeren commando van het menu Gegevens om rijen te importeren.

Activeer de opties van uw keuze in het volgende scherm:

Bestandsnaam

Gebruik de knop Bladeren om het bestand waar de gegevens uit gehaald worden te kiezen.

Opmaak

Dit is een lijst met bestandsindelingen waarmee gegevens in de tabel geïmporteerd kunnen worden.
Deze lijst bevat: ASCII formaat, Text, CSV. Kies hieruit welk formaat u nodig heeft.

Opties

Gegevens van het klembord Importeren

Hiermee kan de gebruiker gegevens vanuit het Windows klembord importeren.

Waarden automatisch aanvullen

Bij het importeren vanuit een eenvoudige naar een meer ingewikkelde boekhouding worden sommige
kolommen in de geïmporteerde rijen niet ingevuld. In dit geval wordt deze optie geadviseerd.
Hierdoor zal het programma automatisch de ontbrekende gegevens aanvullen vanuit de huidige
boekhouding.

Kolom koptekst

Door het selecteren van deze optie worden niet alleen gegevens maar ook kopteksten meegenomen
bij het importeren.
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Unicode (Utf-8)

Door het selecteren van deze optie worden alle gegevens geïmporteerd in een formaat dat leesbaar is
door Unicode programma's.
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Rijen ophalen en sorteren (Ophalen)

Deze functie is beschikbaar via menu Gegevens → Rijen ophalen en sorteren....

Dit commando is anders dan de functie Rijen sorteren omdat deze een nieuwe tabel aanmaakt waar
de opgehaalde rijen worden getoond. De rijen van de originele tabel worden niet veranderd. U kunt in
de Ophalen tabel op het rijnummer (onderstreept) dubbelklikken om terug te gaan naar de
overeenkomstige rij in oorspronkelijke tabel.

Ophalen tab
U kunt in de Ophalen tabel op het rijnummer (onderstreept) dubbelklikken om terug te gaan naar de
overeenkomstige rij in oorspronkelijke tabel.

Kolom

U moet de kolom selecteren waarvan u de gegevens wilt ophalen.

Voorwaarde

U moet de voorwaarde voor de selectie kiezen (bv. Groter, kleiner, bevat tekst, begint met, eindigt
met, ...).

Waarde

In dit veld moet u de tekst invoeren die gebruikt wordt in de vergelijking met de voorwaarde
(bijvoorbeeld, indien de voorwaarde = gelijk is, met als vergelijkingstekst 15.01.2022, dan haalt het
programma alle transacties op met de datum 15 januari 2022).
De tekst is een datum indien het gekozen veld Datum is, een numerieke waarde indien het veld een
Bedrag is, een woord indien het veld een Beschrijving is.
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Toevoegen

Met deze knop kunt u nieuwe velden toevoegen voor meer Ophaal criteria.

Alles wissen

Met deze knop kunt u alle keuzes die u gemaakt heeft voor het Ophalen wissen.

Alleen geselecteerde rijen

Deze optie is alleen beschikbaar als u rijen heeft geselecteerd. Als deze optie is aangevinkt worden
alleen de geselecteerde rijen opgehaald en gesorteerd.

Totaal rij

Met deze optie aangevinkt zal het programma de rij met totalen laten zien voor de opgehaalde rijen
die een bedrag of tijdteller bevatten.

Sorteren tab
De te sorteren kolommen kunnen worden aangegeven. De opties zijn hetzelfde als voor het Rijen
sorteren commando.

Compositie tab
De uitleg van dit tabblad staat op de algemene pagina over Compositie.

Voorbeeld met een rekeningen lijst
Soms wil je alleen een lijst met rekeningen hebben.

Ga in de Rekeningen tabel staan.
Roep het Rijen ophalen en Sorteren commando op.
In kolom kies Rekening
In Voorwaarde kies "Niet leeg"

Als u de rekeningen gesorteerd wilt hebben op Beschrijving

Ga naar de Sorteren sectie
In het Sorteren op veld geeft u de kolom "Beschrijving" aan

Als u alleen bepaalde kolommen wilt weergeven, kunt u een nieuwe weergave maken met het
commando Tabellen instellen.
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Rijen sorteren

Het Rijen sorteren commando is beschikbaar in het menu Gegevens.

In tegenstelling tot het commando Rijen ophalen en sorteren verandert deze functie de volgorde van
de rijen in tabel waarin u zich bevindt, gebaseerd op de sorteersleutels. We raden daarom aan om
zeer zorgvuldig te werk te gaan voordat u een sorteeractie start, vooral als u in de Rekeningentabel
staat, omdat de structuur van het rekeningschema aangetast kan worden.

De rijen in de tabel kunnen gesorteerd worden op de inhoud van de kolommen. Het is mogelijk
maximaal drie sorteersleutels op te geven:

Sorteren op

U kunt kiezen op welke kolom gesorteerd moet worden, het sorteercriterium.

Daarna op

Het programma geeft u de mogelijkheid nog twee andere sorteercriteria te kiezen.

Oplopend

Het sorteren gebeurt in oplopende volgorde met inachtneming van het soort gegeven van de
sorteercriteria (datum, tekst, ...)

Aflopend

Het sorteren gebeurt in aflopende volgorde met inachtneming van het soort gegeven van de
sorteercriteria (datum, tekst, ...)
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Nummer

Als de kolom die is gekozen als sorteercriterium alleen getallen bevat moet u deze optie aanvinken.

Alles wissen

Met deze knop kunt u alle keuzes die u gemaakt heeft voor het sorteren wissen.

Alleen geselecteerde rijen

Deze optie is alleen beschikbaar als u rijen heeft geselecteerd. Als deze optie is aangevinkt worden
alleen de geselecteerde rijen gesorteerd.
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Kolommen instellen

Deze functie is beschikbaar via menu Gegevens → Kolommen instellen.... Met dit commando
kunnen kolommen worden weergegeven, verborgen, hernoemd of verplaatst worden naar links of
rechts in de verschillende tabellen.

Weergeven Tabblad
Koptekst

Dit is de koptekst van de kolom.

Koptekst2

Deze koptekst wordt door het programma alleen gebruikt voor enkele velden (b.v. de kolom Bedrag).

Beschrijving

Dit is de beschrijving van de kolom. Deze beschrijving wordt getoond als tooltip.

Opmaak

Dit is de opmaak die gebruikt wordt om getallen, datum en tijd weer te geven (zie hoofdstuk over
formaten  aan het eind van deze pagina).

Breedte

Dit veld bepaalt de horizontale maat van de kolom.

Kolom stijl

Dit is een drop-down menu dat de stijl aangeeft die gebruikt moet worden. Deze stijl heeft voorrang
op de stijl van de rij.

https://www.banana.ch/doc10/nl/node/2710/#1
https://www.banana.ch/doc10/nl/node/2710/#1
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Uitlijning

De gebruiker kan in dit drop-down menu kiezen om de tekst rechts of links te laten uitlijnen of te
centreren.

Tekstterugloop

Deze optie geeft de gebruiker de mogelijkheid om de tekst in een cel over meerdere regels te
verdelen.

Beveiligd

Deze optie geeft de gebruiker de mogelijkheid om de kolom te beveiligen zodat geen gegevens
kunnen worden ingevoerd of aangepast.

Niet afdrukken

Als deze optie is aangevinkt wordt de kolom niet meegenomen bij het afdrukken.

Zichtbaar

Met deze optie kan de gebruiker de kolom zichtbaar maken.

Tabellen kunnen worden veranderd. Velden kunnen worden toegevoegd, kopteksten veranderd en
kolombreedtes en de volgorde waarin de kolommen worden weergegeven kunnen worden aangepast.

Naar boven, beneden verplaatsen

De kolommen staan weergegeven in de volgorde waarin ze in de tabel weergegeven worden. De
zichtbare kolommen zijn voorzien van een vinkje. De volgorde is eenvoudig te veranderen door de
naam te verslepen met de muis of door de knoppen Naar boven verplaatsen of Naar beneden
verplaatsen te gebruiken.

Toevoegen

Voeg nieuwe kolommen toe aan de actieve tabel. Kolommen die toegevoegd worden door de
gebruiker zijn alleen informatief; het programma doet geen berekeningen op numerieke gegevens.
Als u een kolom van het type bedrag toevoegt wordt in sommige gevallen de door de gebruiker
ingevoerde gegevens gebruikt in berekeningen. Kolommen met bedragen worden alleen in de
volgende tabellen opgeteld:

Rekeningentabel,
Rekeningkaartentabel,
Tabel met opgehaalde rijen.

Verwijderen

Deze knop wordt gebruikt om een kolom te verwijderen van een lijst. Een systeem kolom kan echter
niet worden verwijderd.

Instellingen Tabblad
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Naam

Voer de veldnaam van de toe te voegen kolom. Het programma zet de kolom automatisch in de lijst.

XML naam

Dit is de naam van het actieve veld in de Xml indeling en wordt automatisch ingevuld door het
programa.

Gegevenstype

U kunt kiezen uit de volgende voorgedefineerde types: Tekst, Nummer, Bedrag, Datum en Tijd.

Max. and Min. lengte

Maximun and minimum veld lengte.

Max. and Min. Waarde

Het is mogelijk de minimum en maximum waarden in te voeren (nummers of karakters).

Decimaalpunten

Het is mogelijk het aantal cijfers achter de komma in te stellen.

Kolom-nummer

Dit is het nummer dat automatisch wordt gegeven aan een kolom, en is er alleen voor technische
doeleinden.

Alles in hoofdletters

Door deze optie aan te vinken worden alle gegevens in de kolom in hoofdletters weergegeven.

Standaard Datum en getallen formaat
Als het programma eenmaal is geïnstalleerd gebruikt het automatisch de standaardinstellingen van
uw operating systeem.

Als u de instellingen van uw operating systeem wilt veranderen moet u naar Configuratiescherm
(Windows) of Systeem Voorkeuren (Mac) gaan.

Dit gaat stap voor stap zo in Windows 8 en Windows 10:

vanuit het Start menu ga naar het Configuratiescherm
Klik op Land/regio
een dialoogvenster verschijnt waarin u het datumformaat kunt wijzigen (in de Notaties tab)
om ook getallen of valuta formaten te veranderen klikt u in hetzelfde venster op de knop Meer
instellingen... en dan op de betreffende tab voor getallen, valuta, etc.

Dit gaat stap voor stap zo in Mac OS X 10.9.5:

klik op Systeemvoorkeuren vanuit het Apple logo (linksboven in uw scherm)
kies het Datum en tijd icoon in het dialoogvenster dat verschijnt
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er verschijnt een nieuw scherm waarin u Open taal en zone... kunt kiezen
er verschijnt een nieuw scherm waarin u op de knop Geavanceerd kunt klikken
tenslotte verschijnt er een nieuw scherm waarin u het getallen formaat (tab Algemeen) en het
datum en tijd formaat (Datum en Tijd tabs) kunt veranderen.

Datum, tijd en nummer opmaak
Als geen specifiek formaat wordt gespecificeerd wordt het standaard Windows formaat gebruikt
(datum, tijd en getallen zoals aangegeven in het configuratiescherm).

Binnen Banana Boekhouding, kan alleen het weergaveformaat worden veranderd.
Om het invoerformaat te veranderen (bij het veranderen van een waarde) moet u de
instellingen van uw besturingssysteem aanpassen.

Om het formaat te veranderen klikt u op Gegevens → Kolommen instellen en voert u het gewenste
type in het Opmaakveld in. De opmaaktypen worden hieronder weergegeven met voorbeelden.

Opmaak datum Voorbeelden van een datum
d mm yy 31 01 15
dd m yy 31 1 15
ddd d mmm yyyy vr 2 jan 2015
dddd dd mmmm yyyy vrijdag 02 januari 2015
De letter “d” (dag) geeft de dag aan, de "m" (maand) de maand en de "y", dus niet "j", (jaar) het jaar.
Opmaak ti Voorbeelden van tijd
hh:mm:ss:zzz 04:04:36:089
h:m:ss:zz 4:4:36:89
Natuurlijk kunt u de volgorde van de onderdelen van de datum en tijd naar wens omkeren (b.v. mm
dd yyyy).
Als scheidingsteken kunt u alle scheidingstekens van het toetsenbord gebruiken (b.v. #, @, -, /, .,
etc.).
Opmaak getallen Voorbeeld voor getallen
0. 259
0.00 258.85
0.000 258.848
Het aantal decimalen in een getal kan aangepast worden aan de wensen van de gebruiker. Werkelijke
berekeningen worden gemaakt met alle ingevoerde decimalen. Afronding gebeurt alleen bij het
weergeven op het scherm.
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Nieuwe kolom

Via Gegevens  → Kolommen instellen kunt u uw eigen kolommen toevoegen.

Naam
Voer de naam in van de kolom die toegevoegd moet worden.

XML naam
De naam van de kolom zoals deze in XML weergegeven wordt en gebruikt wordt in scripts.

Gegevens type
Het is mogelijk te kiezen tussen de volgende voorgedefinieerde types: Tekst, Nummer, Bedrag,
Datum, Tijd.
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Tabellen instellen

Dit commando wordt geactiveerd via het menu Gegevens > Tabellen instellen.

De Tabellen:
Dit zijn de elementen die de gegevens bevatten in de vorm van rijen en kolommen.
 
De Weergaven;
Aangegeven onder de tabelnaam van alle tabellen
Dit zijn de elementen die bepalen hoe de kolommen van de tabel worden weergegeven.
Met de weergaven kan men bepalen welke kolommen zichtbaar moeten zijn, de volgorde van
de weergegeven kolommen en de manier waarop deze worden weergegeven.

Om tabellen toe te voegen gebruikt u het commando Nieuwe functies toevoegen van het menu Extra.

Weergave instellingen
Voor iedere tabel kunt u bepalen:

Naam
De naam van de tabel in de bestandstaal. Dit veld kan geen spaties of speciale karakters
bevatten.
De naam kan alleen van toegevoegde tabellen veranderd worden.
XML naam
Deze naam wordt gebruikt voor de programmering. Dit veld kan geen spaties of speciale
karakters bevatten. De naam kan alleen van toegevoegde tabellen veranderd worden.
Koptekst
De naam die in de tabellijst verschijnt.
Zichtbaar
Geeft aan of de tabel zichtbaar is of niet.
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Weergaven beheren
Naam
Het is mogelijk een nieuwe naam voor de geselecteerde Weergave in te voeren.

XML naam
Dit is de Weergave naam voor de XML export functie. Voor systeem Weergaven kan deze naam niet
worden veranderd.

Nummer
Dit is een nummer dat automatisch aan de Weergave wordt gegeven door het programma.

Zichtbaar
De Weergave zal zichtbaar zijn als deze checkbox is aangevinkt.

Systeem
Als deze checkbox is aangevinkt is de Weergave een systeemweergave en kan niet worden
verwijderd of aangepast.

Kolommen instellen...
Laat de Kolommen instellen pagina zien waarmee deze aangepast kunnen worden, zowel door deze
weer te geven als voor het instellen ervan.

Pagina-instelling...
Deze knop brengt u naar de Pagina instellingen.

Weergave toevoegen...
Deze knop voegt een nieuwe Weergave toe aan de active tabel.

Verwijderen...
Deze knop verwijdert een Weergave.

Default instelling

Bepaalt dat de geselecteerde Weergave als standaard weergave wordt gebruikt.
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Nieuwe weergave

Naam van de weergave
Voer de naam in van de weergave die u wilt toevoegen.

Naam van de weergave XML
Dit is de weergave naam voor in de XML uitvoer.

Na de creatie wordt de nieuwe weergave op dezelfde plaats weergegeven als de bestaande
weergaven en wordt deze aan de rechterkant van de andere weergaven toegevoegd.
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Menu Opmaak

In het menu Opmaak zijn de volgende commando's aanwezig:

Standaard stijl

Dit is de standaard stijl voor het hele bestand.

Punts

U kunt diverse lettertypegroottes instellen met 8pt, 10pt, etc.

Vet en Cursief

Markeert tekst in de geselecteerde cel of rij met vetgedrukt of schuingedrukt.

Standaardstijl wijzigen

Er is een standaardstijl voor het bestand. De standaardstijl wordt gebruikt als een rij toegevoegd
wordt.

Om de standaardstijl te wijzigen:

pas de gewenste stijl toe op een rij;
kies van menu Opmaak → Standaardstijl wijzigen.

Alle rijen met de oorspronkelijke standaardstijl worden vanaf nu getoond in de nieuwe standaardstijl.

Rijhoogte berekenen

Als de tekst in een cel in een rij erg lang is zorgt het commando Rijhoogte berekenen van het menu
Opmaak ervoor dat de tekst helemaal zichtbaar wordt door de hoogte van de rij aan te passen.

Om de hoogte van de rij aan te passen moet de gebruiker:

het Gegevens → Kolommen instellen commando kiezen;
de bijbehorende veldnaam kiezen;
de Tekstterugloop optie in het Weergave tabblad activeren;
het commando Rijhoogte berekenen van het menu Opmaak uitvoeren voor iedere keer dat
dit nodig is.

Alle Rijhoogten berekenen

Dit commando Alle rijhoogten berekenen werkt op dezelfde manier als het vorige commando maar
dan op alle rijen van de tabel.

Alle Rijhoogten opnieuw instellen

Stelt alle rijhoogten opnieuw in op de standaardwaarde.
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Pagina-einde

Op elk punt in het bestand kan de gebruiker een pagina-einde invoegen.
Om een pagina-einde in te voegen:

plaats de cursor op de eerste rij waar de nieuwe pagina moet beginnen;
Kies het Opmaak → Pagina-einde commando.

Om een pagina-einde te verwijderen:

plaats de cursor op de rij met het pagina-einde;
open het menu Opmaak en kies het Pagina-einde commando opnieuw waardoor de pagina
einde verdwijnt.
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Rijen markeren door middel van kleuren

Door regels te kleuren is het makkelijker in één oogopslag verschillende typen transacties te
onderscheiden.

Om regels te markeren moet u deze selecteren en dan op één van de volgende twee icoontjes

klikken: 
Het eerste icoontje zet de achtergrondkleur, het tweede de kleur van de tekst.

Om de markering op te heffen selecteert u de rij of rijen en klikt op Geen kleur/Automatisch (aanwezig
in het menu van ieder icoontje).
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Menu Extra

Onder dit menu vindt u de volgende commando's:

Bestandsinfo
Nieuwe functies toevoegen / verwijderen...
Copie bestand creëren...
Naar nieuw bestand converteren
Bestand samenvoegen
Programmaopties
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Bestandsinfo

Het Bestandsinfo commando van het menu Extra laat de eigenschappen van het boekhoudbestand
zien.

Kolommen
Door op weergave Compleet te klikken worden ook de XML kolommen weergegeven waarmee het
mogelijk is om gegevens automatisch over te dragen als de tabel geëxporteerd wordt.

Sectie: de Groepnaam van de waarden
ID: de specifieke en explicite identificatie van de waarde
Beschrijving: geeft een uitleg van de waarde
De rijen die vetgedrukt worden weergegeven zijn de sectietitels die de diverse elementen
groeperen
Waarde: de opgemaakte waarde
Sectie in XML: de naam van de sectie in het Engels
ID in XML: de identificatie in het Engels
Waarde in XML: de inhoud van het veld in XML formaat.

De Sectie in XML en de ID in XML identificeren de waarde ondubbelzinnig.
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Nieuwe functies toevoegen

Het Nieuwe functies toevoegen commando is te vinden in het menu Extra.

Met deze optie kunt u tabellen toevoegen die helemaal door de gebruiker beheerd worden.
Om een nieuwe functie toe te voegen moet u de functie die u nodig heeft selecteren.

De beschikbare opties zijn afhankelijk van het bestandstype.

Zie de pagina Boekhoudfuncties toevoegen voor meer details per afzonderlijke optie.
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Tabel Documenten

Met de tabel Documenten kunt u teksten, afbeeldingen of programmeerscripts opnemen in uw
boekhoudbestand.

De tabel kan op twee manieren worden toegevoegd:

Door de gebruiker via het menu Extra → Functies toevoegen... → Documenten tabel toevoegen.
Deze tabel wordt automatisch aangemaakt bij het opslaan van documenten (bv bij het
toevoegen van het logo of bijlagen aan de Uitgebreide Balans of Uitgebreide Balans op groepen
van het menu Rapporten → Bijlagen tabblad.

De tabel Documenten heeft de volgende kolommen:

Id
Dit is de naam van het document.
Documenten waarvan de naam begint met een "_" hebben een speciale betekenis.

"_budget.js"
Hierin kunt u specifieke functies voor de Budget tabel invoeren.
De dlgmanageaddons Id wordt gebruikt om de afbeelding die als logo wordt gebruikt op
te slaan.
De attachment_ Id wordt gebruikt voor bijlagen in de uitgebreide balans.

Beschrijving
Een korte beschrijving van het bestand (optioneel)
Bijlagen
Bevat het bestand.
Door op de cel te klikken kunt u de inhoud van het bestand bekijken of veranderen.

There are these types of possible content
Image (image/png, image/jpg)
Normal text (text/plain)
Formatted text html (text/html),
Programming in javascript (text/javascript)
Sheet style CSS (text/css).
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Een nieuwe bijlage toevoegen

Voeg een nieuwe rij toe
Voer in de kolom Id de bestandsnaam in
In de kolom DBschrijving kunt u de benodigde tekst invoeren
Klik in de kolom Bijlage op de cel, of kies het Edit symbool, kies het soort afbeelding en kies
het plaatje dat u wilt invoegen in de afdruk.
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Editor Markdown

In Banana Contabilità Plus gli allegati di bilancio ora si possono inserire anche tramite linguaggio
markdown, oltre che in html. È molto comodo per inserire delle tabelle negli allegati.

Disponibile in Banana Contabilità Plus solo con il piano Advanced , o nei piani
Professional e Free con l'Advanced in modalità dimostrativa  (70 registrazioni) →
passa ora al piano Advanced .

Il Markdown è un linguaggio che permette di creare del testo formattato usando un normale editore di
testo e una sintassi semplice da scrivere e  leggere. 

In Banana Plus è possibile utilizzare questo linguaggio negli allegati della tabella Documenti e sono
supportate le specifiche GitHub Flavored Markdown .

Documentazione pubblicata da github.com:

Formattazione di base
Formattazione avanzata
Mastering Markdown

Aggiungere un documento Markdown
Selezionare la tabella Documenti
Aggiungere una nuova riga.
Nella colonna Id scrivere un nome che identifica il documento.

https://www.banana.ch/it/update
https://www.banana.ch/doc/it/appmsg_it_info_license_extended_startupmode
https://www.banana.ch/it/upgrade
https://github.github.com/gfm/
https://docs.github.com/en/articles/basic-writing-and-formatting-syntax
https://docs.github.com/en/articles/working-with-advanced-formatting
https://guides.github.com/features/mastering-markdown/
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Nella colonna Descrizione si può scrivere il testo desiderato.
Nella colonna Allegati fare doppio clic sulla cella oppure selezionare il simbolo di modifica,
selezionare il tipo Testo Markdown. 

Aggiungere un allegato di bilancio con testo markdown

Esempio di sintassi markdown per creare una tabella
Per creare delle tabelle in markdown , il contenuto delle colonne deve essere dal segno barra
verticale, preceduto e seguito da uno spazio " | ".
Per l'allineamento della colonna si deve creare una riga con

Sinistra: semplici trattini (minimo tre trattini).
Centrato: trattini preceduti e seguiti dal duepunti ":---:".
Destra: trattini seguiti dal duepunti "---:"

# Notes to the Balance (Example)

The financial statements of Example have been prepared in accordance with the
International Financial Reporting Standards (IFRS).

## Cash Positions

| Account | Description | Current Year | Previous Year |
| :---: | --- | ---: | ---: |
| 1000 | Cash  | 23'000.00 | 17'000.00 |
| 1020 | Bank account| 9'000.00 | 1'000.00 |
| | **Total** | **32'000.00** | **18'000.00** |

## Other Fixed Assets

| Account | Description | Current Year | Previous Year |
| :---: | --- | ---: | ---: |
| 1000 | Machinery | 13'000.00 | 17'000.00 |
| 1020 | Furniture | 5'000.00 | 4'000.00 |
| | **Total** | **18'000.00** | **21'000.00** |

https://docs.github.com/en/github/writing-on-github/working-with-advanced-formatting/organizing-information-with-tables
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Copie bestand creëren

You can activate the command from the Tools menu → Create file copy.

This feature allows you to create a new file, identical to the existing one.  You can choose to copy the
file with the following options:

Keep Opening balances. If the option is activated, the opening balances of the copied file will be
shown in the new file.
Keep Transactions. If this option is activated, transactions of the copied file will be shown in the
new file.
Keep Recurring transactions. If this option is activated, the recurring transactions of the copied
file will be shown in the new file.

This feature is very useful when you want to make test changes and have the confidence that you can
go back without losing data.

If none of the options are activated, a new file will be created only showing the same accounting plan.

The new file must be saved with a name.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 188

Naar nieuw bestand converteren

Het commando wordt geactiveerd via menu Extra > Naar nieuw bestand converteren.

In het dialoogvenster dat verschijnt is het bestandstype waarmee u aan het werk bent geselecteerd
en een lijst van mogelijke keuzes wordt getoond:

Deze opdracht converteert een bestaand bestand (dat niet wordt veranderd) in een ander bestand
met andere eigenschappen:

Verander taal
Verander afronding
Verander het soort bestand Bijvoorbeeld:

Van een boekhouding zonder BTW naar een met BTW
Van een Dubbel-boekhouden naar een Vreemde-valuta boekhouding

Het is alsof u een nieuw leeg bestand heeft gemaakt en daarna de gegevens er handmatig in
overgebracht.

De kenmerken van de bestaande file kunnen bekeken worden met het commando Extra >
Bestandsinfo

Aanmaken en gegevensoverdracht
Het commando menu Extra > Naar nieuw bestand converteren:

Maakt een nieuw bestand aan van het gespecificeerde type met voorgedefinieerde1.
kolominstellingen
Brengt de gegevens over naar het nieuwe bestand, intussen de nodige conversies uitvoerend2.
Slaat het nieuwe bestand op onder een naam die het soort bestand aangeeft.3.

Bij het converteren van een bestand met meer opties naar één dat er minder heeft, zal een deel van
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de gegevens verloren gaan tijdens de conversie. Als men bijvoorbeeld een boekhoudbestand met
BTW converteert naar een boekhoudbestand zonder BTW, dan gaan alle gegevens in de BTW
kolommen verloren tijdens de conversie.

Overgang van een Dubbel-boekhouden naar een Vreemde-
valuta boekhoudbestand

Zorg ervoor dat in Bestands- en boekhoudingseigenscappen het valuta symbool wordt
gespecificeerd dat de basisvaluta wordt
Kies de boekhouding met vreemde valuta als doel
Het programma maakt een boekhouding met vreemde valuta aan waarbij de bestaande
gegevens behouden blijven:

De Transactiestabel bevat de kolommen om de vreemde valuta te beheren zoals het
valuta bedrag, de valuta en de wisselkoers 1,000
De bestaande rekeningen in de Rekeningentabel worden aangevuld met het basis
valutasymbool

U dient de standaard rekeningen voor Wisselkoerswinst en - verlies toe te voegen
In de Bestands- en boekhoudingseigenschappen dient u de standaard rekeningen
voor Wisselkoerswinst en - verlies aan te geven.

De Wisselkoersentabel is leeg; het is daarvoor nodig de valuta's en wisselkoersen die in
de transacties gebruikt worden toe te voegen
In de Rekeningentabel moeten de vreemde valuta toegevoegd worden.

Om de valuta van een boekhoudingsbestand te veranderen, zie de tabblad Boekhouding van
Bestands- en Boekhoudingseigenschappen.

Overgang van een boekhouding zonder BTW naar een met
BTW

Kies het gewenste boekhoudtype met BTW als doel
Het programma maakt een boekhouding aan met BTW kolommen waarbij de bestaande
gegevens behouden blijven:

Voegt de BTW rekeningen toe aan de Rekeningenkaart
De Bestandsinfo met betrekking tot de BTW moet kompleet gemaakt worden en de
standaard rekening, waarop de BTW geregistreerd moet worden, moet aangegeven
worden
Via Acties > Naar boekhouding importeren > BTW codes kunnen de betreffende
percentages uit de BTW codes tabel worden gebruikt.

Parameters voor het aanmaken van een nieuw bestand
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Voor meer informatie raadpleegt u de betreffende pagina.
 

Gerelateerde pagina's:

BTW Beheer

https://www.banana.ch/doc10/nl/node/2619
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Bestand samenvoegen

Dit commando wordt geactiveerd via Extra → Bestand samenvoeten....

Het is mogelijk twee bestanden samen te voegen maar dan moeten ze wel van het zelfde soort zijn
(bijvoorbeeld twee dubbel-boekhouden bestanden). Het is niet mogelijk verschillende soorten
bestanden samen te voegen (bijvoorbeeld een dubbel-boekhouden bestand en een Inkomsten &
Uitgaven bestand).

Om twee bestanden met goed gevolg samen te voegen is het belangrijk dat ze dezelfde
rekeningnummers hebben. Ga als volgt te werk:

Open het bestand waarin de gegevens van beide bestanden samengevoegd gaan worden
Selecteer het Bestand samenvoegen commando van het menu Extra
Selecteer het pad en de naam van het bestand dat samengevoegd moet worden
Bevestig de samenvoeg operatie
Als de bestanden niet helemaal hetzelfde zijn, ook al zijn ze van de zelfde soort, (bijvoorbeeld,
boekhouding met BTW en boekhouding zonder BTW), dan verschijnt een waarschuwing voor
mogelijk gegevensverlies.
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Programmaopties

De instellingen voor het programma zijn te vinden via menu Extra → Programmaopties. Hier zijn
diverse technische instellingen te vinden voor het programma.

In de volgende pagina's vindt u meer gedetailleerde informatie.

Interface
Editor
Bestandsbeheer
Geavanceerd

Systeeminfo
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Algemeen

De interface opties zijn te vinden via menu Extra → Programmaopties → Algemeen.

Programmaopties

Taal

Dit is de taal die door het programma wordt gebruikt. U kunt deze instelling veranderen als u een
andere dan de standaardtaal wilt gebruiken of als uw taal niet beschikbaar is als de standaardtaal.

Lettertype

Hiermee kunt u het gewenste lettertype kiezen.

%in-/uitzoomen

Hiermee kunt u de lettergrootte in de tabellen groter en kleiner maken als u dat wilt.

Het zoom percentage kan ook worden veranderd met de schuifregelaar of in het vakje aan de
rechterkant van de statusbalk.
Het doel van zoom is de inhoud van de tabel aan te passen aan de grootte van het venster.
Voor de grootte van de tekst van menu's, dialogen en iconen worden de instellingen van het
operating systeem gebruikt maar deze kunnen ook door de gebruiker aangepast worden.

Negatieve getallen in rood weergeven

Door deze optie te gebruiken worden negatieve getallen in rood weergegeven in de tabellen.
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Opstart

Controleren op updates

Met deze optie geactiveerd maakt het programma een verbinding met de website Banana.ch  en
controleert of er een update is voor de versie die nu in gebruik is.

Startpagina weergeven

Met deze optie geactiveerd laat het programma na het starten eerst de nieuwspagina zien.

Laatst gebruikte bestanden tonen

Met deze optie geactiveerd laat het programma in het menu Bestand de laatst gebruikte bestanden
zien.

Webserver starten

Met deze optie geactiveerd kunnen Banana Boekhoudgegevens benaderd worden vanuit externe
programma's.

Voor meer informatie zie Integrated Webserver (Engelstalig)

https://www.banana.ch/nl/node/11181/
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Editor

De Editor opties zijn te vinden via menu Extra → Programmaopties → Editor.

Gedrag

Tabel met een enkele klik bewerken

Met deze optie geactiveerd is een enkele klik op een geselecteerde cel genoeg om deze te
kunnen aanpassen.
Als deze optie niet is geactiveerd is een dubbelklik nodig om de geselecteerde cel aan te
kunnen passen.

Tekst automatisch aanvullen

Met deze optie geactiveerd selecteert het programma automatisch de eerste tekst in de
drop-down lijst en vult deze in in de rij waar u bezig bent.

Optellen tijdens selectie

Met deze optie geactiveerd telt het programma geselecteerde bedragen op. Zet deze optie uit als dit
instant optellen andere bewerkingen vertraagt. U kunt niet aansluitende bedragen selecteren door de
Crtl toets ingedrukt te houden en dan de gewenste cellen ieder apart te selecteren met de linker muis
knop.

Met Enter, ga naar de volgende rij

Met deze optie geactiveerd gaat de cursor naar de volgende rij als de Enter toets wordt ingedrukt.
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Invoer

Maximum aantal ongedaan gemaakte bewerkingen

Voer het maximum aantal bewerkingen in dat ongedaan gemaakt kan worden met het menu
Bewerken → Bewerking ongedaan maken (één bewerking per keer ongedaan maken).

Rijbeperking in Smart Fill

Bij het invoeren van gegevens leest het programma de gegevens die eerder ingevoerd zijn en
probeert de invoer aan te vullen. Als er veel rijen zijn kan deze functie het invoeren van data
vertragen. De gebruiker kan een limiet voor het aantal rijen instellen waarboven de smart-fill niet
gebruikt wordt. Als er geen waarde wordt opgegeven of 0 dan wordt Smart Fill altijd gebruikt.
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Bestandsbeheer

De opties voor Bestandsbeheer zijn te vinden via menu Extra → Programmaopties →
Bestandsbeheer.

Documenten opslaan

Dit gedeelte bevat de volgende opties voor het opslaan van documenten.

Automatisch opslaan bij het sluiten van documenten

Als deze optie is geactiveerd worden de gegevens iedere keer als het bestand gesloten wordt
automatisch opgeslagen.

Autorecover informatie elke

Met deze optie kan de frequentie (in minuten) van het automatisch opslaan worden ingesteld. Het
programma slaat de gegevens op in een document genaamd autobackup+bestandsnaam. Als het
programma of de computer ermee stopt kunt u de gegevens herstellen door dit bestand te openen en
het in het bestandsmenu op te slaan als.

Reservekopie aanmaken (.BAK)

Bij het opslaan met dezelfde naam wordt de eerdere versie van het bestand hernoemd met de BAK
extensie.
Zie de pagina Een bestand openen en opslaan voor meer informatie.

Bestandsextensie
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Extensies van bestanden die veilig worden geacht

Deze optie definieert de bestandstypes (bijvoorbeeld: "pfd", "jpg", ... ) en de url schema's
(bijvoorbeeld: "http:", "x-devonthink-item:", ...) die geopend mogen worden met een dubbelklik in de
kolom Documentkoppeling van de transactietabel. Hierdoor wordt u beschermd tegen het openen van
onveilige bestanden of schema's. Extensies moeten zonder punt aan het begin ingevoerd worden en
schema's met een dubbele punt aan het eind.

Standaardinstellingen herstellen

Als op deze knop geklikt wordt zet het programma veranderde instellingen terug op de
standaardwaarde.
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Geavanceerd

De opties voor Geavanceerd zijn te vinden via menu Extra → Programmaopties → Geavanceerd.

Pdf

TrueType-lettertypen inschakelen

Als deze optie is ingeschakeld, wordt het op het tabblad Interface geselecteerde lettertype gebruikt
bij het afdrukken van PDF-bestanden, anders wordt een native PDF-bestandstype (Helvetica of Times
New Roman) gebruikt. Deze optie moet worden uitgeschakeld als de tekst in de gegenereerde PDF-
bestanden onleesbaar is.

Systeem info
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Deze sectie geeft informatie over het besturingssysteem en de werkomgeving weer. Deze informatie
kan worden opgevraagd door technische ondersteuning. Klik in dit geval op de knop Naar klembord
kopiëren en plak de gegevens in een e-mail bericht of het contactformulier.
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Menu Rapporten

Menu Rapporten commando's in verschillende toepassingen
Het menu Rapporten bevat commando's om verschillende boekhouddocumenten weer te geven en
af te drukken. De te gebruiken commando's zijn verschillend afhankelijk van de gekozen applicatie.

Door op de verschillende links te klikken worden de webpagina's weergegeven met gedetailleerde
informatie over de diverse commando's.

Cash Manager
Rekening / Categorie kaarten
Journal per periode
Uitgebreide rekening
Uitgebreide rekening op groepen 
Boekhoudingsoverzichten
BTW overzicht (alleen voor Cash Manager met BTW optie)

Inkomsten & Uitgaven boekhouding
Rekening / Categorie kaarten
Journal per periode
Uitgebreide balans
Uitgebreide balans op groepen 
Boekhoudoverzichten
Klanten
Leveranciers
BTW overzicht (alleen voor de Inkomsten & Uitgaven boekhouding met BTW optie)

Dubbel boekhouden en vreemde valuta boekhouding
Rekening kaart
Journal per periode
Uitgebreide balans
Boekhoudoverzichten
BTW overzicht
Klanten
Leveranciers

Time sheet
Maandelijks Rapport
 

Vaste activa register
Toon Journaal
Items overzicht
Transacties overzicht
 

Voorraad
Voorbeelden van afdrukken
 

Offertes en facturen
Gegevens archiveren
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Bibliotheek en collecties
Laat niet ingeleverde items zien
Gegevens archiveren
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Menu Acties

In het menu Acties vindt u de volgende commando's:

Totalen opnieuw berekenen
Boekhouding controleren
Transacties op datum sorteren
Vervaldatums weergeven
Terugkerende transacties
Transactions blokkeren
Nieuw jaar aanmaken
Beginsaldi bijwerken
Naar boekhouding importeren

Door op de verschillende links te klikken wordt u doorgestuurd naar de webpagina's met
gedetailleerde informatie over de diverse commando's.
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Menu Extensies

Banana Extensies
Dit zijn uitbreidingen van de functionaliteiten van het programma, voor rapportering, berekening,
exporteren, importeren, opstellen van facturen en betalingsherinneringen en andere.

Ze moeten worden ingesteld door de gebruiker, door te klikken op de juiste knop in het
dialoogvenster Extensies beheren vanuit het menu Extensies, bijvoorbeeld In boekhouding
importeren.

De uitvoering vindt plaats via het Extensies menu of binnen de specifieke functionaliteit
(bijvoorbeeld: Naar boekhouding importeren in menu Acties).

Het Extensies menu laat alle reeds geïnstalleerde Banana Extensies zien die gebruikt kunnen
worden in het bestand dat op dit moment geopend is. Door een commando te selecteren wordt de
aangegeven extensie uitgevoerd.

Extensies beheren
Via het commando Extensies beheren.... kunt u zoeken, installeren, uw instellingen wijzigen of
Banana Extensies verwijderen.

Een nieuwe Extensie installeren
Voor informatie over het installeren van een nieuwe extensie bezoekt u onze pagina Extensies
beheren....

Technische informatie over BananaApps
Meer technische informatie over Banana Extensies

Het zijn programma's in Javascript die gebruik maken van API's die beschikbaar zijn in Banana
Boekhouding.
Ze zijn zeer veilig en kunnen geen functies uitvoeren die een impact kunnen hebben op het
besturingssysteem.
Single Extensies.
Een tekstbestand met de .js-extensie, dat een programma in Javascript bevat dat de kenmerken
van een Banana Extensie aangeeft.
Extensie package
Een gecomprimeerd bestand met de extensie .sbaa, dat verschillende andere bestanden kan
bevatten die nodig zijn voor de toepassing, zoals commando's, afbeeldingen, dialogen. Een
pakket kan meerdere commando's bevatten. De titel van het pakket en de commando's die het
bevat zijn aangegeven in het menu Extensies.
Als u een pakket uitschakelt, worden alle Extensies uitgeschakeld.
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Benodigdheden voor het draaien van extensies
De commando's voor het uitvoeren van Banana Extensies zijn alleen beschikbaar als het huidige
bestand (het bestand waaraan u werkt) de karakteristieken heeft die de Extensies vereisen. Als een
Extensie niet zichtbaar is in het Extensies Menu of niet uitvoerbaar is, komt dat omdat geen van
deze karakteristieken aanwezig is.

Extensies zijn beschikbaar in een specifieke context:

Productiviteit
Commando's die kunnen worden opgeroepen in het Extensies Menu.
Importeren.
Beschikbaar via het commando Naar boekhouding importeren van het menu Acties.
Exporteren.
Beschikbaar in het menu Extensies. De gebruiker moet aan het einde van het proces de
bestandsnaam definiëren.
Factuurrapport
Bereidt de af te drukken facturen voor. Beschikbaar via Rapporten → Klanten → Facturen
afdrukken.
Rapport betalingsherinneringen
Bereidt de af te drukken betalingsherinneringen voor. Beschikbaar via het
Betalingsherinneringen afdrukken.... commando (menu Taken -> Klanten).
Overzichten
Bereidt de af te drukken overzichten voor. Beschikbaar via Rapporten → Klanten →
Herinneringen afdrukken.
Overzichten afdrukken
Bereidt de af te drukken overzichten voor. Beschikbaar via Rapporten → Klanten →
Overzichten afdrukken.

Associatie via een bestandstype.
Extensies die vereisen dat het huidige bestand bijvoorbeeld een boekhoudbestand is, of één
van het type Dubbel boekhouden of een adressen bestand.
Associatie via een eigenschap.
Sommige Apps zijn alleen uitvoerbaar als het betreffende woord is gespecificeerd in de
Bestands- en boekhoudingseigenschappen, tabblad Andere (vanuit het menu Bestand).
Bijvoorbeeld, als een lijst van beheerders afgedrukt moet worden, met vereiste specifieke
kolommen, is het woord "Beheerder" nodig.

Het Ontwikkelen van een eigen extensie

Iedereen kan Banana Extensies maken die de functionaliteit van het programma uitbreiden. Kennis
van programmeren is echter vereist.

Om een Banana extensie te ontwikkelen is het beter te starten vanaf een bestaand project.

Begin met een bestaand project van de github.com\BananaAccounting  site
Lees vooral de documentation for developpers op onze website, (Engelstalig)
Installeer de extensie met het Extensies beheren commando (van het menu Extensies).

https://github.com/BananaAccounting
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Extensies beheren

Met dit dialoogvenster kunt u Banana Extensies installeren, instellingen aanpassen en verwijderen.
Om een Extensie uit te voeren moet u deze eerst installeren.

Een nieuwe Extensie installeren
Ga als volgt te werk om een Extensie te installeren:

Kies land en taal
Kies in het linkermenu Online
Selecteer het soort Extensie (bijvoorbeeld productiviteit)
Zoek de gewenste Extensie op in de lijst of typ en het Zoekveld de naam van de Extensie die u
wilt gebruiken.
Klik op de knop Installeren
Klik op de knop Sluiten

De beschikbare Extensies worden hieronder weergegeven (de afbeelding is een voorbeeld):

De geïnstalleerde extensie is zichtbaar in het Menu extensies.

Opmerking

Als het Extensies venster niet de hele lijst extensies laat zien moet u deze bijwerken of de
zoekopdracht uitbreiden door te kiezen voor elk land, elke taal en Alles in het lijstje met types.

Als de hele lijst niet het formaat van uw bank bevat moet u afschriften aanvragen in het universele
ISO 20022 formaat. Binnenkort zullen alle banken de verschillende formaten (csv, MT940...)
vervangen door het Europese standaard ISO 20022 format.
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Lijst met Extensies
Deze lijst toont de geïnstalleerde Banana Extensies en de Extensies die voor installatie beschikbaar
zijn.

Geïnstalleerde Extensies worden links uitgelijnd weergegeven. Extensies die uit meerdere
opdrachten bestaan worden voorafgegaan door het groter dan teken ">".
De naam van de Extensie
Informatie over de Banana Extensie die in de lijst geselecteerd is:

Beschrijving
Link naar meer informatie, opent de gerelateerde internetpagina
laatste update
Banana Extensie datum en tijd
Lokale Banana Extensie datum en tijd (voor het geïmporteerde bestand)
Categorie
Soort Extensie, bijvoorbeeld Factuurherinnering
Land
Land waar de Extensie gebruikt kan worden, "Universeel" geeft aan dat de Extensie in
meerdere landen gebruikt kan worden
Taal
Taal van de Extensie
Knop Installeren
Download de Banana Extensie voor lokaal gebruik.

Informatie over geïnstalleerde Extensies
Het ">"-symbool voor een package geeft aan dat het een Banana Extensies-pakket is, dat
meerdere commando's bevat.
Geactiveerd
Als er in dit selectievakje geen vinkje staat werkt de Extensie niet. Voor een pakket
kunnen losse commando's gedeactiveerd worden.
Automatisch bijwerken
Als er in dit selectievakje een vinkje staat wordt de Extensie automatisch bijgewerkt
Vereiste eigenschappen.
Om een Extensie goed te laten functioneren, moeten deze worden ingesteld in Bestand →
Bestands- en boekhoudingseigenschappen → Andere
Eigenschappen toepassen knop
Past de nieuwe eigenschappen voor uw bestand toe
Knop Uitvoeren
Voert de geselecteerde Extensie uit.
Deze knop is alleen zichtbaar als de Extensie van toepassing is binnen uw huidige
bestand.
Bijvoorbeeld, een vreemde valuta Extensie werkt alleen in een bestand dat is aangemaakt
als een vreemde valuta boekhoudingsbestand.
Knop Instellingen
Sommige Extensies staan het aanpassen van instellingen toe voor de uitvoering van hun
taak. Dit is gerelateerd aan uw huidige geopende bestand. Als u dezelfde Extensie met
een ander bestand gebruikt moet u misschien andere instellingen gebruiken.
Bijvoorbeeld in facturen overzichten kunnen we hiermee de elementen vastleggen die
voor het afdrukken nodig zijn.
Knop Deïnstalleren
Verwijderd de Extensie of het pakket.
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Extensies zoeken

Banana Extensies worden weergegeven met de volgende selectie criteria:

Taal
Land
Zoektekst
Geïnstalleerd
Laat de geïnstalleerde Extensies zien.
Online
Laat de Extensies zien die online beschikbaar zijn.
Systeem.
Laat de voorgeïnstallerde Extensies zien. U kunt deze activeren of de-activeren met het
selectievakje.

Details weergeven
Er verschijnt een lijstje met:

De "laatst bijgewerkt" datum van de Extensie.
De categorie van de Extensie.
Het land waar de Extensie gebruikt kan worden.
De taal van de Extensie.
De URL waar de source van de Extensie gevonden kan worden.

Instellingen
Als de Extensie de mogelijkheid heeft parameters in te stellen (Engelstalig) is de knop Instellingen
actief.
Als dit het geval is worden dialogen weergegeven waarmee vaste parameters, die voor deze extensie
gebruikt worden, ingesteld kunnen worden.
De parameters hebben betrekking op elk bestand.

Aanpassen
Hiermee kunt u de geselecteerde Extensie aanpassen. Ga naar de folder waar het bestand van de
Extensie file is opgeslagen.

Deïnstalleren
Dit verwijdert de geselecteerde Extensie permanent. U kunt geen systeem extensies verwijderen of
die voor alle gebruikers geïnstalleerd zijn.
Op dit moment is het niet mogelijk extensies te verwijderen die in een bestand zijn opgeslagen met
de naamextensie .sbaa. Als u deze wilt verwijderen moet u het bestand verwijderen.

Meer informatie... (knop aan zijkant)
Brengt u naar de gekozen Extensie info pagina
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Toevoegen vanuit bestand...
Hiermee kunt u een Banana Extensie toevoegen vanuit een lokaal bestand. Dit is vooral bedoeld voor
de ontwikkeling van Extensies..

Het bestand moet altijd in dezelfde map blijven.
Als de Extensie wordt veranderd zal het programma altijd de laatste versie gebruiken.

Toevoegen vanuit url...
Voegt een nieuwe Extensie toe vanuit een link naar een document op internet.

Het bestand wordt gedownload van het internet.
Het bestand wordt opgeslagen in de gebruikersfolder.

Extensies bijwerken
Download de meest recente versie van de extensies van de Banana Boekhouding server.
De gedownloade extensie moeten niet veranderd worden omdat ze overschreven worden bij het
bijwerken.
Als er nieuwe extensies zijn worden deze aan de lijst toegevoegd. Geïmporteerde extensies worden
niet aangepast.

De Extensies worden geïnstalleerd in de gebruikersmap. Alleen de gebruiker die de nieuwe Extensies
importeerde of de beschikbare Extensies bijwerkte kan deze zien. Een handmatige installatie
procedure moet gebruikt worden om Extensies te installeren voor alle gebruikers of op
systeemniveau.

Banana Boekhouding werkt de geïnstalleerde extensies automatisch bij tijdens de start van iedere
toepassing. De automatische controle wordt één keer per dag gedaan bij de eerste start.
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Extensie Instellingen

Bij enkele extensie kunt u parameters instellen die door de extensie gebruikt worden.

De parameters kunnen worden ingesteld en veranderd met het dialoogvenster.
Bij het starten worden de parameters ingesteld op de standaardwaardes.
De parameters zijn gerelateerd aan het boekhoudbestand.
Een extensie pakket kan meerdere extensies bevatten en daardoor kunnen er meerdere
parameters per pakket zijn.

Extensies Instelling Dialoog
De inhoud van de dialoog is verschillend voor iedere extensie. Als voorbeeld wordt de dialoog voor de
UNI10 factuur getoond.

Invoergebied voor waardes

De instellingen dialoog is opgedeeld in onderdelen die sub-onderdelen bevatten, ieder met:

Kolom Eigenschap.
Dit is de naam van de eigenschap.

Kolom Waarde.
Dit is de waarde van de eigenschap. Door te klikken kunt u een waarde invoeren, een
ingestelde veranderen of een bestaande verwijderen.
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Knoppen

Onderaan de dialoog zijn de volgende knoppen te vinden:

Help.
Deze knop brengt u naar de documentatiepagina van de extensie die u aan het gebruiken
bent.

Standaardinstellingen herstellen
Door op deze knop te klikken worden alle standaardinstellingen van de kolom Waarde
hersteld.

Annuleren.
Annuleert de gemaakte veranderingen en sluit de dialoog.

Ok.
Bevestigt en slaat de ingevoerde parameters op. Als u deze per ongeluk heeft opgeslagen
kunt u terug naar de vorige situatie met de Annuleren knop.

Toegang tot de instellingendialoog
U kunt de instellingendialoog op de volgende oproepen:

Vanuit Extensies beheren, door op de knop Instellingen aan de rechterkant te klikken.
Via de knop Instellingen in het Afdrukken/Afdrukvoorbeeld van het overzicht aangemaakt door
de extensie.
Voor facturen, via Rapporten → Klanten → facturen afdrukken , Layout sectie, Instellingen
knop.

http://www.banana.ch/doc/nl/node/8295
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Een Extensie offline installeren

Om een Extensie offline te installeren gaat u als volgt te werk:

Ga op een andere computer die een internetverbinding heeft naar onze Extensies  pagina
Download de Extensie die u nodig hebt (een .js of .sba bestand) en sla dit op een USB stick of
ander apparaat op
Kopieer de Extensie op de computer zonder internet verbinding
Open Banana Boekhouding op uw computer zonder internet verbinding en open uw
boekhoudbestand
Klik op Extensies → Extensies beheren
Klik op de knop Toevoegen vanuit bestand... en kies het pad waar u de Extensie opgeslagen
hebt
De Extensie wordt nu opgenomen in de geïnstalleerde Extensies en in het menu Extensies.

https://www.banana.ch/apps/nl/node/8536
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Afdrukken Etiketten

Met Extensies → Etiketten → Afdrukken kunt u adressen afdrukken. In diverse tabbladen kunt u
instellingen kiezen van het formaat van het etiket tot de selectie van de adressen die gesorteerd en
afgedrukt moeten worden. Elke instelling kan opgeslagen worden in Aanpassingen.

De uitleg van de tabbladen vindt u op de volgende pagina's.

Opties
Etiket
Ophalen
Sorteren
Aanpassing
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Opties

Plaats van het eerste etiket

Bepaalt de plaats van het eerste etiket. Bij voorbeeld, als een 1 wordt ingevoerd in de velden Begin
etiket horizontaal en Begin etiket verticaal, dan verschijnt het etiket op de linkerbovenhoek op de
pagina.

Aantal exemplaren per etiket

De waarde 1 in dit veld betekent dat slecht één exemplaar van ieder etiket gewenst is.

Waarschuwen als tekst etiket overschrijdt
Met deze optie aangevinkt zal het programma de gebruiker waarschuwen met een foutmelding als de
tekst buiten de grenzen van het etiket valt.

Opmaak etiketten

U kunt kiezen tussen de etiketten formaten die in de lijst staan.
Als het door u gewenste formaat niet in de lijst staat kunt u met de knop Veranderen... het
Etiketten - formaten dialoogvenster waar u de door u gewenste instellingen kunt kiezen.

Gegevens

Geeft de bron aan van de gegevens voor de etiketten die afgedrukt moeten worden:

Tabel - de gegevens uit de huidige tabel (Rekeningen, Transacties, Budget, Totalen, BTW code)
worden afgedrukt. Als gegevens ophalen was uitgevoerd dan worden alleen de opgehaalde
gegevens afgedrukt.
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Alleen geselecteerde rijen - alleen de eerder geselecteerde adressen worden afgedrukt.
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Etiket

Lijst velden

Dit is een lijst van alle mogelijke etiketten velden; u kunt op twee manieren een veld toevoegen:

Dubbel klik op een element in de lijst
Klik op een element in de lijst en bevestig met de Veld toevoegen knop.

De geselcteerde velden worden toegevoegd op de plaats van de cursor in het Etiketten weergeven
gebied. U kunt de velden direct toevoegen door de naam ervan in te voeren omgeven door < Kleiner
dan en > Groter dan symbolen.

Etiketten weergeven

Hier wordt de plaatsing van de velden weergegeven. De vermeldingen "<NAAM VELD>" worden
vervangen door de overeenkomstige waarde in de tabel.

De symbolen Groter dan en Kleiner dan scheiden de velden van elkaar. Om deze symbolen in de tekst
te laten verschijnen:
type "\<" i.p.v. "<";
type "\>" i.p.v. ">"
en type "\\" i.p.v. "\"

Regelinvoer en spaties behouden.
Als deze optie uitstaat houdt het programma geen rekening met eventuele spaties en lege rijen.
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Ophalen

De uitleg van dit tabblad staat op de pagina Rijen ophalen en sorteren (Ophalen) van het menu
Gegevens.
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Sorteren

De uitleg van dit tabblad staat op de pagina over Rijen sorteren van het menu Gegevens.
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Aanpassing

De uitleg van dit tabblad staat op de algemene pagina over Aanpassing.
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Etiketten - formaten

U kunt de etiketteninstellingen bereiken via Extensies → Etiketten → Formaten.

Het programma levert al veel voorgedefinieerde etikettenformaten; het is echter mogelijk de
standaard instellingen aan te passen en ook persoonlijke instellingen aan te maken met het
Aanpassing (Standaard) commando.
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Pagina opmaak - Opties

Pagina

Linkermarge, Rechtermarge, Bovenste marge, Onderste marge
Voer de grootte in centimeters in; als er geen getallen worden ingevoerd zijn de marges nul.

Aantal horizontale etiketten
Voer het aantal etiketten in dat naast elkaar op de bladzijde staan.

Aantal verticale etiketten
Voer het aantal etiketten in dat onder elkaar op de bladzijde staan.

Liggend afdrukken
De pagina wordt horizontaal (liggend) afgedrukt als dit vakje is aangevinkt.

Etiketten van rechts naar links
De etiketten worden afgedrukt van rechts naar links en van boven naar beneden.

Etiket

Linkermarge, Rechtermarge, Bovenste marge, Onderste marge
Het is mogelijk de marge voor elke etiket in te voeren; de waarde van de etikettenmarges moet in
centimeters ingevoerd worden.

Tekst horizontaal centreren
Kies deze optie om de tekst horizontaal te centreren op ieder etiket.
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Tekst verticaal centreren
Kies deze optie om de tekst verticaal te centreren op ieder etiket.

Tekengrootte

Basisformaat
Dit veld laat de standaard tekengrootte zien.

Automatisch, maar niet kleiner dan
Het programma berekent de maximale tekengrootte voor een gegeven etiket, beginnend op 14 punts
aflopend tot 8 punts. De berekening wordt gemaakt rekening houdend met zowel de hoogte als de
breedte van het etiket. Als een etiket een regel tekst heeft die te lang is (of te veel rijen om af te
drukken), dan wordt een foutmelding gegeven. Zelfs al is het niet compleet, dan wordt het etiket toch
afgedrukt.

Opmerking:
Printers drukken niet af op het hele oppervlak van de pagina omdat ze minimum marges nodig
hebben. Het programma probeert de etiketten aan te passen aan de marges die de printer nodig
heeft.
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Pagina opmaak - Aanpassing

Alle instellingen die zijn gezet in de "Opties" tab kunnen worden opgeslagen door Aanpassingen te
gebruiken en kunnen weergegeven worden als dat nodig is.
Voor meer informatie over dit tabblad raadpleegt u de algemene pagina over Aanpassing.
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Menu Favorieten

Favorieten zijn weergaven van afdrukken of overzichten met aangepaste instellingen.

Het menu Favorieten laat een lijst van alle aangemaakte Aanpassingen zien en kan indien nodig
opgeroepen worden.

Het menu Favorieten wordt niet standaard weergegeven maar verschijnt als een gebruiker
aanpassingen aanmaakt waarbij hij aangeeft dat deze in het menu moeten verschijnen (de eerste
keer moet het bestand even worden gesloten en opnieuw geopend om dit te laten gebeuren).
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Aanpassing

Een Aanpassing is een weergave of afdruk met aangepaste instellingen die kan worden opgeslagen.
Aanpassingen kunnen weer opnieuw worden gebruikt voor het afdrukken van documenten zonder dat
de instellingen opnieuw gedaan hoeven te worden.

Aanpassingen kunnen vanuit de volgende menu's gedaan worden, voor de volgende documenten:

Rapporten voor:
Rekeningkaarten
Uitgebreide Balans
Uitgebreide Balans op groepen
Boekhoudoverzichten
BTW overzichten

Bestand voor:
Pdf bestand aanmaken
Bestand exporteren

Gegevens voor:
Rijen ophalen en sorteren
Rijen ophalen

Extensies - voor Adressen aanpassing.

Zo gaat u te werk
Afhankelijk van het document dat gecreëerd moet worden begint u met op het betreffende menu en
commando te klikken (Rekeningkaarten, Account cards, Financiële overzichten, Bestand exporteren
...).

In het dialoogvenster dat verschijnt:

Klik op de tab Aanpassing.
Klik on de knop Nieuw.
Voer de naam van de nieuwe compositie in.
Kies de gewenste opties in de verschillende secties.
Klik op de knop Toepassen.
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Iedere aanpassing verschijnt in het menu van het overeenkomstige commando en kan aangepast,
hernoemd, gedupliceerd of verwijderd worden.

Naam

Voer een naam in om de aanpassing te identificeren (bijvoorbeeld Onderverdeling per kwartaal
overzicht).

Beschrijving

Voer de beschrijving in van de aanpassing.

Dit venster elke keer weergeven

Wanneer deze optie is geactiveerd wordt de dialoog voor het aanpassen van de instellingen getoond.
Als deze optie niet is geactiveerd wordt het afdrukvoorbeeld van het aangevraagd overzicht (Balans,
overzicht, etc.) meteen getoond.

In menu weergeven (afhankelijk van het menu/commando waarin men zich bevind)

Als deze optie is geactiveerd verschijnt de aanpassing in het menu van het commando.

In het 'Favorieten' menu weergeven

Als deze optie is geactiveerd verschijnt de compositie in het menu Favorieten.

Alleen lezen

Als deze optie is geactiveerd is het niet mogelijk de instellingen te veranderen.
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Nieuw

Met deze knop kunt u een nieuwe compositie aanmaken.

Verwijderen

Met deze knop kunt u een bestaande aanpassing verwijderen.

Dupliceren

Met deze knop kunt u een aanpassing dupliceren.

Importeren...

Met deze knop kunt u een aanpassing importeren vanuit een ander Banana Boekhouding bestand.

Toepassen

Met deze knop kunt u de gekozen instellingen voor de nieuwe compositie opslaan.

Weergave in het menu waarmee u begint
Afhankelijk van het menu waar u zich in bevindt worden de Standaard compositie en uw opgeslagen
persoonlijke composities getoond.

Aanpassing (Standaard)

Dit is de aanpassing die standaard gebruikt wordt door het programma, als er geen andere
aanpassing was aangemaakt.

In het volgende voorbeeld wordt het menu van de Boekhoudoverzichten getoond.

Directe toegang tot de aanpassingen
In de tabellen waar de aanpassingen worden getoond en in de voorbeeldweergaves worden het
menu aanpassing en het instellingen icoon getoond. Dit maakt het mogelijk gemakkelijk van de
ene aanpassing naar de andere te gaan en dit geeft snel toegang tot de instellingen voor het geval
dat u deze wilt aanpassen.
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Venster menu

Nieuw Venster
Dit commando opent een nieuw venster met dezelfde inhoud als het reeds geopende venster.

Naast elkaar
Met dit commando kunt u binnen het Banana Boekhouding Plus programma de verschillende
bestanden zien, naast elkaar weergegeven, die tegelijk open zijn. Als u twee beeldschermen heeft is
het erg handig het Banana Boekhouding Plus programma te gebruiken met op ieder scherm een
geopend boekhoudbestand. Op deze manier heeft u meer overzicht. Meer informatie vindt u hierna.

Twee bestanden tegelijk bekijken

De twee bestanden worden met hetzelfde programma weergegeven. Het informatievenster
onderaan het scherm verandert naar het bestand waarin u met de cursor aan het werk bent.

Er zijn twee manieren om twee of meer bestanden op hetzelfde moment te bekijken.

Twee bestanden naast elkaar openen in Banana Boekhouding

Open de twee bestanden via Bestand > Open.
Klik menu Venster > Naast elkaar.

Het Banana Boekhouding Plus programma tweemaal openen

Open het Banana Boekhouding Plus programma tweemaal vanaf het Windows startmenu.
Open een boekhoudbestand in ieder programma,

Dit werkt heel goed als u een breed scherm heeft of twee monitors verbonden aan dezelfde
computer.
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Volgend venster of vorig venster
Met deze commando's kunt van het ene naar het andere venster overschakelen. De toetscombinatie
Ctrl + Tab is hiervoor ook erg handig.

Waarschuwingsberichten, Geluidssignaal, Berichten wissen
In het gedeelte dat is gereserveerd voor berichten kunt u kiezen of en hoe deze worden
weergegeven. Als u Berichten wissen activeert worden alle berichten in het informatievenster
verwijderd.

Weergave
Het commando is momenteel beschikbaar in de Banana Dev Channel-versie  en stelt u in staat om
de weergave van de volgende opties aan te passen:

Menu Ontwikkeling tonen
Bekijk meer informatie op de pagina Menu Ontwikkelen.
Toon de cell-editor
Als de weergave is uitgeschakeld, wordt de editor voor het schrijven van tekst niet boven aan
de knoppenbalk weergegeven, maar u kunt nog steeds tekst schrijven in elke cel.
Toon Rij editortoets
Indien geactiveerd, wordt de knop om de rij-inhoud te bewerken weergegeven. Door
rechtsonder op de knop rijeditor te klikken, wordt een venster weergegeven waarin het mogelijk
is om de enkele rijen via een formulierweergave te bewerken. Deze modus is ontworpen om de
invoer van teksten op tablet of mobiele apparaten te vergemakkelijken.
Toon het informatievenster
Indien uitgeschakeld, worden het onderste informatievenster, grafieken en berichten niet
weergegeven.
Toon de statusbalk
Indien uitgeschakeld, wordt de statusbalk onderaan het venster, waar het rijnummer en de
zoominstelling worden getoond, niet weergegeven.
Weergavethema  
Met deze optie kunt u de donkere modusfunctionaliteit  instellen in de volgende modi:

Systeemstandaard -  de instelling wordt overgenomen van uw besturingssysteem.
Donker -  de donkere modus is ingesteld.
Helder  -  de  heldere modus  is ingesteld.

Voorbeeldvenster
Met dit commando kunt u het document in een voorbeeldweergave bekijken.

Openingspagina
Met dit commando kunt u kiezen of u de openingspagina wilt weergeven of niet.

Lijst van geopende bestanden
Onderaan het menu Venster worden alle bestanden die op dit moment geopend zijn in Banana
Boekhouding Plus getoond. Het bestand dat nu in gebruik is wordt als geselecteerd weergegeven, de

https://www.banana.ch/nl/insiderprogram
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andere blijven op de achtergrond.
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Menu Ontwikkelen

In Banana Boekhouding Plus is deze functie alleen beschikbaar met het Advanced plan .

Ontwikkelaars opties

Bevat handige opties voor ontwikkelaars van scripts, apps of web pagina's voor Banana Boekhouding
Plus.

Screenshot activeren (Ctrl + 3)

Als deze functie is geactiveerd kunt u met de toetscombinatie Ctrl + 3 afbeeldingen van de tabellen
en dialoogvensters van het programma opslaan.
Zie ook Schermafbeeldingen maken.

Debug paneel tonen

Als deze optie actief is wordt  'Debug output' (Engelstalig) weergegeven in het onderste gedeelte
van het programmavenster. Alle debug informatie wordt weergegeven in dit paneel. Door middel van
de debug informatie kunt u het correct functioneren van het programma verifiëren tijdens het
uitvoeren van scripts, apps of aanroepen van de webserver. Deze informatie is bedoeld voor
ontwikkelaars van scripts, apps of web pagina's. Zie pagina Debugging (Engelstalig) voor meer
informatie.

Systeeminfo

Dit gedeelte geeft informatie weer over het besturingssysteem en de werkomgeving. Deze informatie
kan worden opgevraagd door technische ondersteuning. Klik in dit geval op de knop Naar klembord
kopiëren en plak de gegevens in het e-mailbericht of het contactformulier.
 

https://www.banana.ch/nl/update
http://www.banana.ch/doc/en/node/4735
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Schermafbeeldingen maken

Voor deze functie gebruikt u de sneltoets Ctrl+3. Hiermee kunt u een schermafdruk van het
programma maken en opslaan.
Om deze functie te gebruiken moet deze activeren via het menu  → Ontwikkelen →  Screenshot
activeren (Ctrl + 3). Hiervoor moet het menu Ontwikkelen geactiveerd zijn via Venster → Menu
ontwikkeling.
Dit is handig om documentatie te maken, omdat het alleen het gedeelte van het programmavenster
vastlegt waarin u geïnteresseerd bent.

Het beeld vastleggen

We adviseren u om bij het maken van een schermafdruk 90% vergroting te gebruiken zodat er meer
gegevens in het plaatje passen maar u toch leesbare teksten krijgt.

Alles weergeven
Maakt een afbeelding van het hele Banana venster.
Tabel en informatievenster weergeven
Maakt alleen een afbeelding van de tabel en het informatievenster eronder (zonder menu's,
knoppenbalk en statusbalk).
Tabel weergeven
Maakt alleen een afbeelding van de tabel
Kolommen weergeven
Maakt alleen een afbeelding van de tabel en alleen tot het maximum aantal kolombreedte
(zonder spaties).

Venster verkleinen tot (aantal pixels)

Verkleint het programmavenster tot een ingestelde grootte zodat u altijd dezelfde grootte heeft als u
meerdere schermafdrukken maakt.

Verbergen / Weergeven van vensteronderdelen

Hiermee kunt meer tabelrijen zichtbaar maken, door de knoppenbalk, het informatievenster en de
statusbalk te verbergen.

Windows  - Hoe de vensterschaduw te verwijderen
Windows 8 en 10 "verbeteren" hun dialoogvensters door er een schaduw aan toe te voegen. Bij het
maken van een schermafdruk ziet u daardoor de achtergrond.

Om dit te voorkomen kunt u als volgt te werk gaan:

Type Sysdm.cpl in het Windows zoekvak
Ga naar de sectie Geavanceerd
Instellingen voor visuele effecten
Vink de optie Schaduw onder vensters weergeven uit.
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Help Menu

Het menu Help geeft toegang tot de volgende commando's.

Gebruikers-handleiding - toegang tot all documentatie en uitleg over alle technische en
boekhoudkundige onderwerpen
Sneltoetsen - lijst van alle sneltoetsen met gedetailleerde beschrijving van het gebruik ervan
Controleren op updates... - controleert, via onze website, of er een nieuwere versie van de
software  is
Support center  - toegang tot de Banana ondersteuning web pagina
Abonnement beheren
Het dialoogvenster om uw abonnement te beheren met de volgende informatie:

Het e-mailadres waarmee u zich geregistreerd heeft en de mogelijkheid dit te
verwijderen.
Het plan dat u in gebruik heeft en de vervaldatum.
Link om uw versie met een Product Key te otgrendelen.
Link om een abonnement te kopen of te verlengen.
Link waarmee de beschikbaarheid van een bijgewerkt abonnement gecontroleerd kan
worden.

About Banana Boekhouding+ - Open een venster dat informatie geeft over het programma
zoals versienummer, serienummer, Copyright, ...

https://www.banana.ch/nl/download
https://www.banana.ch/nl/download
https://www.banana.ch/nl/support
http://www.banana.ch/doc/nl/activate
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Sneltoetsen

U kunt de lijst met sneltoetsen ook direct raadplegen door vanuit het programma het commando
Sneltoetsen te kiezen van het menu Help.

Windows sneltoetsen
Mac sneltoetsen

Windows sneltoetsen
Boekhoudtoetsen Beschrijving
F9 Voer een eenvoudige controle uit.
Shift+F9 Voer een algehele controle uit.

F6
Deze sleutel voert verschillende functies uit afhankelijk van de
kolom die de gebruiker bewerkt. De functies worden toegelicht in
het informatievenster.

Alt+ Klikken met linkermuisknopDe rekeningkaart of de tabel Rijen ophalen tonen wanneer men op
een rekeningnummer klikt.

. (Punt) In een datum-kolom, voer de huidige datum in.
Bewerkingstoetsen Beschrijving
Enter, Tab Ingetoetste tekst bevestigen en één cel verder gaan.
Alt+Enter Ingetoetste tekst bevestigen en één rij verder gaan.
Shift+Tab Ingetoetste tekst bevestigen en terugkeren naar de vorige cel.
F2 Cel-inhoud bewerken.

Dubbele klik Cel-inhoud bewerken. Onder de programmaopties, kunt u aangeven
dat de cel-inhoud met een enkele klik bewerkt kan worden.

Backspace, Spatie De inhoud van de huidige cel verwijderen en de inhoud bewerken.
Backspace Het voorgaande letterteken verwijderen.
Delete De volgende lettertekens verwijderen.
Ctrl+C Geselecteerde tekst of cellen kopiëren.
Ctrl+V Geselecteerde tekst of cellen plakken.
Delete Inhoud van de selectie verwijderen.
niet toegewezen Verwijder tekst vanaf de cursor naar het einde van de cel.
F4 Kopieer de vorige cel van dezelfde kolom.
Shift+F4 Kopieer de vorige cel van dezelfde kolom en ga één cel vooruit.
Ctrl+Shift+C Geselecteerde rijen kopiëren.
Ctrl+Shift+V Gekopieerde rjien invoegen.
Ctrl+- Geselecteerde rijen verwijderen.
Ctrl+D Geselecteerde rijen dupliceren
Ctrl++ Rijen invoegen voor de positie van de cursor.
Ctrl+Enter, Ctrl+Return Voeg één rij toe onder de positie van de cursor.
Verplaatstoetsen Beschrijving
Links Schuif naar links.
Rechts Schuif naar rechts.
Omhoog Schuif naar boven.
Omlaag Schuif naar beneden.
PgUp Schuif één scherm-pagina naar boven.
PgDown Schuif één scherm-pagina naar beneden.
Home Schuif naar het begin van de rij.
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Einde Schuif naar het eind van de rij.
Ctrl+Home Schuif naar de linker bovenhoek van de tabel.
Ctrl+Einde Schuif naar de rechter onderhoek van de tabel.
Ctrl+Links Schuif naar boven naar de rand van het huidige gegevensgebied.
Alt:Omhoog Rijen naar boven verplaatsen
Alt+Omlaag Rijen naar beneden verplaatsen
Ctrl+Rechts Schuif naar rechts naar de rand van het huidige gegevensgebied.
Ctrl+Omhoog Schuif naar boven naar de rand van het huidige gegevensgebied.
Ctrl+Omlaag Schuif naar beneden naar de rand van het huidige gegevensgebied.
Alt+PgDown Volgende weergave.
Alt+PgUp Vorige weergave.
Ctrl+PgDown Volgende tabel.
Ctrl+PgUp Vorige tabel.
Ctrl+Tab Volgend venster.
Ctrl+Shift+Backtab Vorig venster.

F5 Ga naar de gewenste rij door het intoetsen van het rijnummer in het
actieve venster.

Shift+F5 Naar oorspronkelijke rij gaan.
Selectietoetsen Beschrijving
Shift+PgUp Selecteer kolom zich verplaatsend naar boven, pagina per pagina.
Shift+PgDown Selecteer kolom zich verplaatsend naar beneden, pagina per pagina.
Shift+Links Selecteer rij aan de linkerkant.
Shift+Rechts Selecteer rij aan de rechterkant.
Shift+Omhoog Bovenste kolom selecteren.
Shift+Omlaag Onderste kolom selecteren.
Shift+Home Terug naar het begin van de rij selecteren.
Shift+Einde Vooruit tot einde van rij selecteren.
Ctrl+Shift+Home Terug naar top van tabel selecteren.
Ctrl+Shift+Einde Vooruit naar het einde van tabel selecteren.
Ctrl+A Gehele tabel selecteren.
Andere toetsen Beschrijving
Ctrl+F4 Sluit het actieve venster.
niet toegewezen Programma afsluiten.
Ctrl+N Nieuw bestand.
Ctrl+S Opslaan.
Ctrl+O Openen.
Ctrl+P Afdrukken.
Esc Bewerking annuleren.
Ctrl+Z Bewerking ongedaan maken.
Ctrl+Y Bewerking opnieuw uitvoeren.
Ctrl+F Zoeken.
F3 Volgende zoeken.
Ctrl+B Vette tekst.
Ctrl+I Tekst cursief weergeven.
F1 Help weergeven.
Multimediatoetsenbord Wordt uitgevoerd door

Functietoets (bijv. F6) Druk op de fn-toets, alsmede de bijbehorende functietoets (bijv. Fn
+ F6).
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Mac sneltoetsen
Sneltoetsen op Apple computers zijn iets anders dan Windows sneltoetsen. Het belangrijkste verschil
is dat er in plaats van de Crtrl-toets op het Mac-toetsenbord de Command-toets is. Je vindt de
volledige lijst onder Help → Sneltoetsen.
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About Banana Boekhouding+

In het About dialoogvenster (menu Help → About Banana Boekhouding+), vindt u diverse
informatie over het programma.

Versie
Het versienummer dat u gebruikt (b.v. 10.0.4) van Banana Boekhouding+ is duidelijk zichtbaar.
Banana Boekhouding Plus is numeriek gezien versie 10, welke continu verbeterd zal worden, dus
zullen er extra versienummers komen, b.v.10.0.1, 10.0.2, etc. voor elke volgende release.
Belangrijk: voor technische vragen, voordat u contact opneemt met de support service, zorg ervoor
dat u de laatste versie hebt (door hem te downloaden van onze download pagina )

Samen met het versienummer vindt u ook het serienummer, het webadres en informatie over het
auteursrecht.

Patent- en juridische informatie
In dit tabblad vindt u opnieuw de Copyright informatie, de Banana Boekhouding patenten en de
handelsmerk verklaringen. U vindt hier ook de indicatie van alle programmeer platformen die de
software gebruikt met de daarbij behorende licenties en copyrights.

Credits
In deze sectie worden erkenningen en credits gegeven aan allen die hebben deelgenomen en nog
steeds actief deelnemen aan de ontwikkeling, onderhoud en promotie van ons programma.

https://www.banana.ch/nl/download
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Foutmeldingen

Lijst met foutmeldingen
Complete lijst met foutmeldingen met uitleg
Voor meer informatie over het Foutmeldingen venster zie de pagina Interface.

Als het programma foutmeldingen laat zien:

Ga naar de helppagina voor de getoonde fout: in het Informatievenster (waar de foutmeldingen
verschijnen) wordt naast de foutmelding het symbool weergegeven. Door op dit symbool te
klikken wordt u direct doorgestuurd naar de online pagina die overeenkomt met de fout en die
de mogelijke oorzaken en oplossingen geeft.
Als de fout blijft bestaan:

Update uw software naar de meest recente versie door deze op te halen bij de volgende
pagina:
Download .
Controleer de boekhouding.
Zorg er in een Vreemde Valuta boekhouding voor dat de Wisselkoersverschillen zijn
aangemaakt en toegepast.

Foutmeldingen Uit- en Inschakelen
Uitschakelen van het weergeven van foutmeldingen:

Vink het "Niet waarschuwen" vakje aan in de foutmelding
Vink het "Waarschuwingsberichten" vakje uit in het menu Venster

Inschakelen van het weergeven van foutmeldingen:
Vink het "Waarschuwingsberichten" vakje aan in het menu Venster
Door het uitvoeren van het commando Boekhouding controleren.

https://www.banana.ch/doc/nl/banana-error-details/nl
https://www.banana.ch/nl/download
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Boekhoud toepassingen

Banana Boekhouding Plus biedt diverse gemakkelijk te gebruiken professionele op Excel geënte
toepassingen waarmee direct resultaten kunnen worden bereikt.
De boekhoudtoepassingen gebruiken een boekhoud-, planning- en rapportagemechanisme gebaseerd
op de methode van het dubbel boekhouden en bieden verschillende gemeenschappelijke functies.

Inkomsten & Uitgaven boekhouding
Cash manager (voorheen Kasboek)
Voor het beheer van een enkelvoudige boekhouding, met de mogelijkheid om inkomsten en
uitgaven in te delen naar categorie.
Boekhouding inkomsten & uitgaven
Om een uitgebreide boekhouding te beheren met diverse balansoverzichten en categorieën
waaraan inkomsten en uitgaven worden toegewezen.
Dit maakt een simpel gebruik mogelijk waarvoor geen kennis van Debet en Credit nodig is. Er
zijn ook een Balans en inkomsten overzichten mogelijk.

Dubbel boekhouden
Dubbel Boekhouden. Een volledige, uitgebreide, boekhoudoplossing volgens de dubbel
boekhouden methode. Bewerkingen worden bepaald door het aangeven van de Debet of de
Credit rekening. De financiële overzichten zijn compleet met een Balans, Resultatenrekening,
Journaal en Rekening kaarten.
Vreemde valuta boekhouding
Dubbel boekhouden met de mogelijkheid om rekeningen in verschillende munteenheden te
beheren:

Rekeningen voor klanten en leveranciers in verschillende valuta.
Transactie met huidige, historische of vrij te kiezen wisselkoers.
Facturen in de munteenheid van de klantenrekening.
Balans- en rekeningmutaties in basisvaluta of in de vreemde valuta van de rekening.
Berekening van de niet-gerealiseerde wisselkoerswinsten en -verliezen
(wisselkoersverschillen).



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 241

Facturering geïntegreerd in de boekhouding
Factuur als gewone transactie invoeren
Kolommen voor verschillende inhoud speciaal voor facturen.
Met of zonder BTW.
Mogelijkheid aanpassingen te doen en correcties te maken.
Afdrukken van een enkele factuur of groepen van meerdere facturen met een eenvoudig
commando.
Keuze uit verschillende afdrukformaten die ook aan te passen zijn aan persoonlijke wensen.
In digitaal formaat exporteren met Extensions (uitbreidingen).
Aanpasbare herinneringen en rekeningafschriften.

BTW beheer
Ondersteunt specificaties van elke land:

BTW code tabel om de verschillende BTW percentages aan te gaven. Elke BTW transactie
ondersteund.
Automatische BTW berekening, netto of bruto.
BTW overzichten.
Electronisch BTW gegevens versturen naar het het BTW-platform van de Zwitserse Bondsstaat.
Extensies voor BTW ondersteuning per land, gebaseerd op de eisen van de
belastingautoriteiten.

Financiële Planning
Voor bestaande en beginnende bedrijven.
Aanmaken van een budget door middel van budgettransacties.
Automatische berekening van herhalende uitgaven of inkomsten (rente, loon, bankkosten, etc.).
Mogelijkheid om een artikelcode, hoeveelheid en prijs aan te geven.
Javascript berekeningen om afhankelijke bedragen te berekenen (berekening van de rente over
het werkelijke gebruik van een lening).
Het programma zet automatisch financiële planningen op, compleet met liquiditeitsplanning,
saldo prognoses, voorlopige balans en resultatenrekening en de mutaties op een rekening.
Automatische financiële vooruitzichten voor meerdere jaren.
Keuze van de weergave per periode.
Vergelijking tussen budget en eindbalans.

Functies voor boekhoudapplicaties
De diverse boekhoudapplicaties leveren verschillende functies.

Deze functies kunnen worden geactiveerd of toegevoegd afhankelijk van uw wensen.
Het programma is gebruiksvriendelijk; een functie die niet wordt gebruikt, wordt ook niet geactiveerd.

Opzetten van een boekhouding
Werkt in elke munteenheid. Het valutasymbool kan gekozen worden uit een lijst of naar eigen
inzicht ingesteld.
Mogelijkheid om het aantal decimalen te veranderen (standaard 2), van 0 tot 12 decimalen om
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cryptovaluta te beheren.
De boekhoudperiode kan naar wens worden ingesteld als kalenderjaar of met een begin- en
einddatum die daarvan verschillen.
Keuze van de taal van de boekhouding.

Bestand- en gegevensopslag (zoals in Excel)
Van toepassing op alle Banana applicaties:

Nieuwe bestanden aanmaken vanuit kant en klare modellen of vanuit eigen bestanden.
De gegevens voor een boekhoudjaar worden opgeslagen in één enkel bestand.
Het bestand kan worden opgeslagen op elke medium, computer, nertwerk, cloud of worden
verstuurd per e-mail.
Mogelijkheid een onbeperkt aantal boekhoudbestanden van elk soort te beheren.
Gegevens kunnen door meerdere gebruikers tegelijk benaderd worden, maar door één persoon
tegelijk worden bewerkt.

Rekeningschema
De indeling en de structuur van de rekeningen is volledig op maat te maken.
Numerieke of alfanumerieke rekening en groep naam.
Mogelijkheid notities toe te voegen of extra kolommen.
Groepering en totalen zijn aan te passen volgens een schema geschikt voor elk land.
Saldo, rekeningmutaties en totalen worden in real-time bijgehouden en weergegeven.
Kostenplaatsen en winstcentra voor gedetailleerd beheer van kosten en inkomsten van
specifieke activiteiten of projecten.
Segmenten voor overzichten per sector (vestiging).
Klantendetails met toezicht op uitstaande facturen, herinneringen en rekeningafschriften.
Leveranciersoverzichten met toezicht op betaalde en openstaande facturen.
Beheer van klanten en leveranciers, ook als niet in de balans opgenomen rekeningen (met
kostenplaats), voor een boekhouding die volgens de kasmethode wordt gevoerd.
Niet in de balans opgenomen rekeningen.

Transacties
Enkele of verzamel transacties (over meerdere rijen).
Op transactie- of op kasbasis.
Gebruik van excel-achtige interface, selecteren, kopiëren en plakken, regels toevoegen, zoeken
en vervangen.
Aanbevelingen, auto-aanvullen en opslaan van herhalende bewerkingen voor snellere
gegevensinvoer.
Automatische of aangepaste nummering van documenten.
Mogelijkheid ingevoerde gegevens aan te passen, kolommen of andere informatie toe te
voegen of te ordenen.
Koppeling met bestanden of bonnen in digitaal formaat (pdf, afbeeldingen) en het met één klik
openen van documenten.
Importeren van gegevens van bankafschriften:

Verschillende formaten worden ondersteund
Mogelijkheid om geïmporteerde transacties aan te vullen of te verwijderen.

Rijen markeren met een kleur.
Mogelijkheid kolommen op verschillende manieren weer te geven.
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Context informatie over rekeningsaldo, verschillen of fouten.

Blockchain voor gegevensbescherming
Bescherming van ingevoerde mutaties met digitale gegevenscertificatie techniek (zoals bij
Bitcoin).
Voldoet aan wettelijke eisen.
Versturen van gegevens naar de auditor met de zekerheid dat er niet mee geknoeid kan
worden.

Standaard en aangepaste overzichten:
Balans, resultatenrekening, journaal, rekeningkaarten.
Aanpassing en opslag van afdrukinstellingen.
Gegevens exporteren naar en koppelen met Excel.

Grafieken
Overzicht van de ontwikkeling van rekeningen.
Vergelijking van budget en eindbalans
Realtime weergave tijdens het invoeren.

Boekhouding controleren
Boekhouding controleren met één klik. De boekhouding wordt opnieuw berekend alsof alle
transacties opnieuw zijn ingevoerd.
Elke foute instelling, verschil of fout wordt gerapporteerd.
Iedere melding is gekoppeld aan een help pagina die de oorzaken uitlegt en de oplossingen
geeft.
Mogelijkheid altijd te corrigeren.

Eindejaarsafsluiting en het aanmaken van een nieuw jaar
Automatisch proces om een bestand voor het nieuwe jaar aan te maken, met een overzicht van
de saldi en winst en verlies.
U kunt gaan werken aan het nieuwe jaar, zelfs als u het vorige niet hebt afgesloten.
Commando om een overzicht te maken van de saldi als het vorige jaar is afgesloten.
Mogelijkheid om notities toe te voegen en af te drukken.
Commando om alle gegevens en afdrukken in pdf formaat te archiveren.

Diversen
Nieuwe bestanden aanmaken uitgaande van een bestaand bestand.
Overzetten van het ene boekhoudingstype naar een ander, in geval van groei en toevoegen van
functionaliteit.
Extra tabellen toevoegen:

Items Tabel
Tabel om items aan te geven die gefacturereerd worden.
Kan dienen als beheer van kleine voorraad of veilige opslag.

Documenten Tabel:
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Om afbeeldingen (bedrijfslogo) of tekst documenten op te slaan (bijvoorbeeld
Javascript programma's).

Andere tabellen:
U kunt tabellen toevoegen waarin u notities kunt invoeren of andere informatie. Tabellen
kunnen worden aangepast door er kolommen aan toe te voegen.

XBRL overzicht
Mogelijkheid om XBRL bestanden te genereren die geschikt zijn voor verschillende landen.
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Dubbel Boekhouden

Dubbel boekhouden is een applicatie van Banana Boekhouding Plus waarmee u uw rekeningen heel
professioneel kunt beheren. Het is gratis tot 70 transacties in het Free plan van Banana
Boekhouding Plus. In het Professional en Advanced plans  is het daarentegen onbeperkt te
gebruiken.

Ideaal voor het MKB, ervaren accountants en frequente boekhouders. Werk snel en maak een Balans,
Winst- en Verliesrekening, Financiële Planning, Budget en vele andere overzichten in no time.
Vele complexe operaties, zoals BTW beheer, vreemde valuta, budgettering en winst- en
verliesrekeningen zijn heel eenvoudig gemaakt omdat deze allemaal geautomatiseerd zijn.

▶ Video: Hoe dubbel boekhouden te beginnen  (Engelstalig)
Ontdek alle karakteristieken van Banana Dubbel boekhouden

Vele functies, meer automatisering

Begin meteen: Kies een van de vele modellen  voor diverse toepassingen.
Snelle invoer: Importeer vanuit elektronisch bankieren, sla herhalende transacties op met de
regels voor automatisch aanvullen.
Directe controles: Met de kolom Saldo kunt u snel zien of er onbalans is tussen de debet en
credit kolommen en vanaf welke regel de verschillen beginnen.
Na iedere boeking worden de saldi bijgewerkt met een indicatie van het resultaat voor het jaar.
Koppel boekstukken eenvoudig: koppel iedere transactie aan het bijbehorende digitale
document.
Gegevens importeren en exporteren.
Balans en winst- en verliesrekening , rekeningkaarten (grootboek), Journaal met één klik.
Analytische boekhouding voor projecten,, sectoren of particuliere activiteiten dankzij
Kostenplaatsen en Winstcentra en Segmenten.
Automatische rekeningkaarten (grootboek). Het overbrengen van bedragen gaat automatisch
na het boeken in de transactietabel (journaal).
De balans en de winst-en-verliesrekening kunnen direct met een klik worden weergegeven en u
kunt kiezen voor een eenvoudige structuur met de eindtotalen of met de subtotalen, die meer
details opleveren
Om de BTW te boeken hoeft u geen extra boeking te doen, maar voert u eenvoudig een code in
waarmee de BTW berekend kan worden en deze tegelijk op de BTW rekening geboekt wordt.

https://www.banana.ch/nl/buy
https://www.banana.ch/en/node/11351
https://www.banana.ch/apps/nl?combine=&langcode=nl&country=262&category=All&type=All&publisher=All&op=Indienen#
http://www.banana.ch/doc/nl/node/3314
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Geautomatiseerde BTW aangifte met gegevens in XML formaat voor de belastingdienst.
Budget instellen waarmee u de financiële planning kunt bepalen met betrekking tot kosten en
inkomsten zodat u een toekomst zonder onzekerheden heeft.

Meer informatie
Organisatie van uw boekhouddocumenten
Boekhouding met het factuurstelsel of het kasstelsel
BTW beheer
Vreemde valuta boekhouding

https://www.banana.ch/nl/node/10965
https://www.banana.ch/nl/node/10968
https://www.banana.ch/nl/node/11223
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Hoe beginnen - Dubbel boekhouden

▶ Video: How to start a Double-entry accounting  (Engelstalig): video uitleg die u laat zien hoe u
eenvoudig een dubbel boekhouden boekhouding opzet, het rekeningschema aanpast, een budget
maakt, transacties invoert en overzichten afdrukt.

Aanmaken van een boekhoudbestand uitgaande van een
online model
Banana Boekhouding biedt modellen voor alle rechtsvormen, verdeeld naar land en soort
boekhouding. Deze kunnen direct in het programma worden geopend vanuit het menu Bestand,
Nieuw... of ze kunnen worden gedownload van pagina met modellen op onze websit.

Hierna wordt uitgelegd hoe te beginnen met een model direct vanuit het programma:

Menu Bestand → Nieuw....1.
Selecteer het land, de taal, de categorie en het type boekhouding2.
Kies uit de lijst van modellen het model dat het dichtst komt bij wat u nodig heeft.3.
Klik op de knop Aanmaken.4.

In het gedeelte "Zoeken" worden bij het invoeren van een sleutelwoord in het programma de
modellen weergegeven die het ingevoerde sleutelwoord bevatten.

Het is ook mogelijk om vanuit een leeg bestand te beginnen, door de optie blanco bestand aanmaken
te activeren. Om de start te vergemakkelijken en groeperingsfouten te vermijden, raden wij u altijd
aan om steeds te beginnen met een bestaand model.

Meer informatie over het aanmaken van een nieuw bestand vindt u op de pagina Nieuw bestand
aanmaken.

Het instellen van de bestands- en
boekhoudingseigenschappen (basis gegevens, Boekhouding

https://www.banana.ch/en/node/11351
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tab)
Dit kan vanuit het menu Bestand → bestands- en boekhoudingseigenschappen (basis
gegevens). Hier geeft u de bedrijfsnaam aan die in de afdrukken, en op andere plaatsen,
verschijnt.
Kies de basis valuta waarin de boekhouding gedaan wordt.

Opslaan
Sla met het commando Bestand → Opslaan als...  de gegevens op en geef een naam aan het
bestand. Het dialoogvenster Opslaan van uw besturingssysteem wordt getoond.

Het wordt aangeraden de naam van het bedrijf gevolgd door het jaar te gebruiken, bijvoorbeeld
"bedrijf-2021.ac2", om het bestand te onderscheiden van andere boekhoudbestanden.
U kunt zoveel boekhoudbestanden opslaan als u wilt, ieder met zijn eigen naam.
U kunt het pad selecteren, (opslaan op schijf, usb stik of cloud).
Wanneer u van plan bent documenten te koppelen aan de boekhouding van het huidige jaar
bevelen we u aan een aparte map aan te maken voor ieder boekhouding en dan per jaar waarin
u alle bestanden groepeert.

Algemeen gebruik van het programma
Banana Boekhouding is geïnspireerd op Excel. De gebruikersaanwijzingen en commando's zijn zoveel
mogelijk het zelfde gehouden als die van Microsoft Office.
Op de pagina programma interface vindt u meer uitleg over het algemene gebruik van het
programma.
De boekhouding wordt gedaan in tabellen; deze werken allen op dezelfde manier.

Het Rekeningschema aanpassen
Pas in de Rekeningen tabel het Rekeningschema aan uw eigen wensen aan:

Voeg rekeningen toe en /of verwijder bestaande rekeningen (zie Rijen toevoegen in het menu
Bewerken)
Verander de rekeningnummers, de beschrijvingen (bijvoorbeeld, voer de naam van uw eigen
Bankrekening in), voer andere groepen in, etc.

http://www.banana.ch/doc/nl/node/3932
http://www.banana.ch/doc/nl/node/3932
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Maak groepen aan, raadpleeg onze Groepen pagina over het aanmaken van subgroepen.
Definieer Kostenplaatsen of Segmenten die worden gebruikt om bedragen in meer detail en op
een specifiekere manier te laten zien.

De Transacties
De Transacties moeten in de Transacties tabel ingevoerd worden; gezamenlijk vormen deze het
Journaal.

In de specifieke kolommen (zie ook pagina Transacties):

Voer de Datum in
Voer het Documentnummer in dat aan het papieren boekhouddocument is toegekend.
Hiermee kunnen documenten gemakkelijk teruggevonden worden als de transactie eenmaal is
ingevoerd in de boekhouding.
Voer de Beschrijving in
Voer in de Debetrekening de doelrekening in
Voer in de Creditrekening de bronrekening in.
Voer het bedrag in.
In een boekhouding met BTW, voer het bruto bedrag in, inclusief BTW en de BTW code.  Het
programma scheidt de BTW, terwijl het de netto kosten of de netto winsten apart berekent.

Versnellen van het invoeren van de transacties

Om het invoeren van de transacties te versnellen kuntt u de volgende functies gebruiken:

de Smart fill functie die het mogelijk maakt gegevens die al eens eerder ingevoerd zijn
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automatisch aan te vullen.
de Terugkerende transacties functie die wordt gebruikt om terugkerende transacties in een
aparte tabel te onthouden.
het importeren vanuit uw gedownloade banktransacties. importeer alle transacties vanuit bank
of credit kaart afschriften in het boekhoudbestand.

Transacties met BTW

Om BTW transacties in te voeren gaat u als volgt te werk:

vanuit het menu Bestand kies het commando Nieuw en dan Dubbel Boekhouden met BTW
Kies een van de bestaande modellen  voor uw land met Dubbel Boekhouden met BTW en een
BTW Codes tabel.
Om te zien hoe de transacties met BTW ingevoerd moeten worden bezoekt u de pagina
Transacties.

Transacties in meerdere rijen

Transacties in meerdere rijen of Samengestelde transacties die betrekking hebben op meer dan twee
rekeningen en credit/debet bedragen in meerdere rekeningen (bijvoorbeeld, als diverse facturen zijn
betaald per bank) moeten in meerdere rijen ingevoerd worden:

Één rij voor iedere debet- of creditrekening
Als alle afzonderlijke debet en credit rijen ingevoerd zijn zou er geen verschilsaldo moeten zijn.

Voor meer details zie het gedeelte Samengestelde transacties op de pagina Transactie-soorten.

Controleren van klanten- en leveranciersfacturen
Met Banana Boekhouding kunt u de facturen die u moet betalen en de facturen waarvoor u nog geld
tegoed hebt in het oog houden. Zie pagina's:

Submenu Klanten
Submenu Leveranciers

De Rekeningkaart
De Rekeningkaart laat automatisch alle transacties zien die ingevoerd zijn voor dezelfde rekening
(bijvoorbeeld, contanten, bank, klanten, etc.).

Om een rekeningkaart weer te geven klikt u met de muis eenmaal op een rekeningnummer (of
selecteert u de cel met de pijltjestoetsen) en klikt u vervolgens op het kleine blauwe symbool dat
verschijnt in de cel.

https://www.banana.ch/apps/nl
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Rekeningkaart per periode

Om de rekeningkaart met saldi voor een bepaalde periode te laten zien gaat u als volgt te werk:

Menu Raporten → Rekening-/Categorie kaarten.
Activeer in de Periode sectie Geselecteerde periode en voer de Startdatum en Einddatum in
van de periode.

Kijk voor meer details op de pagina Periode.

Één Rekeningkaart afdrukken

Om de één rekeningkaart af te drukken roept u de kaart op vanuit de Rekeningen of Transactietabel
en start het afdrukken van het menu Bestand.

Alle of enkele Rekeningkaarten afdrukken

Ga als volgt te werk om meerdere of alle rekeningkaarten af te drukken:

Menu Raporen → Rekening-/Categorie kaarten,
Selecteer de rekeningkaarten die afgedrukt moeten worden:
Met het filter kunt u automatisch alle rekeningen, kostenplaatsen, segmenten, groepen of
alleen de gewenste rekeningen selecteren.

Kijk voor meer details op de pagina Rekening-/Categorie kaarten

De Balans
De Balans laat de saldi zien van alle rekeningen van bezittingen, Activa & Passiva. Het verschil
tussen de Activa en de Passiva bepaalt het Kapitaal.
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De Winst- en Verliesrekening
De Winst- en Verliesrekening laat alle Uitgaven en Inkomsten rekeningen zien. Het verschil tussen de
Uitgaven & Inkomsten bepaalt de Winst of Verlies van het Boekjaar.

Afdrukken van de balans en de resultatenrekening
In Banana Boekhouding kunnen de balans en de resultatenrekening op twee manieren worden
bekeken en afgedrukt:

In de Uitgebreide Balans wordt een balans met een eenvoudige lijst van alle rekeningen
weergegeven zonder onderscheid van groepen en subgroepen.
In de Uitgebreide Balans op groepen  wordt de balans weergegeven met de rekeningen
verdeeld in groepen en subgroepen; bovendien zijn er veel functies om de presentatie aan te
passen die niet in de Uitgebreide balans aanwezig zijn.

Om de balans en de resultatenrekening af te drukken in twee modi:

Menu Rapporten → Uitgebreide balans.
Menu Rapporten → Uitgebreide balans op groepen.
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Gegevens opslag in PDF formaat
Aan het einde van het jaar, als de hele boekhouding voltooid, gecorrigeerd en gecontroleerd is,
kunnen alle boekhoudgegevens opgeslagen worden met:

menu Bestand → PDF bestand aanmaken.

Het Budget
Voordat u begint met een boekjaar kunt u een inschatting maken van de uitgaven en inkomsten zodat
u de economische en financiële situatie van uw bedrijf onder controle hebt.
Het budget kan op twee manieren opgezet worden:
 

Jaarlijks budget in de Rekeningentabel in Budget weergave, Budget kolom. Voor iedere rekening1.
wordt het jaarbudget aangegeven.
Op deze manier geven de Budget kolommen de bedragen weer die op het hele jaar betrekking
hebben, als u het Budget opstelt met menu Rapporten → Uitgebreide balans op groepen.
Het Budget wordt opgezet de Budgettabel. De budgettabel wordt geactiveerd via menu Extra2.
→ Functies toevoegen/verwijderen.
In deze tabel worden alle mutaties met betrekking tot uitgaven en inkomsten vastgelegd alsof
de mutaties werden vastgelegd in de transactietabel. Wanneer deze tabel geactiveerd is wordt
de kolom Budget van de rekeningentabel automatische gedeactiveerd.

Kijk voor meer details op de pagina Budget.
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Karakteristieken van Banana Dubbel
boekhouden

De dubbel boekhouden toepassing van Banana voldoet aan de professionele eisen van alle bedrijven
en organisaties waar een boekhouding wettelijk is voorgeschreven.

Het is een erg krachtig gereedschap maar toch flexibel en eenvoudig te gebruiken omdat de
verschillende functies kunnen worden in- of uitgeschakeld. Hierdoor kunt u zowel de
hoofdboekhouding alsook het gestructureerde rekeningschema op verschillende niveaus
beheren: met BTW, klanten en leveranciers beheer, facturering, kostenplaatsen en segmenten.
Er kunnen op elk moment aanpassingen worden gemaakt waardoor iedereen perfecte
resultaten bereikt. Het is ideal voor de ervaren accountant die snel wil werken maar ook voor
beginners. Om deze reden wordt het gebruikt voor boekhoudonderwijs in vele scholen .

Gelijkwaardig aan Excel

Excel-achtige functies en commando's

Alle gegevens die u in de tabellen invoert zijn altijd zichtbaar, direct onder handbereik.
U werkt snel omdat u herhalende transacties kunt selecteren, kopiëren en plakken in meerdere
cellen en rijen.
Als u een fout maakt kunt u deze herstellen door bewerkingen te annuleren of terug te draaien.
Voeg zoveel rijen toe als u wilt zonder limiet of verwijder rijen die u niet nodig heeft.
Als u een fout maakt in een bedrag, een rekening, een BTW code of een beschrijving kunt u
deze in een oogwenk herstellen met de zoeken en vervangen functie.
U hoeft geen formules in te voeren omdat de berekeningen direct bijgewerkt worden en u een
samenhangend beeld heeft (zoals in spreadsheets).
Alles wat u ziet kan worden afgedrukt of naar PDF of andere formaten worden geëxporteerd.
U kunt uw bedrijfslogo gebruiken om uw afdrukken te personaliseren.
De kolommen zijn aan te passen, u kunt ze verplaatsen, nieuwe toevoegen en de breedte
instellen.
Werk met het formaat dat het best bij u past.
Geef regels een kleur om ze na te kijken, aan uw accountant te laten zien of om ze later
kompleet te maken.

Op tabellen gebaseerde structuur

Het boekhouden gebeurt in drie tabellen die op dezelfde manier gebruikt worden als in Excel
spreadsheets maar die al helemaal ingesteld zijn en geprogrammeerd met alles wat u voor een snelle
en veilige boekhouding nodig heeft.

Rekeningen tabel.
U kunt alle contanten, klanten, leveranciers, etc. rekeningen instellen en de beginsaldi invoeren
zonder deze handmatig te hoeven boeken in de transactietabel. U kunt meerdere rekeningen
groeperen, zoals de contanten en de bank in de liquiditeitsgroep, zodat u bijgewerkte saldi
meteen kunt controleren.
Transactietabel.
Het centrum van de boekhouding waar de transacties worden ingevoerd of geïmporteerd. De
debet- en credittransacties kunnen worden aangevuld met extra informatie om klanten en

https://www.banana.ch/nl/node/10678
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leveranciers te beheren, facturen te versturen, kosten- / winstcentra, segmenten, hoeveelheden
en prijzen te beheren en al het andere dat u nodig heeft. Scrollend door de tabel krijgt u een
uitgebreid overzicht van alle mutaties. De tabel kan worden aangepast om de boekhouding
altijd perfect op orde te houden.
Totalentabel.
Deze geeft de totalen per groep weer en wordt gebruikt om de rekeningsaldi te controleren.

Er kunnen extra tabellen worden toegevoegd om extra functies te ondersteunen.

Budgettabel.
Bereid financiële prognoses voor met dezelfde soort dubbele boekhouding invoer als in de
transactietabel. Compleet met liquiditeitsplanning, budget en verwachting voor
resultatenrekening, klanten, leveranciers, investeringen, projecten en segmenten voor een of
meerdere jaren.
BTW codes tabel.
Stel de vereiste percentages en parameters in die gebruikt worden in de transactietabel voor de
automatische berekening van BTW en de overzichten voor de belastingdienst.
Itemstabel.
Om een lijst van te factureren artikelen aan te maken. Het programma houdt uw inkomsten en
uitgaven bij.
Eigen tabellen.
Om aan specifieke wensen te voldoen.

Snelstart

Modellen

Begin direct met een van onze modellen zonder tijd te verliezen. U kunt er een kiezen uit de lijst voor
uw land en voor het soort bedrijf dat u uitvoert. U kunt het model aanpassen om het nog beter op uw
wensen af te stemmen.

U heeft een makkelijke start door een nieuw bestand aan te maken vanuit een model.
Als u al uw eigen Banana Boekhouding model heeft kunt u dit, met alle instellingen, weer
gebruiken voor een andere boekhouding.
Meer dan 1000 modellen, gerangschikt per land en soort gebruik, aan te passen en met
gebruikersdocumentatie .
Zoek eenvoudig modellen en gebruik ze direct in het programma .

Opzetten van de boekhouding

Stel zelf de munteenheid voor uw boekhouding in, u kunt deze kiezen uit een lijst met
wereldvaluta's of er zelf een instellen (bijvoorbeeld voor cryptovaluta).
Stel zelf de boekhoudperiode in, indien nodig meerdere jaren en niet beperkt tot de klassieke
periode van 1 januari tot 31 december.
Kopteksten en boekhoudgegevens in te stellen in een enkel dialoogvenster, eenvoudig om weer
te geven.
Kies zoveel decimalen als u wilt, van 0 tot 27, bij het aanmaken van de boekhouding.
U kunt het aantal decimalen probleemloos veranderen gedurende het jaar.

Meertalig

U bent vrij om de taal van uw boekhouding te kiezen bij het aanmaken van het bestand .

https://www.banana.ch/apps/nl?combine=&langcode=nl&country=All&category=All
https://www.banana.ch/apps/nl?combine=&langcode=nl&country=All&category=All
https://www.banana.ch/apps/nl/node/9296#gebruik_de_modeltemplate_id_begint_met_
https://www.banana.ch/doc/nl/install
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Pas de kopteksten van de kolommen aan naar uw wens.
U kunt uw boekhouding tegelijk in meerdere talen doen.
Afdrukken zijn ook in meerdere talen aan te passen.

Bestands- en gegevensopslag

Alle gegevens worden in één bestand opgeslagen waar u alles zonder tijdverspilling in terug
kunt vinden.
Voor ieder jaar wordt een apart bestand aangemaakt. Alle gegevens hebben betrekking op het
jaar en er is geen verwarring.
Geef het bestand de naam die u wenst.
Met een enkele licentie kunt u een onbeperkt aantal boekhoudingen doen.
Gegevens blijven helemaal in uw bezit.
Sla uw gegevens op elk medium op, computer, netwerk, cloud of verstuur deze per e-mail . U
kunt erbij waar u ook bent.
Gelijktijdige toegang door meerdere gebruikers, maar slechts één persoon kan het bestand
openen om het te bewerken.
Maak uw boekhouding veiliger met een wachtwoord.

Planning-Uitvoering-Beheer
Binnen hetzelfde dubbel boekhouden boekhoudbestand kunt u uw boekhouding doen, of uw budget
bijhouden of beiden. De krachtige "Planning - Uitvoering - Beheer" benadering is heel intuïtief .

Dubbel boekhouden methode

Met Banana Boekhouding kunt u boekhouden met de internationale methode van het dubbel
boekhouden. Het voldoet aan internationale standaarden.
Voldoet aan de eisen voor elke boekhouding.
Bruikbaar in elk land.
Transacties met debet en credit kolommen.
Als er een onbalans is in de transacties wordt er een melding van het verschil gegeven.
Bedragen worden in de kolommen weergegeven in het formaat dat door uw computer gebruikt
wordt zodat u niet hoeft te wennen aan andere formaten waar u niet bekend mee bent.

Debetbedragen worden positief aangegeven en creditbedragen negatief.
De berekening wordt gedaan volgens de Debet - Credit = 0 equation .

Balans, Resultatenrekening en alle andere afdrukken van de boekhouding.
Alle afdrukken zijn aan te passen.
Weergave formaat naar keuze.

Transacties volgens het kasstelsel of het factuurstelsel .
Gegevens beveiliging met blockchain technologie (volgens een gepatenteerde methode).
De methode van dubbel boekhouden wordt door veel scholen over de hele wereld gebruikt om
boekhoudonderwijs te geven .

Rekeningschema

Het rekeningschema is volledig aan uw wensen aan te passen.
Hetzelfde rekeningschema wordt gebruikt voor de boekhouding en voor financiële, vermogens-
en inkomensprognoses.
De balans en de resultatenrekening kunnen aangepast worden om te voldoen aan de structuur
en de inhoud volgens uw eisen.
Elk nationaal, internationaal of vrij groeperingsschema wordt ondersteund (Engelstalige pagina)

https://www.banana.ch/nl/node/11059
https://www.banana.ch/nl/plannen-uitvoeren-controleren
https://www.banana.ch/nl/node/10964
https://www.banana.ch/nl/node/10968
https://www.banana.ch/nl/node/10678
https://www.banana.ch/nl/node/10678
https://www.banana.ch/nl/node/9892
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.
Niet in de balans opgenomen rekeningen voor het beheer van posten die niet in de begroting
mogen worden opgenomen, maar die u wel moet afschrijven.
U kunt hetzelfde rekeningschema gebruiken om zowel transacties in te voeren als ook uw
financiële prognoses.
U kunt zelf uw rekeningnummers kiezen, numeriek of alfanumeriek, tot 256 karakters lang.
U kunt zelf uw beschrijving invoeren, tot 256 karakters lang.
Het is niet langer nodig om begin- en eindsaldi in te voeren met boekingen .
U voert de saldi direct in de kolom Opening van de rekeningentabel in en alleen wanneer u
Banana Boekhouding voor de eerste keer gebruikt. In de volgende jaren vindt de overdracht
automatisch plaats.
Saldi, rekeningmutaties en totalen worden contextueel weergegeven en zijn altijd up to date.
Voor iedere klanten-, leveranciers of partnerrekening zijn er kolommen om adressen en andere
nuttige informatie die u nodig heeft op te slaan.
Andere kolommen toevoegen voor notities, groepering of bedragen.
U hoeft de bedragen in de kolommen niet zelf op te tellen; ze worden automatisch correct
berekend en bijgewerkt.
U kunt daardoor kolommen met uw eigen gegevens aanmaken en heel specifieke details
zichtbaar maken.

Transacties

U kunt een enkele transactie invoeren, of samengestelde transacties in meerdere rijen, als het
om meerdere rekeningen gaat.
U kunt invoeren met de methode van het factuurstelsel of het kasstelsel .
Bij het invoeren van uw gegevens worden reeds eerder ingevoerde teksten getoond. Met één
klik wordt de transactie ingevulde (auto-aanvullen).
Directe melding van fouten en verschillen, met de mogelijkheid om deze later te corrigeren.
Sla terugkerende boekingen op om deze weer op te roepen als ze weer voorkomen zonder dat u
ze opnieuw helemaal in hoeft te voeren.
In alle tabellen zijn standaard kolommen beschikbaar en deze kunnen naar wens weergegeven
worden.
Kolommen voor hoeveelheid en prijs voor facturering en kostenbeheersing.
Automatische nummering van documenten met oplopende nummers.
Documenten zijn altijd onder handbereik door de digitale boekstukken (PDF, afbeeldingen) te
koppelen aan boekhoudbestanden en deze met één klik te openen.
Voer eigen teksten in tot 256 karakters lang, ook over meerdere regels.
Geef rijen een kleurtje voor transacties die u later moet controleren of corrigeren, of om ze aan
de accountant te laten zien.
Voeg kolommen toe om er andere informatie in in te voeren.
Transacties op Kostenplaatsen en Winstcentra
Transacties op Segmenten
Sla de ingestelde indeling van de kolommen op in weergaven om de inhoud die het
belangrijkste is voor u goed weer te geven.
Context informatie over rekeningsaldo, verschillen of fouten.
Voor de periodieke- of eindejaarsafsluitingen kunt u de "boekhouding controleren" functies
gebruiken. U bent dan in staat fouten in de saldi te vinden (bijvoorbeeld saldi op
bankafschriften en saldi in de boekhouding). U ziet meteen wat er fout is en kunt correcties
uitvoeren zodat alles weer met elkaar overeenkomt.
Gegevens importeren:

Voer sneller transacties in door deze te importeren vanuit digitale bankafschriften.

http://www.banana.ch/doc/nl/node/2626
https://www.banana.ch/nl/node/10968
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U kunt transacties importeren die in verschillende formaten worden aangeleverd door
banken .
Geïmporteerde rijen kunnen worden aangepast, aangevuld of verwijderd.
Gegevens kunnen ook vanuit andere software worden geïmporteerd.

Financiële prognoses

Als u een budget moet maken kunt u dit doen door een budgettabel aan te maken.
Gebruik eenvoudig dezelfde invoermethode als u al gewend bent in de inkomsten en uitgaven
boekhouding .
Financiële prognoses compleet met liquiditeitsplanning.
Balansprognoses.
Resultatenrekening prognoses.
Automatische meerjaren planning.
Voer het budget in met transactions in de budgettabel.
Herhalende inkomsten en uitgaven invoeren met één transactie.
Alle functies beschikbaar in boekhouding:

Transacties in een of meerdere regels.
Budget voor klanten
Budget prognose voor leveranciers, BTW, kostenplaatsen en winstcentra, segmenten.
Hoeveelheden en prijzen.

Berekeningen in javascript met toegang tot de waardes van de huidige prognose:
Planning van de omzetstijging.
Berekening van provisies en kosten in percentages van de verkoop.
Afschrijving berekening.
Rente berekening.
Gebruik van variabelen.

Prognoses die beschikbaar zijn in afdrukken uit de boekhouding:
Volledig naar wens aan te passen.
Prognoses per maand, kwartaal, halfjaar, jaar.
Vergelijk prognose met huidige situatie.

Rekening kaart met budgettransacties per rekening of groep.

Balans en resultatenrekening

Overzichten met eind- of budgetgegevens, of beide, met een indicatie van afwijkingen.
Indeling met groepen en subgroepen naar eigen inzicht.
Bijgewerkte resultaten direct zichtbaar in de rekeningentabel.
Afdrukken op maat:

Uw eigen logo toevoegen.
Keuze van kolommen die weergegeven worden.
Keuze van secties die weergegeven worden.
Gedetailleerd of gegroepeerd afdrukken
Afdrukken per periode.
Kolommen ingedeeld per periode (maand, kwartaal, halfjaar, jaar).
Bedragen van vorig jaar.
Vergelijking van de verwachtte waarde.
Kolommen verdeeld per segment.
Toegevoegde bijlagen.
Groepering zoals in het rekeningschema of volgens uw eigen schema.
Aanpassing opslaan.

Overzicht in tabelvorm (net zoals maatwerk afdrukken maar met de gegevens in de tabel).

https://www.banana.ch/apps/nl/extensions?combine=&langcode=All&country=262&type=265
https://www.banana.ch/apps/nl/extensions?combine=&langcode=All&country=262&type=265
https://www.banana.ch/nl/financiele-planning
https://www.banana.ch/nl/financiele-planning
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Naar PDF exporteren voor archivering en naar andere formaten voor gegevensverwerking.

Andere afdrukken van de boekhouding

Afdrukken van de hele inhoud van tabellen of van alleen een selectie.
Uw eigen logo toevoegen om documenten en afdrukken te personaliseren.
Journaal.
Rekeningkaarten met boekingen en groepen:

Met transacties voor rekeningen of voor prognoses.
Per periode.
Per rekening, groep, kostenplaats of segment.
Boekhoud- of begrotingsgegevens.
Kolommenindeling aan te passen.

Naar PDF of andere formaten exporteren.

Grafieken

Contextueel, onderaan de tabel.
Verschillende formaten.
Saldo ontwikkeling per rekening of groep.
Boekhoudwaarden.
Begroting.
Voorafgaande jaar.
Keuze in soort grafiek.

Meer functies voor bedrijfsbeheer
Met het programma kunt u extra informatie aan de transacties toevoegen, zodat u dezelfde gegevens
kunt gebruiken voor het BTW-beheer, voor het volgen van klanten en leveranciers, het uitschrijven
van facturen, het genereren van rapporten voor projecten of bedrijfssectoren en om te voldoen aan
de verschillende vennootschaps- en belastingverplichtingen.

BTW beheer

Deze functie kan worden geactiveerd naar keuze (bij het aanmaken van een boekhouding).
BTW code tabel om de verschillende BTW-percentages en -soorten aan te geven.
Alle nationale vereisten worden ondersteund.
Er kunnen ook andere soorten verkoopbelastingen mee beheerd worden (bijvoorbeeld
Amerikaanse verkoopbelasting).
BTW code invoeren.
BTW teruggave functionaliteit (door de BTW code voorafgegaan door een minteken te
gebruiken).
Bruto en netto BTW berekeningen.
Automatische uitsplitsing en boeking op de aangegeven BTW rekeningen .
BTW overzichten:

Per periode of compleet.
Met of zonder mutaties.
Optioneel, met totalen per percentage, BTW code, rekening.

Extensies voor BTW overzichten per land gebaseerd op de eisen van de betreffende
belastingautoriteiten.

https://www.banana.ch/area/nl/node/10504
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Klanten beheer

Functie kan naar keuze worden geactiveerd (door het toevoegen van rekeningen in het
rekeningschema.
Controleren van facturen en klantenbetalingen.
Klanten database in het rekeningschema (rekeningentabel).
Maak groepen en totalen voor klanten aan in verschillende groepen.
Bekijk facturen per klant of op globaal niveau.
Rekeningoverzicht klantenverkeer en openstaande facturen.
Automatische verrekening, open facturen.
Klantenbeheer ook beschikbaar in de vorm van kostenplaatsen (op een contantenbasis).

Facturen aan klanten

Functie kan naar keuze geactiveerd worden (door de kolom voor het factuurnummer in de
transactietabel te gebruiken)
Facturen kunnen direct in de transactietabel ingevoerd worden.
Vereist het opzetten van de klanten database.
Factuurgegevens als gewone transactieregels invoeren.
Zie facturen afdrukken en versturen naar klanten.
Een kolom om hoeveelheden en prijzen aan te geven.
Met of zonder BTW.
Mogelijkheid tot aanpassing en correctie.
Druk met één klik een enkele factuur of meerdere gecombineerd af.
Keuze uit verschillende afdruk formaten .
Pas de factuur naar uw voorkeuren aan.
Met extensie exporteren in digitaal formaat.
Met extensies op maat gemaakte herinneringen aanmaken.
Met extensies op maat gemaakte rekeningoverzichten van klanten aanmaken.

Leveranciersbeheer

Functie kan naar keuze worden geactiveerd (door het toevoegen van rekeningen in het
rekeningschema.
Leveranciersdatabase bevindt zich in het rekeningschema (in de rekeningentabel).
Mogelijkheid om leveranciers te verdelen in verschillende groepen.
Beheer van facturen van en betalingen aan leveranciers.
Open facturen per leverancier of maak een volledig overzicht.
Rekeningoverzicht leveranciersmutaties en nog openstaande facturen.
Automatische verrekening open facturen.

Kostenplaatsen en winstcentra

Functie kan naar keuze worden geactiveerd (door het toevoegen van kostenplaatsen en
winstcentra rekeningen in het rekeningschema).
Voor projecten, kostprijsberekening of rentabiliteit.
Instellen van kostenplaatsen in het rekeningschema.
Groepering op meerdere niveaus.
Drie niveaus van kostenplaatsen en winstcentra.
Onbeperkt aantal kostenplaatsen per niveau.
Negatieve boeking (met minteken).
Rapporten zoals balans en winst- en verliesrekening:

https://www.banana.ch/apps/nl/node/9034
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Saldo wordt voortdurend bijgewerkt.
Op maat gemaakte overzichten.
Rekeningkaart van alle boekingen met voortschrijdend saldo.
Contextafhankelijke grafiek.

Segmenten

Functie kan naar keuze worden geactiveerd (door het toevoegen van rekeningen voor
segmenten in het rekeningschema).
Segment kolom
De balans en resultatenrekening van een of meer bedrijfssectoren.
Het instellen van segmenten direct in de rekeningentabel
Tot 10 segmentniveaus.
Groepering op meerdere niveaus.
Onbeperkt aantal segmenten per niveau.
Saldo wordt voortdurend bijgewerkt.
Rapporten zoals balans en winst- en verliesrekening:

Op maat gemaakte overzichten.
Rekeningkaart van alle boekingen met voortschrijdend saldo.
Contextafhankelijke grafiek.

Balans en resultatenrekening voor ieder segment.

Itemstabel

Voor facturen en met geïntegreerd magazijn- of artikelenbeheer.
Koppeling van items aan de boekingen in de transactietabel.
Automatisch bijgewerkte boekingen voor inkomende en uitgaande artikelen.
Begin- en eindwaarde.
Toevoegen van extra kolommen.

Controle en afsluiting

Foutrapportage en boekhouding controle

Commando om de rekeningen te controleren.
De boekhouding wordt opnieuw berekend alsof alle bewerkingen opnieuw ingevoerd worden.
Rapporteert elke foute instelling, verschil of fout.
Ieder rapport is gekoppeld aan een helppagina die de oorzaken uitlegt en de oplossing
voorstelt.
Controleert of het rekeningsaldo overeenkomt met het echte saldo (contanten, bank, BTW).
Mogelijkheid om te corrigeren.

Transactie bescherming

Beveiliging van rijen.
Vergrendeling van ingevoerde boekingen met digitale gegevens certificatie techniek (Bitcoin
type).
Beveiliging met een wachtwoord.
Voldoet aan wettelijke eisen.
Gegevens sturen naar de auditor met de zekerheid dat er niet mee geknoeid kan worden.
Boekingen met een bepaalde datum ontgrendelen.
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Afsluiting en nieuw jaar opening

Procedure om automatisch het bestand voor het nieuwe jaar aan te maken.
Overdracht van openingssaldi voor balansrekeningen.
Werk aan het nieuwe jaar kan beginnen, zelfs als het vorige nog niet is afgesloten.
Commando om de eindsaldi van het vorige jaar over te dragen.

Gegevens exporteren en archiveren

Direct vanuit excel kopiëren en plakken.
Tabellen naar PDF en verschillende andere formaten exporteren.
Archiveren van afdrukken en boekhoudgegevens naar PDF of andere formaten.
Extensies om een standaard auditbestand aan te maken .
Het boekhoudbestand op elk soort backupmedium opslaan.

Extensies en andere functies

Functies toevoegen

Nieuwe functies toevoegen.
Functies die niet langer nodig zijn verwijderen.
Overzetten van het ene type boekhouding naar het andere:

Boekhouding met of zonder BTW.
Naar vreemde valuta boekhouding of weer terug.
Van inkomsten/uitgaven boekhouding naar dubbel boekhouden of weer terug.

Documententabel

Om afbeeldingen op te slaan (bedrijfslogo's) of tekst documenten (bijvoorbeeld Javascript
programma's).

Andere extra tabellen

Toevoegen van andere tabellen waarin notities of andere informatie kan worden ingevoerd.
Tabellen kunnen worden aangepast door kolommen eraan toe te voegen.

Extensies

Standaard extensies voor diverse afdrukken en andere functies .
Snel op te zoeken en te installeren.
Automatisch bijwerken.
Op maat te maken extensies.
De mogelijkheid om uw eigen lokale extensies te ontwikkelen en te installeren .

Uitgebreide documentatie
Ieder dialoogvenster en foutmelding heeft zijn eigen documentatie bereikbaar in één klik .
Documentatie die voortdurend bijgewerkt wordt .
FAQ .
Documentatie ook in Pdf formaat beschikbaar.

https://www.banana.ch/nl/node/10640/
https://www.banana.ch/apps/nl/extensions
https://www.banana.ch/nl/node/9386
https://www.banana.ch/doc/nl/search?search=fout
https://www.banana.ch/doc/nl/documentatie
https://www.banana.ch/nl/node/9340
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Bestands- en boekhoudingseigenschappen

Hier worden de hoofdgegevens van de boekhouding ingevoerd zoals de kopteksten van de afdrukken,
de begin en eind datums, de basis valuta, het bedrijfsadres, de BTW rekening, het wachtwoord, etc.

Het Bestands- en boekhoudeigenschappen venster heeft de volgende tabbladen:

Tabblad Boekhouding
Tabblad Opties
Tabblad Adres
BTW
Tabblad Andere
Tabblad Wachtwoord
Tabblad Teksten
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Rekeningschema

De rekeningentabel is de controlekamer van uw boekhouding. Het gebruik lijkt op dat van een Excel
spreadsheet. In de rekeningentabel stelt u alles in wat u nodig heeft om de boekhouding te doen en
om altijd een bijgewerkt overzicht te hebben van de financiële en economische situatie van uw
bedrijf.

Invoeren en aanpassen van gegevens is simpel
Voeg rekeningen toe en verander ze, snel en eenvoudig, door het invoeren, veranderen of
verwijderen van de regel waarin ze staan.
Er is geen limiet aan het aantal rekeningen dat toegevoegd kan worden in het rekeningschema.
Ieder rekening kan bestaan uit cijfers of letters.
De beschrijving kan heel lang zijn.
De groepen en subgroepen kunnen naar eigen inzicht ingedeeld worden om de balans en de
resultatenrekening samen te stellen.
De beginsaldi worden direct in de kolom Opening ingevoerd.
Er kunnen kolommen toegevoegd worden om extra informatie in te voeren.
Rekeningen kunnen ook in de transactietabel automatisch hernoemd en vervangen worden.
De kolommen met de bedragen worden direct bijgewerkt, in een oogopslag weet u de status
van liquiditeit, kapitaal, verkopen, winst.
Met het opzetten van het budget heeft u de vergelijking met de eindbalans.

Flexibel groepen systeem
Het systeem met groepen is heel flexibel en krachtig:

Hiermee kunt u voor elk land het rekeningschema opzetten en het precies aanpassen aan de
wensen van het bedrijf.
Als u niet tevreden bent met de indeling of nummering van de rekeningen en groepen kunt u
deze makkelijk aanpassen.

De structuur van het rekeningschema in de rekeningtabel wordt ook in de presentatie van de balans
en de resultatenrekening gebruikt.
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Belangrijkste elementen

Secties
Deze geven de indeling van het rekeningschema voor het afdrukken van de Balans en Winst- en
Verliesrekening aan.
Groepen
Hiermee kunt u elementen maken die de rekeningen en subgroepen optellen op meerdere
niveaus.
Rekeningen
Dit zijn de elementen van de boekhouding waar de boekingen worden vastgelegd. Ze worden
aangegeven in debet of credit afhankelijk van het soort boeking, bestemming of oorsprong.
Deze geven aan op welke rekening (debet of credit) de boekingen moeten worden gedaan.
Iedere rekening heeft een code of een nummer (rekeningnummer), een beschrijving, een klasse
en een groep waartoe deze behoort; ze hebben ook een beginsaldo, het huidige saldo, het
budget, etc.

Klant- en leveranciersgegevens
U kunt speciale rekeningen hebben voor het versturen van facturen en het controleren van
betalingen. Deze worden gewoonlijk geplaatst aan het eind van het rekeningschema. Ze kunnen
worden ingesteld als een register met de saldi gekoppeld aan de balans of als kostenplaats of
winstcentrum met alle details maar zonder koppeling naar de balans.

Klantenregister
Leveranciersregister

Kostenplaatsen en winstcentra
Geschikt om projecten te beheren of om precieze details te hebben van een specifiek evenement, of
om klanten en leveranciers te beheren volgens het kasstelsel.

Kostenplaatsen en winstcentra
Dit zijn speciale rekeningen waarvan het nummer voorafgegaan wordt door een punt ".", een
komma "," of een punt-komma ";". Ze worden gebruikt om bedragen toe te kennen aan speciale
rekeningen anders dan de algemene boekhoudrekeningen.

Segmenten
Deze worden gebruikt om overzichten te maken van de verschillende sectoren of activiteiten waarin
het bedrijf actief is. 

Segmenten
Dit zijn een soort sub-rekeningen waarvan het rekeningnummer voorafgegaan wordt door een
dubbele punt ":". Ze worden gebruikt om sommige transacties toe te kennen aan
subcategorieën van het rekeningschema.

Geavanceerde afdrukken
Met de volgende commando's kan de gebruiker rekeningen weergeven en afdrukken op een andere
manier:

http://www.banana.ch/doc/nl/node/3317
http://www.banana.ch/doc/nl/node/2629
http://www.banana.ch/doc/nl/node/3900
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Boekhoudoverzicht
Het is mogelijk om alleen de rekeningen met transacties te selecteren, om een tijdelijke
groepering te krijgen of rekeningen gegroepeerd volgens de B-Klasse of volgens een extern
groeperingsschema.
Uitgebreide Balans
Drukt alle rekeningen van de boekhouding af verdeeld in Activa, Passiva, Uitgaven en
Inkomsten
Uitgebreide Balans op groepen
Laat de gebruiker aangepaste afdrukken maken met groepen.
Specifieke geavanceerde afdrukken zijn beschikbaar door de Banana Extensions  te
gebruiken.

https://www.banana.ch/apps/nl
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De kolommen van het Dubbel boekhouden

De rekeningentabel bestaat uit verschillende kolommen. Afhankelijk van de Weergaven worden
kolommen gezamenlijk getoond. Iedere kolom heeft zijn eigen functie.

Hierna wordt voor de volgende kolommen uitgelegd welke gegevens moeten worden ingevoerd:

Secties
Hier worden codes ingevoerd waarmee de gebruiker afgebakende delen van het
Rekeningschema kan afdrukken als hij de Uitgebreide Balans op groepen afdrukt.
 
Groep
Bevat de code die bepaald dat dit een rij met codes voor groepen is. De groepscode wordt dan
gebruikt in de GR kolom om de optelling van rekening of een groep aan te geven.
 
Rekening
Het rekeningnummer, de kostenplaats of het segment wordt hier ingevoerd.
 
Beschrijving
Een tekst met de beschrijving van de rekening, groep of sectie.
 
Uitschakelen (alleen zichtbaar in de weergave Andere)
Door een 1 in te voeren verschijnt de rekening niet in de auto-aanvullen lijst maar kan wel
worden gebruikt in de transactietabel.
Door een 2 in te voeren wordt de rekening uitgeschakeld en kan niet worden gebruikt.
 
Bklasse
Dit geeft aan of de rekening thuishoort in 1 = Activa, 2 = Passiva, 3 = Uitgaven, 4 = Inkomsten,
zie ook Rekeningen
 
Tel Op In (Gr)
Dit geeft een groep aan zodat het programma deze regel op kan tellen in deze groep.
 
Gr1 en Gr2
Extra groepscodes voor gebruik met extern boekhoudoverzicht bestanden.
 
Openingssaldo

Het rekeningsaldo wordt aan het begin van het jaar ingevoerd.
Creditbedragen moeten worden ingevoerd met een minteken ervoor.
Het totaal van alle bedragen, in debet (positief) en credit (negatief) van de rekeningen die
behoren tot klasse 1,2,3 en 4 moet nul zijn. Wanneer de beginsaldi niet in evenwicht zijn
wordt een verschil aangegeven in het informatievenster.
Als er rekeningen toegevoegd zijn en er is een verschil laat dan de boekhouding opnieuw
berekenen.
Het beginsaldo in de balansrekeningen wordt gebruikt om het huidige saldo te berekenen.
Als er bedragen zijn ingevoerd in de budgettabel wordt het beginsaldo door het
programma gebruikt om de financiële planning mee te beginnen.
Zie voor meer informatie pagina Dubbel boekhouden beginsaldi.
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Debet Mutaties en Credit Mutaties (Beveiligde kolommen)
Het totaal van de debet en credit mutaties in de Transactietabel.

Als er geen fouten zijn, zijn de totalen van de twee kolommen in evenwicht, anders wordt
er een verschil weergegeven in de kolom Saldo dat gecontroleerd en gecorrigeerd moet
worden.
In de regel met Verschil moet nul zijn is het correct als er bedragen te zien zijn in deze
twee kolommen. Het is belangrijk dat deze bedragen gelijk zijn. Zie ook de pagina
Wiskundige basis  van het boekhouden.
 

Saldo  (Beveiligde kolom)
Het saldo van de rekening bestaat uit het beginsaldo samen met de mutaties in debet en credit.
Het saldo in debet is positief terwijl een credit saldo negatief is (minteken).
 
Budget
Hier voert u het budget bedrag in voor huidige periode.

Het budget bedrag voor Uitgaven (debet) moet worden ingevoerd als een positief bedrag,
voor Inkomsten als negatief (credit).
Wanneer de Budgettabel is geactiveerd is de Budget kolom in de rekeningentabel
beveiligd en worden de bedragen erin berekend op basis van de budget boekingen.
 

Budgetverschil (Beveiligde kolom)
Het verschil tussen het Saldo en het Budget bedrag.
 
Vorige
Het saldo van de rekening aan het eind van het voorafgaande jaar.
Met het commando Nieuw jaar aanmaken of Beginsaldi bijwerken worden de waardes in de
Saldo kolom van het bestand van het vorige jaar overgedragen.
De bedragen van het voorafgaande jaar moeten handmatig worden ingevoerd wanneer een
nieuwe boekhouding wordt aangemaakt en de gebruiker afdrukken wil hebben met de
bedragen van dat jaar.
 
Verschil Vorig Jaar (Beveiligde kolom)
Het verschil tussen het Saldo en het bedrag van het vorige jaar.
 
BTW-Nummer
Het BTW nummer in het geval dat deze rekening is verbonden aan een klant of leverancier.
 
BTW-code
De BTW code die automatisch moet worden toegepast als deze rekening wordt ingevoerd in de
Debetrekening- of Creditrekeningkolom van een Transactie.
 
Adres kolommen
Het is mogelijk het programma adreskolommen toe te laten voegen om klant- en
leveranciersgegevens te beheren.

Toevoegen of verplaatsen van kolommen
Als een kolom van het type Bedrag wordt toegevoegd in het Rekeningschema stelt het
programma het totaalbedrag samen volgens het geselecteerde groepsschema
Toegevoegde kolommen van het type Getal daarentegen worden niet getotaliseerd.
Met het Kolommen instellen commando kunnen kolommen zichtbaar worden gemaakt, de

https://www.banana.ch/nl/node/10964
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volgorde kan worden veranderd en het is mogelijk andere kolommen toe te voegen.
Met het Pagina instelling commando kan men de opmaak van de afdruk (staand of liggend,
vergroting, etc) instellen.

Rekeningen lijst gesorteerd op beschrijving of andere
criteria
Om lijsten van rekeningen, gesorteerd op verschillende manieren, te krijgen gebruikt u het Rijen
ophalen en sorteren  commando van het menu Gegevens. We raden u aan heel voorzichtig te zijn met
het sorteren van rijen op verschillende criteria om geen verwarring te veroorzaken in de groepering
en de totalen.

Weergaven
Het rekeningschema wordt aangemaakt met standaard weergaven.

Basis Weergegeven worden de belangrijke kolommen, de groeperingskolommen en de saldi.
Transacties Weergegeven worden de kolommen met de Debet en Credit transacties.
Budget Weergegeven worden de Budget en de Budget Verschil kolommen.
Vorige Weergegeven worden de Vorige en de Vorige Verschil kolommen die betrekking hebben
op het vorige jaar.
Andere Weergegeven worden de Uitschakelen kolom en de kolommen voor het BTW-nummer
en het Fiscale nummer..
Afdrukken Weergegeven worden alleen kolommen voor de Rekening, de Beschrijving en het
Saldo.

De weergaven kunnen worden aangepast en nieuwe kunnen worden toegevoegd met de functie
Weergaven instellen.
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Rekeningen | Dubbel boekhouden

Rekeningen bepalen de hoofdstructuur waarop elke boekhouding berust. Als u één van de modellen
van Banana Boekhouding , opent zijn de rekeningen al aanwezig in de rekeningentabel en bevatten
alle instellingen die nodig zijn om direct transacties in te voeren in de transactietabel.

De rekeningen in de rekeningentabel zijn als volgt onderverdeeld:

Balans rekeningen - activa en passiva.
Winst- en verliesrekeningen - Inkomsten en uitgaven.
Klanten en leveranciers basisgegevens.
Rekeningen voor kostenplaatsen en winstcentra - voor het beheer van projecten of voor het
klanten / leveranciers register.
Segment rekeningen - voor het beheer van bedrijfssectoren of -vestigingen.

De BKlasse
De BKlasse is essentieel voor correct totalen van bedragen en saldi. In de kolom BKlasse moet iedere
rekening één van de volgende waardes krijgen, onafhankelijk van het rekeningnummer of groep
waartoe deze behoort:

1 - voor activa
2 - voor passiva
3 - voor uitgaven
4 - voor inkomsten

Groepen en subgroepen hebben geen BKlasse, daarom blijft de cel in de betreffende kolom leeg.

BKlasse van niet in de balans opgenomen rekeningen
Niet in de balans opgenomen rekeningen zijn rekeningen waarvan de bedragen en saldi niet in de
totalen van de balans en resultatenrekening worden opgenomen. Het zijn rekeningen voor
bijvoorbeeld aanbetalingen en voorwaardelijke verplichtingen.
Buiten de balans rekeningen moeten de volgende BKlasse krijgen:

5 voor Activa Buiten Balans
6 voor Passiva Buiten Balans
7 - 10 - voor andere rekeningen  Buiten Balans

Een nieuwe rekening of categorie toevoegen
U kunt in de rekeningentabel, weergave Basis, nieuwe rekeningen (of nieuwe categorieën in de
inkomsten / uitgaven boekhouding) toevoegen.

Belangrijk om te weten voordat u een rekening of categorie toevoegt:

Het rekeningnummer kan samengesteld worden uit cijfers, letters en scheidingstekens.
Het is niet mogelijk meer dan één rekening met hetzelfde nummer te hebben.
Iedere rekening moet een BKlasse hebben en tot een groep horen.

https://www.banana.ch/apps/nl
https://www.banana.ch/apps/nl
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Ga als volgt te werk om een rekening of categorie toe te voegen:

Ga naar de rij voor die waarin de nieuwe rekening of categorie wordt toegevoegd.
Voeg een rij toe met het commando Bewerken → Rijen invoegen.
Vul in de betreffende kolommen in: het rekening- of categorienummer, de beschrijving, de
BKlasse (1 voor activa, 2 voor passiva, 3 voor uitgaven, 4 voor inkomsten - alleen voor dubbel
boekhouden), het nummer voor Gr dat hetzelfde moet zijn als het nummer ingevoerd voor de
rekeningen die bij dezelfde groep horen.

Waarschuwing: als u een transactie invoert met een rekeningnummer dat niet in het rekeningschema
voorkomt krijgt u een foutmelding; om deze te verwijderen is het nodig de boekhouding opnieuw te
berekenen met het commando Shift + F9 of via het menu Acties → Totalen opnieuw berekenen....

De naam van een rekening wijzigen
Dit is een erg nuttige functie omdat u hiermee de naam van een rekening kunt veranderen en deze
verandering tegelijk door kunt laten voeren in de transactietabel. Hierdoor hoeft u niet de rekening in
iedere transactie, die de vorige rekening bevat, te veranderen. Bovendien kunt u hiermee ook een
groep of een BTW code veranderen.

Ga in de rekeningengabel naar de rekening / categorie of groep kolom, of naar de BTW
code kolom van de BTW codes tabel.
Gebruik het commando Gegevens → Hernoemen.
Geef de nieuwe rekening, groep, categorie naam of BTW code.

Het programma werkt automatisch de transactietabel bij met de nieuw naam of BTW code.

Een rekening verwijderen
Wanneer een boekhouding reeds gestart is moet u er zeker van zijn dat een rekening nog niet
gebruikt is in de transactietabel en dat deze nog geen beginsaldo heeft voordat u deze verwijdert.

Ga naar de rij met de rekening die verwijderd moet worden.
Gebruik het commando Bewerken → Rijen verwijderen....

Het wordt aangeraden na het verwijderen van een rekening of een categorie het commando Acties →
Totalen opnieuw berekenen te gebruiken. Het programma geeft een foutmelding als de verwijderde
rekening of categorie in gebruik is in transacties.

Beginsaldi
Het beginsaldo van iedere rekening wordt getoond in de Opening kolom.

De Activa saldi worden normaal, positief, weergegeven
De Passiva saldi worden ingevoerd met het minteken (negatief)
Doorgaans worden alleen de Activa en Passiva beginsaldi aangegeven.

Bekijk de Jaarafsluiting en nieuw jaar pagina om te zien hoe de beginsaldi automatisch naar het
volgende jaar kunnen worden overgebracht.

Meer details over beginsaldi zijn te vinden op de pagina Begin saldi.
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Verschillen in de Beginsaldi
In een correct boekhoudbestand moet het totaal van de beginsaldi van de Activa gelijk zijn aan het
totaal van de beginsaldi van de Passiva, er worden dus geen verschillen getoond.
Als de totalen niet overeenkomen laat het programma een foutmelding zien met de melding dat er
een beginsaldi verschil is (informatie venster).
Als u rekeningnummers veranderd heeft en u denkt dat de foutmelding niet correct is controleer de
boekhouding opnieuw met het Boekhouding opnieuw controleren commando van het menu
Rapporten, of gebruik Shift + F9.
Als u Banana Boekhouding voor de eerste keer gebruikt moet u de beginsaldi handmatig invoeren
(kolom Opening). Zorg ervoor dat de saldi van de passiva worden ingevoerd met een minteken (-)
voor het bedrag.

Meer details zijn beschikbaar op de pagina's:

Verschillen in beginsaldi (Dubbel boekhouden).
Verschillen in beginsaldi (Vreemde valuta boekhouding).

Klanten en leveranciers rekeningen
Klanten en leveranciers rekeningen kunnen direct in de secties van de balans worden ingevoerd.
Hiermee kunnen lijsten van klanten en leveranciers worden gemaakt met twee gescheiden groepen
voor de totalen, een voor de activa voor klanten en de andere voor de passiva voor de leveranciers.
Als de lijst van klanten en leveranciers erg lang is, is het mogelijk een klanten / leveranciers register
te creëren aan het eind van het rekeningschema.

Er zijn verschillende mogelijkheden om dit op te zetten:

Direct in het gedeelte van de Jaarrekening waarbij de klanten en leveranciers respectievelijk in
de activa en passiva worden opgenomen.
Opzet met klanten / leveranciers register aan het eind van het rekeningschema met de totalen
in de jaarrekening. Deze opzet is ideaal voor diegenen die de BTW beheren met de methode
van het factuurstelsel.
Opzet met klanten / leveranciers register aan het eind van het rekeningschema met de totalen
in de balans.
Deze opzet is ideaal voor diegenen die de BTW beheren met de methode van het kasstelsel.

Rekeningen met addressen
In de weergave Adressen van de rekeningentabel zijn kolommen te vinden om de adressen van
klanten, leveranciers of leden in te voeren. Wanneer de kolommen niet aanwezig zijn kunt u deze
toevoegen met:

Menu Extra → Functies toevoegen → Adreskolommen toevoegen in de rekeningentabel.

De adreskolommen zijn essentieel om facturering te doen, herinneringen te sturen en betalingen te
doen.

Meer details zijn te vinden op de pagina Addresboek.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 274

De rekeningen voor kostenplaatsen en winstcentra
Deze zijn ideaal voor projectmanagement, hebben details over specifieke gebeurtenissen, of voor
andere behoeften.

Kostenplaatsen en winstcentra
Dit zijn rekeningen met een punt ",", komma "," of puntkomma ";" voor het rekeningnummer.
Ze worden gebruikt om de transactiebedragen op te tellen bij extra rekeningen als toevoeging
op de basis rekeningen.
Alle bedragen in de kostenplaatsen en winstcentra zijn gescheiden van de balans en
resultatenrekening en zijn alleen bedoeld voor informatief gebruik.

De Segmentrekeningen
Deze zijn om jaarrekeningen voor verschillende sectoren of activiteiten waarin het bedrijf actief is op
te maken.

Segmenten
Zij zijn vergelijkbaar met sub-rekeningen, waarbij het nummer wordt voorafgegaan door een
dubbele punt ":" en worden gebruikt om de boekhoudtransacties toe te schrijven aan sub-
categorieën van rekeningen.
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Rekeningen en categorieën aanpassen

Met Banana Boekhouding is het mogelijk om het rekeningschema aan te passen door rekeningen en
categorieën toe te voegen of te verwijderen.

Om een nieuwe rekening of categorie toe te voegen gaat u als volgt te werk:

Ga in de rij staan boven de rij waar u de nieuwe rekening toe wilt voegen
Voeg een nieuwe lege rij toe met het commando Rijen toevoegen
Voer in de toepasselijke kolommen in:

Het rekeningnummer
De beschrijving
De BKlasse (1 voor de Activa, 2 voor de Passiva, 3 voor de Baten en 4 voor de Lasten)
Het groeperingsnummer kolom Tel Op In, dat hetzelfde moet zijn als degene die
ingevoerd is voor de rekeningen die bij dezelfde Groep horen.

Als u een transactie invoert met een niet bestaande rekening geeft het programma een foutmelding;
om deze weg te krijgen moet u een nieuwe rekening aanmaken in het rekeningschema, en de
boekhouding controleren met de Shift + F9 toetscombinatie of met menu Acties → Boekhouding
controleren.

Een nieuwe groep toevoegen
Ga in de rij staan boven de rij waar u de nieuwe groep toe wilt voegen
Voeg een nieuwe lege rij toe met het commando Rijen toevoegen
Voer in de toepasselijke kolommen in:

Het groepsnummer
De groepsbeschrijving
Het groeperingsnummer kolom Tel Op In waarin deze groep opgeteld moet worden.

Een rekening, een groep, een categorie of een BTW code
hernoemen
Dit is een heel handige functie waarmee u een rekening, een groep, een categorie of een BTW code
kunt hernoemen waarna de vervanging automatisch plaatsvindt in de transactie- en de budgettabel
zonder dat u dit zelf handmatig moet doen.

Om een van deze elementen te hernoemen gaat u als volgt te werk:

Ga in de cel staan waar de rekening of groep (Rekeningentabel), of de categorie
(categorieëntabel), die hernoemd moet worden. zich bevinden.
Als het nodig is om een BTW-code te hernoemen, dan moet u in de btw-codetabel op de cel
gaan staan van de code die vervangen moet worden.
Kies het menu Gegevens → Hernoemen commando.
Voer de nieuwe rekening, categorie, groep of BTW-code in.
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Een rekening, een groep, een categorie of een BTW code
verwijderen

Ga op het rijnummer staan van het element dat verwijderd moet worden.
Klik op het menu Bewerken → Rijen verwijderen.
Voer het aantal rijen in dat u wilt verwijderen

Na het verwijderen van een rekening, een categorie, een groep of een BTW code is het nodig de
boekhouding opnieuw te controleren. Het programma geeft een waarschuwing als de verwijderde
rekening, categorie of groep in transacties werd gebruikt.

Als u een groep verwijdert en niet alle rekeningen die bij de verwijderde groep horen worden
verwijderd, dan moet u het groepsnummer in de kolom Tel op in veranderen voor de overblijvende
rekeningen, anders worden er fouten gerapporteerd.
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Groepen

Het groeperings- en totalisatie systeem
Banana heeft een heel praktisch en direct groepensysteem ontwikkeld waarmee u in de
rekeningentabel alle informatie kunt opnemen die nodig is om de structuur te definiëren van de
balans, resultatenrekening en andere onderdelen van de boekhouding.

Het groepensysteem is flexibel; hiermee kunt u een rekeningschema voor elk land implementeren en
het tegelijk aan de specifieke behoeften van uw bedrijf aanpassen. Zowel heel eenvoudige als erg
ingewikkelde schema's en presentaties kunnen worden gemaakt met meervoudige niveaus van
totalisatie, voor ieder soort boekhouding.

Nog een voordeel van dit systeem is dat u de resultaten direct kunt te zien kunt krijgen. Bij iedere
rekening en groep kunt u meteen het saldo zien, de mutaties en het budget. Totalen worden meteen
bijgewerkt terwijl u uw bestand aanpast.

Het Banana groepen- en totalisatiesysteem is gebaseerd op het gebruik van twee kolommen van de
rekeningen- en categorieëntabel:

Groep (TOTAAL rij)
Als een groep identificatie wordt ingevoerd in een rij dan wordt de rij een TOTAAL rij.
In deze rij worden de bedragen van de kolom Tel op in opgeteld die dezelfde identificatie
bevatten.
Als er een groep is in een regel kan er geen rekening zijn.

Tel op in
Telt de bedragen in deze rij op in de aangegeven groep.
Voor iedere rij met een rekening of een groep geeft u de groep aan in welke deze regel
opgeteld moet worden.
Het getal dat hier gebruikt wordt moet één van de getallen zijn die gedefinieerd zijn in de
Groep kolom.

Met dit systeem kan een rekening getotaliseerd worden in een groepsrij, de groep in een andere
groep en zo verder... om zo diverse totalisatieniveuas te creëren. Dit totalisatiesysteem is erg
krachtig en flexibel, maar het kost wat tijd om er aan te wennen om het echt goed te kunnen
gebruiken.

De opzet van de structuur van het rekeningschema
Het rekeningschema kan in Banana Boekhouding voornamelijk worden opgezet op twee verschillende
manieren:

1. Structuur zonder subgroepen (of subtotalen).

In dit geval is de structuur erg eenvoudig. U maakt een lijst van alle rekeningen zonder subgroepen
en telt alle rekeningen of categorieën op in de hoofdgroepen:

Voor Dubbel boekhouden:

Activa
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Passiva
Uitgaven
Inkomsten

Voor een inkomsten/uitgaven boekhouding of Cash Manager (met categorieëntabel):

Inkomsten
Uitgaven

2. Structuur met subgroepen

De structuur is complexer. De rekeningen of categorieën van de hoofdgroepen worden verdeeld in
verschillende subgroepen die op hun beurt worden opgeteld in de overeenkomstige hoofdgroepen.

Hier laten we de structuur zien van het rekeningschema met een voorbeeld van een
onderverdeling in subgroepen in een dubbele boekhouding. Iedere subgroep kan op zijn beurt:

Activa

Vlottende activa
Contanten en equivalenten
Klanten
Voorraad

Vaste Activa
Meubilair
Machines en uitrusting
Computers, software.

Passiva

Vreemd vermogen
Leveranciers
Bank leningen
Andere kortetermijnschulden
Langetermijnschulden

Eigen vermogen
Eigen vermogen
Reserve fondsen
Overgedragen winst en verlies
Winst over het boekjaar

U kunt op elk moment vanuit de rekeningentabel door menu Bestand → Afdrukken of
Afdrukvoorbeeld het rekeningschema of een gedeelte ervan afdrukken.
Vanuit de rekeningentabel heeft u altijd een afdruk van het controlesaldo door de weergave
Transactie.

Voorbeelden van de hoofdgroepen in het Dubbel
Boekhouden
Ieder boekhoudbestand model gebruikt zijn eigen totalisatiesysteem. Hierna worden de hoofdgroepen
van het Dubbel Boekhouden uitgelegd.
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In het Dubbel Boekhouden moet het totaal van de Debet saldi (positief) samen met de Credit saldi
(negatief) een 0 (nul) opleveren.

De 00 is de rij waar alle bedragen bij elkaar opgeteld worden.
Het is de "Summa summarum" van alle Debet & Credit saldi.
Als de Saldi kolommen geen nul opleveren is er een Debet/Credit verschil en is er
hoogstwaarschijnlijk een fout gemaakt. In dat geval is het verstandig de boekhouding te
controleren (zie volgende punt).
In de Debet en Credit kolommen van de Transacties weergave (Rekeningentabel) staan
alleen positieve bedragen, dus ook in de rij van de 00 groep zal het totaal van de
transacties niet gelijk zijn aan nul.

De volgorde van de berekeningen om tot het resultaat in 00 te komen is als volgt:

De 1000 rekening → groep 1 (Totaal Activa) → Groep 00
De 2000 rekening → groep 2 (Totaal Passiva) → Groep 00
De 3000 rekening → groep 3 (Totaal Uitgaven) → Groep 02 (resultaat Winst & Verlies rekening) 
→ Groep 206 (Winst/Verlies van het huidige jaar in de Balans) → Groep 2 (Totaal Passiva) →
Groep 00.
De 4000 rekening → groep 4 (Totaal Inkomsten) → Groep 02 (resultaat Winst & Verlies
rekening)  → Groep 206 (Winst/Verlies van het huidige jaar in de Balans) → Groep 2 (Totaal
Passiva) → Groep 00.

Het resultaat van de Winst & Verlies rekening wordt toegevoegd aan het
eigen vermogen

Zoals u kunt zien in het voorbeeld wordt de Groep 02 (Winst/Verlies van de Winst & Verlies rekening)
opgeteld in de groep 206 passiva (resultaat van het huidige jaar).
Met deze organisatie van de groep hebben we meerdere voordelen:

In het lopende jaar wordt het bedrijfsresultaat weergegeven in de balans
Het Totaal Passiva komt overeen met het Totaal Activa (op voorwaarde dat er geen fout in de
boekhouding zit).
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Toevoegen of verwijderen subgroepen
Ga op de regel staan boven de regel waar de nieuwe groep wordt ingevoerd
Voeg een regel toe met het commando Bewerken → Rijen toevoegen...
Typ het groepsnummer in de kolom Groep , een beschrijving en het GR nummer (kolom Tel op
in) waarin u deze groep opgeteld wilt hebben.

Toevoegen van een totalisatieniveau

Met dit systeem is het makkelijk om totalisatieniveaus toe te voegen.
Als we een subgroep voor de contanten & bank rekeningen willen maken:

Voeg een lege rij toe achter de bank rekening
Voer de waarde 10 in de Groep kolom in
Voer de waarde 1 in de kolom Tel op in in

Geef Tel op in 10 aan in de rekeningen 1000 en 1020
De volgorde voor de berekening wordt:
De 1000 rekening → Groep 10 (contanten & bank) → Groep 1 (Totaal Activa) → Groep 00.
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Als u een andere subgroep "Vlottende Activa" wilt toevoegen gaat u op dezelfde manier te werk:

Voeg een lege rij toe boven de rij van de Totale Activa
Voer de waarde 11 in de Groep kolom in
Voer de waarde 1 in de kolom "Tel op in" in

Geef de 11 aan de kolom "Tel op in" in "Klanten en Goederen voor verkoop (voorraad)" rijen.

Titelrijen (met Gr)

Ook in de titelrijen is het nuttig om de Gr (de groep van de Totaalrij) aan te geven waartoe deze rij
behoort.
Op deze manier wordt de titel niet afgedrukt in de uitgebreide balans op groepen wanneer de
rekeningen nul zijn.

Verwijderen van subgroepen

Als de Rekeningentabel subgroepen laat zien die niet langer nodig zijn of ongewenst kunnen deze
worden verwijderd. Verwijder eenvoudigweg de rij van de subgroep en verander de "Tel op in" van
elke rekening die deel uitmaakte van die subgroep.
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Controleren van de structuur

Als het Rekeningschema eenmaal opgezet is voer dan het menu Actie → Boekhouding controleren
commando uit. Als er fouten zijn geeft het programma daarvan een melding.

Oneindige lus fout

Deze waarschuwing verschijnt als aan Groep wordt opgeteld in een Groep van een lager niveau
waardoor een oneindige lus fout wordt veroorzaakt.
Er zou een oneindige lus ontstaan als, in het voorafgaande voorbeeld, de Activa Groep (1) zou worden
opgeteld in Groep 10.
Het programma zou, nadat het de Groep 1 had berekend, het bedrag in Groep 10 optellen waarna dat
op zijn beurt in Groep 1 opgeteld zou worden en daarna weer in 10 zonder dat er een eind aan kwam.

Winst & Verlies Rekening met Bruto Winst
Het is ook mogelijk een Winst & Verlies Rekening te gebruiken die begint met het totale
Bedrijfsresultaat en die daar de kosten van aftrekt.
Hieronder staat een voorbeeld van het Zwitserse PME Rekeningschema.

Uitgebreid gebruik van het totalisatiesysteem
Het totalisatiesysteem is erg flexibel:

Het is mogelijk zowel Groepen als Rekeningen op te tellen in een Groep
Dit is te zien in het eerder getoonde voorbeeld waar de Groep Liquide middelen (10) en de
rekeningen (1030 en 1090) worden opgeteld in de Activa.
Het is ook mogelijk om de groep aan titelrijen toe te kennen
Op deze manier wordt de titel van een groep niet afgedrukt als de groep niet in de afdruk
voorkomt omdat deze nul is.
U kunt wat voor soort nummering ook gebruiken
U kunt tot honderd totalisatieniveaus creëren

De Totaal rij kan na de rijen staan
De Totaal rij kan voor de rijen staan
De Totaal rij kan totaal ergens anders staan op een aparte plaats
Dit wordt gebruikt om registers te maken (bijvoorbeeld een klantenregister)

De rekeningen en de Groepen kunnen opgeteld worden in één enkele andere Groep.
Het is niet mogelijk één en dezelfde rekening tegelijk in twee Groepen op te tellen.
Dit systeem wordt ook gebruikt om de Kostenplaatsen en de Segmenten op te tellen.
Let er echter op geen verschillende groepen te gebruiken voor normale rekeningen en voor
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kostenplaatsen, omdat de resulterende bedragen dan niet correct zullen zijn. 

Optelling van de Rekeningkolommen

De berekeningsprocedure telt de kolommen met bedragen op:

De kolommen met bedragen gedefinieerd door het systeem worden opgeteld.
De kolommen met bedragen toegevoegd door de gebruiker worden opgeteld.

De volgorde van de berekening

Het programma berekent de totalen op de volgende manier:

Zet de waardes van de kolommen met Bedragen van de Groepen op nul
Telt de bedragen van de Rekeningrijen in de Groepsrijen (eerst berekeningsniveau)
Telt het saldo van de Groepsrijen in de Groepen van een hoger niveau
Herhaalt de bewerking totdat alle niveaus zijn berekend.

Gerelateerde Documenten

Beginsaldi
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Secties

De kolom Sectie moet een codering bevatten die wordt gebruikt om de verschillende instellingen van
de afdrukken  te bepalen. De verschillende onderdelen van de boekhoudoverzichten zijn verdeeld in
diverse secties; elke sectie staat op zichzelf.

Met deze onderverdeling in secties kunt u kiezen of u de hele balans en reseltatenrekening wil
afdrukken of welke secties afgedrukt moeten worden (bijvoorbeeld alleen de balans of juist een groep
waarbij andere onderdelen worden weggelaten van de afdruk).

Hieronder een tabel met codes die gebruikt moeten worden in de kolom Sectie van de
rekeningentabel:

* Titel 1 het sterretje scheidt de secties en geeft de hoofd-koppen aan
** Titel 2 te gebruiken voor de tweede-niveau-koppen
1 Activa te gebruiken in de titelrij van de Activa
2 Passiva te gebruiken in de titelrij van de Passiva
3 Lasten te gebruiken in de titelrij van de Lasten
4 Baten te gebruiken in de titelrij van de Baten
01 Klantenlijst te gebruiken in de titelrij van de Klantenlijst
02 Leverancierslijst te gebruiken in de titelrij van de Leverancierslijst
03 Kostenplaatsen te gebruiken in de titelrij van de Kostenplaatsen
04 Winstcentra te gebruiken in de titelrij van de Winstcentra
# Opmerkingen te gebruiken in de titelrij van de Opmerkingen
#X Verborgen gegevens te gebruiken in de rij vanwaar de gegevens onzictbaar moeten blijven

De code in de kolom Sectie wordt gebruikt om de afdrukinstellingen te bepalen voor de uitgebreide
balans op groepen.

Iedere sectie wordt afgedrukt alsof het een aparte tabel is.

De rubrieken
* Titel 1 levert een niveau 1 rubriek op.
Deze kan niveau 2 secties of rubrieken bevatten.
Dit is handig voor het groeperen van secties die samen afgedrukt moeten worden zoals de
balans die zowel activa als passiva bevat.
** Titel 2 levert een niveau 2 rubriek op.

De basis secties
Het sectienummer bepaalt:

Hoe de bedragen worden afgedrukt: de bedragen kunnen worden weergegeven zoals in het
rekeningschema of omgekeerd.
De creditbedragen (negatief) worden positief weergegeven als deze omgekeerd zijn, terwijl de
positieve bedragen negatief worden weergegeven.
Welke kolommen worden gebruikt om bedragen weer te geven: of de kolom Saldo of de
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kolom Totaal transacties in periode wordt gebruikt.
De kolom Saldo geeft het saldo van de rekening aan op een bepaalde tijd (saldo per 30
juni).
De kolom Totaal transacties in periode geeft het totaal van de transacties in de
aangegeven periode aan; dit wordt gebruikt voor de resultatenrekening en geeft de
uitgeven of inkomsten voor een bepaalde periode aan.

Uitleg van de verschillende secties

1 Activa (bedragen zoals in het rekeningschema, kolom saldo).
2 Passiva (negatieve bedargen, kolom saldo).
3 Kosten (bedragen zoals in het rekeningschema, kolom totaal transacties in periode).
4 Inkomsten (negatieve bedargen, kolom totaal transacties in periode).
Deze sectie kan ook alleen worden gebruikt en bevat zowel kosten als baten
(resultatenrekening). In dit geval worden baten positief weergegeven en lasten negatief.

Deze secties moeten uniek zijn. Er kan maar één sectie 1 activa of 2 passiva zijn. Gelijksoortige
secties kunnen worden gebruikt voor andere secties, grootboeken of kostenplaatsen.

Afgeleide secties
Secties die werken zoals de hoofdsecties:

01 Als Activa (bedragen zoals in het rekeningschema, kolom saldo)
Wordt gebruikt voor het klantenregister.
02 Als Passiva (negatieve bedargen, kolom saldo)
Wordt gebruikt voor het leveranciersregister.
03 Als Uitgaven (bedragen zoals in het rekeningschema, kolom totaal transacties in periode)
Wordt gebruikt voor kostenplaatsen.
04 Als Inkomsten (negatieve bedargen, kolom totaal transacties in periode)
Wordt gebruikt voor winstcentra.

Andere Secties
Er zijn andere soorten secties:

# Gebruikt om de sectie met notities (alleen afdruk beschrijving)
Te gebruiken voor budget bijlagen.
#X Verborgen sectie. Deze sectie wordt niet opgenomen in de selectie van de secties noch in
de afdruk. Deze wordt gebruikt om een gedeelte aan te geven dat u niet af wilt drukken.

Opstelling en breedte van de kolommen bij het afdrukken
De kolomopstelling en de breedte van de kolommen worden automatisch bepaald door het
programma:

De secties 1, 2, 01, 02 worden afgedrukt met de saldi op de aangegeven datum.
De secties 3, 4, 03, 04 worden afgedrukt met de bewegingen voor de periode.
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Secties van de Balans
Om de balans in de verschillende rubrieken te kunnen indelen, moeten de in de kolom Sectie de
volgende codes worden ingevuld:

Een * op dezelfde rij als de titel van de Balans.
Een 1 op dezelfde rij als de titel van de Activa.
Een 2 op dezelfde rij als de titel van de Passiva.

Secties van de Winst & Verlies rekening
Voer een * in op dezelfde regel als de titel van Winst & Verlies.
Voer een 4 in op dezelfde regel als de titel van Baten.
Voer een 3 in op dezelfde regel als de titel van Lasten.

Secties van Winst & Verlies in een trapsgewijs formaat
In het geval van een trapsgewijze resultatenrekening wisselen de groepen van uitgaven en inkomsten
elkaar af is er daardoor geen duidelijk onderscheid tussen de sectie van kosten en inkomsten; voer
daarom alleen in:
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Een * op dezelfde rij als de titel van de Winst & Verlies rekening.
Een 4 op de lege rij onder als de titel van de Winst & Verlies rekening.

Secties in het klanten / leveranciers register
De weergave van de bedragen is hetzelfde als voor activa en passiva. Deze codering is ook van
toepassing als klanten en leveranciers worden ingesteld als kostenplaatsen.

Voer een * in op dezelfde regel als de titel van het Klanten / Leveranciers register of op een
lege regel (zoals in het voorbeeld).
Voer 01 in op dezelfde regel als de titel van het Klanten register.
Voer 02 in op dezelfde regel als de titel van het Leveranciers register

Als er kostenplaatsen en winstcentra zijn moet u invoeren:

Een * in dezelfde regel als de Kostenplaatsen en Winstcentra of in een lege regel
03 in dezelfde regel als de titel van de Kostenplaatsen of in een lege regel (voorafgaande aan
de kostenplaatsen).
04 in dezelfde regel als de titel van de Winstcentra of in een lege regel (voorafgaande aan de
Winstcentra).

De kostenplaatsbedragen worden positief getoond als kosten; winstcentra bedragen worden negatief
weergegeven als inkomsten.
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Gerelateerd document: Uitgebreide Balans op groepen
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Boekhouding gegevens overzetten naar een
nieuw rekeningschema

Hieronder leggen we uit hoe te handelen bij:

overgang naar een rekeningschema met een afwijkende nummering
het ophalen en converteren van de gegevens van een bestaande boekhouding, inclusief de
transacties, naar een nieuw rekeningschema.

Converteren naar een nieuw jaar
Als u een nieuw jaar wilt beginnen met een nieuw rekeningschema zijn er twee mogelijkheden:

Het vorige jaar (2022) converteren en dan een nieuw jaar (2023) aanmaken.
U heeft dan twee verschillende bestanden voor het jaar 2022 (een met het oude
rekeningschema, met een kolom Rekeningen_1 met de nieuwe rekeningnummers) en een enkel
bestand voor het jaar 2023 met het nieuwe rekeningschema.
Deze aanpak is ideaal om de rekeningschema's van de twee jaren op elkaar af te stemmen.
Op deze manier kunt doorgaan met het maken van veranderingen in het jaar 2022 en dan de
beginsaldi bijwerken in het jaar 2023.
Het bestand voor het nieuwe jaar 2023 aanmaken en dan het bestand van het jaar 2023
converteren met de overgedragen saldi.
Het jaar 2022 blijft onveranderd. Voor het jaar 2023 heeft u een overgangsbestand met het
oude rekeningschema maar met de bijgewerkte openingssaldi.
Het overzetten van het 2023 bestand kan gedaan worden meteen aan het begin maar ook
nadat enkele transacties ingevoerd zijn.
Omdat de oude rekeningnummers in het bestand van het jaar 2022 zitten kunt u veranderingen
gemaakt voor 2022 niet overhevelen naar 2023.

Stap 1: Een nieuw boekhoudbestand aanmaken
Maak een nieuw boekhoudbestand aan.1.

menu Bestand → Nieuw → kies een voorgedefinieerd boekhoudbestand model.
Pas het rekeningschema aan uw eigen wensen aan.2.

Stap 2: De passende rekeningen toevoegen
In de Rekeningentabel:1.

menu Gegevens → Kolommen instellen
Klik op de knop Toevoegen.
Voer de beschrijving Rekening_1 in.

Voer voor iedere rekening in de Rekening_1 kolom de overeenkomstige rekening in het oude2.
rekeningschema in.
Als de rekening hetzelfde blijft kunt u ervoor kiezen deze niet aan te geven.
Als meerdere rekeningen gegroepeerd moeten worden in één rekening voer dan de rekeningen3.
in gescheiden door een puntkomma "1000;1001".
Als één rekening verdeeld moet worden over meerdere rekeningen moet u handmatig4.
verdergaan, zie hierna.
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Stap 3: Het importeren beginnen
Via Acties →Naar boekhouding importeren... → Bestand.
Kies het bestand met uw oude rekeningschema met de knop Bladeren

Bevestig door op de OK knop te klikken en ga verder met het volgende scherm
Stel de import opties in
Activeer de optie voor Rekeningnummers converteren en geef aan dat de rekening-
combinaties zich in het doelbestand bevinden.

Het importeren herhalen

Als er fouten worden gemeld en het nodig is om het importeren te herhalen, is het nodig de importeer
bewerking te annuleren zodat het bestand waarmee begonnen wordt leeg is. Anders worden de saldo
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bedragen gedupliceerd, zowel in de beginsaldi als in de transactietabel.

Onderverdeling van een rekening in meerdere rekeningen
Wanneer men overgaat naar een meer gedetailleerd rekeningschema is het waarschijnlijk nodig een
rekening onder te verdelen in meerdere rekeningen.
Ga na het importeren op de volgende manier handmatig verder:

Verdeel in het Rekeningschema de beginsaldi, budgetsaldi en de bedragen van vorig jaar van
één rekening over meerdere rekeningen;
Ga door de transacties, een voor een, van de rekening die onderverdeeld moet worden en wijs
deze toe aan de meer toepasselijke rekening of maak extra transacties aan als dat nodig is om
een rekening in meer gedetailleerde rekeningen onder te verdelen.
Ga op dezelfde manier te werk voor de transacties van de Budget tabel.

Resultaten en mogelijke fouten
Als het programma fouten rapporteert (ontbreken van rekeningen of andere fouten) moet het
importeren waarschijnlijk worden onderbroken en de aanpassingen compleet gemaakt; herhaal
daarna het importeren.

Omdat het programma te maken heeft met verschillende rekenschema's kan het geen uitgebreide
verificaties doen en garanderen dat alle gegevens correct zijn geïmporteerd en gegroepeerd.

Het wordt daarom sterk geadviseerd om het resultaat handmatig te controleren om er voor te
zorgen dat de totalen van de Balans en de Winst & Verlies rekening correct zijn.
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Beginsaldi | Dubbel boekhouden

Beginsaldi bij het starten van een boekhouding
Wanneer Banana Boekhouding voor de eerste keer gebruikt wordt moeten de beginsaldi handmatig
ingevoerd worden om de openingsbalans te creëren

Nadat het rekeningsschema opgezet is, ga als volgt verder:

Ga naar de Rekeningen tabel, weergave Basis, Opening kolom.1.
Voer de beginsaldi van de Activa en Passiva handmatig in. De Passiva worden ingevoerd,2.
voorafgegaan door het minteken (-).
Controleer of de Totale Activa uitkomen op hetzelfde totaal als de Totale Passiva, zodat uw3.
boekhouding in evenwicht is. Als er verschillen zijn in de openingsbalans moet u deze
controleren en corrigeren.

Beginsaldi van kostenplaatsen
De kolom Opening in de rekeningentabel kan ook gebruikt worden om de beginsaldi van de
kostenplaatsen in te voeren.

Beginsaldi voor Segmenten
Om de beginsaldi van de segmenten in te voeren moeten begintransacties worden ingevoerd.
Meer details zijn te vinden op de pagina Segmenten.

Beginsaldi voor een
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boekhouding die al
begonnen is
Wanneer u met een nieuwe boekhouding begint en daarbij gegevens overneemt van andere
programma's zijn er twee mogelijkheden:

Begin met de boekhouding vanaf het begin van het jaar door de beginsaldi van het begin van1.
het jaar (rekeningtabel, kolom Opening) en de boekingen (transactietabel), die al met andere
programma's gedaan zijn, in te voeren (zie ook Gegevens overnemen vanuit andere
programma's). Hierdoor heeft u alle boekhoudgegevens in één bestand.
Beginnend op de datum wanneer de boekhouding wordt overgenomen:2.

Voer de beginsaldi (rekeningtabel, kolom Opening) in door de bedragen van de andere
boekhouding over te nemen.
Behalve het invoeren van de beginsaldi van de activa en passiva rekeningen is het ook
nodig de beginsaldi van de uitgaven (positieve bedragen) en de inkomsten (negatieve
bedragen) in te voeren.
Het bedrijfsresultaat tot op dat moment moet worden vermeld in de rekening voor
overgedragen winst/verlies.
Als het om winst gaat moet het beginsaldo als een negatief bedrag worden ingevoerd, bij
verlies als een positief bedrag.
Controleer dat de som van de beginsaldi nul is, met andere woorden dat het programma
geen verschillen aangeeft.
Voer de nieuwe transacties in de transactietabel in.

Beginsaldi met begintransacties
Beginsaldi kunnen ook worden ingevoerd als begintransacties in de transactietabel.

Ga voor iedere begintransactie als volgt te werk:

Geef de startdatum van de boekhouding als transactiedatum.
Voer in de kolom Type de code "01" (openingstransactie) in.
Geef de debet of credit rekening aan en het bedrag.
Het totaal van de begin debetsaldi moet gelijk zijn aan die in credit.

Beginsaldi die als transactie ingevoerd zijn worden gebruikt voor het maken van overzichten. Het
beginsaldo van transactie wordt opgeteld bij het bedrag dat in de kolom Opening van de
rekeningentabel is ingevoerd.

Saldi van het vorige jaar
Als u een nieuwe boekhouding begint door een bestaande over te nemen en u wilt de saldi van vorig
jaar in de afdrukken laten verschijnen moet u de saldi van vorig jaar invoeren in de kolom Vorig jaar
van de rekeningentabel in de weergave Vorige:

Voer de eindsaldi van de activa rekeningen van vorig jaar in.
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Voer de eindsaldi van de passiva rekeningen van vorig jaar in (voer een minteken in vóór het
bedrag).
Voer de eindsaldi van de uitgaven van vorig jaar in.
Voer de eindsaldi van de inkomsten van vorig jaar in (voer een minteken in vóór het bedrag).

Een nieuw jaar beginnen
Wanneer u begint met een nieuw jaar neemt het programma automatisch de beginsaldi over naar het
volgende jaar.
Zie ook Jaarafsluiting en nieuw jaar.

Wanneer voor een speciale reden de beginsaldi veranderd moeten worden kunnen deze handmatig
aangepast worden in de kolom Opening van de rekeningentabel. Zorg ervoor dat er na iedere
aanpassing geen boekhoudverschillen zijn. We raden in ieder geval aan om het overdragen van de
beginsaldi te doen met het commando Nieuw jaar aanmaken of, indien de boekhouding voor het
nieuwe jaar al is aangemaakt, met het commando Beginsaldi bijwerken.

De rekeningkaarten worden automatisch aangemaakt en het is niet mogelijk daar de beginsaldi direct
in te voeren of veranderingen te maken.

Om het beginsaldo in een rekeningkaart te veranderen moet u naar de rekeningtabel, kolom Opening,
gaan en om mutaties te corrigeren moet u de invoer in de transactietabel aanpassen.

Beginsaldi afdrukken
Om de beginsaldi af te drukken:

Om de inhoud van de tabel af te drukken gebruikt u het Afdrukvoorbeeld commando, en
selecteert u de rijen van de balans.
U kunt ook de Boekhoudafdrukken gebruiken en de afdruk instellen voor alleen de balans en de
kolom Opening.
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Verschillen in de beginsaldi

Aan het begin van het boekjaar moet het totaal van de Activa overeenkomen met het totaal van de
Passiva, anders is het niet mogelijk een correcte balans te hebben en is het nodig de reden daarvan
te onderzoeken en te corrigeren om er voor te zorgen dat er in het informatiescherm geen bericht
Verschil in beginsaldi staat.

Er kunnen verschillende redenen zijn die leiden tot een verschil in de beginsaldi:

Wanneer het programma voor de eerste keer gebruikt wordt zijn de passiva niet ingevoerd met1.
een minteken voor het bedrag.
Het resultaat van het vorige jaar werd niet automatisch toegewezen bij het aanmaken van een2.
nieuw jaar.
De saldi voor uitgaven en inkomsten zijn overgedragen bij het aanmaken van een nieuw jaar3.
terwijl dat niet gedaan had moeten worden.
Bij het handmatig invoeren van de beginsaldi is geen rekening gehouden met het resultaat van4.
vorig jaar. In dit geval correspondeert het verschil met de overgebrachte winst of verlies.
Bij het handmatig toewijzen van de winst aan meerdere rekeningen zijn scheidingstekens voor5.
de duizendtallen en decimalen gebruikt die afwijken van de in de Banana Boekhouding voor
bedragen gebruikte tekens.

De oplossingen voor iedere fout worden uitgelegd in deze foutmeldingspagina .

In het voorbeeld laat het programma een foutmelding zien van een verschil in de beginsaldi van
1000.-.

Na controle en correctie moeten de beginsaldi van de totale activa gelijk zijn aan die van de totale
passiva.

Het is ook mogelijk om de saldi in de totalentabel te controleren en te vereffenen in Totalentabel.

https://www.banana.ch/doc/nl/contamsg_nl_tot_teid11des
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Transactietabel | Dubbel boekhouden

De transactietabel is de centrale plaats voor de boekhouding waar alle bewerkingen met financiële en
economische gevolgen worden ingevoerd. Het gebruik is gelijkwaardig aan Excel. In de
transactietabel zijn de mutaties altijd zichtbaar en in perfecte volgorde en door er doorheen te
bladeren heeft u een duidelijk zicht op alle gebeurtenissen.
Alle ingevoerde gegevens kunnen worden aangepast en gecorrigeerd waardoor u altijd eenvoudig een
perfecte boekhouding heeft.

Snelle invoer
De tabel is gelijkwaardig aan Excel, U kunt op en neer scrollen en in elke cel gaan staan.

Er zijn heel wat functies die gegevens invoeren en aanpassen erg snel maken.

De volgende bewerkingen zijn mogelijk:

Annuleren en Opnieuw uitvoeren.
Een of meer cellen selecteren en kopiëren / plakken.
Toevoegen, kopiëren en verwijderen van regel, per stuk of meerdere tegelijk.
Teksten zoeken en vervangen.
Rijen op datum sorteren.
De auto-aanvullen functie geeft suggesties voor gegevens die ingevoerd kunnen worden
(bijvoorbeeld een lijst met rekeningen).
Met de F6 toets waardes overnemen van dezelfde soort rij.
Met de F4 toets waardes overnemen van de vorige rij.
De datum overnemen van de vorige rij.
In de kolom Doc worden oplopende nummers (met verschillende tellers) aangegeven.
In de kolommen Debet of Credit kunt u zoeken naar de rekening door de beschrijving ervan in
te typen.
In de kolommen voor bedragen kunt u formules invoeren zoals "30 + 25" en het programma
voert het resultaat in.

Meer informatie is beschikbaar op de pagina Cellen.
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Mutaties importeren
Door transacties van bank- of creditkaartafschriften te importeren wordt gegevensinvoer in de
transactietabel versneld en worden fouten voorkomen. Gegevens worden vastgelegd precies zoals ze
op het afschrift staan.

Behalve van rekeningafschriften kunt u ook gegevens van andere programma's importeren.
Het programma vult automatisch ontbrekende gegevens aan.
Er zijn diverse formaten beschikbaar voor het importeren.
U kunt gegevens van andere programma's kopiëren en plakken.
Geïmporteerde gegevens kunnen worden aangevuld, aangepast of verwijderd.
Het is mogelijk extensies te programmeren om elk soort bestand te importeren.

Meer informatie is beschikbaar op de pagina Naar boekhouding importeren.

Beheer van uiteenlopende informatie
Er kan veel informatie worden aangegeven in iedere invoerregel:

De valutadatum en die van het document.
Een oplopend nummer van document en protocol, of externe referentie.
Alle extra informatie die u nodig heeft, door het toevoegen van kolommen.
Koppeling naar een digitaal document.

Koppelingen toevoegen en verwijderen.
Open de koppeling en bekijk de inhoud.

BTW Beheer (als gekozen is voor een boekhouding met BTW bij het aanmaken van het
bestand):

Door de BTW code in te voeren berekent het programma automatisch de BTW.
Opsplitsing en boeking van de BTW op de aangewezen rekening.
U kunt definiëren of het bedrag netto of bruto BTW is.
U kunt aangeven dat het om een omgekeerde btw-code gaat door een minteken "-" vóór
de btw-code.
U kunt een BTW-percentage aangeven dat niet kan worden teruggevorderd.
U kunt speciale gevallen coderen met extra codes.

Kostenplaatsen en Winstcentra:
Tot 3 Kostenplaatsen en Winstcentra voor iedere boekingsregel.
U kunt negatief boeken door een minteken "-" voor het Kostenplaatsen en Winstcentra
bedrag te plaatsen.

Segmenten:
U kunt tot 10 segmenten aangeven voor iedere debet of credit rekening.

Leveranciers beheer:
Beheer op basis van transacties (opgezet als grootboek) als op basis van kasmiddelen
(instelling als kostenplaatsen en winstcentra).
Beheer van de vervaldatum en betaling voor een overzicht van de uitstaande en betaalde
facturen.

Klanten beheer:
Beheer op basis van transacties (opgezet als grootboek) als op basis van kasmiddelen
(instelling als kostenplaatsen en winstcentra).
Beheer van de vervaldatum en betaling voor een overzicht van de uitstaande en geïnde
facturen.

Facturen naar klanten:
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Invoer van de aanmaak van facturen.
Suggestie voor te gebruiken klantenrekening.
Hoeveelheid en prijs (kolommen zichtbaar maken).

Voor facturatie of kostenbeheersing.
Automatische berekening van het bedrag.

Artikelnummer (als de optie is geactiveerd).
Om te koppelen aan de itemstabel.
Automatische berekening van de hoeveelheden van binnenkomende en uitgaande
producten.

Afdrukken facturen.
Aanduiding van informatie die nodig is om de factuur af te drukken.

Rekeningkaart
Vanuit de transactietabel kunt u elke rekeningkaart aanmaken. Ga naar de cel waar het
rekeningnummer in staat (in de debet of credit kolom) en klik op het icoontje dat in de
rechterbovenhoek van de cel verschijnt.

Als u zich in de rekeningkaart bevindt brengt klikken op het rijnummer van een transactie u terug
naar de transactietabel, precies op de originele transactie.

Meer informatie over rekeningkaarten is te vinden op de pagina rekening- / categoriekaart.

Gegevenserificatie
Het invoeren van gegevens is erg veilig. Banana Boekhouding heeft functies waarmee automatische
detectie en rapportage van fouten gedaan worden.

Het programma verifieert dat ingevoerde waardes correct zijn.
Als er onbalans is tussen de debet en credit kolommen wordt dit in rood aangegeven in het
informatievenster.
Transacties waar u onzeker over bent kunt u "in behandeling" laten en later afhandelen.
Voor iedere foutmelding is er een overeenkomstige help pagina (vereist een
internetverbinding).
In het informatievenster onderaan het scherm vindt u de volgende informatie:

Beschrijving, mutatie en saldo van de gebruikte rekeningen.
Foutmeldingen met een koppeling naar de help pagina.
Vermelding van het debet en credit verschil.

Door de werkelijke banksaldi in te voeren met de #checkbalance functie kunt u direct de balans
van de saldi in de boekhouding controleren en fouten vermijden.
Met het commando Boekhouding controleren controleert het programma alle ingevoerde
gegevens opnieuw en attendeert u op vergissingen en fouten.
U kunt rijen een kleur geven, lettertype ervan veranderen en vetgedrukt maken.
U kunt rijen beveiligen.
Transacties blokkeren met blockchain technologie.

Indeling van de kolommen
Voor een prettiger gegevensinvoer kunt u alle kolommen in uw eigen volgorde zetten.

U kunt ervoor kiezen om:
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Kolommen naar rechts of naar links te schuiven.
Extra kolommen weer te geven of onnodige te verbergen.
Eigen kolommen toe te voegen.
De volgorde van de kolommen op te slaan in Weergaven.

Meer informatie is beschikbaar op de pagina Kolommen instellen.
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Transactietabel kolommen en weergaven |
Dubbel boekhouden

De transactietabel heeft vooraf ingestelde kolommen en weergaven.

De kolommen van de transactietabel
De kolommen die hieronder weergegeven worden met * ervoor zijn doorgaans niet zichtbaar.
Gebruik het commando Menu Gegevens → Kolommen instellen om deze zichtbaar te maken.

Datum
De datum die het programma gebruikt om de transactie in een bepaalde tijd te plaatsen. De datum
moet binnen de limieten van de boekhoudperiode liggen die gedefinieerd zijn in het Tabblad
Boekhouding (van Bestands- en boekhoudeigenschappen). In het Opties tabblad van hetzelfde
venster kan men aangeven of de transactiedatum verplicht is. Als dit niet het geval is kan dit veld
leeg gelaten worden.
Als er geblokkeerde transacties zijn geeft het programma een foutmelding als een datum wordt
ingevoerd die gelijk aan of eerder is dan de datum van de blokkering.

*Doc.Datum (Documentdatum)
De datum van het document kan hier ingevoerd worden, bijvoorbeeld de datum van het sturen van de
factuur.

*Datumwaarde
De valutadatum van de banktransactie kan hier worden aangegeven. Deze datum wordt
geïmporteerd van een elektronisch bankafschrift.

Doc (Documentnummer)
Het nummer van het boekstuk dat dient als basis voor de boekhoudkundige transactie. Het wordt
geadviseerd om bij het invoeren van de transactie een oplopend nummer aan te geven op het
document zodat het boekstuk makkelijk kan worden teruggevonden vanuit de transactie.
De functie voor automatisch aanvullen stelt oplopende waardes voor maar ook de transactie codes
die eerder zijn gedefinieerd in de Terugkerende transacties tabel.

Het programma stelt het volgende document nummer voor waarmee kan worden doorgegaan door op
F6 te drukken.

In het geval van numerieke documentnummers verhoogt het programma eenvoudigweg de
hoogste waarde die het vindt in de Doc kolom.
In het geval van alfanumerieke documentnummers verhoogt het programma het laatste
numerieke deel; dit is nuttig als men een aparte nummering aan wil houden voor contante en
bank mutaties.Als eerder Documentnummer C-01 is ingevoerd en men begint een C in te typen
dan stelt het programma C-02 voor.Als eerder Documentnummer B-104 is ingevoerd en men
begint een B in te typen dan stelt het programma B-105 voor.Als eerder Documentnummer
D10-04 is ingevoerd en men begint een D in te typen dan stelt het programma D10-05 voor.

Bij Terugkerende transacties kunt u groepen transacties opzetten die met een enkele code ingevoerd
kunnen worden.
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Om een groot aantal documentnummers toe te voegen kunt u ook Excel gebruiken. U kunt in Excel de
gewenste hoeveelheid documentnummers aanmaken en dan kopiëren en plakken  in Banana
Boekhouding in de Doc kolom van de Transacties tabel.

*Doc.Prot. (Protocolnummer)
Een extra kolom voor het geval dat er een alternatieve nummering voor de transacties of voor het
document nodig is.
De functie voor automatisch aanvullen stelt oplopende waardes voor die op dezelfde manier werken
als in de Doc kolom. Dit wordt bijvoorbeeld gebruikt voor:

Wanneer het nodig om oplopende nummers toe te kennen aan transacties die verschillen van
het document nummer.
Wanneer de transacties worden ingevoerd door anderen in een ander bestand en deze dan
worden geïmporteerd in de boekhouding. Op deze manier is het mogelijk oplopende nummering
te gebruiken in de boekhouding en het originele nummer te behouden.

*Type (Type document)
Bevat een code die het programma gebruikt om een transactie type te identificeren. Als u liever uw
eigen codes gebruikt is het aan te raden een nieuwe kolom toe te voegen.

01 voor in rapporten: deze transactie wordt beschouwd als een begin transactie, dus deze
wordt niet getoond in balansen per periode maar wel in de openingsbalans beginsaldi.
van 10 tot 19: codes voor facturen aan klanten
van 20 tot 29: codes voor facturen van leveranciers
van 30 tot 1000: codes gereserveerd voor toekomstig gebruik.

*Factuur (Factuurnummer)
Een nummer van een verstuurde of betaalde factuur dat wordt gebruikt bij de facturen controle
functie voor klanten en leveranciers.

*Doc.Origineel (Origineel documentnummer)
Het referentie nummer dat op een document staat bijvoorbeeld het nummer van een credit nota.

*Koppeling (Koppeling extern bestand)
Dient om een koppeling naar een extern bestand in te voeren, doorgaans een boekstuk.
Door op de symbooltjes aan de bovenkant van de cel te klikken opent het programma het document.
Zie ook de pagina Koppeling naar een document invoeren, aanpassen en openen.

Als een link is ingevoerd in de cel verschijnt een icoontje door erop te klikken wordt het
document geopend, maar alleen als het een extensie heeft die veilig wordt geacht.
Met het andere icoontje kunt u een koppeling invoeren en aanpassen.

*Ext.Verwijzing (Externe verwijzing)
Een referentienummer toegewezen door een programma dat deze bewerking uitvoerde. Deze waarde
kan gebruikt worden om te controleren of een gegeven transactie dubbel is geïmporteerd.

Beschrijving
De tekst van de transactie.
De auto-aanvullen functie stelt de tekst van een eerder ingevoerde transactie voor, of van één die
ingevoerd is in het voorafgaande jaar, als de betreffende optie (Smart fill met transacties van vorig
jaar) is geactiveerd. Door op de F6 toets te drukken haalt het programma de gegevens van de
voorafgaande rij met dezelfde beschrijving op en vult daarmee de kolommen van de actieve rij aan.

https://nl.wikipedia.org/wiki/Kopi%C3%ABren_en_plakken


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 302

In het geval dat de beschrijving begint met #CheckBalance wordt de transactie beschouwd als één
die dient om het saldo te controleren. Zie de pagina Boekhouding controleren voor meer informatie
over dit onderwerp.

*Opmerkingen (Annotaties)
In dit veld kunnen opmerkingen toegevoegd worden aan de transactie.

Deb.Rek. (Debetrekening)
De debetrekening waarop geboekt wordt.

Het is mogelijk een segment in de Debet rekening kolom in te voeren. Deze worden doorgaans
gescheiden door een "." of een "-".
Als men in de rekeningenlijst de toets met het segmentscheidingssymbooel aanslaat gaat men
meteen naar het volgende segment.
Als men daarentegen de Enter toets aanslaat wordt de invoer beëindigd en gaat men naar de
volgende kolom.
De autoaanvullen functie geeft suggesties voor rekeningen en segmenten. Men kan ook een
zoektekst invoeren en dan toont het programma alle rekeningen met deze tekst in één van de
kolommen.

*Beschr. Debetrek. (Beschrijving Debetrekening)
De beschrijving van de ingevoerde rekening zoals die voorkomt in het Rekeningschema.

Cred.Rek. (Creditrekening)
De creditrekening waarop geboekt wordt. We verwijzen voor de rest van de informatie naar de uitleg
onder de Debetrekening.

*Beschr. Credittrek. (Beschrijving Creditrekening)
De beschrijving van de ingevoerde rekening zoals die voorkomt in het Rekeningschema.

Bedrag
Het bedrag dat ingevoerd wordt in de debet- of creditrekening.

*Saldo
De kolom Saldo laat de som van debet en credit zien. Er wordt daarom alleen een bedrag getoond
voor invoer in verschillende rekeningen. Aan het eind zou het saldo nul moeten zijn. Als er een bedrag
terugkomt is dat omdat er een fout is.

BTW kolommen
Informatie over de BTW kolommen kan gevonden worden in de pagina Transacties onder BTW
Beheer.

KP1 (Kostenplaats 1)
De Kostenplaatsrekening voorafgegaan door een ".".

*KP1-beschrijving (Beschrijving van kostenplaats 1)
De beschrijving van de Kostenplaats zoals die in het Rekeningschema voorkomt.

KP2 (Kostenplaats 2)
De Kostenplaatsrekening voorafgegaan door een ",".

*KP2-beschrijving (Beschrijving van kostenplaats 2)
De beschrijving van de Kostenplaats zoals die in het Rekeningschema voorkomt.
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KP3 (Kostenplaats 3)
De Kostenplaatsrekening voorafgegaan door een ";".

*KP3-beschrijving (Beschrijving van kostenplaats 3)
De beschrijving van de Kostenplaats zoals die in het Rekeningschema voorkomt.

*Verv. Datum (Vervaldatum)
De datum waarvoor de factuur betaald moet zijn. Voor meer informatie zie de pagina's Klanten en
Leveranciers.

*Bet. Datum (Betalingsdatum)
Wordt gebruikt in combinatie met het Vervaldatums weergeven commando.
Als men echter de controlefunctie voor de klanten/leveranciers facturen wil gebruiken om de
betalingen te controleren moet men een transactie invoeren voor een gestuurde factuur en een
andere voor de betaling ervan.

*Blok.Num (Nummer blokkeren), Blok.Bedr. (Bedrag blokkeren), Blok.Progr. (Progressief
blokkeren), Blok.Regel (Regel blokkeren)
Meer informatie vindt u in de Transacties blokkeren pagina.

Extra kolommen
Met menu Extra → Nieuwe Functies toevoegen → Kolom 'Items' toevoegen in transactietabel worden
in de transactietabel de volgende kolommen toegevoegd:

ProductID
De code uit de Itemstabel. Als u een artikel invoert dat aanwezig is in de itemstabel worden de
beschrijving, eenheid, eenheidsprijs, BTW code en rekening opgenomen.

Hoeveelheid
De hoeveelheid vermenigvuldigd met de eenheidsprijs geeft het totale bedrag (kan ook een negatief
getal zijn).

Eenheid
Een beschrijving die betrekking heeft op de hoeveelheid, bijvoorbeeld: kg, ton, liter.

Eenheidsprijs
De prijs per eenheid vermenigvuldigd met de hoeveelheid geeft het totale bedrag (kan ook een
negatief getal zijn).

Als een waarde wordt ingevoerd in de Hoeveelheid of Eenheidsprijs kolommen wordt het bedrag
berekend op basis van de inhoud van deze twee kolommen en omgezet naar een positief getal.

Nieuwe kolommen toevoegen
Met het Kolommen instellen commando is het mogelijk in te stellen dat kolommen worden
weergegeven, verborgen gehouden of verhuisd worden, nieuwe kolommen toe te voegen of aan te
geven dat een kolom niet in de afdruk meegenomen moet worden.

De toegevoegde kolommen in de Transactietabel worden ook toegevoegd in de Terugkerende
transacties tabel, in de Rekeningenkaart en in het BTW rapport zonder zichtbaar te zijn.
Om deze kolommen zichtbaar te maken gebruikt u het Kolommen instellen commando.
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Als een kolom van het "bedrag" type wordt toegevoegd dan worden de ingevoerde bedragen
opgeteld in de Rekeningkaart. 

Weergaven
De volgende weergaven worden automatisch aangemaakt wanneer een nieuwe boekhouding wordt
geopend: 

Basis: de hoofdkolommen worden weergegeven
Kostenplaatsen: de KP1, KP2 en KP3 kolommen worden weergegeven
Vevaldatums: de kolommen Vervaldatum en Betalingsdatum worden weergegeven
Blokkeren: de kolommen die te maken hebben met de Blokkeringsfunctie worden
weergegeven.

Met het Weergaven instellen commando kunnen de weergaven worden aangepast en kunnen
persoonlijke weergaven worden toegevoegd.
Met het Pagina instelling commando kunt u het afdrukformaat van de weergave aanpassen.
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Transactie-soorten

Eenvoudige transacties (op één regel)
Eenvoudige transacties hebben te maken met twee rekeningen (een Debet rekening en een Credit
rekening) en worden ingevoerd in één enkele rij. Iedere transactie heeft zijn eigen document nummer.

Samengestelde transacties (over meerdere regels)
Samengestelde transacties waarbij op meer dan twee rekeningen geboekt wordt moeten ingevoerd
worden in meerdere rijen. De gebruiker moet één rekening per rij gebruiken. De tegenrekening voor
de hele transactie moet ingevoerd worden in de eerste rij.
De documentnummers die ingevoerd worden in de diverse rijen zijn hetzelfde omdat we met één en
dezelfde transactie te maken hebben.

Let op:
In samengestelde transacties moeten de data in de transacties hetzelfde zijn omdat er anders
verschillen in de boekhouding ontstaan bij berekeningen per periode.

Openingstransacties
De beginsaldi worden gewoonlijk aangegeven in de rekeningentabel.

Openingstransacties zijn nodig in speciale gevallen zoals:

In een vreemde valuta boekhouding als u andere begin wisselkoersen heeft dan die
aangegeven in de begin wisselkoersen van  de wisselkoersentabel. Zie Begin transacties in
vreemde valuta.
Voor het invoeren van Beginsaldi voor segmenten.
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De openingstransacties worden aangemaakt door de transacties in te voeren met de begindatum van
de boekhouding en code 01 in de kolom Type document.

Openingstransacties veranderen de beginsaldi in de rekeningentabel niet.
Het beginsaldo ingevoerd met een transactie wordt gebruikt in de afdrukken van de balans,
rekeningkaarten.
Als er voor dezelfde rekening een beginsaldi is en een boeking van het beginsaldo worden deze
twee bedragen opgeteld.
Op deze manier kunt u openingstransacties invoeren die het beginsaldo van een rekening
corrigeren.
Bij het invoeren van beginsaldi met transacties is het nodig ervoor te zorgen dat de som van
debet (positief) en credit (negatief) nul is.
Voor iedere debet invoer moet er een corresponderende credit invoer zijn.
Het kan nuttig zijn om een openingsrekening te hebben die dient als tegenrekening voor het
boeken van de beginsaldi. Na alle openingstransacties moet het saldo van deze rekening
uiteraard nul zijn.

Bij het invoeren van beginsaldi wordt over het algemeen alleen de debet of credit rekening
aangegeven. Het is echter ook mogelijk om een tegenrekening aan te geven die in het algemeen een
specifieke rekening is voor openingsboekingen.
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Het boeken van bankcheques

Om de uitgifte van bankcheques te boeken, moet een rekening Uitgegeven cheques in de passiva
worden aangemaakt.

De check wordt uitgegeven op het moment dat een leverancier wordt betaald en later wordt deze
gedebiteerd van de bankrekening.

De rekening kaart van de uitgegeven checks na de transacties.  



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 308

Creditcard betaling met vooruitbetaling

Vooruitbetaling op creditcards
Controleer of er een rekening voor de creditcard bestaat in het passiva gedeelte van het
rekeningschema voordat u boekingen gaat doen. Maak er een aan als dit niet het geval is.

De rekening voor de creditcard wordt toegevoegd aan de groep of sub-groep van de kortlopende
schulden als dit een vereiste is in het gekozen rekeningschema. Als er geen sub-groepen zijn moet
deze rekening worden opgenomen in de passiva sectie.

Voorbeeld:

Een bedrag van € 1000 wordt overgemaakt van de bankrekening naar de creditcard.

In Debet wordt de creditcardrekening geregistreerd

In Credit wordt de bankrekening geregistreerd waarmee de betaling wordt verricht.

Uw creditcardafrekening boeken
Wanneer de rekening van de creditcard komt, moet u alle kosten op de creditcard boeken en het
tegoed van de creditcardrekening terugboeken.

Voorbeeld:
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We ontvangen de creditcardafrekening voor een totaal van € 749 (details: € 479 voor aanschaf
computer, € 150 voor hotelkosten, € 120 voor kantoorbenodigdheden) (Doc. 10).

Dit wordt geboekt op meerdere rijen :

In Debet neemt u alle kosten op die verband houden met de uitgaven die in de credit card zijn
opgenomen; u neemt één uitgave per rij op.
In Credit wordt het totaalbedrag van de creditcarduitgaven geboekt.

Controleer het saldo van de creditcard

Iedere keer als u een voorschot op de creditcard zet en na het boeken van alles wat met de creditcard
betaald is, moet u controleren dat het saldo van de creditcard in de boekhouding overeenkomt met
het saldo op de creditcard.
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Uw creditcardtransacties boeken volgens het
kas- en facturatiestelsel

Creditkaart in een boekhouding met het kasprincipe

Als er geen betalingen worden gedaan op de kredietkaart en de factuur wordt helemaal via de bank
betaald moet u de creditkaart factuur boeken op het moment van betalen als de kosten ook geboekt
zouden moeten worden.

U moet op meerdere rijen boeken:

Voer dezelfde datum en hetzelfde documentnummer in voor iedere transactie op elke rij die
voor de boeking gebruikt wordt.
Voer in de kolom Credit van de eerste rij de bankrekening in waarmee de factuur wordt
betaald.
Voer in deze rij in de kolom Bedrag het totale bedrag in dat betaald is op de creditkaart
factuur.
Voer in de kolom Debet van iedere volgende rij de rekening in die verwijst naar de uitgaven
van de creditkaart transactie.
Voer het bedrag voor iedere deeltransactie in Debet in.
Voer, in het geval van BTW, voor iedere rij een BTW code in de kolom BTW Code in.

Na het boeken van alle mutaties controleert u het creditkaart saldo door de rekeningkaart voor de
creditkaart te openen.

Creditcard en boekhouding volgens factuurstelsel
Als de boekingen zijn gebaseerd op het facturatiestelsel worden alle kosten die betrekking hebben
op creditkaartaankopen geboekt bij de ontvangst van de creditkaartfactuur:

Voer dezelfde datum en hetzelfde documentnummer in voor iedere transactie op elke rij die
voor de boeking gebruikt wordt.
Alle uitgaven worden Debet geboekt. Iedere uitgave moet een aparte rij ingevoerd worden.
Voer in de kolom Bedrag het bedrag van een enkele transactie in Debet in.
Boek uw creditkaartrekening als Credit, zoals voor elke leverancier.
Voer in de kolom Bedrag het totale bedrag in dat betaald moet worden van de creditkaart.
Voer, in het geval van BTW, voor iedere rij een BTW code in de kolom BTW Code in.
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Wanneer de creditkaartrekening wordt betaald voert u de betaling in:

Als debet op de creditkaartrekening (de schuld is opgeheven)
Als credit op de bankrekening waarmee de factuur is betaald.
Het totale bedrag van de creditkaartrekening wordt ingevoerd.
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Transacties van uw creditcard importeren

Met Banana Boekhouding kunt u de transacties van uw creditcard in het boekhoudbestand
importeren.

U moet ervoor zorgen dat het rekeningschema de creditcardrekening en de overschrijvingsrekening
omvat die voor stortingen moet worden gebruikt

Installeer het gegevensformaat van uw bank
Om het importeren uit te kunnen voeren is het nodig dat het formaat van de gegevens die de
creditcardorganisatie levert compatibel is met een van de formaten die Banana Boekhouding levert.

Om de extensie te installeren die bij het formaat hoort van de gegevens die de bank van uitgifte
levert gaat u als volgt te werk:

Menu Extensies → Extensies beheren.
Selecteer de bank waar de creditcard vandaan komt en klik op de knop Installeren.
Het formaat zal weergegeven worden in het Naar boekhouding importeren venster.

De creditcard mutaties importeren
Nadat u de extensie voor het met Banana Boekhouding compatibele gegevensformaat heeft
geïnstalleerd gaat u als volgt te werk om de gegevens te importeren:

Kies van het Acties → Naar boekhouding Importeren → Transacties venster het formaat dat bij
de bank hoort die de creditcard uitgegeven heeft.
Kies met de knop Bladeren het bestand dat de bank gestuurd heeft en bevestig met OK.
Indien nodig voert u de periode in en geeft u de bankrekening aan. Bevestig met OK.
Alle transacties worden in de transactietabel geïmporteerd.
Voer in iedere rij de tegenrekening in die bij de boeking hoort.

Creditcard transacties importeren als er stortingen gedaan
zijn
Wanneer er stortingen gedaan zijn op de creditkaart worden deze geboekt in de boekhouding. In dit
geval is er, na het importeren van de creditkaartgegevens, het probleem van het boeken van de
stortingen. Hiervoor verschijnt een dubbele mutatie op de creditkaartrekening:

De creditkaartrekening is aanwezig als tegenrekening voor de bankkosten voor de betalingen
aan de creditkaart.
De creditkaartrekening is aanwezig in de transacties die geïmporteerd worden van de
creditkaart.

Om deze overlap te vermijden wordt de overschrijvingsrekening gebruikt tijdens het importeren.

Zo gaat het importeren:

Kies van het Acties → Naar boekhouding Importeren → Transacties venster het formaat dat bij
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de bank hoort die de creditcard uitgegeven heeft.
Kies met de knop Bladeren het bestand dat de bank gestuurd heeft en bevestig met OK.
Indien nodig voert u de periode in en geeft u de overschrijvingsrekening aan. Bevestig met OK.
Alle transacties worden in de transactietabel geïmporteerd.
Voer in iedere rij de tegenrekening in die bij de boeking hoort.
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Totalentabel

De Totalentabel toont de totalen per groep en stelt u in staat om het saldo van de boekhouding te
controleren.
De tabel wordt automatisch aangemaakt door het programma en kan niet worden gewijzigd door de
gebruiker.

In de Totalentabel is het mogelijk om in één oogopslag een idee te krijgen van de situatie van de
eigen activiteit. U ziet de totale activa, passiva, lasten en baten en vooral of u winst of verlies heeft.
Groep 00 is erg belangrijk omdat u direct kunt zien of alles op zijn plaats is of dat er verschillen zijn in
het saldo.
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Afdrukken

Alle afdrukken van de Jaarrekening, de Winst- en Verliesrekening, en de verschillende
boekhoudverslagen zijn beschikbaar via het menu Rapporten. Ieder commando heeft diverse opties
om de verschillende afdrukken aan te passen.

Uitgebreide Balans op groepen
Dit voorbeeld is gemaakt door de volgende functies te gebruiken:

Uitgebreide Balans op groepen
Kolommen instelling om aan te geven welke kolommen weergegeven moeten worden (in het
voorbeeld worden de kolommen van het Lopende en het Voorafgaande jaar weergegeven)
Stijl instelling: Lugano (Groepen uitgelicht), Stijl eigenschappen: Groepen en totalen: Kleur.

Uitgebreide balans met budget
Dit voorbeeld is gemaakt door de volgende functies te gebruiken:

Uitgebreide Balans
Opties In afdruk opnemen : om aan te geven welke kolommen weergegeven moeten worden
(in het voorbeeld worden de kolommen van het Lopende jaar en het Budget weergegeven)
Stijl instelling: Berlijn (gekleurde kolommen).
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Uitgebreide Balans
Dit voorbeeld is gemaakt door de volgende functies te gebruiken:

Uitgebreide Balans
Opties In afdruk opnemen : om aan te geven welke kolommen weergegeven moeten worden
(in het voorbeeld worden de kolommen van Lopend, Vorige en % Verschil weergegeven)
Stijl instelling: Berlijn (gekleurde kolommen).

Onderverdeling per halfjaar
Dit voorbeeld is gemaakt door de volgende functies te gebruike

Uitgebreide Balans op groepen
Kolommen instellen om aan te geven welke kolommen weergegeven moeten worden (Lopend
en Budget).
Onderverdeling → Onderverdeling per periode  om de onderverdeling per periode in te stellen
Stijl instelling: Lugano (Groepen uitgelicht), Stijl eigenschappen: Groepen en totalen: Kleur.
Kleuren (Kolom-eigenschappen) om verschillende kleuren aan de kolommen te geven.

Onderverdeling per segment
Dit voorbeeld is gemaakt door de volgende functies te gebruiken:

Uitgebreide Balans op groepen
Onderverdeling → Onderverdeling per segment  om het segment niveau te kiezen dat

http://www.banana.ch/doc/nl/node/3265
http://www.banana.ch/doc/nl/node/3265#segment
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weergegeven moet worden
Afdruk stijl:
Bij het afdrukken van de segmenten is het niet mogelijk de kleuren van de kolommen in te
stellen.

PDF bestand met alle boekhoudgegevens
Het aangemaakte bestand heeft een inhoudsopgave die op een makkelijke manier toegang geeft tot
de verschillende afdrukken.

De volgende gegevens kunnen opgeslagen worden in het PDF bestand

Balans en Winst & Verlies rekening
Rekeningen tabel, Transacties, BTW codes, Totalen
BTW rapporten
Rekening kaarten

Als u dit bestand op een niet-herschrijfbare CD opslaat (om het bij uw boekhouding documenten op te
bergen) voldoet dit aan de wettelijke eisen voor het opslaan van de boekhoudgegevens.

Dit voorbeeld is gemaakt door de volgende functies te gebruiken:

Menu Bestand, Pdf bestand aanmaken commando
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Een extra kolom afdrukken
Om in de Balans een extra kolom af te drukken zijn de volgende functies gebruikt:

Nieuw kolom toevoegen in de rekeningentabel, via het Gegevens → Kolommen instellen menu.
Uitgebreide Balans op groepen
Kolommen (geavanceerd) om de kolom zichtbaar te maken.
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Rekeningkaarten / Grootboek

De rekeningkaart komt overeen met het Grootboek en maakt het mogelijk om een volledige lijst van
boekhoud mutaties te hebben met betrekking tot dezelfde rekening, kostenplaats, segment en groep.

De Rekeningenkaart openen
Er zijn twee manieren om een rekeningkaart te openen:

Eerste methode

Deze methode wordt aanbevolen wanneer u enkele of alle rekeningkaarten wilt weergeven en
afdrukken.

Kies Rapporten → Rekeningkaarten in het menu

Er verschijnt een dialoogvenster met de volgende secties:

Rekeningen
Periode
Opties
Aanpassing

Klik op de betreffende links om meer informatie over de secties te vinden.

Tweede methode

Klik op het icoontje dat verschijnt als u de cel selecteert die het rekening- of groepsnummer
bevat.

Bijwerken van de rekening kaart
De rekeningkaart is tijdelijk en wordt berekend wanneer het commando gegeven wordt om dit te
doen. Veranderde of toegevoegde transacties in de transactietabel worden niet automatisch
bijgewerkt in de rekeningkaart.

http://www.banana.ch/doc/nl/node/7217
http://www.banana.ch/doc/nl/node/2729
http://www.banana.ch/doc/nl/node/2604
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Om de rekeningkaart bij te werken na veranderingen moet het Rekeningkaarten commando
gegeven worden of, als de rekeningkaart nog openstaat, klikken op het knopje Tabel vernieuwen in
de rechterbovenhoek zie afbeelding hieronder.

Let op

Het is niet mogelijk de gegevens in de rekeningkaart te veranderen. Dubbelklik op het rijnummer in
de rekeningkaart om terug te gaan naar de bijbehorende regel in de Transacties- of Budgettabel.

De Geselecteerde Rekening kolom
In de Geselecteerde Rekening kolom, die zichtbaar gemaakt kan worden met menu Gegevens →
Kolommen instellen, wordt de rekening getoond waarop de transactie plaatsvond.
Wanneer u een rekeningkaart heeft van één of meerdere rekeningen, groepen of segmenten ziet u
precies de rekening die werd gebruikt.

De tegenrekening in de rekeningkaarten
In de Rekeningkaarten wordt de kolom Tegenrekening (Tegenrek.), die de rekening aangeeft die de
transactie afsloot, getoond.
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Als er transacties zijn op meerdere rekeningen (transacties op meerdere rijen) zoals in het voorbeeld
hieronder en er wordt één rekening ingevoerd in debet en meerder rekeningen in credit, of andersom,
dan leidt de software de mogelijke tegenrekening af door de volgende logica te gebruiken:

In de eerste transactierij wordt de rekening 5000 beschouwd als de gemeenschappelijke
tegenrekening van de transacties die daarna komen.

Op Rekeningkaart 5000 laten de samengestelde transacties (Bruto salaris van december) de
tegenrekening zien aangegeven door het [*] symbool. Het is onmogelijk de tegenrekeningen
direct in de rekeningkaart weer te geven omdat de rekening meerdere tegenrekeningen heeft
(1020, 5700, 5730). Daarom plaatst het programma het [*] symbool in de Tegenrek.
(Tegenrekening) kolom wat betekent dat we te maken hebben met een transactie op meerdere
rekeningen.
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Op de Rekeningkaarten van de volgende transactierijen (1020, 5700, 5730), wordt de
gemeenschappelijke tegenrekening aangegeven tussen rechte haken ("[5700]"), en geeft een
afgeleide tegenrekening aan.

Kaarten van groepen en klassen
In de rekeningkaart van een groep of een klasse worden alle transacties van de rekeningen die bij de
geselecteerde groep of klasse horen gegroepeerd.
De rekeningen van de groep of de klasse kunnen worden getoond door de Geselecteerde Rekening
kolom zichtbaar te maken.
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Budget rekeningkaart
Als er budgettransacties zijn ingevoerd in de budgettabel is het mogelijk rekening- of groepskaarten
te maken van het budget:

Via the Rapporten → Rekeningkaarten → Budgettransacties  kan de optie Budget transacties
worden geactiveerd.

Grootboek (alle rekeningkaarten) afdrukken
Om de Rekeningkaarten af te drukken:

Menu Rapporten, commando Rekeningkaarten...
Met behulp van het Filter kunnen alle rekeningkaarten die geheel of gedeeltelijk (bijvoorbeeld
alleen rekeningen, kostenplaatsen, segmenten) afgedrukt moeten worden geselecteerd
Activeer de gewenste opties (bijvoorbeeld periode, 1 rekening per pagina, ...) in de diverse
secties Periode, Opties, Compositie
Druk op OK om te bevestigen, na het selecteren van de gewenste optie.

http://www.banana.ch/doc/nl/node/2846#budget_transacties


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 324

Voor de uitleg over de diverse tabbladen bezoek de volgende pagina'"s: Tabblad Rekening/Categorie,
Tabblad Periode en Tabblad Opties.
Het programma toont de geselecteerde rekeningkaarten.

Om af te drukken kies het commando Afdrukken van het menu Bestand.

Als de Budget-tabel geactiveerd is in uw boekhoudbestand, kunt u kiezen welke transacties u wenst
te zien (Huidige of budget transacties)

Een logo gebruiken in de rekeningkaarten
Vanaf Banana Boekhouding 9 kunt u een logo gebruiken in de afdrukken van de rekeningkaart. Nadat
u uw rekening kaarten heeft aangemaakt met het commando Rapporten → Rekeningkaarten...
gebruikt u het commando menu Bestand → Afdrukvoorbeeld. In het afdrukvoorbeeldscherm klikt u
op het Instellingen icoon. In het dialoogvenster dat geopend wordt kiest u in de Logo optie uw logo in
plaats van Geen.
Zie ook de pagina Logo-instellen.

De instellingen opslaan
Als u de rekeningkaarten regelmatig afdrukt, bijvoorbeeld alle kaarten die met de Verkopen
rekeningen te maken hebben, is het handig een specifieke aanpassing aan te maken.

Ga naar het tabblad Compositie
Maak een nieuwe compositie aan met de knop Nieuw
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Geef een naam op voor de compositie, bijvoorbeeld "rekeningen Verkopen", in het veld
Beschrijving van het venster
Selecteer de rekeningen die u afgedrukt wilt hebben.

Nu kunt u, telkens wanneer u deze rekeningen wilt afdrukken, de compositie selecteren die u
aangemaakt heeft.

Pagina instellen
In Pagina instelling kunt u de marges & andere instellingen van de pagina specificeren.
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Rekeningen

U komt in dit venster via menu Rapporten → Rekeningkaarten (zie pagina Rekeningkaarten).

Rekeningen

Er verschijnt een lijst met alle beschikbare rekeningen.

Alles selecteren

Door deze optie te activeren worden alle rekeningen van het Rekeningschema automatisch
geselecteerd.

Als u een of meer rekeningen wilt afdrukken activeert u alleen de gewenste rekeningen.

Zoeken

Met deze optie kunt u direct een of meer rekeningen zoeken. Voer het rekeningnummer of de
beschrijving in om de lijst van rekeningen te filteren.

U kunt ook de rekening aangeven die getoond moet worden met de segmenten (indien aanwezig).
Rekeningen en segmenten kunnen gecombineerd worden (bekijk de "developer explanations"
Engelstalig).

1000|1001 toont de transacties van de 1000 en 1001 rekeningen.
1000:01 toont alle transacties van de 1000 rekening met het 01 segment.

Op rekeningnummer sorteren

Als deze optie wordt gebruikt worden de rekeningen gesorteerd volgens de selectie die in het filter is
toegepast (onderaan het dialoogvenster). Als er bijvoorbeeld rekeningen, kostenplaatsen of
segmenten zijn met afkortingen worden deze in alfabetische volgorde gesorteerd.

Filter

Met deze functie kunt u alle rekeningkaarten of alleen een selectie filteren, in het bijzonder:



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 327

Rekeningen; Kostenplaatsen; Segmenten - deze worden standaard gefilterd wanneer geen
selectie wordt gemaakt
Rekeningen (bestaande kostenplaatsen en segmenten worden uitgesloten)
Rekeningen; Kostenplaatsen (alleen segmenten worden uitgesloten)
Kostenplaatsen (rekeningen en segmenten worden uitgesloten)
Segmenten (rekeningen en kostenplaatsen worden uitgesloten)
Groepen - bestaande groepen worden getoond - u moet degene die afgedrukt moeten worden
selecteren
Klassen - alle klassen worden getoond - u moet degenen die afgedrukt moeten worden
selecteren.

Huidige transacties of Budget transacties

Als de Budgettabel geactiveerd is in uw boekhoudbestand, kunt u kiezen:

Huidige transacties
De gegevens van de transacties tabel worden verwerkt.

Budget transacties
De gegevens in de Budgettabel worden verwerkt.
Bij afwezigheid van een Budgettabel worden de bedragen van de budgetkolom van de
Rekeningentabel (weergave Budget) omgezet in maandelijkse bedragen op basis van de begin-
en einddatum van de boekhouding (als dit een jaar is, is dit een deling door 12 maandelijkse
termijnen).
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Verschillen in rekeningbedragen (rekeningkaart 00)

Als er verschillen in rekeningbedragen voorkomen (zie de foutmeldingspagina DEBET-CREDIT-verschil
) open dan de rekeningkaart voor Groep 00 (of degene in uw rekeningschema die alle rekeningen

bevat van BKlasse 1, 2, 3 en 4).
U krijgt een lijst van alle transacties met opeenvolgende saldi die na iedere boeking nul zouden
moeten zijn. De rij waarvan het saldo ongelijk nul is bevat de fout.

https://www.banana.ch/doc/nl/doppiamsg_nl_diffdareavere


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 329

Rekeningkaart Periode

De uitleg van het tabblad Periode is hetzelfde als die van het tabblad Periode in "Uitgebreide balans
op groepen".
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Opties

Via menu Rapporten → Rekeningkaarten → Opties kunt u de verschillende opties bereiken die
gebruikt worden voor het afdrukken.

Rijen voor einde van pagina
Deze functie zorgt ervoor dat een rekening niet over twee pagina's afgedrukt wordt. Indien de af te
drukken rekeningkaart niet minstens een aantal rijen bevat dat overeenstemt met het in dit veld
ingevoerde aantal, zal het afdrukken van de hele kaart naar de volgende pagina worden verplaatst.

Eén rekening per pagina
Door deze optie te activeren wordt iedere kaart op een aparte pagina afgedrukt (zelfs die met weinig
transacties).

Kolomkoppen herhalen
Door deze optie te activeren worden de kolomkoppen herhaald voor iedere rekening binnen een
pagina.

Rekeningen zonder transacties opnemen
Door deze optie te activeren worden kaarten zonder transacties ook afgedrukt.

Weergave
U kunt hier de kolomweergave selecteren die opgenomen moet worden in de weergave en afdruk van
de rekeningkaarten:

Basis
BTW
Kostenplaatsen
Verval datum

Het programma gebruikt dezelfde volgorde als in de transactietabel wanneer geen criterium wordt
aangegeven.

Sorteringskolom
In de rekeningkaart kunnen transacties worden gesorteerd op verschillende soorten gegevens:
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Document datum
Datumwaarde
Vervaldatum
Betalingsdatum
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Journaal

In Banana Boekhouding komt het Journaal overeen met de Transactietabel. Het is mogelijk het hele
journaal af te drukken of alleen maar een deel ervan door de rijen te selecteren die u wilt afdrukken.

Er zijn verschillende manieren om het journaal af te drukken:

Plaats uzelf in de Transactiestabel en klik op het icoon Afdrukvoorbeeld, vervolgens op het
icoon Afdrukken.
Vanuit de Transactiestabel, selecteer van het menu Bestand → Afdrukvoorbeeld → icoon
Afdrukken.
Vanuit het menu Rapporten → Journaal op periode ...

Periode

U kunt ervoor kiezen om alles of en specifieke periode af te drukken. Voor een specifieke periode
voert u de start- en einddatum in.

Sorteren

In het tabblad Sorteringskolom kunt u de criteria kiezen waarmee het het journaal wordt gesorteerd
bij het afdrukken.
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De afdruk van het journaal aanpassen
Om de afdruk van het journaal naar uw hand te zetten kunt u de volgorde van de kolommen en de
kopteksten veranderen. Informatie over hoe dit te doen vindt u in de pagina Kolommen instellen; u
kunt ook diverse opties kiezen voor de afdruk, zie de pagina Pagina instelling.
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Uitgebreide Balans

De Balans vertegenwoordigt alle Activa, Passiva, Lasten en Baten op een bepaald moment. Het
verschil tussen Activa en Passiva bepaalt het eigen vermogen. In Banana Boekhouding heeft de
uitgebreide balans de volgende kenmerken:

De groepering van de rekeningen wordt gedaan volgens de inhoud van de BKlasse kolom.
De Uitgebreide Balans (menu Rapporten) kan, weergegeven als afdrukvoorbeeld, opgeslagen
worden in verschillende formaten (PDF, HTML, Excel) en kan gekopieerd worden naar het
klembord.
Het is mogelijk het budget te berekenen, weer te geven en af te drukken aan het jaar of voor
een specifieke periode.
Transacties zonder datum worden beschouwd als begintransacties en verschijnen niet in
afdrukken van de Winst & Verlies rekening.

Klik op menu Rapporten > Uitgebreide balans om de Uitgebreide balans te berekenen, bekijken
en af te drukken. Er verschijnt een dialoogvenster met verschillende secties waarin u parameters kunt
instellen.

Zie ook Afdrukvoorbeelden.

Pagina's afdrukken en In afdruk opnemen
Door in deze secties, de verschillende opties te activeren kunt u bepalen welke inhoud wordt
afgedrukt in de Uitgebreide balans.

De optie "Saldi van vorig jaar" is alleen beschikbaar als het veld Alles is geselecteerd in de sectie
Periode. Wanneer echter een specifieke periode wordt gekozen is de optie niet actief. In dit geval
moet de Uitgebreide balans op groepen worden gebruikt.

Paginakoptekst
Rijen 1 - 4
Voer in deze velden de teksten in die gebruikt moeten worden als kopteksten bij het afdrukken.
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Logo
Het is mogelijk om het logo toe te voegen in de kop van alle pagina's van het overzicht.
Als een of meer logo's zijn toegevoegd in het menu Bestand > Logo instellen dan kunt u er een uit de
lijst kiezen.
Als er nog geen logo aanwezig is kunt u de knop Bewerken gebruiken om het logo toe te voegen.

Paginanummers afdrukken
Wanneer deze optie is geactiveerd worden de paginanummers in de voetteksten afgedrukt.

Datum afdrukken
Wanneer deze optie is geactiveerd wordt de datum in de voetteksten afgedrukt.

Kaft afdrukken
Kaft afdrukken
Wanneer deze optie is geactiveerd wordt de kaft afgedrukt.

Logo
Het is mogelijk om het logo toe te voegen in de kaft van het overzicht.
Als een of meer logo's zijn toegevoegd in het menu Bestand → Logo instellen dan kunt u er een uit de
lijst kiezen.
Als er nog geen logo aanwezig is kunt u de knop Bewerken gebruiken om het logo toe te voegen.

Kolomkoptekst (Balans / Winst- en Verlies)
De velden aan het eind van het dialoogvenster Uitgebreide Balans worden gebruikt om de koppen
voor het vorige en lopende jaar waar te geven in de afdruk.
De eerste twee velden onder elkaar worden gebruikt in de Balans, de tweede twee voor de Winst- en
Verliesrekening.

Wanneer de velden niet zichtbaar zijn bij het openen van het dialoogvenster moet u naar beneden
scrollen om ze zichtbaar te maken.

Lopend jaar
Voer in dit veld de einddatum in van de huidige boekhouding.

Vorig jaar
Voer in dit veld de einddatum in van de boekhouding van het vorige jaar.

Wanneer u overgaat naar het nieuwe jaar met menu Acties > Nieuw Jaar aanmaken, wordt de kop
van het vorige jaar niet automatisch aangepast. Deze moet dus handmatig worden aangepast. Dit
probleem wordt in de toekomst opgelost.

Dialoogvenster niet helemaal zichtbaar
Om het dialoogvenster Uitgebreide Balans helemaal zichtbaar te maken gebruikt u een van de twee
volgende procedures:

Vergroot het dialoogvenster.
Sleep de schuifbalk aan de rechterkant van het venster naar beneden.
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In afdruk opnemen
Het is mogelijk de opties, die gebruikt moeten worden in de afdrukken, te kiezen door de diverse
selectievakjes aan- of uit te vinken.

Andere tabbladen

De uitleg voor de andere tabbladen is beschikbaar op de volgende pagina's:

Periode
Stijl
Teksten
Marges
Aanpassing



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 337

Uitgebreide Balans op groepen

De Uitgebreide balans op groepen verschilt van de de Uitgebreide balans op de volgende punten:

Geeft de subgroepen in detail weer.
Heeft de mogelijkheid groepen of rekeningen uit te sluiten (bijvoorbeeld om alleen het totaal
van de groep weer te geven en niet de rekeningen waaruit dit totaal is opgebouwd).
In het Rekeningschema - Secties is het mogelijk te selecteren welke rekeningen mee te
nemen of weg te laten in afdrukken.
Het is mogelijk voor een gegeven periode te kiezen wat voor soort onderverdeling u wilt
(bijvoorbeeld kunt u kiezen om in het eerste halfjaar de gegevens per maand of per kwartaal op
te halen).
Het is mogelijk om een onderverdeling te maken per segment.

Om de Uitgebreide balans op groepen te berekenen en weer te geven klik op het menu Rapporten →
Uitgebreide balans op groepen; er verschijnt een venster met diverse secties waarmee de
gebruiker de afdrukinstellingen kan bepalen.

Zie ook Afdrukvoorbeelden.

FAQ
Wanneer ik groepen met een nulsaldo uitsluit worden de titels die verwijzen naar de
uitgesloten groep toch nog weergegeven; hoe kan ik deze weg krijgen?
Ga naar Secties onder het kopje Rekeningschema en activeer Huidige rij verbergen bij de
titels
Ik zou graag de weergave van de periode in de titels van de afdrukken onderdrukken
("1ste Semester 2013"); hoe kan ik dit doen?
Ga naar Kopteksten onder het kopje Pagina en deactiveer de Periode afdrukken optie.
Ik wil op de kaft, als er lange titels staan, kunnen kiezen hoe ik de tekst over twee
rijen verdeel en of ik vetgedrukt toepas. Is dit mogelijk?
Het is niet mogelijk het formaat van de kaft te veranderen.
Sommige bedragen worden niet meegenomen in de aangewezen periode. Waarom?
Transacties zonder een datum worden geteld als begintransacties en verschijnen niet in de
afdruk van de Winst & Verlies rekening. Zorg ervoor datums in alle transacties in te voeren.
De Totalen groepen die alle rekeningen van klasse 3 en 4 bevatten worden hernoemd
naar "Winst" of "Verlies", afhankelijk van het resultaat van de boekhoudperiode. Kan
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ik dat veranderen?
Ga naar Secties onder het kopje Rekeningschema en overschrijf de originele tekst door in de
het veld Alternatieve tekst een andere tekst in te voeren voor de actieve rij.
Hoe kan ik de gegevens van het vorige jaar weergeven als dit langer is dan een
standaard jaar?
Klik op de knop "Geavanceerd" in het dialoogvenster van de Uitgebreide balans op groepen bij
Kolommen, voor zowel de balans als de resultatenrekening. Klik in het venster "Kolommen" op
"Toevoegen". Activeer nu de Optie "Prior" in de lijst onder "Kolommen rekeningentabel". Sluit
alle vensters door op Ok te klikken. U kunt, indien nodig, de koppen van de kolommen
aanpassen door in het venster "Kolommen" op de knop "Eigenschappen" te klikken.
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Kopteksten

In de sectie Pagina → Koptekst bevinden zich de opties voor de kopteksten van de pagina's en het
logo voor het afdrukken van de Jaarrekening en de Winst- en Verliesrekening.

Rij 1, Rij 2, Rij 3, Rij 4
In deze velden voert u de teksten in die u als kopteksten in de afdrukken wilt zien. Deze kopteksten
komen voor op de kaft en als kopteksten op iedere pagina.

Periode en/of subdivisie afdrukken
Deze optie is alleen actief als een specifieke periode is gespecificeerd. De periode wordt niet in de
titels van de afdrukken weergegeven wanneer u deze optie uitzet.

Voettekst

Pagina nummers afdrukken
Door deze functie te activeren worden paginanummers afgedrukt.

Datum afdrukken
Door deze functie te activeren wordt de datum afgedrukt.

Kaft afdrukken
Door deze functie te activeren wordt de kaft afgedrukt.
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Layout

In de sectie Pagina → Layout kunt u de lettergrootte en de paginaoriëntatie van de pagina's voor het
afdrukken van de Jaarrekening en de Winst- en Verliesrekening instellen.

Tekengrootte
De afdrukweergave verandert volgens de ingestelde waarde.

Pagina oriëntatie
U kunt hier de pagina oriëntatie selecteren: automatisch, liggend en staand.
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Logo

Met Bestand → Logo-instelling is het mogelijk een logo te gebruiken en de instellingen (breedte,
hoogte, positie) ervan te definiëren. Het is ook mogelijk Aanpassingen aan te maken en op te slaan
met andere logo instellingen.
Dit is een eenvoudiger alternatief voor de logo instelling via de Documententabel.

Om de logo optie voor het afdrukken van de Jaarrekening en de Winst- en Verliesrekening te activeren
is het nodig Logo in plaats van geen te selecteren.
Om de optie voor logo zichtbaar te maken moet u uw logo instellen met Bestand → Logo-instelling.
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Marges

In de sectie Pagina → Marges kunt u de marges instellen van de pagina's voor het afdrukken van de
Jaarrekening en de Winst- en Verliesrekening.

Boven, Onder, Links, Rechts
Dit is de afstand tussen de paginarand en de inhoud.

Koptekst
Dit is de afstand tussen de koptekst en de inhoud.

Voettekst
Dit is de afstand tussen de voettekst en de inhoud.

Marges verhogen m.b.t. afdrukbaar gebied
Als deze optie wordt aangezet wordt de inhoud, als deze bij het afdrukken buiten de randen van de
pagina gaat, automatisch bijgesteld zodat deze binnen het afdrukbare gebied blijft.
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Secties

Deze sectie kan variëren afhankelijk van de instellingen van de kolom Sectie van de rekeningentabel:
zie pagina Secties in het rekeningschema.

Zoals in Rekeningen-tabel
Met deze optie geselecteerd zijn de weergave- en afdrukinstellingen van de Uitgebreide Balans op
groepen hetzelfde als in de Rekeningentabel.
Door op het pijltje links te klikken kunt u de onderdelen van de sectie weergeven. Gewoonlijk worden
alleen groepen met een saldo weergegeven. Om ook groepen met een nulsaldo weer te geven gaat u
naar de sectie Rijen en klikt u op groepen met nulsaldo.

Afhankelijk van de selectie zijn er verschillende secties met verschillende opties:

secties 1, 2, 3, 4, 01, 02, 03, 04... hebben betrekking op de belangrijkste posten van de Balans
rekening secties hebben betrekking op de geselecteerde rekening
groep secties hebben betrekking op de geselecteerde groep

Sectie*
Als u een sectie met een sterretje selecteert hebt u de volgende opties:

Sectie verbergen
Klik op de sectie die u wilt verbergen.

Huidige rij verbergen
Klik op de rij die u wilt verbergen.

Op een nieuwe pagina beginnen
Klik op de kop waarvan u wilt dat die op een nieuwe pagina begint en activeer deze optie.

Alternatieve tekst
Voer een alternatieve tekst in als u een andere tekst wilt voor de geselecteerde sectie of rij.

Als u een nummer of een groep selecteert (1, 2, 3, 4.....) zijn er extra opties:
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Groep voor % berekening (%)
Deze optie is zichtbaar bij het selecteren van een sectie (Activa, Passiva, ...).

De groep dient als basis voor het berekenen van het percentage van de rekeningen in de sectie en
groepen.

Bepaald door software. De groep wordt vastgesteld door het programma. In de regel is dit de
laatste groep in de sectie (totaal activa, passiva, inkomsten en uitgaven).
Groep aangegeven door de gebruiker
Voor de resultatenrekening moet een groep worden aangegeven (bijvoorbeeld totaal verkopen).

Rijen van een lager niveau verbergen
Als u een groep selecteert en u activeert deze optie dan worden rijen van een lager niveau van deze
groep niet afgedrukt in de Uitgebreide Balans op groepen.

Als rekening tonen
Als u een groep selecteert en u activeert deze optie dan wordt de groep weergegeven als een
rekening in de Balans.

Extern boekhoudoverzicht
Drukt de Uitgebreide Balans op groepen af gebaseerd op de structuur van het Bestand
Boekhoudingsoverzicht:
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Bestand Boekhoudingsoverzicht
U kunt het bestand van het Bestand Boekhoudingsoverzicht selecteren met de knop Bladeren.

Groeperings kolom
Kolom waarin de rekeningen verwijzen naar de groepen gedefinieerd in het Bestand
Boekhoudingsoverzicht. Beschikbare kolommen: Gr, Gr1, Gr2, BKlasse en GrBTW.

Ontbrekende groepering signaleren
Controleert of alle rekeningen horen bij een groep in Bestand Boekhoudingsoverzicht.
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Rijen

In de sectie Rekeningschema → Rijen kunt u kiezen voor het afdrukken van de volgende
elementen: Rekeningen, rekeningen met nulsaldo, rekeningen met transacties, groepen
met nulsaldo, lege rijen.
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Kolominstellingen dubbel boekhouden

De sectie Rekeningschema → Kolommen bevat de belangrijkste opties voor het aanpassen van de
kolommen die weergegeven en afgedrukt moeten worden in de Jaarrekening, de Winst- en
Verliesrekening en in de Opmerkingen.

Balans, Winst Verlies Rekening en Opmerkingen

De verschillende opties bepalen welke gegevens worden weergegeven en worden opgenomen in de
afdrukken van de overzichten.

Rekeningnummers
Behalve de rekeningbeschrijvingen worden ook de rekeningnummer opgenomen.

Lopend
Het saldo of de mutaties in basis valuta voor de geselecteerde periode of onderverdeling van periode.
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Kolommen (geavanceerd)

Met dit dialoogvenster kunt u de verschillende kolommen zien zoals die in het overzicht verschijnen
en kunt u de weergave, kopteksten en de kleur van de tekst en de achtergrond veranderen.

U kunt de lijst met kolommen wijzigen met de knoppen Toevoegen of Verwijderen:

Kolommen  Rekeningen tabel
Volledige lijst met kolommen in de tabel Accounts
Boekhoudbedragen [A]
Lijst met kolommen berekend voor de huidige boekhoudperiode. (A = Werkelijk)
Budgetbedragen [B]
Lijst met kolommen berekend op basis van gegevens uit de Budgettabel. (B=Budget)

De volgende opties zijn beschikbaar:

Kolommen verbergen/zichtbaar maken
Met het vinkje kunt u een kolom uit de lijst zichtbaar maken of verbergen.
Volgorde veranderen
Gebruik de Naar boven verplaatsen of de Naar beneden verplaatsen knoppen of versleep
de kolom met de muis.
Nieuwe kolom toevoegen
U kunt andere kolommen van de rekeningentabel, of één van de kolommen die door de
rapportagefunctie berekend worden, toevoegen aan het overzicht.
Kolommen uit de lijst verwijderen
Met de knop Verwijderen wordt de kolom verwijderd. U kunt deze altijd weer toevoegen:
Verander de kleur van de tekst of de achtergrond.
Verander de koptekst of andere eigenschappen van de kolom.
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Kolommen - Toevoegen

Het is mogelijk nieuwe kolommen toe te voegen in de Balans, de Winst & Verlies rekening en de
Opmerkingen. Dit doet u via het menu Rapporten → Uitgebreide Balans op groepen →
Kolommen → knop Geavanceerd... → knop Toevoegen.

Lijst met beschikbare kolommen
Het dialoogvenster laat alle kolommen zien die in het overzicht opgenomen kunnen worden:

Kolommen uit de rekeningentabel.
Kolommen met boekhoudbedragen.
Kolommen met budgetbedragen.

Door een kolom uit de lijst te activeren wordt deze toegevoegd aan het overzicht. In het
dialoogventster geavanceerd kunt u de volgorde en kopteksten veranderen.

Door het vinkje weg te halen wordt de kolom uit het overzicht verwijderd.

Kolommen die in de rekeningtabel aanwezig zijn
U kunt elke kolom uit de rekeningentabel opnemen, bijvoorbeeld:

Notitie.
Extra beschrijving.
Beschrijving in een andere taal.
Geïmporteerde of andere kolommen door u toegevoegd.

Boekhoudbedragen
Dit zijn de kolommen met de bedragen berekend door het programma, de beginsaldi en de
ingevoerde transacties, voor de aangegeven periode of voor de onderverdeelde periode.

Het bedrag in valuta van de rekening
Alleen zichtbaar voor vreemde valuta boekhoudbestanden. De saldi in vreemde valuta van de
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rekening worden ook weergegeven.

Huidig
De saldi van het huidige jaar worden weergegeven.

Opening
De Beginsaldi worden weergegeven.

Vorige (periode)
De saldi van de vorige periode worden weergegeven (maand, kwartaal, halfjaar, etc).

Vorige jaar
De saldi van het vorige jaar worden weergegeven.

YTD (Year To Date)
Deze kolom is alleen beschikbaar in de Winst & Verlies rekening. De saldi van het begin van het jaar
tot de laatste transactie datum worden weergegeven.

Budget bedragen
Dit zijn de kolommen met de bedragen die door het programma berekend worden, gebaseerd op de
budgetbedragen die ingevoerd zijn in de rekeningen- of budgettabel. Als u de budgettabel heeft
aangemaakt en er gegevens in heeft ingevoerd gebruikt het programma de gegevens uit deze tabel
voor de berekening, zelfs als er bedragen in de kolom Budget van de rekeningentabel staan. Zie
ook informatie over Budget.

Budget (Huidige periode)
De bedragen voor het budget van de huidige periode worden weergegeven.

Budget Vorige
De bedragen voor het budget van de vorige periode worden weergegeven.

Budget vorig jaar
The budget amounts are displayed for the same period as the current one, but from the previous
year.
De budgetbedragen voor dezelfde periode als de huidige worden weergegeven maar voor het budget
van het vorige jaar.

Opmerkingen over de berekeningsperiode
Het programma kan geen bedragen berekenen voor overlappende perioden tussen meerdere
boekhoudjaren of jaren met begin en eind boekhouddata die niet overeenkomen.
Om saldi te verkrijgen van het vorige jaar dat langer is dan een kalenderjaar activeert u de kolom
Prior. Deze kolom vervangt de kolom "Vorig jaar" die alleen de saldi van vorig jaar van 01.01.xx tot
31.12.xx laat zien.
U vindt deze kolom met menu Rapporten → Uitgebreide balans op groepen → Kolommen →
knop Geavanceerd → Toevoegen. Door te klikken op Rekeningtabel kolommen wordt de lijst
van alle kolommen in de rekeningentabel weergegeven. Activeer in deze lijst de kolom Prior.
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Kopteksten en Opties (Kolom-
eigenschappen)

In deze sectie bevinden zich opties om de kopteksten van de kolommen in de overzichten aan te
passen.

Headers

Rij 1/ Rij 2 / Rij 3
Het is mogelijk de kopteksten van de kolommen te veranderen door de Tekst optie (van het
uitklapmenu) te kiezen en de tekst voor de nieuwe koptekst in te voeren. Als u de Kolom optie kiest
wordt de naam van de geselecteerde kolom getoond.

Opties

Zichtbaar
Als dit vakje wordt geactiveerd wordt de koptekst getoond.

Als een totalenkolom weergeven
Als dit vakje wordt geactiveerd worden alleen de bedragen in de Totalen kolom getoond.
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Kleuren (Kolom-eigenschappen)

U komt in dit scherm via menu Rapporten → Uitgebreide Balans op groepen → Kolommen →
knop Geavanceerd → Eigenschappen → Kleuren. Er zijn opties om de kleuren van teksten en
kolommen te veranderen.

Veranderen
Met deze knop kunt u de kleur van de tekst of de achtergrond veranderen.

Standaardkleur
Met deze knop kunt u de standaardkleur van de tekst of de achtergrond herstellen.
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Onderverdeling

Via menu Rapporten → Uitgebreide Balans op groepen → sectie Rekeningschema →
Onderverdeling kunt u de opties voor onderverdeling in periodes bereiken (jaar, halfjaar, kwartaal,
maand).

Geen
De hele periode wordt getoond.

Onderverdeling per periode
Met de onderverdeling per periode maakt het programma kolommen aan voor de aangegeven
periodes. Voor iedere periode ziet u dezelfde kolommen voor de hele periode.

Met deze functie kunt u de gegevens bekijken voor een periode van:

dagelijks
maandelijks
twee maandelijks
per kwartaal
per 4 maanden
semester (6 maanden)
jaar
5 jaar
10 jaar.

De gekozen periode verschijnt in de kolomkop.

Om ervoor te zorgen dat u niet een overmatig aantal kolommen in de afdruk krijgt:

Beperk het aantal items die u wilt afdrukken.
Geef een kortere periode aan.
Geef het maximum aantal periodes aan.
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Periodes voor het hele jaar aanmaken
Wanneer de boekhoudperiode niet hetzelfde is als het kalenderjaar, maar als de gebruiker toch alle
maanden wil zien, moet deze optie worden geactiveerd.

Kolom Totalen
Deze functie maakt een kolom Totalen aan voor de geselecteerde periodes in de Winst & Verlies
rekening en in de weergave Totalen van het Boekhoudoverzichten commando (menu Rapporten).

Max aantal verdelingen
Het standaard maximaal aantal perioden is 36. In speciale gevallen, als de gebruiker speciale en erg
gedetailleerd statistieken over een lange tijdsspanne wil krijgen, kan deze waarde handmatig
veranderd worden. Een hoog maximaal aantal perioden kan het programma trager maken.

Onderverdeling per segment
Met segmenten kunt u overzichten maken voor een bepaalde sectie van het bedrijf. Secties worden
gedefinieerd in het rekeningschema. Met de verdeling in periodes maakt het programma kolommen
aan voor de verschillende segmenten. Voor ieder segment ziet u dezelfde kolommen voor de hele
periode.

Iedere onderverdeling krijgt de naam van de kop in het rekeningschema. De gesplitste gegevens
(gebaseerd op uw selectie) wordt weergegeven.

De optie Onderverdeling per segment is alleen actief als segmenten zijn ingesteld in de
rekeningentabel.

U kunt selecteren:

Alles selecteren - Op deze manier worden segmenten die worden toegevoegd automatisch
weergegeven in de afdruk.
Leeg - De bedragen die niet toegewezen zijn aan een segment worden weergegeven.
Een keuze uit de segmenten - Kies alleen de segmenten die u in de afdruk wilt zien.
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Kolom Totalen
Als deze optie wordt geactiveerd worden de totalen voor het geselecteerde segment opgehaald.

Segment koptekst
U kunt hier de tekst kiezen die weergegeven moet worden als kolomkoptekst voor de segmenten.
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Periode

In de sectie Rekeningschema → Periode kunt u de hoeveelheid te verwerken gegevens beperken,
deze alleen voor een aangegeven periode weergeven of afdrukken of, in het geval van een budget,
prognoses maken voor meerdere jaren.

Alle

Alle boekingen worden opgenomen in de afdruk.

Geselecteerde periode

Dit staat voor de opgegeven periode, met vermelding van de begin- en einddatum.

Om prognoses voor meerdere jaren te maken is het nodig de einddatum van het jaar van het vereiste
budget in te voeren in the menu Bestand, Bestandseigenschappen tabblad Boekhouding. Voer de
begin- en einddatum van de periode ook in de sectie Periode van de Uitgebreide balans op groepen
in.
Om te budgetteren buiten de boekhoudperiode moeten de transacties in de budgettabel een
herhalingscode hebben. De prognoses worden weergegeven in de kolom Budget.

Boekingen zonder datum

Als er transactie zonder datum zijn ingevoerd in de boekhouding worden deze alleen opgenomen als
Alle is geselecteerd.
Als u echter een periode, bijvoorbeeld 1 januari tot en met 31 december, invoert worden de
transacties zonder datum niet weergegeven in het overzicht.
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Stijl

Met dit dialoogvenster kunt u layouts en het formaat van de bedragen kiezen voor het afdrukken van
de balans en de resultatenrekening. Iedere layout kan aangepast worden door de stijl eigenschappen
en kleuren te veranderen. Kolommen kunnen ook aangepast worden in de sectie Kolommen.

Gebruik stijl
Er zijn diverse modellen van de Uitgebreide balans. Door er een te kiezen kan de gebruiker de
Uitgebreide balans van zijn keuze aanmaken.

Stijl-eigenschappen
Voor iedere stijl kunnen de kleuren van de letters en de achtergronden worden gedefinieerd.

Waarde / Veranderen... / Default herstellen
Met deze functies kan de gebruiker de stijl aanpassen of terugzetten naar de standaardstijl.

Rij-opmaak negeren
De formattering van de rij wordt niet meegenomen wanneer deze optie is geactiveerd.
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Opmaak getallen

In de sectie Stijl → Opmaak getallen kunt u de formaten van getallen en de weergave van
negatieve getallen veranderen.

Delen door 1000
Als er grote bedragen zijn worden de laatste drie nullen weggelaten door deze optie te activeren.

Centen tonen
Door deze optie te activeren worden centen getoond.

Nulbedragen tonen
Met deze optie geactiveerd is het mogelijk te kiezen tussen nulbedragen getoond als 0,00 of als -,-.

Negatieve getallen
Negatieve getallen kunnen worden getoond met het minteken voor of achter het bedrag, of het
bedrag kan getoond worden tussen ronde haakjes. U kunt ook de optie activeren om de negatieve
getallen in rood te tonen.
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Teksten

Via de sectie Stijl → Teksten kunt u de kopteksten van de kolommen, die het programma gebruikt
voor de afdrukken, veranderen.

Om de teksten in de Waarde kolom te veranderen dubbelklikt u op de cel die u wilt aanpassen.
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Bijlagen

Via de sectie Stijl → Bijlagen kunt u tekst toevoegen aan het overzicht.

Teksten worden afgedrukt na de Balans en Winst & Verlies rekening.
Ieder document begint op een nieuwe bladzijde.

Documenten
Alle documenten die in de tabel Documenten staan (Html of tekst formaat) worden hier opgesomd.

U kunt de volgorde in het overzicht veranderen door het item met uw muis te verslepen
Alle documenten met een vinkje worden afgedrukt.

Bewerken...

Een tekstverwerkingsvenster wordt geopend waar u nieuwe tekst kunt invoeren of bestaande tekst
kunt veranderen.

Toevoegen

Met deze knop opent u een nieuw leeg document waar u tekst kunt toevoegen in een nieuwe bijlage.
Als u nog geen tabel Documenten heeft aangemaakt doet het programma dat automatisch.

Verwijderen

Met deze knop verwijdert u de geselecteerde bijlage en zijn inhoud.

Opmerkingen
Deze functie is niet beschikbaar in vorige versies.
Wanneer het bestand wordt geopend met een vorige versie van de Banana Boekhouding
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software krijgt u een melding dat het bestand niet helemaal compatibel is.
Als u in dit tabblad veranderingen gemaakt heb en u drukt op OK dan moet u meerdere malen
het Ongedaan maken commando geven om dit ongedaan te maken.
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Aanpassing

Met aanpassingen kunt u afdrukinstellingen opslaan en deze later weer gebruiken.

Uitleg over de sectie Aanpassing vindt u op de pagina met algemene informatie over Aanpassing.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 363

Eindejaar PDF afdrukken

Pdf-archief met alle boekhoudgegevens
Het bestand wordt aangemaakt met een inhoudsopgave die een gemakkelijke toegang tot de
verschillende afdrukken mogelijk maakt.

U kunt de volgende documenten in PDF formaat opslaan:

Balans en Winst- en Verliesrekening
Rekeningen-, transactie-, BTW- en totalentabel
BTW overzichten
Rekeningkaarten

Als u dit bestand opslaat op een niet herschrijfbare CD (te bewaren bij de boekhouddocumenten)
voldoet u aan de vereisten voor het archiveren van boekhoudgegevens.

Dit voorbeeld is gemaakt met de volgende functies:

Menu Bestand → Pdf bestand aanmaken

Een extra kolom afdrukken
De volgende functies worden gebruikt om een extra kolom in de balans af te drukken:

Voeg de nieuwe kolom toe in de Rekeningen tabel, via het menu Gegevens → Kolommen
instellen
Uitgebreide Balans op groepen
Kolommen (geavanceerd), om de weergave van de nieuwe kolom te activeren.

http://www.banana.ch/doc/nl/node/2124
http://www.banana.ch/doc/nl/node/2124
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Meerjaren overzichten

Met een overzicht over meerdere jaren heeft u een eenvoudige en directe vergelijking van de
ontwikkeling van uw bedrijf. Banana Boekhouding kan balansen weergeven tot en met twee vorige
jaren in hetzelfde overzicht, dus de balans van 2022, 2021 en 2020 in een enkel rapport.

Om de balansen van meerdere jaren te kunnen bekijken is het nodig dat de gegevens voor de optie
"Bestand van vorig jaar" correct zijn ingevuld in de Bestand en boekhoudingseigenschappen →
Optie tabblad. Anders kan Banana Boekhouding de balansen van de vorige boekhoudperiodes niet
ophalen en die blijven dan leeg.

In het volgende voorbeeld laten we zien hoe u een overzicht voor de jaren 2022, 2021 en 2020 krijgt.
Zo gaat u te werk:

menu Rapporten → Uitgebreide balans op groepen ...
Vink aan Lopend en Vorig jaar in de sectie Kolommen.
Knop Geavanceerd (klik zowel op de knop in het gedeelte voor de Balans als voor de Winst
_Verlies rekening).

Klik in het dialoogvenster dat geopend wordt op de knop Toevoegen om een kolom toe te
voegen.

Ga in de lijst naar beneden tot u "Vorig jaar - 2 jaren" ziet (we moeten 2 jaar terug vanaf het
lopende jaar).
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Bevestig met 3 maal OK om het overzicht te krijgen.
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Boekhoudingsoverzicht

Het commando Boekhoudingsoverzichten... van het menu Rapporten. maakt de bedragen
van de rekeningen zichtbaar met een specifieke groepering, voor een specifieke periode of met
een specifieke onderverdeling.
Transacties zonder een datum worden beschouwd als openingstransacties en verschijnen niet
in de afdrukken van de Winst & Verlies rekening.

Een logo gebruiken in de afdruk van het
boekhoudingsoverzicht
Om boekhoudoverzichten met een logo te maken moet u, nadat u het overzicht gemaakt heeft:

Menu Bestand → Afdrukvoorbeeld → kies Pagina instelling (klik op het Instellingen icoon).
In het dialoogvenster dat geopend wordt kiest u in de Logo optie uw logo in plaats van Geen.

Zie ook de pagina Logo-instellen.

Base tabblad
Rapport
Hier kunt u de gewenste groepering kiezen:

Zoals in Rekeningen-tabel - het rapport laat een lijst van alle rekeningen precies zoals in de
Rekeningen-tabel zien met de Beginsaldi en Saldokolommen
Rekening op klasse - het rapport laat de rekeningenlijst, maar zonder de subgroepen, zien
Extern boekhoudingsoverzicht - het rapport laat de gegevens zien volgens een groepering
ingesteld in een apart bestand (menu Bestand → Nieuw... → Dubbel boekhouden →
Boekhoudingsoverzicht).

Opties
Hier kunt u de rekeningen kiezen die wel- of niet meegenomen moeten worden:

Alleen groepstotalen weergeven - alleen de groepstotalen worden getoond
Rekeningen met transacties opnemen - alleen rekeningen met transacties worden



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 367

afgedrukt
Rekeningen met nulsaldo opnemen - ook rekeningen met een nulsaldo worden afgedrukt
Groepen zonder rekeningen uitsluiten - groepen die uitsluitend rekeningen met een
nulsaldo bevatten worden niet afgedrukt.
 

Andere tabbladen
De andere tabbladen worden uitgelegd in de volgende pagina's:

Tabblad Periode
Tabblad Onderverdeling
Tabblad Aanpassing

Rapport resultaat
Een nieuwe tabel wordt aangemaakt waarin de resultaten worden getoond.
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Budgettabel

De invoer voor de financiële planning wordt gedaan in de Budgettabel. Deze is gelijkwaardig aan de
transactietabel maar heeft enkele kolommen speciaal om het budgetteren sneller en makkelijker te
maken.
U kunt gegevens ook naar wens aanpassen om betrouwbare en altijd perfect bijgewerkte budgetten
te hebben:

Budgettabel.
Budgettabel en de financiële planning
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Jaarafsluiting | Dubbel boekhouden

De verrichtingen aan het einde van het jaar omvatten alle controles, analyses en tijdgebonden
verrichtingen die aan het einde van het jaar moeten worden uitgevoerd voordat de financiële
overzichten voor het jaar worden opgesteld.

Technische aspecten
Met Banana Boekhouding heeft elk boekjaar zijn eigen aparte bestand; technisch gezien is er geen
concept van afsluiting van het boekjaar:

Wanneer een nieuw jaar begint, wordt een nieuw bestand aangemaakt met het commando
Nieuw Jaar aanmaken.
U kunt tegelijkertijd blijven werken aan het bestand van het nieuwe jaar en het bestand van het
vorige jaar. Zodra de afsluitingen zijn voltooid, kunt u de beginsaldi van het bestand van het
nieuwe jaar bijwerken.

Belasting aspecten
Vóór het afsluiten van de boekhouding is het nodig een aantal bewerkingen uit te voeren die
gevolgen hebben voor de belastingen. De rekening goederen moet worden aangepast, de transacties
voor afschrijvingen moeten worden ingevoerd, het opgebouwde inkomen en schulden, de BTW
aangifte moeten worden gecompleteerd, bepaling hoe en op welke rekeningen de winst en verlies
moeten verrekend en zo zijn er nog veel meer bewerkingen voor controle en waarmerking.

Voor het programma is er geen verschil of de winst hoog is of laag. Echter voor de belastingen maakt
dit veel uit. Deze aspecten moeten worden geverifieerd met uw belastingadviseur of accountant. Het
kan heel nuttig zijn een specialist te raadplegen om te begrijpen wat er allemaal nodig is voordat u de
boeken sluit, vooral als u voor de eerste keer een boekhouding beheert. Accountants zijn erg druk aan
het begin van het jaar en gedurende de periode voorafgaand aan de deadline van de
belastingaangifte. Het kan daarom handig zijn dit te bespreken met uw accountant - of hem het
boekhoudbestand toe te sturen - een paar maanden voordat de boeken gesloten worden, zodat u zelf
thuisraakt in wat er moet gebeuren.

Commando boekhouding controleren
Banana Boekhouding laat u toe om snel te registreren en ook om uitstaande operaties te onderbreken
zonder de voortzetting van het werk te hinderen.

Het commando Acties → Boekhouding controleren voert een hele reeks controles uit, alsof u de
gegevens vanaf het begin opnieuw invoert, en wanneer er fouten of verschillen worden ontdekt,
worden deze gesignaleerd.

Het is raadzaam om het commando Boekhouding controleren met een zekere regelmaat te gebruiken
en telkens wanneer er verschillen of foutsignalen zijn, belangrijke wijzigingen (opening wisselkoersen,
BTW codes) en vooral voor het afsluiten van de boekhouding.
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Controles en verificaties
Verificatie van de beginsaldi

In de Rekeningen-tabel moet in de kolommen Begin- en Saldo in de rij "Verschil moet nul zijn"
geen bedrag worden vermeld, anders is er een fout die moet worden gevonden en gecorrigeerd
opdat de openingssaldi correct zijn.
Opmerking: In de Transacties weergave, in de Debit en Credit kolommen, is het normaal
bedragen te hebben.
Zorg ervoor dat de debiteuren- en crediteurentransacties van het vorige jaar zijn afgesloten.
Controleer of de beginsaldi in overeenstemming zijn met de eindsaldi van het vorige jaar die
reeds gecontroleerd en aan de belastingdienst gemeld zijn.
Voor boekhouding met vreemde valuta, zie de betreffende pagina Beginsaldi in boekhouding
met vreemde valuta .

Verificatie van de boekhoudsaldi

Het eerste wat moet worden gedaan is ongetwijfeld ervoor zorgen dat de rekeningsaldi met elkaar
overeenstemmen. Het saldo van de kasrekening moet overeenstemmen met het werkelijke kassaldo.
Het saldo van bankrekeningen, creditcards, leningen of tegoeden moet overeenstemmen met het
saldo op het bankafschrift. Hetzelfde geldt voor alle andere rekeningen waarop u uitstel van betaling
heeft, BTW, leveranciers, enz.

Als er een verschil is, moet u nagaan waarom en dienovereenkomstig hetzij het beginsaldo, hetzij de
transacties corrigeren.

Verschillen in de Transactiestabel

Controleer in de Transactiestabel (Info venster onderaan) of er geen verschillen worden
gerapporteerd. Naast de functies die aanwezig zijn in de opdracht Boekhouding controleren, is er
in de Transacties tabel van Banana Boekhoiuding Plus ook de kolom Saldo, waarmee u alle rijen kunt
opsporen waar verschillen zijn ontstaan. Een snelle scroll van de kolom is voldoende om de
boekhoudkundige verschillen onmiddellijk te identificeren en ze te corrigeren, zonder de fouten in het
nieuwe jaar te laten voortduren.

Verschillen tussen banksaldi van bankafschriften en boekhoudsaldi (functie CheckBalance)

Deze verrichting is van fundamenteel belang voor de waarheidsgetrouwheid van de boekhouding. Wij
raden u aan de verificatie van de saldi, #CheckBalance, niet alleen aan het einde van de
boekhoudperiode uit te voeren, maar periodiek aan het einde van elke maand, om te voorkomen dat
eventuele onjuiste saldi van maand tot maand worden doorgegeven.
Meer informatie over de verificatie van de balans op de Checkbalance-pagina.

Vreemde valuta boekhouding
Als u vreemde valuta boekhouding gebruikt, moet u ook slotwisselkoersen instellen en
ongerealiseerde wisselkoerswinsten en -verliezen boeken. Raadpleeg hiervoor deze pagina:

Jaarafsluiting in een boekhouding met vreemde valuta

http://www.banana.ch/doc/nl/node/9858
http://www.banana.ch/doc/nl/node/9858
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Boekhoudkundige afsluitingsboekingen
Aan het einde van het jaar, vóór de aanvang van het nieuwe jaar, moeten er afsluitende boekingen
worden verricht. Dit zijn correctieboekingen, waardecorrecties en aanpassingen in verband met
personeelsbijdragen. Dit zijn de belangrijkste:

Importeer de bewegingen van de kasrekening in het hoofdboekhoudbestand
Deze bewerking wordt alleen uitgevoerd in het geval dat de kasrekening apart wordt bijgehouden in
een apart bestand van de boekhouding.
Nadat de import heeft plaatsgevonden, moet worden gecontroleerd of het saldo van de kasrekening
in het hoofdboekhoudbestand overeenkomt met het saldo van het kasbestand. Deze controle kan ook
worden uitgevoerd met de  Check Balance functie, beschreven in de vorige paragraaf.

Importeren van de loonverrichtingen in het boekhoudbestand
Deze handeling wordt alleen uitgevoerd als de salarisadministratie wordt beheerd met een specifieke
boekhoudsoftware waarmee u de transacties kunt importeren in het Banana Boekhouding Plus
bestand.
De import wordt uitgevoerd via het menu Acties → Naar boekhouding importeren → Transacties met
kolomkop importeren.
Vergeet niet om de 13e maand van december quota in te voegen, als deze niet is gemaakt door de
payroll software.

Correctie van de Delcredere-rekening
Ondernemingen die op basis van het toerekeningsbeginsel boeken, moeten, indien zij potentiële
verliezen voorzien, de Delcredere-rekening vereffenen.

Afschrijving
Op 31.12 moet u de afschrijvingen van roerende en onroerende activa boeken en de eventuele
versnelde afschrijvingen evalueren voor de activa die snel verouderd zijn.
U kunt onze applicatie Register Aktiva gebruiken die automatisch de afschrijvingstransactie aanmaakt
en u kunt ze hervatten in het boekhoudbestand.

Inventaris aanpassing
Met onze Inventarisapplicatie beschikt u over nauwkeurige tellingen, zowel per stuk als per waarde,
zodat u uw voorraadafrekening sneller kunt bepalen.

Openstaande facturen van klanten en leveranciers controleren op 31.12
Om het proces te vergemakkelijken, kunt u met de functie openstaande facturen per klant en
openstaande facturen per leverancier snel de waarden per 31.12 vaststellen.

Privégebruik
Als de onderneming een bedrijfswagen gebruikt, moet u de transactie voor het privégebruik met de
juiste BTW-code invoeren.

Afsluiting en BTW-aangifte
Alvorens de BTW-aangifte in te dienen, raden wij u aan de volgende verificaties uit te voeren:

Gebruik het commando Boekhouding controleren. In geval van fouten en verschillen, vindt u de
berichten in het Informatievenster (onderaan het scherm), in de rubriek Berichten.
Controleer of er geen verschillen zijn in de kolom Saldo van de Transacties-tabel.
Controleer of uw banksaldi overeenkomen met die op de bankafschriften.
Controleer of, na terugboeking van het saldo op de verschuldigde BTW-rekening (aan de
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belastingdienst te betalen BTW), de automatische BTW-rekening op nul staat. Op de
verschuldigde BTW-rekening moet het te betalen bedrag of het te ontvangen kredietbedrag
worden vermeld.
Voordat je de laatste BTW-aangifte indient, bekijk je de BTW-overzichten van de voorgaande
kwartalen, om te controleren of de aan de belastingdienst betaalde bedragen nog steeds
overeenkomen met de weergegeven bedragen.
Gebruik het VAT Overzicht commando om de verschillende rapporten te bekijken en een PDF
afdruk te maken om de gegevens te archiveren. In geval van belastingcontroles zullen deze
nuttig zijn.

De rekening vereffenen voor de Bronbelasting
Na de berekening en de boeking van de salarissen van december, gaat u over tot de boeking van de
verrekening van de "Bronbelasting", op basis van de afrekening die naar de Belastingdienst is
gezonden.

Vergoedingen voor het hoger management
Indien voorzien, neem het bedrag dat door de fiscus als forfaitaire terugbetaling is toegestaan op in
het salaris van december.

Verrekening privérekening
Verifieer het saldo van de privérekening. Als er een debet/credit-relatie bestaat tussen het bedrijf en
de eigenaar(s) (of naaste personen), boek dan de inkomsten- of uitgavenrente zoals bepaald in de
leenovereenkomst of volgens de toepasselijke belastingrichtlijnen.

Verrekening van belastingen en vergoedingen
Controleer of de in de loop van het jaar verrichte aanbetalingen betrekking hebben op het lopende
jaar. Belastingbetalingen die betrekking hebben op voorgaande jaren moeten eerst worden geboekt
om de overeenkomstige gereserveerde bedragen af te sluiten, en vervolgens (indien er overschotten
zijn) moeten deze worden geboekt via de rekening "Directe Belastingen" (activa). Indien het saldo van
de voorzieningen onvoldoende of te hoog is, moet het verschil als buitengewone bate/last of met
betrekking tot voorgaande perioden worden geregistreerd.

Boeking van de eindsaldi AOW en sociale bijdragen

Boeking van de eindsaldi van de sociale verzekeringen

Stuur het bestand naar de boekhouder voor afsluitingen
Als de afsluitingen en/of audits door uw boekhouder worden uitgevoerd, stuurt u het met Banana
Boekhouding Plus aangemaakte boekhoudbestand gewoon per e-mail of slaat u de gegevens op een
USB-stick op.

Als uw boekhouder Banana Boekhouding heeft, stuurt u het ac2-bestand gewoon per e-mail of
via een USB-stick. U kunt uw bestanden en digitale documenten ook opslaan in een gedeelde
map met uw vertrouwenspersoon op Dropbox. U hoeft geen zware papieren documenten meer
naar de boekhouder te brengen. Bovendien zal hij snel werken zonder de papieren
documentatie te moeten doornemen.
Indien uw mandataris geen Banana Boekhouding heeft, kunt u een PDF-bestand maken van de
boekhoudkundige gegevens, via het menu Bestand → PDF bestand aanmaken en stuur
hem/haar het bestand per e-mail. Hij/zij zal u alle wijzigingen en toevoegingen aangeven die
moeten worden opgenomen om de boekhoudkundige periode correct af te sluiten.
Als alternatief kan uw gevolmachtigde uw boekhoudbestand openen met de gratis versie van
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Banana Boekhouding Plus, door het te downloaden van onze Download pagina . Als uw
bestand meer dan 70 transacties bevat, zal hij/zij niet in staat zijn om boekingen toe te voegen
of wijzigingen aan te brengen, maar hij/zij zal nog steeds in staat zijn om alle gegevens te zien,
gedetailleerde kaarten van de rekeningen te krijgen door gewoon te dubbelklikken op een
rekeningnummer, enz, en u adviseren over mogelijke correcties en / of verbeteringen.

Transacties blokkeren
Zodra de afsluitings- en verificatieboekingen zijn uitgevoerd, raden wij u aan om over te gaan tot het
blokkeren van uw boekhoudtransacties.

Menu Acties → Transacties blokkeren

De transactierijen worden genummerd en krijgen een blockchaincode die hun veiligheid
garandeert

Printouts voor de Jaarafsluiting
Voor de afdrukken aan het einde van het boekjaar kunt u de informatie vinden door op de volgende
links te klikken:

Rekeningkaarten / Grootboek
Journaal
Uitgebreide Balans op groepen
Boekhoudingsoverzicht
BTW Overzicht
Eindejaar PDF afdrukken

PDF Bestand
Met het commando PDF Bestand aanmaken kunt u alle documenten van de volledige
boekhoudperiode (rekeningkaarten, journaal, BTW-overzichten, maand-, kwartaal- en jaarverslagen...)
in één enkel PDF-bestand bewaren.

U kunt de boekhoudgegevens archiveren door het boekhoudbestand en de PDF-afdrukken op te slaan.
Maak eventueel back-ups op een externe schijf.

Documentatie voor het auditproces
Op de pagina De documentatie voor de audit voorbereiden hebben wij een reeks opmerkingen en
suggesties geplaatst over documentatie die naar de auditor moet worden gestuurd. Een volledige
documentatie is een goede basis om het werk van de auditor efficiënter en sneller te laten verlopen.

Winst/verlies toewijzing
In Banana Boekhouding Plus vindt de verdeling van de winst of het verlies automatisch plaats bij de
start van het nieuwe jaar. Voor meer informatie raadpleeg de pagina Nieuw jaar aanmaken.

https://www.banana.ch/nl/download
http://www.banana.ch/doc/nl/node/3353


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 374

Nieuw jaar aanmaken | Dubbel boekhouden

 Het commando nieuw jaar aanmaken creëert een bestand voor het nieuwe jaar op basis van het
boekhoudbestand dat wordt afgesloten. Het commando wijzigt het huidige bestand niet, zodat het
zonder gevolgen kan worden uitgevoerd.

Logica van de overgang naar het nieuwe jaar
Met Banana Boekhouding heeft u voor elk jaar een apart bestand. Wanneer het nieuwe jaar begint, is
de operationele logica als volgt:

Met het commando Nieuw jaar aanmaken, maakt het programma een nieuw bestand voor het
jaar aan, met hetzelfde rekeningschema, dezelfde instellingen en saldi van het lopende jaar dat
op het punt staat te worden afgesloten.

Zodra het nieuwe jaarbestand is gecreëerd, sla het op met een nieuwe naam.
De handeling van het aanmaken van het nieuwe bestand kan worden herhaald indien u
besluit het bestand niet op te slaan.

U kunt aan beide bestanden tegelijk werken:
In het nieuwe worden de transacties van het nieuwe jaar ingevoerd. Het zal ook mogelijk
zijn wijzigingen aan te brengen in het rekeningschema, de BTW of andere, zonder dat het
vorige jaar wordt beïnvloed.
In het dossier van het vorige jaar worden de transacties verder ingevoerd om het jaar af
te sluiten en de typische afsluitende verrichtingen uit te voeren, saldi te verifiëren,
rapporten af te drukken, enz.

In het bestand van het nieuwe jaar worden, met het commando Acties → Beginsaldi bijwerken
de wijzigingen die in het bestand van het vorige jaar werden aangebracht, hervat. Deze
operatie moet worden uitgevoerd ten laatste wanneer er geen wijzigingen meer zijn in het
vorige jaar.

Zodra het Bestand voor het nieuwe jaar is aangemaakt, zullen degenen die geabonneerd zijn op het
Professional Plan van Banana Boekhouding Plus, het bericht Advanced Plan in demonstratiemodus
zien. Deze melding zal verschijnen in het Info venster onderaan het scherm en zal pas verdwijnen bij
het bereiken van 70 transactieregels in de Transactions tabel.

Controleren en afsluiten van de boekhouding van het vorige
jaar
Alvorens de beginsaldi bij te werken, is het belangrijk dat u alle controles, verificatiebewerkingen en
alle boekingen ter afsluiting van het boekjaar hebt uitgevoerd, om verschillen tussen de eindsaldi van
het lopende jaar en de beginsaldi voor het volgende jaar te voorkomen. Raadpleeg de pagina:

Controle en afsluiting in het Dubbel boekhouden
Afsluiting en wisselkoersen voor de Vreemde valuta boekhouding
Specifieke informatie voor het instellen van slotkoersen en het boeken van niet-gerealiseerde
wisselkoerswinsten en -verliezen.

https://www.banana.ch/doc/nl/appmsg_nl_info_license_extended_startupmode
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Bewerkingen uitgevoerd door het commando Nieuw jaar
aanmaken
Het Nieuw jaar aanmaken... commando voert de volgende bewerkingen uit, rekening houdend met de
door de gebruiker ingestelde parameters

Maakt een nieuw bestand aan (zonder naam) met het rekeningschema en de instellingen van
uw huidige bestand, maar zonder transacties.
Kopieert de gegevens van de Saldo kolom van uw huidige bestand naar de Opening kolom van
het nieuwe bestand (alleen voor de geselecteerde klassen)
Telt de winst of verlies van het vorige jaar op bij het beginsaldo van de aangegeven rekening of
rekeningen voor de uitsplitsing (gewoonlijk wordt de rekening voor overgedragen winst / verlies
aangegeven).
Kopieert de gegevens van de Saldo kolom van uw huidige bestand naar de Vorig Jaar kolom
van het nieuwe bestand (voor alle rekeningen).
Werkt de Bestands en boekhoudingseigenschappen van het bestand bij:

Stelt de begin- en einddatum in, waarbij 1 jaar wordt toegevoegd aan de bestaande.
In de sectie Opties, stelt de bestandsnaam van het vorige jaar in en activeert de optie om
de transacties van het vorige jaar te gebruiken voor autoaanvulling.

Voert in een Vreemde valuta boekhouding de slot wisselkoersen van het vorige jaar in als
opening wisselkoersen..
Als er gegevens in de Budgettabel staan, worden de transactierijen overgenomen in het nieuwe
jaar, rekening houdend met de instellingen.
Als de optie Segmenten is geactiveerd worden openingstransacties voor de segmenten
aangemaakt.

Dialoog Nieuw Jaar aanmaken
In het dialoogvenster Nieuw jaar aanmaken kunt u de parameters opgeven voor het aanmaken van
het bestand voor het nieuwe jaar:

Beginsaldi van de rekeningen overbrengen
De beginsaldi van de geselecteerde opties worden overgebracht.

Balans
Toont de saldi van activa-, passiva- en aandelenrekeningen. Deze optie moet over het algemeen
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geactiveerd zijn.

Winst- en Verliesrekening (niet aangeraden)
De saldi van de uitgaven- en inkomstenrekeningen moeten NIET worden overgedragen naar het
nieuwe jaar.
Deze optie wordt alleen gebruikt in speciale gevallen. Activeer deze optie alleen als u weet wat u
doet.

Buiten de balans om
Toont rekeningen met BKlasse (5 en 6)

Kostenplaatsen
Deze moeten worden geactiveerd als de kostenplaatsen worden gebruikt om posten te beheren die
doorlopen in de tijd zoals klanten, leveranciers en partners.

Kostenplaatsen KP1
Deze beginnen met een punt ".".

Kostenplaatsen KP2
Deze beginnen met een komma ","

Kostenplaatsen KP3
Deze beginnen met een puntkomma ";".
Voor meer informatie zie pagina Kostenplaatsen en Winstcentra.

Segmenten

De beginsaldi van de segmenten worden gecreëerd met openingstransacties in de transactietabel.

Voor meer informatie zie pagina Segmenten.
Het programma maakt transacties aan voor iedere rekening en segment die overeenkomen
daarmee de exacte situatie van het vorige jaar reproducerend.

Het wordt aanbevolen om de beginsaldi van de segmenten niet in te voeren in de kolom
Opening. Als dit is gedaan in het vorige jaar laat het programma het saldo opnieuw zien in de
kolom Opening van het nieuwe jaar.

Let op: verrekeningen, zoals het opnemen en afsluiten van overgangsrekeningen, deze moeten
handmatig worden ingevoerd.

Winst/Verlies toewijzen
Wanneer de beginsaldi naar het nieuwe jaar worden overgedragen, worden de overgedragen
winstrekeningen bij de vermelde cijfers opgeteld.

Toe te wijzen totaal
Het programma geeft het winst/verlies bedrag aan dat verdeeld moet worden.

Rekeningen
Selecteer de rekening(en) (maximaal drie) waarin het bedrijfsresultaat moet worden verdeeld. Als er
meerdere rekeningen voor de toewijzing van het financiële jaarresultaat zijn moet het bedrag
handmatig in de bijbehorende velden ingevoerd worden.
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Als maar één rekening wordt geselecteerd wordt het bedrag automatisch ingevoerd. Het programma
werkt de beginsaldi automatisch bij. Het totaal van de Activa zal precies overeenkomen met het
totaal van de Passiva.

De toewijzing van het resultaat van de boekhoudperiode aan meer dan drie rekeningen.
Wijs in dit geval het resultaat van de boekhoudperiode automatisch toe aan de overgedragen Winst-
en verliesrekening zoals gebruikelijk, en ga verder met het aanmaken van het nieuwe jaar.
Voer in de Transacties tabel van het nieuwe jaar (nieuw bestand) een meervoudige boeking uit om
het bedrijfsresultaat van de overgedragen winst- of verliesrekening aan de gewenste rekeningen toe
te wijzen.

Uitstellen van de toewijzing van de winst of het verlies van het jaar
Indien u het resultaat van het jaar nog niet wenst toe te wijzen, kunt u toch overgaan tot het
aanmaken van het nieuwe jaar, door op de OK knop te klikken. Daarna kunt u overgaan tot de
toewijzing van het bedrijfsresultaat via het menu Acties → Beginsaldi bijwerken. Het programma toont
hetzelfde venster dat verschijnt met het commando Nieuw jaar aanmaken.

Sla het nieuwe bestand op
Het programma maakt een nieuw boekhoudbestand aan voor het nieuwe jaar:

U moet daarna de bestandseigenschappen compleet maken en het bestand opslaan met een nieuwe
naam.

Bevestig de Bestands en boekhoudingseigenschappen voor het nieuwe jaar. Het
programma gebruikt de kopteksten van het vorige jaar en voert automatisch de begin- en
einddatum van het nieuwe jaar in.
Geef via Bestand → Opslaan als... de map aan waar het nieuwe boekhoudbestand
opgeslagen moet worden. Wij raden u aan de bedrijfsnaam en het jaar als naam in te voeren.
Zie ook Beheer boekhoudbestanden

Als er verschillen zijn of andere problemen kunt u het aangemaakte bestand ook niet opslaan en de
bewerking om een nieuw jaar aan te maken later herhalen.

Beginsaldi bijwerken
Nadat u de laatste wijzigingen van het vorige jaar hebt ingevoerd, gebruikt u het commando Acties →
Beginsaldi bijwerken , om de openingssaldi op te halen en de winst van het vorige jaar opnieuw toe
te wijzen.

Deze operatie kan verschillende keren worden herhaald en kan veilig worden uitgevoerd, aangezien
de integriteit van de gegevens tijdens de overgang gewaarborgd is en er geen informatie verloren
gaat.

Indien u wenst over te schakelen naar een ander type boekhouding voor het nieuwe jaar (met
vreemde valuta of met BTW) gaat u verder met het aanmaken van het nieuwe bestand en gebruikt u
vervolgens het commando Extra → Naar nieuw bestand converteren.

Indien u een kopie van het bestand wenst te maken, zonder de saldi over te dragen, gebruik dan het
commando Extra → Copie bestand creëren

https://www.banana.ch/nl/node/11059
http://www.banana.ch/doc10/nl/node/9735
http://www.banana.ch/doc10/nl/node/9735
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Wijzigen van overgedragen saldi
Zodra de saldi naar het nieuwe jaar zijn overgedragen (nieuw bestand), kunnen de beginsaldi, indien
nodig, handmatig worden gewijzigd door de bedragen in de volgende kolommen te wijzigen:

Kolom Opening van de rekeningentabel.
Kolom Vorige voor saldi die betrekking hebben op het vorige jaar.
In de transactietabel voor segmenten.

Als u veranderingen hebt gemaakt in het bestand van het vorige jaar klikt u op menu Acties →
Beginsaldi bijwerken  om de saldi over te dragen.

http://www.banana.ch/doc/nl/node/9735
http://www.banana.ch/doc/nl/node/9735
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Beginsaldi bijwerken

Het commando Beginsaldi bijwerken (menu Acties) neemt gegevens over uit het bestand van het
vorige jaar en werkt de beginsaldi bij voor het huidige jaar.

Wanneer moet u het commando Beginsaldi bijwerken
gebruiken?
Het commando Beginsaldi bijwerken is nodig in de volgende gevallen:

U hebt het nieuwe jaar aangemaakt met het commando Nieuw jaar aanmaken, maar u hebt nog
wijzigingen aangebracht in het bestand van het vorige jaar (extra transacties, nieuwe
rekeningen, ...).
U hebt besloten de toewijzing van de winst of het verlies voor het jaar te wijzigen.

De boekhouding van het vorige jaar controleren
Om verschillen tussen de eindsaldi van het vorige jaar en de beginsaldi van het nieuwe jaar te
voorkomen, is het van belang dat u, voordat u het commando Beginsaldi bijwerken gebruikt, er zeker
van bent dat u alle controles, verificatiebewerkingen en alle boekingen ter afsluiting van het boekjaar
hebt uitgevoerd, zoals aangegeven op de pagina Jaarafsluiting.

Het dialoogvenster Beginsaldi bijwerken
Om dit dialoogvenster te openen, gebruikt u het menu Acties → Beginsaldi bijwerken.
U moet het pad invoeren naar de plaats waar het bestand van het vorige jaar zich bevindt:

Het programma zal de naam van het opgeslagen bestand voorstellen
Als de naam van het bestand of het pad naar de locatie is gewijzigd, drukt u op de knop
Bladeren.

Verrichtingen die door dit commando worden overgedragen
Het commando neemt de gegevens van het vorige jaar over, zonder de inhoud ervan te wijzigen. Dit
commando kan dus worden herhaald zonder gevolgen voor het bestand van het voorgaande jaar.
Het commando voert dezelfde bewerkingen uit als in Nieuw jaar aanmaken, behalve die welke
betrekking hebben op het aanmaken van het bestand.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 380

Veranderingen in het rekenschema van het vorige jaar
Als u na het aanmaken van het nieuwe jaar rekeningen toevoegt aan het rekeningschema van het
vorige jaar en dan saldi overbrengt kan het programma een foutmelding geven.

Werk het Rekeningschema voor het huidige jaar bij.
Herhaal de operatie Beginsaldi bijwerken

U kunt de veranderingen importeren met het commando Rekeningen importeren.
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Een boekhoudoverzicht aanmaken

Het Bestand Boekhoudingsoverzicht (boekhoudoverzicht) is een bestand waarin de presentatie van
een overzicht wordt ingesteld door aan te geven hoe de rekeningen worden gegroepeerd.

Het op deze manier gecreëerde groeperingssysteem kan aan de boekhouding worden gekoppeld om
de voor de nieuwe presentatie geselecteerde rekeningen op te halen en te totaliseren.

Het extern boekhoudoverzicht kan, behalve voor aanpassing van de balans en de resultatenrekening
of van andere overzichten, ook worden gebruikt om over te gaan op een ander rekeningschema en de
overdracht van de bijbehorende saldi. Meer details vindt u op de pagina Overgang naar een nieuw
rekeningschema.

Het extern boekhoudoverzicht is alleen beschikbaar met het Banana Boekhouding+ Advanced plan.

Er zijn twee mogelijkheden om te groeperen:

Groepering gebaseerd op de aangegeven groepen
Deze manier is nuttig als men de rekeningen volgens andere kenmerken wilt groeperen,
bijvoorbeeld presenteer de balans en de resultatenrekening volgens een groepering die anders
is de de groepering ingesteld in de rekeningentabel.

In het overzicht wordt het groepensysteem aangemaakt.
Geef voor iedere rekening in de rekeningentabel in de boekhouding in de GR1 kolom
(of een andere kolom) de groep aan waarin de rekening gegroepeerd moet worden.
Wanneer het overzicht wordt uitgevoerd worden alle rekeningen die met groepen in het
externe overzicht bestand gemarkeerd zijn overgenomen.

Groepering gebaseerd op de aangegeven rekeningen
Deze manier is nuttig als men een geen overzicht wil met alle maar alleen met een paar
geselecteerde rekeningen.

Geef in het overzicht de rekeningen aan van de rekeningentabel van het
boekhoudbestand die opgenomen moeten worden.
Wanneer het overzicht wordt uitgevoerd worden alleen de aangegeven rekeningen
overgenomen.

Zo maakt u een boekhoudoverzicht bestand aan
Om een boekhoudoverzicht te maken:

Menu Bestand → Nieuw... → Boekhoudingsoverzicht
U kunt met een bestaand of een geheel nieuw model beginnen.
Sla het aangemaakte bestand op onder een nieuwe naam.

https://www.banana.ch/nl/buy
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De kolommen van het Boekhoudingsoverzicht
Het Boekhoudingsoverzicht bestand heeft dezelfde kolommen als die in het Rekeningschema van het
boekhoudbestand. Dit maakt het mogelijk de groeperingen en totalen aan te maken.

Sectie
Deze kolom wordt gebruikt om de namen aan te geven die in de presentatie gebruikt moeten worden.
Voor de diverse mogelijkheden, zie de documentatie over de Secties.

Groep
De groep waarin de rekeningen van de boekhouding moeten worden getotaliseerd of een groep van
het overzicht.

Rekening (alleen zichtbaar de weergave Compleet)
De rekening die in het overzicht opgenomen moet worden.

Als er rekeningen zijn wanneer het overzicht wordt aangemaakt worden alleen die
overgedragen die aangegeven zijn.
Als er geen rekeningen zijn aangegeven worden de rekeningen die bij elkaar horen d.m.v. een
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groep overgedragen.

Beschrijving
Beschrijving voor de groepering of voor de rij zelf.

Tel Op In
In de kolom Tel Op In, geeft men het de naam van het totaal aan waarin de rij moet worden
getotaliseerd.

Tot
Als het woord "Ja" wordt ingevoerd wordt alleen de Totaal rij weergegeven en niet de rekeningen die
deel zijn van dit totaal.
Zie ook "Alleen groepstotalen weergeven" in het Boekhoudingsoverzicht.

Behouden
Doorgaans worden de totaalrijen die rekeningen hebben met een saldo meegenomen in het overzicht.
Als u "Ja" aangeeft in deze kolom wordt de rij altijd getoond. Dit kan toegepast worden op zowel de
totalen als de rekenigen.

Met trans.
Dit is van toepassing op groepen die een nulsaldo hebben.
De rij wordt alleen getoond als er transacties waren gedurende de overzichtsperiode.

Een Overzicht op groepen aanmaken
Maak in het Overzicht de gewenste groepen en subgroepen aan.
In de Gr1 of Gr2 kolom van de Rekeningentabel geeft men de groep aan waarin de rekening
moet worden getotaliseerd.
Als de Gr1 kolom (of een andere voorkeurskolom) niet zichtbaar is maak deze dan zichtbaar
met het commando Kolommen instellen.
De rekeningen die niet worden aangewezen worden niet meegenomen in het Overzicht.
Genereer het Overzicht door de opdrachten:

Uitgebreide Balans op groepen, gedeelte Secties (Rapporten xx)
Rekeningschema → Extern boekhoudingsoverzicht
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Een Overzicht aanmaken dat alleen geselecteerde
rekeningen van de boekhouding groepeert
Deze methode is actief zelfs als in het overzicht maar één rekening wordt aangegeven.
Geef geen enkele rekening aan als u wilt dat het overzicht wordt gegenereerd op groepen.

In het overzicht worden aangegeven:

De rekeningen van de boekhouding die gegroepeerd moeten worden.
Alleen de aangewezen rekeningen worden in het overzicht opgenomen.
De groepen waarin de rekeningen gegroepeerd moeten worden.

Het boekhoudverzicht kan met de volgende opdrachten aangemaakt worden:

Menu Rapporten → Uitgebreide Balans op groepen, gedeelte Secties,
Rekeningschema → Secties → Extern boekhoudingsoverzicht

Menu Rapporten Boekhoudingsoverzicht kies het Base tabblad en de optie Extern
boekhoudingsoverzicht.
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Vreemde valuta

Vreemde valuta boekhouding is gebaseerd op de methode van het dubbel boekhouden waardoor
rekeningen en transacties in vreemde valuta's kunnen worden beheerd.

Veel dingen van de vreemde valuta boekhouding zijn hetzelfde als van het dubbel boekhouden. Om
ontbrekende lessen of diepgaande informatie te vinden raden we u aan om de volgende pagina's te
raadplegen:

Dubbel Boekhouden.
Karakteristieken

Informatie
Rekeningschema, bestandseigenschappen en wisselkoersentabel
We raden aan om één van de reeds ingestelde voorbeeldbestanden te kiezen en dit naar uw wensen
aan te passen. Let er op dat het rekeningschema de rekening voor winst en verlies
door wisselkoersvariaties moet bevatten en dat er rekeningen in vreemde valuta moeten zijn.

Het rekeningschema met vreemde valuta opzetten
Groepen en subgroepen
Een boekhouding met vreemde valuta beginnen, vreemde valuta tabblad
Wisselkoersen tabel

Transacties
Boekingen moeten op dezelfde manier ingevoerd worden als de dubbel boekhouden transacties

Verschillende types transacties
Boeken van wisselkoersverschillen

Afdrukken

Rekening-/Categorie kaarten
Journaal
Uitgebreide balans
Uitgebreide balans op groepen
Boekhoudoverzichten

Overzetten van een dubbel boekhouden bestand naar een
vreemde valuta boekhoudbestand
Om te zien hoe u vreemde valuta mogelijkheden toe kunt voegen aan een dubbel boekhouden
bestand kijkt u op de pagina Naar nieuw bestand converteren.
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Hoe te beginnen - Vreemde valuta

Aanmaken van een boekhoudbestand uitgaande van een
model
Ga als volgt te werk:

Menu Bestand → commando Nieuw....1.
Selecteer het Gebied, de Categorie en het boekhouding type (met of zonder BTW).2.
Uit de lijst van de Online modellen, kies het model dat het dichtst komt bij wat u nodig heeft.3.
Klik op de knop Aanmaken.4.

U kunt naar modellen zoeken door in het gedeelte Zoeken een sleutelwoord in te voeren. Het
programma geeft de modellen weer die het ingevoerde sleutelwoord bevatten.

Het is ook mogelijk om vanuit een leeg bestand te beginnen, door onder Leeg bestand een bestand
te kiezen. Om de start te vergemakkelijken en groeperingsfouten te vermijden, raden wij u altijd aan
om steeds te beginnen met een bestaand model.

Meer informatie over het aanmaken van een nieuw bestand vindt u op de pagina Nieuw bestand
aanmaken.

De bestandseigenschappen instellen (basis gegevens)
Stel de gegevens in de verschillende secties in via het commando Bestand →
Bestandseigenschappen.

Tabblad Boekhouding

Vul de bedrijfsnaam in die verschijnt in de kopteksten van de afdrukken en andere weergaven.
Kies de basis munteenheid waarmee de boekhouding gedaan wordt uit de lijst naast
Basisvaluta.
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Bestand opslaan
Sla de gegevens op met het commando Bestand → Opslaan als en geef het bestand een naam. Het
dialoogvenster voor opslaan dat hoort bij uw besturingssysteem wordt weergegeven.

Het wordt aangeraden om de naam van het bedrijf te kiezen gevolgd door het jaar
"Bedrijf-20xx.ac2" om het bestand te onderscheiden van de andere.
U kunt zoveel boekhoudbestanden aanhouden als u nodig heeft en ieder heeft zijn eigen naam.
U kunt kiezen welk pad of welk medium u wilt gebruiken (diskdrive, USB of cloud).
Als u verwacht documenten te hebben die gekoppeld zijn aan de boekhouding van het huidige
jaar kunt u een aparte map aanmaken voor ieder boekhouding jaar waar alle bestanden
gegroepeerd worden.

Algemeen gebruik van het programma
Banana Boekhouding is geënt op Excel. De aanwijzingen voor de gebruiker en de commando's zijn
zoveel mogelijk gelijksoortig als die van Microsoft Office.
Voor meer informatie over het algemene gebruik van het programma bezoekt u de pagina over onze
Programma interface.

Wisselkoersen tabel
Voordat u begint met het invoeren van vreemde valuta transacties is het nodig de parameters van de
te gebruiken munteenheden te definiëren in de wisselkoersen tabel.
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Het rekeningschema aanpassen
Pas in de rekeningentabel het rekeningschema naar uw eisen aan:

Voeg rekeningen to en / of verwijder bestaande (zie Nieuwe rijen toevoegen).
Verander de rekeningnummer, de beschrijvingen (bijvoorbeeld voer de naam van uw eigen
bankrekening in), voer andere groepen in, etc.
Raadpleeg onze pagina over Groepen om subgroepen aan te maken.

De Transactietabel
Vreemde valuta transacties moeten worden ingevoerd in de Transactietabel; samen vormen ze het
Journaal.

Sneller transacties invoeren
Om de transacties sneller te kunnen invoeren kunt u de volgende functies gebruiken:

Tekst automatisch aanvullen - hiermee wordt invoer automatisch aangevuld met gegevens die
eerder ingevoerd zijn.
Terugkerende transacties - deze worden gebruikt om terugkerende transacties in een aparte
tabel op te slaan.
Transacties importeren - voor het automatisch importeren van uw bank, of creditcard
afschriften.
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Klanten- en leveranciersfacturen controleren
Met Banana Boekhouding kunt u de te betalen facturen en de betalingen van verstuurde facturen in
de gaten houden. Zie pagina's:

Sub-menu klanten
Sub-menu leveranciers

De rekeningkaart
De rekeningkaart laat automatisch alle transacties zien die geboekt zijn op dezelfde rekening
(bijvoorbeeld contanten, bank, klanten, etc.).

Om een rekeningkaart weer te geven klikt u op het blauwe icoontje dat verschijnt als u met de muis
op de rekening gaat staan.

Rekeningkaart per periode

Om de rekeningkaart met saldi die bij een bepaalde periode horen weer te geven klikt u op:

menu Rapporten → Rekeningkaart → Periode tab → Geselecteerde periode
Voer de start- en einddatum van de periode in.

Zie voor meer details de pagina Periode.

De rekeningkaart afdrukken

Om één rekeningkaart af te drukken geeft u de kaart weer vanuit de rekeningen- of
transactietabel en start u de afdruk vanuit het menu Bestand.

Om meerdere of alle rekeningkaarten af te drukken klikt u op menu Rapporten → Rekeningkaarten
en kiest u de rekeningkaarten die afgedrukt moeten worden. Door het filter in het venster te
gebruiken kunt u automatische alle rekeningen, kostenplaatsen, segmenten, groepen, etc. selecteren.

Voor meer details, raadpleegt u de pagina Rekeningkaarten / Grootboek.

De Balans en de Resultatenrekening
De Balans laat de saldi van alle balansrekeningen zien, activa en passiva. Het verschil tussen activa
en passiva bepaalt het eigen vermogen.
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De weergave en het afdrukken van de balans wordt uitgevoerd vanuit het menu Rapporten, met de
commando's Uitgebreide balans of Uitgebreide balans op groepen.

Het commando Uitgebreide balans laat de rekeningen zien zonder de verdeling in groepen en
subgroepen.
Het commando Uitgebreide Balans op groepen laat de rekeningen zien met een verdeling in
groepen en subgroepen; daarnaast heeft deze functie vele mogelijkheden, die niet aanwezig
zijn in Uitgebreide balans, om de presentatie aan te passen.

Gegevens archiveren in PDF formaat
Aan het einde van het jaar, als de hele boekhouding is voltooid, gecorrigeerd en gecontroleerd,
kunnen alle boekhoudgegevens worden gearchiveerd met het commando PDF bestand aanmaken.

Het Budget
Voordat u aan een belastingjaar begint kunt u de kosten en opbrengsten schatten zodat u de
economische en financiële situatie van uw bedrijf onder controle heeft.
 
Het budget kan op twee verschillende manieren opgezet worden:

Met de Budget kolom van de rekeningentabel. Voor iedere rekening wordt het jaarbudget1.
aangegeven.
Op deze manier geeft de Budget kolom de bedragen voor het hele jaar weer als u het budget
weergeeft vanuit het commando Rapporten → UItgebreide balans op groepen,
In de Budget tabel die aangemaakt kan worden met het commando Extra → Nieuwe functies2.
toevoegen.
In deze tabel kunt u alle gebudgetteerde kosten en opbrengsten invoeren door middel van
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transacties. Als u deze tabel gebruikt wordt de budgetkolom van de rekeningentabel
automatisch uitgeschakeld.
In dit geval kunt u een gedetailleerd budget opstellen, rekening houdend met de mogelijke
veranderingen in het jaar en in verschillende perioden van het jaar.

Raadpleeg voor meer details de pagina Budget.
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Karakteristieken van de vreemde valuta
boekhouding

Dankzij Banana boekhouding in vreemde valuta kunt eenvoudig internationaal werken, in de taal die
u wenst en met de vreemde valuta rekeningen die u nodig heeft. Ook hier is de structuur die van
spreadsheets, gelijkwaardig aan Excel en met alle hulpmiddelen van de andere Banana applicaties.
De functies zijn gebaseerd op de methode van het dubbel boekhouden. Als u ooit BTW beheer nodig
heeft dan kunt u de BTW functies op elk moment activeren.

Banana boekhouding in vreemde valuta is bijzonder interessant voor degenen die in het buitenland
actief zijn, voor verenigingen die over het algemeen over de hele wereld actief zijn of projecten
uitvoeren en gewoon voor degenen die in hun boekhouding rekeningen in vreemde valuta nodig
hebben.

De talrijke functies van Banana Boekhouding vreemde
valuta

Beheer zoveel rekeningen als u wilt in vreemde valuta
U heeft geen aparte boekhoudingen nodig voor rekeningen in andere munteenheden. In
hetzelfde rekeningschema dat u voor uw boekhouding gebruikt voert u de rekeningen in
vreemde valuta in, zet u de wisselkoers in de wisselkoerstabel voor wisselkoersverschillen en u
bent klaar om boekingen te gaan doen.
U kunt elke munteenheid instellen, standaard of naar eigen inzicht gedefinieerd (voor gebruik
als digitale valuta).
Decimalen voor valuta kunnen worden ingesteld van 0 tot 28. In het algemeen worden 2
decimalen gebruikt maar de boekhouding kan worden ingesteld op 0 decimalen of 3 (Tunesië)
of op meer als deze wordt gebruikt voor cryptovaluta 9 voor Bitcoin of 18 voor Ethereum.
Dezelfde methode als bij dubbel boekhouden
U werkt met dezelfde dubbel boekhouden methode, boekt debet en credit en heeft alle
overzichten en details van een professionele boekhouding.
Automatische wisselkoersberekening
Op het moment dat u een vreemde valuta rekening aanmaakt hoeft u niet het equivalent in
vreemde valuta handmatig te berekenen, het programma berekent automatisch de wisselkoers.
U kunt de wisselkoers invoeren door de wisselkoers bij te werken in de wisselkoerstabel of
direct in de transactietabel in de kolom Wisselkoers.
Transacties in andere munteenheden
U kunt alle noodzakelijke transacties in vreemde valuta invoeren, inclusief overschrijvingen en
transacties die in basis valuta zijn. Hiermee kunt u ingewikkelde bewerkingen uitvoeren in uw
boekhouding.
Volledige overzichten met balans en resultatenrekening
Rekeningen met zowel de saldi in vreemde valuta als de overeenkomstige waarde in basis
valuta (nationale munteenheid) worden weergegeven in de balans en de resultatenrekening.
Als u buitenlandse zakenrelaties heeft en u moet de balans en resultatenrekening in een
tweede valuta presenteren kan dit zonder aparte overzichten in Excel te maken. Ga gewoon
naar de rekeningentabel, kies de Valuta2 weergave en u krijgt de weergave van alle
rekeningen in zowel tweede als basis valuta.
Rekeningkaarten met bedragen in vreemde en basis valuta
De rekeningkaarten kunnen worden weergegeven met de bedragen in basis en vreemde valuta.
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Hiermee kunt u de saldi in beide munteenheden evalueren.
Vrije wisselkoersen en de wisselkoerstabel
U kunt de wisselkoersen instellen voor verschillende toepassingen: variabele wisselkoersen,
vaste wisselkoersen, verschillende wisselkoersen voor dezelfde valuta, bijvoorbeeld om
investeringen te beheren en zonder rekeningen met dezelfde valuta te beïnvloeden.
Automatische wisselkoersverschillen
Wanneer u de wisselkoersverschillen moet berekenen werkt u de wisselkoers in de
wisselkoerstabel bij en gebruikt u het bijbehorende commando; de verschillen worden
automatisch in de transactietabel ingevoerd.
Budgetteren kan ook in vreemde valuta
In het vreemde valuta boekhouding bestand kunt u ook de liquiditeit van de rekeningen in een
vreemde munteenheid budgetteren, evenals het maken van prognoses van de balans en de
resultatenrekening. U kunt budgets en prognose overzichten afdrukken of deze combineren met
de kolommen van het budget, balans en bijbehorende variaties.
Automatische controle op niet geboekte wisselkoersverschillen
Door het Boekhouding controleren commando te gebruiken heeft u niet langer niet geboekte
wisselkoersverschillen omdat deze gerapporteerd worden als ze bestaan. Deze functie is vooral
belangrijk om wisselkoers verschillen in de beginsaldi te voorkomen bij het aanmaken van een
nieuw jaar.
Financiële overzichten, jaarrekeningen en rapporten, ook in een tweede valuta.

Vreemde valuta boekhouding, gebaseerd op het dubbel boekhouden heeft vele andere
karakteristieken identiek aan die van het dubbel boekhouden, die u kunt vinden op de volgende
pagina:

Karakteristieken van Banana Dubbel boekhouden.
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Theoretische achtergrond vreemde valuta

In dit deel worden de theoretische basisbegrippen over vreemde valuta uitgelegd.
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Wisselkoersen en boekhoudproblemen

Every nation has its own currency and to obtain another currency it is necessary to buy it using the
appropriate exchange. The price of a currency compared to another is called the exchange rate. To
change money means to convert the amounts of one currency to another. The exchange (exchange
rate) varies constantly and indicates the rate of conversion.

For example, on January 1st

1 Euro (EUR) was equal to 1.32030 US Dollar (USD)
1 US Dollar was equal to 0.7580 Euro
1 EUR was equal to 1.60970 Swiss Franc (CHF)
1 EUR was equal to 157.2030 Japanese Yen (JPY)

Multi-currency Accounting One talks about multi-currency accounting or multi-value accounting when
accounts in different currencies are kept. It is necessary to have multi-currency accounting when a
company has bank, cash, and debtors’ accounts in more than one currency. Even if just one account
is in a foreign currency it is necessary to administer a multi-currency accounting.

Basic Currency

The amounts referring to different currencies cannot be totaled directly. It is necessary to have a
basic currency to refer to and to use for the totals. The main point of accounting is that the totals of
the “Debit” balances must correspond to the totals of the “Credit” balances. To verify that the
accounting is balanced, there must be a single currency with which to do the totals. If there are
different currencies, the basic currency must be indicated before anything else. Once the basic
currency has been chosen and some operations have been executed, the basic currency can no
longer be changed. To change the basic currency, the accounting must be closed and another opened
with a different basic currency. The basic currency is also used to establish the Balance Sheet and to
calculate the profit or loss of theoperation.

Each amount has its equivalent in basic currency

To be able to add the totals and verify that the operations balance, it is necessary to have the
equivalent in basic currency for every transaction. In this way you can check that the total of the
Debit entries is the same as the total of the Credit ones. If the basic currency is Euros and there are
transactions in US Dollars, there needs to be an exchange value in Euros for every transaction in US
Dollars. All the Euro amounts will be totaled to verify that the accounting balances.

Account currency

Each account has its own currency symbol which indicates in which currency the account will be
administered. You must therefore indicate what the currency of the account will be. Each account will
then have its own balance expressed in its own currency. Only entries in this currency will be
permitted on this account. If the account is in Euro, then there can only be Euro entries on this
account; if the account is in USD, then there can only be entries in the specified USD currency on this
account. When you have to administer entries in YEN, then you have to have an account whose
symbol is the YEN.
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Account Balance in basic curency

For each account, alongside the balance in the account’s own currency, the balance in basic currency
will also be kept, in order to calculate the balance sheet in basic currency.
The account card for the USD bank account has to correspond exactly to the bank statement as far as
the USD amounts are concerned.
The value in basic currency will always be specified for each accounting entry. If the account is in
USD, in the entries there will be, beyond the amounts in USD, also its value in EUR. The EUR balance
will be given by the sum of all the entries expressed in EUR. The actual balance in basic currency will
depend on the exchange rate factors used to calculate the exchange value of each, single entry to
EUR.
If on a given day you take the actual balance in USD and convert it to EUR at the daily exchange rate,
you will get an exchange value that differs from the balance of the account in basic currency. This
difference is due to the fact that the exchange rate used for entries on a daily basis is different from
the actual daily exchange rate.
Thus there is a difference between the actual value at the daily exchange rate and the accounting
balance in basic currency. This accounting difference is called the exchange rate difference.
The difference between the balance in basic currency and the calculated value has to be registered,
when the accounting is closed, as an exchange rate profit or loss.

Balances in another currency (currency2)

All the accounting reports will be calculated in basic currency. If you take the basic currency values
and change them to another currency, you will get the balance in another currency. The program has
a Currency2 column where all the values are automatically entered and presented in the currency
specified as Currency2. The logic for the conversion of the amounts is the following:

If Currency2 is the same as the account or operation currency, then the original value will be
used.
If the account is in USD and Currency2 is USD, the USD amount will be used.
In all other cases the basic currency amount will be used and changed into Currency2.
The daily exchange rate is used. Even for past entries, the exchange value in Currency2 will be
expressed on the basis of the most recent exchange rate, and not on the historical one used on
the day of the entry.

You need to pay attention to the fact that a balance converted to another currency will show small
differences in the totals. Often the converted value of a total is not equal to the sum of split exchange
values, as can be seen from the following example:

 Moneta base EURMoneta 2 USD
   
Cash 1.08 1.42
Bank 1.08 1.42
Total Assets 2.16 2.84
   
Personal capital2.16 2.85
Total Liabilities 2.16 2.85

In the basic currency, total assets are equal to total liabilities. It is permitted to present a Balance
Sheet that contains differences only if they are understandable and if it is indicated that they were
due to calculations from another currency.

Accounts table, Currency 2 view
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Valuta's omrekenen

Variabilità dei cambi
La compravendita di monete avviene su un mercato libero. Il prezzo (tasso di cambio) viene fissato in
base alle regole della domanda e dell'offerta. Le differenze nel controvalore possono essere più o
meno importanti a seconda delle fluttuazioni del tasso di cambio.

Data Cambio EUR/USDControvalore EUR
di USD 1000.00 Modifica controvalore rispetto al 01-01

01-011.32030 1'320.03
31-031.33350 1'333.50 13.47
30-061.34750 1'347.50 27.47
30-091.42720 1'427.20 107.17

Il cambio
ll cambio è riferito alla moneta base. Ci sono sempre due diversi valori di cambio fra due monete, a
seconda della moneta che viene usata come moneta base.

Per le monete USD ed Euro ci sono quindi due diversi cambi:

Se la base di cambio è EUR allora il cambio è 1.32030
1 Euro (EUR) corrispondeva a 1.32030 US Dollar (USD)
Se la base di cambio è USD allora il cambio è 0.75800
1 US Dollar corrispondeva a 0.75800 Euro

Nel presente documento si userà di regola l'Euro come moneta base, a cui verranno rapportate le
altre monete.

Cambio inverso
Avendo il cambio EUR/USD di 1.32030, si trova il cambio USD/EUR dividendo 1 per il tasso di cambio.

Cambio Cambio inverso
1/cambio Cambio inverso arrotondato a 6 cifre

EUR/USD 1.320300.75800 0.758000

I controvalori calcolati con un cambio inverso possono risultare diversi da quelli originali a causa degli
arrotondamenti.

Cambio Cambio inversoControvalore 10000
cambio originale

Controvalore 10000
cambio inverso Differenza

EUR/USD 1.320300.75800 13'203.00 13'192.61 10.39

Bisogna evitare di usare cambi inversi per non avere differenze.
Per esempio per il passaggio all’Euro è stato vietato l'uso di cambi inversi .

Moltiplicatore
Vi sono delle monete che hanno cambi molto ampi.
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Sempre al 1 gennaio

1 US Dollar = 670,800 Turkish Lira
1 Turkish Lira (TRL) = 0.00000149 US Dollar (USD)

Invece di usare tanti zeri si può dire che

1000 Turkish Lira (TRL) = 0.00149 US Dollar (USD)

Il moltiplicatore è in questo caso 1000 invece di 1.

Precisione
Di regola si specifica un cambio con una precisione di almeno 6 cifre dopo la virgola.
Ci sono però casi dove è necessario usare una precisione maggiore

1 Turkish Lira (TRL) = 0.00000149 US Dollar (USD)

Quando si cambia la precisione e si arrotonda il cambio in maniera diversa, cambiano anche gli
importi. La precisione con cui si specifica il cambio è molto importante.

Taglio minimo
Specialmente per le banconote si usano tagli minimi. Per i Franchi Svizzeri si usa di regola come taglio
minimo cinque centesimi (0.05). Quando si effettuano dei cambi, per esempio EUR/CHF:

1 EUR = 1.60970 Franco Svizzero

EUR Cambio Controvalore
effettivo in CHFArrotondamento a taglio minimo CHFDifferenzaCambio effettivo

10.001.6097016.09 16.10 0.01 1.61

Calcolo dei cambi e dei controvalori
Quando l'Euro è la moneta base

Fattore di cambio EUR/USD è 1.32030
1 Euro (EUR) corrisponde 1.32030 US Dollar (USD).

Calcolo del controvalore:
Si moltiplica l'importo in moneta base per il fattore di cambio:

EUR 100 per 1.32030 = USD 132.03

Calcolare l'importo in moneta base:

Si divide la moneta di destinazione per il cambio:

USD 132.03 diviso 1.32030 = EUR 100

Calcolare il fattore di cambio:

Si divide l'importo in moneta base per l'importo moneta destinazione:

EUR 100 diviso USD 132.03 = 0.7574
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Cambio di acquisto e di vendita
Le banche effettuano la compravendita di monete e mantengono un margine di guadagno. Applicano
dei tassi di cambio diversi a dipendenza se acquistano o vendono una determinata valuta.

Vendita: la banca riceve moneta locale e dà (vende) moneta estera.

Acquisto: la banca riceve (acquista) moneta estera e dà moneta locale.

Cambio moneta e cambio banconote (Aggio)
Cambio moneta: cambio per movimenti scritturali (da un conto all'altro).
Cambio banconote: cambio per banconote.
Aggio: commissione per convertire un importo scritturale in contanti.

Per il cambio moneta, le banche mantengono un margine minore (differenza acquisto/vendita)
rispetto a quello delle banconote. Quando si desidera trasformare un valore scritturale (avere su un
conto) in moneta contante, la banca applica una commissione detta aggio.

Differenze ricambiando in moneta base
Quando si cambia un importo in un'altra moneta ci si aspetta che cambiando all'inverso si ottiene il
medesimo importo di partenza.

Importo baseCambio ControvaloreRitorno
100.00 1.32030132.03 100.00

Non sempre cambiando il controvalore si ottiene il medesimo importo. A causa degli arrotondamenti
ci possono essere casi dove non si può avere il medesimo valore di ritorno.

Importo base EURCambio Controvalore USDRitorno EURDifferenza EUR
328.67 1.32030433.94 328.66
328.68 1.32030433.95 328.67 0.01
328.69 1.32030433.96 328.68 0.01

Differenze totali scomposizioni
Non sempre il totale del controvalore delle componenti di un importo, dà il medesimo controvalore
dell'importo complessivo.
In questo esempio, l'importo di 2.16 EUR dà un controvalore in USD di 2.85. Scomponendo l'importo e
sommando i due controvalori si ottiene 2.84.

Importo EURCambio Controvalore USD
2.16 1.320302.85
1.08 1.320301.42
1.08 1.320301.42
Totale 2.16 2.84
Differenza 0.01

Queste differenze matematiche non possono essere eliminate se non registrandole appropriatamente.
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Herwaarderingen en wisselkoersverschillen

Exchange rates vary all the time and therefore also the exchange value to basic currency varies.
Between one period and another, there will inevitably be exchange rate differences.

Exchange rate differences are not accounting errors but simple adjustments of the values made
necessary in order to keep the accounting figures in step with normal fluctuations.

As you open the accounting, the figures in the balance column are equal to those present in the
opening column. When there are entries, these will update the figures in the balance column.

The calculated balance column contains the exchange value to basic currency for the account
balance, at the daily exchange (on the exchange rate table). The difference between the balance in
basic currency and the calculated balance is the exchange rate difference.

 Currency at
opening

Exchange
value at
opening in EUR

Basic currency
balance in EUR

Calculate balance
at 30.03.200xx in
EUR

Exchange
rate
difference

Exchange rate 1.32030 1.32030 1.30150
 
Cash EUR 93.80 93.80 93.80 93.80
Bank USD100.00 75.74 75.74 76.83 1.09
Real estate EUR 1'000.00 1'000.00 1'000.00 1'000.00
Total Assets 1'169.54 1'169.54 1'170.63
Loan USD-500.00 -378.70 -378.70 -384.17 -5.47
Personal capital EUR -790.84 790.84 -790.84 -790.84
Total
Liabelities -1'169.54 -1'169.54 -1'175.01

Loss -4.38

At March 30th the EUR/USD exchange rate is different from the one at the beginning of the year. In
the above example there were no accounting entries during the three-month period. The situation,
from an accounting point of view, has not changed since the beginning of the year. Despite this the
total of the updated balance, using the rate at the end of March, is different when compared to the
beginning of the year. The credit bank balance and the loan in USD have a different value in EUR.
There are therefore consequences for the accounting even though there have been no entries.

In the above example, you will notice that the Euro is now worth less against the dollar compared to
the beginning of the year. The dollar is therefore worth more against the Euro.

The exchange value of the balance on the account in USD is greater than it was at the beginning of
the year. You have a greater estate and therefore a profit on the exchange rate.

On the debit side there is a USD 500.00 loan. Now the exchange value in EUR is greater compared to
the value input at the beginning of the year. The value of the loan has increased and brings about a
loss due to the exchange rate difference.

In the following example we shall use the hypothesis that there has been the opposite development.
We imagine that the Euro has increased in value and is therefore worth more against the USD. The
exchange value in EUR of an amount in dollars is less than the one at the beginning of the year.
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Currency at
opening

Exchange value at
opening EUR

Calculate balance at
30.03.20XX Eur
(Hypothetical)

Exchange
rate differece

Cambio 1.32030 1.36150
Cash EUR 93.80 93.80 93.80
Bank USD100.00 75.74 73.44 -2.30
Real estate EUR 1'000.00 1'000.00 1'000.00
Total Assets 1’169.54 1'167.24
Loan USD-500.00 -378.70 -367.24 11.46
Personal capital EUR -790.84 -790.84 -790.84
Totale Liabelities -1’169.54 -1'158.08
Profit 9.16 9.16

As a consequence of an increase in the Euro/dollar exchange rate, you have a USD bank deposit with
an exchange value in EUR which is less than at the beginning of the year. The total worth has
diminished and there is therefore a loss.

The USD loan has a lower exchange value in EUR. A lesser liability is an advantage for the company
and there is thus an exchange rate profit.

Exchange rate profit

You have an exchange rate profit when:

The exchange value of your assets increases (increase of the investments)
The exchange value of the liabilities decreases (decrease of the loans).

Exchange rate losses

You have an exchange rate loss when:

The exchange value of your assets decreases (decrease of the investments)
The exchange value of the liabilities increases (increase of the loans).

Accounting features foe exchange rate differences
Exchange rates can evolve in different ways. Often they rise, only to fall again. The principle rule for
accounting is that the figures written on the Balance Sheet must be true ones. When you present your
Balance Sheet, the exchange values of foreign currency accounts must be made at the exchange rate
on the day of presentation.

The exchange rate difference is calculated as if you had to definitively convert the amount to basic
currency. In reality there is no definitive conversion so you are only dealing with a correction to the
accounting.

Closing exchange rate

At the end of each year it is necessary to prepare the complete Balance Sheet. The exchange rates
thus have to be updated with the closing exchange rates. It is also necessary to enter the exchange
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rate differences once and for all; if these are not entered, then there will be differences in the opening
balances.

Enter the exchange rate diferences
 

Currency
balance

Account balance
EUR

Calculate balance at
30.03.200xx EUR
(hypothetical)

Exchange rate
difference

Exchange 1.32030 1.36150
 

Bank USD100.00 75.74 73.44 -2.30
Exchange rate
difference EUR -2.30

Bank USD100.00 73.44 73.44 0.00

As can be seen from the above example, the bank balance is USD 100.00. For the accounting it has
been valued at 75.74 EUR. Today’s actual exchange, though, is only EUR 73.44. There is a difference
of EUR 2.30 EUR in basic currency. The entry must therefore decrease the EUR amount. You proceed
with a transaction that debits the bank account and credits the exchange rate loss account by EUR
2.30. As you can see, the actual bank account balance of USD 100.00 has not been altered. The entry
only alters the basic currency balance.

When entering the exchange rate difference, you need to be sure that the exchange value in basic
currency corresponds to the actual exchange value, calculated at either the daily exchange rate or
the closing one.
The figures in the account currency must not be altered. You must therefore proceed to make an
entry that only alters the basic currency balance on the specific account.

As the account on the other side you will have the exchange rate profit or loss account.
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Transacties met aankoop-wisselkoersen

Enties on account valued with the exchange rate of the time of purchase

When the positions, valued with exchange rates of the time of purchase (historical ones) are
increased or decreased, you have to calculate the exchange of the exchange rate table, taking into
account the development of the amounts being brought forward.

USD amountExchangeEUR exchange
value Total USD Total EUR Historical

Exchange
Acquisition of
shares 100'000.00 0.9416 106'202.00 100'000.00106'202.000.9416

Increase of shares 50'000.00 0.8792 56'870.00 150'000.00163'072.000.919839
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Investeringen en speciale wisselkoersen

Investments valued at the exchange rate of the time purchase

Certain investments (shares, real estate abroad) are valued using the exchange rate of the time of
purchase (historical exchange) and not the current one. The exchange rate profit and loss is not
accounted for until it is actually realized. You must therefore make certain these accounts do not get
valued using the current exchange rate.

In order to input a fixed, historical exchange, you need to create a supplementary currency on the
account table (e.g. USD1) with a fixed exchange rate. This currency will then only be used for this
account with a fixed rate. If you have to make a transfer from the USD account to the USD1 account,
you proceed exactly as if you were working with two different currencies. For this reason you will have
to use a two-line entry.

Opening with special exchange rates

Inputting the opening balances in the “opening” column, foreign currency amounts will be converted
to basic currency at the opening exchange rate.
If this system proves not to be flexible enough (you need various special rates or there are rounding
differences) the opening can be done manually by making normal entries, indicating the amounts and
the exchange rates you want for each account. In this case, the “opening” column of the Accounts
table will be left blank.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 406

Bestands- en boekhoudingseigenschappen
(vreemde valuta)

Zie ook de pagina over File Properties (Basic Data) voor informatie over de andere secties van het
dialoogvenster.

Rekening voor wisselkoerswinst
Selecteer van de rekeningenlijst de rekening voor wisselkoerswinst, aanwezig in het rekeningschema.
U kunt alleen kiezen uit rekeningen van klasse 3 en 4 die in basis valuta zijn.

Rekening voor wisselkoersverlies
Selecteer van de rekeningenlijst de rekening voor wisselkoersverlies, aanwezig in het
rekeningschema.

Valuta 2
Het is mogelijk een tweede valuta op te geven om de saldi weer te geven in een munteenheid anders
dan de basis valuta.
Het is mogelijk nieuwe valuta toe te voegen die in de lijst ontbreken door als volgt te werk te gaan:

Voer een nieuwe rij in in de wisselkoerstabel; voer in de kolom Ref.Valuta de basis valuta voor
uw boekhoudbestand in en in de kolom Valuta de door u gewenste munteenheid.
Via het menu Bestand → Bestands- en boekhoudingseigenschappen... is de toegevoegde
valuta ook zichtbaar en kan als Valuta2 gekozen worden.

Decimaal Punten
Toont het aantal cijfers achter de comma dat gebruikt moet worden bij het afronden van bedragen in
valuta2.
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Omzetten van bedragen in Valuta2
De omzetting van de bedragen in Valuta2 houdt rekening met de munteenheid van de rekening met
de volgende logica:

Als valuta2 gelijk is aan de rekeningvaluta wordt het bedrag in de rekeningvaluta gebruikt.
Anders, als valuta2 gelijk is aan de basis valuta wordt het bedrag in basis valuta gebruikt.
Anders, (als het bedrag in een andere valuta is) wordt het bedrag in basis valuta omgezet naar
valuta2 met de huidige wisselkoers die in de wisselkoerstabel is ingesteld. Historische
wisselkoersen worden dus niet gebruikt voor de omzetting.

De omzetting in valuta2 is slechts een benadering, de omzetting kan leiden tot verschillen tussen de
totalen.
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Wisselkoersen tabel

In de Wisselkoerstabel kunt u elke valuta en zijn huidige en openingskoers definiëren.

Vóór het invoeren van vreemde valuta transacties is het nodig de parameters te definiëren van de
gebruikte valuta in de Wisselkoerstabel.

Rijen met en zonder datum
Er zijn twee soorten rijen voor de wisselkoers:

Zonder datum, Referentie wisselkoersen voor het programma.1.
Deze worden gebruikt door het programma voor de meest voorkomende
omzettingsbewerkingen.
Voor iedere valuta moet er een wisselkoers rij zijn zonder datum.
De betekenis is de volgende:

Wisselkoers kolom
Dit is de wisselkoers gebruikt door het programma als huidige wisselkoers of als slotkoers.

Huidige wisselkoers.
Dit is de wisselkoers die automatisch wordt voorgesteld bij de transacties als
er geen historische wisselkoers (wisselkoers rijen met een datum) is.
Als u de wisselkoers in de wisselkoerstabel verandert worden de
wisselkoersen en de bedragen in de rijen van het journaal niet aangepast.
Dit wordt gebruikt voor de berekening van de saldo kolom in de
rekeningentabel en voor de omzetting naar Valuta 2.

Slotkoers.
Deze wordt gebruikt als een wisselkoers voor de wisselkoersafwijkingen
boekingen.
Deze wordt de openingskoers bij het aanmaken van een nieuw jaar.

Openingskoers (K.Opening) kolom
Deze wordt gebruikt in de rekeningentabel om het beginsaldo van de vreemde
valuta om te zetten naar het beginsaldo van de basis valuta van de boekhouding.
Als de beginkoers wordt veranderd moet de boekhouding opnieuw worden
berekend.

Met datum (historische wisselkoersen)2.
In de gevallen die hier worden aangegeven kiest het programma de wisselkoers met een datum
gelijk of lager dan de datum van de transactie rij.

Als er bij het invoeren van transacties een historische wisselkoers is wordt deze
voorgesteld en gebruikt als de standaard wisselkoers.
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Bij het aanmaken van wisselkoersafwijkingen en als aangegeven wordt dat historische
wisselkoersen gebruikt moeten worden.
In rijen met een datum wordt de openingskoers niet gebruikt.

Kolommen van de Wisselkoerstabel
Alle kolommen worden weergegeven in de basis weergave.

Datum

De datum voor de wisselkoers.

Zonder datum. Voor het programma gebruikte rij met referentiewisselkoersen.
Met datum. Historische wisselkoers.

Ref. Valuta

Dit is de valuta die dient als de basis voor de wisselkoers (EUR in ons voorbeeld).

Valuta

Dit is de doel valuta, degene waarin de waarde van de "Ref.Valuta" wordt omgerekend.

Tekst

Een tekst om de vreemde valuta die we gebruiken te omschrijven.

Vastgesteld

Waar of onwaar. Als er een vaste wisselkoers is voer dan in deze kolom "Ja" in. De gebruikte
wisselkoers wordt gespecificeerd in de Wisselkoers kolom.

Vermenigv. (Vermenigvuldiger)

De vermenigvuldigingsfactor is doorgaans 1, 100 of 1000 en wordt gebruikt om de effectieve
wisselkoers te krijgen. De vermenigvuldigingsfactor wordt gebruikt voor valuta die een erg lage
waarde hebben om te voorkomen dat wisselkoersen moeten worden ingevoerd met veel nullen.

In onze modellen wordt de negatieve vermenigvuldigingsfactor (-1) gebruikt in de kolom
Vermenigvuldiger van de wisselkoerstabel.
In dit geval:

Wordt in de kolom Referentie Valuta de naam van de basisvaluta van de boekhouding
ingevoerd
Wordt in de kolom Valuta de naam van de vreemde valuta ingevoerd.

Wanneer in de Referentie Valuta en Valuta kolommen de afkortingen van de valuta omgekeerd
staan, moet de Vermenigvuldiger op 1 (positieve wisselkoers) gezet worden.

Verander de vermenigvuldigingsfactor niet als er al transacties zijn in dezelfde valuta, anders
geeft het programma een foutmelding als gevolg van foute wisselkoersen.
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Wisselkoers

Deze kolom laat de actuele wisselkoers of de slotkoers voor de valuta zien, vergeleken met de
referentie valuta.
Deze kolom wordt ook gebruikt voor de berekening van het wisselkoersverschillen. Voordat de
wisselkoersverschillen berekend worden of het sluiten van de boekhouding moet deze waarde
bijgewerkt worden door de slotkoers in te voeren.

De wisselkoers en de vermenigvuldigingsfactor worden toegepast volgens de volgende formules

Met vermenigvuldigingsfactor > 0
Valuta bedrag = Ref. Valuta bedrag * (wisselkoers / |vermenigvuldigingsfactor|)
Met vermenigvuldigingsfactor < 0
Ref. Valuta bedrag = Valuta bedrag * (wisselkoers / |vermenigvuldigingsfactor|)

Openingswisselkoers

Dit is de wisselkoers op het moment dat de boekhouding gestart. Moet alleen ingevoerd worden
in een rij zonder datum.

Deze wordt gebruikt om het beginsaldo van de vreemde valuta om te rekenen naar het
beginsaldo van de basis valuta van de boekhouding.
Moet overeenkomen met de slotkoers van het voorafgaande jaar.
Wanneer de slotkoersen niet gelijk zijn aan de openingskoersen kunnen de Activa en de Passiva
verschillende totalen hebben; zie Verschillen in beginsaldi.
De openingskoers moet nooit veranderd worden in de loop van het jaar anders ontstaan er
wisselkoersverschillen in het totaal van de beginsaldi.
Wanneer een nieuw jaar wordt aangemaakt of wanneer de beginsaldi worden bijgewerkt
definieert het programma de openingskoers met de waarde aangegeven in de Wisselkoers
kolom (rij zonder datum) van de boekhouding van het vorige jaar.

Minimum

Deze kolom toont de minimum geaccepteerde wisselkoers. Als een lagere wisselkoers wordt gebruikt
tijdens de invoer wordt er een waarschuwing gegeven.

Maximum

Deze kolom toont de maximum geaccepteerde wisselkoers. Als een hogere wisselkoers wordt
gebruikt tijdens de invoer wordt er een waarschuwing gegeven.

Decimaal Punten

Deze kolom toont het aantal cijfers achter de komma dat gebruikt moet worden bij het afronden van
bedragen in valuta.

Veranderingen in de Wisselkoerstabel
De wisselkoersen ingevoerd in de transacties staan op zichzelf en zijn onafhankelijk van de
wisselkoersen die getoond worden in de Wisselkoerstabel. Als u een wisselkoers verandert in de
Wisselkoerstabel heeft dit geen gevolgen voor de transacties die al ingevoerd zijn.

Echter, de volgende veranderingen hebben wel gevolgen:
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Verandering van de Openingswisselkoers
De volgende keer dat u de boekhouding opnieuw berekent worden de saldi in de basis valuta
van de rekeningen opnieuw berekent met de nieuwe wisselkoers. Daarom, let op bij het
veranderen van de Openingskoersen nadat u de beginsaldi heeft ingevoerd.
Het is belangrijk de boekhouding opnieuw te laten berekenen wanneer u de Openingskoersen
verandert en er beginsaldi zijn.
Verandering van de vermenigvuldigingsfactor

Wanneer de vermenigvuldigingsfactor van een valuta, die al in gebruik is in de
Transactietabel, wordt veranderd geeft het programma een foutmelding zodra de
boekhouding opnieuw wordt berekent of het programma gaat op de transactierij staan.
Het transactiebedrag en het correcte bedrag in de basis valuta moeten dan opnieuw
worden ingevoerd.
Wanneer de boekhouding wordt herberekend worden als gevolg daarvan de beginsaldi in
de basisvaluta herberekend.

Directe wisselkoersen
Directe wisselkoersen zijn de wisselkoersen waar de basisvaluta en de vreemde valuta in
dezelfde rij staan.
In het voorbeeld hieronder staan directe wisselkoersen EUR > USD.

Indirecte wisselkoersen
Indirecte wisselkoersen zijn de wisselkoersen waar een directe uitwisseling tussen twee valuta niet
wordt aangegeven (niet aanbevolen).
De wisselkoers wordt door het programma afgeleid van andere combinaties van ingevoerde
wisselkoersen.
In dit voorbeeld is de EUR > USD wisselkoers niet gedefinieerd en het programma gaat uit van de EUR
> USD en USD > EUR wisselkoersen.
Het programma ondersteunt indirecte wisselkoersen. Echter, wij bevelen aan om alleen directe
wisselkoersen te gebruiken. Vermijd het gebruik van rekeningen waar de directe wisselkoers tussen
de basisvaluta en de valuta van de rekening niet gespecificeerd wordt. Met indirecte wisselkoersen is
het niet altijd duidelijk welke wisselkoers toegepast wordt.
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Historische wisselkoersen
Zoals eerder uitgelegd beschouwt het programma een wisselkoers als historisch als deze een datum
heeft. In de volgende gevallen kiest het programma de wisselkoers met een datum gelijk aan of
eerder dan de datum van de transactie rij.

Bij het invoeren van transacties, als er een historische wisselkoers is, wordt deze voorgesteld en
gebruikt als de standaard wisselkoers.
Als de wisselkoersverschillen transacties worden aangemaakt en de optie om de historische
wisselkoers te gebruiken is geactiveerd.
In rijen met een datum wordt de beginkoers niet gebruikt.

 
U kunt wisselkoersen van een ander .ac2 bestand importeren of historische wisselkoersen vanuit
Excel kopiëren bijvoorbeeld.
Als u meerdere historische wisselkoersen importeert aan het einde van uw boekhoudperiode, dus als
u al boekhoudtransacties heeft ingevoerd, verwijdert u gewoon handmatig de wisselkoerstransacties
(Wisselkoers kolom in de transactietabel) om er zeker van te zijn dat het programma de
geïmporteerde wisselkoersen gebruikt in plaats van de in de transacties ingevoerd.
 

Gemiddelde maandelijkse wisselkoers
Als het nodig is om een gemiddelde maandelijkse wisselkoers te hebben moet deze handmatig in de
wisselkoerstabel ingevoerd worden, in een rij zonder datum. In de transactietabel wordt de
gemiddelde wisselkoers altijd gebruikt totdat deze weer bijgewerkt wordt in de wisselkoerstabel.

Voor meer informatie over de maandelijkse gemiddelde wisselkoers bevelen we de pagina
valutakoersen per maand van de belastingdienst  aan.

 

https://www.belastingdienst.nl/wps/wcm/connect/nl/douane_voor_bedrijven/content/hulpmiddel-wisselkoersen
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Niet-compatibele wisselkoeren van
voorgaande versies

Als de basis valuta wordt ingevoerd als referentie valuta dan kunnen wisselkoersen met een
vermenigvuldigingsfactor groter dan 1 een verschil geven tussen het Banana Plus
boekhoudingsprogramma en eerdere versies. In deze zeldzame gevallen wordt een waarschuwing
gegeven en het bestand wordt geopend als "alleen lezen" als dit afkomstig is van een eerdere versie
van het programma.

Corrigeer de vermenigvuldigingsfactor en de wisselkoers als volgt om dezelfde bedragen te krijgen:

Open het bestand in Banana Plus en bevestig de waarschuwing;
Herbereken de boekhouding (Shift + F9);
De waarschuwing "Transactie vermenigvuldiger is niet hetzelfde als die in de Wisselkoerstabel"
kan genegeerd worden;
Controleer of de saldi en het resultaat van de boekhoudperiode verschillend zijn in vergelijking
met die van eerdere versies. Als er geen verschillen zijn sla dan het boekhoudbestand op onder
een nieuwe naam; anders is het nodig als volgt te werk te gaan;
Corrigeer de wisselkoers in de Wisselkoerstabel door deze te vermenigvuldigen met de waarde
van de vermenigvuldigingsfactor en zet de vermenigvuldigingsfactor op 1 voor de
wisselkoersen met een vermenigvuldigingsfactor groter dan 1, Bijvoorbeeld, als we een
vermenigvuldigingsfactor van 100 hebben en een wisselkoers van 0.9944608, corrigeer dan de
wisselkoers naar 99.44608 en de vermenigvuldigingsfactor naar 1;
Herbereken de boekhouding (Shift + F9);
De waarschuwingen "Transactie vermenigvuldiger is niet hetzelfde als die in de
Wisselkoerstabel" kan genegeerd worden of het is mogelijk deze te verwijderen door in de
overeenkomstige transactie rij op het bedrag in basis valuta te klikken en op F6 te drukken;
Controleer of de saldi en het resultaat van de boekhoudperiode overeenkomen met die van
eerdere versies;
Sla het bestand op met een nieuwe naam;
Vanaf nu kunt u de wisselkoersen en de vermenigvuldigingsfactor in het uw voorkeursformaat
definiëren, omgekeerd, met of zonder vermenigvuldigingsfactor, waarbij u de saldi en het
resultaat van de boekhoudperiode controleert na iedere verandering.
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Het rekeningschema met vreemde valuta

Het Rekeningschema van de vreemde valuta boekhouding is hetzelfde als dat van een boekhouding
zonder vreemde valuta, behalve voor specifieke dingen die hierna aangegeven worden.

Basis valuta
In de Bestand → Bestands- en boekhoudingseigenschappen moet de basis munteenheid worden
gedefinieerd.

Vreemde valuta
Vreemde valuta rekeningen worden gedefinieerd en de rekeningentabel. Voor iedere vreemde
valuta rekening moet het symbool van de vreemde valuta worden ingevoerd in de kolom Valuta.

In de wisselkoersen tabel moet het vreemde valuta symbool en de openingskoers worden ingevoerd
voor iedere vreemde valuta.

In het voorbeeld hieronder is de basis munteenheid de EUR die, zoals u ziet, in de kolomkoppen
getoond wordt van de kolommen met de bedragen in basis valuta.

Valutarekening
Iedere rekening heeft een valuta symbool dat hetzelfde kan zijn als de basis valuta of een valuta
symbool dat verschilt van de basis valuta zoals aangegeven in de Wisselkoers tabel.
 

Activa en passiva rekeningen, anders dan in basis valuta (EUR in het voorbeeld), kunnen ook in
andere valuta opgegeven worden.

De Lasten en Baten rekeningen, anders dan in basis valuta (EUR in het voorbeeld), kunnen ook in
andere valuta opgegeven worden.
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Uitleg van de kolommen van de vreemde valuta
boekhouding

Valuta
Voer het symbool van de rekeningvaluta in. Voor vreemde valuta boekhoudingen moet het symbool
ook aanwezig zijn in de wisselkoerstabel.

Opening valuta
Het beginsaldo wordt voor iedere rekening ingevoerd of het nu een basisrekening of een rekening in
vreemde valuta is.

Het beginsaldo in basis valuta

Een beveiligde kolom berekend door het programma.
Het beginsaldo in basisvaluta wordt berekend door het programma.
Voor rekeningen in basisvaluta wordt het beginsaldi van de kolom Opening valuta
weergegeven.
Voor rekeningen in vreemde valuta wordt het saldo van de kolom Opening valuta weergegeven
omgezet met de wisselkoers uit de wisselkoers tabel aangegeven in een rij zonder datum in de
kolom Opening.

Saldo Valuta

Beveiligde kolom gebruikt door het programma.
Het saldo wordt berekend uit het beginsaldo en de bedragen van de invoer in basis en vreemde
valuta. Voor rekeningen in vreemde valuta wordt het saldo omgezet volgens de wisselkoers uit
de wisselkoerstabel.
Voor rekeningen in vreemde valuta wordt het saldo omgezet volgens de wisselkoers in de
wisselkoerstabel.

Saldo

Beveiligde kolom gebruikt door het programma.
Het saldo wordt berekend door het programma en komt overeen met de som van het
beginsaldo (voor rekeningen in vreemde valuta is dit het saldo omgezet in basisvaluta) en de
bedragen van de transacties in basisvaluta en in vreemde valuta (bedragen omgezet volgens
een wisselkoers uit de wisselkoerstabel).

Saldo berekend
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Beveiligde kolom gebruikt door het programma.
Dit is het valuta saldo van de rekening omgerekend met de huidige wisselkoers (wisselkoers uit
de wisselkoerstabel aangegeven in een rij zonder datum).
In deze kolom kunnen de de valuta rekening saldi, omgerekend naar basis valuta, verschillen
van die in de kolom Saldo omdat er wisselkoersverschillen zijn.

Wisselkoersverschillen rekening

Zichtbaar in de weergave Andere.
In deze kolom kunt u, voor specifieke rekening/rekeningen, een rekening wisselkoerswinst en -
verlies invoeren. De aangegeven rekening wordt gebruikt door de procedure Transactie
aanmaken voor wisselkoersafwijking, en wordt gebruikt in plaats van de rekening
wisselkoerswinst en -verlies ingevoerd in de Bestands- en boekhoudingseigenschappen.
In de kolom Rekening Wisselkoersafwijking kan men aangeven:

"0;0" Dit betekent dat er voor deze rekening geen wisselkoersafwijkingen berekend
moeten worden.
Twee rekeningen gescheiden door een punt-komma, "Rekening
Wisselkoersverlies;Rekening Wisselkoerswinst", bijvoorbeeld "6949;6999"
Als er een wisselkoersverlies is wordt de eerste rekening gebruikt, gaat het om een
wisselkoerswinst dan de tweede.
"Eén enkele rekening" bijvoorbeeld "6949"
Deze rekening wordt zowel gebruikt voor een wisselkoerswinst als voor een
wisselkoersverlies.

Beginsaldi

Informatie over het invoeren van de beginsaldi in een vreemde valuta boekhouding is te vinden op de
pagina Beginsaldi in de vreemde valuta boekhouding.

Wisselkoerswinst- en wisselkoersverlies rekeningen
In het Rekeningschema moet men de standaard rekeningen invoeren voor de wisselkoerswinst of het
wisselkoersverlies; deze worden aangegeven in de Bestands- en boekhoudingseigenschappen
(vreemde valuta).

De rekeningen voor de wisselkoersverschillen moeten de BClasse 3 (Lasten) of 4 (Baten) hebben.
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Herwaarderingsrekeningen en historische wisselkoersen
Wisselkoersen variëren. De werkelijke waarde van het saldo in de rekening valuta varieert daarom
afhankelijk van de vreemde valuta variatie.

Het basis valuta bedrag van een rekening wordt berekend door de opening wisselkoers te gebruiken
en de wisselkoersen die worden aangegeven in de transacties. Omdat deze waarde overeenkomt met
de tegenwaarde van de huidige wisselkoers moet de rekening geherwaardeerd worden.

De herwaardering gebeurt door het berekenen van de wisselkoers verschillen.

Met de automatische berekening van wisselkoersverschillen voert de software een bedrag in basis
valuta in wisselkoersverschil) zodat de saldi in basis valuta overeenkomen met de tegenwaarde
(berekend saldo).

Deze afstemming wordt gedaan aan het eind van het jaar voordat de rekeningen gesloten worden of
wanneer u de balans wilt afdrukken met wisselkoers waardes die overeenkomen met de huidige
werkelijkheid. Zie het commando Transactie aanmaken voor wisselkoersafwijking.
Er zijn rekeningen (bijvoorbeeld gerelateerd aan investeringen) waarvoor een zo-genoemde historisch
wisselkoers wordt gebruikt. Met een historische wisselkoers bedoelen we een wisselkoers die niet
verandert in de loop van de tijd.
 

Er zijn twee manieren om wisselkoersen te hebben die niet veranderen:

Maak een extra valuta symbool (bijvoorbeeld EUR2) aan in de Wisselkoerstabel waarop altijd
dezelfde wisselkoers wordt toegepast.

Geef in de beschrijving van de munteenheid aan dat dit om een historische wisselkoers
gaat.
Deze valuta moet dan worden gebruikt voor de rekening met de historische wisselkoers
en uiteraard ook in de boekingen op de rekening
Maak een nieuw valuta symbool aan voor iedere rekening met een andere historische
wisselkoers.
U kunt zo veel valuta symbolen aanmaken als u nodig heeft voor de diverse rekeningen
met historische wisselkoersen.
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Verander de wisselkoers van de rekening historische wisselkoersen als er extra aan- of
verkopen zijn die een aanpassing van de waarde vereisen en maak ook een transactie
aan voor de wisselkoerswinst of -verlies.

Beginsaldi invoeren als openingstransacties.
In plaats van de kolom Openingsaldi te gebruiken worden de beginsaldi ingevoerd als
transacties. U kunt de openingskoers gebruiken die u wilt.
In de kolom Wisselkoersverschil voert u de waarde "0;0" in waarmee u aangeeft dat de
rekening niet moet worden geherwaardeerd.

Groep totalen in vreemde valuta
Doorgaans hebben de kolommen in vreemde valuta geen totalen omdat het geen zin heeft totalen te
berekenen voor waardes in verschillende valuta.

Als u een groep heeft die alleen rekeningen heeft in een specifieke valuta kan het valuta symbool
worden aangegeven op groepsniveau in de Rekeningentabel en telt het programma deze bedragen
op. Als er rekeningen zouden zijn met verschillende valuta symbolen zouden er geen bedragen
worden weergegeven (het programma zou ook geen fout melden).
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De basisvaluta veranderen in de vreemde
valuta boekhouding

In een vreemde valuta boekhouding worden alle bedragen getoond in de rekeningvaluta en in de
basisvaluta. Als u de basisvaluta verandert moeten alle wisselkoersen en bedragen in basisvaluta
handmatig opnieuw ingevoerd worden.

Het wordt aanbevolen om de basisvaluta te veranderen aan het begin van het jaar als er nog geen
boekingen zijn. Hoe dan ook, u kunt het nog steeds doen tijdens het jaar. Als u bijvoorbeeld de
basisvaluta van een bestaand boekhoudbestand wilt veranderen (bijvoorbeeld als uw
boekhoudbestand in EUR is en u wilt het in USD hebben) gaat u als volgt te werk:

Sla het bestand onder een andere naam op
In Bestandseigenschappen

Geef de nieuwe basisvaluta aan
Verwijder de verwijzing naar het bestand van vorig jaar (tabblad Opties)

Voer in de wisselkoerstabel de wisselkoersen in voor de basisvaluta aan:
Als er veel transacties zijn die geconverteerd moeten worden kunt u de gemiddelde
wisselkoersen voor iedere maand invoeren in de wisselkoerstabel waarbij u de
begindatum van de maand aangeeft. Het programma gebruikt dan de historische
wisselkoers in de transacties.

In het rekeningschema:
Vervang de oude valuta door de nieuwe
U kunt daarbij de zoeken en vervangen functie gebruiken
Als er beginsaldi zijn moet u deze opnieuw invoeren in de nieuwe valuta
Ook moeten de kolommen Saldo van vorig jaar, Budget en andere worden
geconverteerd

In de transactietabel:
Als er transacties zijn moet u deze een voor een corrigeren:

Voor transacties die al in de correcte valuta zijn herberekent het programma het bedrag
in de nieuwe basisvaluta als u de F6 functietoets gebruikt.
Voor andere transacties moet u het goede bedrag in basisvaluta invoeren en dan op F6
drukken.

In de budgettabel:
Ga op dezelfde manier te werk als in de transactietabel
Gebruik het commando boekhouding controleren van het menu Acties, los mogelijke fouten op
en blijf het commando boekhouding controleren gebruiken tot er geen foutmeldingen meer zijn.
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Transacties vreemde valuta boekhouding
Met de vreemde valuta boekhoudtoepassing is het mogelijk boekingen te doen met rekeningen in
vreemde valuta. De boekingen doet u in de transactietabel. Alle onderdelen van de transactie moeten
worden ingevoerd, ook het valuta bedrag van de rekening, de wisselkoers die van toepassing is op
deze transactie en het bedrag in basis valuta.
 

Uitleg van de kolommen
In vergelijking met de kolommen van het dubbel boekhouden zijn er de volgende extra kolommen in
de transactietabel:

Valuta bedrag
Dit is het bedrag in de valuta die gespecificeerd staat in de kolom met het valutasymbool.
Dit bedrag wordt door het programma gebruikt om het saldo in valuta van de bijbehorende
rekening bij te werken.
Valuta
Dit is het valutasymbool van de valuta van het bedrag.
Het valutasymbool moet de Basis valuta zijn, gespecificeerd in de Bestands- en
boekhoudingseigenschappen (in menu Bestand), of het valutasymbool van een bedrag
aangegeven in de kolommen Debet.Rek. of Credit.Rek.
U kunt ook een andere valuta gebruiken zolang de aangegeven Debet.Rek. en Credit.Rek.
basisvaluta rekeningen zijn.
In dit geval wordt het valuta bedrag gebruikt als een referentie maar niet voor
boekhouddoeleinden.
Wisselkoers
Wordt gebruikt om het vreemde valuta bedrag om te rekenen naar zijn Basisvaluta equivalent.
Bedrag in Basisvaluta
Het transactie bedrag, uitgedrukt in Basisvaluta.
Dit bedrag wordt door het programma gebruikt om het saldo van de bijbehorende rekening in
Basisvaluta bij te werken.
Vermenigv. (vermenigvuldigingsfactor)
Doorgaans niet zichtbaar in deze weergave. Deze waarde wordt vermenigvuldigd met de
wisselkoers.

Extra hulp vanuit het programma
Het programma herschrijft alle waardes met de hierboven uitgelegde logica, alsof er geen
waardes aanwezig waren, als u op de F6 toets drukt terwijl de u op de Valuta bedrag kolom
staat. Deze functie is handig wanneer de Debet of de Credit rekening wordt veranderd.
Als er een boeking is met een enkele rekening in basisvaluta (zie 'Samengestelde transacties' in
Transactie-soorten) en zijn waarde in de kolom Valuta is handmatig veranderd in een
valutasymbool van een vreemde munteenheid, dan is het nodig op een cel van de kolom
Valuta te gaan staan en op de F6 toets te drukken om de Wisselkoers bij te werken en het
bedrag in basisvaluta te berekenen.
Smart fill voor de Wisselkoers kolom
Het programma stelt diverse wisselkoersen voor die het uit de Wisselkoerstabel haalt of uit
de wisselkoersen die eerder gebruikt zijn in transacties.
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Soorten boekingen in de Vreemde Valuta boekhouding
Alle bedragen, zowel de bedragen in basisvaluta als die in vreemde valuta, moeten altijd worden
ingevoerd in de Valuta Bedrag kolom.

Voor informatie over de wisselkoers, vermenigvuldiger en historische wisselkoers gaat u naar de
pagina Wisselkoerstabel.

Opgelet: in de transactievoorbeelden is de basisvaluta de euro.

Voor iedere transactie zijn er twee rekeningen (debet rekening en credit rekening). In het programma
kan één vreemde valuta per transactierij worden gebruikt. Dus de volgende directe combinaties
bestaan:

Boekingen tussen twee rekeningen in basisvaluta met het bedrag in basisvaluta. (In
het plaatje, de transactie Nr. 1 in de Doc kolom)
De rekeningvaluta is de basisvaluta.
Boekingen tussen twee rekeningen in basisvaluta met het bedrag in vreemde valuta
(Doc Nr. 2)
De aangegeven rekeningen zijn in basisvaluta maar het valutasymbool en het valuta bedrag
aangegeven in de transactierij zijn niet in basisvaluta maar in een vreemde valuta.
Om de andere valuta in te voeren moet de gebruiker handmatig het valutasymbool veranderen.
Dit wordt gebruikt als men naar het buitenland gaat en geld wordt gewisseld om in lokale valuta
te betalen. In dit geval hebben we geen specifieke rekening.
Voor de berekening van het saldo (beide rekeningen in basisvaluta) wordt alleen de kolom van
de basisvaluta gebruikt.
Boekingen tussen een rekening in vreemde valuta en een rekening in basisvaluta
(Doc Nr. 3)
De valuta moet die van de rekening in vreemde valuta zijn.
Voor de berekening van het saldo van de rekening in vreemde valuta gebruikt het programma
het bedrag in vreemde valuta en voor het saldo in basisvaluta gebruikt het programma het
bedrag in basisvaluta.
Boekingen tussen twee rekeningen met dezelfde vreemde valuta (Doc Nr. 4)
De valuta moet hetzelfde zijn als de rekeningvaluta van beide rekeningen (USD1 en USD2). Om
de wisselkoers bij te werken, gaat u naar de cel Valuta en drukt u op F6.
Boekingen tussen twee rekeningen met verschillende vreemde valuta (Doc Nr. 5)
Bijvoorbeeld, de bank wisselt geld tussen twee vreemde munteenheden:
In dit geval moet de transactie geboekt worden in twee rijen.
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Het bedrag in basisvaluta moet in beide rijen hetzelfde zijn. Het is verstandig een bedrag te
gebruiken dat dicht bij de huidige wisselkoers ligt om hoge wisselkoersverschillen te
voorkomen.
Om de bedragen in basisvaluta hetzelfde te laten zijn moet het bedrag in basisvaluta
handmatig ingevoerd worden, dan berekent het programma de wisselkoers.
Wisselkoersverschillen (Doc. Nr. 6)
Het doel van deze transactie is om het saldo van de Basisvaluta in lijn te brengen met de
tegenwaarde van de Vreemde valuta rekening met de wisselkoers van vandaag.
Op de Vreemde valuta rekening wordt alleen het bedrag in Basisvaluta voor de
wisselkoersverschillen geboekt.
Deze worden automatisch aangemaakt met het commando Transactie aanmaken voor
wisselkoersafwijking... .

Voor de wisselkoerswinsten bepaalt het programma automatisch de rekening die
geherwaardeerd moet worden in debet en de wisselkoerswinst rekening in credit. De
wisselkoerswinst rekening wordt aangegeven in de Bestands- en
boekhoudingseigenschappen (Basis Data) of in de gespecificeerde rekening in de kolom
wisselkoersverschillen rekening van de weergave "Andere" (bedoeld voor een of
meerdere specifieke rekeningen).
Voor de wisselkoersverliezen bepaalt het programma automatisch de rekening die
geherwaardeerd moet worden in credit en de wisselkoersverlies rekening in debet. De
wisselkoersverlies rekening wordt aangegeven in de Bestands- en
boekhoudingseigenschappen (Basis Data) of in de gespecificeerde rekening in de kolom
wisselkoersverschillen rekening van de weergave "Andere" (bedoeld voor een of
meerdere specifieke rekeningen).
Het Valutabedrag wordt leeg gelaten
Het Valutasymbool is de basisvaluta
In de Basisvalutabedrag kolom wordt het bedrag van de herwaardering van de
rekening (winst of verlies) aangegeven.

De wisselkoers bepalen
De boekhouder is degene die bepaalt welke wisselkoers gebruikt moet worden voor iedere boeking. In
het algemeen worden de volgende regels gebruikt:

Voor normale boekingen wordt de wisselkoers van de dag gebruikt.
Voor aan- of verkopen van valuta worden de koersen gebruikt die aangegeven worden door een
wisselkantoor of een bank.
Eerst wordt het bedrag in vreemde valuta ingevoerd in het programma en daarna het bedrag in
basisvaluta. Het programma berekent de wisselkoers. De wisselkoers aangegeven door de bank
kan iets afwijken omdat banken wisselkoersen specificeren met minder cijfers achter de komma
en de bedragen vaak afronden.
Wanneer meerdere boekingen met dezelfde wisselkoers worden gedaan is het handig de
wisselkoers in de Wisselkoerstabel bij te werken zodat het programma deze automatisch kan
gebruiken.
Voor boekingen vanuit het buitenland die BTW plichtig zijn kan het zijn dat de autoriteiten een
standaard wisselkoers opleggen. In dit geval moet deze wisselkoers ingevoerd worden in de
Wisselkoers kolom van de transactie.
Voor de aankoop van vastgoed of investeringen in aandelen wordt een historische wisselkoers
gebruikt. In dit geval moet een valutasymbool worden aangemaakt in de Wisselkoerstabel
(bijvoorbeeld USD1) met een historische wisselkoers die niet onderhevig is aan
wisselkoersveranderingen.
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Men kan zoveel wisselkoerssymbolen aanmaken als nodig is voor alle historische wisselkoersen.

Transacties met BTW
De BTW rekening en de rekening waarvan de BTW wordt afgetrokken moeten in basisvaluta zijn. Het
is onmogelijk de BTWcode te gebruiken om de BTW van een vreemde valuta rekening af te trekken.
Om boekingen te doen met BTW met tegenrekeningen in vreemde valuta moeten twee
transactierijen worden gebruikt:

Eerst moet het bedrag van de aankoop worden geboekt op een interne overboekingsrekening in
basisvaluta en de bijbehorende BTW code moet worden toegepast. Het bedrag in basisvaluta
moet worden berekend door een wisselkoers te gebruiken die in overeenstemming is met de
eisen van de Belastingdienst.
In een tweede rij moet het saldo van de interne overboekingsrekening op nul gezet worden; als
tegenboeking moet de rekening in vreemde valuta worden ingevoerd.
Het bedrag van deze transactie moet exclusief BTW zijn, zowel in basis als in vreemde valuta.
Uiteraard moet de wisselkoers die gebruikt moet worden dezelfde zijn als die gebruikt is in de
voorafgaande transactie.

In het voorbeeld is de basisvaluta de EUR. De aankoop is nationaal maar betaald van een vreemde
valuta rekening (USD).

BTW en vreemde valuta transacties
Bij transacties met rekeningen in vreemde valuta is het mogelijk om de BTW te registreren met een
bruto bedrag (Bedragtype 0, inclusief BTW).
Als u netto waarden invoert (Bedragtype 1, exclusief BTW), geeft het programma een fout aan; de
berekening van de brutowaarde zou hier in veel gevallen onjuist zijn vanwege de afronding van de
BTW en de wisselkoers.
In deze gevallen is het aan te raden om de brutowaarde in te voeren. Zie ook de Uitleg van de fout .

Automatismen bij het invoeren van vreemde valuta
transacties
Wanneer een nieuwe transactie wordt ingevoerd moeten de gegevens in de bovengenoemde
kolommen compleet gemaakt worden.

Wanneer enkele bedragen van de transactie worden veranderd vult het programma de transactie aan
met de voorgedefinieerde waardes. Als deze bedragen niet voldoen aan de gebruikerseisen moeten
deze worden aangepast in de transactie.

Aanpassingen van de waardes in de Wisselkoerstabel hebben geen effect op reeds ingevoerde
transacties. Dus, als de wisselkoers in de Wisselkoerstabel wordt veranderd heeft dit geen effect op

https://www.banana.ch/doc/nl/doppiamsg_nl_wrnivabaseimponibileconimportononindivisabase
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eerder ingevoerde transacties.

Wanneer het bedrag in valuta wordt ingevoerd en er is of een Debet of een Credit rekening, en
er zijn geen andere waardes ingevoerd, dan werkt het programma als volgt:

het valutasymbool wordt opgehaald van de rekening die in gebruik is waarbij voorrang
wordt gegeven aan de rekening die niet in basisvaluta is;
de wisselkoers, gedefinieerd in de Wisselkoerstabel, wordt toegepast met de volgende
logica:

de historische wisselkoers met een datum eerder of gelijk aan de transactiedatum
wordt gebruikt
Als er geen historische wisselkoers gevonden wordt dan wordt de wisselkoers van
de rij zonder datum gebruikt.

de vermenigvuldigingsfactor gedefinieerd in de Wisselkoerstabel wordt gebruikt of het
getal 1 als dit de basisvaluta is;
het bedrag in basisvaluta wordt berekend.

Wanneer het bedrag in valuta wordt veranderd (en er zijn al andere waardes aanwezig) dan
werkt het programma als volgt:

het bedrag in basisvaluta wordt berekend met de bestaande wisselkoers.
Wanneer het valutasymbool wordt veranderd werkt het programma als volgt:

de wisselkoers wordt met de vermenigvuldigingsfactor toegepast en het bedrag in
basisvaluta wordt berekend (zoals hierboven).

Wanneer de wisselkoers wordt veranderd werkt het programma als volgt:
het bedrag in basisvaluta wordt berekend met gebruikmaking van de ingevoerde
wisselkoers.

Wanneer het bedrag in basisvaluta wordt veranderd werkt het programma als volgt:
de wisselkoers wordt herberekend.

Informatie venster
In het informatie venster geeft het programma aan:

Verschillen, als die er zijn, tussen totalen van de boekingen in Debet en Credit
Uitleg over het gebruik van de F6 toets

Voor de rekeningen die bij de transactierij horen waar men op staat geeft het programma altijd in het
informatievenster aan:

het rekeningnummer
de beschrijving van de rekening
het bedrag van de rekening in basisvaluta
het huidige rekeningsaldo in basisvaluta
het valutasymbool van de rekening
het bedrag van de transactie in de rekeningvaluta (als dit verschilt van de basisvaluta)
het huidige rekeningsaldo in valuta (als dit verschilt van de basisvaluta)

Beginsaldi
Voor de boekhouding met vreemde valuta rekent het programma bij het invoeren van de
openingssaldi in de Rekeningentabel de bedragen om in de basisvaluta aan de hand van de
openingskoers zoals gedefinieerd in de Wisselkoerstabel, kolom K.Opening.
Om historische wisselkoersen als openingsbalans te gebruiken, kunt u een ander valutasymbool



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 425

aanmaken of transacties aanmaken in de Transactietabel met de openingssaldi. Op deze manier kunt
u verschillende wisselkoersen gebruiken voor verschillende rekeningen.

Voer één enkele transactie in voor elke rekening met een openingssaldo (activa en passiva),
met vermelding van de aanvangsdatum van de boekhouding en de debet- of
creditrekening.
Voer in de kolom DocType de waarde "01" in om aan te geven dat het een openingswaarde is.

In de Banana rapporten of afdrukken wordt dit bedrag als openingsbalans weergegeven.
De transactie actualiseert echter niet de kolom Openingsaldo in de Rekeningentabel.

Bij het gebruik van openingstransacties, houd er rekening mee dat:

Om herwaardering van de rekeningen met de lopende wisselkoers te vermijden, dient in de
rekeningentabel "0,0" in de kolom "Rekening Wisselkoersafwijking" te worden vermeld.
Met de software kunt u zowel enige openingssaldi in de rekeningentabel als enige
openingstransacties in de transactietabel (activa en passiva) toevoegen.
Beide bedragen worden in de berekeningen meegenomen en als het dezelfde rekening is,
worden ze bij elkaar opgeteld.
We raden niet aan om de twee methodes tegelijkertijd te gebruiken om moeilijk te vinden
fouten en verschillen te vermijden.
Openingstransacties moeten handmatig worden ingevoerd.
Eventuele debet- en creditverschillen worden weergegeven als een transactieverschil.

Gegevensoverdracht van eerdere versies
In versie 4 of eerder werd de afwezigheid van een valutasymbool in de Transactietabel
geïnterpreteerd als een transactie in basisvaluta.
In versie 7 of 8 moet iedere transactie zijn eigen valutasymbool hebben. Daarom moeten de
transacties zonder valutasymbool in het boekhoudbestand worden gecompleteerd wanneer u
overgaat van versie 4 naar versie 7 of 8. Om dit te doen, moet een nieuwe kolom Valuta worden
toegevoegd aan de Transactietabel door het commando Kolommen instellen uit te voeren vanuit
het menu Gegevens.
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Wisselkoersafwijkingen

Transacties aanmaken voor wisselkoersverschillen
Zie voor de theorie pagina Herwaarderingen en wisselkoersverschillen (Engelstalig) .

De wisselkoersverschillen transacties zijn voor het in evenwicht brengen van het saldo van de
vreemde valuta rekening met het saldo dat berekend is in basisvaluta. In essentie is het een
kwestie van aanpassing van de bedragen in de basisvaluta rekening houdend met
wisselkoersverlies of -winst als gevolg van variatie in de wisselkoersen.
Als deze wisselkoersverschillen niet worden geboekt kunnen er verschillen in de beginsaldi van
het volgende jaar ontstaan.
De wisselkoersverschillen kunnen worden berekend aan het eind van de jaarafsluiting of
gedurende de boekhoudperiode (bijvoorbeeld aan het eind van een kwartaal). In dit geval
kunnen de historische wisselkoersen nuttig zijn omdat u daarmee verschillende wisselkoersen
kunt hebben op specifieke data.
Het programma berekent het wisselkoersverschil op basis van de saldi op de gespecificeerde
datum. Het is daardoor mogelijk het wisselkoersverschil te berekenen op een specifieke datum,
zelfs als u boekingen na die datum gedaan heeft.
Zie voor meer uitleg de pagina Wisselkoersafwijkingen niet geboekt .
Wisselkoersverschillen worden niet berekent op de rekeningen die tot de winst en
verliesrekening behoren.
Wisselkoerswinsten/-verliezen, die voortvloeien uit wisselkoersverschillen, zijn financiële en
geen exploitatieposten en worden derhalve niet opgenomen in de bepaling van het
bedrijfsresultaat of de winst- en verliesrekening.

Dialoogvenster Transactie aanmaken voor
wisselkoersafwijking...
Het commando Transactie aanmaken voor wisselkoersafwijking... van het menu Acties
berekent de herwaarderingen voor vreemde valuta rekeningen.

Datum van de transacties voor de wisselkoersafwijkingen

Het programma is in staat het wisselkoersverschil te berekenen op een datum zelfs als er boekingen
na die datum zijn.

https://www.banana.ch/doc/nl/contamsg_nl_controlloconta_avvisa_diffcambi
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Voer de datum in die uw wisselkoersafwijkingen transacties moeten hebben.
Het programma stelt de einddatum van de maand voor waarin de laatste transactie is
ingevoerd.
Als er transacties zijn voor wisselkoersafwijkingen met dezelfde datum vraagt het
programma of deze vervangen moeten worden. Het programma beschouwt de transacties
voor wisselkoersafwijkingen als bestaand als deze dezelfde datum, doc, beschrijving,
rekenigen en valuta hebben en als er geen bedrag staat in de rekening valuta.

Documentnummer

Voer het documentnummer in dat uw wisselkoersafwijking transacties moeten hebben.

Historische wisselkoersen gebruiken (wisselkoers rijen met datum)

Gebruik als deze optie niet geactiveerd is
Als er in uw wisselkoerstabel geen historische wisselkoersen (wisselkoersen met een
datum) zijn is deze optie niet geactiveerd.
Het programma gebruikt de wisselkoers van de rijen zonder datum in uw
wisselkoerstabel.
Als u historische wisselkoersen gebruikt voor de jaarafsluiting moet u erop letten dat de
gebruikte wisselkoers dezelfde is als de huidige.

Gebruik als deze optie geactiveerd is
Het programma geeft de datum van de wisselkoers, gevonden in de wisselkoerstabel, die
gebruikt wordt om het wisselkoersverschil te berekenen.
Dit wordt de wisselkoers met een datum gelijk aan of eerder dan de aangegeven datum.
We raden aan deze optie niet te activeren bij het berekenen van wisselkoersverschillen bij
de jaarafsluiting.
Bij het boeken van wisselkoersverschillen bij de jaarafsluiting moet de historische
wisselkoers hetzelfde zijn als de huidige wisselkoers, anders krijgt u een foutmelding dat
de wisselkoersverschillen niet bere

Waardes die gebruikt worden om de transacties aan te
maken
Voor meer informatie verwijzen we naar onze pagina Vreemde valuta transacties.

Bedrag van de transactie

Transacties voor de wisselkoersafwijkingen worden alleen aangemaakt voor de rekeningen in
vreemde valuta die een afwijkend saldo hebben in basisvaluta vergeleken met het berekende
saldo op een specifieke datum.
Voor het bedrag in basisvaluta wordt het verschil tussen rekeningsaldo in basisvaluta en het
rekeningsaldo in vreemde valuta, omgerekend naar basisvaluta, gebruikt.

Rekeningsaldo

Voor de berekening van de wisselkoersafwijkingen worden de saldi in de rekeningvaluta en in
basisvaluta, op de gespecificeerde datum, gebruikt.

Wisselkoerswinst en wisselkoersverlies rekeningen

Als wisselkoerswinst en -verlies rekeningen worden gebruikt, in de volgende volgorde:
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De rekeningen ingevoerd in de specifieke kolom van het rekeningschema met vreemde valuta.1.
De wisselkoers winst & verlies rekeningen aangegeven in de Bestands- en2.
boekhoudingseigenschappen.

Positie van de ingevoerde rijen

Wanneer u zich in de Transactietabel bevindt terwijl u dit commando uitvoert worden de rijen
ingevoegd op de positie van de cursor.
Anders worden ze ingevoegd aan het eind van de transactietabel of op de positie van bestaande
transacties in het geval dat ze deze vervangen.

Voordat u het commando gebruikt
Zorg ervoor dat de Wisselkoers winst en verlies rekening worden aangegeven via Bestands-1.
en boekhoudingseigenschappen... van het menu Bestand, sectie Vreemde Valuta. Het is
ook mogelijk dezelfde rekening voor zowel wisselkoers winsten als wisselkoers verliezen aan te
geven.
Zorg ervoor dat de rekeningen in vreemde valuta worden bijgewerkt en dat de saldi in vreemde2.
valuta van deze rekeningen (bijvoorbeeld bankrekeningen) overeenkomen met de saldi
aangegeven door de bank.
Werk de huidige wisselkoersen van de Wisselkoerstabel bij.3.
U moet de slotkoersen of die van een periode-einde aangeven in de rijen zonder een datum
in de Wisselkoers kolom (verander niet de begin wisselkoers in de K.Opening kolom). Om de
Wisselkoersafwijkingen te berekenen gebruikt het programma de wisselkoersen van de rijen
zonder een datum. Als deze laatste er niet zijn geeft het programma een foutmelding.

Wisselkoersen voor het Nieuwe Jaar
Om de Beginsaldi van het Nieuwe Jaar in basisvaluta exact te laten overeenkomen met de Eindsaldi
van het voorafgaande jaar moeten de Openingskoersen van het Nieuwe Jaar, aangegeven in de
Wisselkoerstabel, hetzelfde zijn als die worden gebruikt voor het afsluiten van de boekhouding, dus:

De slotkoersen moeten worden aangegeven in de Wisselkoers kolom van de rijen zonder een
datum;
De openingskoersen moeten worden aangegeven in de K.Opening kolommen van de rijen
zonder een datum.

De procedure om een nieuw jaar aan te maken of om de beginsaldi bij te werken kopieert de
sluitingssaldi (Wisselkoers kolom, rijen zonder een datum) van het vorige jaar in de openingskoersen
(Wisselkoerstabel, K.Opening kolom, rijen zonder een datum) van het bestand van het nieuwe jaar.
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Wisselkoersverschillen bij kostenplaatsen
Het commando Transacties aanmaken voor wisselkoersverschillen... neemt geen
wisselkoersverschillen mee die aanwezig zijn in kostenplaatsen in valuta anders dan de valuta van de
boekhouding. Deze verschillen moeten handmatig worden geboekt aan het eind van het jaar. De
transacties moeten alleen het bedrag in de valuta van de boekhouding weergeven; geef dit bedrag
eerst aan, en daarna de betrokken kostenplaats en zijn valuta. Als de valuta wordt ingevoerd wordt
het bedrag in de valuta van de boekhouding verwijderd en moet dan opnieuw worden ingevoerd.
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Budget

In de budgettabel wordt de financiële planning ingevoerd. Het invoeren van de transacties gaat op
dezelfde manier als in de transactietabel
Afhankelijk van het soort boekhouding kunnen er verschillende kolommen voor het budget zijn.
Er zijn ook kolommen voor het invoeren van hoeveelheden en prijzen en voor berekeningsformules.

Zie voor meer informatie over het budget pagina over de budgettabel.
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Beginsaldi in de vreemde valuta
boekhouding

Beginsaldi als u begint met Banana Boekhouding
Wanneer u Banana Boekhouding voor de eerste keer gebruikt moeten de beginsaldi handmatig
ingevoerd worden om een balans te kunnen maken.

Voordat u de beginsaldi gaat invoeren is het belangrijk enkele basisinstellingen te kiezen:

Wisselkoerstabel

Stel in de wisselkoerstabel de vreemde valuta en de overeenkomstige openingskoers ten
opzichte van de basis valuta in.
De openingskoers wordt alleen ingevoerd als Banana Boekhouding voor de eerste keer gebruikt
wordt en wordt automatisch bijgewerkt, in de opvolgende jaren bij het aanmaken van een
nieuw jaar met menu Acties → Nieuw jaar aanmaken, gebaseerd op de eindkoers van het
bestand van vorig jaar.
De beginkoers moet altijd worden aangegeven in een rij zonder datum en moet nooit veranderd
worden behalve bij fouten of bij speciale situaties.
De beginkoers moet gelijk zijn aan die van het vorige jaar. Zie Verschillen in beginsaldi.

Rekeningentabel

Zorg ervoor dat er een rekening in het rekeningschema aanwezig is om de
wisselkoersverschillen te boeken (Resultatenrekening) en dat deze wordt aangegeven in menu
Bestand → Bestandseigenschappen → Vreemde valuta.
De beginsaldi moeten ingevoerd worden in de weergave Basis van de rekeningentabel, in de
kolom Opening Valuta voor zowel de rekeningen in basis- als vreemde valuta.
De kolom Opening (basis valuta) is beveiligd. Het programma berekent automatisch de
wisselkoers voor de basis valuta volgens de openingskoers aangegeven in de wisselkoerstabel.
Passiva saldo's moeten worden ingevoerd met een minteken voor het bedrag.
Controleer na het invoeren van de beginsaldi van de resultatenrekening dat het totaal van de
activa gelijk is aan het totaal van de passiva, zodat de boekhouding in evenwicht is. Als er
verschillen zijn in de beginsaldi moeten deze worden nagekeken en gecorrigeerd.

Ga naar de rekeningentabel in Basis weergave, kolom Opening Valuta.1.
Voer handmatig de beginsaldi van de activa en passiva rekeningen in. Passiva saldi moeten2.
worden ingevoerd met een minteken voor het bedrag.
Controleer dat het totaal van de activa gelijk is aan het totaal van de passiva, zodat de3.
boekhouding in evenwicht is. Als er verschillen zijn in de beginsaldi moeten deze worden
nagekeken en gecorrigeerd.
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Beginsaldi van kostenplaatsen en segmenten
De kolom Opening Valuta van de rekeningentabel kan ook worden gebruikt om de beginsaldi van de
kostenplaatsen in te voeren.

Om de beginsaldi van de segmenten in te voeren moeten openingstransacties worden gebruikt. Meer
details zijn te vinden in de pagina Segmenten.

Met Banana Boekhouding beginnen gedurende het jaar
Als u met een nieuwe boekhouding begint waarbij u werk overneemt dat al is gedaan met andere
programma's zijn er twee mogelijkheden:

Begin de boekhouding vanaf het begin van het jaar door de beginsaldi van het begin van het1.
jaar in te voeren (rekeningtabel, kolom Opening Valuta) en de transacties (transactietabel) die
al eerder zijn ingevoerd met andere programma's (zie ook Gegevens importeren vanuit andere
programma's). Hierdoor heeft u alle boekhoudgegevens in één bestand.
Begin vanaf de datum dat de boekhouding wordt overgenomen:2.

Voer de beginsaldi (rekeningentabel kolom Opening Valuta) in door de bedragen van de
andere boekhouding over te nemen.
Behalve het invoeren van de beginsaldi van de activa en passiva is het ook nodig om de
beginsaldi van de uitgaven (positieve bedragen) en de inkomsten (negatieve bedragen) in
te voeren.
Het bedrijfsresultaat tot op dat moment moet worden vermeld in de rekening voor
overgedragen winst/verlies.
Als het winst is moet het beginsaldo als negatief bedrag ingevoerd worden, bij verlies als
positief bedrag.
Controleer dat de totalen van de beginsaldi nul zijn zodat het programma geen
verschillen aangeeft.
Voer de nieuwe boekingen in de transactietabel in.

Beginsaldi als openingstransacties
Beginsaldi kunnen ook worden ingevoerd als openingstransacties en de transactietabel, zowel voor
alle balansrekeningen als voor sommige rekening categorieën zoals die van de segmenten die
handmatig moeten worden geboekt in de transactietabel.

Ga voor ieder beginsaldo als volgt te werk:
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Geef de startdatum van de boekhouding aan als transactiedatum.
Voer in de kolom Type de code "01" in. (Als deze kolom niet zichtbaar is gebruikt u menu
Gegevens → Kolommen instellen om deze zichtbaar te maken).
Geef de debet of credit rekening aan en het bedrag.
Het totaal van de debet beginsaldi moet overeenkomen met die in credit.

Beginsaldi ingevoerd als transactie worden gebruikt bij het maken van overzichten. Wanneer er
beginsaldi in de kolom Opening van de rekeningentabel staan en de beginsaldi van sommige
rekeningen handmatig ingevoerd zijn in de transactietabel (bijvoorbeeld beginsaldi van segmenten)
worden deze automatisch opgeteld bij de beginsaldi die in de kolom Opening van de rekeningentabel
staan.

Het invoeren via transacties kan nuttig zijn als er andere openingskoersen nodig zijn dan die in de
wisselkoerstabel. Als u deze procedure gebruikt moet u duidelijk zijn over de boekhoudkundige en
juridische gevolgen.

Saldi van het vorige jaar
Als u een nieuwe boekhouding begint door een bestaande boekhouding over te nemen, en u wilt dat
de bedragen van het vorige jaar verschijnen op de afdrukken, is het nodig de saldi van het vorige jaar
in te voeren in de kolom Vorig jaar in de rekeningentabel in de weergave Vorige.
De vorige bedragen worden weergegeven in de afdrukken van de uitgebreide balans in de kolom
Vorig Jaar.

Voer de eindsaldi van de activa rekeningen van vorig jaar in.
Voer de eindsaldi van de passiva rekeningen van vorig jaar in (gebruik een minteken voor het
bedrag).
Voer de eindsaldi van de uitgaven van vorig jaar in.
Voer de eindsaldi van de inkomsten van vorig jaar in (gebruik een minteken voor het bedrag).

Een nieuw jaar aanmaken
Wanneer u met een nieuw jaar begint brengt het programma automatisch de beginsaldi over naar het
volgende jaar.
Zie de pagina Jaarafsluiting en nieuw jaar.
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De beginsaldi afdrukken
Om de beginsaldi af te drukken:

Om de inhoud van de tabel af te drukken gebruikt u het commando Afdrukken /
Afdrukvoorbeeld, en selecteert u de rijen van de balans.
U kunt ook de boekhouding afdrukken gebruiken en de afdruk instellen op alleen de balans en
de kolom Opening.
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Afdrukken

Alle afdrukken van de balans, winst- en verliesrekening en de verschillende boekhoudoverzichten zijn
beschikbaar via het menu Rapporten. Ieder commando heeft verschillende opties om de afdrukken
naar wens aan te passen.

De afdrukken in de vreemde valuta boekhouding hebben dezelfde functies als die van het dubbel
boekhouden, met de toevoeging van de weergave van kolommen en bedragen in vreemde valuta,
wisselkoersen en tegenwaarde in basisvaluta.

De belangrijkste beschikbare afdrukken:

Rekeningkaart
Uitgebreide balans
Uitgebreide balans op groepen
Boekhoudoverzicht
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Rekeningkaart vreemde valuta boekhouding

Kolommen en de weergaven van de rekeningkaart
In de Rekeningkaart zijn er drie groepen met kolommen met Debet en Credit bedragen en het Saldo
in basis en vreemde valuta.

Basisvaluta
Aangegeven worden het Beginsaldo, de Transacties en het Saldo in basisvaluta.
Rekening valuta
De Transacties in de Rekening valuta worden aangegeven.
Als de rekeningen in Basisvaluta zijn zijn deze waardes identiek aan die in Basisvaluta.
Valuta2
Voor iedere transactie wordt het bedrag in Valuta2 aangegeven.
De logica van het converteren van bedragen hangt af van de rekeningvaluta, zie Converteren
naar Valuta2 op pagina Bestands- en boekhoudingseigenschappen (vreemde valuta).
Het bedrag in Valuta2 is de tegenwaarde van het bedrag in Basisvaluta omgerekend naar de
actuele koers voor Valuta2.
De bedragen van de transacties op de rekeningkaart worden met de volgende logica
omgerekend:

Voor de opening- of overdrachtsrijen wordt het rekeningsaldo omgerekend.
Voor de transacties:

De debet en credit bedragen in valuta2 worden omgerekend.
Het saldo van de rekening in valuta2 wordt berekend door de omgerekende
bedragen in valuta2 op te tellen.
Het is mogelijk dat het eindsaldo van de valuta2 rekening niet gelijk is aan het saldo
van de valutarekening omgerekend naar valuta2. Zie de pagina Exchange rates
issues  (Engelstalig) voor mogelijke afrondingsverschillen.

Transactie valuta
Het is niet zichtbaar of deze niet gelijk zijn aan de rekeningvaluta of basisvaluta. Als een
rekening wordt geboekt in een valuta verschillend van de rekeningvaluta, maar gelijk aan
valuta2, zijn de bedragen in valuta2 niet de originele bedragen, maar bedragen
omgerekend van de basisvaluta.

Weergaven van de rekeningkaarten
In de rekeningkaart van de vreemde valuta boekhouding zijn verschillende weergaven waarvan iedere
bepaalde kolommen bij elkaar weergeeft. Als u van de ene naar de andere weergave gaat veranderen
de kolommen.

U kunt de volgorde van de kolommen veranderen en extra weergaven maken. Meer details over
weergaven zijn te vinden op Tabellen instellen.

Gegevens aanpassen
Het is niet mogelijk de gegevens in de rekeningkaart aan te passen, maar u kunt op het
(onderstreepte) rijnummer klikken om terug te gaan naar de betreffende rij in de oorspronkelijke

https://www.banana.ch/doc/en/accounting_issues_6
https://www.banana.ch/doc/en/accounting_issues_6
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tabel (Transacties of Budget), waar u de gegevens kunt veranderen. Meer informatie is beschikbaar
op de pagina Rekening-/Categorie kaart (paragraaf Bijwerken van de Rekeningkaart.

Informatievenster
In het onderste deel van het scherm, het Informatievenster worden de waardes van de rekeningen
betreffende de actieve transactie aangegeven:

Rekeningnummer
Beschrijving van de rekening
Bedrag van de rekening in basisvaluta
Huidige rekeningsaldo in basisvaluta
Valutasymbool van de rekening
Bedrag van de transactie in de rekeningvaluta
Huidige rekeningsaldo in valuta
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Uitgebreide Balans vreemde valuta
boekhouding

De Uitgebreide Balans wordt in de vreemde valuta boekhouding op dezelfde manier gedaan als die in
het dubbel boekhouden. Informatie is beschikbaar via de volgende link: Uitgebreide Balans.

Het verschil bestaat er uit dat de vreemde valuta rekeningen de bedragen zowel in vreemde als in
basisvaluta (het bedrag omgerekend) weergeven.
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Uitgebreide Balans op groepen vreemde
valuta

De Uitgebreide Balans op groepen wordt in de vreemde valuta boekhouding op dezelfde manier
gedaan als die in het dubbel boekhouden. Informatie is beschikbaar via de volgende link: Uitgebreide
Balans op groepen.

Het verschil bestaat er uit dat de vreemde valuta rekeningen de bedragen zowel in vreemde als in
basisvaluta (het bedrag omgerekend) rapporteren.
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Boekhoudingsoverzichten vreemde valuta

Boekhoudingsoverzichten in vreemde valuta worden op dezelfde manier gedaan als die in het dubbel
boekhouden. Informatie is beschikbaar via de volgende links: Boekhoudingsoverzicht; Bestand
Boekhoudingsoverzicht.
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Jaarafsluiting | Boekhouding met vreemde
valuta

Aan het einde van het boekjaar, vóór de overgang naar het nieuwe jaar, moet niet alleen worden
nagegaan of er geen fouten of verschillen in de boekhouding zijn, maar moet ook een reeks
afsluitende handelingen worden verricht. Deze zijn zeer belangrijk omdat zij niet alleen een juist en
volledig overzicht van de onderneming geven, maar ook fiscale gevolgen hebben.

Nieuw jaar
Met Banana Boekhouding heeft elk boekhoudjaar zijn eigen aparte bestand; technisch gezien is er
geen concept van een boekhoudkundige afsluiting:

Wanneer een nieuw jaar begint wordt een nieuw bestand aangemaakt met het Nieuw Jaar
aanmaken commando.
U kunt tegelijkertijd blijven werken aan zowel het bestand van het nieuwe jaar als het bestand
van het vorige jaar. Zodra de afsluitingen zijn voltooid, kunt u de beginsaldi van het bestand
voor het nieuwe jaar bijwerken.

Controle- en verificatieverrichtingen
Alvorens de financiële overzichten af te drukken, is het van belang de controlehandelingen uit te
voeren:

Gedetailleerde uitleg is te vinden op de pagina Jaarafsluiting in het Dubbel Boekhouden.
Het menu Acties → commando Boekhouding controleren voert een hele reeks controles uit, en
wanneer fouten of verschillen worden ontdekt, worden ze gesignaleerd.

Hieronder vindt u de belangrijkste controle- en vereffeningsoperaties:

Verschillen in beginsaldi
De beginsaldi van het lopende jaar moeten overeenstemmen met de eindsaldi van het vorige
jaar, en er moet een evenwicht zijn tussen de activa en de passiva, anders is de boekhouding
niet correct.
Verschillen in openingswisselkoersen
In de regel worden de openingskoersen aan het begin van het jaar vastgesteld. Het kan echter
voorkomen dat bepaalde verificatieprocedures zijn blijven liggen; daarom is het van belang
vóór het afsluiten van de boekhouding na te gaan of:

De wisselkoersen aan het begin van het jaar zijn dezelfde als de definitieve koersen op
31.12 van het voorgaande jaar,
De gebruikte wisselkoersen zijn die welke door de belastingdienst worden verstrekt, zoals
hieronder aangegeven.

Verschillen tussen banksaldi op bankafschriften en rekeningsaldi in de boekhouding
(functie CheckBalance)
Het is belangrijk om de overeenstemming te controleren van bank-, post-, kredietkaart- en
andere rekeningsaldi die in uw belastingaangiften moeten worden opgenomen.
Verschillen in de Transactiestabel
In het Informatie venster onderaan het scherm, mag geen verschil worden getoond. Banana
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Boekhouding Plus biedt in de Transactiestabel ook de mogelijkheid om de kolom Saldo  te
bekijken, waarmee u alle rijen kunt opsporen waar verschillen zijn ontstaan.

Boekhoudkundige afsluitingen
In een Boekhouding met vreemde valuta zijn, net als in het Dubbel boekhouden, enkele afsluitende
boekhoudtransacties noodzakelijk alvorens over te gaan naar het nieuwe jaar. Dit zijn
correctieboekingen, waardecorrecties en correcties in verband met personeelsbijdragen.

Op de pagina Jaarafsluiting in dubbel boekhouden vindt u een lijst van afsluitende boekhoudkundige
en fiscale bewerkingen.
We bespreken hierbij afsluitende boekingen voor wisselkoersverschillen.

Afsluitingswisselkoersen en niet-gerealiseerde
winsten/verliezen
Om financiële overzichten te verkrijgen, moeten rekeningen in vreemde valuta worden omgerekend
in de basisvaluta tegen de huidige of de historische wisselkoers. Wisselkoersschommelingen
resulteren in ongerealiseerde wisselkoerswinsten of -verliezen. Deze moeten worden geboekt met de
volgende opdracht uit het menu Acties:

Transacties aanmaken voor wisselkoersverschillen
Raadpleeg deze pagina voor het gehele onderwerp over het instellen van wisselkoersen
en het berekenen van ongerealiseerde winsten en verliezen.
Let erop dat de slotwisselkoersen in de Wisselkoersen tabel moeten worden
ingevoerd in rijen zonder datum. Deze wisselkoersen worden door het programma
overgenomen voor de berekening van de beginsaldi van het nieuwe jaar. Indien
wisselkoersen met datum worden ingevoerd, zullen er verschillen zijn in de beginsaldi van
het nieuwe jaar.

Na de boeking van de wisselkoersverschillen worden de saldi in basisvaluta bijgewerkt aan de hand
van de slotwisselkoersen die in de Wisselkoersen tabel (rijen zonder datum) zijn ingevoerd. In het
rekeningschema zijn de saldi in de kolom Saldo Basisvaluta gelijk aan die in de kolom Berekend Saldo.

http://www.banana.ch/doc/nl/node/9827
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Nieuw Jaar | Vreemde valuta boekhouding

Voordat u naar het nieuwe jaar overgaat, moet u ervoor zorgen dat u alle controles, verificaties en
afsluitende boekingen hebt uitgevoerd, zoals aangegeven op de volgende bladzijden

Jaarafsluiting van het Dubbel Boekhouden
Jaarafsluiting van het Boekhouden met vreemde valuta, voor alles wat met wisselkoersen te
maken heeft

Alle boekhoudkundige informatie met betrekking tot de opening van het nieuwe boekjaar is te vinden
op de pagina

Nieuw jaar aanmaken in het Dubbel Boekhouden

In wat volgt beperken we ons tot informatie over wisselkoersaangelegenheden in de Boekhouding
met vreemde valuta.

Aanmaken van een nieuwe boekhoudperiode
Bij het overschakelen naar een nieuw boekjaar, neemt het programma automatisch de openingssaldi
over naar het volgende jaar. Meer details zijn beschikbaar op de pagina Nieuw jaar aanmaken.

Ook in de Boekhouding met vreemde valuta is het mogelijk om over te schakelen naar het nieuwe
jaar, zelfs als het vorige jaar nog niet definitief is afgesloten (omdat er nog geen boekingen zijn
gedaan, de koersverschillen nog niet zijn berekend, of het bedrijfsresultaat nog niet is verdeeld).
Het is echter belangrijk dat vóór het afsluiten van het jaar de wisselkoersverschillen worden berekend
in het jaar dat gaat worden afgesloten, via het menu Acties → Transacties aanmaken voor
Wisselkoersafwijking.

Vervolgens kunt u in de nieuwe boekhoudkundige periode die eerder werd gecreëerd, de beginsaldi
bijwerken via het menu Acties → Beginsaldi bijwerken.

Verschillen in beginsaldi
Indien er verschillen zijn in de beginsaldi in de nieuwe boekhoudperiode, raden wij u aan alle
controles en verificaties uit te voeren die op de pagina Controles en verificaties worden voorgesteld.

Indien de verschillen te wijten zijn aan wisselkoersverschillen die niet in de vorige boekhoudperiode
werden berekend, volg dan de instructies op de pagina Verschillen in de beginsaldi.

Beginsaldi afdrukken
Om de beginsaldi af te drukken:

Om de inhoud van de tabel af te drukken gebruikt u het commando Afdrukken/Afdrukvoorbeeld,
waarbij u de rijen van de Balans selecteert.
Het is ook mogelijk de Boekhoudafdrukken te gebruiken en de afdruk alleen in te stellen voor
het gedeelte van de balans en de openingskolom.
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Verschillen in beginsaldi | Vreemde Valuta

Wanneer u rekeningen in vreemde valuta heeft moet u de wisselkoersverschillen boeken voordat u de
boekhouding afsluit. Het programma signaleert een verschil in de beginsaldi in het nieuwe jaar
wanneer in het vorige jaar de wisselkoersverschillen niet berekend zijn.

Er zijn twee mogelijkheden om dit probleem op te lossen:

Wanneer het vorige boekjaar nog niet is gecontroleerd en afgesloten bereken dan de
wisselkoersverschillen in het vorige jaar,

Voer in de Wisselkoerstabel in de Wisselkoers kolom de officiële wisselkoersen op 31
december in
Gebruik in het commando menu Acties → Transactie aanmaken voor wisselkoersafwijking....
Open het bestand voor het nieuwe jaar en werk de beginsaldi bij.

Wanneer het vorige jaar al afgesloten is moet u een aanpassing doen van de beginsaldi van het
nieuwe jaar:

Open het bestand van het nieuwe jaar
Voer in de Activa of de Passiva (Rekeningentabel), afhankelijk van de situatie, een nieuwe
rekening Niet geboekte Wisselkoersverschillen in of boek het bedrag op de rekening 1090
Overdrachtrekening (zoals in het volgende voorbeeld).
Voer in de Opening Valuta kolom het bedrag overeenkomend met het wisselkoersverschil in.

Op 1 januari wordt de wisselkoersverschillen rekening op nul gezet door middel van een
transactie in de transactietabel (in dit geval is het een wisselkoersverlies), door de
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aangemaakte rekening of 1090 te gebruiken, waarbij de rekening die betrekking heeft op de
wisselkoersafwijkingen (Wisselkoers winst/verlies) van de Winst & Verlies rekening als
tegenrekening gebruikt wordt.

Nadat de transactie om het wisselkoersverschil te boeken gemaakt is moet de rekening die gebruikt
is een saldo nul hebben of een saldo gelijk aan het bedrag overeenkomend met het saldo voor de
transactie.

In het geval van een wisselkoerswinst moet het bedrag van het verschil worden ingevoerd in een
passiva rekening, of in de activa maar dan met een minteken ervoor.
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Boekhouding met cryptovaluta

Met Banana Boekhouding kunt u elke munteenheid beheren, inclusief de Bitcoin, Ethereum en alle
andere cryptovaluta, zelfs bij een ICO (Initial Coin Offering), met elke muntaanduiding en de
mogelijkheid 27 decimalen te gebruiken en vrij instelbare wisselkoersen. Er worden nauwkeurige
waarde- en boekhoudoverzichten aangemaakt. In Banana Boekhouding heeft u altijd de exacte
waarde voor iedere individuele valuta. Elke munteenheid kan gekozen worden als basisvaluta. Er kan
gewerkt worden met EUR, US$, Bitcoin en elke andere valuta.

Enkele of meerdere valuta
Bij het boekhouden moet u eerst beslissen of u dat in één valuta of in meerdere valuta doet. Het
Kasboek en de Inkomsten & Uitgaven boekhouding werken met één enkele munteenheid, terwijl u
met het Dubbel boekhouden rekeningen kunt bijhouden in diverse verschillende valuta.

De basis valuta wordt gedefinieerd in Bestands- en boekhoudingeigenschappen (van het menu
Bestand). Het programma laat een lijst voorgedefinieerde valuta zien maar u kunt elke andere
valutacode aangeven.

Bij het Dubbel boekhouden worden bedragen aangegeven in rekening- en basisvaluta. Bedragen in
basisvaluta kunnen opgeteld worden en worden daarom gebruikt voor het aanmaken van de Balans,
de Winst & Verliesrekening en de verschillende overzichten.

Wanneer u kiest voor een vreemde valuta boekhouding kunnen de valuta die u nodig heeft ingesteld
worden in de Wisselkoerstabel, waarbij u de wisselkoers tussen de verschillende munteenheden
aangeeft. Land- of cryptovaluta kunnen beheerd worden zonder enige beperking en elke afkorting
voor de valuta kan gebruikt worden.

Het aantal decimalen voor de boekhouding veranderen
Om afrondingsverschillen te voorkomen wordt het aantal decimalen bepaald wanneer het
boekhoudbestand wordt gecreëerd. Zo worden alle bedragen op dezelfde manier afgerond en worden
verschillen zoals die soms in Excel optreden voorkomen.

We adviseren bij het beginnen van een nieuwe boekhouding een bestaand model te kiezen dat
gewoonlijk is ingesteld met 2 decimalen.
Als u voor uw boekhouding meer decimalen nodig heeft moet u "het bestand opnieuw aanmaken"
met het volgende commando

Menu Extra → Naar nieuw bestand converteren

Het programma maakt een kopie van uw bestand met nieuwe Parameters nieuw bestand, inclusief
het aantal benodigde decimalen. Voor een vreemde valuta boekhouding moet u aangeven:

Het aantal decimalen voor de basis valuta.
Het aantal decimalen voor de rekeningen in vreemde valuta.
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Het instellen van het aantal decimalen voor vreemde valuta
Bij het gebruik van vreemde valuta in het Dubbel Boekhouden moet de afronding aangegeven worden
voor bedragen in vreemde valuta.
Het aantal decimalen voor vreemde valuta moet in het algemeen niet kleiner zijn dan het aantal
gebruikt voor de basis valuta.
Bij het beheer van cryptovaluta, zoals de ETH, moet u 18 decimalen aangeven in het
conversiebestand.

De verschillende valuta  codes moeten aangegeven worden in de Wisselkoersen tabel met de
bijbehorende beginsaldi en huidige wisselkoersen.

De valuta code moet worden aangegeven voor iedere rekening in de Rekeningentabel van het
Rekeningschema.

In de Valuta bedrag kolom worden de bedragen dan weergegeven met het maximum aantal
decimalen, zelfs voor valuta die niet zoveel decimalen gebruiken. Als u een kleiner aantal decimalen
wilt hebben, dan kunt u in het formaat van de kolom het aantal decimalen instellen dat u wilt.
Bijvoorbeeld met "0.00000" zal slechts 6 decimalen worden weergegeven.

Valuta en decimalen
Valuta codes zijn beschikbaar en te raadplegen in een Engelse, met het aantal decimalen , en een
Nederlandse, alleen een lijst , Wikipedia pagina.

Valuta hebben meestal 2 decimalen.
Valuta met 0 decimalen zijn

BIF Burundian Franc
CLP Chilean peso
DJF Djiboutian franc
GNF Guinean franc
ISK  Icelandic króna
JPY Japanese yen
KRW South Korean won
PYG  Paraguayan guaraní
RWF Rwandan franc
UGX  Ugandan shilling
UYI  Uruguay Peso en Unidades Indexadas

https://en.wikipedia.org/wiki/ISO_4217
https://nl.wikipedia.org/wiki/ISO_4217
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VUV  Vanuatu vatu
XOF CFA franc BCEAO
XPF CFP franc (franc Pacifique)

Valuta met 3 decimalen zijn
BHD Bahraini dinar
IQD Iraqi dinar
JOD Jordanian dinar
KWD Kuwaiti dinar
LYD Libyan dinar
TND Tunisian dinar

Valuta met 4 decimalen zijn
UYW Unidad previsional

Cryptovaluta

Er is een veelheid aan cryptovaluta , ieder met een eigen naam en code.

Er is geen aanduiding voor het aantal decimalen. Voor zover bekend zijn deze

BTC Bitcoin met 9 decimalen.
ETH  Ethereum met 18 decimalen.
Diverse andere virtuele munten zijn gebaseerd op de Ethereum blockchain en hebben 18
decimalen nodig.

Geef het aantal benodigde decimalen voor de gebruikte valuta aan in het Parameters nieuw bestand
dialoogvenster (Zie de afbeelding hierboven).

https://github.com/crypti/cryptocurrencies
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Boekhouding inkomsten & uitgaven

Inkomsten en Uitgaven boekhouding is een applicatie van Banana Boekhouding Plus, om de
inkomsten en uitgaven van verschillende rekeningen te beheren. Het is gratis te gebruiken tot 70
transacties in het Free plan van Banana Boekhouding Plus. In het Professional en Advanced plan ,
is het het gebruik onbeperkt. Het kan zelfs gebruikt worden door mensen zonder boekhoudtraining.

Inkomsten en Uitgaven boekhouding is ideaal voor de boekhouding van kleine bedrijven,
verenigingen, eenmanszaken of voor ondersteunende boekhouding van projecten of onroerend goed.

▶ Video: Hoe een inkomsten en uitgaven boekhouding te beginnen  (Engelstalig)
Ontdek alle functies van inkomsten en uitgaven boekhouding

Professionele boekhouding eenvoudig in het gebruik

De inkomsten / uitgaven boekhouding is erg intuïtief en eenvoudig te gebruiken omdat de boekingen
worden ingevoerd als inkomsten en uitgaven. Deze boekhouding kan door iedereen gebruikt worden,
zelfs zonder boekhoudtraining.
Het is ideaal om administraties te beheren van kleine tot middelgrote bedrijven, verenigingen, privé
bedrijven (ZZP-ers) of als aanvullende boekhouding voor projecten of eigendommen.
De resultaten zijn echter professioneel omdat het programma technisch gezien het dubbel
boekhouden mechanisme gebruikt. Er zijn daardoor dezelfde functies beschikbaar als bij het dubbel
boekhouden zoals balans en resultatenrekening, rekeningoverzichten, BTW beheer, kostenplaatsen
en winstcentra, segmenten. Het is alleen niet mogelijk rekeningen in vreemde valuta te hebben.

Kant en klare modellen
Wilt u snel een inkomsten- en uitgavenboekhouding starten? Niets is eenvoudiger: we hebben
verschillende kant-en-klare modellen voor u. U kunt de modellen die u al heeft gedownload en
geïnstalleerd openen in Banana Boekhouding Plus.
U vindt universele modellen, dus geschikt voor elk land, landspecifieke modellen en modellen in
verschillende talen. De meest gebruikte modellen zijn:

Gezinsbegroting en huishoudboekhouding | boekhouding inkomsten & uitgaven (Universeel)
Inkomsten & Uitgaven boekhouding voor een Onderneming  (Universeel) (Engelstalig)

https://www.banana.ch/nl/buy
https://www.banana.ch/en/node/11352
http://www.banana.ch/apps/nl/node/9105
http://www.banana.ch/apps/nl/node/9105
https://www.banana.ch/apps/en/node/9623
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Overeenkomsten en verschillen met het dubbel boekhouden
Om boekhouding inkomsten en uitgaven eenvoudiger en intuïtiever te maken zijn de rekeningen
ondergebracht in twee tabellen.

Rekeningentabel - Balans:
De bezittingen worden positief weergegeven 
De schulden worden negatief weergegeven.
Het eigen vermogen wordt berekend als het verschil tussen de activa en de passiva.

Categorieëntabel - Uitgaven en Inkomsten rekeningen:
Uitgaven worden getoond als een negatief bedrag.
Inkomsten worden getoond als een positief bedrag.
Winst of verlies wordt berekend als het verschil tussen positieve en negatieve bedragen.

Bij het invoeren van de transacties moeten het binnenkomende of uitgaande bedrag, de rekening
voor de inkomsten of de uitgaven en de categorie worden aangegeven. Het bedrag wordt geboekt op
de aangegeven rekening. In de kolom Categorie kunt u een categorie of zelfs een rekening aangeven:

Als een categorie wordt aangegeven in de kolom Categorie wordt het bedrag in de categorie
opgenomen als inkomsten of uitgaven.
Als een rekening wordt aangegeven in de kolom Categorie wordt het bedrag omgekeerd
geboekt (met het teken omgekeerd). Als het uitgaand is in dit geval positief. Op deze manier
kunnen boekingen gedaan worden tussen twee balansrekeningen.
Het is echter niet mogelijk te geven en nemen tussen twee categorieën met een enkele
boeking.
U moet twee boekingen gebruiken zonder de rekening kolom te gebruiken, met in de eerste
regel de inkomsten en in de tweede regel de uitgaven.

Verzamelboekingen kunnen ook worden ingevoerd, waardoor er een boeking met meerdere
categorieën ontstaat. In dit geval worden meerdere regels gebruikt. De eerste is die van de rekening
en zonder categorie en de andere met de categorie en zonder rekening.

Direct beschikbare informatie
In de rekeningen- en categorieëntabellen worden de saldi van alle rekeningen, inkomsten en uitgaven
direct weergegeven. Na iedere boeking worden de saldi automatisch bijgewerkt en het is niet nodig
overzichten aan te maken om alles onder controle te krijgen. Kijk gewoon in de rekening- of categorie
tabellen.

Onderwerpen die hetzelfde zijn als in het Dubbel
boekhouden
Op de sub pagina's van deze documentatie vindt u gedetailleerde informatie specifiek over
inkomsten- en uitgavenboekhouding. Echter, sommige functies zijn hetzelfde als degene die
beschreven zijn voor dubbel boekhouden.
Gebruik de volgende pagina's voor extra informatie over verschillende onderwerpen.

Toevoegen / Hernoemen / Verwijderen van een rekening
Groepen invoegen
Kostenplaatsen en Winstcentra
Segmenten



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 451

Kolom Saldo

Commando's

Boekhouding controleren
Transacties blokkeren
Nieuw jaar aanmaken
Facturen aanmaken

Afdrukken

Journaal
Rekening/Categorie kaarten
Uitgebreide rekening
Uitgebreide rekening op groepen
Boekhoudingsoverzichten
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Hoe beginnen - Inkomsten & Uitgaven

De complete en professionele boekhouding die lijkt op Excel voor degenen die niet veel
boekhoudkennis hebben. U kunt altijd bewerken en krijgt foutloze resultaten.

▶ Video: How to start an Income & Expense accounting :
video die u laat zien hoe eenvoudig het is om een inkomsten & uitgaven boekhouding op te zetten, de
rekeningen- en de categorieëntabel aan te passen, een budget te maken, de transacties in te voeren
en overzichten af te drukken.

Ga als volgt te werk:

Menu Bestand, → Nieuw....1.
Selecteer het land, de taal, de categorie en het type boekhouding.2.
Uit de lijst van de Online modellen, kies het model dat het dichtst komt bij wat u nodig heeft.3.
Klik op de knop Aanmaken.4.

In het gedeelte "Zoeken" worden bij het invoeren van een sleutelwoord in het programma de
modellen weergegeven die het ingevoerde sleutelwoord bevatten.

Het is ook mogelijk om vanuit een leeg bestand te beginnen, door de optie blanco bestand
aanmaken te activeren. Om de start te vergemakkelijken en groeperingsfouten te vermijden, raden
wij u altijd aan om steeds te beginnen met een bestaand model.

Meer informatie over het aanmaken van een nieuw bestand vindt u op de pagina Nieuw bestand
aanmaken.

Bestandseigenschappen instellen
Stel uw gegevens in met het commando Bestands- en boekhoudingseigenschappen... (menu
Bestand) en sla het bestand op met een eigen naam.

https://www.banana.ch/en/node/11352


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 453

Bestand opslaan
Met het menu Bestand → Opslaan als... geeft u het bestand een naam en slaat u het op. Het voor uw
besturingssysteem gebruikelijke dialoogvenster om een bestand op te slaan verschijnt.

Het is aan te raden de naam van het bedrijf te gebruiken gevolgd door het jaartal, bijvoorbeeld
"Bedrijf_2020.ac2" om het te onderscheiden van andere boekhoudbestanden.
U kunt zoveel boekhoudbestanden aanhouden als u nodig heeft, ieder heeft zijn eigen naam.
U kunt zelf het pad en de media waarop het bestand opgeslagen wordt kiezen (schijf, usb stick
of cloud).
Als u verwacht dat u gekoppelde documenten heeft voor de boekhoudingen van dit jaar is het
handig dat u voor iedere boekhouding een aparte map aanmaakt waarin u de bestanden
groepeert.

De Rekeningentabel aanpassen
In de Rekeningentabel kunt u de vermogensrekeningen aanpassen aan uw eigen behoefte:

U kunt de rekeningnummers aanpassen
U kunt de beschrijving aanpassen
In de kolom Opening moet u de beginsaldi invoeren

Denk erom dat voor Passiva rekeningen (bijv. uitgaven) de bedragen van de beginsaldi voorafgegaan
moeten worden door het minteken (-). Deze bewerking hoeft alleen maar uitgevoerd te worden als u
Banana Boekhouding software voor het eerst gebruikt. Daarna wordt het beginsaldo automatisch
overgeheveld aan het eind van het jaar bij het aanmaken van een nieuw jaar (menu Taken,
commando Nieuw jaar aanmaken).



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 454

De Categorieëntabel aanpassen
In de Categorieëntabel voert u de baten (winst/inkomsten) en lasten (uitgaven/kosten) categorieën in
waarbij u voor iedere een code, een beschrijving en de groep waar deze bij hoort aangeeft. De
Categorienummers en -beschrijvingen kunt u aanpassen indien gewenst.
De categorieën hebben geen beginsaldo, en mogen dit ook niet krijgen, aan het begin van het jaar
om het resultaat van het boekjaar te bepalen.

Transactietabel
In de Transactietabel worden de dagelijkse inkomsten en uitgaven transacties ingevoerd waarbij de
rekening wordt aangegeven waarop de boeking gedaan wordt en de categorie waarvoor de uitgave
gedaan is of inkomsten ontvangen zijn.
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In de kolommen die van toepassing zijn:

Voer de datum in
Voer het documentnummer in dat handmatig is toegewezen aan het papieren document.
Hiermee kunt u documenten makkelijk terugvinden wanneer de boekingstransactie is
ingevoerd.
Voer een beschrijving in
Voer in de Inkomsten kolom het bedrag van de inkomsten in
Voer in de Uitgaven kolom het bedrag van de uitgaven in
Voer in de kolom Rekening het rekeningnummer in (dit moet een bestaande rekening in de
Rekeningentabel zijn, bijvoorbeeld Bank)
Voer in de kolom Categorie de inkomsten of uitgaven categorie in (dit moet een bestaande
categorie in de Categorieëntabel zijn, bijvoorbeeld Contributies)

Sneller invoeren van transacties

Om het invoeren van uw transacties te versnellen kunt u gebruiken:

de Smartfill functie die ingevoerde gegevens automatisch aanvult met gegevens die al eens
eerder ingevoerd zijn.
de Terugkerende transacties functie (menu Taken), die gebruikt wordt om terugkerende
transacties op te slaan in een aparte tabel.
het importeren van elektronische bankafschriften of transacties.

Transacties met BTW

Om transacties met BTW in te voeren gaat u als volgt te werk:

Kies van het menu Bestand het commando Nieuw en kies Inkomsten/Uitgaven boekhouding
met BTW
Kies een van de bestaande modellen  voor uw land van de Inkomsten/Uitgaven boekhouding
met BTW
Zie ook de Transacties pagina over het invoeren van transacties met BTW.

https://www.banana.ch/apps/nl
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Transacties over meerdere rijen

Transacties over meerdere rijen, of Samengestelde transacties, zijn transacties waarin meer dan twee
rekeningen betrokken zijn en inkomsten/uitgaven op meerdere rekeningen of categorieën
(bijvoorbeeld als u verschillende facturen betaald van de bankrekening). In dit geval moet u de
transactie in meerdere rijen invoeren:

In de eerste rij voert u het totale bedrag in van inkomsten of uitgaven en de rekening waar dit
bedrag vanaf gaat of bijkomt
In iedere volgende rij voert u het bedrag van de inkomsten of uitgaven in en het toepasselijke
categorienummer in de categoriekolom.
Ieder bedrag wordt apart geboekt in een verschillende rij. Als alle losse inkomsten en uitgaven
rijen zijn ingevoerd mogen er geen verschillen zijn.

De Rekeningenkaart

Met de Rekeningenkaart heeft u een complete lijst van boekingen die betrekking hebben op dezelfde
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rekening of dezelfde groep.

Om een rekeningkaart te openen klikt u eenmaal op de cel met het rekeningnummer en dan
eenmaal op het blauwe pijltje dat in de rechterbovenhoek van de cel staat.
Om meerdere rekeningkaarten tegelijk te openen moet u het commando Rekeningkaarten
van het menu Rapporten uitvoeren.
Om rekeningkaarten bij te werken, nadat er veranderingen in de Transactiestabel gemaakt zijn,
klikt u op de twee circelvormige pijlen aan de rechter bovenkant van de rekeningkaart.

De Categoriekaart

Met de Categoriekaart heeft u een complete lijst van boekingen die betrekking hebben op dezelfde
categorie.

Om een categoriekaart te openen klikt u eenmaal op de cel met het categorienummer en
dan eenmaal op het blauwe pijltje dat in de rechterbovenhoek van de cel staat.
Om meerdere categoriekaarten tegelijk te openen moet u het commando Rekeningkaarten
van het menu Rapporten uitvoeren.
Om rekeningkaarten bij te werken, nadat er veranderingen in de Transactiestabel gemaakt zijn,
klikt u op de twee circelvormige pijlen aan de rechter bovenkant van de rekeningkaart.

Rekeningkaarten per periode

Om een rekeningkaart met rekeningsaldi op bepaalde data te openen klik u op Rapporten in het
menu, Rekeningkaarten... en dan op Geselecteerde periode in de tab Periode om de door u
gekozen periode in te voeren.

Zie de pagina Periode voor meer informatie.
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De Rekeningkaarten afdrukken

Om een Rekeningkaart af te drukken, opent u deze vanuit de Rekeningen-, Categorieën- of
Transactiestabel en begint u het afdrukken vanuit het menu Bestand.

Om enkele of alle Rekeningkaarten af te drukken, klik op menu Rapporten, kies Rekeningkaarten en
kies de Rekeningen die u wilt afdrukken. Met het filter in het venster kunt u kiezen voor alle
rekeningen, kostenplaatsen, segmenten, groepen, etc.

Zie de pagina Rekeningkaarten voor meer informatie.

Uitgebreide rekening
Om de Uitgebreide Rekening en de Uitgebreide Rekening op groepen te bekijken kiest u in het menu
Rapporten het commando Uitgebreide Rekening of de Uitgebreide Rekening op groepen. U
kunt ook overzichten per periode maken.

De Uitgebreide Rekening laat alle rekeningen en categorieën zien zonder enige subgroepen
De Uitgebreide Rekening op groepen laat alle rekeningen en categorieën zien met subgroepen.

Archiveer gegevens als PDF
Aan het eind van het jaar, wanneer de boekhouding afgesloten is kunt u alle boekhoudkundige
gegevens opslaan met het commando Pdf bestand aanmaken... van het menu Bestand.
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Het Budget
Voordat u met uw boekjaar begint kunt u een budget aanmaken met uw geschatte uitgaven en
inkomsten om controle te hebben over de financiële en economische toestand van uw bedrijf.

Het budget kan op twee manieren ingesteld worden:

Met de Budget kolom van de Categorieëntabel. Voor iedere rekening wordt het jaarbudget
aangegeven.
In dit geval, als u het budget opvraagt met het commando Uitgebreide rekening op groepen
van het menu Rapporten, laat de Budget kolom de bedragen zien die betrekking hebben op
het hele jaar.
Met de Budgettabel, die u handmatig activeert met het commando Nieuwe functies
toevoegen van het menu Extra.
In deze tabel worden alle schattingen ingevoerd als budgettransacties voor inkomsten en
uitgaven. Wanneer u deze tabel activeert wordt de Budget kolom van de Rekeningentabel
automatisch gedeactiveerd.
In de Budgettabel kunt u een gedetailleerd budget instellen dat rekening houdt met mogelijke
veranderingen gedurende het jaar en in verschillende periodes van het jaar.

Zie ook: Transacties, Uitgebreide rekening.
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Karakteristieken van de Inkomsten en
Uitgaven boekhouding

Met de Inkomsten en Uitgaven boekhouding toepassing van Banana Boekhouding Plus kunt u
eenvoudig de inkomsten en uitgaven van uw bedrijf beheren, zelfs als u geen boekhoud kennis heeft.
Intuïtief en snel door gebruiksgemak en flexibiliteit.

Ideaal voor de boekhouding van kleine bedrijven, verenigingen, ZZPers of voor de aanvullende
boekhouding van projecten of vastgoed.

Zelfs als u niet het professioneel dubbel boekhouden gebruikt kunt u toch professionele afdrukken en
overzichten maken omdat het programma technisch gesproken intern het dubbel boekhouden
gebruikt. U kunt een bestand opzetten, beginnend met een van onze modellen en dit naar uw wensen
aanpassen zonder gedwongen te worden vaste schema's te gebruiken waarin geen veranderingen
gemaakt kunnen worden.

Net zoals bij dubbel boekhouden heeft u een balans en een resultatenrekening, rekeningoverzichten,
BTW beheer, kostenplaatsen en winstcentra, segmenten. Het is echter niet mogelijk een vreemde
valuta boekhouding te doen.

Gelijkwaardig aan Excel

Excel-achtige functies en commando's

Alle gegevens die u in de tabellen invoert zijn altijd zichtbaar, direct onder handbereik.
U werkt snel omdat u herhalende transacties kunt selecteren, kopiëren en plakken in meerdere
cellen en rijen.
Als u een fout maakt kunt u deze herstellen door bewerkingen te annuleren of terug te draaien.
Voeg zoveel rijen toe als u wilt zonder limiet of verwijder rijen die u niet nodig heeft.
Als u een fout maakt in een bedrag, een rekening, een BTW code of een beschrijving kunt u
deze in een oogwenk herstellen met de zoeken en vervangen functie.
U hoeft geen formules in te voeren omdat de berekeningen direct bijgewerkt worden en u een
samenhangend beeld heeft (zoals in spreadsheets).
Alles wat u ziet kan worden afgedrukt of naar PDF of andere formaten worden geëxporteerd.
U kunt uw bedrijfslogo gebruiken om uw afdrukken te personaliseren.
De kolommen zijn aan te passen, u kunt ze verplaatsen, nieuwe toevoegen en de breedte
instellen.
Werk met het formaat dat het best bij u past.
Geef regels een kleur om ze na te kijken, aan uw accountant te laten zien of om ze later
kompleet te maken.

Op tabellen gebaseerde structuur

Het boekhouden gebeurt in twee tabellen die op dezelfde manier gebruikt worden als in Excel
spreadsheets maar die al helemaal ingesteld zijn en geprogrammeerd met alles wat u voor een snelle
en veilige boekhouding nodig heeft.

Rekeningen tabel.
U kunt alle contanten, klanten, leveranciers, etc. rekeningen instellen en de beginsaldi invoeren
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zonder deze handmatig te hoeven boeken in de transactietabel. U kunt meerdere rekeningen
groeperen, zoals de contanten en de bank in de liquiditeitsgroep, zodat u bijgewerkte saldi
meteen kunt controleren.
Categorieëntabel.
In deze tabel stelt u alle categorieën voor inkomsten en uitgaven in en daardoor weet u alle
details van iedere uitgave en alle ontvangsten en u bent in staat te evalueren waar u het
meeste aan besteedde of wat het meeste winst opleverde. Net zoals in de rekeningentabel ziet
u meteen alle bijgewerkte saldi en de kolommen van de binnenkomende en uitgaande
mutaties. U weet meteen hoeveel u heeft uitgegeven, hoeveel u heeft ontvangen en wat u
verdiensten zijn.
Transactietabel.
Dit is de tabel waarin u al uw dagelijkse mutaties invoert. Er kunnen veel functies gebruikt
worden voor een snelle gegevensinvoer, het overnemen van de opgeslagen rijen, het kopiëren
en plakken van dezelfde soort transacties, het overnemen van herhaalde transacties en het
importeren van mutaties uit bankafschriften.

Er kunnen extra tabellen worden toegevoegd om extra functies te ondersteunen.

Budgettabel.
Bereid financiële prognoses voor met dezelfde soort invoer als in de transactietabel. Compleet
met liquiditeitsplanning, budget en verwachting voor resultatenrekening, klanten, leveranciers,
investeringen, projecten en segmenten voor een of meerdere jaren.
BTW codes tabel.
Stel de vereiste percentages en parameters in die gebruikt worden in de transactietabel voor de
automatische berekening van BTW en de overzichten voor de belastingdienst.
Itemstabel.
Om een lijst van te factureren artikelen aan te maken. Het programma houdt uw inkomsten en
uitgaven bij.
Eigen tabellen.
Om aan specifieke wensen te voldoen.

Snelstart met onze modellen
Begin direct met een van onze modellen zonder tijd te verliezen. U kunt er een kiezen uit de lijst voor
uw land en voor het soort bedrijf dat u uitvoert. U kunt het model aanpassen om het nog beter op uw
wensen af te stemmen.

U heeft een makkelijke start door een nieuw bestand aan te maken vanuit een model.
Een veelvoud aan modellen gerangschikt per land en soort gebruik, aan te passen en met
gebruikersdocumentatie .
Zoek eenvoudig modellen en gebruik ze direct in het programma .

Opzetten van de boekhouding

Stel zelf de munteenheid voor uw boekhouding in, u kunt deze kiezen uit een lijst met
wereldvaluta's of er zelf een instellen (bijvoorbeeld voor cryptovaluta).
Stel zelf de boekhoudperiode in, indien nodig meerdere jaren en niet beperkt tot de klassieke
periode van 1 januari tot 31 december.
Kopteksten en boekhoudgegevens in te stellen in een enkel dialoogvenster, eenvoudig om weer
te geven.
Kies zoveel decimalen als u wilt, van 0 tot 27, bij het aanmaken van de boekhouding.
U kunt het aantal decimalen probleemloos veranderen gedurende het jaar.

https://www.banana.ch/apps/nl?combine=&langcode=nl&country=All&category=All
https://www.banana.ch/apps/nl?combine=&langcode=nl&country=All&category=All
https://www.banana.ch/apps/nl/node/9296
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Meertalig

U bent vrij om de taal van uw boekhouding te kiezen bij het aanmaken van het bestand .
Pas de kopteksten van de kolommen aan naar uw wens.
U kunt uw boekhouding tegelijk in meerdere talen doen.
Afdrukken zijn ook in meerdere talen aan te passen.

Bestands- en gegevensopslag

Alle gegevens worden in één bestand opgeslagen waar u alles zonder tijdverspilling in terug
kunt vinden.
Voor ieder jaar wordt een apart bestand aangemaakt. Alle gegevens hebben betrekking op het
jaar en er is geen verwarring.
Geef het bestand de naam die u wenst.
Met een enkele licentie kunt u een onbeperkt aantal boekhoudingen doen.
Gegevens blijven helemaal in uw bezit.
Sla uw gegevens op elk medium op, computer, netwerk, cloud of verstuur deze per e-mail . U
kunt erbij waar u ook bent.
Gelijktijdige toegang door meerdere gebruikers, maar slechts één persoon kan het bestand
openen om het te bewerken.
Maak uw boekhouding veiliger met een wachtwoord.

Planning-Uitvoering-Beheer
Binnen hetzelfde inkomsten en uitgaven boekhoudbestand kunt u ook uw toekomstige inkomsten en
uitgaven budgetteren, waarmee u eenvoudig de "Planning - Uitvoering - Beheer" benadering in
praktijk brengt .

Dezelfde methode voor verschillende doelen

Als er een onbalans is in de transacties wordt er een melding van het verschil gegeven.
Bedragen worden in de kolommen weergegeven in het formaat dat door uw computer gebruikt
wordt zodat u niet hoeft te wennen aan andere formaten waar u niet bekend mee bent.

Intuïtieve weergave van bedragen, positief voor inkomsten en negatief voor uitgaven.
Met één klik rapporten, journaal, rekeningkaarten en andere overzichten.

Alle afdrukken zijn aan te passen.
Weergave formaat naar keuze.

Gegevens beveiliging met blockchain technologie (volgens een gepatenteerde methode) om
maximale integriteit van uw boekhoudgegevens te garanderen.

Rekeningschema

Het rekeningschema is aan te passen. Voer zoveel rekeningen in als u wilt en een totaal voor
groepen van uw keuze.
De categorieëntabel kan ook aangepast worden, elke categorie die u wenst kan ingevoerd
worden.
U kunt hetzelfde rekeningschema gebruiken om zowel transacties in te voeren als ook uw
financiële prognoses.
U kunt zelf uw rekeningnummers kiezen, numeriek of alfanumeriek, tot 256 karakters lang.
U kunt zelf uw beschrijving invoeren, tot 256 karakters lang.
Het is niet langer nodig om begin- en eindsaldi in te voeren in de boekingen. U voert de saldi
direct in de kolom Opening van de rekeningentabel in en alleen wanneer u Banana

https://www.banana.ch/doc/nl/install
https://www.banana.ch/nl/node/11059
https://www.banana.ch/nl/plannen-uitvoeren-controleren
https://www.banana.ch/nl/plannen-uitvoeren-controleren
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Boekhouding Plus voor de eerste keer gebruikt. In de volgende jaren vindt de overdracht
automatisch plaats.
Saldi, rekeningmutaties en totalen worden contextueel weergegeven en zijn altijd up to date.
Voor iedere klanten-, leveranciers of partnerrekening zijn er kolommen om adressen en andere
nuttiger informatie die u nodig heeft op te slaan.
Andere kolommen toevoegen voor notities, groepering of bedragen.
U hoeft de bedragen in de kolommen niet zelf op te tellen; ze worden automatisch correct
berekend en bijgewerkt.
U kunt daardoor kolommen met uw eigen gegevens aanmaken en heel specifieke details
zichtbaar maken.

Transacties

U kunt een enkele transactie invoeren, of samengestelde transacties in meerdere rijen, als het
om meerdere rekeningen gaat.
Bij het invoeren van uw gegevens worden reeds eerder ingevoerde teksten getoond. Met één
klik wordt de transactie ingevulde (auto-aanvullen).
Directe melding van fouten en verschillen, met de mogelijkheid om deze later te corrigeren.
Sla terugkerende boekingen op om deze weer op te roepen als ze weer voorkomen zonder dat u
ze opnieuw helemaal in hoeft te voeren.
In alle tabellen zijn standaard kolommen beschikbaar en deze kunnen naar wens weergegeven
worden.
Kolommen voor hoeveelheid en prijs voor facturering en kostenbeheersing.
Automatische nummering van documenten met oplopende nummers.
Documenten zijn altijd onder handbereik door de digitale boekstukken (PDF, afbeeldingen) te
koppelen aan boekhoudbestanden en deze met één klik te openen.
Voer eigen teksten in tot 256 karakters lang, ook over meerdere regels.
Geef rijen een kleurtje voor transacties die u later moet controleren of corrigeren, of om ze aan
de accountant te laten zien.
Pas het formaat van rijen aan om de weergave naar uw zin aan te passen.
Voeg kolommen toe om er andere informatie in in te voeren.
Sla de ingestelde indeling van de kolommen op in weergaven om de inhoud die het
belangrijkste is voor u goed weer te geven.
Context informatie over rekeningsaldo, verschillen of fouten.
Voor de periodieke- of eindejaarsafsluitingen kunt u de "boekhouding controleren" functies
gebruiken. U bent dan in staat fouten in de saldi te vinden (bijvoorbeeld saldi op
bankafschriften en saldi in de boekhouding). U ziet meteen wat er fout is en kunt correcties
uitvoeren zodat alles weer met elkaar overeenkomt.
Gegevens importeren:

Voer sneller transacties in door deze te importeren vanuit digitale bankafschriften.
U kunt transacties importeren die in verschillende formaten worden aangeleverd door
banken .
Geïmporteerde rijen kunnen worden aangepast, aangevuld of verwijderd.
Gegevens kunnen ook vanuit andere software worden geïmporteerd.

Financiële prognoses

Als u een budget moet maken kunt u dit doen door een budgettabel aan te maken.
Gebruik eenvoudig dezelfde invoermethode als u al gewend bent in de inkomsten en uitgaven
boekhouding .
Financiële prognoses compleet met liquiditeitsplanning.
Budget prognoses voor de categorieën van de inkomsten en uitgaven boekhouding.

https://www.banana.ch/apps/nl/extensions?combine=&langcode=All&country=262&type=265
https://www.banana.ch/apps/nl/extensions?combine=&langcode=All&country=262&type=265
https://www.banana.ch/nl/financiele-planning
https://www.banana.ch/nl/financiele-planning
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Als u denkt over het doen van lange termijn investeringen kunt u de automatische meerjaren
planning maken.
Maak u budget aan met simpele boekingen.
Alle functies beschikbaar in boekhouding:

Transacties in een of meerdere regels.
Budget voor klanten
Budget prognose voor leveranciers, BTW, kostenplaatsen en winstcentra, segmenten.
Hoeveelheden en prijzen.

Berekeningen in javascript met toegang tot de waardes van de huidige prognose:
Planning van de omzetstijging.
Berekening van provisies en kosten in percentages van de verkoop.
Afschrijving berekening.
Rente berekening.
Gebruik van variabelen.

Prognoses die beschikbaar zijn in afdrukken uit de boekhouding:
Volledig naar wens aan te passen.
Prognoses per maand, kwartaal, halfjaar, jaar.
Vergelijk prognose met huidige situatie.

Rekening kaart met budgettransacties per rekening of groep.

Kasmiddelen en economisch overzicht

Overzichten met eind- of budgetgegevens, of beide, met een indicatie van afwijkingen.
Indeling met groepen en subgroepen naar eigen inzicht.
Bijgewerkte resultaten direct zichtbaar in de rekeningentabel.
Afdrukken op maat:

Uw eigen logo toevoegen.
Keuze van kolommen die weergegeven worden.
Keuze van secties die weergegeven worden.
Gedetailleerd of gegroepeerd afdrukken
Afdrukken per periode.
Kolommen ingedeeld per periode (maand, kwartaal, halfjaar, jaar).
Bedragen van vorig jaar.
Vergelijking van de verwachtte waarde.
Kolommen verdeeld per segment.
Toegevoegde bijlagen.
Groepering zoals in het rekeningschema of volgens uw eigen schema.
Aanpassing opslaan.

Overzicht in tabelvorm (net zoals maatwerk afdrukken maar met de gegevens in de tabel).
Naar PDF exporteren voor archivering en naar andere formaten voor gegevensverwerking.

Andere afdrukken van de boekhouding

Afdrukken van de hele inhoud van tabellen of van alleen een selectie.
Uw eigen logo toevoegen om documenten en afdrukken te personaliseren.
Journaal.
Rekeningkaarten met boekingen en groepen:

Met transacties voor rekeningen of voor prognoses.
Per periode.
Per rekening, groep, kostenplaats of segment.
Boekhoud- of begrotingsgegevens.
Kolommenindeling aan te passen.
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Naar PDF of andere formaten exporteren.

Grafieken

Contextueel, onderaan de tabel.
Verschillende formaten.
Saldo ontwikkeling per rekening of groep.
Boekhoudwaarden.
Begroting.
Voorafgaande jaar.
Keuze in soort grafiek.

Meer functies voor bedrijfsbeheer
Met het programma kunt u extra informatie aan de transacties toevoegen, zodat u dezelfde gegevens
kunt gebruiken voor het BTW-beheer, voor het volgen van klanten en leveranciers, het uitschrijven
van facturen, het genereren van rapporten voor projecten of bedrijfssectoren en om te voldoen aan
de verschillende vennootschaps- en belastingverplichtingen.

BTW beheer

Deze functie kan worden geactiveerd naar keuze (bij het aanmaken van een boekhouding).
BTW code tabel om de verschillende BTW-percentages en -soorten aan te geven.
Alle nationale vereisten worden ondersteund.
Er kunnen ook andere soorten verkoopbelastingen mee beheerd worden (bijvoorbeeld
Amerikaanse verkoopbelasting).
BTW code invoeren.
BTW teruggave functionaliteit (door de BTW code voorafgegaan door een minteken te
gebruiken).
Bruto en netto BTW berekeningen.
Automatische uitsplitsing en boeking op de aangegeven BTW rekeningen .
BTW overzichten:

Per periode of compleet.
Met of zonder mutaties.
Optioneel, met totalen per percentage, BTW code, rekening.

Extensies voor BTW overzichten per land gebaseerd op de eisen van de betreffende
belastingautoriteiten.

Klanten beheer

Functie kan naar keuze worden geactiveerd (door het toevoegen van rekeningen in het
rekeningschema.
Controleren van facturen en klantenbetalingen.
Klanten database in het rekeningschema (rekeningentabel).
Maak groepen en totalen voor klanten aan in verschillende groepen.
Bekijk facturen per klant of op globaal niveau.
Rekeningoverzicht klantenverkeer en openstaande facturen.
Automatische verrekening, open facturen.
Klantenbeheer ook beschikbaar in de vorm van kostenplaatsen (op een contantenbasis).

https://www.banana.ch/area/nl/node/10504
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Facturen aan klanten

Functie kan naar keuze geactiveerd worden (door de kolom voor het factuurnummer in de
transactietabel te gebruiken)
Facturen kunnen direct in de transactietabel ingevoerd worden.
Vereist het opzetten van de klanten database.
Factuurgegevens als gewone transactieregels invoeren.
Zie facturen afdrukken en versturen naar klanten.
Een kolom om hoeveelheden en prijzen aan te geven.
Met of zonder BTW.
Mogelijkheid tot aanpassing en correctie.
Druk met één klik een enkele factuur of meerdere gecombineerd af.
Keuze uit verschillende afdruk formaten .
Pas de factuur naar uw voorkeuren aan.
Met extensie exporteren in digitaal formaat.
Met extensies op maat gemaakte herinneringen aanmaken.
Met extensies op maat gemaakte rekeningoverzichten van klanten aanmaken.

Leveranciersbeheer

Functie kan naar keuze worden geactiveerd (door het toevoegen van rekeningen in het
rekeningschema.
Leveranciersdatabase bevindt zich in het rekeningschema (in de rekeningentabel).
Mogelijkheid om leveranciers te verdelen in verschillende groepen.
Beheer van facturen van en betalingen aan leveranciers.
Open facturen per leverancier of maak een volledig overzicht.
Rekeningoverzicht leveranciersmutaties en nog openstaande facturen.
Automatische verrekening open facturen.

Kostenplaatsen en winstcentra

Functie kan naar keuze worden geactiveerd (door het toevoegen van kostenplaatsen en
winstcentra rekeningen in het rekeningschema).
Voor projecten, kostprijsberekening of rentabiliteit.
Instellen van kostenplaatsen in het rekeningschema.
Groepering op meerdere niveaus.
Drie niveaus van kostenplaatsen en winstcentra.
Onbeperkt aantal kostenplaatsen per niveau.
Negatieve boeking (met minteken).
Rapporten zoals balans en winst- en verliesrekening:

Saldo wordt voortdurend bijgewerkt.
Op maat gemaakte overzichten.
Rekeningkaart van alle boekingen met voortschrijdend saldo.
Contextafhankelijke grafiek.

Segmenten

Functie kan naar keuze worden geactiveerd (door het toevoegen van rekeningen voor
segmenten in het rekeningschema).
De balans en resultatenrekening van een of meer bedrijfssectoren.
Het instellen van segmenten direct in de rekeningen- of categorieëntabel
Tot 10 segmentniveaus.

https://www.banana.ch/apps/nl/node/9034
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Groepering op meerdere niveaus.
Onbeperkt aantal segmenten per niveau.
Saldo wordt voortdurend bijgewerkt.
Rapporten zoals balans en winst- en verliesrekening:

Op maat gemaakte overzichten.
Rekeningkaart van alle boekingen met voortschrijdend saldo.
Contextafhankelijke grafiek.

Balans en resultatenrekening voor ieder segment.

Itemstabel

Voor facturen en met geïntegreerd magazijn- of artikelenbeheer.
Koppeling van items aan de boekingen in de transactietabel.
Automatisch bijgewerkte boekingen voor inkomende en uitgaande artikelen.
Begin- en eindwaarde.
Toevoegen van extra kolommen.

Controle en afsluiting

Foutrapportage en boekhouding controle

Commando om de rekeningen te controleren.
De boekhouding wordt opnieuw berekend alsof alle bewerkingen opnieuw ingevoerd worden.
Rapporteert elke foute instelling, verschil of fout.
Ieder rapport is gekoppeld aan een helppagina die de oorzaken uitlegt en de oplossing
voorstelt.
Controleert of het rekeningsaldo overeenkomt met het echte saldo (contanten, bank, BTW).
Mogelijkheid om te corrigeren.

Transactie bescherming

Beveiliging van rijen.
Vergrendeling van ingevoerde boekingen met digitale gegevens certificatie techniek (Bitcoin
type).
Beveiliging met een wachtwoord.
Voldoet aan wettelijke eisen.
Gegevens sturen naar de auditor met de zekerheid dat er niet mee geknoeid kan worden.
Boekingen met een bepaalde datum ontgrendelen.

Afsluiting en nieuw jaar opening

Procedure om automatisch het bestand voor het nieuwe jaar aan te maken.
Overdracht van openingssaldi voor balansrekeningen.
Werk aan het nieuwe jaar kan beginnen, zelfs als het vorige nog niet is afgesloten.
Commando om de eindsaldi van het vorige jaar over te dragen.

Gegevens exporteren en archiveren

Direct vanuit excel kopiëren en plakken.
Tabellen naar PDF en verschillende andere formaten exporteren.
Archiveren van afdrukken en boekhoudgegevens naar PDF of andere formaten.
Extensies om een standaard auditbestand aan te maken .

https://www.banana.ch/nl/node/10640/
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Het boekhoudbestand op elk soort backupmedium opslaan.

Extensies en andere functies

Functies toevoegen

Nieuwe functies toevoegen.
Functies die niet langer nodig zijn verwijderen.
Overzetten van het ene type boekhouding naar het andere:

Boekhouding met of zonder BTW.
Naar vreemde valuta boekhouding of weer terug.
Van inkomsten/uitgaven boekhouding naar dubbel boekhouden of weer terug.

Documententabel

Om afbeeldingen op te slaan (bedrijfslogo's) of tekst documenten (bijvoorbeeld Javascript
programma's).

Andere extra tabellen

Toevoegen van andere tabellen waarin notities of andere informatie kan worden ingevoerd.
Tabellen kunnen worden aangepast door kolommen eraan toe te voegen.

Extensies

Standaard extensies voor diverse afdrukken en andere functies .
Snel op te zoeken en te installeren.
Automatisch bijwerken.
Op maat te maken extensies.
De mogelijkheid om uw eigen lokale extensies te ontwikkelen en te installeren .

Uitgebreide documentatie
Ieder dialoogvenster en foutmelding heeft zijn eigen documentatie bereikbaar in één klik .
Documentatie die voortdurend bijgewerkt wordt .
FAQ .
Documentatie ook in Pdf formaat beschikbaar.

https://www.banana.ch/apps/nl/extensions
https://www.banana.ch/nl/node/9386
https://www.banana.ch/doc/nl/search?search=fout
https://www.banana.ch/doc/nl/documentatie
https://www.banana.ch/nl/node/9340
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Rekeningschema

Rekeningentabel
De rekeningentabel geeft de balansrekeningen weer, de volgende gegevens worden er ingevoerd:

Balansrekeningen, inclusief klanten- en leveranciersrekeningen.
De totalen van de groepen.
Voor meer informatie over het groeperingssysteem zie de pagina over Groepen in het dubbel
boekhouden.
De beginsaldi.

In de rekeningentabel bevinden zich ook de rekeningsaldo, mutaties en budgetbedragen. Er is
daardoor altijd direct bijgewerkt overzicht van de financiële situatie. Activa worden getoond als
positieve, passiva als negatieve bedragen.

In het voorbeeld hierna zijn alle rekeningen gegroepeerd in Groep 1 (Net estate) in de
rekeningentabel. Activa rekeningen worden opgeteld bij de passiva rekeningen en het verschil
bepaalt de nettowinst.

De kolommen van de Rekeningentabel:

Sectie
Voer een ster in om een verandering van sectie aan te geven. Bijvoorbeeld, om het Totale Vermogen
te scheiden van Kostenplaatsen.
De waardes die ingevoerd worden in de kolom Sectie worden gebruikt bij de presentatie van de
Uitgebreide rekening op groepen.
Zie ook de pagina Secties voor meer informatie.

Groep 
Er worden waarden ingevoerd die de categorieën optellen die dezelfde groepering hebben in de
kolom Tel Op In. Ze zijn de basis voor de totalen.
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Rekening
Voer het getal of de afkorting van de rekening die beheert moet worden (contanten, bank).

Beschrijving
Voer de beschrijving in voor de rekening.

Gr
Voer een waarde in die de categorie aangeeft die bij dezelfde groep hoort.

Opening
Het invoeren van een rekeningsaldo is alleen nodig als een nieuw bestand wordt geopend of als
Banana Boekhouding software voor de eerste keer gebruikt wordt. Bij het aanmaken van een nieuw
jaar worden de saldi automatisch ingevuld.

Inkomsten
Deze geblokkeerde kolom laat het saldo zien van de transacties met inkomsten. Het saldo wordt
automatisch bijgewerkt na iedere boeking.

Uitgaven
Deze geblokkeerde kolom laat het saldo zien van de transacties met uitgaven. Het saldo wordt
automatisch bijgewerkt na iedere boeking.

Saldo
Deze geblokkeerde kolom laat het saldo zien van de transacties met inkomsten en uitgaven. Het
saldo wordt automatisch bijgewerkt na iedere boeking.

Secties
Met de secties  in de rekeningen- en/of categorieëntabel kunt u een aantal rekeningen en
categorieën definiëren die u wilt afdrukken via het commando Raporten → Uitgebreide balans op
groepen.

De secties worden aangegeven in de kolom Secties van de rekeningen- en categorieëntabel
Een * (ster) markeert het begin van de sectie
Een ** (dubbele ster) markeert het begin van een subsectie
Een # markeert het begin van een notitie sectie
De ene sectie eindigt als een andere begint
In tegenstelling tot de dubbele boekhouding kunnen numerieke secties niet gebruikt worden
Als er geen sectie wordt aangegeven voegt het programma deze automatisch toe als u het
commando de eerste keer gebruikt

In de rekeningentabel "Balans"
In de categorieëntabel "Resultaat"

Het is handig om aparte secties te maken als u kostenplaatsen, segmenten of klanten en
leveranciers grootboeken heeft.
Op deze manier kunt u overzichten van voor u belangrijke informatie afdrukken.

Rekeningen en categorieën instellingen
In dit dialoogvenster kunt u instellen hoe de rekeningen en categorieën afgedrukt moeten worden

http://www.banana.ch/doc/nl/node/3317
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De inkomsten- en uitgavenboekhouding
categorieën

Categorieëntabel
De categorieëntabel laat de situatie van de inkomsten en uitgaven zien.
De categorieën kunnen naar eigen inzicht gekozen worden:

De categorieën van de uitgaven en inkomsten.
Toepasselijke kostplaatsen en winstcentra.
De totalen van de groepen.
Voor meer informatie over het systeem van de groepen zie pagina Groepen in het dubbel
boekhouden.

In het voorbeeld hieronder zijn drie hoofdgroepen:

Groep 4 - Totaal van alle categorieën die de groepering 4 hebben in de kolom Tel Op in (totaal
inkomsten).
Groep 3 - Totaal van alle categorieën die de groepering 3 hebben in de kolom Tel Op in (totaal
uitgaven).
Groep 00 - Het totaal van de groepen 3 en 4 (totaal inkomsten en Uitgaven) die het resultaat
bepalen voor de boekhoudperiode.

De kolommen van de Categorieëntabel

De belangrijkste kolommen van de categorietabel worden hieronder opgesomd. De weergave van de
kolommen verandert naargelang de geselecteerde weergave.
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U kunt extra systeemkolommen en uw eigen kolommen toevoegen via Gegevens → Kolommen
instellen.

Sectie

Voer een ster in in de rij die de titel bevat, om een verandering van sectie aan te geven, die wordt
weergegeven in de uitgebreide rekening op groepen. (In ons voorbeeld staat de ster in rij met de titel
"Operating Result").

Als andere secties dan Inkomsten en Uigaven nodig zijn, zoals Kostenplaatsen en Winstcentra, kan
een andere ster ingevoerd worden op de betreffende titel rij. Zie ook de pagina Secties voor meer
detail en informatie.

Groep 
Voer een code (getal of woord) in dat identiek is aan degene ingevoerd voor iedere categorie in de
Tel Op In kolom. De totalen voor iedere categorie die hoort tot dezelfde groep van de Tel Op In
kolom worden dan opgeteld (in ons voorbeeld: Groep 4 telt de Inkomsten categorieën op en groep 3
de Uitgaven categorieën).

Categorie
Het categorienummer dat de inkomsten of uitgaven identificeert, wordt ingevoerd.

Beschrijving
Voer een beschrijving in voor de bijbehorende Inkomsten of uitgaven Categorie. Deze beschrijving
wordt automatisch overgenomen uit de kolom Categoriebeschrijving van de tabel Records (indien
weergegeven).

Tel Op In
Iedere Categorie heeft een code waarmee de totalen voor de betreffende Groep bepaald worden (in
ons voorbeeld alle categorieën voor Inkomsten, in de Tel Op in kolom, hebben het groepsnummer 4
omdat deze worden opgeteld in Groep 4, Totale Inkomsten).

Inkomsten
Deze geblokkeerde kolom laat het saldo zien van de transacties met inkomsten. Het saldo wordt
automatisch bijgewerkt na iedere boeking.

Uitgaven
Deze geblokkeerde kolom laat het saldo zien van de transacties met uitgaven. Het saldo wordt
automatisch bijgewerkt na iedere boeking.

Saldo
Deze geblokkeerde kolom laat het saldo zien van de transacties met inkomsten en uitgaven. Het
saldo wordt automatisch bijgewerkt na iedere boeking.
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Beginsaldi in de inkomsten en uitgaven
boekhouding

Beginsaldi als u begint met Banana Boekhouding
Bij het voor de eerste keer aanmaken van een nieuw bestand met Banana Boekhouding moeten de
beginsaldi handmatig worden ingevoerd in de kolom Opening van de Rekeningentabel.

De positieve bedragen van de balans (contanten, bank, klanten, meubilair, etc.) moeten
gewoon als positief bedrag worden ingevoerd in de kolom Opening.
De negatieve bedragen van de balans (te betalen posten, salarissen, etc.) moeten worden
ingevoerd in de kolom Opening met een minteken voor het bedrag.

Wanneer u met het commando Nieuw jaar aanmaken overgaat naar een nieuw jaar voert Banana
Boekhouding alle beginsaldi automatisch in de Rekeningentabel in.

Met Banana Boekhouding beginnen gedurende het jaar
Wanneer u een nieuwe boekhouding begint, waarbij u het reeds met andere programma's gedane
werk overneemt, heeft u twee mogelijkheden:

Begin de boekhouding vanaf het begin van het jaar door de beginsaldi van het begin van het
jaar in te voeren (rekeningentabel, kolom Opening) en de transactie (transactietabel) die al met
andere programma's ingevoerd zijn (zie ook Gegevens van andere programma's overdragen).
Op deze manier heeft u alle boekhouddetails in één enkel bestand.
Beginnend vanaf de datum waarop de boekhouding wordt overgenomen:

Voer de beginsaldi in (rekeningentabel, kolom Opening) door de huidige bedragen over te
nemen van de andere boekhouding.
Behalve het invoeren van de beginsaldi is het ook nodig om de saldi van de inkomsten
(positief) en de uitgaven (negatief) in te voeren in de categorieëntabel.
Voer de nieuwe transacties in de transactietabel in.
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Saldi van het voorafgaande jaar
Wanneer u met een nieuwe boekhouding begint door een bestaande boekhouding over te nemen en u
wilt dat de bedragen van het afgelopen jaar in de afdrukken voorkomen, moet u de saldi van het
voorafgaande jaar invoeren in de kolom Vorig jaar van de rekeningentabel in de weergave
Vorige:

Voer de positieve eindsaldi van de balans van het vorige jaar in.
Voer de negatieve eindsaldi van de balans van het vorige jaar in, gebruik een minteken voor het
bedrag.
Voer de eindsaldi van de inkomsten van het vorige jaar in
Voer de eindsaldi van de uitgaven van het vorige jaar in, gebruik een minteken voor het bedrag.

Een nieuw jaar aanmaken
Wanneer u een nieuw jaar begint vanuit een bestaande boekhouding draagt het programma
automatisch de beginsaldi voor het volgende jaar over.
Zie ook Jaarafsluiting en nieuw jaar.

De beginsaldi afdrukken
Om de beginsaldi af te drukken:

Om de inhoud van de tabel af te drukken gebruikt u het commando Afdrukken /
Voorbeeldafdruk, waarbij u de rijen van de rekeningentabel selecteert.
U kunt ook de boekhoudafdrukken gebruiken en ervoor kiezen dat de afdruk alleen van de
balans en de kolom beginsaldi gemaakt wordt.

 



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 477

Transacties inkomsten & uitgaven
boekhouding

Transactietabel
De transacties worden ingevoerd in de Transactietabel.
Voer voor iedere transactie de datum, document nummer, beschrijving, bedrag van inkomsten of
uitgaven, rekening en categorie in.

Inkomsten/Uitgaven: het bedrag dat binnenkomt of eruit gaat.
Rekening: voer een van de vermogensrekeningen in (kas, bank, klanten, leveranciers,...).
Categorie: voer een inkomsten of uitgaven categorie in.

Sneller transacties invoeren:
Om het invoeren van de transacties sneller te laten verlopen, kunt u gebruik maken van:

de functie van het Auto-aanvullen bij het invoeren van gegevens; deze maakt het mogelijk
automatisch gegevens, die reeds eerder zijn ingevoerd, op te halen
de functie van de Terugkerende transacties die het mogelijk maakt de terugkerende transacties
in een daarvoor bestemde tabel op te slaan
Het importeren van transacties van digitale bankafschriften of transactiebestanden.

 De kolommen van de Transactietabel
De belangrijkste kolommen van de Transactietabel worden hieronder opgesomd. De weergave van de
kolommen verandert naargelang de geselecteerde weergave.

U kunt extra systeemkolommen en uw eigen kolommen toevoegen via Gegevens → Kolommen
instellen.

Datum
De datum van de inkomende of uitgaande transactie

Doc
Voer hier een documentnummer in. Gewoonlijk gebruikt men hetzelfde documentnummer dat
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toegekend is aan het "papieren document". Dit maakt het mogelijk ook na lange tijd gemakkelijk het
document terug te vinden.

Beschrijving
Voer hier een beschrijving in om de inkomende of uitgaande transactie te identificeren.

Inkomsten
Het inkomende bedrag invoeren.

Uitgaven
Het uitgaande bedrag invoeren

Rekeningen
Hier de vermogensrekeningen invoeren (kas, bank, postbank, klanten, leveranciers, etc).

Categorie
Hier de inkomsten- of uitgaven-categorie invoeren, gedefiniëerd in de Categorieën-tabel.

Categorie Beschrijving
Deze kolom neemt automatisch de beschrijving van de categorie over, ingevoegd in de tabel
Categorieën.
Indien u de omschrijving van een categorie in de tabel Categorieën wijzigt, moet u de boekhouding
herberekenen om de nieuwe tekst in de kolom Omschrijving van de categorie in de tabel
Verrichtingen weer te geven.

Transacties met meerdere boekingen
Bij het invoeren van een transactie met meerdere boekingen moet u deze over meerdere rijen
invoeren.

Hierna laten we een voorbeeld zien (zie boeking 11 in de kolom Doc). Er worden meerdere rekeningen
via de bank betaald.

Voer dezelfde datum en document nummer in in alle rijen die met deze transactie te maken
hebben. Hiermee kunt een transactie met meerdere boekingen makkelijk terugvinden.
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Voer in de eerste rij het totale bedrag in de kolom Uitgaven in als het een betaling is, of in de
kolom Inkomsten als het een storting is.
Voer in de kolom Rekening de betaalrekening in (rekening waarmee u betaalt of waarop u
ontvangt). De cel in de kolom Categorie in de eerste rij blijft leeg.
In de volgende rijen voert u het betaalde of ontvangen bedrag van de betreffende factuur op
iedere rij in (in de Uitgaven of Inkomsten kolom).
Iedere factuur wordt ingevoerd in een aparte rij.
De kolom Rekening blijft leeg.
Voer in de kolom Categorie de categorie van iedere boeking in om aan te geven waarvoor de
uitgave gedaan is of de inkomsten ontvangen zijn.

Voorbeelden van transacties met BTW
Om transacties met BTW te verwerken is het nodig een Inkomsten / Uitgaven model met BTW  in te
stellen.

Bijkomende kolommen

Afhangend van het gekozen type Inkomsten & Uitgaven boekhouding (namelijk met of zonder BTW),
zijn er bijkomende kolommen voor het invoeren van de BTW gegevens.

BTW-code
De BTW-code ingeven die betrekking heeft op een verkoop of een aankoop.De ingevoerde code moet
aanwezig zijn in de BTW-codes tabel.

Voor de beschrijving van de andere BTW kolommen, zijn er meer details beschikbaar op de pagina
Transacties. 

Om het invoeren gemakkelijker te maken, kunt u in de Rekening- en Categoriekolom van de
Transactietabel tekst invoeren voor de rekening of categorie die u zoekt, in plaats van het invoeren
van het nummer van de rekening of categorie.
De software toont u de lijst van alle rekeningen en categorieën waar de ingevoerde tekst in voorkomt.
Met de Pijl-omlaag toets kunt u in de lijst het gezochte item aanwijzen en selecteren door op Enter
te drukken.

https://www.banana.ch/apps/nl?combine=&langcode=nl&country=All&category=All&type=254&op=Invia
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Om, na het invoeren van de transacties, de boekingen op een rekening of een categorie te laten zien
klikt u op het blauwe symbooltje in rekening/categorie cel (rechterbovenhoek van de geselecteerde
cel).

Rekening- en categoriekaart
De weergave van de transacties in de rekening- of categoriekaart lijkt erg op die van de
Transactietabel. Wanneer u nieuwe transacties invoert of veranderingen maakt (altijd in de
Transactietabel) kunt u de rekening/categoriekaart bijwerken door op het Tabel vernieuwen teken
(ronde blauwe pijl) aan de rechterkant van het scherm te klikken.
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Budget transacties

Budgettabel
Financiële planning wordt gedaan in de Budgettabel.

Prognoses worden ingevoerd alsof ze normale transacties zijn, zoals in de transactietabel.
Zowel hoeveelheden en prijzen als formules kunnen worden ingevoerd,

Zie de pagina Budgettabel voor meer informatie.
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Afdrukken

Onmiddelijke informatie
Rekening-saldi, inkomsten en uitgaven kunnen direct bekeken worden in de Rekeningen- en
Categorieën tabellen.
Na het invoeren van elke transactie worden de saldi automatisch bijgewerkt. Het is niet nodig een
rapport af te drukken om de situatie onder controle te hebben, u kunt gewoon de Rekeningen- of
Categorieën tabel consulteren.

Geavanceerde afdrukken
Alle afdruktaken worden uitgevoerd vanuit het Rapporten menu, waar de verschillende functies voor
de afdrukken zich bevinden:

Journaal - commando Journaal op periode. U kunt de gehele, of een specifieke, periode
opvragen.

Rekening-/Categorie kaarten commando. U kunt alle kaarten opvragen of een selectie
aangeven.
Voer de gewenste periode in in het tabblad Periode; in het tabblad Opties kunt u verschillende
opties activeren die al dan niet in de afdruk opgenomen moeten worden. Configuraties voor de
afdruk kunnen opgeslagen worden via het tabblad Aanpassing zodat ze op elk gewenst moment
opgevraagd kunnen worden zonder dat u opnieuw alle instellingen opnieuw moet invoeren.

Uitgebreide rekening commando.  De Uitgebreide rekening kan ook voor een specifieke periode
gedefinieerd worden en verschillende opties kunnen opgenomen worden; er kunnen ook
verschillende aanpassingen aangemaakt worden.

Uitgebreide rekening op groepen commando. De Uitgebreide rekening op groepen kan ook voor
een specifieke periode gedefinieerd worden en verschillende opties kunnen opgenomen
worden; er kunnen ook verschillende aanpassingen aangemaakt worden.

Boekhoudingsoverzichten commando. Het rapport met de gevraagde opties wordt weergegeven
in de Rekeningen tabel. U kunt rapporten per periode aanmaken, met of zonder vergelijking
met vorige jaren of vorige periodes; elke periode kan onderverdelingen bevatten en ook hier
kunt u aanpassingen opslaan.
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Rekeningkaart / Categoriëen - Inkomsten en
Uitgaven

De rekening- of categoriekaart wordt aangemaakt vanuit het grootboek en geeft u een complete lijst
van de boekhoudmutaties van de betreffende rekening, categorie, kostenplaats, segment of groep.

De rekeningkaart openen
Er zijn twee manieren om een rekening- of categoriekaart te openen en af te drukken.

Eerste methode

Deze methode wordt aanbevolen als u verschillende rekening- of categoriekaarten wilt zien of
afdrukken.

Klik in het menu op Rapporten → Rekening-/Categoriekaarten...

Er verschijnt een dialoogvenster met de volgende secties:

Rekening/Categorie
Periode
Opties
Aanpassing

Klik voor gedetailleerde informatie over de secties op de betreffende link.

http://www.banana.ch/doc/nl/node/7217
http://www.banana.ch/doc/nl/node/2729
http://www.banana.ch/doc/nl/node/2604
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Tweede methode

Met deze methode kunt u één enkele kaart vanuit een tabel openen.

Klik op het icoontje dat verschijnt als u de cel selecteert die de rekening, de categorie, of het
groepsnummer bevat.

De rekeningkaart bijwerken
De rekening- of categoriekaart is tijdelijk en wordt berekend op het moment van het verzoek. Als er
transacties zijn veranderd of toegevoegd in de transactietabel wordt de rekeningkaart niet
tegelijkertijd bijgewerkt.

Om de rekeningkaart na veranderingen bij te werken is het nodig het commando
Rekening/Categoriekaart opnieuw te gebruiken, of, als de rekeningkaart nog geopend is, op het
symbooltje, dat in de afbeelding hieronder getoond wordt, te klikken.

Let op

In de rekening-, categorie- of groepenkaart is het niet mogelijk gegevens te veranderen. Om dit te
doen kunt u op het rijnummer dubbelklikken waardoor het programma naar de overeenkomstige rij
van de transactie- of budgettabel gaat en daar een verandering maken.
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De kolom Geselecteerde rekening
In de kolom Geselecteerde Rekening, die zichtbaar gemaakt kan worden vanaf elke rekeningkaart
met Gegevens → Kolommen instellen, wordt de rekening waarop de transactie plaatsvond
weergegeven.
Als u een rekeningkaart heeft gemaakt van een of meer rekeningen, categorieën, groepen en
segmenten ziet u hiermee precies welke rekening wordt gebruikt.

De kolom Tegenrekening
De kolom Tegenrekening wordt weergegeven op de rekening- of categoriekaart en geeft de
tegenrekening aan die de boeking compleet maakt.

Kaarten van groepen of klassen
In de rekeningkaart van een groep of klasse worden alle transacties van de rekeningen die tot een
geselecteerde groep of klasse horen opnieuw gegroepeerd.
De rekeningen of categorieën van de groep of klasse kunnen worden weergegeven door de kolom
Geselecteerde Rekening zichtbaar te maken.
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Budget rekeningkaart
Als er budget transactie zijn ingevoerd in de budgettabel is het mogelijk om rekening- of
groepskaarten te maken van het budget:

menu Rapporten → Rekening / Categoriekaarten → kies Budget transacties.

Het grootboek (rekeningkaarten) afdrukken
Om de kaarten af te drukken:

menu Rapporten → Rekeningkaarten
Door het Filter te gebruiken is het mogelijk automatisch alle rekeningkaarten te selecteren die
afgedrukt moeten worden of een gedeelte (bijvoorbeeld alleen rekeningen, kostenplaatsen of
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segmenten).
In de diverse secties Periode, Opties, Aanpassing worden de gewenste functies geactiveerd
(bijvoorbeeld periode, een rekening per pagina ....).
Bevestig met OK, na het instellen van de gewenste opties.

De geselecteerde rekeningkaarten verschijnen op het scherm. Om ze af te drukken klik op menu
Bestand → Afdrukken.

Een logo toevoegen aan de rekeningkaarten
Vanaf Banana 9, is het mogelijk ook een logo toe te voegen aan de afdrukken van de
rekeningkaarten.

Ga na het aanmaken van de rekeningkaart als volgt te werk:

menu Rapporten → Rekening kaarten
menu Bestand → Afdrukvoorbeeld.
Geef uw logo aan in het dialoogvenster dat geopend wordt (in plaats van geen).

Gedetailleerde informatie is te vinden op de pagina Logo-instelling.

De instellingen opslaan
Als u regelmatig de kaarten van bepaalde rekeningen moet afdrukken, bijvoorbeeld alles van de
verkopen, is het handig om een speciale aanpassing aan te maken:

menu Rapporten → Rekening kaarten → sectie Aanpassing
Klik op de knop Nieuw
Geef de naam aan in de beschrijving, bijvoorbeeld "Rekening verkopen"
Selecteer de rekeningen die u wilt afdrukken
In het menu Bestand → Pagina instellen  kunt u de marges en andere pagina instellingen
bepalen.

Telkens wanneer u de rekeningen moet afdrukken kiest u de aanpassing die u heeft aangemaakt.

http://www.banana.ch/doc/nl/node/2605
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Journaal - Inkomsten / Uitgaven boekhouding

In de inkomsten / uitgaven boekhouding worden, net als in alle Banana Boekhouding applicaties, de
boekingen ingevoerd in de transactietabel. Als u het journaal (de lijst van alle transacties) wilt
afdrukken kunt u dat doen op twee verschillende manieren:

Vanuit de Transacties-tabel,
kies van het menu Bestand → Pagina instellen (om alle afdrukopties in te stellen)
terugkeren naar het menu Bestand → Afdrukken.

Vanuit het menu Rapporten → Journaal op periode....

Journaal op periode
Banana Boekhouding Plus biedt, via het menu Rapporten → Journaal op periode..., de
mogelijkheid om het journaal af te drukken met de mutaties van de hele periode of van een periode
die bepaald wordt door de ingevoerde begin- en eindtijd.

De informatie op de sectie Periode is identiek aan die beschreven in Sectie Periode van de
gemeenschappelijke functies.
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In de sectie Sorteringskolom kunt u de kolom kiezen waarop de gegevens gesorteerd worden bij het
afdrukken van het journaal.
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Uitgebreide rekening

De Uitgebreide Rekening geeft een overzicht van de voortgang van het vermogen en het
bedrijfsresultaat van het jaar. Deze functie is aanwezig in de Boekhouding inkomsten &
uitgaven.
De Uitgebreide Rekening wordt berekend en zichtbaar gemaakt met het commando
Uitgebreide Rekening... van het menu Rapporten.
In het scherm dat verschijnt kunt u de kop invoeren die op de eerste pagina van de
Uitgebreide Rekening verschijnt; verder zijn er nog een aantal opties die u kunt selecteren
om meer details in de afdruk in te stellen.
Transacties zonder datum worden beschouwd als beginsaldi en verschijnen niet in de afdrukken
van de Winst & Verlies Rekening.

Zie ook Afdrukken.

Paginakopteksten

Rijen 1-4
In deze rijen kan de gebruiker vrijuit de Rapportkoppen bepalen.

Kolomkopteksten

Begindatum
Voer de startdatum van de boekhouding in.
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Einddatum
Voer de einddatum van de boekhouding in.

Vorig jaar
Voer de einddatum van de boekhouding van het vorige boekjaar in.

Pagina's afdrukken

Met deze opties bepaalt u welke pagina's in de afdruk verschijnen en of er een nieuwe pagina gestart
wordt in de afdruk tussen verschillende soorten pagina's.

Rekeningen
De rekeningen worden afgedrukt.

Beginpagina
De beginpagina met de bestandskoppen wordt afgedrukt.

Categorieën
De categorieën worden afgedrukt.

Einde van pagina na rekeningen
De rekeningen en categorieën worden afgedrukt op twee verschillende pagina's.

In afdruk opnemen

Met deze opties bepaalt u welke details moeten worden opgenomen in de afdruk.
Sommige van deze opties zijn niet beschikbaar (bv. Saldi budget) als een specifieke periode is
geselecteerd in de sectie Periode.

Andere Tabbladen
De uitleg over de andere tabbladen is beschikbaar op de volgende pagina's:

Periode
Stijl
Teksten
Marges
Compositie
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Uitgebreide rekening op groepen

Deze functie is alleen beschikbaar in versie 7.0.4 of hoger. De gebruiker kan hiermee de Uitgebreide
rekening op groepen maken met alle opties die beschikbaar zijn in de Dubbelboekhouden versie.

De Uitgebreide rekening op groepen maakt het mogelijk om:

In de afdruk alle groepen mee te nemen die aanwezig zijn in de Rekeing- en
Categorieëntabellen.
Groepen of rekeningen individueel uit te sluiten
Een onderverdeling per periode te kiezen
(bijvoorbeeld, men kan een ervoor kiezen een onderverdeling per maand of per kwartaal te
hebben in het eerste halfjaar)
Een onderverdeling per segment te kiezen.

Hieronder ziet u een voorbeeld van een uitgebreide rekening voor een boekhouding inkomsten &
uitgaven; voor complete documentatie zie Uitgebreide Balans op groepen.
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Boekhoudingsoverzichten

Dit commando geeft de bedragen van rekeningen weer volgens een bepaalde groepering, voor
een gespecificeerde periode of per onderverdeling.
Transacties zonder datum worden beschouwd als beginsaldi en verschijnen niet in de afdrukken
van de Winst & Verlies Rekening.

Weergave

U kiest hier het gewenste groeperingsschema:

Rekeningen - Het rapport toont een lijst van alle rekeningen met de volgende kolommen:
beginsaldo, inkomsten, uitgaven en rekeningsaldo
Categorieën - Het rapport toont een lijst van alle categorieën met de volgende kolommen:
beginsaldo, inkomsten, uitgaven en rekeningsaldo

Opties

U kiest hier hoe rekeningen in de afdruk opgenomen of uitgesloten moeten worden:

Rekeningen uitsluiten - alleen de categorieën worden afgedrukt
Rekeningen zonder transacties opnemen - rekeningen zonder transacties worden ook
afgedrukt
Rekeningen met nulsaldo opnemen - rekeningen met een saldo van nul worden ook
afgedrukt
Groepen zonder rekeningen uitsluiten - groepen met rekeningen met een saldo van nul
worden niet afgedrukt.
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Andere Tabbladen

De uitleg over de andere tabbladen is beschikbaar op de volgende pagina's:

Periode
Onderverdeling
Aanpassing
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BTW Overzicht (alleen voor bestanden met
BTW optie)

Informatie over het BTW overzicht is te vinden op de pagina BTW Overzicht.
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Nieuw Jaar aanmaken | Inkomsten en
Uitgaven boekhouding

Het commando Nieuw jaar aanmaken creëert een bestand voor het nieuwe jaar op basis van het
boekhoudbestand dat wordt afgesloten. Het commando wijzigt het huidige bestand niet, zodat het
zonder gevolgen kan worden uitgevoerd.

Logica van de overgang naar het nieuwe jaar
Met Banana Boekhouding heeft u voor elk jaar een apart bestand. Wanneer het nieuwe jaar begint, is
de operationele logica als volgt:

Met het commando Nieuw jaar aanmaken, maakt het programma een nieuw bestand voor het
jaar aan, met hetzelfde rekeningschema, dezelfde instellingen en saldi van het lopende jaar dat
op het punt staat te worden afgesloten.

Zodra het nieuwe jaarbestand is gecreëerd, sla het op met een nieuwe naam.
De handeling van het aanmaken van het nieuwe bestand kan worden herhaald indien u
besluit het bestand niet op te slaan.

U kunt aan beide bestanden tegelijk werken:
In het nieuwe worden de transacties van het nieuwe jaar ingevoerd. Het zal ook mogelijk
zijn wijzigingen aan te brengen in het rekeningschema, de BTW of andere, zonder dat het
vorige jaar wordt beïnvloed.
In het dossier van het vorige jaar worden de transacties verder ingevoerd om het jaar af
te sluiten en de typische afsluitende verrichtingen uit te voeren, saldi te verifiëren,
rapporten af te drukken, enz.

In het bestand van het nieuwe jaar worden, met het commando Acties → Beginsaldi bijwerken
de wijzigingen die in het bestand van het vorige jaar werden aangebracht, hervat. Deze
operatie moet worden uitgevoerd ten laatste wanneer er geen wijzigingen meer zijn in het
vorige jaar.

Zodra het Bestand voor het nieuwe jaar is aangemaakt, zullen degenen die geabonneerd zijn op het
Professional Plan van Banana Boekhouding Plus, het bericht Advanced Plan in demonstratiemodus
zien. Deze melding zal verschijnen in het Info venster onderaan het scherm en zal pas verdwijnen bij
het bereiken van 70 transactieregels in de Transactions tabel.

Controleren en afsluiten van de boekhouding van het vorige
jaar
Alvorens de beginsaldi bij te werken, is het belangrijk dat u alle controles, verificatiebewerkingen en
alle boekingen ter afsluiting van het boekjaar hebt uitgevoerd, om verschillen tussen de eindsaldi van
het lopende jaar en de beginsaldi voor het volgende jaar te voorkomen. Raadpleeg de pagina:

Controle en afsluiting in het Dubbel boekhouden

In tegenstelling tot het Dubbel boekhouden is er bij het afsluiten van de periode van een Boekhouding
inkomsten en uitgaven geen winst of verlies toe te wijzen. Het verschil tussen de inkomsten- en
uitgavencategorieën in de nieuwe boekhoudperiode wordt getoond als een stijging of daling van het
vermogen.

https://www.banana.ch/doc/nl/appmsg_nl_info_license_extended_startupmode
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Bewerkingen uitgevoerd door het commando Nieuw jaar
aanmaken
Het Nieuw jaar aanmaken... commando voert de volgende bewerkingen uit, rekening houdend met de
door de gebruiker ingestelde parameters

Maakt een nieuw bestand aan (zonder naam) met het rekeningschema en de instellingen van
uw huidige bestand, maar zonder transacties.
Kopieert de gegevens van de Saldo kolom van uw huidige bestand naar de Opening kolom van
het nieuwe bestand (alleen voor de geselecteerde klassen)
Kopieert de gegevens van de Saldo kolom van uw huidige bestand naar de Vorig Jaar kolom
van het nieuwe bestand (voor alle rekeningen).
Werkt de Bestands en boekhoudingseigenschappen van het bestand bij:

Stelt de begin- en einddatum in, waarbij 1 jaar wordt toegevoegd aan de bestaande.
In de sectie Opties, stelt de bestandsnaam van het vorige jaar in en activeert de optie om
de transacties van het vorige jaar te gebruiken voor autoaanvulling.

Als er gegevens in de Budgettabel staan, worden de transactierijen overgenomen in het nieuwe
jaar, rekening houdend met de instellingen.
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Beginsaldi bijwerken | Inkomsten en
Uitgaven boekhouding

Het commando Beginsaldi bijwerken neemt gegevens over uit het bestand van het vorige jaar en
werkt de beginsaldi bij voor het huidige jaar.

Wanneer moet u het commando Beginsaldi bijwerken
gebruiken?
Het commando Beginsaldi bijwerken is nodig in de volgende gevallen:

U hebt het nieuwe jaar aangemaakt met het commando Nieuw jaar aanmaken, maar u hebt nog
wijzigingen aangebracht in het bestand van het vorige jaar (extra transacties, nieuwe
rekeningen, ...).
In het voorgaande jaar zijn wijzigingen aangebracht (toegevoegde of gewijzigde transacties,
toegevoegde rekeningen, enz.).

De boekhouding van het vorige jaar controleren
Om verschillen tussen de eindsaldi van het vorige jaar en de beginsaldi van het nieuwe jaar te
voorkomen, is het van belang dat u, voordat u het commando Beginsaldi bijwerken gebruikt, er zeker
van bent dat u alle controles, verificatiebewerkingen en alle boekingen ter afsluiting van het boekjaar
hebt uitgevoerd, zoals aangegeven op de pagina Jaarafsluiting van het Dubbel Boekhouden.

Het dialoogvenster Beginsaldi bijwerken
Om dit dialoogvenster te openen, gebruikt u het menu Acties → Beginsaldi bijwerken.
U moet het pad invoeren naar de plaats waar het bestand van het vorige jaar zich bevindt:

Het programma zal de naam van het opgeslagen bestand voorstellen
Als de naam van het bestand of het pad naar de locatie is gewijzigd, drukt u op de knop
Bladeren.

Verrichtingen die door dit commando worden uitgevoerd
Het commando neemt de gegevens van het vorige jaar over, zonder de inhoud ervan te wijzigen. Dit
commando kan dus worden herhaald zonder gevolgen voor het bestand van het voorgaande jaar.

Het commando voert dezelfde bewerkingen uit als in Nieuw jaar aanmaken, behalve die welke
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betrekking hebben op het aanmaken van het bestand.

Veranderingen in het rekenschema van het vorige jaar
Als u na het aanmaken van het nieuwe jaar rekeningen toevoegt aan het rekeningschema van het
vorige jaar en dan saldi overbrengt, kan het programma een foutmelding geven.

Voer de nieuwe rekeningen ook in het bestand voor het nieuwe jaar in.
Herhaal de operatie Beginsaldi bijwerken

U kunt de veranderingen importeren met het commando Rekeningen importeren.
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Cash Manager documentatie

Cash Manager is een Banana Boekhouding Plus applicatie, helemaal gratis. Het programma is zo
eenvoudig dat iedereen het kan gebruiken, van kinderen tot volwassenen, zonder enige boekhoud
kennis. Met deze toepassing weet u direct wat uw inkomsten en uitgaven zijn en over hoeveel
contanten u beschikt.

▶ Video: Cash Manager  (Engelstalig)
Ontdek alle Cash manager functies
 

Cash Manager heeft een tabel structuur, zoals in Excel. Het is ideaal voor geldbeheer voor
verschillende gebruikers:

Familie - om te budgetteren en inkomsten en uitgaven onder controle te krijgen.
Jongeren - voor diegenen die beginnen met het beheren van hun eerste uitgaven en zich
bewust worden van hun besparingen.
Studenten - voor degenen die hun beschikbare middelen onder controle willen hebben en die
zicht willen hebben op de uitgaven voor studie of universiteit.
Verenigingen - om te budgetteren en contante uitgaven en inkomsten te beheren.
Bedrijven - om snel alle bonnen te boeken en gedetailleerd overzicht te hebben van uitgaven
en inkomsten op de contanten rekening. Met de scan van iedere bon kunt u deze als PDF
bestand direct aan het boekhoudbestand koppelen.
Projecten - voor het beheer van kosten die bij een project horen.

Onderwerpen die hetzelfde zijn als in het Dubbel
boekhouden

Toevoegen / Hernoemen / Verwijderen van een rekening
Groepen invoegen
Kostenplaatsen en Winstcentra
Segmenten
De kolom Saldo

Commando's

https://www.banana.ch/en/node/11389


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 502

Boekhouding controleren
Transacties blokkeren
Nieuw jaar aanmaken
Facturen aanmaken

Afdrukken

Journaal
Rekening-/Categorie kaarten
Uitgebreide rekening
Uitgebreide rekening op groepen
Boekhoudingsoverzichten
BTW overzicht
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Hoe beginnen - Kasboek

De eenvoudigste manier om met Banana Boekhouding Plus aan de slag te gaan, is een van de vele
beschikbare templates te kiezen en deze aan te passen aan uw wensen.

Aanmaken van een boekhoudbestand uitgaande van een
online model
Ga als volgt te werk:

Menu Bestand, commando Nieuw....1.
Selecteer Online Modellen2.
Selecteer het land, de taal, de categorie en het type boekhouding3.
Uit de lijst van de Online modellen, kies het model dat het dichtst komt bij wat u nodig heeft.4.
Door op de het gekozen model te klikken opent het programme direct het bestand.5.

In het gedeelte "Zoeken" worden bij het invoeren van een sleutelwoord in het programma de
modellen weergegeven die het ingevoerde sleutelwoord bevatten.

Het is ook mogelijk om vanuit een leeg bestand te beginnen, door de optie blanco bestand aanmaken
te activeren. Om de start te vergemakkelijken en groeperingsfouten te vermijden, raden wij u altijd
aan om steeds te beginnen met een bestaand model.

Meer informatie over het aanmaken van een nieuw bestand vindt u op de pagina Nieuw bestand
aanmaken.

Bestandseigenschappen instellen
Stel uw gegevens in met het commando Bestands- en boekhoudingseigenschappen... (menu
Bestand) en sla het bestand op met een eigen naam.
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Het beginsaldo van de rekening invoeren
Voer de rekening in die u wilt beheren in de Rekeningentabel van het Kasboek en het beginsaldo in de
kolom Opening. Het commando Nieuw jaar aanmaken... van het menu Taken zorgt ervoor dat het
beginsaldo wordt overgenomen van een vorig jaar. Er kan één rekening worden ingevoerd.

De Categorieëntabel aanpassen
In de Categorieëntabel kunt u de inkomsten en uitgaven categorieën aanpassen aan uw eigen
wensen. Het is mogelijk om:

het categorienummer aan te passen
de beschrijving aan te passen
categorieën te verwijderen
categorieën toe te voegen
subgroepen toe te voegen
subgroepen te verwijderen

Alle saldi van de Categorieën bepalen het resultaat van het boekjaar (winst of verlies) en mogen
daarom geen beginsaldi bevatten.

Nieuwe categorieën toevoegen

Wanneer nieuwe categorieën moeten worden toegevoegd in een reeds bestaande groep gaat u als
volgt te werk:

Voeg een lege rij toe (Menu Bewerken, Rijen toevoegen... ) voor het Totaalrij van de Groep
Voer het nummer of de afkorting van de Categorie in de kolom Categorie in
Voer de Beschrijving in die de categorie omschrijft
Voer in de Gr kolom een Gr in die identiek is aan de andere categorieën die tot het Groepstotaal
horen.
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Subgroepen toevoegen

Ga als volgt te werk om subgroepen toe te voegen:

Voeg een lege rij toe (Menu Bewerken, Rijen toevoegen... ) op de plaats waar een nieuwe
subgroep toegevoegd moet worden
Voer een nummer of een afkorting in in de laatste lege rij van de kolom Groep (in ons voorbeeld
10 - Totale verkopen)
Voer de Beschrijving in die de nieuwe subgroep omschrijft
Voer het Groepstotaal nummer in in de Gr kolom (in ons voorbeeld 1 - Totale verkopen).

Categorieën of subgroepen verwijderen

Selecteer de categorieën of subgroepen die u wilt verwijderen en voer het Rijen verwijderen
commando uit van het menu Bewerken.

Transactiestabel
In de Transactiestabel worden de dagelijkse inkomsten en uitgaven transacties ingevoerd waarbij de
rekening wordt aangegeven waarop de boeking gedaan wordt en de categorie waarvoor de uitgave
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gedaan is of inkomsten ontvangen zijn.

Sneller invoeren van de transacties

Om het invoeren van uw transacties sneller te maken kunt u:

de Smart fill functie gebruiken waarmee de transacties automatisch worden aangevuld met
gegevens die al eens eerder zijn ingevoeurd.
de Terugkerende transacties functie gebruiken (Menu Taken). Deze wordt gebruikt om
terugkerende transacties te onthouden in een aparte tabel.
De Banktransacties naar boekhouding importeren functie gebruiken.

Transacties met BTW

Om transacties met BTW in te voeren gaat u als volgt te werk:

Kies van het menu Bestand het commando Nieuw en kies Kasboek met BTW
Kies een van de bestaande modellen  voor uw land van de Inkomsten/Uitgaven boekhouding
met BTW
Zie ook de Transacties pagina over het invoeren van transacties met BTW.

De Categorie- of Groepkaart

Met de Categorie- of Groepkaart kunt u een complete lijst maken van boekingen die betrekking
hebben op dezelfde categorie of groep.

Om een categorie- of groepkaart te openen klikt u eenmaal op het categorienummer cel en
dan eenmaal op het blauwe pijltje dat verschenen is in de rechterbovenhoek van de cel.
Om meerdere categorie- of groepkaarten te openen moet u het commando Rekening-/
Categorie kaarten van het menu Rapporten gebruiken.
Om de categorie- of groepkaarten bij te werken nadat er veranderingen in de
Transactiestabel zijn gemaakt moet u klikken op het symbool met de twee ronde pijltjes in de
rechterbovenhoek van de rekeningkaart.

https://www.banana.ch/apps/nl
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Rekeningkaarten per periode

Om een rekeningkaart met rekeningsaldi op bepaalde data te openen klik u op Rapporten in het
menu, Rekening-/ Categorie kaarten... en dan op Geselecteerde periode in de tab Periode om
de door u gekozen periode in te voeren.

Zie de pagina Periode voor meer informatie.

De Categoriekaarten afdrukken

Om een Categoriekaart af te drukken, opent u deze vanuit de Rekeningen-, Categorieën- of
Transactiestabel en begint u het afdrukken vanuit het menu Bestand.

Om diverse of alle Rekeningkaarten af te drukken, klik op menu Rapporten, kies Rekeningkaarten en
kies de Rekeningen die u wilt afdrukken. Met het filter in het venster kunt u kiezen voor alle
rekeningen, kostenplaatsen, segmenten, groepen, etc.

Zie de pagina Rekeningkaarten voor meer informatie.

Uitgebreide rekening

Om de Uitgebreide Rekening en de Uitgebreide Rekening op groepen te bekijken kiest u in het menu
Rapporten het commando Uitgebreide Rekening of de Uitgebreide Rekening op groepen. U
kunt ook overzichten per periode maken.

De Uitgebreide Rekening laat alle rekeningen en categorieën zien zonder enige subgroepen
De Uitgebreide Rekening op groepen laat alle rekeningen en categorieën zien met subgroepen.
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Archiveer gegevens als PDF

Aan het eind van het jaar, wanneer de boekhouding afgesloten is kunt u alle boekhoudkundige
gegevens opslaan met het commando Pdf bestand aanmaken... van het menu Bestand.

Het Budget

Voordat u met uw boekjaar begint kunt u een budget aanmaken met uw geschatte uitgaven en
inkomsten om controle te hebben over de financiele en economische toestand van uw bedrijf.

Het budget kan op twee manieren ingesteld worden:

Met de Budget kolom van de Categorieëntabel. Voor iedere rekening wordt het jaarbudget
aangegeven.
In dit geval, als u het budget opvraagt met het commando Uitgebreide rekening op groepen
van het menu Rapporten, laat de Budget kolom de bedragen zien die betrekking hebben op
het hele jaar.
Met de Budgettabel, die u handmatig activeert met het commando Nieuwe functies
toevoegen van het menu Extra.
In deze tabel worden alle schattingen ingevoerd als budgettransacties voor inkomsten en
uitgaven. Wanneer u deze tabel activeert wordt de Budget kolom van de Rekeningentabel
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automatisch gedeactiveerd.
In de Budgettabel kunt u een gedetailleerd budget instellen dat rekening houdt met mogelijke
veranderingen gedurende het jaar en in verschillende periodes van het jaar.
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Karakteristieken van Cash Manager
(Kasboek)

Cash Manager is een Banana Boekhouding applicatie die helemaal gratis is. Iedereen, jong en oud,
kan deze applicatie gebruiken, zonder enige kennis van boekhouden. Cash Manager is eenvoudig en
intuïtief, met een spreadsheet structuur zoals in Excel.

De karakteristieken van Cash Manager zijn identiek aan die van de Inkomsten en Uitgaven
boekhouding, met het verschil dat u in de rekeningentabel van Cash Manager één rekening kunt
gebruiken terwijl in de Inkomsten en Uitgaven boekhouding, net zoals bij een balans, zoveel
rekeningen als nodig zijn gebruikt kunnen worden.

Cash Manager is ideaal voor:

Het bijhouden van contanten of één bankrekening.
Het voeren van een privéboekhouding.
Het maken van een budget met prognoses van de uitgaven en de ontwikkeling van de liquiditeit
voor meerdere jaren.
Het bijhouden van een apart bestand voor de kas dat periodiek geïmporteerd kan worden in
een bestand met het grootboek.

Cash Manager is eenvoudig te gebruiken omdat:

U boekingen kunt invoeren en aanpassen totdat alles correct is.
U een categorie aan iedere boeking voor inkomsten en uitgaven kunt toekennen en dan
automatisch het totaal per groep heeft.
U overzichten heeft waarin u kunt zien hoeveel u heeft besteed en hoeveel u over heeft.
Alle bonnen geordend, klaar om naar uw accountant te sturen.

▶ Video: How to start a Cash Manager (Cash book)  (Engelstalig)

Direct informatie
In de rekeningen- en categorieëntabellen worden de saldi van de contantenrekening en de
categorieën, inkomsten en uitgaven, direct weergegeven.
 

Na iedere transactie worden de saldi automatisch bijgewerkt en het is niet nodig overzichten te
maken om alles onder controle te houden. Ga gewoon naar de rekeningen en categorieën tabel.

Vergelijkbaar met Excel

Excel-achtige functies en commando's

De gegevens die u in de tabellen invoert zijn altijd zichtbaar en onder handbereik.
U kunt snel werken omdat u herhalende transactie kunt selecteren, kopiëren en plakken met
meerdere rijen tegelijk.
Als u een foutje maakt kunt u dit corrigeren door bewerkingen te annuleren of opnieuw te doen.

https://www.banana.ch/en/node/11389
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Voeg zoveel regels toe als u wilt, zonder beperkingen, of verwijder regels die u niet nodig heeft.
Wanneer u een fout maakte met een bedrag, een rekening, een BTW code of een beschrijving
kunt u dit in een oogwenk corrigeren met de functie Zoeken en Vervangen.
U hoeft geen formules in te voeren omdat de berekeningen onmiddellijk worden bijgewerkt en u
een contextuele weergave heeft (zoals in spreadsheets).
Alles wat u ziet kan worden afgedrukt of geëxporteerd worden naar PDF of andere formaten.
U kunt u bedrijflogo instellen om afdrukken te personaliseren.
De kolommen zijn aan te passen. U kunt ze verplaatsen, nieuwe toevoegen en hun breedte
veranderen.
Werk met het formaat dat het beste bij u past.
Geef regels een kleur om direct transacties aan te geven waar u naar moet kijken, om aan de
accountant te laten zien of die compleet gemaakt moeten worden.

Op tabellen gebaseerde structuur

Boekhouden gebruikt voornamelijk drie tabellen die op dezelfde manier worden gebruikt als de Excel-
spreadsheets maar die al volledig zijn ingesteld en geprogrammeerd met alles wat u nodig hebt om
uw boekhouding snel en veilig bij te houden.

Rekeningentabel.
U kunt alle rekeningen voor contanten, klanten, leveranciers, enz. instellen en de openingssaldi
invoeren zonder dat u deze handmatig in de transactietabel hoeft te plaatsen. U kunt meerdere
rekeningen groeperen, zoals de kas of de bank in de liquiditeitsgroep, zodat u direct de
bijgewerkte saldi kunt controleren.
Categorieëntabel.
In deze tabel stelt u alle categorieën voor inkomsten en uitgaven in; zo kent u de details van
alle uitgaven en inkomsten en kunt u evalueren waar u het meest hebt uitgegeven of welke
inkomsten de meeste winst hebben opgeleverd. In deze tabel ziet u onmiddellijk alle
bijgewerkte saldi en de kolommen met de inkomende en uitgaande mutaties. U weet meteen
hoeveel u heeft uitgegeven, hoeveel u heeft geïnd en hoeveel winst u heeft gemaakt.
Transactietabel.
Dit is de tabel waarin u al uw dagelijkse mutaties invoert. Diverse functies kunnen worden
gebruikt om snel gegevens in te voeren, van het herhalen van de opgeslagen rijen tot het
kopiëren en plakken van dezelfde transacties, en het herhalen van terugkerende bewerkingen
tot zelfs het importeren van banktransacties.

Om extra functies te gebruiken kunnen tabellen worden toegevoegd.

Budgettabel.
Financiële budgetten opstellen met de methode van inkomsten en uitgaven. Complete
liquiditeitsplanning, begroting en prognose van de resultatenrekening, projecten, segmenten
voor een of meer jaren.
BTW codes tabel.
Stel de vereiste tarieven en parameters in die moeten worden gebruikt in de transactietabel
voor de automatische berekening van de BTW en de overzichten die moeten worden ingediend
bij de belastingdienst.

Snel aan de slag met onze modellen
Begin direct met een van onze modellen, zonder tijd te verspillen. U kunt er een kiezen die geschikt is
voor uw land en voor het type bedrijf dat u voert. U kunt het aanpassen om het nog beter aan te laten
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sluiten bij uw wensen.

U kunt snel aan de slag met het aanmaken van een nieuw bestand vanuit een model.
Vele modellen verdeeld naar land en soort gebruiker, aan te passen en met
gebruikersdocumentatie .
Zoek eenvoudig modellen direct vanuit het programma en gebruik ze .

Boekhouding opzet

Stel de valuta voor uw boekhouding naar wens in, u kunt deze kiezen uit een lijst met
wereldvaluta's of zelf instellen (cryptovaluta).
Stel zelf een boekhoudperiode in, indien nodig over meerdere jaren en niet gekoppeld aan de
klassieke periode van 1 januari tot 31 december.
Koppen en boekhoudgegevens in één dialoog ingesteld, eenvoudig weer te geven.
Gebruik zoveel decimalen als u wilt, van 0 tot 27 (ingesteld wanneer de boekhouding wordt
aangemaakt) .
U kunt het aantal boekhouddecimalen gedurende het jaar veranderen zonder problemen.

Meertalig

U kunt zelf de taal voor uw boekhouding kiezen bij het aanmaken van uw bestand .
Pas de kolomkoppen naar uw wens aan.
U kunt tegelijkertijd in meerdere talen uw boekhouding doen.
Afdrukken zijn ook in meerdere talen aan te passen.

Opslaan van bestanden en gegevens

Alle gegevens worden in één enkel bestand opgeslagen waarin u alles kunt terugvinden zonder
tijdverlies.
Voor ieder jaar wordt een apart bestand aangemaakt. Alle gegevens hebben betrekking op dit
jaar en zo is er geen verwarring mogelijk.
Geef het bestand de naam die u zelf kiest.
Met één licentie kunt u een onbeperkt aantal boekhoudingen doen.
�Gegevens zijn helemaal van u zelf.
Sla uw gegevens op alle media op, computer, netwerk of cloud, of email deze . U heeft
toegang tot uw gegevens, waar u ook bent.
Tegelijkertijd toegang voor meerdere gebruikers, maar een bestand kan slechts door één
gebruiker tegelijk bewerkt worden.
Maak uw boekhouding veiliger door wachtwoordbescherming te gebruiken.

Planning-Uitvoering-Controle
Binnen hetzelfde cash manager boekhoudbestand kunt u ook uw toekomstige inkomsten en uitgaven
budgetteren, waarmee u eenvoudig de "Planning - Uitvoering - Beheer" benadering in praktijk brengt

.

Dezelfde methode voor verschillende doeleinden

Als er een onbalans is in de transacties wordt er een melding van het verschil gegeven.
Bedragen worden in de kolommen weergegeven in het formaat dat door uw computer gebruikt
wordt zodat u niet hoeft te wennen aan andere formaten waar u niet bekend mee bent.

Intuïtieve weergave van bedragen, positief voor inkomsten en negatief voor uitgaven.

https://www.banana.ch/apps/nl?category=All&combine=&country=All&langcode=nl&op=Submit&publisher=All&type=All
https://www.banana.ch/apps/nl?category=All&combine=&country=All&langcode=nl&op=Submit&publisher=All&type=All
https://www.banana.ch/apps/nl/node/9296
http://www.banana.ch/doc/nl/node/2566
http://www.banana.ch/doc/nl/node/2566
https://www.banana.ch/doc/nl/install
https://www.banana.ch/nl/node/11059
https://www.banana.ch/nl/plannen-uitvoeren-controleren
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Met één klik rapporten, journaal, rekeningkaarten en andere overzichten.
Alle afdrukken zijn naar wens aan te passen.
Weergave formaat naar keuze.

Gegevens beveiliging met blockchain technologie (volgens een gepatenteerde methode) om
maximale integriteit van uw boekhoudgegevens te garanderen .

Pas categorieën aan voor inkomsten en uitgaven

De categorieëntabel kan aangepast worden, elke categorie die u wenst kan ingevoerd worden.
U kunt hetzelfde rekeningschema gebruiken om zowel transacties in te voeren in uw
boekhouding als in uw budget.
U kunt zelf uw rekeningnummers kiezen, numeriek of alfanumeriek, tot 256 karakters lang.
In de kolom Beschrijving kunt u zelf uw beschrijving invoeren, tot 256 karakters lang.
Voer bet openingssaldo alleen in wanneer u Banana Boekhouding Plus voor de eerste keer
gebruikt. In de volgende jaren vindt de overdracht automatisch plaats.
Saldi, rekening mutaties en totalen direct weergegeven en op elk moment bijgewerkt.
Extra kolommen toevoegen voor notities, groepering of bedragen.
U hoeft de bedragen in de kolommen niet zelf op te tellen; ze worden automatisch correct
berekend en bijgewerkt U kunt daardoor kolommen met uw eigen gegevens aanmaken en
heel specifieke details zichtbaar maken.

Transacties

U kunt een enkele transactie invoeren, of samengestelde transacties in meerdere rijen, als het
om meerdere rekeningen gaat.
Bij het invoeren van uw gegevens worden reeds eerder ingevoerde teksten getoond. Met één
klik wordt de transactie ingevulde (auto-aanvullen).
Directe melding van fouten en verschillen, met de mogelijkheid om deze later te corrigeren.
Sla terugkerende boekingen op om deze weer op te roepen als ze weer voorkomen zonder dat u
ze opnieuw helemaal in hoeft te voeren.
In alle tabellen zijn standaard kolommen beschikbaar en deze kunnen naar wens weergegeven
worden.
Kolommen voor hoeveelheid en prijs voor facturering en kostenbeheersing.
Automatische nummering van documenten met oplopende nummers in meerdere reeksen
tegelijk.
Documenten zijn altijd onder handbereik door de digitale boekstukken (PDF, afbeeldingen) te
koppelen aan boekhoudbestanden en deze met één klik te openen.
Voer eigen teksten in tot 256 karakters lang, ook over meerdere regels.
Geef rijen een kleur voor transacties die u later moet controleren of corrigeren, of om ze aan de
accountant te laten zien.
Pas het formaat van rijen aan om de weergave naar uw zin aan te passen.
Voeg kolommen toe voor het invoeren van extra informatie.
Sla de ingestelde indeling van de kolommen op in weergaven om de inhoud die het
belangrijkste is voor u goed weer te geven.
Context informatie over rekeningsaldo, verschillen of fouten.
Voor de periodieke- of eindejaarsafsluitingen kunt u de "boekhouding controleren" functies
gebruiken. U bent dan in staat fouten in de saldi te vinden (bijvoorbeeld saldi op
bankafschriften en saldi in de boekhouding). U ziet meteen wat er fout is en kunt correcties
uitvoeren zodat alles weer met elkaar overeenkomt.
Gegevens importeren:

Voer sneller transacties in door deze te importeren vanuit digitale bankafschriften.
U kunt transacties importeren die in verschillende formaten worden aangeleverd door

http://www.banana.ch/doc/nl/node/3353
http://www.banana.ch/doc/nl/node/3353
http://www.banana.ch/doc/nl/node/2710
http://www.banana.ch/doc/nl/node/2710
https://www.banana.ch/apps/nl/extensions?combine=&langcode=nl&country=All&type=All&op=Indienen#
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banken .
Geïmporteerde rijen kunnen worden aangepast, aangevuld of verwijderd.
Gegevens, zoals die van facturen, kunnen ook vanuit andere software worden
geïmporteerd .

Financiële prognoses

Als u een budget moet maken kunt u dit doen met een budgettabel.
Gebruik eenvoudig dezelfde invoermethode als u al gewend bent in de Cash Manager
boekhouding.
Financiële prognoses compleet met liquiditeitsplanning.
Budget prognoses voor de categorieën van de Cash Manager boekhouding.
Als u denkt over het doen van lange termijn investeringen kunt u de automatische meerjaren
planning maken .
Maak u budget aan met het eenvoudig invoeren van transacties.
Alle functies beschikbaar in boekhouding:

Enkelvoudige transacties of transacties in meerdere regels met meer dan een
categorie.
Budget voor klanten met gebruik van kosten plaatsen.
Budget prognose voor leveranciers, BTW, kostenplaatsen en winstcentra, segmenten (in
de categorieëntabel).
Hoeveelheden en prijzen.

Budgetgetallen die beschikbaar zijn in boekhoudafdrukken:
Volledig naar wens aan te passen.
Prognoses per maand, kwartaal, halfjaar, jaar.
Vergelijk prognose met huidige situatie.

Rekening kaart met budgettransacties voor de rekening of de categorieën.

Balans en resultatenrekening

Overzichten met eind- of budgetgegevens, of beide, met een indicatie van afwijkingen.
Indeling met groepen en subgroepen naar eigen inzicht.
Bijgewerkte resultaten direct zichtbaar in de tabellen voor de contantenrekening en de
categorieën.
Afdrukken op maat:

Uw eigen logo toevoegen.
Keuze van kolommen die weergegeven worden.
Keuze van secties die weergegeven worden.
Gedetailleerd of gegroepeerd afdrukken
Afdrukken per periode.
Kolommen ingedeeld per periode (maand, kwartaal, halfjaar, jaar).
Bedragen van vorig jaar.
Vergelijking met de verwachtte waarde.
Kolommen onderverdeeld per segment.
Toegevoegde notities.
Aanpassing opslaan.

Overzicht in tabelvorm (net zoals maatwerk afdrukken maar met de gegevens in de tabel).
Naar PDF exporteren voor archivering en naar andere formaten voor gegevensverwerking.

Andere afdrukken van de boekhouding

Afdrukken van de hele inhoud van tabellen of van alleen een selectie.

https://www.banana.ch/apps/nl/extensions?combine=&langcode=nl&country=All&type=All&op=Indienen#
http://www.banana.ch/doc/nl/node/4760
http://www.banana.ch/doc/nl/node/4760
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Uw eigen logo toevoegen om documenten en afdrukken te personaliseren.
Journaal.
Rekeningkaarten met boekingen en groepen:

Met transacties voor rekeningen of voor het budget.
Per periode.
Per rekening, groep, kostenplaats of segment.
Boekhoud- of begrotingsgegevens.
Kolommenindeling aan te passen.

Naar PDF of andere formaten exporteren.

Grafieken

Contextueel, onderaan de tabel.
Verschillende formaten.
Saldo ontwikkeling voor de contantenrekening en de categorieën.
Boekhoudbedragen.
Prognoses.
Voorafgaande jaar.
Keuze in het soort grafiek.

Meer functies voor bedrijfsbeheer
Met het programma kunt u extra informatie aan de transacties toevoegen, zodat u dezelfde gegevens
kunt gebruiken voor het BTW-beheer, voor het volgen van klanten en leveranciers, het uitschrijven
van facturen, het genereren van rapporten voor projecten of bedrijfssectoren en om te voldoen aan
de verschillende vennootschaps- en belastingverplichtingen.

BTW beheer

Deze functie kan worden geactiveerd naar keuze (bij het aanmaken van een boekhouding).
Tabel met BTW codes om de verschillende BTW-percentages en -soorten aan te geven.
Alle nationale vereisten worden ondersteund.
Er kunnen ook andere soorten verkoopbelastingen mee beheerd worden (bijvoorbeeld
Amerikaanse verkoopbelasting).
Voorbeelden van het invoeren van BTW codes.
BTW teruggave functionaliteit (door de BTW code voorafgegaan door een minteken te
gebruiken).
Bruto en netto BTW berekeningen.
Automatische uitsplitsing en boeking op de aangegeven BTW categorieën.
BTW overzichten:

Per periode of compleet.
Met of zonder mutaties.
Optioneel, met totalen per percentage, BTW code, rekening.

Extensies voor BTW overzichten per land gebaseerd op de eisen van de betreffende
belastingautoriteiten (Engelstalig).

Kostenplaatsen en winstcentra

Instellen van kostenplaatsen direct in de catigorieëntabel.
Groepering op meerdere niveaus (Categorieëntabel)
Drie niveaus van kostenplaatsen en winstcentra.
Onbeperkt aantal kostenplaatsen per niveau.
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Negatieve boeking (met minteken).
Rapporten zoals uitgebreide balans voor de contantenrekening en inkomsten en uitgaven:

Saldo wordt voortdurend bijgewerkt.
Op maat gemaakte overzichten .
Rekeningkaart van alle boekingen met voortschrijdend saldo.
Contextafhankelijke grafiek.

Segmenten

Om de uitgebreide balans en resultatenrekening van een of meer bedrijfssectoren te verkrijgen
Het instellen van segmenten direct in de categorieëntabel
Groepering op meerdere niveaus (Categorieëntabel)
Tot 10 segmentniveaus.
Onbeperkt aantal segmenten per niveau.
Saldo wordt voortdurend bijgewerkt.
Rapporten zoals uitgebreide balans voor de contantenrekening en voor inkomsten en uitgaven:

Op maat gemaakte overzichten.
Rekeningkaart van alle mutaties met voortschrijdend saldo..
Contextafhankelijke grafiek.

Overzicht voor ieder segment.

Itemstabel

Voor facturen en met geïntegreerd magazijn- of artikelenbeheer.
Koppeling van items aan de mutaties in de transactietabel.
Automatisch bijgewerkte boekingen voor inkomende en uitgaande artikelen.
Begin- en eindwaarde.
Toevoegen van extra kolommen.

Controle en afsluiting

Foutrapportage en boekhouding controle

Commando om de rekeningen te controleren.
De boekhouding wordt opnieuw berekend alsof alle bewerkingen opnieuw ingevoerd worden.
Rapporteert elke foute instelling, verschil of fout.
Iedere foutmeldin is gekoppeld aan een helppagina die de oorzaken uitlegt en de oplossing
voorstelt.
Controleert of het rekeningsaldo overeenkomt met het echte saldo (contanten, bank, BTW).
Mogelijkheid om te corrigeren.

Transactie bescherming

Beveiliging van rijen.
Vergrendeling van ingevoerde boekingen met digitale gegevens certificatie techniek (Bitcoin
type).
Beveiliging met een wachtwoord.
Voldoet aan wettelijke eisen.
Gegevens sturen naar de auditor met de zekerheid dat er niet mee geknoeid kan worden.
Boekingen met een bepaalde datum ontgrendelen.

http://www.banana.ch/doc/nl/node/7218
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Afsluiting en nieuw jaar opening

Procedure om automatisch het bestand voor het nieuwe jaar aan te maken.
Overdracht van openingssaldi voor contantenrekening.
Werk aan het nieuwe jaar kan beginnen, zelfs als het vorige nog niet is afgesloten.
Commando om het eindsaldo van de contantenrekening over te dragen wanneer het vorige jaar
is afgesloten.

Gegevens exporteren en archiveren

Direct vanuit excel kopiëren en plakken.
Tabellen naar PDF en verschillende andere formaten exporteren.
Archiveren van afdrukken en boekhoudgegevens naar PDF of andere formaten.
Het boekhoudbestand op elk soort backupmedium opslaan.

Extensies en andere functies

Functies toevoegen

Nieuwe functies toevoegen.
Functies die niet langer nodig zijn verwijderen.
Overzetten van het ene type boekhouding naar het andere:

Van Cash Manager zonder BTW naar een met BTW
Van Cash Manager naar Inkomsten/Uitgaven boekhouding (met of zonder BTW)
Van Cash Manager naar Dubbel boekhouden of boekhouding met vreemde valuta (met of
zonder BTW)

Documententabel

Om afbeeldingen op te slaan (bedrijfslogo's) of tekstdocumenten (bijvoorbeeld Javascript
programma's).

Andere extra tabellen

Toevoegen van andere tabellen waarin notities of andere informatie kan worden ingevoerd.
Tabellen kunnen worden aangepast door kolommen eraan toe te voegen.

Extensies

Standaard extensies voor diverse afdrukken en andere functies .
Snel op te zoeken en te installeren.
Automatische updates.

Uitgebreide documentatie
Ieder dialoogvenster en foutmelding heeft zijn eigen documentatie bereikbaar in één klik .
Documentatie die voortdurend bijgewerkt wordt .
FAQ .
Documentatie ook in PDF formaat beschikbaar.

http://www.banana.ch/apps/nl/extensions
https://www.banana.ch/doc/nl/banana-error-details
https://www.banana.ch/doc/nl/documentatie
https://www.banana.ch/nl/node/9340
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Cash Manager Rekeningentabel

De rekeningentabel van Cash Manager bevat maar één rekening en er kunnen geen andere
rekeningen worden toegevoegd.

The columns of the Accounts table:

Groep 
Deze kolom blijft leeg.

Rekening
Voer het getal of de afkorting van de rekening die beheert moet worden (contanten, bank).

Beschrijving
Voer de beschrijving in voor de rekening.

Opening
Het invoeren van een rekeningsaldo is alleen nodig als een nieuw bestand wordt geopend of als
Banana Boekhouding software voor de eerste keer gebruikt wordt. Bij het aanmaken van een nieuw
jaar worden de saldi automatisch ingevuld.

Inkomsten
Deze geblokkeerde kolom laat het saldo zien van de transacties met inkomsten. Het saldo wordt
automatisch bijgewerkt na iedere boeking.

Uitgaven
Deze geblokkeerde kolom laat het saldo zien van de transacties met uitgaven. Het saldo wordt
automatisch bijgewerkt na iedere boeking.

Saldo
Deze geblokkeerde kolom laat het saldo zien van de transacties met inkomsten en uitgaven. Het
saldo wordt automatisch bijgewerkt na iedere boeking.
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Categorieëntabel van Cash Manager

De categorieëntabel geeft de inkomsten en uitgaven situatie weer.
U kunt naar eigen inzicht instellen:

De uitgaven- en inkomstencategorieën.
Eventueel kostenplaatsen en winstcentra.
De totalisatiegroepen.
Kijk voor meer informatie over het groepen systeem op pagina Het groepering- en
totalensysteem .

In het voorbeeld hieronder zijn drie hoofdgroepen:

Groep 4 - Totaal van alle categorieën die de groepering 4 hebben in de kolom Tel Op in (totaal
inkomsten).
Groep 3 - Totaal van alle categorieën die de groepering 3 hebben in de kolom Tel Op in (totaal
uitgaven).
Groep 00 - Het totaal van de groepen 3 en 4 (totaal inkomsten en Uitgaven) die het resultaat
bepalen voor de boekhoudperiode.

De kolommen van de Rekeningentabel:

De belangrijkste kolommen van de categorietabel worden hieronder opgesomd. De weergave van de
kolommen verandert naargelang de geselecteerde weergave.

U kunt extra systeemkolommen en uw eigen kolommen toevoegen via Gegevens → Kolommen
instellen.

Sectie

http://www.banana.ch/doc/nl/node/2629
http://www.banana.ch/doc/nl/node/2629
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Voer een ster in in de rij waarin een titel wordt ingevoerd die dan wordt overgenomen in de
uitgebreide rekening op groepen. In ons voorbeeld wordt een ster ingevoerd op de regel met de titel
Bedrijfsresultaat.

Als andere secties, zoals kostenplaatsen en winstcentra, worden gebruikt als aanvulling op inkomsten
en uitgaven, moet een er nog een ster worden ingevoerd in de kolom Secties, ook weer op de titel rij.
Zie ook de pagina Secties voor meer informatie.

Groep 
Voer een code (getal of woord) in dat identiek is aan degene ingevoerd voor iedere categorie in de
Tel Op In kolom. De totalen voor iedere categorie die hoort tot dezelfde groep van de Tel Op In
kolom worden dan opgeteld (in ons voorbeeld: Groep 4 telt de Inkomsten categorieën op en groep 3
de Uitgaven categorieën).

Categorie
Voer het getal of de afkorting van de categorie die het type inkomsten of uitgaven identificeert.

Beschrijving
Voer de beschrijving in voor de categorie. Deze beschrijving wordt automatisch overgenomen uit de
kolom Categoriebeschrijving van de tabel Records (indien weergegeven).

Tel Op In
Iedere Categorie heeft een code waarmee de totalen voor de betreffende Groep bepaald worden (in
ons voorbeeld alle categorieën voor Inkomsten, in de Tel Op in kolom, hebben het groepsnummer 4
omdat deze worden opgeteld in Groep 4, Totale Inkomsten).

Inkomsten
Deze geblokkeerde kolom laat het saldo zien van de transacties met inkomsten. Het saldo wordt
automatisch bijgewerkt na iedere boeking.

Uitgaven
Deze geblokkeerde kolom laat het saldo zien van de transacties met uitgaven. Het saldo wordt
automatisch bijgewerkt na iedere boeking.

Saldo
Deze geblokkeerde kolom laat het saldo zien van de transacties met inkomsten en uitgaven. Het
saldo wordt automatisch bijgewerkt na iedere boeking.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 521

Budgettabel van Cash Manager

De financiële planning wordt gedaan in de Budgettabel.

Budgettransacties worden ingevoerd, zoals in de transactietabel, alsof ze normale transacties zijn.
U kunt ook Hoeveelheid en prijs en Formules voor berekeningen invoeren.

Zie voor meer informatie over de budgettabel de pagina Budgettabel.
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Transacties

De transacties worden ingevoerd in de Transactiestabel.

Voor meer informatie over de kolommen in de Transactiestabel van het Kasboek zie de pagina
Transacties (Inkomsten & Uitgaven boekhouding).
Voer het volgende in voor iedere boeking:

de datum
het document nummer
de beschrijving
het bedrag voor inkomsten of uitgaven
de categorie uit de Categorieëntabel die bij de inkomsten of uitgaven hoort
als de transactie onderhevig is aan BTW voer dan de BTW-code in de BTW-code kolom in.
De BTW-codes staan in de Tabel BTW Codes.

Sneller transacties invoeren:
Om het invoeren van de transacties sneller te doen verlopen, kunt u gebruik maken van:

de functie van het Auto-aanvullen bij het invoeren van gegevens (Smartfill); deze maakt het
mogelijk automatisch gegevens, die reeds eerder zijn ingevoerd, op te halen
de functie van de Terugkerende transacties die het mogelijk maakt de terugkerende transacties
in een daarvoor bestemde tabel op te slaan
Het importeren van transacties van een bank-rekeningafschrift.

Voorbeelden van transacties zonder BTW

Voorbeelden van transacties met BTW
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Categorie kaart
Klik eenmaal op het blauwe pijltje dat in de rechterbovenhoek van de cel met het categorienummer
verschijnt om de boekingen voor een categorie weer te geven.

De weergave van de transacties in de categoriekaart lijkt erg op die van de Transactiestabel.
Wanneer u nieuwe transacties invoert of veranderingen maakt (altijd in de Transactiestabel) kunt u de
categorie- of groepkaart bijwerken door op het Tabel vernieuwen teken (ronde blauwe pijl)
aan de rechterbovenkant van het scherm te klikken.
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Afdrukken

Onmiddelijke informatie
Rekening-saldi, inkomsten en uitgaven kunnen direct bekeken worden in de Rekeningen- en
Categorieën tabellen.
Na het invoeren van elke transactie worden de saldi automatisch bijgewerkt. Het is niet nodig een
rapport af te drukken om de situatie onder controle te hebben, u kunt gewoon de Rekeningen- of
Categorieën tabel consulteren.

Geavanceerde afdrukken
Alle afdruktaken worden uitgevoerd vanuit het Rapporten menu, waar de verschillende functies voor
de afdrukken zich bevinden:
 

Journaal - commando Journaal op periode. U kunt de gehele, of een specifieke, periode
opvragen.

Rekening-/Categorie kaarten commando. U kunt alle kaarten opvragen of een selectie
aangeven.
Voer de gewenste periode in in het tabblad Periode; in het tabblad Opties kunt u verschillende
opties aktiveren die al dan niet in de afdruk opgenomen moeten worden. Configuraties voor de
afdruk kunnen opgeslagen worden via het tabblad Aanpassing zodat ze op elk gewenst moment
opgevraagd kunnen worden zonder dat u opnieuw alle instellingen opnieuw moet invoeren.

Uitgebreide rekening commando.  De Uitgebreide rekening kan ook voor een specifieke periode
gedefiniëerd worden en verschillende opties kunnen opgenomen worden; er kunnen ook
verschillende composities aangemaakt worden.

Uitgebreide rekening op groepen commando. De Uitgebreide rekening op groepen kan ook voor
een specifieke periode gedefiniëerd worden en verschillende opties kunnen opgenomen
worden; er kunnen ook verschillende aanpassingen/composities aangemaakt worden.

Boekhoudingsoverzichten commando. Het rapport met de gevraagde opties wordt weergegeven
in de Rekeningen tabel. U kunt rapporten per periode aanmaken, met of zonder vergelijking
met vorige jaren of vorige periodes; elke periode kan onderverdelingen bevatten en ook hier
kunt u composities opslaan.

Afdrukvoorbeeld van een Uitgebreide Rekening op Groepen
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Cash Manager rekening- / categoriekaart

De rekening- of categoriekaart wordt aangemaakt vanuit het grootboek en geeft u een complete lijst
van de boekhoudmutaties van de betreffende rekening, categorie, kostenplaats, segment of groep.

De rekeningkaart openen
Er zijn twee manieren om een rekening- of categoriekaart te openen en af te drukken.

Eerste methode

Deze methode wordt aanbevolen als u verschillende rekening- of categoriekaarten wilt zien of
afdrukken.

Klik in het menu op Rapporten → Rekening-/Categoriekaarten...

Er verschijnt een dialoogvenster met de volgende secties:

Rekening/Categorie
Periode
Opties
Aanpassing

Klik voor gedetailleerde informatie over de secties op de betreffende link.

http://www.banana.ch/doc/nl/node/7217
http://www.banana.ch/doc/nl/node/2729
http://www.banana.ch/doc/nl/node/2604
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Tweede methode

Met deze methode kunt u één enkele kaart vanuit een tabel openen.

Klik op het icoontje dat verschijnt als u de cel selecteert die de rekening, de categorie, of het
groepsnummer bevat.

De rekeningkaart bijwerken
De rekening- of categoriekaart is tijdelijk en wordt berekend op het moment van het verzoek. Als er
transacties zijn veranderd of toegevoegd in de transactietabel wordt de rekeningkaart niet
tegelijkertijd bijgewerkt.

Om de rekeningkaart na veranderingen bij te werken is het nodig het commando
Rekening/Categoriekaart opnieuw te gebruiken, of, als de rekeningkaart nog geopend is, op het
symbooltje, dat in de afbeelding hieronder getoond wordt, te klikken.

Let op

In de rekening-, categorie- of groepenkaart is het niet mogelijk gegevens te veranderen. Om dit te
doen kunt u op het rijnummer dubbelklikken waardoor het programma naar de overeenkomstige rij
van de transactie- of budgettabel gaat en daar een verandering maken.
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De kolom Geselecteerde rekening
In de kolom Geselecteerde Rekening, die zichtbaar gemaakt kan worden vanaf elke rekeningkaart
met Gegevens → Kolommen instellen, wordt de rekening waarop de transactie plaatsvond
weergegeven.
Als u een rekeningkaart heeft gemaakt van een of meer rekeningen, categorieën, groepen en
segmenten ziet u hiermee precies welke rekening wordt gebruikt.

Kaarten van groepen of klassen
In de rekeningkaart van een groep of klasse worden alle transacties van de rekeningen die tot een
geselecteerde groep of klasse horen opnieuw gegroepeerd.
De rekeningen of categorieën van de groep of klasse kunnen worden weergegeven door de kolom
Geselecteerde Rekening zichtbaar te maken.

Budget rekeningkaart
Als er eenmaal budget transactie zijn ingevoerd in de budgettabel is het mogelijk om rekening- of
groepskaarten te maken van het budget:

menu Rapporten → Rekening / Categoriekaarten → kies Budget transacties.
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Het grootboek (rekeningkaarten) afdrukken
Om de kaarten af te drukken:

menu Rapporten → Rekeningkaarten
Door het Filter te gebruiken is het mogelijk automatisch alle rekeningkaarten te selecteren die
afgedrukt moeten worden of een gedeelte (bijvoorbeeld alleen rekeningen, kostenplaatsen of
segmenten).
In de diverse secties Periode, Opties, Aanpassing worden de gewenste functies geactiveerd
(bijvoorbeeld periode, een rekening per pagina ....).
Bevestig met OK, na het instellen van de gewenste opties.

De geselecteerde rekeningkaarten verschijnen op het scherm. Om ze af te drukken klik op menu
Bestand → Afdrukken.

Een logo toevoegen aan de rekeningkaarten
Vanaf Banana 9, is het mogelijk ook een logo toe te voegen aan de afdrukken van de
rekeningkaarten.

Ga na het aanmaken van de rekeningkaart als volgt te werk:

menu Rapporten → Rekening kaarten
menu Bestand → Afdrukvoorbeeld.
Geef uw logo aan in het dialoogvenster dat geopend wordt (in plaats van geen).

Gedetailleerde informatie is te vinden op de pagina Logo-instelling.
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De instellingen opslaan
Als u regelmatig de kaarten van bepaalde rekeningen moet afdrukken, bijvoorbeeld alles van de
verkopen, is het handig om een speciale aanpassing aan te maken:

menu Rapporten → Rekening kaarten → sectie Aanpassing
Klik op de knop Nieuw
Geef de naam aan in de beschrijving, bijvoorbeeld "Rekening verkopen"
Selecteer de rekeningen die u wilt afdrukken
In het menu Bestand → Pagina instellen  kunt u de marges en andere pagina instellingen
bepalen.

Telkens wanneer u de rekeningen moet afdrukken kiest u de aanpassing die u heeft aangemaakt.

http://www.banana.ch/doc/nl/node/2605
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Journaal Cash Manager

Journaal
Zoals in alle Banana Boekhouding applicaties worden de boekingen ingevoerd in de Transactiestabel.
Als u het journaal (de lijst van alle transacties) wilt afdrukken kunt u dat doen op verschillende
manieren:

Plaats uzelf in de Transactiestabel en klik op het icoon Afdrukvoorbeeld, vervolgens op het
icoon Afdrukken.
Vanuit de Transactiestabel, selecteer van het menu Bestand → Afdrukvoorbeeld → icoon
Afdrukken.
Vanuit het menu Rapporten → Journaal op periode ...

Journaal op periode
Banana Boekhouding Plus biedt, via het menu Rapporten → Journaal op periode..., de mogelijkheid om
het journaal af te drukken met de mutaties van de hele periode of van een periode die bepaald wordt
door de ingevoerde begin- en eindtijd.

De informatie over de sectie Periode is beschikbaar op de pagina Periode van de gemeenschappelijke
functies.
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In de sectie Sorteringskolom kunt u de kolom kiezen waarop de gegevens gesorteerd worden bij het
afdrukken van het journaal.
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UItgebreide rekening

De informatie over de uItgebreide rekening is identiek aan die van de  UItgebreide rekening van de
inkomsten / uitgaven boekhouding.
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Uitgebreide rekening op groepen

De informatie over de Uitgebreide rekening op groepen is identiek aan die van de Uitgebreide
rekening op groepen van de inkomsten / uitgaven boekhouding.
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Boekhoudingsoverzicht

De informatie in Cash Manager Boekhoudingsoverzicht is identiek aan die van het Inkomsten /
UItgaven Boekhoudingsoverzicht .

http://www.banana.ch/doc/nl/node/2770
http://www.banana.ch/doc/nl/node/2770
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BTW- en omzetbelastingoverzicht (alleen met
BTW optie)

Informatie over het BTW overzicht is beschikbaar op pagina BTW overzicht.
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Boekhoudkundige Functies
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Klantenbeheer

Met klantbeheer kunt u klantgegevens vastleggen, organiseren en beheren en kunt u transacties en
betalingen van klanten, vervaldatums voor betalingen en contactgegevens bijhouden. U kunt
betalingen van klanten bijhouden, de betaalstatus van uitgegeven facturen bijwerken en facturen
invoeren en afdrukken.

Klanttransacties boeken
De Transactietabel is het hart van Banana Boekhouding en wordt gebruikt om alle transacties vast te
leggen, inclusief klanttransacties, door simpelweg de klantrekening in te voeren. U werkt snel omdat
u klanttransacties kunt selecteren, kopiëren en plakken die al eerder zijn ingevoerd. Als u fouten
maakt, kunt u deze corrigeren, zodat u gemakkelijk kunt boeken:

Een verstuurde factuur boeken.
Een betaalde factuur boeken.
Credit nota's.
Facturen maken.

Er zijn kolommen voor het invoeren van informatie, zoals:

De datum, vervaldatum, de verwachte datum en de betaaldatum van de transactie.
Het factuurnummer.
De debet- en creditrekening waar de klant- en tegenrekening aangegeven kunnen worden.
Het bedrag.
De BTW codes voor de automatische berekening van BTW.
Koppelingen naar digitale documenten (bijvoorbeeld de factuur die naar de klant wordt
gestuurd of bonnen als PDF bestanden).

Klantrekeningen
Klantrekeningen worden gebruikt om alle transacties te boeken die betrekking hebben op de klanten
van een bedrijf.

De belangrijkste functies van klantenrekeningen zijn:

Een rekening te maken voor iedere klant en alle transacties bij te houden.
De facturen die naar iedere klant gestuurd worden te boeken.
De klantbetalingen te boeken en te koppelen aan de verstuurde facturen.

In Banana Boekhouding:



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 539

Klantrekeningen en adresen (voornaam, achternaam, bedrijfsnaam, adres, taal van de klant,
BTW nummer, etc.) worden ingesteld in de rekeningentabel.
Mutaties op de klantrekeningen worden ingevoerd in de transactietabel.
Na iedere invoer worden alle saldi van de klantenrekeningen (rekeningentabel) automatisch
bijgewerkt en daarmee heeft u meteen een overzicht over de uitstaande facturen.

Verstuurde facturen boeken
De factuur wordt gebruikt voor boekhoud- en belastingdoeleinden, omdat u hiermee de inkomsten en
uitgaven van uw bedrijf nauwkeurig kunt registreren en verkoop- of inkoopbelasting kunt berekenen.

Als u facturen verzendt in Word, Excel of andere programma's, kunt u de uitgifte vastleggen in de
boekhouding zodat u weet wat de klant verschuldigd is en, indien nodig, aanmaningen kunt sturen.

In Banana Boekhouding, worden de facturen geboekt in de transactietabel door in te voeren:

De datum en de beschrijving
Een factuurnummer
In de debet rekening de rekening van de klant en in de credit rekening de inkomsten
De BTW code voor de verkoop of de verleende dienst. De berekeningen worden automatisch
gedaan en BTW bedragen automatisch ingevuld.

Wanneer de factuur verstuurd moet worden maakt het programma deze automatisch aan en drukt
hem af.

Facturen maken en afdrukken
U kunt direct in de transactietabel ook eenvoudig transacties invoeren om facturen te maken.

Door de debet- en creditrekening in te voeren, kunt u niet alleen de factuur afdrukken, maar hebt u
tegelijkertijd de boeking van de factuur in het boekhoudbestand.
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Vanuit het menu, Rapporten > Klanten > Facturen afdrukken kunt u:

De factuur bekijken en afdrukken.
Het afdrukformaat  kiezen en andere informatie instellen om de afdruk aan te passen.

Met het Advanced  plan is meer personalisatie mogelijk.

Geïnde facturen boeken
In Banana Boekhouding kunnen geïnde facturen op een van de volgende manieren geboekt worden in
de transactietabel:

Handmatig:
Voer de datum en beschrijving in
Door in de kolom Factuur het klantenrekeningnummer in te voeren verschijnt een uitklap
menu met de openstaande facturen. Selecteer de betaalde factuur en druk op Enter. Het
programma voert automatisch de klantenrekening in de creditkolom in en het bedrag van
de factuur. Voer daarna eenvoudig de contantenrekening in de debetkolom in om de
transactie te completeren.

Gegevens importeren vanuit bankafschriften met gebruik van Regels
Het programma importeert gegevens vanuit ISO 20022 bankafschriften en door Regels te
gebruiken voert het programma de complete transactie in, met alle gegevens, zonder dat
handmatige actie nodig is.

Uitstaande facturen

Openstaande klantenfacturen zijn uitgegeven facturen die openstaan omdat de klant nog niet volledig
heeft betaald.

https://www.banana.ch/apps/nl/node/9034
http://www.banana.ch/nl/buy
https://www.banana.ch/doc/nl/rules
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Openstaande klantenfacturen kunnen worden beheerd met een grootboek dat verstuurde facturen,
vervaldata en ontvangen betalingen bijhoudt. Op deze manier kan de verkoper de financiële situatie
van iedere klant in de gaten houden en betaalherinneringen sturen wanneer facturen te lang open
blijven staan.

Het is belangrijk om op te merken dat openstaande facturen aan klanten de liquiditeit van het bedrijf
van de verkoper kunnen beïnvloeden, omdat het geld dat vastligt in deze facturen nog niet is geïnd.

Banana Boekhouding genereert automatisch een overzicht met openstaande facturen waarin u direct
kunt zien welke facturen nog openstaan en van welke klant, evenals het totale bedrag aan
openstaande facturen.

Er zijn twee soorten overzichten:

Open facturen per klant, waarin alle open facturen voor iedere klant worden weergegeven.1.
Open facturen per vervaldatum, waarin alle open facturen worden weergegeven op2.
volgorde van vervaldatum.

De vervaldatum van een factuur kan op verschillende manieren worden ingesteld. Meer informatie
kan woden gevonden op pagina Vervaldata en betalingsvoorwaarden.

Rekeningkaart

Rekeningkaarten zijn documenten die in de boekhouding worden gebruikt om de financiële
transacties van een bedrijf vast te leggen. Elke kaart vertegenwoordigt een specifieke rekening in het
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grootboek van het bedrijf en bevat gedetailleerde informatie over de transacties met betrekking tot
die rekening, zoals de datum van de financiële transactie, het type transactie, het bedrag en de
beschrijving van de transactie.

In Banana Boekhouding produceert het programma, op basis van de gegevens ingevoerd in de
transactietabel, automatisch de rekeningkaart voor iedere klant, waarin het beginsaldo, alle
transacties en het eindsaldo worden getoond. U kunt de rekeningkaart ook per periode maken.

Herinneringen
Betalingsherinneringen worden gebruikt om klanten te vragen achterstallige of openstaande facturen
te betalen.

Met de functie betalingsherinneringen versnelt u het betalingsproces van klanten, vermindert u
vertragingen en beheert u tegelijkertijd effectief de cashflow.

Banana Boekhouding biedt functies om:

Achterstallige of openstaande facturen te identificeren.
Betalingsherinneringen te maken.
Betalingsherinneringen te personaliseren.

In Banana Boekhouding Plus kunt u betalingsherinneringen op twee manieren afdrukken:

Met Betalingsherinneringen afdrukken
Druk de herinneringen samenvatting af (lijst van openstaande facturen).
Druk facturen af zonder betaalstrook.
Beperkte mogelijkheid tot personaliseren.
Functie beschikbaar in Banana Boekhouding Plus - elk plan (maar niet in de beperkingen
van het Free plan).

Met Betalingsherinneringen afdrukken met de dialoog Facturen afdrukken
Afdrukken met betaalstrook.
Personalisatie van het uiterlijik.
Hiervoor is de versie Banana Boekhouding Plus Dev-Channel  nodig en het Advanced
plan.

http://www.banana.ch/doc/nl/node/8296
http://www.banana.ch/doc/nl/node/9997
http://www.banana.ch/nl/insiderprogram
https://www.banana.ch/nl/advanced
https://www.banana.ch/nl/advanced
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Creditnota's

Een creditnota is een boekhouddocument dat gebruikt wordt om een reeds gestuurde factuur te
corrigeren of te annuleren. Dit kan gedaan worden om een aantal redenen:

Teruggave van een teveel betaald bedrag
Korting op de prijs van een product or dienst
Producten retour
Correctie van of een foutieve factuur

In Banana Boekhouding verwerkt u creditnota's in de transactietabel door de inkomstenrekening in te
voeren in de debetrekening en de klantenrekening in de creditrekening; de BTW code moet worden
ingevoerd met een minteken ervoor, zodat het BTW bedrag tegelijkertijd wordt teruggeboekt.

Het programma gebruikt de boeking van de credit nota om automatisch een afdruk van de creditnota
 te maken.

Het instellen en gebruiken van de klantgegevens en
facturering functies

De boekhouding instellen op het factuurstelsel of1.
De boekhouding in stellen op het kasstelsel.2.
Klantgegevens instellen.3.
De transactietabel instellen en facturen invoeren.4.

http://www.banana.ch/doc/nl/node/8295
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Overzichten van uitstaande, vervallen en verstuurde facturen.5.
Facturen aanmaken.6.

Omerkingen
Vreemde valuta boekhoudingen: Rapporten worden gebaseerd op de rekening valuta saldi;
mogelijke wisselkoersafwijkingen worden niet meegenomen.
In de tabel Uitgegeven facturen worden ook de boekingen van wisselkoersverschillen
weergegeven, terwijl in andere afdrukken alleen de valuta van de klant wordt gebruikt.

Voorbeeld bestand
Klanten en leveranciers

Klantenregister en controle van openstaande facturen
Vanuit de boekhouding kunt u direct:

Klantrekeningen aanmaken, met de bijbehorende adressen en andere klantgegevens.
Aan de transacties toevoegen:

de gegevens die bij de gestuurde facturen horen (factuurnummer, klant, bedrag,
vervaldatum).
de gegevens die bij de betaalde facturen horen en bij het sturen van credit nota's, als die
er zijn.

De lijst van uw geplande betalingen ophalen.

Andere functies die beschikbaar zijn:

Facturen afdrukken
Overzichten afdrukken
Betalingsherinneringen
Credit nota's

https://www.banana.ch/apps/nl/node/8820
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Adressen | Klanten / Leveranciers register |
Leden

In de weergave Adres van de rekeningentabel bevinden zich kolommen om de adressen van klanten,
leveranciers of leden te beheren.
Adresgegevens zijn essentieel voor het beheer van rekeningen, herinneringen, bonnen en betalingen.

Als de weergave Adres en dus ook de kolommen voor het beheer van adresgegevens ontbreken in de
rekeningentabel kunt u deze via het menu als volgt toevoegen:

Extra → Nieuwe functies toevoegen/verwijderen → Adreskolommen toevoegen in de
Rekeningen  tabel.

Dit commando voegt in de rekeningentabel toe:

De Adres weergave die de kolommen weergeeft voor het opslaan van adresgegevens.

Gebruik het commando kolommen instellen om de weergave of de volgorde van de kolommen te
veranderen.

De kolommen van de weergave Adres
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Voorvoegsel

De aanspreektitel (Mw,, Dhr., Dr. etc.).

Voornaam

De voornaam van de klant, leverancier of het lid.

Achternaam

De achternaam van de klant, leverancier of het lid.

Organisatie

De naam van het bedrijf of de vereniging.

Straat

De straat waar de klant, leverancier of het lid gevestigd is of woont.

Adres extra

Kolom om andere adresgegevens in te voeren zoals postbus, of een erg lang adres.

Postcode

De postcode.

Plaats

De naam van de stad van de klant, leverancier of het lid.

Land

Het land waarin de stad ligt.

Landcode

De code voor het land.
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Taal

U kunt voor iedere klant-, leverancier- of ledenrekening de taal instellen. Hiermee kunt u de
documenten (bijvoorbeeld facturen) in hun eigen taal bekijken en afdrukken.
Geef de codes als volgt aan:

de - voor Duits
fr - voor Frans
it - voor Italiaans
en - voor Engels
es - voor Spaans
nl - voor Nederlands
zh - voor Chinees
pt - voor Portugees
ru - voor Russisch

Vaste telefoon

Nummer van de vaste telefoon

Mobiele telefoon

Mobiele telefoon nummer

Fax

Fax nummer

Email werk

E-mail adres

www

Websiteadres van de klant, leverancier of lid

Geboorte

De geboortedatum van de klant, leverancier of lid

Dagen

Aantal dagen waarbinnen de incasso en de betaling gedaan moet zijn

Limiet

Bij creditering wordt de kredietlimiet vermeld, of de debetlimiet als het om een leverancier gaat.

Bank

De naam van de bank van de klant, leverancier of lid
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IBAN

Het IBAN nummer van de klant, leverancier of lid

Bank clearing

De identificatie code van de bank van de klant, leverancier of lid
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Klantenbeheer met de methode van het
factuurstelsel

Introductie
Met Banana boekhouding kunt u de facturen van klanten beheren met de methode van het factuur- of
het kasstelsel. Gedetailleerde uitleg is te vinden op pagina Boekhouden met de methode van het
factuur- of het kasstelsel .

Hieronder wordt uitgelegd hoe u voor elke klant een aparte rekening kunt opzetten en een groep voor
klanten, zodat u een lijst met afzonderlijke facturen per klant beschikbaar hebt.

Indien u slechts enkele facturen heeft en geen detail per klant wilt bijhouden, kunt u ook één rekening
aanhouden om alle klantenfacturen te registreren. De lijst met facturen geldt dan voor alle klanten en
niet voor één enkele klant.

Instellen het klantenregister
Het klantenregister met zijn rekeningen en/of groepen wordt aan het einde van het rekeningschema
toegevoegd in een aparte sectie. 

De volgende gegevens moeten worden toegevoegd om het register aan te maken:

Een * sectie (kop) (zie Secties)
Een 01 sectie voor de Klanten (zie Secties)
De Klantenrekeningen die nodig zijn (zie Een nieuwe rekening toevoegen). Iedere klant is een
aparte rij in het rekeningschema met zijn eigen rekeningnummer. Het rekeningnummer kan vrij
worden gekozen (zie Rekeningen), aanbevolen wordt echter alleen cijfers te gebruiken, met
name voor het betalingsbeheer.
Een groep die alle klantenrekeningen groepeert
Deze groep wordt op zijn beurt gegroepeerd in een groep die aanwezig is in de Activa.

Het Totaal Klanten wordt opgeteld in de groep 110A van de Gr kolom.
Dezelfde code of getal dat gebruikt wordt voor de Gr (110A) moet gebruikt worden in de Activa
Groep kolom in de rij die overeenkomt met Totaal Klanten.
Het groepsnummer kan vrij worden gekozen (zie Groepen).

Een verzonden factuur boeken
De verstuurde factuur wordt geboekt door de volgende gegevens in de betreffende kolommen in te
voeren:

Datum van de factuur en een documentnummer
Factuurnummer - Het is erg belangrijk om het factuurnummer in de kolom Factuur in te voeren
omdat dit wordt gebruikt om de verschillende klantoverzichten te automatiseren en om

https://www.banana.ch/nl/node/10968
https://www.banana.ch/nl/node/10968
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automatisch de openstaande factuur af te sluiten bij het boeken van de betaling.
Klantenrekening in kolom Debet en inkomstenrekening in kolom Credit
De BTW code voor de verkopen.

Een betaling boeken
Er zijn twee manieren om de betaling van een klantenfactuur te boeken:

Handmatig boeken van de betaling van de klantenfactuur.1.
Automatische boeking door gegevens te importeren vanuit bankafschriften in ISO 20022 format2.

.

De betaalde factuur wordt geboekt door de volgende gegevens in de betreffende kolommen in te
voeren:

Voer in de Datum kolom de transactie datum in.
Voer in de Type kolom 11 in (betaling door klant).
Voer in de Factuur kolom het factuurnummer van de betaalde factuur in.

Met een dubbele klik op de cel laat het programma een lijst van alle open facturen zien.
Als een alternatief kunt u ook op F2 drukken. Als F2 niet werkt moet u uw
klanten/leveranciers instellingen activeren door de groep van uw klantenregister in te
voeren via menu Rapporten → Klanten → Instellingen.
Kies het nummer van de betaalde factuur. Het programma voert automatisch in:

In de kolom Beschrijving, de betalingsbeschrijving
In de kolom Credit rekening, het klantenrekeningnummer
In de kolom Bedrag, het factuurbedrag
Als het ingevoerde bedrag niet inclusief BTW is en de klanten zijn ingesteld als
kostenplaatsen, moet u de kostenplaatsen correct configureren om het bedrag met
BTW te kunnen gebruiken in Bestand en boekhoud eigenschappen (basisgegevens),
tabblad BTW. Zie ook BTW-bedrag met kosten- en winstcentra.
In de kolom Debet moet u de tegenrekening handmatig invoeren (de bankrekening
waarop het bedrag is bijgeschreven).

Een creditnota boeken
Om een bedrag in mindering te krijgen op de originele factuur moet hetzelfde factuurnummer
gebruikt worden.

Als het aanpassingsdocument (bijvoorbeeld een creditnota) een andere nummer heeft dat
beschikbaar moet blijven, voer dit dan in een andere kolom in, bijvoorbeeld DocOrigineel.
Voer de gegevens in voor de columns Datum, Doc., Origineel Doc, Beschrijving
De BTW code moet worden voorafgegaan door een minteken "-" zodat de BTW operatie wordt
omgekeerd of gebruik een speciale BTW code voor debetnota's (ingesteld in de BTW code
tabel).

Note: om een debetnota die naar de klant gestuurd moet worden af te drukken moet in de kolom
Type 12 ingevoerd worden. Zie Een creditnota invoeren.

http://www.banana.ch/doc/nl/node/8785
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Klantenbeheer met de methode van het
kasstelsel

Instellen van het klantenregister met kostenplaatsen
Het is mogelijk het klanten/leveranciers register te beheren als kostenplaatsen (zie ook de pagina
Kostenplaatsen en Winstcentra). Een gedetailleerde toelichting is beschikbaar op pagina Boekhouding
met het factuurstelsel of het kasstelsel .

we raden u aan de KP3 kostenplaatsen te gebruiken (degene waar de rekeningen worden
voorafgegaan door een puntkomma ";")
Stel de klanten groep in via Rapporten → Klanten → Instellingen.

Door deze opzet verschijnen verschijnen de kostenplaatsensaldi voor klanten en leveranciers niet in
de Balans maar u beschikt wel over alle gegevens en overzichten voor intern gebruik.

Transacties

Bij het versturen van de factuur boekt u alleen het bedrag en de klantenrekening in de kostenplaats
kolom. In detail:

Datum en documentnummer indien beschikbaar.
Factuurnummer.
Bruto bedrag zonder BTW code. De BTW wordt bij het kasstelsel geboekt als de factuur betaald
wordt.
Klantenrekening in kolom KP3 (";").
Om de saldi op de klantenrekening correct weer te geven moet u als volgt te werk gaan:

wanneer het versturen van de factuur wordt geboekt wordt de klantenrekening normaal
ingevoerd in kolom KP3 (bijvoorbeeld 10001).
wanneer u de ontvangen betaling voor de factuur boekt in kolom KP3 moet u de
klantenrekening invoeren met een minteken (bijvoorbeeld -10001).

Meer informatie is te vinden op de pagina Clients and suppliers with VAT, using the Cash principle
(Engelstalig).

https://www.banana.ch/nl/node/10968
https://www.banana.ch/nl/node/10968
https://www.banana.ch/en/node/10879
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Klanteninstellingen

Om de opties in het Klantenmenu te activeren moet u de klantengroep instellen via menu Rapporten
→ Klanten → Instellingen.
Als er geen groep wordt aangegeven in de instellingen van het Klanten menu zijn alle functies
uitgeschakeld.

De volgende dialogen zijn identiek voor zowel de functionaliteit van de klanten als van de
leveranciers.
Hieronder worden de functies met betrekking tot de klanten uitgelegd, maar deze zijn ook van
toepassingen op die van leveranciers.

Algemeen
Groep of rekening

Kies de algemene groep of rekening die de Klanten- of Leverancierslijst bevat. De groep of rekening
moet al aanwezig zijn in de Rekeningentabel.

Zie voor meer details de pagina's:

Instellen van het Klantenregister en Instellen van het Leveranciersregister (facturatie methode).
Instellen van het Klantenregister en Instellen van het Leveranciersregister (kas methode).

Betalingstermijn van de facturen (in dagen)

Om de betalingstermijn te berekenen, gebruikt het programma in volgorde van prioriteit:

De vervaldatum, als u deze in de transactie hebt ingevoerd.
Indien er meerdere data zijn voor hetzelfde factuurnummer, kiest het programma de meest
recente datum.
Indien het aantal dagen wordt vermeld in de kolom BetalingstermijnInDagen van de
Rekeningen-tabel, wordt de datum van de transactie verhoogd met het aantal dagen.
De datum van de transactie wordt verhoogd met het aantal dagen dat in de instellingen dialoog
is aangegeven.
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Transacties van vorige opnemen (jaren)

Indien 0: het programma geeft geen facturen van het voorgaande jaar weer, maar alleen de
openingssaldi van de klantenrekening
Indien 1: het programma neemt ook de facturen van het voorgaande jaar in de klantenkaart op
Indien 2 of meer: het programma neemt ook de facturen van de jaren daarvoor in de
klantenkaart op.

Geavanceerd

Koppeling naar het factuur document

U kunt de facturen opslaan (pdf, doc of andere) en de link invoeren in Koppeling naar het factuur-
document. Als u het factuurnummer aangeeft in de kolom Factuur van de Transactietabel, opent
het programma het document , zodat u toegang krijgt tot de inhoud.

De koppeling kan bevatten:

De XML naam <DocInvoice> of de naam van een andere kolom tussen <> (groter dan, kleiner
dan tekens).
Als u "<DocInvoice>.pdf" gebruikt en u staat op een rij met factuurnummer 100 dan probeert
het programma het bestand "100.pdf" te openen. U kunt de bestandsnaam ook vooraf laten
gaan door een mapnaam.
U kunt elke bestandsextensie gebruiken. De extensie moet echter wel worden opgenomen in de
lijst of extensies die als veilig worden beschouwd. (Extra-Programma opties-Advanced).
Het is ook mogelijk een pad aan te geven voor de veldnaam die de naam bevat van het
document dat moet worden geopend.
Met de koppeling "c:\temp\<DocInvoice>.pdf" en factuurnummer 100 opent het programma het
bestand C:\temp\100.pdf.
De naam van de map is relatief t.o.v. de map waar het bestand zit.

Een factuurdocument openen
Plaats uzelf in de Transactie-tabel, in de kolom Factuur, in de cel waar de link van het te openen
document is geplaatst.
Gebruik de rechter muisknop om het contextmenu te openen
Gebruik het commando "Koppeling naar factuur openen"
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Diverse verrichtingen

Op deze pagina leggen we enkele belangrijke functies en instellingen uit waarmee u uw klanten
optimaal kunt beheren, het werk kunt versnellen en correcte rapporten kunt maken.

De factuurkolom weergeven in de Transactiestabel
Automatisch aanvullen van factuurgegevens
Factuur-rijen ophalen en Koppeling naar factuur openen commando's
Activeren van de Addreskolommen (optioneel)
Instellen van de vervaldatum voor de facturen
Instellen van de klanteninstellingen

De factuurkolom weergeven in de Transactietabel
Als de kolom Factuur niet wordt weergegeven in de transactietabel kan deze zichtbaar gemaakt
worden via het commando Menu Gegevens → Kolommen instellen → Kolom Factuur.

Het is erg belangrijk om het factuurnummer in te voeren om het programma automatisch de
verschillende overzichten te laten maken en voor het vereffenen van het bedrag in de
klantenrekening als de factuur wordt betaald.

Haal de factuur op die als pdf opgeslagen is door op de cel in de kolom Factuur te klikken.

Automatisch aanvullen van factuurgegevens
Wanneer een betaling wordt geboekt of een uitgereikte factuur wordt gecorrigeerd doet het
programma suggesties om de transactie automatisch aan te vullen. Ga als volgt te werk:
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Maak een nieuwe transactie rij aan en voer de datum en een eventueel documentnummer in.
In de kolom Factuur druk op F2;

De lijst met openstaande facturen verschijnt. Wanneer u een factuurnummer of
rekeningnummer intikt wordt de lijst gefilterd op de ingevoerde tekst.
Kies de gewenste factuur en druk op Enter. Het programma vult de transactie
automatisch aan met de beschrijving, debet of credit rekening en het bedrag. Uiteraard
kunnen deze gegevens handmatig veranderd worden.

Los van de datum is het mogelijk om de Klantrekening aan te geven voordat u op F2 drukt om
de lijst van uitstaande facturen te laten zien; in dit geval wordt de lijst gefilterd op de
Klantrekening in de transactierij.

Let op
De lijst die wordt getoond in de factuur kolom bevat zowel de Klant als de Leveranciers facturen.
Een leveranciersfactuur kan hetzelfde nummer hebben als de factuur van een andere leverancier
omdat het weergavecriterium, naast het factuurnummer, ook rekening houdt met de
Leveranciersrekening.

Factuur-rijen ophalen en Koppeling naar factuur openen
commando's

Het Factuur-rijen ophalen commando toont de transacties van de geselecteerde factuur.
Het commando wordt uitgevoerd door op het blauwe pijltje in de rechterbovenhoek van de cel te
klikken of door met de rechtermuisknop op de cel te klikken.

Het Koppeling naar factuur openen commando opent het document volgens het voorschrift dat is
gedefinieerd in Klanten instellingen (Taken - Klanten - Instellingen - Koppeling naar het
factuur document).

In dit veld kunnen ook andere kolommen in de tabel aangegeven worden door hun XML namen te
gebruiken.

Wanneer het bericht "Bestandsextensie wordt als onveilig beschouwd" verschijnt, voeg dan de
extensie (bijvoorbeeld .doc) toe met het commando Extra - Programma opties, Geavanceerd,
Bestandsextensie.
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Activeren van de Addreskolommen (optioneel)
Het is mogelijk enkele specifieke kolommen toe te voegen aan de Rekeningentabel om het adres en
ander Klantgegevens in te voeren:

Kies het commando menu Extra → Nieuwe functies toevoegen...
Kies het commando Adreskolommen toevoegen in de Rekeningen tabel
(Als u deze optie niet ziet in de lijst betekent dit dat deze functie al is geactiveerd).

Het programma voegt in de Rekeningentabel toe:

Een Adres weergave waarin de toegevoegde kolommen zichtbaar zijn.
De kolommen waarmee adresgegevens en andere informatie ingevoerd kan worden.

Gebruik het commando Kolommen instellen van het menu Gegevens om een of meer
van deze kolommen weer te geven, ook in de andere weergaven.
Om andere weergaven aan te maken met alleen bepaalde kolommen gebruikt u het
Weergaven instellen commando via het commando Tabellen instellen van het menu
Gegevens.

Kies de Rekeningen tabel, Adres weergave en voeg de gewenste informatie to
Klantenrekeningen.

Instellen van de vervaldatum voor de facturen
Om de vervaldata van facturen in te stellen / te wijzigen, kunt u op drie niveaus ingrijpen, waarbij het
eerste niveau een hogere prioriteit heeft. Vervaldatumgegevens worden weergegeven in het
betalingsschema en afgedrukt op het factuurdocument.

Niveau 1 - de vervaldatum op een individuele factuur instellen

In de rij van de Transacties tabel, waar uw factuur is ingevoerd, vindt u een kolom Verv. Datum
wanneer u de weergave Vervaldatum gebruikt. Als hier een datum is ingesteld, heeft deze voorrang
boven data die op het 2e of 3e niveau zijn ingesteld.

Niveau 2 - het instellen van de vervaldatum op een individuele
klant/leveranciersrekening

Om een vervaldatum op klantniveau in te stellen, bijvoorbeeld +20 dagen na het uitreiken van de
factuur, selecteert u de klantrekening in de Rekeningen-tabel, gebruikmakend van de Adresweergave,
ga naar de Dagen kolom (BetalingstermijnInDagen) om het aantal gewenste dagen in te stellen.
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Niveau 3 - Algemene instelling

Vervaldata voor alle klanten/leveranciers kunnen worden ingesteld via het menu Taken → Klanten →
Instellingen...

Instellen van de klanteninstellingen
Kies het commando Taken → Klanten → Instellingen...
Geef in het veld "Groep of rekening" de groep van het Rekeningschema waarin de diverse
Klantrekeningen zijn gegroepeerd.
Voor een uitleg van de diverse opties zie Klanten- en leveranciersinstellingen.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 560

Lijst Klantenfacturen

Uitgereikte facturen aan klanten weergeven
Commando: Rapporten → Klanten → Uitgereikte facturen...

Deze dialoog is identiek voor zowel de menu's Klanten als Leveranciers.
Hieronder leggen we de functionaliteiten met betrekking tot klanten uit, maar deze zijn ook van
toepassing op de leveranciers.

Alle klanten (leveranciers)
Toont het Klantensaldo van alle klanten die bij de groep horen die gedefinieerd is in de Klanten- en
leveranciersinstellingen.

Alleen gespecificeerde klant (leverancier)
Toont het Klantensaldo van een geselecteerde klant die hoort tot de groep die gedefinieerd is in de
Klanten- en leveranciersinstellingen.

De openstaande facturen weergeven
Commando: Rapporten → Klanten → Open facturen per klant

In deze tabel worden de facturen die een saldo ongelijk nul hebben weergegeven.

Voor vreemde valuta boekhouding: als er niet geboekte wisselkoersverschillen voor een specifieke
klant zijn wordt er een regel "Wisselkoersverschil aanpassing" weergegeven die het saldo van de
open facturen lijst in evenwicht brengt met het saldo op de rekeningkaart.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 561

De achterstallige facturen weergeven
Commando: Rapporten → Klanten - Open facturen op vervaldatum

In deze tabel worden de facturen die een saldo ongelijk nul hebben weergegeven, gegroepeerd op
vervaldatum.

De vervaldatum van een factuur kan op verschillende manieren worden ingesteld. Meer informatie
vindt u op de volgende pagina: Vervaldata en betalingsvoorwaarden
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Overzichten afdrukken

U kunt de afdruk van de overzichten starten via het menu Rapporten → Klanten → Overzichten
afdrukken....

Het is essentieel om de layout Rekeninguittreksel klant te installeren om het overzicht af te
drukken. Er zijn twee manieren om dit te doen:

Kies van het menu Extensies → Extensies beheren → kies de layout Rekeninguittreksel klant.
Kies van het menu Rapporten → Klanten → Overzichten afdrukken... → Meer layouts... →
Rekeninguittreksel klant.

Datum overzicht

Dit is de datum die afgedrukt wordt op het overzicht. Het is niet mogelijk een datum in te stellen
eerder dan de datum van de laatste aanwezige transactie.

Layout

Met de stijlen kunt u het uiterlijk van de afdruk aanpassen.
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Betalingsherinneringen afdrukken

Functie beschikbaar met Banana Boekhouding Plus - elk plan (uitgezonderd de
beperkingen van het Free plan )

U kunt de afdruk van de betalingsherinneringen starten via het menu Rapporten → Klanten →
Betalingsherinneringen afdrukken.

Het programma maakt automatisch betalingsherinneringen aan uit de achterstallige facturen

Naast de afdrukken maakt het programma direct de transacties aan in de transactietabel die
gebruikt worden om de geschiedenis van de verstuurde herinneringen te reconstrueren.
Deze transacties laten de datum van het document zien en in het documenttype: 16-1 eerste
herinnering, 16-2 tweede herinnering en 16-3 derde herinnering.

Gebruik laatste betalingsherinneringen

Als er in de transactietabel herinneringstransacties zijn met de aangegeven datum zal het
programma voorstellen deze herinneringen af te drukken.

Aanmaken van nieuwe betalingsherinneringen

Voor alle achterstallige facturen worden automatisch herinneringstransacties aangemaakt in de
transactietabel waardoor die kunnen worden afgedrukt. 

https://www.banana.ch/nl/buy
https://www.banana.ch/nl/buy
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Betalingsherinneringen

Het programma laat de achterstallige facturen zien die u kunt uitvinken als u er geen herinnering voor
wilt sturen.

Layout

Er zijn twee layout modellen beschikbaar voor de betalingsherinneringen, één met en één zonder logo
(zie Logo instelling). Het is niet mogelijk om er een betalingsstrook, notities en vrije teksten aan toe te
voegen. Als u de betalingsstrook nodig heeft gebruikt u Betalingsherinneringen afdrukken vanuit de
dialoog Facturen.

Extensies beheren

Gebruik het menu extensies om de layouts bij te werken met de laatste modellen of uw eigen layouts
toe te voegen.
Hiermee kunt u van de geselecteerde layout de parameters instellen.
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Vervaldatums weergeven

Klanten & Leveranciers Beheer
Om facturen die verstuurd of ontvangen zijn automatisch te beheren, raden wij u aan het Submenu
Klanten en het Submenu Leveranciers te gebruiken.

Verbind een vervaldatum aan een transactie
Als een alternatief voor klanten en leveranciers beheer, of voor een eenvoudiger controle, kunt u de
betaaldatum ook handmatig invoeren in de transactie rij, in de Bet. Datum kolom.

Dit is een manier van werken die een vereenvoudigde controle toelaat.

Met het Gegevens menu → Kolommen Instellen commando moet u de Verv. Datum en de Bet.
Datum kolommen zichtbaar maken.

Daarna voert u de vervaldatum van de factuur in de Verv. Datum kolom in en de betaaldatum van
de factuur in de Bet. Datum kolom, zodra de betaling geboekt wordt.

De vervaldatum van een factuur kan op verschillende manieren worden ingesteld. Meer informatie
vindt u op de volgende pagina: Vervaldata en betalingsvoorwaarden

Vervaldatums weergeven
Met het commando Vervaldatums weergeven van het Acties menu, laat het programma, in de
tabel Vervaldatums, de transactie rijen zien die een vervaldatum maar geen betaaldatum hebben.

Voor een automatisch schema van de vervaldatums (openstaande posities van klanten en
leveranciers), zie de pagina Lijst Klantenfacturen.
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Facturatie geïntegreerd in uw
boekhoudbestand

De geïntegreerde factureringsfunctie van Banana Boekhouding Plus biedt het
klantfactuurregistratiesysteem rechtstreeks vanuit de transactietabel. Hiermee kunt u afdrukken
maken, inclusief aanpasbare afdrukken, op basis van transacties van klanten.

U kunt zowel facturen met een QR betaalstrook voor Zwitserland als internationale facturen
voor andere landen afdrukken, zelfs in vreemde valuta zonder een QR betaalstrook.

▶ Video Hoe u gepersonaliseerde facturen kunt aanmaken en afdrukken (EN)
Karakteristieken van de geïntegreerde facturering

Facturen maken
De transactietabel is het hart van Banana Boekhouding en wordt ook gebruikt om facturen te
versturen. Niets is makkelijker: om een factuur te maken voert u een gewone transactie in die de
klant de kosten in rekening brengt.

Met Banana Boekhouding kunt u ook facturen in vreemde valuta maken.

De kolommen van belang voor de facturering:

Datum - Factuurdatum
Factuur - Het factuurnummer.
Beschrijving - Beschrijving van het te factureren item.
Als er meer dan één item is om te factureren gebruikt u nog een regel met hetzelfde
klantnummer.
Debet - Klantrekening.
Credit - Winstrekening.
Bedrag - Factuurbedrag.
U kunt ook de hoeveelheid en de eenheidsprijs aangeven en het programma berekent het
bedrag.
BTW code- BTW code van de winst.

Voordelen
Met geïntegreerde facturering van Banana Boekhouding wordt uw administratieve werk eenvoudiger
waardoor de tijd nodig voor het beheer van de facturen, klanten en boekingen minder wordt:

https://www.banana.ch/en/node/11345
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Factuur transacties zijn altijd hetzelfde voor de facturering en de boekhouding waardoor de
kans op fouten en omissies kleiner wordt.
Banana Boekhouding produceert automatisch de bijbehorende boekhouddocumenten, zoals
BTW-, klantrekening- en bonnenlijsten.
U heeft meteen een accuraat overzicht over uw klanten met voortdurend bijgewerkte saldi.
Veel automatisering om uw werk gemakkelijk te maken met met directe professionele
resultaten:

Adressen van contacten worden automatisch opgehaalde zodat de gegevens niet steeds
opnieuw ingevoerd hoeven te worden in de factuur.
Geen handmatige berekeningen. Alle berekeningen zijn automatisch, altijd nauwkeurig en
up-to-date.
De taal, munteenheid, aantal decimalen en afronding kunnen voor iedere individuele
factuur ingesteld worden.
Weergave van de vervaldatum.
Archivering van facturen voor een overzichtelijke administratie die altijd beschikbaar is
voor belastingcontroles.

Tabel Items 
Met de Items Tabel kunt u een artikelen lijst beheren en beschikbare aantallen, verkopen en
verkoopprijzen bijhouden.

In deze tabel worden gegevens voor het beheer van artikelen of diensten die gefactureerd moeten
worden ingevoerd. Ieder artikel krijgt een ID en er kunnen groepen van artikelen en diensten in
dezelfde categorie gemaakt worden.
Er zijn diverse kolommen beschikbaar voor complete en gedetailleerde informatie:

Product (ProductenId): de code van het artikel.
Beschrijving: de beschrijving van het artikel..
Groep waartoe het product behoort.
Rekening (voor de boekhouding).
BTW code van de verkoop.
Eenheid: een afkorting om het type van de hoeveelheid te definiëren (dozen, uren...).
Verkoopprijs: de verkoopprijs per eenheid.
Verkoopkosten.

De Items tabel is gekoppeld aan de Items kolommen van de transactietabel.

Het gebruik van de Items tabel versnelt de gegevensinvoer van de factuurgegevens in de
transactietabel. Door de ID (artikelcode) in te voeren, neemt het programma automatisch de
omschrijving, eenheid en eenheidsprijs over. Door de hoeveelheid in te voeren, wordt de totale te
factureren prijs berekend en ingevoerd.
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Internationale facturen afdrukken
Na het invoeren van de factuurgegevens in de transactietabel kunt u de factuur maken en afdrukken
met een van de beschikbare modellen voor het afdrukken van facturen.

Vanuit het menu,  Rapporten > Klanten > Facturen afdrukken:

Kies the Model 11 programmeerbare factuur
Pas uw afdruk naar wens aan. Meer aanpassingen zijn mogelijk met het Advanced plan .
Bekijk de factuur. U kunt deze opslaan als PDF en elektronisch versturen of afdrukken.

Met dezelfde boeking kunt u er ook voor kiezen om Aflevernota's, Offertes en Herinneringen af te
drukken vanuit het dialoogvenster Facturen afdrukken, onder Voorkeuren Layout > Afdrukken
als.

Factuur structuur
In deze afbeelding kunt u de structuur van een factuur zien:

 

 
Logo
Voeg een gepersonaliseerd logo
in. menu Bestand → Logo
instelling...

 

Koptekst
De kop van de factuur wordt
hetzelfde als de tekst die u
ingevoerd heeft in menu
Bestand → Bestands- en
boekhoudingseigenschappen
Tabblad Adres

 

Klantadres
Het adres van de klant wordt
opgehaald uit de
Rekeningentabel. Zie
Klantenrekeningen instellen.

 

Factuurgegevens
De inhoud van de factuur moet u
in de transactietabel invoeren.
Meer over het invoeren van
facturen.

 

Vrije teksten
Voer begintekst, notities en
begroeting toe door de kolom
Type te gebruiken en eindteksten
via Menu Rapporten → Klanten →
Facturen afdrukken → Opties
Modellen.

 
Zwitserse QR-Code
Alleen van toepassing voor
Zwitserland.

https://www.banana.ch/apps/en/node/9034
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/nl/buy
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Klantenbeheer
Met Klantenbeheer kunt u klantinformatie beheren, klanttransacties en -betalingen, vervaldata en
ontractinformatie bijhouden. U kunt betalingen van klanten volgen en de betalingsstatus van
verstuurde facturen bijwerken en facturen invoeren en afdrukken.

In Banana Boekhouding worden de klantgegevens opgeslagen in de rekeningentabel.

Om facturen te maken is het nodig om:

Het klantenregister te definiëren
Klantenbeheer met de methode van het factuurstelsel 
Klantenbeheer met de methode van het kasstelsel

Facturen aan te maken door de transacties in de transactietabel in te voeren en de
klantenrekening te debiteren.

Met een reeks functies kunt u beheren:

Reeksen van facturen door deze in de transactietabel in te voeren door:
Handmatige invoer van de reeks facturen.
Automatische invoer door transacties te importeren vanuit ISO 20022 afschriften. Door
Regels te gebruiken voert het programma de complete boeking in, met alle gegevens,
zonder enige handmatige tussenkomst.

Herinneringen
Met het model voor Betalingsherinneringen afdrukken
Met het model voor facturen afdrukken

Een factuur maken vanuit een kostenplaats
Wanneer het klantregister wordt opgezet met kostenplaatsen (Klantenbeheer met de methode van
het kasstelsel), 
wordt de kolom kostenplaats KP3 gebruikt voor de factuurtransacties.

Geef in de betreffende kolommen in de transactietabel aan:

De datum.
Het factuurnummer.
De beschrijving van het item, dat u op de factuur wilt laten weergeven.
Als er meer dan een item gefactureerd moet worden gebruikt u een andere regel met hetzelfde
klantnummer.
In de Debet rekening boekt u geen bedrag
In de Credit rekening boekt u geen bedrag
Het bedrag. U kunt ook de hoeveelheid en eenheidsprijs invoeren en het programma berekent
het bedrag.
Voer in kolom KP3 de rekening voor de kostenplaats van de klant in (rekeningentabel).

http://www.banana.ch/doc/nl/node/8296
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Functies die nog niet beschikbaar zijn
Deze door gebruikers gewenste functies zijn nog niet beschikbaar:

Automatisch facturen per email sturen.
Het maken van offertes.
Met het programma kunt u een factuur afdrukken met de vermelding 'Offerte'.
Het maken van aflevernota's.
Met het programma kunt u een factuur afdrukken met de vermelding 'Aflevernota'.
Koppeling met de voorraadbeheer applicatie.
Koppeling met de Timesheet applicatie.
Het maken van facturen in vreemde valuta met BTW in basis valuta (bijvoorbeeld facturen in
USD met BTW in EUR). 

Offertes en facturen applicatie
Wanneer u facturen gescheiden van de boekhouding wilt versturen (handig voor contanten
boekhouding) en ook offertes wilt maken kunt u gebruiken: 

Offertes en facturen applicatie.

Hiermee kunt u makkelijker extra informatie aan facturen of offertes toevoegen.

Meer informatie
Factuurafdrukken personaliseren
Facturen afdrukken en BTW  (Engelstalig)
Taal van de klant instellen in facturen
Vervaldata en betalingsvoorwaarden
Tabblad Adres met alle bedrijfsgegevens
Extensies instellingen en personalisaties
Wachtwoordbeveiliging van uw facturatiebestand

Voorbeeldbestanden:
Voorbeeldbestand Facturen in de Boekhouding inkomsten & uitgaven
Voorbeeldbestand Facturen in het Dubbel Boekhouden
Voorbeeldbestand Facturen met gebruik van kostenplaatsen
Te gebruiken voor maken van facturen met BTW op basis van contanten (klanten en
leveranciers opgezet met kostenplaats KP3).

https://www.banana.ch/it/node/10885
https://www.banana.ch/apps/nl/node/8564
https://www.banana.ch/apps/nl/node/8455
https://www.banana.ch/apps/en/node/8714
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Bestand instellen

Er zijn twee manieren om uw boekhoudbestand in te stellen voor facturering

Gebruik een bestaand model om een nieuw boekhoudbestand aan te maken.1.
Pas uw bestaande boekhoudbestand aan.2.

Nieuw Boekhoudbestand
Er zijn diverse modellen beschikbaar die een vooraf ingesteld klantenregister bevatten. Facturering is
mogelijk in de volgende boekhoudtypes:

Dubbel boekhouden met of zonder BTW.
Vreemde valuta boekhouding met of zonder BTW.
Inkomsten en & Uitgaven boekhouding met of zonder BTW.

Een nieuw boekhoudbestand maakt u als volgt aan:

Menu Bestand → Nieuw.
Kies Gebied en taal.
Type facturen in het veld Filteren op.
Kies een model uit de weergegeven lijst aan de rechterkant.
Sla uw bestand op met een naam.

Volg nu de instructies de in de documentatie over het factureren staan.

Om in boekhoudtypes met BTW het bestand correct in te stellen adviseren we u om de uitleg op de
pagina  Facturen afdrukken en BTW te volgen.

Uw bestaande boekhoudbestand aanpassen

Als u uw bestaande boekhoudbestand wilt aanpassen voor het maken van facturen moet u wat
functies en instellingen toevoegen om de facturen te kunnen afdrukken:

Voer de gegevens van uw bedrijf in

In het menu Bestand → Bestands-en boekhoudeigenschappen... → Adres kunt u het adres
en andere gegevens van uw bedrijf invullen die gebruikt worden in de kop van de factuur.
Om uw persoonlijke logo te gebruiken volgt u deze instructies.

Maak in de Rekeningentabel een lijst van klanten

In de rekeningentabel kunt u uw klantenregister opstellen

Voeg klantadres kolommen toe en geef deze weer.
In de Rekeningentabel kunt u voor Adresweergave kiezen en uw klantengegevens
invoeren.
Als de Adresweergave niet beschikbaar is kunt u deze toevoegen door menu Extra →
Nieuwe functies toevoegen... → Adreskolommen toevoegen in de Rekeningen tabel.

Beheer uw klantinstellingen via menu Rapporten → Klanten → Instellingen.

https://www.banana.ch/nl/node/10885
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De kolommen die u wilt gebruiken toevoegen in de transactietabel

De kolommen voor het factureren weergeven in de transactiestabel:

Menu Gegevens → Kolommen instellen en dan Typedoc (Doctype) en Docfactuur
(DocInvoice) aanvinken.
Voeg eventueel de kolommen voor Hoeveelheid en Eenheidsprijs toe.
Menu Extra → Nieuwe functies toevoegen... → Kolom 'Items' toevoegen in de
Transacties tabel.
Voeg eventueel de itemstabel toe.
Hiermee kunt u uw items bijhouden en uw voorraad beheren.
Menu Extra → Nieuwe functies toevoegen... → Items-tabel toevoegen.

Facturering in een bestand dat alleen voor facturering
gebruikt wordt
Als u uw facturering gescheiden wilt houden van uw hoofdboekhouding moet u een nieuw bestand
aanmaken. U voegt in uw rekeningschema alleen rekeningen toe voor klanten waar u facturen naar
stuurt. Facturen worden ingevoerd via de transactietabel.
Deze werkwijze is geschikt voor:

Boekhouding op basis van contant geld. Alleen het betaalde bedrag wordt ingevoerd in het
boekhoudbestand.
Als u het beheer van uw facturen helemaal gescheiden wilt houden van uw hoofdboekhouding,
bijvoorbeeld voor een vereniging die contributie int van haar leden.

Hoe een gescheiden boekhoudbestand aan te maken voor facturatie:

Download het model , open het en pas het aan uw eisen aan.1.
Als een alternatief kunt u met elk ander model beginnen en het aanpassen - zoals eerder
beschreven - voor het gebruik met facturen.
Zorg ervoor dat alle instellingen en kolommen aanwezig zijn, zoals eerder uitgelegd.2.

https://www.banana.ch/apps/nl/node/8455
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Invoeren van de factuurgegevens

Factuurgegevens worden ingevoerd in de Transactietabel. Gebruik een nieuwe rij voor iedere factuur.

Voor de datum in van uw transactie.
Het factuurnummer.
De tekst die u invoert in de kolom Beschrijving (product, diensten, consultancy kosten, ...)
verschijnt op de factuur aan uw klant.
Voer het klantnummer in de kolom Debet in.
Voer de tegenrekening in de kolom Credit (Verkopen rekening, consultancy kosten, etc.) in.
Voer het Bedrag in.
In een boekhouding met BTW voert u uw BTW code in met het bijbehorende BTW percentage.
Zie facturen afdrukken en BTW beheer .

Facturen over meerdere rijen

Als er meerdere onderdelen zijn in uw factuur (verschillende items of diensten, of beide) dan moet u
deze op aparte regels invoeren (één onderdeel per rij):

Gebruik een nieuwe rij om ieder item dat u wilt laten verschijnen bij het afdrukken van uw
factuur.
Gebruik voor iedere rij dezelfde datum en hetzelfde factuurnummer.

Basis kolommen voor facturen in de Transactietabel

Datum
De datum van de factuur staat in deze kolom. Alle rijen van deze factuur moeten dezelfde datum
hebben.

Factuur
Om de facturen te beheren moet u een factuurnummer invoeren in de kolom Factuur en een
rekeningnummer dat bij het klantenregister hoort in de kolom Debet Rek. (of KP3 als men de
klanten beheert met het kasstelsel).

Extra kolommen

Type
In de kolom Type  kunt u specifieke rijen definiëren zoals een totaal rij of een speciale

https://www.banana.ch/en/node/10885
http://www.banana.ch/doc/nl/node/9828
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betalingsvoorwaarde voor een factuur. Deze kolom is standaard niet zichtbaar maar moet zichtbaar
gemaakt worden met het commando menu Gegevens → Kolommen instellen en dan Doctype kolom
aanvinken.

Hoeveelheid
De hoeveelheid geleverde goederen en diensten wordt in deze kolom ingevoerd. Om de hoeveelheid
kolom toe te voegen gebruikt u menu Extra → Nieuwe functies toevoegen... → Adreskolommen
toevoegen in de Rekeningen tabel.

Eenheid
Voer hier de eenheid van het geleverde in (bijvoorbeeld 'kilo', 'uur', 'meter', 'kg').

Eenheidsprijs
Voer de prijs per eenheid in voor goederen en diensten. Het programma berekent automatisch het
resulterende bedrag met uw invoer in de kolom Hoeveelheid.
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Kortingen en teruggaves

Om een korting of teruggave in een factuur in te voeren voegt u een nieuwe rij toe en typt daar in:

Factuur datum.
Factuur nummer.
Beschrijving van de korting of teruggave.
Rekeningen in de debet en credit kolommen. Het is belangrijk om de rekeningen om te
keren in vergelijking met de verkooptransactie.
Wanneer het klanten / leveranciers register is ingesteld met kostenplaatsen en er zijn
boekingen met kortingen en teruggaves, dan moet het teken van de kostenplaatsen worden
omgekeerd om het bedrag omgekeerd te krijgen.
In geval van BTW geeft u de BTW code aan met het minteken zodat de BTW wordt afgetrokken,
of, indien aanwezig, gebruikt u de BTW code voor korting of teruggave.
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Taal van de klant instellen

De standaard formaten ondersteunen de volgende talen: Italiaans, Duits, Engels, Frans, Nederlands.

Factuur teksten worden afgedrukt in de taal van de klant als deze is ingesteld in de kolom Taal
(Rekeningentabel, Adresweergave).
De taal is een ISO code van in het algemeen 2 kleine letters (Engelstalige link)  (it=Italiaans,
de=Duits, en=Engels, fr=Frans, nl=Nederlands).

Wanneer geen taal is aangegeven voor de klantenrekening wordt de taal van de boekhouding
gebruikt, zoals ingesteld in menu Bestand → Bestands- en boekhoudingseigenschappen... →
tabblad Andere.

http://en.wikipedia.org/wiki/List_of_ISO_639-1_codes
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Vervaldata en betalingsvoorwaarden

De vervaldatum van een factuur kan op verschillende manieren ingesteld worden:

Algemene vervaldatum - gelijke vervaldatum voor alle facturen
Kies menu Acties → Klanten → Instellingen → Algemeen → Betalingstermijn van de
facturen,  geef de periode (in dagen) waarna de factuur als vervallen wordt beschouwd.
Bijvoorbeeld, als de datum van uw document 10 mei is en u voert een waarde van 10 dagen in
dan is de vervaldatum 20 mei.
Vervaldata per klant - specifiek voor iedere klant
In de Rekeningentabel is een kolom Dagen beschikbaar (als deze niet wordt weergegeven
maakt u deze zichtbaar via menu Gegevens → Kolommen instellen...)
De periode (in dagen) waarna de factuur beschouwd wordt als vervallen kunt u in deze kolom
instellen.
Specifieke data per factuur
In de Transactietabel kunt u met de Vervaldata weergave de Verv. Datum kolom
weergeven.

Alternatieve tekst voor de vervaldatum
Het is mogelijk een vrije tekst te definiëren als betalingsvoorwaarde voor iedere factuur die de
tekst van de vervaldatum vervangt. Zie  De factuur aanpassen - Kolomopties Type voor meer
informatie.
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Facturen in andere valuta afdrukken

U kunt facturen afdrukken in verschillende valuta

U moet een vreemde valuta boekhoudbestand gebruiken.
Facturen worden afgedrukt in de valuta van de klantenrekening.
Als u facturen in verschillende valuta naar dezelfde klant wilt sturen moet u rekeningen in
verschillende valuta aanmaken voor dezelfde klant.
Als een BTW code wordt gebruikt moet deze in dezelfde munteenheid zijn als de
klantenrekening.
Zie Boekhouding met BTW en vreemde valuta.
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De factuur aanpassen met opties in de kolom
Type

  De kolom Type in de Transactietabel kan gebruikt worden om commando's te definiëren voor het
afdrukken van specifieke gegevens op uw factuur.
Om de kolom weer te geven vinkt u TypeDoc aan via menu Gegevens → Kolommen instellen....

Gegevens invoeren
Zodra de kolom wordt weergegeven, kunt u doorgaan met het invoeren van uw gegevens. U moet:

Een lege rij toevoegen na de Datum van de factuur.
De datum van de factuur invoeren in de kolom Datum.
De vereiste parameter invoeren in Type kolom (zie de tabel hierna).
Het factuurnummer invoeren in de kolom Factuur.
De gegevens die op de factuur afgedrukt moeten worden in de kolom Beschrijving.

Factuur aan de klant
Door 10: in de Type kolom in te typen worden alle mogelijke beschikbare opties om gegevens van
uw factuur aan te passen weergegeven.

Factuur gegevens Kolom Type kolom Beschrijving

Klant adres
Als een ander adres dan het adres gedefinieerd in de
Rekeningentabel nodig is kan het gespecificeerd
worden door de juiste opties te gebruiken.
Geef elementen van het adres aan in aparte rijen
(voornaam, achternaam, adres...).

10:adr:fna
10:adr:lna
10:adr:bna

10:adr:str1
10:adr:str2
10:adr:str3
10:adr:cod
10:adr:cit
10:adr:sta
10:adr:cou

Voer voornaam in
Voer achternaam in
Voer naam van het
bedrijf/organisatie in
Voer regel 1 van het adres in
Voer regel 2 van het adres in
Voer regel 3 van het adres in
Voer de postcode in
Voer de plaats in
Voer de provincie in
Voer het land in
 

Groet
Na de details van de factuur kunt u een regel met
een groet aan het eind toevoegen (zie ook Factuur
voorbeelden  (Engelstalig)).

10:gre Voer uw groet in

Eindopmerkingen
Een of meer rijen met opmerkingen kunnen
ingevoegd worden na de details van de factuur en
voor de groet (zie ook Factuur voorbeelden
(Engelstalig)).

10:not Voer uw opmerkingen in

Order datum 10:ordd Voer de datum van de order in

Order nummer 10:ordn Voer het nummer van de order
in

https://www.banana.ch/apps/en/node/9398#doctype_beg_not_gre
https://www.banana.ch/apps/en/node/9398#doctype_beg_not_gre
https://www.banana.ch/apps/en/node/9398#doctype_beg_not_gre
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Factuur gegevens Kolom Type kolom Beschrijving
Instelling (geavanceerd)
Als u gepersonaliseerde gegevens wilt afdrukken op
de factuur kunt u de van toepassing zijnde instelling
gebruiken.
Deze optie is bedoeld voor gebruikers met kennis
van JavaScript programmering. Hiermee kunt de
layout van de factuur veranderen door de
instellingen te gebruiken die via dit commando
aangegeven worden.
Voor meer informatie zie de pagina over Aagepaste
gegevens afdrukken (Engelstalig).

10:par Voer uw aangepaste gegevens in

Betalingsvoorwaarden
Indien u een andere tekst voor de
betalingsvoorwaarden wilt aangeven voer dan de
gewenste tekst in. Deze wordt weergegeven op de
factuur.

10:ter Voer de alternatieve tekst voor
de betalingsvoorwaarde in.

Begintekst 10:beg Voer de tekst die voor de
factuurtitel verschijnt in

Titel
Als u de standaard factuurtitel niet wilt gebruiken
kunt u aan andere kiezen.

10:tit Voer uw tekst voor de
factuurtitel in

Subtotaal items
In de tabel met factuurgegevens kunt u de
subtotalen voor de artikelen invoeren (zie ook
Factuur voorbeelden  (Engelstalig)).

10:tot
10:tot:0
10:tot:1
10:tot:2

Voer niveau 0 subtotaal in (tot
en tot: 0 is altijd niveau 0)
Voer niveau 1 subtotaal in
Voer niveau 2 subtotaal in

Teksten voor de kopregel
In de factuurdetails tabel kunt u koppen toevoegen
aan groepsitems (zie ook Factuur voorbeelden
(Engelstalig)).

10:hdr
Voer de tekst in die u wilt
toevoegen aan de factuur
details. Leeg laten om een lege
regel to te voegen.

Subtotalen

Om subtotalen in te voegen moet u extra rijen in de transactietabel toevoegen:

Voer 10 in de Type kolom in; kies :tot uit het uitklapmenu, 10:tot wordt weergegeven. Kies
vervolgens :1  of type dit in
Voer een toepasselijke beschrijving in de kolom Beschrijving in (bijvoorbeeld Totaal goederen)
Voer het factuurnummer in (als het nummer ontbreekt wordt het totaal niet afgedrukt).

Voorbeeld van een factuur met subtotalen.

https://www.banana.ch/apps/en/node/9398#doctype_beg_not_gre
https://www.banana.ch/apps/en/node/9398#doctype_beg_not_gre


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 583

Alternatieve tekst voor betalingsvoorwaarden

Het is mogelijk uw eigen omschrijving te definiëren voor betalingsvoorwaarden voor iedere factuur.
Deze vervangt de bestaande tekst voor de vervaldatum.

Voeg een extra regel met hetzelfde factuurnummer in de transactietabel in.
Type 10: in de kolom Type en kies :ter van het uitklapmenu, Hierdoor verschijnt de term
10:ter.
Voer in de kolom Beschrijving uw tekst in (bijvoorbeeld 30 dagen, 60 dagen, etc. ..).

Als de factuur wordt afgedrukt wordt de waarde weergegeven die als betalingsvoorwaarde is
toegekend.

Extra mogelijkheden voor aanpassingen

Andere aanpassingsopties zoals de definitie van bankgegevens of tekst ter afsluiting zijn te vinden in
de
Dialoogvenster voor het afdrukken van facturen.
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Factuurafdrukken personaliseren

Het afdrukken van facturen kan gepersonaliseerd worden en aangepast aan uw specifieke wensen.

Stel het adres van uw bedrijf in (afzender)
Stel uw bedrijfsadres in met menu → Bestands en boekhoudeigenschappen (Basic gegevens) → Adres

,

Stel de klantgegevens in de rekeningentabel in
In de Rekeningen tabel stelt u het klantenregister in.
Laat de kolommen met adressen weergeven in de weergave Adres en voer de klantenadressen
in.
Wanneer de weergave Adres niet zichtbaar is kunt u deze toevoegen via het menu Extra →
Functies toevoegen → Voeg adreskolommen toe in de rekeningentabel.
Configureer de klantinstellingen in het menu Rapporten > Klanten > Instellingen.

Klantadressen ophalen uit Excel
Als klantgegevens beschikbaar zijn in een Excelbestand kunnen deze eenvoudig naar de
Rekeningentabel overgebracht worden, in de adres weergave.

Voorwaarde is dat er in de rekeningentabel, aan het eind van het rekeningschema een klanten of
relatieregister opgezet is. Zorg ervoor dat u genoeg lege rijen heeft om de gegevens vanuit Excel in
te kopiëren.

Ga als volgt te werk:

Selecteer in Excel de kolom met de te kopiëren gegevens en gebruik het commando Kopiëren
(Ctrl+C).
Ga in de Banana rekeningentabel (adres weergave) staan in de overeenkomstige kolom en
voer het commando Plakken (Ctrl+V of Paste) in het menu Bewerken uit.
Herhaal deze bewerking voor alle adreskolommen (rekening, voornaam, achternaam,
organisatie, straat, postcode, landcode, taal).
De gegevens uit de betreffende kolommen zijn nodig voor het afdrukken van de factuur.
Wanneer u niet alle kolommen van het Excelbestand heeft moet u de ontbrekende informatie
handmatig toevoegen.

Stel de taal van de klant in
U kunt de facturen afdrukken in de taal van de klant. Om dit te doen moet u eerst de taal van de klant
instellen.

Logo en afzender en hun positie instellen
Om het logo in te stellen moet u:

Het afbeeldingsbestand van het logo ophalen met menu Bestand → Logo instellen.

http://www.banana.ch/doc/nl/node/2570
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Om het logo in de factuur te gebruiken moet u in de factuurinstellingen  (Engelstalig) Logo
activeren en de naam van de aanpassing die u heeft gebruikt invoeren. De logonaam is
hoofdlettergevoelig.

Bijvoorbeeld, kunt u het logo aan de linkerkant plaatsen en het adres aan de rechterkant en kunt u de
grootte van het logo aanpassen.

Het adres van de afzender komt terecht aan de rechterkant, als de standaardinstellingen niet zijn
aangepast, onafhankelijk van de aanwezigheid van het logo.

Als u het adres van de afzender aan de linkerkant wilt plaatsen zonder logo, moet de volgende pagina
bezoeken:

Factuur zonder logo en adres aan de linkerkant  (Engelstalig).

Pas het adres in de kop van de factuur aan
De stijl van het adres van de afzender in de factuurkop (kleur, grootte, lettertype..) wordt volgens de
standaardinstellingen van het programma ingesteld.

Met het Advanced Plan van Banana Boekhouding Plus  kunt u de stijl van het adres aanpassen. Zie
voor meer informatie de pagina Voorbeelden  (Engelstalig).

Stel de factuurinformatie in
Factuurinformatie gaat over de datum, klantnummer, vervaldatum, etc., die gewoonlijk wordt
geplaatst net onder de kop en naast het klantadres.
Met de CH10  (Engelstalig) en UNI11  layouts kunt u definiëren welke factuurinformatie
opgenomen moet worden en welke niet bij het afdrukken. U vindt instructies op de
Factuurinstellingen  pagina (Engelstalig).

Van de andere afdruklayouts (CH01-CH09 / UNI01-UNI08) kan de informatie niet worden aangepast.

De betaaltermijn instellen
De betaaltermijn voor facturen is standaard dagen vanaf de factuurdatum.

Ga als volgt te werk om de betaaltermijn te veranderen:

Voeg in de Transactietabel een rij toe aan de factuur
Voer in de kolom Datum de factuurdatum in
Voer in de kolom DocType 10:ter (:ter voor Betalingstermijn) in
Voer in de kolom Factuur het factuurnummer in
Voer in de kolom Beschrijving de gewenste betaaltermijn in (bijvoorbeeld "10 dagen")

Uw tekst wordt getoond in de factuurinformatie.

De plaats en de elementen van het klantadres instellen
Met de CH10  (Engelstalig) en UNI11  layouts kunt u de plaats en de elementen van het klantadres
definiëren. U vindt instructies op de Factuurinstellingen  pagina (Engelstalig).

https://www.banana.ch/apps/en/node/9365
https://www.banana.ch/apps/en/node/9398#left_company_address
https://www.banana.ch/nl/advanced
https://www.banana.ch/apps/en/node/9417
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9365#Invoice_information
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9365#Invoice_information
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Van de andere afdruklayouts (CH01-CH09 / UNI01-UNI08) kan de klantadres informatie niet worden
aangepast.

Afleveradres instellen
Om een afleveradres in te voeren in aanvulling op het klantadres, gaat u als volgt te werk:

Gebruik de kolom Type van de transactietabel, commando 10:sadr.
Voeg een regel toe aan de factuur in de transactietabel.
Voer in de kolom Datum de factuurdatum in
Voer in de kolom Type in:

10:sadr:fna voor de naam.
10:sadr:lna voor de voornaam.
10:sadr:str1 voor het adres (straat en nummer).
10:sadr:cod voor de postcode.
10:sadr:cit voor de plaats.

Voer in de kolom Factuur het factuurnummer in
Voer in de kolom Beschrijving de tekst die weergegeven moet worden in.

Met de CH10  (Engelstalig) en UNI11  layouts gaat u naar de Factuurinstellingen →
Klantadres sectie  (Engelstalig) en klik op het Afleveradres invoerveld.
De gegevens ingevoerd in de kolom Type van de factuurtabel worden overgenomen en
meegenomen in de afdruk van de factuur.

Titel/onderwerp instellen
Om de titel of het onderwerp van de factuur in te stellen heeft u twee opties:

Gebruik de kolom DocType in de transactietabel en voer de tekst 10:it in.
U kunt voor iedere factuur een titel definiëren.
Als u het veld leeg laat wordt de standaard tekst gebruikt.
Een tekst ingevoerd in de kolom DocType heeft altijd voorrang voor de titel ingevoerd in
de layout instellingen (zie volgende punt).

Met de CH10  (Engelstalig) en UNI11  layouts kunt u de tekst invoeren in de
factuurinstellingen  → sectie Teksten → Factuurtitel (Engelstalig).

De titel wordt gebruikt in alle facturen die met deze layout worden afgedrukt.
De titel wordt alleen gebruikt als geen titel is gedefinieerd zoals beschreven in het eerste
punt.

Als geen tekst wordt ingevoerd gebruikt het programma de standaard tekst.

De begintekst instellen
In de begintekst in te voeren van de factuur heeft u twee opties:

Gebruik de kolom DocType in de transactietabel en voer de tekst 10:beg in.
U kunt voor iedere factuur een begintekst definiëren.
Als u het veld leeg laat wordt de standaard tekst gebruikt.
Een tekst ingevoerd in de kolom DocType heeft altijd voorrang voor de titel ingevoerd in
de layout instellingen (zie volgende punt).

Met de CH10  (Engelstalig) en UNI11  layouts kunt u de tekst invoeren in de
factuurinstellingen  → sectie Teksten → Begintekst (Engelstalig).

https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9365#customer_address
https://www.banana.ch/apps/en/node/9365#customer_address
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9365
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9365
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De titel wordt gebruikt in alle facturen die met deze layout worden afgedrukt.
De titel wordt alleen gebruikt als geen titel is gedefinieerd zoals beschreven in het eerste
punt.

De factuurdetails instellen
Gebruik de transactiestabel om de factuurgegevens in te voeren.

Zie ook Kortingen en teruggaves.

Met de CH10  (Engelstalig) en UNI11  layouts kunt u bepalen welke kolommen in de afdruk worden
weergegeven. Zie factuurinstellingen → Factuurdetails  (Engelstalig) hoe dit gedaan moet worden.

Van de andere afdruklayouts (CH01-CH09 / UNI01-UNI08) zijn de kolommen niet aan te passen.

De eindtekst instellen
Ga als volgt te werk om de eindtekst van de factuur in te stellen:

In de Dialoog Factuur afdrukken → Opties sectie
Kies de gewenste taal
Voer de tekst in het veld Eindtekst
Deze tekst wordt gebruikt in alle afdruklayouts.

Met de CH10  (Engelstalig) en UNI11  layouts kunt u de eindtekst definiëren in de
factuurinstellingen

Ga naar Invoice Settings  → sectie Tekst→ Eindtekst veld en voer uw tekst voor iedere taal
in.
Deze tekst wordt toegepast op alle facturen aangemaakt met die layout in hetzelfde .ac2
bestand.
Deze tekst heeft voorrang op elke tekst die is ingevoerd in de factuur afdrukken dialoog.

Om verschillende eindteksten voor ieder factuur in te stellen moet u de kolom DocType van de
transactietabel gebruiken:

Voer in de kolom DocType 10:not (Notities) in.
Voer in de kolom Beschrijving de gewenste eindtekst in. De tekst die u invoert verschijnt op
een enkele regel.
Om extra regels met notities toe te voegen moet u de invoer in de kolommen DocType en
Beschrijving herhalen op meerdere rijen.

Bankrekeningnummer instellen
Wanneer u de QR-code niet gebruikt moet u het bankrekeningnummer invoeren voor het betalen van
de factuur.

Zie het eerdere hoofdstuk over Eindteksten instellen voor het invoeren van het
bankrekeningnummer.

https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9365
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9365
https://www.banana.ch/apps/en/node/9365
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Stijlen en kleuren instellen
Factuurafdruklayouts  hebben ook een instelling waarin u kunt definiëren:

Het lettertype
Voer de naam van het font in (bijvoorbeeld Arial, Helvetica, etc).

De kleuren
U kunt de Engelse naam gebruiken (black, yellow, white, blue, red, etc.).
Of de hexadecimale waarde (HEX) voorafgegaan door het # teken (e.g. #000000,
#009FE3, #FF00EA).
Kleurcodes zijn eenvoudig te vinden op het internet. Bijvoorbeeld kunt u de tabel op
https://www.w3schools.com/cssref/css_colors.asp  raadplegen.

De CH10  (Engelstalig) en UNI11  layouts hebben ook een factuurinstellingen  om de
lettergrootte te definiëren.

Vetgedrukte teksten instellen
Op de pagina factuurinstellngen  (Engelstalig) vindt u informatie on vetgedrukte tekst toe te passen

 (Engelstalig) op factuurteksten.

Afbeeldingen toevoegen aan facturen
Met het Advanced Plan van Banana Boekhouding Plus  kunt u afbeeldingen toevoegen aan de
offertes en facturen die naar klanten gestuurd worden.
Met deze functionaliteit kan de factuur nog meer gepersonaliseerd worden en de klant die deeze
ontvangt heeft een completer en directer beeld van de gefactureerde items.

Zie ook onze informatiepagina's over het toevoegen van afbeeldingen:

Factuurafdrukken aanpassen met Javascript  (Engelstalig)
Offertes en facturen met productafbeeldingen

Betaalde facturen afsluiten
Er zijn twee manieren om open facturen af te sluiten:

Facturen handmatig afsluiten
Afsluiten met ISO 20022 gegevensimport (Alleen Zwitserland, Engelstalig)

Andere bronnen
Factuurafdrukken personaliseren

http://www.banana.ch/apps/nl/node/9034
https://www.w3schools.com/cssref/css_colors.asp
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9365
https://www.banana.ch/apps/en/node/9365
https://www.banana.ch/apps/en/node/9365#bold_text
https://www.banana.ch/nl/advanced
https://www.banana.ch/apps/en/node/9396#print_images_of_items
https://www.banana.ch/nl/node/11439
https://www.banana.ch/apps/en/node/9514
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Facturen afdrukken

Het dialoogvenster Facturen afdrukken is toegankelijk vanuit het menu Rapporten → Klanten →
Facturen afdrukken.

Nadat u de afdrukopties hebt gekozen, gebruikt u de knop OK om een voorbeeld van de factuur te
bekijken.

Tabblad Afdrukken
Factuurnummers

Om specifieke facturen af te drukken geeft u aan:

Het factuurnummer voor een enkele afdruk ervan.
Nummers gescheiden door komma's "1,3,6" voor afdrukken van meerdere facturen.
Nummers gescheiden door streepjes "1-3" voor afdrukken van een opvolgende reeks van
facturen.
Als het factuurnummer zelf een streepje '-' bevat, bijvoorbeeld als u een factuurnummer
'2022-1' hebt, moet dit ingesloten zijn door accolades {} om de nummering te onderscheiden
van een documentreeks {2022-1}-{2022-3}.

Facturen vanaf

Met deze optie kunt u alle facturen afdrukken die binnen een geselecteerde periode vallen. U moet
een begin- en een einddatum invoeren.
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Niet-afgedrukte facturen

Facturen waarvan de kolom Afgedrukt van de Transactietabel leeg is worden afgedrukt. Met deze
selectie worden daardoor alle niet-afgedrukte facturen afgedrukt.

Layout

Met de stijlen kunt u het uiterlijk van de factuur aanpassen. Er zijn modellen beschikbaar  met logo's
of met een hoeveelheid kolom.

Andere Modellen...

Met deze knop gaat u naar het dialoogvenster Apps beheren, waar u uw modellen bijwerkt naar de
meest recente versie, of uw eigen modellen toevoegt.

Instellingen...

U kunt met deze knop specifieke parameters voor de geselecteerde stijl instellen. Zie de uitleg op de
pagina Modellen  voor meer informatie.
De belangrijkste opties zijn:

Pagina koptekst opnemen,
Kleuren kiezen

Kolom 'Afgedrukt' bijwerken na het afdrukken

U kunt deze kolom zichtbaar maken met het commando menu Gegevens → Kolommen instellen.

Het programma werkt de inhoud van deze kolom bij nadat de voorbeeldafdruk gemaakt is door de
tekst '1' erin te zetten. Hiermee kan het commando Niet-afgedrukte facturen selecteren alleen
de facturen af drukken die nog niet afgedrukt zijn.

Tabblad Opties modellen

In dit tabblad is het mogelijk om voor elke taal specifieke teksten toe te voegen, zoals een groet
of uw bankgegevens om de betaling te vergemakkelijken.
Afhankelijk van de taal van de klant zal het programma aan het einde van de factuur de opgeslagen
teksten voor de aangegeven taal weergeven.

Selecteer het menu Rapporten → Klanten → Facturen afdrukken → Opties, voer de gewenste
tekst in en druk vervolgens op OK. U ziet het afdrukvoorbeeld.

https://www.banana.ch/apps/nl/node/9034
https://www.banana.ch/apps/nl/node/9034
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Factuur als PDF afdrukken
Facturen kunnen ook worden opgeslagen in PDF-formaat, zodat ze gemakkelijk per e-mail kunnen
worden verzonden.

Vanuit het Afdrukvoorbeeld (Rapporten→ Klanten → Facturen afdrukken → OK), selecteert u PDF
aanmaken in het bovenste menu.
Voor meer informatie zie de pagina Afdrukken/Afdrukvoorbeelden.
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Afleverbon afdrukken

Wanneer u een factuur maakt met geïntegreerde facturering wordt deze automatisch geboekt in de
boekhouding en op de klantenrekening. Het is mogelijk een factuur af te drukken met het woord
"Afleverbon" waarin dezelfde factuurgegevens staan door model UNI11  (Engelstalig) te gebruiken.

Het is echte niet mogelijk een losse boeking te doen voor de afleverbon zonder enige invloed op de
boekhouding, een die niet de klantenrekening debiteert of andere rekeningen crediteert.

Verplichte vereisten om de lay-outvoorkeuren te gebruiken:

Banana Boekhouding Plus  (Release 10.1.7 of nieuwer).
Het Advanced plan

Hoe u een afleverbon afdrukt
Selecteer in de transactietabel de rij waar van de af te drukken afleverbon en ga als volgt te werk:

Menu Raporten > Klanten > Facturen afdrukken
Selecteer Layout UNI11
Selecteer onder Afdrukken als:

Afleverbon met bedragen
In it geval worden de gedetailleerde bedragen en het totale bedrag opgenomen in de
afleverbon.
Afleverbon zonder bedragen
Alleen de details van de afgeleverde goederen worden weergegeven in de afleverbon
zonder bedragen.

Bevestig met OK.

Aflever adres
Wanneer de afleverbon afgedrukt moet worden met een ander dan het factuuradres moet het
afleveradres worden ingevoerd in de transactietabel door de kolom Type te gebruiken.

In dit geval wordt met de afleverbon het adres ingevoerd in de transactietabel afgedrukt en niet het
adres van de betrokken klant dat in plaats daarvan te vinden is in de rekeningentabel in de
weergave Adres.

Personaliseren van de afdruk
Alle instellingen die bij Layout UNI11 horen worden gehandhaafd bij het afdrukken van de afleverbon.

Om de instellingen te veranderen gaat u naar Afdruk Layout Instellingen .

Onder Teksten > Afleverbon  kunt u de begin- en eindteksten van de afleverbon definiëren.

Voorbeeld van een afdruk:

https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/nl/download
https://www.banana.ch/nl/update
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9365#deliverynote_reminder_texts
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Betalingsherinneringen afdrukken

In Banana Boekhouding Plus kunt u herinneringen op twee verschillende manieren afdrukken:

Betalingsherinneringen afdrukken vanuit de dialoog Betalingsherinneringen afdrukken
De betalingsherinnering is gebaseerd op het uitstaande saldo van de klant.
De functie is beschikbaar in Banana Boekhouding Plus - elk plan (uitgezonderd de
beperkingen van het Free plan).
Gebruikt de Betalingsherinnering (Banana+)  (Engelstalig) Layout. De afdruk is zonder
de QR betalingsstrook.
Personalisatiemogelijkheden zijn beperkt.

Betalingsherinneringen afdrukken vanuit de dialoog Facturen afdrukken
De betalingsherinnering wordt aangemaakt van de onbetaalde factuur.
Gebruikt dit niet als de klantrekening een gedeeltelijk openstaand saldo heeft dat niet
overeenkomt met een specifieke factuur.
Vereist de Banana Accounting Plus Dev-Channel  versie en het Advanced plan
Gebruikt de UNI11  layout.
Personalisatiemogelijkheden worden geleverd door de layouts.

https://www.banana.ch/apps/en/node/9658
https://www.banana.ch/nl/insiderprogram
https://www.banana.ch/nl/update
https://www.banana.ch/apps/en/node/9423
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Betalingsherinneringen afdrukken vanuit de
dialoog Facturen afdrukken

Met Banana Boekhouding Plus, met de UNI11  layout (Engelstalig), kunt u betalingsherinneringen
afdrukken.

Vereisten om de lay-outvoorkeuren te gebruiken:

Banana Boekhouding Plus (Release 10.1.7 of nieuwer) .
Het Advanced plan

Op basis van de factuurgegevens ingevoerd in de transactietabel, kunnen herinneringen worden
afgedrukt.

Hoe een herinnering af te drukken
Selecteer in de transactietabel de rij van de factuur waarvoor u een herinnering wilt afdrukken ga
als volgt te werk:

In Menu Rapporten > Klanten > Facturen afdrukken
Selecteer Layout UNI11
Onder Afdrukken als, selecteer een van de volgende opties:

1. herinnering
2. herinnering
3. herinnering

Bevestig met OK

Afdruk personaliseren
Alle instellingen voor de UNI11 layout zitten ook in de afdruk van de herinnering.

Om de instellingen te veranderen gaat u naar Print Layout Settings .

Onder Tekst → Herinnering  kunt u de begin- en eindteksten van de herinnering definiëren .

 Afdruk voorbeeld:

https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/nl/download
https://www.banana.ch/nl/update
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9423
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Afsluiten van facturen

Facturen worden automatisch gesloten wanneer u de betaling vastlegt en ze verschijnen niet langer
in de lijst met openstaande facturen Rapporten → Klanten → Open facturen per klant

Facturen overdragen naar een nieuw jaar
Aan het einde van het jaar worden alle facturen automatisch overgedragen naar het nieuwe jaar
via Rapporten → Klanten → Instellingen → Transacties van de vorige ... jaar/jaren opnemen.

Als u alleen de openstaande facturen wilt rapporteren en niet alle factuurbewegingen, moet u:

De vorige jaren die moeten worden opgenomen op 0 zetten.
De afsluitende verrichtingen van de openstaande facturen creëren, waarbij het bedrag van de
klanten-/leveranciersrekening wordt overgeboekt naar een tijdelijke rekening die niet tot de
klanten-/leveranciersgroep behoort (bijvoorbeeld tussenrekening 1090)
In het nieuwe jaar de openingsverrichtingen van de facturen aanmaken, waarbij u de facturen
van de tijdelijke rekening naar de klanten-leveranciersrekening overbrengt.

Wijzigen van de klantenrekening
Het is mogelijk om de naam van de klantenrekening te wijzigen via het commando Hernoemen, maar
als er nog openstaande facturen zijn uit voorgaande jaren, zullen deze in de tabel openstaande
facturen worden weergegeven met de oude nummering.

Om een klantrekeningnummer te wijzigen waarop nog openstaande facturen van vorige jaren staan,
gaat u als volgt te werk:

Voer de nieuwe klantrekening in de Rekeningen tabel in
In deTransacties tabel, maak de overboekingstransacties aan voor alle openstaande facturen:
vermeld het factuurnummer in de kolom Factuurnummer, de nieuwe klantrekening in Debet en
in Credit de oude klantrekening.

Wij raden u aan deze operatie aan het einde van het jaar uit te voeren, zodat u de oude klantrekening
in het nieuwe jaar kunt verwijderen, waardoor het saldo weer op nul wordt gezet.

Wijziging van factuurnummer
Als u het nummer van een onbetaalde factuur wilt wijzigen, zijn er twee mogelijkheden:

Direct de oorspronkelijke transactie van de factuur wijzigen door het factuurnummer te
vervangen.

Of

Maak een transactie aan die het openstaande factuurbedrag overboekt naar een
tussenrekening, met gebruikmaking van de oorspronkelijke factuurnummering
Maak een tweede boeking die het openstaande factuurbedrag van de tussenrekening naar de
klantrekening overbrengt, met gebruik van het nieuwe factuurnummer.
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Credit nota's

Credit nota's hebben hun eigen TypeDoc, die anders is dan die voor facturen.

Voer uw transactie in alsof het een factuur is.
Geef het nummer van de credit nota aan in de kolom Factuur.
De rekeningen volgen de logica van het boeken van een credit nota. Als gevolg daarvan is het
bedrag van het document negatief.
Voer '12:' in de kolom Type in.
Voer in de kolom Beschrijving de tekst in die verschijnt in de Credit Nota details.
In sommige afdrukformaten van Banana 9 wordt altijd het woord Factuur afgedrukt. Om dit te
veranderen gaat u als volgt te werk:

Voer een regel in met een identiek factuurnummer en 12:tit in de kolom Type.
Voer Credit Nota in de kolom Beschrijving in.

De credit nota afdrukken

Het zelfde commando als voor het afdrukken van facturen wordt gebruikt: Rapporten → Klanten →
Facturen afdrukken.
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Afrondingen in de facturen

Wanneer u een boekhouding heeft waarin de kleinste munteenheid 5 cent is, zoals bijvoorbeeld bij de
Zwitserse frank, en daarin een factuur afdrukt wordt het totaal afgerond naar 5 cent, als dat nodig is.
Als het totaal op de afgedrukte factuur niet overeenkomt met het transactiebedrag wordt de
gebruiker gewaarschuwd voor het verschil.

Als afronding van het totaalbedrag niet nodig is kiest u het commando Taken → Klanten → Instellingen
→ Geavanceerd om de gewenste afronding in te stellen, bijvoorbeeld 0.01, die het totaal van de
factuur in overeenstemming brengt met het transactiebedrag.

Maak de afrondingstransactie aan die opgenomen wordt in de afdruk van de factuur, zoals in het
voorbeeld:
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Submenu Leveranciers

Leveranciersregister en beheer van uitstaande facturen
Direct in het boekhoudbestand is het mogelijk om:

De leveranciersrekeningen aan te maken met hun adres en andere leveranciersgegevens.
In de transacties in te voeren:

Gegevens over de ontvangen facturen (factuurnummer, leverancier, bedrag,
vervaldatum).
Gegevens over de betalingen aan leveranciers en de ontvangst van creditnota's.

Overzichten van facturen en betalingen te maken.

Leveranciers functies instellen en gebruiken
Rekeningen instellen voor het factuurstelsel (op transactiebasis).1.
Rekeningen instellen voor het kasstelsel (op afrekenbasis).2.
Leveranciers instellingen configureren(dezelfde uitleg als voor klanten).3.
Het instellen van de transactietabel en boeken van leveranciersfacturen.4.
Ontvangen, openstaande of vervallen leveranciersfacturen weergeven.5.

Let op
In een vreemde valuta boekhouding worden de overzichten gebaseerd op de saldi in de valuta
van de leveranciersrekening. Hierdoor wordt geen rekening gehouden met
wisselkoersverschillen.
De wisselkoersverschillentransacties worden wel weergegeven in de tabel Ontvangen
facturen terwijl in de andere overzichten alleen het bedrag in valuta van de leverancier geldig
is.
De kolom Beschrijving van de overzichten bevat de eerste transactieregel voor iedere factuur.
Voor de boekhouding via het kasstelsel is het mogelijk een leveranciersregister op te zetten
met kostenplaatsen.

Voorbeeld bestand
Klanten en Leveranciers voorbeeldbestand

https://www.banana.ch/apps/nl/node/8820
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Boekhouden via het factuurstelsel

Introductie
Met Banana Boekhouding kunt u de leveranciers beheren, zowel via het factuurstelsel als via het
kasstelsel. Een gedetailleerde toelichting vindt u op de pagina Boekhouding met het factuur- of
kasstelsel .

Hieronder leggen we uit hoe u groepen en leveranciersrekeningen kunt opzetten zodat u een aparte
lijst met facturen per leverancier beschikbaar hebt.

Indien u slechts enkele facturen heeft en geen detail per leverancier wilt bijhouden, kunt u ook één
rekening aanhouden om alle leveranciersfacturen te registreren. De lijst met facturen geldt dan voor
alle leveranciers en niet voor één enkele leverancier.

Instellen van het leveranciersregister
De Leveranciersrekeningen & -groepen kunnen precies zoals de gewone rekeningen direct worden
ingevoerd in het Rekeningschema.
Het is ook mogelijk een aparte sectie aan te maken met het Leveranciersregister. Op deze manier is
in het rekeningschema alleen het totaal van de Leveranciersgroep zichtbaar, terwijl in het register alle
individuele Leveranciersrekeningen worden weergegeven.

Om het Leveranciersregister in een aparte sectie aan te maken voegt u aan het eind van het
Rekeningschema toe:

Een * sectie (kop) (zie Secties)
Een 02 sectie voor de Leveranciers (zie Secties)
De Leveranciersrekeningen die nodig zijn (zie Een nieuwe rekening toevoegen). Iedere
leverancier is een aparte rij in het rekeningschema met zijn eigen rekeningnummer. Het
rekeningnummer kan vrij worden gekozen (zie Rekeningen), aanbevolen wordt echter alleen
cijfers te gebruiken, met name voor het betalingsbeheer.
Een groep die alle leveranciersrekeningen groepeert.
Deze groep wordt op zijn beurt gegroepeerd in een groep die aanwezig is in de Passiva.

Het Totaal Leveranciers wordt opgeteld in de samenvattende groep 200A van de Gr kolom.
Dezelfde code of getal dat gebruikt wordt voor de Gr (200) moet gebruikt worden in de Passiva
Groep kolom, voor de overdracht van het Totaal Leveranciers naar de Balans.
Het groepsnummer kan vrij worden gekozen (zie Groepen).

https://www.banana.ch/nl/node/10968
https://www.banana.ch/nl/node/10968
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Een ontvangen factuur boeken

Een betaling boeken
Voer de transactiedatum in
Ga op Factuurkolom veld staan en druk op F2 of dubbelklik op de cel.
Een lijst van openstaande facturen verschijnt.
Kies de gewenste leveranciersfactuur en druk op Enter.
Het programma maakt de transactie compleet met de kolom Beschrijving, de Debetrekening
en het Bedrag. Totdat de tegenrekening wordt ingevoerd, zal het programma een verschil in
de transacties signaleren.

Een creditnota boeken
Om een bedrag in mindering te krijgen op de originele factuur moet hetzelfde factuurnummer
gebruikt worden. Wanneer het correctiedocument (bijvoorbeeld een creditnota) een ander nummer
heeft dat bewaart moet blijven, kan dit nummer ingevoerd worden in een andere kolom zoals
Doc.Origineel (Origineel Documentnummer).
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Boekhouden via het kasstelsel

Instellen van het leveranciersregister met kostenplaatsen
Het is mogelijk het klanten/leveranciers register te beheren als kostenplaatsen (zie ook de pagina
Kostenplaatsen en Winstcentra). Een gedetailleerde toelichting vindt u op de Engelstalige pagina
Accounting on turnover or collected .

We raden u aan de KP3 kostenplaatsen te gebruiken (degene waar de rekeningen worden
voorafgegaan door een puntkomma ";")
De kostenplaatsen saldi voor klanten en leveranciers verschijnen niet in de Balans.

Transacties
 

https://www.banana.ch/area/en/node/6509
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Diverse verrichtingen

De verschillende functies in de lijst op deze pagina gebruiken dezelfde methode als bij klanten. Voor
meer informatie bezoekt u de bijbehorende klant pagina's.

De factuurkolom weergeven in de Transactietabel
Zie Klanten -De factuurkolom weergeven in de Transactietabel
 

Automatisch aanvullen van factuurgegevens
Zie Klanten - Automatisch aanvullen van factuurgegevens
 

Factuur-rijen ophalen en Koppeling naar factuur openen
commando's
Zie Klanten -Factuur-rijen ophalen en Koppeling naar factuur openen commando's
 

Activeren van de adreskolommen (optioneel)
Zie Klanten - activeren van de adreskolommen

Instellen van de leveranciersinstellingen
Kies het commando Rapporten → Leveranciers → Instellingen...
Het is belangrijk om in het veld "Groep of rekening" de groep van het Rekeningschema aan te
geven waarin de diverse leveranciersrekeningen zijn gegroepeerd.
Voor een uitleg van de diverse opties zie Klanten- en leveranciersinstellingen.
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Lijst Leveranciersfacturen

De ontvangen facturen weergeven
Commando: Rapporten → Leveranciers → Ontvangen facturen van leveranciers

In deze tabel worden alle facturen die deel zijn van het Leveranciersregister of die bij een individuele
leverancier horen weergegeven.

De openstaande facturen weergeven
Commando: Rapporten → Leveranciers → Open rekeningen per leverancier

In deze tabel worden alleen de facturen die een saldo ongelijk nul hebben weergegeven.

Voor vreemde valuta boekhouding: als er niet geboekte wisselkoersverschillen zijn voor een bepaalde
leverancier wordt een regel "Aanpassing wisselkoersverschillen" weergegeven die het saldo in de
open facturen lijst in evenwicht brengt met het saldo op de rekeningkaart.

Facturen weergeven op vervaldatum
Commando: Rapporten → Leveranciers → Open facturen op vervaldatum

In deze tabel worden de facturen die een saldo ongelijk nul hebben weergegeven, gegroepeerd op
vervaldatum.
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Payment orders for open invoices

The new Payments function allows you to create payment orders (pain.001) starting from a list of
transactions or from reading the QR codes of invoices received.

The pain.001 files are XML messages that contains details of the payments to be made and that can
be uploaded to the portal of the major financial institutions. Banana currently supports the Swiss
payment standards.

This document explains the procedure for creating a payment order starting from a list of open
supplier invoices booked in your accounting file. If you want to understand how payments work in
Banana, we recommend reading the document Payment orders PAIN.001 .

Prerequisites and important notes
Currently the payment functionality is available in the Dev-Channel version, so please install the
latest version of Banana Accounting+ Dev Channel .
This extension works only with the Advanced Plan , you can request a 1 month promo code
from our support service.
The extension is currently in Beta Test, please check everything and report any
problem.

How to create a pain.001 payment order
Open your accounting file (double entry accounting or income-expense accounting ) or1.
download our example file
The first time, install the Payment functionalities2.
Set up the debit bank account, which will be used when creating the payment order. In the3.
Accounts table, select the debit account and complete the following data (Address view)):
- Name, surname or company name (bank account holder)
- IBAN (IBAN account of the bank or postal account to be debited)
- Bank clearing (BIC code of the financial institution to be debited)
Check and update the address and payment information of your suppliers in the Accounts4.
table (Address view).
If you don't have a list of suppliers, please define it according to our explanation in the
Suppliers section.

 
Enter the invoices of your suppliers in the Transactions table. You don't need to add any5.
payment information, as it will be added automatically by the program.

http://www.banana.ch/apps/en/node/9327
https://www.banana.ch/en/insiderprogram
https://www.banana.ch/en/buy
https://cdn.banana.ch/portal/repodata/ghba/Switzerland/payments/doc/Payments_2022_en.ac2
http://www.banana.ch/apps/en/node/9327
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Select the command Reports→ Suppliers → Create file from open invoices6.
The program will create the payment/data for each open invoice and append it to the
transactions table. These transactions, won't affect the accounting result

7.
The dialog 'Payment file' will appears, select the invoices you want to pay and click on the next8.
button

 
Complete with the name, IBAN and BIC of the account to be debited, click on the next button9.
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A summary of the payment file is displayed and you can specify where to save it. Click on10.
Finish, you will be asked to save the payment file, which you can upload to your bank. Note: In
Banana it's not possible to connect to your bank and transmit the file, you need to upload the
file from your computer into the bank app or website.

 
After saving the XML file, a new transaction row with the object payment/file will be added to11.
the end of the Transactions table. 
 

When a payment order is created, the respective payment records are not created in Banana,12.
since the file must be sent to the bank, which will confirm the payment or non-payment (e.g. if
the debit account is incorrect, the orders will not will be executed). To automatically create the
payment transactions, it is possible to import the bank's CAMT.054 file into Banana, which
contains all the payments made. To display payments individually on the account statement,
the "Individual booking" option must be activated, otherwise only the total amount will be
displayed on the account statement.
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BTW Beheer

BTW beheer met Banana Boekhouding is compleet en flexibel en maakt het u mogelijk alle mogelijke
BTW gevallen te verwerken met de volgende functies.

BTW-codes tabel
De percentages en andere parameters voor de berekening van BTW worden hierin gedefinieerd.
Bestanden voor landen die ondersteund worden hebben BTW-codes gebaseerd op de benodigde
BTW overzichten.
BTW instellingen in bestandseigenschappen
Hiermee kunt u de standaardrekening instellen waarop de BTW geboekt moet worden en de
bedragen die gebruikt moeten worden om te boeken op kostenplaatsen en winstcentra.
BTW kolommen in de rekeningtabel
Een BTW-code kan worden geassocieerd met een specifieke rekening zodat er automatisch de
standaard BTW-code wordt voorgesteld wanneer de rekening wordt gebruikt in de
transactietabel.
BTW kolommen in de transactietabel
Bij het boeken wordt de BTW-code aangegeven en het programma berekent de BTW en boekt
deze op de betreffende rekeningen.
BTW overzicht
Is een overzicht van alle BTW transacties voor de gedefinieerde periode. U kunt dit naar uw
eigen behoefte aanpassen.
Extensies voor nationale BTW overzichten.
Dit zijn extra overzichten, verschillend voor ieder land, die BTW gegevens afdrukken of
exporteren in het formaat dat vereist is voor de belastingdienst. Zie National VAT
documentation.

Zie ook:

National VAT documentation (Engelstalig)
Specifieke BTW documentatie voor Zwitserland, Italië en andere landen.
Voor Duitsland klik hier, Frankrijk hier en Italië hier.
BTW-codes bijwerken
Als er veranderingen in regelingen en percentages zijn (Engelstalig, voor Zwitserland).
Naar nieuw bestand converteren
Om van een boekhouding zonder BTW naar een met BTW over te gaan of andersom.

https://www.banana.ch/en/node/10872
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Theorie

BTW (Belasting Toegevoegde Waarde) is een belasting die voor rekening komt van de consument.
Iedere BTW-plichtige moet de belasting berekenen en periodiek afdragen aan de Belastingdienst.

Ieder land heeft zijn eigen BTW tarieven die worden vastgesteld in verschillende percentages
afhankelijk van het soort goederen of diensten. Bepaalde goederen en diensten zijn vrijgesteld of
uitgesloten.

De percentages variëren al naar gelang de financiële behoefte van het land: Daarom kunnen er in de
loop der jaren veranderingen optreden.

BTW tarief
In deze uitleg gebruiken we de volgende percentages om de berekeningen duidelijker te maken:

10 % normaal tarief
5% laag tarief
0% uitgesloten of vrijgestelde transacties

BTW berekening
Netto prijs x BTW percentage / 100 = BTW bedrag

Voorbeeld:
Netto prijs 300
BTW tarief 10%
BTW bedrag = 300 x 10 / 100 = 30
 

Bruto prijs berekening
Netto prijs + BTW bedrag = Bruto prijs

Voorbeeld:
300 + 30 =  330

Soms is het brutobedrag bekend en moeten de netto- en BTW-bedragen worden gevonden.

Netto prijs berekening
Bruto prijs / (100 + BTW tarief) x 100 = Netto prijs

Voorbeeld:
330 / (100 + 10) x 100 = 300

De nettoprijs vormt de kosten (aankoop) of de opbrengsten (verkoop) van de onderneming.
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BTW bedrag berekening
Bruto prijs - Netto prijs = BTW bedrag

Voorbeeld:
330 - 300 = 30

of

330 - [330 / (100 + 10) x 100] = 30

Het BTW-bedrag vormt het debetbedrag (verkopen) of het creditbedrag (aankopen) voor van de
belastingdienst.

BTW percentage berekening
BTW bedrag / Netto bedrag x 100  = BTW percentage

Voorbeeld:
30 / 300 x 100 = 10%

Een ander voorbeeld:

20 / 400 x 100 = 5%

Deze rekenmethode wordt gebruikt wanneer het percentage niet bekend is.
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Bestandseigenschappen (BTW tab)

Dit tabblad verschijnt alleen als een boekhouding met BTW is gekozen.

Het tabblad voor het instellen van BTW rekeningen kan bereikt worden via menu Bestand →
Bestandseigenschappen → tabblad BTW.

BTW-rekening

De automatische BTW-rekening, die aanwezig is in het rekeningschema, staat hier standaard
ingesteld. In dit geval hoeft de BTW rekening niet toegevoegd te worden aan de BTW-codes tabel.

Door alleen de BTW-rekening met automatische uitsplitsing in te stellen, vloeien alle BTW-bedragen,
zowel van de verkopen als van de aankopen, respectievelijk naar het credit en het debet van deze
rekening en is het niet nodig de rekening voor terugvorderbare BTW in te stellen. Aan het einde van
het kwartaal wordt het saldo van de BTW-rekening voor automatische uitsplitsing overgeboekt naar
de rekening voor te betalen BTW (of de BTW-rekening van de belastingdienst).

BTW rekening verhaalbaar

Als de automatische BTW uitsplitsingsrekening niet ingesteld is als de enige BTW rekening wordt de
rekening verhaalbare BTW ingesteld. In dat geval hoeft de BTW rekening niet toegevoegd te worden
aan de BTW-codes tabel.

BTW-afronding

Hier voert u in hoe de BTW bedragen moeten worden afgerond; als u bijvoorbeeld 0.05 invoert
worden de BTW bedragen afgerond naar veelvouden van 0.05.

Kostenplaats 1 (KP1), 2 (KP2), 3 (KP3)

Voor ieder Kostenplaats kunt u kiezen welk bedrag gebruikt moet worden voor de transactie in
kostenplaats:
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Transactiebedrag gebruiken
Bedrag met BTW gebruiken
(Wanneer kostenplaatsen worden gebruikt voor Klanten/Leveranciers rekeningen)
Bedrag zonder BTW gebruiken
(Wanneer kostenplaatsen worden gebruikt voor Inkomsten en Uitgaven)

Nota bene: Als één van deze parameters veranderd wordt moet de boekhouding opnieuw berekend
worden.

Gerelateerde pagina's:

BTW Beheer
Kostenplaatsen en Winstcentra
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Tabel BTW Codes

Met de instellingen in de tabel BTW codes kunt u alle parameters voor BTW beheer definiëren. Er zijn
de volgende instellingen:

Verschuldigde of verhaalbare BTW
Transactie bedrag geregistreerd als netto, bruto of BTW bedrag als 100% (BTW betaald aan de
douane)
BTW tarieven die van toepassing zijn
De rekening waarin de BTW geboekt moet worden
Speciale afronding voor iedere code
Methode voor het groeperen en voor het berekenen van de totalen.

De BTW-codes tabel heeft een weergave Basis en een weergave Compleet. Het verschil tussen de
twee is dat de weergave Compleet diverse kolommen weergeeft die niet beschikbaar zijn en de
weergave Basis.

Berekeningsmethode
De parameters aangegeven in de BTW-codes tabel worden gebruikt om de BTW van de individuele
transacties te berekenen. De parameters vastgelegd in de BTW-codes tabel kunnen niet worden
veranderd in de transacties. Op deze manier wordt gegarandeerd dat de BTW berekeningen correct
zijn en eenduidig.

Let op: wanneer de waarde van een BTW code, die al gebruikt is in transacties, wordt veranderd
worden de veranderingen nog niet meteen doorgevoerd; in dit geval is het nodig het Boekhouding
controleren commando uit te voeren (menu Acties → Boekhouding controleren... ). Wanneer de
BTW-codes tabel wordt veranderd vraagt het programma aan de gebruiker, d.m.v. melding in het Info
venster, een complete herberekening te doen als voorzorg.

Gedetailleerde beschrijving van de kolommen
Voer de volgende gegevens in de volgende kolommen in:

Groep: een code of getal dat de groep waartoe de code hoort identificeert.
BTW code:

Gewone BTW codes
De code om de BTW code te identificeren en weer te geven in de transacties.
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Codes voorafgegaan door een dubbele punt ":"
Dit zijn geen echte BTW codes. Deze worden gebruikt in de transactietabel om BTW
gevallen met meer detail te specificeren (bijvoorbeeld in BTW-registratie met
omgekeerde heffing; twee BTW codes worden tegelijk gebruikt, gescheiden door ":",
zodat het programma het te betalen en te ontvangen BTW bedrag kan berekenen).

Beschrijving: een tekst voor de beschrijving van de BTW code of de groep.
Uitschakelen:
Hiermee kunt u BTW codes die niet worden gebruikt uitschakelen. Vergemakkelijkt het invoeren
van gegevens in de transactietabel.

1 - de BTW code wordt niet weergegeven in de automatisch-aanvullen-lijst
(Transactietabel), maar nog wel kan worden gebruikt.
2 - de BTW code wordt niet weergegeven in de automatisch-aanvullen-lijst en niet kan
worden gebruikt.

Optellen in: afkorting of getal van de groep waarin de rij die bij een code hoort moet worden
opgeteld.
Gr1: deze kolom wordt gebruikt voor specifieke groeperingen.
De afbeelding laat de groepering zien voor de bedragen van de Zwitserse BTW teruggave.
Gr2: code voor extra groeperingen.
Verschuldigde BTW:
Als het woord Ja wordt ingevoerd betekent dit dat de BTW afgedragen moet worden (aan de
staat verschuldigd is).
Als de cel leeg wordt gelaten betekent dit dat de BTW verhaalbaar is (teruggevraagd kan
worden).
BTW Bedragtype: geeft aan hoe de software het transactiebedrag interpreteert:

0 (of lege cel) met BTW (het transactiebedrag wordt beschouwd als inclusief BTW).
1 = zonder BTW (het transactiebedrag wordt beschouwd als exclusief BTW).
2 = BTW bedrag (het transactiebedrag wordt beschouwd als het BTW bedrag).
Bedragtype 2 wordt met name gebruikt om de op de factuur van de expediteur betaalde
of gedebiteerde douane-BTW te verantwoorden. Meer details over de opname vindt u op
deze pagina: Ent ering VAT at customs for import  (pagina in het Engels).

% BTW: het BTW percentage.
BTW% op bruto: wordt gewoonlijk leeg gelaten. In speciale gevallen moet het woord "Ja"
worden ingevoerd als het BTW percentage moet worden toegepast op het brutobedrag
(inclusief BTW) en niet op het belastbare bedrag.
% Vrijgesteld: als het niet mogelijk is 100% in mindering te brengen voor een BTW code voer
dan hier het niet in mindering te brengen percentage in (bijvoorbeeld 50%).
BTW% op bruto: is over het algemeen leeg. Het woord "Ja" moet alleen worden ingevoerd als
het BTW percentage toegepast moet worden op het bruto bedrag (inclusief BTW) en niet op het
belastbare bedrag (bijvoorbeeld voor vlak tax regelingen).
BTW rekening: de rekening waarop de berekende BTW automatisch wordt geboekt.
In Bestands- en boekhoudingseigenschappen (menu Bestand) kan een rekening, die wordt
gebruikt als BTW rekening, worden gedefinieerd.
Afronden Min.: minimum waarde voor afronding. Als deze wordt leeg gelaten wordt de
afronding aangegeven in de basis gegevens van de boekhouding gebruikt.
Niet waarschuwen: er zijn speciale transacties die het programma zou kunnen interpreteren
als een vergissing maar die in werkelijkheid correct zijn. Voer "Ja" in voor de BTW code waar dit
om gaat om te voorkomen dat de software foutmeldingen geeft.

Wanneer de transacties met BTW worden ingevoerd door de BTW code in de BTW-code kolom toe te
passen berekent de software automatisch alle bedragen die betrekking hebben op de BTW en boekt
deze op de BTW rekening.

https://www.banana.ch/en/node/10883
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Hercontrole van het boekhoudbestand
Wanneer het programma het boekhoudbestand controleert, als de transacties niet zijn geblokkeerd,
herlaadt het de BTW parameters die toegekend zijn aan iedere BTW code. Wanneer een BTW code
instelling is veranderd wordt met deze verandering rekening gehouden in de overeenkomstige
transactiekolommen (die niet door de gebruiker veranderd kunnen worden).

Daarom stelt het programma voor een volledige hercontrole te doen wanneer de BTW tabel
veranderd wordt.

Een nieuw percentage toevoegen
Wanneer een nieuw percentage wordt toegevoegd moet dit in een nieuwe rij gebeuren; voer in de
nieuwe rij de gegevens van de nieuwe BTW code met het nieuwe percentage in er daarbij op lettend
dat de correcte groepering ingevoerd wordt.
Verander geen code die al is ingevoerd in de transacties.

BTW-codes voor in het buitenland geleverde producten en
diensten
Het is mogelijk in de BTW codes tabel aparte groepen in te stellen, BTW codes voor het leveren van
producten en diensten in het buitenland, met specifieke tarieven voor het land waarin men actief is
en waarvoor ook BTW aan het buitenland verschuldigd is.

De overeenkomstige BTW code wordt ingesteld voor ieder land, opgeteld in zijn eigen groep of in een
totalisatiegroep die betrekking heeft op de BTW die betaald moet worden aan  het buitenland.

Om de bedragen te bekijken die betaald moeten worden gaat u naar het menu Rapporten → BTW
overzicht... en kiest u de specifieke code voor het land of de totalisatiegroep die betrekking heeft op
de BTW die betaald moet worden aan  het buitenland.

Het is niet mogelijk BTW opgaven in het buitenland elektronisch te doen.

Eigen groepen
Door groepen aan te maken met meerdere totalen kan de gebruiker de totalen verkrijgen die nodig
zijn voor de BTW aangifte.
Door in het BTW rapport de optie Eigen groeperingsschema gebruiken te activeren berekent de
software de totalen precies zoals aangegeven in de volgorde van de aangegeven groepen in de BTW-
codes tabel.
De groepen worden gebruikt om de totalen van groepen transacties te verkrijgen, bijvoorbeeld de
totalen voor alle export- of importtransacties.

Gerelateerd documenten: 

BTW codes importeren

BTW documentatie per land
Koppeling naar BTW documentatie specifiek voor Zwitserland, Italië of andere landen
(Engelstalig).
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Een BTW-code aan een rekening verbinden

In een boekhouding met BTW is het mogelijk in de Rekeningentabel een BTW code te koppelen aan
inkomsten/uitgaven rekeningen. Daardoor kan het programma, tijdens het boeken van in- en
verkopen, automatisch de BTW code invoeren en de kolommen aanvullen met BTW gegevens
wanneer het rekening nummer ingevoerd wordt.

Om de codes te koppelen:

Klik in de rekeningentabel op weergave Andere. In deze weergave is de BTW code kolom
standaard zichtbaar.
Als u de BTW code kolom in de weergave Basis wilt tonen klikt u op het commando Gegevens →
Kolommen instellen.
Voer de BTW codes in voor de inkomsten/uitgaven in de BTW code kolom.
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BTW afronding

Het Zwitserse systeem voor de berekening van de BTW voorziet in een berekening tot op de cent,
zonder afronding.

Degenen die BTW-bedragen naar centen moeten laten afronden, kunnen de volgende procedure
volgen:

Boek zoals gebruikelijk in de transactietabel door de betreffende BTW code te gebruiken
Op de volgende rij boekt u de uitgaven of de opbrengsten rekening die u in de vorige regel
gebruikt heeft in debet en credit
Voer de centen die afgerond moeten worden in de kolom Bedrag in
Voer in de kolom BTW code een BTW code in met bedrag type 2 (100% BTW bedrag)
bijvoorbeeld M81-2 zoals in het voorbeeld hierna
Als de centen naar beneden moeten worden afgerond voert u de code in met een minteken
ervoor, bijvoorbeeld "-M81-2".
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De BTW rekeningen configureren

Wat zijn BTW rekeningen?
De BTW rekeningen zijn de rekeningen waarop de BTW bedragen automatisch geboekt worden,
gebaseerd op de BTW code instellingen in de BTW-codes tabel.

Als een BTW code wordt gebruikt berekent het programma automatisch de volgende gegevens
gebaseerd op de gegevens die in de transactie worden ingevoerd:

Belastbaar bedrag en BTW-bedrag.
Het belastbare bedrag op de debetrekening.
Het belastbare bedrag op de creditrekening.
BTW-bedrag dat op de BTW-rekening moet worden geboekt.

Als u met de muis over de transactie in het informatiewindow beweegt ziet u welke bedragen worden
geboekt op de verschillende rekeningen.

Algemene BTW rekening (automatisch)
Als er een standaard BTW rekening is ingesteld in Bestand → Bestandseigenschappen → BTW, wordt
deze telkens gebruikt als een boeking wordt gedaan met een BTW code. In dat geval moeten er geen
BTW rekeningen voor de diverse BTW codes in de BTW-codes tabel ingesteld worden.

Inbare en verschuldigde BTW-rekeningen
In de BTW-codes tabel, kunt u in de kolom BTW rekening de rekening voor inbare of verschuldigde
BTW aangeven volgens de BTW code (actief of passief). Als in dit geval specifieke rekeningen zijn
ingesteld in de BTW-codes tabel moet de standaard BTW rekening (Algemene BTW rekening -
automatisch) niet worden ingesteld in het BTW tabblad van Bestandseigenschappen.

Een enkele of meerdere BTW rekeningen gebruiken?
In de boekhouding moet het actieve deel worden gescheiden van het passieve deel. Als de
terugvorderbare BTW wordt verrekend met de verschuldigde BTW, moet alleen het werkelijk
verschuldigde BTW-bedrag in de balans worden opgenomen.
Vanuit boekhoudkundig oogpunt is het in de meeste gevallen niet essentieel, sterker nog, het is beter
om slechts één BTW-rekening te hebben.

Voor rapportagedoeleinden is het echter nuttig om de verschillende soorten BTW-transacties van
elkaar te scheiden. In programma's die geen gebruik maken van BTW-codes is het noodzakelijk om
elke verrichting te scheiden op aparte rekeningen. Met Banana Boekhouding is het dankzij de BTW-
codes en het BTW-overzicht mogelijk om veel zinvollere details te verkrijgen, terwijl ook een enkele
BTW-rekening wordt gebruikt:

Mutaties en totalen (belastbare BTW, BTW-bedrag, verantwoorde BTW) voor iedere BTW code.
Mutaties en totalen per BTW tarief.
Mutaties en totalen per BTW rekening.
Mutaties en totalen per  verschuldigd en invorderbaar BTW bedrag.
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Het is niet nodig verschillende BTW rekeningen te gebruiken om BTW transacties te beheren.

Banana Boekhouding geeft u de keuze om een algemene BTW rekening te gebruiken, ingesteld in de
Bestandseigenschappen, of verschillende BTW rekeningen, ingesteld in de BTW-codes tabel.

Voordelen van het gebruik van één enkele BTW rekening

Na meerdere jaren ontwikkeling hebben we ingezien dat het gebruik van een enkele BTW rekening
intuïtiever is en daarom hebben we voor het Zwitserse rekeningschema gekozen voor een enkele
BTW rekening (2201 BTW aangifte), daarbij uiteraard voor iedereen de mogelijkheid open latend om
de instellingen te veranderen.

De balans en de resultatenrekening zijn beter leesbaar (er zijn niet veel BTW rekeningen).
De mogelijkheid om rekeningen te hebben (bijvoorbeeld van de opbrengsten) om transacties te
boeken met verschillende BTW tarieven.
U weet meteen wat de verschuldigde BTW is zonder meerdere rekeningen op te hoeven tellen.
Directe weergave van alle BTW transacties.
Alle BTW transacties in debet en credit worden in de BTW rekeningkaart weergegeven.

Voordelen van het gebruik van meerdere BTW rekeningen

Wanneer u BTW codes gebruikt is de boeking op een specifieke BTW rekening een herhaling van
informatie die u al heeft met de BTW code in de gedetailleerde beschrijving ervan.

In landen zoals Duitsland is het gewoon een verschillende BTW rekening te hebben voor iedere soort
transactie zodat de BTW aangifte gedaan kan worden door de saldi van de individuele BTW
rekeningkaarten te gebruiken.

Om in deze gevallen compatibiliteit met dit systeem te hebben is het nuttig verschillende BTW
rekeningen te hebben voor ieder BTW tarief.

De BTW rekeningen afsluiten aan het eind van de periode
Aan het einde van de BTW berekeningsperiode is het nuttig de debet en credit BTW rekeningen af te
sluiten en het saldo over te brengen naar één rekening. Dit maakt het mogelijk om:

Het exacte bedrag dat moet worden betaald of ingevorderd te boeken
Bij iedere nieuwe periode de rekening "2201 BTW aangifte" van nul te laten beginnen waardoor
het makkelijker is om te controleren op verschillen of fouten.

Zie voor het periodiek afsluiten van rekening "2201 BTW aangifte" pagina Periodieke afsluiting en
BTW betaling.
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Transacties

De Rekeningschema voorbeelden die onderdeel zijn van het Banana Boekhouding programma zijn al
voorzien van BTW rekeningen. De BTW rekening volgens het BTW overzicht zit in het rekeningschema
en is ingesteld in Bestandseigenschappen → BTW tabblad. (In dit geval hoeft u geen enkele BTW
rekening in te voeren in de BTW-codes tabel).

Wanneer u geen gebruik maakt van een Rekeningschema dat al beschikbaar is in de Banana
Boekhouding software moet u er voor zorgen dat de noodzakelijke BTW rekeningen aanwezig zijn in
uw eigen Rekeningschema. Ons advies is de "BTW volgens BTW overzicht" rekening te gebruiken en
deze in te voeren in Bestandseigenschappen → BTW tabblad.

In de BTW-codes tabel staan codes voor verkopen en voor inkopen. Gebruik bij het invoeren van de
transacties de toepasselijke BTW code.

De software splitst automatisch de BTW bedragen en boekt deze in de "BTW volgens BTW overzicht"
rekening of in de BTW rekening die door de gebruiker is aangegeven in Bestands- en
boekhoudingseigenschappen.

BTW kolommen in de Transactietabel (Weergave Volledige
BTW)
De volledige uitleg van de belangrijkste kolommen van de Transactietabel vindt u in de pagina
Transactietabel kolommen en weergaven.

In de bestanden voor dubbel boekhouden met BTW of in de Inkomsten & Uitgaven
boekhoudingsbestanden met BTW vindt u de volgende BTW kolommen:

BTW-code: voor iedere transactie met BTW moet u een van de BTW codes van de BTW-codes
tabel invoeren. In Omgekeerde BTW boekingen kunnen twee BTW codes worden gebruikt,
gescheiden door een ":".
BTW %: het programma vult automatisch het BTW percentage in dat bij de BTW code hoort die
u ingevoerd heeft. Als het bedrag voorafgegaan wordt door een "+/-" teken is het een
Omgekeerde BTW boeking.
Extra Btw: Een code gerelateerd aan extra informatie over de BTW, te gebruiken in zeer
uitzonderlijke gevallen.
Het is mogelijk om een symbool in te voeren om specifieke BTW gevallen aan te geven. Het
programma geeft opties aan die overeenkomen met BTW codes, beginnend met een dubbele
punt ":".
%Eff.: het programma voert automatisch het BTW percentage in dat hoort bij het netto bedrag.
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Dit percentage is verschillend van het normale percentage als dit gerelateerd is aan het bruto
bedrag.
Belastbaar: wanneer u de BTW code invoert geeft de software automatisch het belastbaar
bedrag aan (zonder BTW)
Bedr. BTW: het programma geeft automatisch het BTW bedrag aan
BTW-Rek.: de rekening waar de BTW wordt geboekt wordt automatisch aangegeven; deze
rekening is eerder ingevoerd in het BTW tabblad in Bestands- en
boekhoudingseigenschappen (in het menu Bestand).
Bedragtype: dit is een code die aangeeft dat de software het transactiebedrag interpreteert
als:

0 (of lege cel) met BTW, het transactiebedrag wordt beschouwd als inclusief BTW
1 = zonder BTW, het transactiebedrag wordt beschouwd als exclusief BTW
2 = BTW bedrag, het transactiebedrag wordt beschouwd als 100% BTW bedrag
Behalve de betekenis van de code heeft deze cel de volgende eigenschappen:
Bedragtype is niet veranderbaar, de standaardinstelling

De kolom is beveiligd
Het programma gebruikt de betreffende waarde uit de BTW-codes tabel
Wanneer u de waarde in de BTW-codes tabel verandert en u herberekent de
boekhouding dan gebruikt het programma de nieuwe waarde van deze code.

Bedragtype is veranderbaar, dit kan éénmalig ingesteld worden met het commando
Nieuwe functies toevoegen (NB: Het activeren van deze optie kan niet meer ongedaan
gemaakt worden).

Wanneer u de BTW code wijzigt gebruikt het programma het Bedragtype dat bij
deze code hoort.
De waarde kan handmatig worden veranderd
Wanneer de boekhouding wordt herberekend wordt de waarde aangegeven in de
Transactietabel aangehouden.

Percentage vrijgesteld: dit geeft het Vrijgesteld % aan.
Wanneer u de BTW code invoert of verandert gebruikt het programma het Vrijgesteld %
dat verbonden is met de BTW code uit de BTW-codes tabel.
U kunt deze waarde handmatig veranderen.

BTWgeboekt: dit is het BTW bedrag geboekt op de BTW rekening.
Het wordt berekend door het programma op basis van het Transactiebedrag, het Bedragtype en
het Vrijgestelde percentage.
BTW-nummer: dit is de code of het BTW nummer van uw klant/leverancier.
Als u een transactie met BTW invoert is het mogelijk het BTW nummer van uw tegenpartij in te
voeren. Als u in de Rekeningentabel, in uw klanten/leveranciersregister hun BTW nummer
invoert wordt dit automatisch geladen in de Transactietabel, in de BTW-nummer kolom.
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Transacties met BTW

Houd de informatie op de pagina Transacties in gedachten bij het invoeren van transacties met BTW.

Een BTW boeking invoeren is erg gemakkelijk:

Voer de datum, het documentnummer en factuurnummer in de desbetreffende kolommen in
Voer de beschrijving, de debet- en de creditrekening in
Voer het bruto bedrag in (inclusief BTW)
Voer de BTW code in voor het soort transactie (inkopen, verkopen, ...), die aanwezig is in de
BTW-codes tabel.

Hoe BTW transacties te corrigeren
Wanneer u de vergissing meteen opmerkt kunt u de transactie aanpassen; dit is alleen mogelijk als u
nog geen BTW aangifte gedaan heeft en de boekhouding nog niet geblokkeerd is.

Wanneer echter uw boekhoudbestand is geblokkeerd of als u al een BTW aangifte gedaan heeft kunt
niet de foute transactie verwijderen, maar moet u enkele annuleringsboekingen doen en dan de
goede transactie opnieuw invoeren.

Om de BTW boeking te corrigeren moet u:

Een nieuwe transactie aanmaken en daarbij de Debet en Credit rekeningen die gebruikt werden
in de foute transactie omkeren
Hetzelfde bedrag invoeren
Dezelfde BTW code invoeren maar dan voorafgegaan door een minteken (bijvoorbeeld: -V81)
Een nieuwe transactie invoeren met de correcte rekeningen, bedrag en BTW code.

Afhankelijk van de ernst van de vergissing zou u kunnen overwegen uw lokale belastingkantoor te
informeren; doorgaans zullen zij u vragen een specifiek formulier te downloaden om fouten in de
vorige BTW periode te corrigeren.

Hoe alleen het BTW bedrag in te voeren
Er zijn gevallen waarbij alleen het BTW bedrag geboekt moet worden, bijvoorbeeld wanneer u een
schadevergoeding ontvangt van de autoverzekering.

In deze gevallen kunt u als volgt te werk gaan:
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Voer de datum en het documentnummer in de desbetreffende kolommen in
Voer in de Creditrekening kolom de rekening in die gebruikt wordt om het BTW bedrag te
betalen (de Debetrekening kolom blijft leeg).
Voer in de kolom Bedrag het BTW bedrag dat betaald moet worden in.
Voer in de kolom BTW-code een BTW-code in die aangeeft dat dit bedrag alleen BTW is (BTW
type is 2 in de BTW codes tabel).
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Transacties met verschillende BTW tarieven

Er kunnen gevallen zijn waarin het totale bedrag bestaat uit diverse belastbare bedragen met
verschillende BTW percentages. In dit geval wordt de transactie over meerdere rijen geboekt.

Voor het boeken van de transactie moet u:

Verdeel het totale bedrag in verschillende bedragen, ieder met zijn eigen BTW percentage.
Voer op iedere rij het deelbedrag (brutobedrag met BTW) in en voer de BTW code in voor het
specifieke percentage.
Wannneer u de meervoudige boeking beëindigd hebt controleert u of de som van de diverse
brutobedragen en de BTW bedragen overeenkomen met het totaal van de factuur..

Voorbeeld:

BTW Vrijstelling

Als u in de factuur ook nog posten hebt met BTW vrijstelling moet u op dezelfde manier handelen als
hierboven en de BTW vrijstelling code kiezen uit de BTW-codes tabel.
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Terugboekingen/Creditnota

Wanneer er terugboekingen zijn voor credit- of debetnota's, of gewoon om vorige boekingen, waarvan
de bedragen onderhevig zijn aan BTW, te corrigeren, dan moet de BTW ook omgekeerd worden in de
correctietransactie.

Voor de transactie:

Verwissel de rekeningen, die in de vorige transactie gebruikt zijn, waarnaar de creditnota
verwijst, in de kolommen Debet en Credit.

Om de BTW om te keren zijn er twee mogelijkheden:

Zet een minteken voor de BTW code (bijvoorbeeld -V81).
Gebruik een van de codes, die naar kortingen verwijzen, die al ingesteld zijn in de BTW-codes
tabel.

Met deze procedures wordt het BTW bedrag aangepast.

Voorbeeld van een creditnota op een verkoop

Wanneer een klant een defect vindt in een gekocht product wordt er gewoonlijk een creditnota ten
gunste van de klant gestuurd. De creditnota heeft een daling van de inkomsten tot gevolg en daarom
een terugvordering van de BTW.

Bijvoorbeeld: we voeren een verkoopwaarde in van 12000 inclusief 8.1% BTW. Daarna sturen we een
creditnota van 200 naar de klant voor een kapot product.

In de transactie van de creditnota die naar de klant is gestuurd:

Zijn de rekeningen voor de verkoop, waarnaar de creditnota verwijst, omgekeerd.
Wordt de BTW code van de verkoop, voor het terugvorderen van de BTW op de creditnota,
ingevoerd voorafgegaan door een minteken.

Voorbeeld van een creditnota op een aankoop

Als we een creditnota van een leverancier ontvangen is de procedure voor de boeking gelijksoortig:

De rekeningen die gebruikt zijn voor de aankoop worden omgekeerd.
Voer dezelfde BTW code die gebruikt is voor de aankoop in, voorafgegaan door een minteken.

Bijvoorbeeld: we boeken een factuur van de inkoop van goederen voor 3000 inclusief 8.1% BTW. We
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krijgen dan een creditnota van 300 van onze leverancier vanwege een defect product.

In de transactie van de creditnota ontvangen van de leverancier:

De rekeningen van de aankoop waaraan de creditnota refereert zijn omgewisseld.
Voor het terugvorderen van de BTW op de creditnota wordt de BTW code van de aankoop
gebruikt, voorafgegaan door een minteken.
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Afsluiting periode en betaling BTW

Automatisch op nul zetten van de rekening "BTW volgens
BTW overzicht" aan het eind van een kwartaal
Aan het einde van een periode, moet u het saldo van de "BTW volgens BTW overzicht" rekening op
nul zetten, door het ten laste te brengen van de rekening verschuldigde BTW.

Deze boeking houdt in:

Het op nul stellen van het saldo op de rekening "BTW volgens het BTW overzicht".
Overdracht van het BTW saldo naar de rekening "verschuldigde BTW".

Indien dit resulteert in een BTW debet, wordt het BTW-saldo geboekt in credit van de
rekening "verschuldigde BTW" en in debet van de rekening "BTW volgens BTW overzicht".
Het saldo wordt op nul gezet.
Indien dit resulteert in een BTW credit, wordt het BTW-saldo geboekt in debet van de
rekening "verschuldigde BTW" en in credit van de rekening "BTW volgens BTW overzicht".
Het saldo wordt op nul gezet.

BTW rekeningkaart na het overbrengen van het periode saldo naar de rekening Te betalen BTW

Het saldo van de rekening "BTW volgens BTW overzicht" wordt op nul gezet na de transactie met de
saldo overdracht naar de rekening "Verschuldigde BTW".

Registratie van nul BTW kwartaaloverzichten
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BTW betaling
De rekening Te betalen BTW (of de rekening BTW aan Belastingdienst) heeft een nulsaldo wanneer u
de verschuldigde BTW betaalt.

Voor de transactie:

Voer de datum, document nummer en beschrijving in de betreffende kolommen in.
Voer in de kolom Debet de rekening in van de verschuldigde BTW.
Voer in de kolom Credit de betaalrekening in,
Voer in de kolom Bedrag de betaalde verschuldigde BTW in.

Met dit systeem kunt u uw saldo ieder kwartaal controleren en in het geval van vergissingen kunt u
vinden in welke periode het saldo niet meer klopt.

Te betalen BTW rekeningkaart na de kwartaalbetaling

Let op:

Het BTW-betalingsproces dat we zojuist hebben uitgelegd, verwijst naar de Zwitserse effectieve BTW-
betalingsmethode en de Zwitserse forfaitaire betalingsmethode met BTW-scheiding.
Als u de Zwitserse forfaitaire betalingsmethode zonder BTW-scheiding gebruikt vindt u specifieke
informatie op de pagina  VAT payment and accounting assessment  (Engelstalig).

Hoe een BTW credit te boeken (Zwitserland)
Als aan het eind van een periode bij het berekenen van de BTW aangifte de vorige BTW hoger is dan
de verschuldigde BTW, heeft uw BTW overzicht een debet saldo.

Om de rekening "BTW volgens het het BTW overzicht" op nul te stellen moet u als volgt een
transactie invoeren:

Zet de de rekening "BTW verschuldigd" in de debet kolom

https://www.banana.ch/en/node/10876#5
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Zet de rekening "BTW volgens het BTW overzicht" in de credit kolom

Gewoonlijk wordt in Zwitserland de BTW credit terugbetaald aan het bedrijf zonder het credit over te
hevelen naar de volgende periode.

Als uw BTW is terugbetaald moet u als volgt een transactie invoeren:

Zet in de kolom Debet uw betaalrekening.
Zet in de kolom Credit uw rekening "verschuldigde BTW" (waarbij het saldo naar nul moet
gaan).
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BTW-registratie met toepassing van de
verleggingsregeling

BTW-registratie met toepassing van de verleggingsregeling
Normaliter wordt de BTW geheven bij de verkoper van de goederen. Verlegging van heffing is de term
die wordt gebruikt om aan te geven dat de BTW bij de koper wordt geheven.

De verleggingsregeling wordt vooral gebruikt wanneer in het buitenland goederen of diensten worden
aangekocht die bij de douane niet zijn belast. In deze gevallen is de exporterende verkoper vrijgesteld
van BTW, terwijl de importerende koper wordt belast tegen het lokale tarief en dit eventueel kan
aftrekken. Daarnaast zijn er nog andere gevallen van aankopen in het buitenland die onder de
verleggingsregeling vallen en elk land voorziet in zijn belastingwetgeving in verschillende situaties. Bij
de boeking van BTW met de verleggingsregeling:

De transactie moet worden opgenomen zodat deze resulteert in verplichte BTW.
Als de BTW aftrekbaar is met het aftrekbare gedeelte van de BTW ook worden geboekt.

Software vereisten
De mogelijkheid om de transactie onder de verleggingsregeling, de belastingplicht en de BTW-
terugvordering op één enkele rij te boeken, is beschikbaar in Banana Accounting Plus .

Verleggingsregeling met alleen BTW verplichting
Als u belasting moet betalen over de aankoop van goederen of diensten, maar niet de mogelijkheid
heeft om de BTW af te trekken:

Geef de BTW code aan die bij de transactie hoort.

De verplichting met de verleggingsregeling zonder aftrek wordt over het algemeen gebruikt in het
geval dat men profiteert van een vaste-kostenregeling of wanneer het soort uitgave niet aftrekbaar
wordt geacht.

Verleggingsregeling met BTW verplichting en BTW
teruggave
Als het verplichte BTW bedrag gelijk is aan dat van de aftrekbare BTW kan de verlegging worden
geboekt op een enkele rij door zowel de code voor de verplichte BTW als de code voor de aftrekbare
BTW te gebruiken.

U gebruikt gedefinieerde BTW codes en het is niet nodig de BTW tabel aan te passen.
Voer in de regel met de verleggingsregeling BTW de twee gedefinieerde BTW codes in de kolom
BTW code in, gescheiden door een dubbele punt ":".
De twee BTW-codes moeten complementair zijn om het saldo te kunnen verrekenen.

Een van de twee codes moet ingesteld zijn voor verplichte BTW en de andere voor
aftrekbare BTW.

https://www.banana.ch/nl/download_nl
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Het BTW percentage en alle andere parameters voor de berekening moeten identiek zijn.
Als de BTW codes niet dezelfde parameters hebben wordt een foutmelding gegeven.

De volgorde van de codes is niet van belang, u kunt de een of de ander als eerste invoeren.
Bij het herstellen van een boeking moet de eerste BTW code worden voorafgegaan door een
minteken "-".
Een herstelboeking wordt gebruikt om een incorrecte boeking te herstellen. In dit geval worden
de zelfde elementen gebruikt maar wordt de originele boeking omgekeerd:

De te betalen BTW code wordt geboekt als terugvorderbare BTW.
De terugvorderbare BTW code wordt geboekt als te betalen BTW.

In de BTW kolommen worden de bedragen voorafgegaan door het teken "+/-", dat betekent dat
de bedragen elkaar opheffen vanwege de BTW.
In de balans en in het BTW overzicht zijn er aparte mutaties voor debet en credit.

Voorbeelden van transacties met verleggingsregeling

Hierna volgen enkele voorbeelden van BTW verleggingstransacties met verschuldigde en
terugvorderbare BTW:

Boekingen inclusief en exclusief BTW.
Herstelboekingen met BTW codes voorafgegaan door het minteken "-".

Verleggingsregeling met een rekening in vreemde valuta
Wanneer de factuur in een valuta is die anders is dan de valuta van de boekhouding moet de boeking
uitgevoerd worden over twee regels:

de factuur in vreemde valuta wordt ingevoerd in de eerste regel
in de tweede regel wordt de verschuldigde en terugvorderbare BTW geboekt met het bedrag in
de valuta van de boekhouding.

Verlegging met verschillende BTW percentages
Wanneer er verschillende percentages gebruikt moeten worden in de verschuldigde en aftrekbare
BTW, of als de BTW gedeeltelijk teruggevorderd kan worden, moet de transactie over meerdere
regels ingevoerd worden:

In de eerste regel wordt de code voor de verschuldigde BTW ingevoerd.
In een andere regel wordt de code voor de terugvorderbare BTW ingevoerd.
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BTW Overzicht

Het BTW Overzicht geeft een overzicht van de BTW berekening gebaseerd op de gekozen periode, de
ingestelde parameters in de BTW-codes tabel en de gekozen opties.

Het BTW overzicht wordt verkregen door te klikken op menu Reporten > BTW overzicht.

Door de volgende opties te activeren kunt u de bijbehorende gegevens in het BTW overzicht
opnemen:
 

Transacties opnemen

Alle transacties met BTW worden opgenomen.

Totalen voor rekening opnemen

Alle totalen van bewerkingen met BTW worden opgenomen, gegroepeerd per individuele rekening.
 

Totalen per code opnemen

Alle totalen van bewerkingen met BTW worden opgenomen, gegroepeerd per individuele BTW code.

Totalen op percentage opnemen

Alle totalen van bewerkingen met BTW worden opgenomen, gegroepeerd per individueel percentage.
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Niet gebruikte codes opnemen

Ook de ongebruikte codes van de BTW-codes tabel worden getoond.

Eigen groeperingsschema (Groep, Gr) gebruiken

De bewerkingen met BTW worden getoond volgens de groepering van de BTW-codes tabel.

Transacties sorteren op

Met deze optie kunnen de transacties gesorteerd worden op één van de aangegeven opties (Datum,
Doc., Beschrijving, etc. ...).
 

Gedeeltelijk overzicht

Door een code of een groep te specificeren en de benodigde opties te selecteren berekent de
software het totaal van de bewerkingen met BTW van:

Alleen gespecificeerde code (door er een van de lijst te kiezen)
Alleen gespecificeerde groep (door er een van de lijst te kiezen)

Andere tabbladen
De informatie over de andere tabbladen is te vinden op de volgende pagina's:

Periode
Aanpassing

BTW Overzicht / transacties met totalen op code

 

Het complete totaal van de laatste rij in het BTW overzicht moet overeenstemmen met het
eindbedrag voor de periode in de saldo kolom van de rekening "BTW volgens het BTW overzicht", op
voorwaarde dat deze beide betrekking hebben op dezelfde periode.

De gegevens van het BTW overzicht kunnen ook overgedragen aan en verwerkt worden door andere
programma's (bijvoorbeeld Excel) en weergegeven worden in formaten die gelijkwaardig zijn aan die
van de formulieren van de belastingdienst.
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Kostenplaatsen en Winstcentra

Kostenplaatsen en winstcentra zijn een functie van Banana Boekhouding Plus die beschikbaar is in
alle toepassingen. De Kostenplaatsen en Winstcentra (hierna aangeduid als Kostenplaatsen) maken
het voor de gebruiker mogelijk de transacties te ordenen volgens andere maatstaven dan met de
gebruikelijke rekeningen. Kostenplaatsen worden doorgaans gebruikt om zekere kosten, voor
specifieke activiteiten die niet noodzakelijk verbonden zijn met elkaar, vast te leggen.

We laten de meest gebruikte zien:

Boeken van specifieke uitgaven
Tentoonstellingen en Evenementen
Klanten en leveranciers, Leden
Extra details voor zekere kosten (bijkomende kosten)

Kostenplaatsen worden toegekend aan de transactie rij en kunnen tegelijk met de segmenten
gebruikt worden.

▶ Video: Kostenplaatsen en Winstcentra  (Engelstalig)

Kenmerken van Kostenplaatsen
De Kostenplaatsen (KP) zijn rekeningen met namen voorafgegaan door de ".", "," en ";"
symbolen
Er zijn drie kostenplaatsen niveaus:

KP1 voorafgegaan door een punt "."
KP2 voorafgegaan door een komma ","
KP3 voorafgegaan door een puntkomma ";"

Ieder niveau is onafhankelijk van het andere
Voor ieder niveau kan er een onbeperkt aantal kostenplaatsen en winstcentra zijn.
Een hoger niveau kan gebruikt worden zonder een lager niveau te gebruiken
Kostenplaatsen codes kunnen letters of cijfers zijn
Kostenplaatsen kunnen hun eigen groepering hebben verschillend van die van normale
rekening. Subgroepen kunnen worden aangemaakt voor hetzelfde niveau van kostenplaatsen.
Let er op kostenplaatsen niet te mengen met andere groepen van een ander niveau of met
normale rekeningen of segmenten.
Iedere kostenplaats heeft zijn eigen rekeningkaart compleet met transacties en saldo
Boeken op een kostenplaats is onafhankelijk van de rekening waarop in debet of credit geboekt
wordt. Men kan zelfs boeken op een kostenplaats zonder een enkele rekening in de debet of
credit kolom.

Instellen van kostenplaatsen de Rekeningen tabel
Kostenplaatsen rekeningen worden ingesteld in de rekeningentabel met uitzondering van Cash
Manager waar dit alleen in de categorieëntabel mogelijk is.

Instellen:

Maak een specifieke sectie aan voor de kostenplaatsen
Dit is nodig voor de weergave van kostenplaatsen in de Uitgebreide Balans op groepen.

https://www.banana.ch/en/node/11496
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Voer een sectie in met een sterretje * voor de overgang naar een sectie
In de volgende rij, in dezelfde kolom, voert u 03 (of 04 voor een winstcentrum) en de
bijbehorende beschrijving in.

Voeg rijen toe voor de kostenplaats
Voer in de Groep kolom de groep in, waartoe de kostenplaats rekening hoort,
Voer in de Rekening kolom de kostenplaatsrekeningnaam in voorafgegaan door een punt
"." voor namen die in de KP1 kolom (in de Transacties tabel) ingevoerd worden, een
komma "," voor namen die in de KP2 kolom ingevoerd worden en een puntkomma ";"
voor namen die in de KP3 kolom ingevoerd worden.
Geef in de Gr kolom de groep aan waarin de bedragen opgeteld moeten worden.
In een Vreemde valuta boekhouding wordt de munteenheid van de rekening ook
gespecificeerd.

Voeg de kostenplaatsen groepen toe
In een en dezelfde groep alleen één specifiek niveau optellen.
Verschillende niveaus kunnen worden aangemaakt zoals bij normale rekeningen.

Bestandseigenschappen (BTW bedrag)
In het Bestandseigenschappen (BTW tab) kunt u instellen hoe de BTW berekend wordt over het
bedrag van de kostenplaatsen met de volgende opties:

Transactie bedrag gebruiken - Het bedrag in de kostenplaats wordt geboekt overeenkomstig
het bedrag in de rekening waarop geboekt is.
Bedrag zonder BTW gebruiken - Het bedrag in de kostenplaats wordt geboekt exclusief de BTW.
Bedrag met BTW gebruiken - Het bedrag in de kostenplaats wordt geboekt inclusief de BTW.

Transacties
Om op kostenplaatsen te kunnen boeken moeten de kostenplaatsenrekeningen wel al ingevoerd zijn
in het Rekeningschema.

Om boekingen te doen moet u in de Transactietabel zijn, in de Kostenplaatsen weergave; u moet de
kostenplaatsenrekeningen invoeren in de KP1, KP2, KP3 kolommen zonder het symbool (. of , of ;)
dat eraan voorafgaat.

Om te op een kostenplaats in credit te boeken moet de kostenplaats ingevoerd worden
voorafgegaan door een minteken (-).
Voor de Inkomsten en Uitgaven boekhouding kunt u in de Bestands-en
boekhoudingseigenschappen definieren dat de kostenplaatsen het teken van de categorie
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volgen.
Om een algemeen bedrag te boeken op meer dan één kostenplaats van hetzelfde niveau moet
een aparte rij worden aangemaakt voor iedere kostenplaats.

Als u de Kostenplaats beschrijving in de transactietabel wil laten zien moet u de betreffende
kolommen (KP1beschrijving, KP2beschrijving, KP3beschrijving) activeren met het Gegevens →
Kolommen instellen commando.

Kostenplaats rekeningkaart
Een kostenplaats wordt op dezelfde manier behandeld als elke andere rekening, dus iedere
kostenplaats heeft zijn eigen rekeningkaart met een rekeningsaldo en transacties.

In tegenstelling tot alle andere rekeningen heeft de kostenplaatsrekening geen tegenrekening. Als u
de tegenrekening wilt bekijken, raden wij u aan Segmenten te gebruiken.
Om alle kostenplaatsen rekeningkaarten te bekijken klikt u op het commando Rapporten → Rekening
/Categorie kaarten → Kostenplaatsen (in de Filter optie).

Verwante documenten:

Leden van een vereniging beheren
Klanten en leveranciers met BTW op betaalde facturen  (Engelstalig)

https://www.banana.ch/en/node/10879
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Segmenten

Introductie
Segmenten worden gebruikt om een systematische scheiding van kosten en inkomsten per eenheid,
afdeling of filiaal aan te brengen. Door segmenten te gebruiken kunt u een winst- en verliesrekening
uitsplitsen in eenheden, afdelingen of filialen zonder dat u rekeningen hoeft aan te maken voor iedere
bedrijfseenheid.
Bijvoorbeeld kan een museum segmenten gebruiken om de inkomsten, de personeelskosten of de
kosten voor het inrichten van iedere tentoonstelling te kennen.

In transacties worden segmenten gekoppeld aan de rekening, in tegenstelling tot kostenplaatsen
waar transacties worden gespecificeerd door en gebruikt voor minder gestructureerde categorisaties
(bijvoorbeeld alle uitgaven van een evenement of de aankopen voor een speciaal doel).

Kostenplaatsen en segmenten kunnen tegelijkertijd gebruikt worden.

Bekijk de video uitleg (engelstalig): Segmenten

Kenmerken van de segmenten
Segmenten zijn rekeningen voorafgegaan door een dubbele punt ":".
Segmentcodes kunnen bestaan uit getallen of letters.
Er kunnen maximaal 10 niveaus van segmenten bestaan.
Het aantal dubbele punten dat voorafgaat aan de segmentcode geeft het niveau aan.

:LU niveau 1 segment
::P1 niveau 2 segment
:::10 niveau 3 segment

Elk niveau kan een onbeperkt aantal segmenten hebben.
De verschillende niveaus van het segment zijn onafhankelijk van elkaar.
De segmenten hebben geen BClasses en hebben geen valuta symbool.
De berekeningen voor segmenten worden gedaan in de basis munteenheid.
In de transacties volgen de segmenten de debet en credit rekening.
Het is niet mogelijk te boeken op een segment zonder een rekening te hebben.
Van de transacties op een enkel segment kunnen rekenin

Segmenten opzetten
De segmenten moeten ingesteld worden in de rekeningentabel, kolom Rekening, aan het eind van het
rekeningschema.

Voer een sterretje in in de Sectie kolom om de sectie te definiëren in relatie tot de segmenten
Voer in de kolom Beschrijving de titel Segmenten in
Voer de beschrijving van de eerste-niveau segmenten in en in de kolom Rekening een ":"

Segmenten van het eerste niveau door een code in te voeren voorafgegaan door ":"
Segmenten van het tweede niveau (en indien nodig het derde niveau), op dezelfde
manier als bij het segment van het eerste niveau, met als verschil dat de segmentcodes
voorafgegaan moeten worden door "::" of ":::", afhankelijk van hun niveau.

https://www.banana.ch/en/node/11508
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Niet toegewezen segment
Wanneer een debet of credit rekening wordt ingevoerd in de transacties zonder een segment aan te
geven wordt de waarde geboekt in het "lege" of niet toegewezen segment.
U kunt een beschrijving aangeven van een niet toegewezen segment door de tekst ": {}" als een
rekeningnaam in te voeren in het rekeningschema.

Segmentsaldo

Het segment is een onderverdeling van wat is ingevoerd op een rekening. Het segmentbedrag staat
dus altijd in relatie tot een rekening en om het totaal van het segment te verkrijgen moet u daarom
het menu Rapporten → Boekhoudoverzicht of Uitgebreide balans op groepen → sectie
Onderverdeling met de optie Onderverdeling per segment geactiveerd, gebruiken.

In het rekeningschema verschijnt het saldo van het segment alleen indien het segment in de boeking
wordt ingevoegd met gebruikmaking van alleen de Debet- of alleen de Creditrekeningkolom. Het
saldo is daarentegen nul (leeg), indien het segment in de kolom Segment wordt ingevoerd of indien
het tegelijkertijd zowel voor de Debet- als voor de Creditrekening wordt gebruikt. In dat geval zijn de
debet- en creditbedragen gelijk en heffen ze elkaar dus op.

Transacties
De segmenten worden ingevoerd in de Transacties tabel gevolgd door de hoofdrekening van het
rekeningsegment.

Als op een segment dat bij meer dan één niveau hoort wordt geboekt moet het segment van het
eerste niveau meteen achter de hoofdrekening worden ingevoerd gevolgd door de code van het
tweede niveau.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 646

Segment kolom
Met deze kolom kunt u segmenten apart van de rekening invoeren.

De kolom Segment is verborgen en als u deze wilt gebruiken moet u deze zichtbaar maken met
menu Gegevens → Kolommen instellen.
De segmenten die ingevoerd worden in de kolom Segment worden toegepast op de rekeningen
die in de boeking gebruikt worden, in de kolommen Debet, Credit, BTW, waarvoor geen
segmenten gespecificeerd zijn.
U kunt de kolom Segmenten gebruiken en ook segmenten invoeren in de kolommen Debet en
Credit.
Bij het gebruik van de kolom Segment wordt het bedrag geboekt op  het segment in zowel
debet als credit. Daardoor is het saldo van het segment in de rekeningentabel nul.

Mutaties tussen segmenten
De onderverdeling van de kosten wordt in het algemeen gemaakt voor iedere boeking. Er zijn echter
situaties waar het beter is om de kosten te boeken op een rekening en deze pas aan het eind van het
jaar te verdelen. Dit kan bijvoorbeeld het geval zijn voor de administratieve kosten die verdeeld
worden over de verschillende afdelingen van een bedrijf.

Ga als volgt te werk:

Gedurende het jaar worden transacties geboekt waarbij rekeningen worden aangegeven in de
Debet en Credit kolom maar waarbij de segmenten leeg gelaten worden of waarbij het hele
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bedrag op een enkel segment geboekt wordt.
Bijvoorbeeld worden alle bureaukosten zonder segment geboekt.
Aan het einde van het jaar worden transacties ingevoerd voor het toekennen van het gedeelte
per segment aan een specifieke kosten of baten rekening.

In de transactie wordt steeds dezelfde rekening geboekt in de kolommen Debet- en
Credit.
De bronsegmenten (die leeg kunnen zijn) en de doelsegmenten worden aangegeven.
Bijvoorbeeld de toekenning van de bureaukosten aan de verschillende afdelingen.

Er moeten evenveel transacties zijn als afdelingen.
In iedere regel heeft de creditrekening geen segment.
De debetrekening krijgt het segment van de afdeling.
Het bedrag komt overeen met het deel dat bij de specifieke afdeling hoort.

Ga verder met deze transacties om de nog niet toegekende kosten aan iedere afdeling
toe te kennen.

Beginsaldi van de segmenten
De beginsaldi van de segmenten moeten bij voorkeur ingevoerd worden als transacties omdat ze
alleen op deze manier gekoppeld kunnen worden aan een rekening. Wanneer u voor een segment het
beginsaldo invoert in de kolom Opening (in de rekeningentabel) wordt dit toegekend aan "{} niet
toegewezen segment".

Om beginsaldi toe te wijzen aan individuele segmenten en de bijbehorende rekening moeten begin
transacties worden ingevoerd (transactietabel).

In de kolom Type moet de waarde 01 ingevoerd worden.
De datum moet gelijk zijn aan de begindatum van de boekhouding.

Met de beginsaldo transactie wordt het bedrag verwijderd van het "lege" segment en toegewezen aan
het specifieke segment.
Als het te verdelen saldo negatief is (credit) moet de rekening zonder segment verschijnen in de
kolom Debet en de rekening met segment in de kolom Credit.

Voorbeeld van een transactie voor een segment beginsaldo:

Laten we aannemen dat het beginsaldo van de rekening 1000 100,00 is (zonder segment dus het
bedrag is toegekend aan het lege segment) en moet worden toegekend aan twee segmenten:

Segment 01 voor 80.00
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Segment 02 voor 20.00
De beginsaldo transacties hebben de begindatum van de boekhouding en in de kolom Type de
waarde 01.
De eerste beginsaldo boeking van het segment heeft in de kolom Debet de rekening
1000:EVENTS en in de kolom Credit de rekening 1000. Het bedrag is 80,00.
De tweede beginsaldo boeking van het segment heeft in de kolom Debet de rekening
1000:COURSES en in de kolom Credit de rekening 1000. Het bedrag is 20,00.

Het commando een nieuw jaar aanmaken

Het commando Nieuw jaar aanmaken of het commando Beginsaldi bijwerken maakt automatisch de
openingstransacties aan voor alle segmentniveaus.
Als u de saldi van een segment niet wilt rapporteren moet u de betreffende openingsbedragen die het
programma automatisch heeft aangemaakt verwijderen.

Het gebruik van het "-" teken als scheidingsteken
In transacties kunt u het minteken "-" gebruiken als scheidingsteken in plaats van de dubbele punt
":".

In Bestandseigenschappen (tabblad Opties) activeert u de optie Het minteken (-) gebruiken als
separator van de segmenten.
Daardoor kunt u in transacties het minteken als separator gebruiken.
Wanneer u het minteken "-" gebruikt als segment scheidingsteken moet u geen rekeningen gebruiken
die streepjes bevatten.

Rapporten
Rapporten van de segmenten worden verkregen met:

Uitgebreide Balans op groepen
Boekhoudingsoverzicht
Rekeningkaart
Rapport op meerdere niveaus
Om rapporten te verkrijgen die rekeningen en segmenten combineren (bijvoorbeeld alle
uitgaven van het filiaal Rome voor Project1) moeten de mogelijkheden van Menu Extensies
worden gebruikt.
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Rapport onderverdeling per niveau

Geef in de Uitgebreide Balans op groepen in de Onderverdeling tab het segment niveau aan dat
gebruikt moet worden.

Rapport Samenvatting

Dit is een samenvatting van alle segmenten uit het rekeningschema met een mogelijke
onderverdeling per periode of per segment.

Raport met niet toegekend segment

Het "lege" segment verzamelt alle bedragen die zijn geboekt zonder een segment te specificeren. Het
is mogelijk een naam aan dit segment te geven in de rekeningentabel. Kies ook voor de optie
Segment koptekst: Beschrijving in de sectie onderverdeling van uitgebreide balans op groepen.
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Verwant document: Verscheidene projecten beheren
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Het gebruik van segmenten voor het beheer
van activiteiten en afdelingen

Met de functie Segmenten is het mogelijk om verschillende afdelingen van een bedrijf of verschillende
projecten van een vereniging te beheren en voor elk de balans en de hele winst- en verliesrekening
op te maken met een onderverdeling van de inkomsten, kosten en winst of verlies.

De segmenten worden ingesteld in het rekeningschema. Wanneer u een transactie invoert geeft u
ook het segment aan. Segmenten kunnen ook worden gebruikt om vestigingen, divisies of
bedrijfsonderdelen te beheren. Een museum kan segmenten gebruiken om te rapporteren over
verschillende tentoonstellingen, een transportbedrijf om overzichten te maken per voertuig.

Instellen van segmenten in uw rekeningschema
Een bedrijf met verschillende vestigingen organiseert evenementen en cursussen en wil aparte
overzichten voor iedere activiteit en vestiging.

Op het eerste niveau, dat van activiteiten, worden rekeningnamen voorafgegaan door een dubbele
punt ":":

Courses
Events

Op het tweede niveau, dat van vestigingen, worden rekeningnamen voorafgegaan door twee dubbele
punten "::":

Rome
Milan

Het is in het algemeen beter afkortingen te gebruiken dan lange namen.

Bekijk de video uitleg (engelstalig): Segmenten

https://www.banana.ch/en/node/11508
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Transacties invoeren voor segmenten
Segmenten worden ingevoerd in de transactietabel in de kolommen Debet en Credit achter de
rekeningnummers.

Segmenten kunnen geboekt worden achter de rekeningnaam met een dubbele punt (:) of een
minteken (-).
Als u de segmenten met een minteken ervoor wil invoeren moet u de optie Het minteken (-)
gebruiken als separator van de segmenten in het menu Bestand, commando
Bestandseigenschappen → Opties.

Winst & Verlies rekening per segment
Het overzicht per segment kan gemaakt worden met het menu:

Raporten → Uitgebreide balans op groepen
Kies onder Rekeningschema, in Secties voor Winst en Verlies.

Activeer de Onderverdeling per segment optie.
Kies het segment waarvoor de winst- en verliesrekenign gemaakt moet worden (per activiteit of
per vestiging)
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Overzicht per activiteit
De verschillende segmenten verschijnen in dit overzicht. De kolom met "{}" is die van de bedragen
niet toegekend aan enig segment.

Overzicht per vestiging
Het overzicht laat de inkomsten, uitgaven en winst voor de verschillende vestigingen zien.
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Budget en financiële planning

Alle boekhoudtoepassingen binnen de Banana Boekhouding Plus software hebben krachtige en
innovatieve hulpmiddelen voor financiële planning  gebaseerd op de methode van het dubbel
boekhouden. U kunt eenvoudig een balans weergeven, prognoses voor de resultatenrekening,
liquiditeits- en investeringsplannen.

Een blik op de toekomst
Door het gebruik van de dubbel boekhouden methode kunt u met financiële prognoses een brede
visie op de toekomst van het bedrijf hebben. U kunt zich voorstellen wat de situatie zal zijn voordat
dingen gebeuren en u krijgt de kans om op tijd actie te ondernemen. Als u ziet dat de kosten
te hoog worden kunt u proberen maatregelen te nemen om deze te verlagen. Als u op tijd
gewaarschuwd wordt voor een tekort aan liquiditeit heeft u de tijd om stappen te ondernemen om dit
te voorkomen.
Met financiële prognoses voegt u waarde toe aan uw bedrijfsmanagement.

Financiële prognoses binnen ieders bereik
Budgettering gebaseerd op de methode van dubbel boekhouden is ongelofelijk krachtig en
binnen ieders bereik.

Budgettering is volledig geïntegreerd in de boekhouding.
Hetzelfde rekeningschema als dat in uw boekhouding wordt gebruikt.
Het is niet nodig een nieuw bestand op te zetten, voeg gewoon de budgetboekingen toe.
Prognoses worden gedaan op basis van de budgetboekingen.
De bewezen methode van dubbel boekhouden wordt gebruikt. Kosten en opbrengsten kunnen
in detail worden gespecificeerd.
Prognoses voor de resultatenrekening en de balans zijn beschikbaar.
U kunt de verkopen, kosten, winsten, liquiditeit en de ontwikkeling van kapitaal volgen.
U kunt de voorgang van een rekening of een groep controleren met alle afzonderlijke
budgetboekingen.
Het programma maakt prognoses per maand, kwartaal of jaar.
Prognoses kunnen opgezet worden met hoeveelheden en formules met berekeningen.
Wanneer een prognose wordt veranderd, bijvoorbeeld als een investering wordt verhoogd,
wordt de afschrijving aan het eind van het jaar automatisch opnieuw berekend.
De financiële planning van het ene jaar kan ook gebruikt worden voor meerdere jaren.
Alle boekhoudoverzichten zijn beschikbaar met de bedragen van het verleden, heden en
toekomst.

Financiële prognoses en een eenvoudig budget in één kolom
De budgetteringsfunctie met financiële vooruitzichten van kosten, opbrengsten en liquiditeit is
geïntegreerd en beschikbaar in alle Banana boekhoudtoepassingen.

Er zijn twee manieren van werken:

Complete financiële planning in de Budget tabel1.
De budget tabel wordt toegevoegd aan het boekhoudbestand waardoor u de budgetboekingen

https://www.banana.ch/nl/node/10654
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kunt invoeren die dienen om complete financiële prognoses te maken.
De Budget kolom van de rekeningentabel wordt automatisch bijgewerkt door het programma op
basis van de transacties die in de budgettabel worden ingevoerd.
Jaarlijks budget in de rekeningentabel2.
Een heel eenvoudige en traditionele methode die inhoudt dat de jaarlijkse schattingen worden
ingevoerd in de Budget kolom van de rekeningen- of categorieëntabel.
Daarna geeft het programma de verschil aan en de Budgetverschil kolom van de rekening- of
categorieëntabel.
Zie pagina: Eenvoudig jaarlijks budget.

Hierna concentreren we ons op de methode die de budgettabel gebruikt.

Directe weergave van de budget bedragen
Financiële planning, gebaseerd op de methode van dubbel boekhouden, maakt gebruik van hetzelfde
rekeningschema als de boekhouding.
In de Rekeningen- en Categorieën tabel (inkomsten en uitgaven boekhouding) kunt u niet alleen
de huidige saldi zien, maar ook de budgetsaldi.
U kunt de structuur van de Balans en de Winst- en Verliesrekening vrij instellen, o.a. door rekeningen
en groepen toe te voegen.
U kunt ook gebruik maken van kosten- en winstcentra, segmenten, en registers voor klanten en
leveranciers.

De Budgettabel
De planning wordt gedaan door transacties in de Budgettabel in te voeren. Dit is te vergelijken met
het invoeren van boekingen, maar dan voor in de toekomst. Herhalende bewerkingen zoals rente
worden maar eenmaal aangegeven door de herhaaloptie aan te zetten en een mogelijke einddatum
aan te geven.
Het jaarlijkse totaal wordt aangegeven in de kolom Totaal.
U kunt zoveel rijen toevoegen als u wilt, voor het huidige jaar of voor de volgende jaren en op elk
moment veranderingen aanbrengen.
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Een heldere en complete blik op de toekomst
Banana Boekhouding levert u alle benodigde overzichten om een uitgebreid zicht te hebben op uw
financiële toekomst, dezelfde overzichten als voor uw boekhouding, helemaal geïntegreerd en
uitgebalanceerd, zonder verschillen,  precies zoals voor de boekhouding. Alles gaat automatisch, u
hoeft geen tijd te verspillen aan het opzetten van tabellen in Excel, het invoeren en controleren van
formules, instellen van rijen en kolommen.

Liquiditeitsplan.
U kunt zien hoe de liquiditeit zich ontwikkelt in de gekozen budgetperiode. U weet vooruit of u
de middelen heeft om met verschillende verplichtingen om te gaan.
Prognose Resultatenrekening.
U kunt zien wat de opbrengsten en kosten en de verwachte resultaten zullen zijn, een overzicht
kiezen met de totalen per groep of zelfs gedetailleerd met de bedragen van de individuele
onderdelen. De uitvoering van de resultatenrekening kan vrij gekozen worden en aangepast
aan de eisen. Het programma berekent automatisch de totalen zonder dat u formules hoeft in
te voeren.
Prognose budget.
Van iedere rekening en groep activa en passiva ziet u de ontwikkeling in de tijd.
Investeringsplan.
Van iedere rekening en groep activa ziet u in detail de ontwikkeling in de tijd.
Gedetailleerde rekening kaarten.
U kunt ieder item in detail analyseren. Dankzij de rekeningkaart kunt u de ontwikkeling de van
de bankrekening of de liquiditeit onderzoeken .
Grafieken van de ontwikkeling in de toekomst.
U kunt direct de toekomstige ontwikkeling van ieder onderdeel zien. Met één blik kunt u
controleren hoe de verkopen zullen lopen en begrijpen of er een liquiditeitsprobleem zal zijn.
Kostenplaatsen en winstcentra en segmenten.
U kunt ook kostenplaatsen, winstcentra en segmenten gebruiken bij het budgetteren.
U kunt gedetailleerde prognoses krijgen voor individuele projecten, klanten of geografische
gebieden.
Vooruitzichten voor meerdere jaren.
U kunt de balans en de resultatenrekening hebben voor één, twee, vijf of zelf tien jaar.
Het programma projecteert de gegevens van het jaar op volgende periodes.
Bekijk de gegevens per maand, kwartaal, jaar of meerdere jaren.
U kunt de balans en de resultatenrekening hebben voor een maand, kwartaal, halfjaar, jaar of
meerdere jaren. U kunt daardoor de periode die u interesseert in detail analyseren.
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Vergelijk het budget met de werkelijke cijfers.
Door hetzelfde rekeningschema te gebruiken is er een directe vergelijking tussen de prognose
en de werkelijkheid.
U kunt eenvoudig afwijkingen van de schatting identificeren.
Sla de instellingen van het overzicht op (aanpassingen).
Maak overzichten en sla de instellingen (aanpassingen) ervan op zodat u ze later weer kunt
gebruiken.

Voor ieder overzicht kunt u de vormgeving kiezen die u wenst. Het programma past de afdrukken
automatisch aan zonder dat u rijen, kolommen en formules hoeft in te stellen. U kunt de gegevens
vanuit verschillende gezichtspunten analyseren in verschillende weergaven.

Bekijk een periode.
Het programma laat u de overzichten van het jaar zien maar u kunt ook vragen om een
vooruitzicht voor enkel een kwartaal. U kunt makkelijk omschakelen tussen jaarlijkse en
meerjaren budgetten.
Ontwikkeling in de tijd.
Het programma kan alle overzichten presenteren met een onderverdeling per periode. U kunt
daardoor de ontwikkeling van de liquiditeit, balans, verkopen en bedrijfsresultaat in de
toekomst zien. U kunt eenvoudig veranderen van weergave zonder formules of tabellen
opnieuw in te moeten stellen.
Volledig op maat gemaakt overzichten.
U kunt de gewenste weergave kiezen en veranderen zoals u wilt. U kunt uw budgetten
professioneel presenteren en een goede indruk maken op uw toeschouwers.
Overzichtsinstellingen opslaan.
U kunt afdrukinstellingen aanmaken en opslaan en deze gebruiken wanneer nodig.

Eenvoudig in gebruik
Alles is al ingesteld, u hoeft alleen maar de budgetboekingen in te voeren met eenvoudige
transacties. Deze benadering is vooral handig voor boekhouders die hiermee direct in staat zijn
nauwkeurige en volledige prognoses te maken. Dankzij de inkomsten en uitgaven boekhouding
kunnen zelfs mensen zonder speciale boekhoudkennis dit doen.

Dezelfde invoer als bij gewone boekingen.
Voor iedere toekomstige financiële gebeurtenis wordt een transactie met datum, beschrijving
en de bijbehorende rekeningen ingevoerd.
Het programma telt de bedragen op per onderdeel en periode, precies zoals in de boekhouding.
Gedetailleerde weergave van opbrengsten en kosten.
De  verschillende kostenitems kunnen in detail worden weergegeven en op het exacte moment
dat ze optreden. Voor personeelskosten kunnen de salarissen van individuele werknemers
worden aangegeven.
Eenvoudiger veranderen en bijwerken.
Aanpassen, toevoegen of verwijderen van opbrengsten of kosten is eenvoudig omdat u alleen
maar specifieke details verandert. Als in het volgende jaar de rente stijgt verandert u gewoon
dit onderdeel. Als er een nieuwe uitgave is, voegt u een nieuwe regel toe. Het programma zal
het budget automatisch bijwerken.

Snel dankzij de herhalingen
Herhaalde bewerkingen worden maar eenmaal ingevoerd. De budgetboeking geeft de frequentie aan
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waarmee bewerking zichzelf herhaalt en het programma houdt er in de toekomst rekening mee.
In een budget zijn er veel bewerkingen die zichzelf herhalen. U zet een uitgebreid budget op in korte
tijd. De herhalingsfunctie is vooral effectief als u het budget moet aanpassen, verander een enkel
bedrag en in één ogenblik wordt alles bijgewerkt.

Automatisering van berekeningen
Het programma voert automatisch eenvoudige of ingewikkelde berekeningen uit.

Berekeningen gebaseerd op hoeveelheden en prijzen.
Verkoopaantallen kunnen opgeslagen worden om een duidelijker zicht op het budget te hebben.
Het programma berekent automatisch het bedrag van de mutatie en werkt de boekhouding bij.
Berekening met formules (Javascript).
De mogelijkheid formules in te voeren is alleen beschikbaar in Banana Boekhouding Plus met
het  Advanced plan . Stap nu over !
Banana Boekhouding Plus levert een uitermate krachtig systeem met formules, speciaal
ontworpen voor financiële planning. U heeft toegang tot budgetgegevens zodat u mutaties kunt
aanmaken die afhangen van vorige gebeurtenissen. U kunt de afschrijving berekenen
gebaseerd op de waarde van de gedane investeringen of de rente op een lening gebaseerd op
het feitelijke gebruik. Het programma berekent na iedere verandering opnieuw de exacte
bedragen.
Formules worden geschreven in de Javascript programmeertaal. Eenvoudige of ingewikkelde
planningen kunnen helemaal automatisch aangemaakt worden.

U kunt waardes toekennen aan variabelen en deze op de volgende regels weer gebruiken.
Javascript opdrachten hebben toegang tot de Banana API.
U kunt ook uw eigen Javascript functies programmeren en oproepen.

Automatische vooruitzichten voor meerdere jaren
U kunt het budget opzetten voor een jaar en het programma vooruitzichten laten aanmaken voor de
volgende jaren.
Alle overzichten zoals het liquiditeitsplan, de resultatenrekening en de prognosebalans zijn ook
beschikbaar voor volgende jaren.

Op deze manier zijn een midden en lange termijn visie op de financiële situatie beschikbaar. De
prognose kan ook volledig beheerd worden voor de volgende jaren. De logica van de bewerkingen is
eenvoudig, voor bewerkingen van het jaar die zichzelf herhalen in de volgende jaren wordt een
jaarlijkse herhalingscode ingevoerd. Op deze manier kan het programma de planningsgegevens
voorspellen voor de betreffende periode. Budgetten voor twee, vijf of zelfs meer jaren kunnen
gemakkelijk worden gemaakt.

Klantenportfolio analyse en leveranciersbeheer
Bij het invoeren van budgetboekingen kunnen klantcodes worden aangegeven. Op deze manier kunt
u een realistische planning opbouwen, beginnend bij uw klantenportfolio, en begrijpen of de kosten
worden gedekt en welke klanten meer winst opleveren.
Het is duidelijk dat dezelfde analyse gedaan kan worden voor leveranciers.

https://www.banana.ch/nl/buy
https://www.banana.ch/nl/node/11200
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Planning van projecten of sectoren
U kunt financiële planningen maken met overzichten van projecten, activiteiten of bedrijfssectoren.
Het is voldoende om in de mutaties aan te geven dat een uitgave of een inkomst betrekking heeft op
een project of een afdeling en het programma is in staat automatisch specifieke overzichten te
maken.

Eenvoudig aan te passen
U kunt de structuur van het rekeningschema aanpassen en de vormgeving van de balans en de
resultatenrekening, rekeningen, categorieën en groepen toevoegen en de overzichten veranderen
automatisch zonder formules te hoeven maken of rijen of kolomtotalen te berekenen.

Vergelijking tussen geschatte en werkelijke gegevens
De boekhouding en het budget gebruiken dezelfde motor om te rekenen en overzichten te maken. In
de transactiestabel voert u de bedragen in uit het verleden en in de budgettabel die van de toekomst.
Het rekeningschema en de ordening van de balans zijn altijd hetzelfde en aanwijzingen voor elke
verandering vergeleken met het budget worden automatisch getoond.

Automatische gegevensoverdracht naar een nieuw jaar
De budgetten opgesteld met Banana Boekhouding zijn gemakkelijk aan te passen en bij te werken.
Verander gewoon de betreffende boekingen en het programma berekent automatisch opnieuw de
formules en werkt het budget bij.

Als u een nieuw jaar aanmaakt gebruikt het programma de budgetgegevens met aangepaste datums.
Het is dan alleen nog een kwestie van aanpassen van de onderdelen die veranderden sinds het vorige
jaar. Dit levert een gedetailleerde en perfecte planning op voor het volgende jaar.

Financiële bedrijfssimulatie
Geïntegreerde planning in boekhouding is erg krachtig en opent een nieuwe tijd in bedrijfsplanning
omdat dit de mogelijkheid biedt de reeks van toekomstige gebeurtenissen met grote precisie en in
detail te simuleren. Prognoses kunnen in detail worden geanalyseerd met dezelfde hulpmiddelen die
gebruikt worden voor boekhoudkundige analyses; controleren wat het break-even punt is en
analyseer de situatie van klanten of projecten.

Leren boekhouden met planning
Door het budget met transacties aan te maken, zoals gebruikt in de boekhouding, leert men de
boekhoudtechniek. Boekhoudtrainingen kunnen veel interessanter en effectiever gemaakt worden
omdat de studenten de taak krijgen hun eigen bedrijf op te zetten en ervoor te zorgen dat dit solide
en winstgevend wordt. Studenten zullen niet alleen de transacties moeten invoeren maar ze zullen
ook een oog moeten houden op het bedrijf en gewend moeten raken aan het lezen van de balans en
de resultatenrekening.
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Een nieuwe financiële planning beginnen

 U kunt eenvoudig financiële planningen maken inclusief liquiditeitsplannen, balans en
resultatenrekeningen. De procedure is dezelfde als voor het aanmaken van een boekhouding.

1. Maak het boekhoud/budgetbestand aan
Maak met het commando Bestand → Nieuw... een budgetbestand aan, gebruik het boekhoudtype en
het boekhoudmodel dat het beste bij uw behoefte past.

U kunt ook beginnen met een van de modellen die al voorbereid zijn om mee te oefenen met
voorbeelden van budgettransacties.

Financiële planning voor huishoudens (met Cash Manager)
Om uw huishouduitgaven en -inkomsten te budgetteren.
Financiële planning voor de opening van een restaurant (Inkomsten en uitgaven boekhouding)

Dit model gebruikt alfabetische rekeningnummers voor een sneller begrip.
Met een inkomsten en uitgaven boekhouding kunt u, zelfs zonder boekhoudkennis, een
professionele planning maken, inclusief liquiditeitsplan, activa prognoses en kosten en
inkomsten.
Financiële planning voor de opening van een restaurant (Dubbel boekhouden)
Voor complete financiële prognoses met het dubbel boekhouden systeem, bedoeld voor
degenen die bekend zijn met de methode van dubbel boekhouden.
Dit model gebruikt alfabetische rekeningnummers voor een sneller begrip.

Er zijn ook voorbeeldbestanden met meer geavanceerde functionaliteit:

Dubbel boekhouden met hoeveelheid en formule kolommen
De verschillende mogelijkheden om de formule kolom te gebruiken worden opgesomd. Met
voorbeelden en uitleg.
Vreemde valuta boekhouding met voorbeeld budgettransacties met formules
Om specifieke formules voor vreemde valuta te gebruiken.
Modellen met voorbeelden van transacties voor complexere thema's.

Nadat u het bestand heeft aangemaakt slaat u het op met een naam die bij voorkeur bestaat uit de
bedrijfsnaam en het jaar, bijvoorbeeld "bedrijf-2020.ac2".

2. Het bestand op maat maken
Nadat u het bestand aangemaakt heeft past u het aan uw specifieke wensen aan:

Stel de Bestandseigenschappen in.1.
De bedrijfsnaam.1.
De boekhoudperiode.2.
Normaliter komt dit overeen met het kalenderjaar. U kunt echter een andere periode
aangeven indien gewenst. Zie  Periode voor de financiële prognose.

Pas het Rekeningschema aan.2.
U kunt de beschrijving veranderen en rekeningen of groepen toevoegen of verwijderen.
Indien nodig kunt u het rekeningschema op elk moment later aanpassen.

https://www.banana.ch/apps/nl/node/8976
https://www.banana.ch/apps/nl/node/8449
https://www.banana.ch/apps/nl/node/8082
https://www.banana.ch/apps/nl/node/8251
https://www.banana.ch/apps/nl/node/8258
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Voer de  Beginsaldi in als dit een bedrijf is dat al in werking is.3.

3. Voer de financiële budgetboekingen in
U kunt nu de financiële budgetboekingen in de Budgettabel invoeren.

4. Bekijk de prognoses
De prognose gegevens zijn zichtbaar in:

Het grafieken venster.
De rekeningentabel, in de Budget kolom.
De overzichten, in de Budget kolom.
De rekeningenkaart, Budgetbedragen.

De prognose aanpassen
U kunt op elk moment transacties wijzigen, toevoegen of verwijderen. De prognose wordt onmiddellijk
herberekend.
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Budget toevoegen aan een bestaand
boekhoudbestand

Het volgende legt uit hoe een financiële planning toe te voegen aan een bestaande boekhouding.

Voeg de budgettabel toe aan een bestaande boekhouding
De eerste stap is de budgettabel aan uw boekhoudbestand toe te voegen. Op dat moment heeft u de
budgettabel tot uw beschikking waarin u de financiële planningstransacties kunt invoeren.

Budgettransacties invoeren
Nu u het rekeningschema al opgezet heeft kunt u direct starten met het invoeren van de transacties
in de budgettabel . Zie ook Transactie voorbeelden.

Volg de instructies en gebruik de modellen aangegeven in:

Een nieuwe financiële planning beginnen.

http://www.banana.ch/doc/nl/node/9712
http://www.banana.ch/doc/nl/node/9712
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De Budget tabel

In de budgettabel worden de budgettransacties ingevoerd. De opzet van de budgettabel is identiek
aan die van de transactiestabel die u gebruikt maar heeft specifieke kolommen die het budgetteren
makkelijker en sneller maken.

U kunt de gegevens naar wens aanpassen om betrouwbare prognoses te laten zien die altijd perfect
bijgewerkt zijn.

Eenvoudige en uitgebreide prognoses
U kunt alle bewerkingen in detail invoeren.
U heeft uitgebreide prognoses omdat deze gebaseerd zijn op de methode van dubbel
boekhouden.

Details van de bron- en bestemmingsrekening.
Het programma berekent en toont de prognoses gebaseerd op de ingevoerde transacties.
U kunt aangeven wanneer een bewerking wordt uitgevoerd en of en hoelang deze herhaald
wordt.

U kunt prognoses aangeven voor het huidige jaar of toekomstige jaren.
Geef de herkomst- en bestemmingsrekening aan. 
Geef het verwachte bedrag aan.

Of gebruik de kolommen Hoeveelheid en Prijs.
Of gebruik de berekeningsformules.

U kunt de boeking aanvullen met :
Klantenrekening
Crediteuren
BTW code
Winstcentrum / Kostenplaats
Segmenten
En voeg extra kolommen toe voor meer informatie.

U kunt de transacties invoeren in de volgorde die u wenst om zo groepen te vormen.
U kunt extra informatie toevoegen om de overdracht van gegevens naar het nieuwe jaar
mogelijk te maken.
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De Budget tabel toevoegen

De Budget tabel toevoegen
Financiële planning wordt gedaan door middel van de Budget tabel.

Als uw boekhoudbestand nog geen Budget tabel heeft voegt u deze als volgt toe:

Menu Extra → Functies toevoegen/verwijderen → Budget tabel toevoegen
Let op: dit kan niet ongedaan worden gemaakt (met de Annuleren toets) ; als u terug wilt
kunnen gaan naar de eerdere toestand, moet u een kopie behouden van de vorige versie van
het bestand, of de functie Budget tabel verwijderen gebruiken.

Daarna zal het programma:

De Budget tabel toevoegen daarbij de budgetwaardes uit de Rekeningen tabel overnemend.
De Budget kolom in de Rekeningen tabel blokkeren.
De waarden van deze kolom worden berekend volgens de budget transacties, waarbij de
periode gebruikt wordt die in het Tabblad Boekhouding van Bestandseigenschappen staat.

De Budget tabel verwijderen
Vanuit menu Extra → Functies toevoegen/verwijderen kunt u de Budgettabel ook verwijderen.

Let op: deze bewerking kan niet ongedaan worden gemaakt. Zodra het commando is uitgevoerd
worden alle gebudgetteerde bewegingen gewist.
Als u terug wilt kunnen gaan naar de eerdere toestand, zorg ervoor dat u een kopie bewaart voordat
u het commando uitvoert.

Zodra de Budget tabel is verwijderd, is de Budget kolom weer beschikbaar voor bewerking in de
Rekeningen tabel.

http://www.banana.ch/doc/nl/node/7923
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Kolommen in de Budget tabel

De Budget tabel kolommen lijken erg op de kolommen van de Transacties tabel. In het volgende
voorbeeld gebruiken we rekeningen met namen om het makkelijker te maken dit te begrijpen. Als u
zelf numerieke rekeningnummers gebruikt blijft u dit gewoon doen.

Hierna vindt u de uitleg voor iedere kolom:

Datum
De toekomstige datum waarop u verwacht dat de bewerking plaats zal hebben:
Als geen exacte datum bekend is, bijvoorbeeld bij maandelijkse verkopen, voer dan de datum
van het einde van de maand in.
Herhalen
Voer een herhalingscode in. Zie voor meer informatie Data en herhalingen.
Bij het berekenen van de prognose maakt het programma intern kopieën van de rijen met
opeenvolgende data gebaseerd op de aangegeven herhalingscode.

Leeg: er is geen herhaling
De eerste rij houdt de aangegeven datum.
De data van de gekopieerde rijen wordt oplopend verhoogd zoals gedefinieerd door de
herhalingscode.
Als de herhaling maandelijks of jaarlijks is in de aangemaakte rijen:

Wordt deze in het algemeen op dezelfde dag gebruikt als in de gebruikte kolom.
Als de dag door het aantal herhalingen verder is dan het eind van de maand dan
wordt de laatste dag van de maand gebruikt.
Als de indicatie voor het einde van de maand "ME" of "YE" is dan wordt de laatste
dag van de maand gebruikt.

Basiscodes voor de herhaling:
"D" voor een dagelijkse herhaling (Dag)
"W" voor een wekelijkse herhaling (Week)
"M" voor een maandelijkse herhaling (Maand)
"Y" voor een jaarlijkse herhaling (Jaar)

Meervoudige herhalingen
Als de code voorafgegaan wordt door een getal treedt de herhaling op met een periode die
bepaald wordt door het getal vermenigvuldigd met de code.

"2M" voor tweemaandelijks
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"3M" voor kwartaal
"6M" voor zes maanden

Herhaling met een dag die later is dan het eind van de periode.
De "M" en "Y "codes met de "E" aan het eind verplaatsen de herhalingsdatum naar het einde
van de maand.

"ME" maandelijkse herhaling maar met een datum aan het einde van de maand.
Als u de datum 1-1-2022 invoert zal de volgende datum 28-2-2022 zijn en die daarna
31-3-2022.
Als de datum 28-2-2022 is zal de volgende datum 31-3-2022 zijn.
"3ME" voor een einde van de maand per kwartaal
Als u begint op 30-6-2022 zal de volgende datum 30-09-2022 zijn.
"6ME" voor half jaarlijks einde van de maand.
"YE" ieder jaar maar aan het eind van de maand.
Als de datum 28-2-2022 is zal de volgende datum 28-2-2023 zijn.
"5YE" iedere vijf jaar maar aan het eind van de maand.
Als de datum 28-2-2022 is zal de volgende datum 28-2-2027 zijn.

Einde (einddatum)
Over het algemeen moet dit veld leeg gelaten worden.
Voer de datum in waarna er geen herhaling meer moet zijn.
Geef bij huur als einddatum de datum aan waarop de huur eindigt.

Variant
Een mogelijke variant van het budget kan hier aangegeven worden, in combinatie met de
Extensies.
Nieuw Jaar
Hier kunt u aangeven hoe de overdracht moet plaatsvinden bij het aanmaken van een nieuw
jaar

Geen waarde: de datum wordt verhoogd met een jaar
"1" De datum blijft hetzelfde
"2" De transactie wordt niet overgedragen naar het nieuwe jaar.

Beschrijving
Een beschrijvende tekst voor de bewerking die in de rekeningentabel staat.
U kunt berekeningsformules gebruiken door de waarde ${} in te voeren (zie Javascript template
literals  (Engelstalig)).
Wanneer de rekeningkaart wordt aangemaakt wordt de formule opgelost en het resultaat
weergegeven.
Bijvoorbeeld de tekst "Bedrag ${10+20} jaar" wordt "Bedrag 30 jaar".
U kunt alle formules gebruiken maar om verwarring te voorkomen wordt het aanbevolen het
toekennen van waarden te vermijden in de kolom Beschrijving.
Debet rekening en Credit rekening, KP1, KP2, KP3
Precies zoals in de Transacties tabel gebruikt u deze kolommen om te bepalen op welke
rekeningen de boeking moet worden gedaan.
U kunt ook segmenten en kostenplaatsen gebruiken om een budget per segment of per
kostenplaats te krijgen. Op deze manier kunt u ook een budget voor segmenten en
kostenplaatsen/winstcentra aanmaken.
Hoeveelheid
De hoeveelheid, vermenigvuldigd met de prijs per eenheid, levert het totaalbedrag op. (zie
Hoeveelheid en prijs kolommen).
Eenheid
In deze kolom kunt u de hoeveelheidsbeschrijving invoeren bijvoorbeeld m3, ton, stuks, ...
Prijs/Eenheid

https://developer.mozilla.org/en-US/docs/Web/JavaScript/Reference/Template_literals
https://developer.mozilla.org/en-US/docs/Web/JavaScript/Reference/Template_literals
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De prijs per eenheid, vermenigvuldigd met de hoeveelheid, levert het totaalbedrag op.
In Inkomsten & Uitgaven boekhoudbestanden moet u de prijs per eenheid negatief
invoeren (met een min teken), om het bedrag in de Uitgaven kolom terecht te laten
komen.

Formule (in basis valuta)
In deze kolom kan de gebruiker rekenformules, in Javascript, en functies van de Banana
Extensies, invoeren.
Als er een formule aanwezig is (of wat voor tekst dan ook) wordt de waarde van de kolom
Bedrag ingevuld volgens het resultaat van de formule. Zie in de volgende punten hoe dit
gebruikt wordt.

In een dubbel boekhouden boekhoudbestand moet het resultaat van de formule altijd een
positief bedrag zijn
In een Inkomsten & Uitgaven boekhoudbestand wordt het resultaat beschouwd als
inkomsten als het positief is, als het negatief is wordt het beschouwd als uitgaven.

FormulaBegin
De tekst die u in deze kolom invoegt wordt ingevoegd vóór de tekst die in de Formule wordt
gebruikt en vervolgens gebruikt voor de berekening.
Het belangrijkste gebruik van de FormulaBegin is het invoegen van een variabele instelling
zoals "A=", in de Formule wordt dan alleen de waarde ingevoegd, zodat die gemakkelijker te
wijzigen is.
Bedrag (in basis valuta)
Het bedrag dat gebruikt wordt voor de prognose.
Als in de rij een herhaling voorkomt wordt het bedrag alleen in de eerste transactie
aangegeven; de bedragen van de volgende transacties worden getoond in de rekeningkaart.
Het bedrag wordt automatisch berekend in de volgende gevallen:

Als er een waarde in de Hoeveelheid of Prijs/Eenheid kolommen staat wordt het
bedrag automatisch berekent op basis van de inhoud van deze twee kolommen.

In een dubbel boekhouden boekhoudbestand is het resultaat een positief bedrag
In een Inkomsten & Uitgaven boekhoudbestand wordt het resultaat beschouwd als
inkomsten als het positief is, als het negatief is wordt het beschouwd als uitgaven.

Als een formule is ingevoerd is het bedrag het resultaat van de formule.
Formules gaan boven de hoeveelheid en prijs/eenheid berekening.

Totaal kolom
Dit is de som van de bedragen van de herhalende rijen die een onderdeel zijn die vallen binnen
de Boekhoud-, plannings- en prognoseperiode die is ingesteld in de bestandseigenschappen.
Als er geen datum is of de begin- of einddatum vallen buiten de boekhoudperiode dan blijft
deze kolom leeg.

Kolommen in inkomsten en uitgaven boekhouding
Voor de Cash Manager en de inkomsten en uitgaven boekhouding worden de bedragen ingevoerd in
de kolommen Inkomsten en Uitgaven.

Kolommen Inkomsten en Uitgaven
De budgetbedragen worden ingevoerd in de kolommen Inkomsten en Uitgaven.
Gebruik van de kolommen Hoeveelheid, Prijs en Formule.
Als het programma automatisch het bedrag gebaseerd op de kolommen Hoeveelheid, Prijs of
Formule berekent wordt het resultaat weergegeven in de kolom Inkomsten als het positief is en
in de Uitgaven kolom als het negatief is.
In de kolommen Hoeveelheid en Prijs kunt u positieve en negatieve waardes invoeren.
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Kolommen in vreemde valuta boekhouding
Bedrag in rekeningvaluta
Dit is het bedrag in de munteenheid van de transactierekening (zie vreemde valuta transacties).
Dit bedrag wordt gebruikt om de waarde in basis valuta te berekenen met de aangegeven
wisselkoers.
Als er een formule is, is de waarde het resultaat van de formule berekening.
Als de rij een herhaling bevat wordt het bedrag van de eerste transactie aangegeven.
Formule bedrag rekeningvaluta
Een berekeningsformule kan worden ingevoerd.
Als de regel een herhaling bevat wordt het bedrag van de eerste transactie weergegeven. De
bedragen van opvolgende herhalingen zijn zichtbaar in de rekeningkaart.
Wisselkoers
De wisselkoers wordt gebruikt om het bedrag in de rekeningvaluta om te zetten in de
basisvaluta.
Totaal bedrag in rekeningvaluta
Dit is het totaal van de bedragen in de herhaalde regels in de rekeningvaluta waarvan de datum
valt binnen de boekhoudperiode gedefinieerd in de bestandseigenschappen.
Als er geen datum is of de begin- of einddatum zijn buiten de boekhoudperiode dan blijft deze
kolom leeg.

Zie ook: Tutorial File Budget Formulas For Multi-Currency Financial Planning  (Engelstalig).

https://www.banana.ch/apps/en/node/8258
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Planning gebaseerd op de Dubbel
boekhouden methode

 Het planningsysteem van Banana Boekhouding is gebaseerd op de methode van het Dubbel
boekhouden, dezelfde methode die ook voor de boekhouding wordt gebruikt.

Het doel is om altijd de rekening van herkomst (credit) en een rekening van bestemming (debet) aan
te geven. Hierdoor heeft u een nauwkeurig beeld van de kapitaalstromen en krijgt u een compleet
beeld dat ook omvat:

Balansprognoses, dus met betrekking tot de financiële situatie, de liquiditeit, de activa, vreemd
en eigen vermogen.
Winst- en verliesprognose: opbrengsten, kosten en resultaat van het jaar.

Plannen, uitvoeren, controleren
 De planning van Banana Boekhouding is een integraal onderdeel van de Plannen - Uitvoeren -
Controleren  cyclus.
U heeft een constante en dynamische controle over de financiële situatie en de evolutie.

Planning en boekhouding in één enkel bestand
Hetzelfde bestand bevat zowel boekhoudkundige als planningsgegevens. U kunt beginnen met een
bestand om de boekhouding bij te houden en later de planning toevoegen, of u kunt beginnen met
een bestand om de planning bij te houden en vervolgens ook de boekhouding te beheren.

Gemeenschappelijke elementen

Basisgegevens van de boekhouding
Koptekst, valuta, boekhoudperiode, adres, andere parameters.
Tabel Rekeningen en Categorieën
Waar u het rekeningstelsel met de rekeningen en de groepen voor de totalen instelt.

Beginsaldi ( Opening kolom)
Deze worden opgenomen in de Rekeningen-tabel en worden gebruikt als beginsituatie
voor zowel de boekhouding (actuele waarden) als de prognoses.

https://www.banana.ch/nl/plannen-uitvoeren-controleren
https://www.banana.ch/nl/plannen-uitvoeren-controleren
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Jaarlijks Budget (Budget kolom)
Met de Budget tabel
De kolom "Budget" van het rekeningstelsel wordt beveiligd en het programma geeft
de bedragen van het budget aan, berekend op basis van de inhoud van de Budget
tabel, die betrekking heeft op de verslagperiode.
Als er geen Budget tabel is
U voert de budgetgegevens handmatig in.
In de prognose creëert het programma de maandelijkse waarde, waarbij de
jaarlijkse waarde wordt gedeeld door het aantal maanden van het boekjaar.

De andere tabellen
BTW Codes tabel
Wisselkoersen tabel

De Boekhoudgegevens (verleden en heden)

De Transacties tabel
Waar de mutaties van het verleden (historisch) worden geregistreerd.
De Transacties tabel is altijd aanwezig in het boekhoudbestand. Als u hem niet gebruikt, kunt u
de tabel onzichtbaar maken.
Huidige waarde (boekwaarde, verleden en heden)
Het is het saldo of de mutatie van de periode voor een rekening of groep.
In de rapporten kunt u de kolom Huidige waarde zien.
Dit zijn de waarden die zijn berekend op basis van boekhoudkundige gegevens, berekend met
inachtneming van de

Beginbalans (Rekeningentabel)
De mutaties in de Transacties tabel

Rekeningkaart (historisch)
Dit zijn de transacties van een rekening of groep die op basis van de beginbalans en de
transacties zijn opgesteld.

De Budgetgegevens

Dit zijn de prognoses, de begrotingen en de planning.
In het programma wordt de term Budget altijd gebruikt voor gegevens die betrekking hebben op de
toekomst.

De Budget tabel
U voert hier de toekomstige, geplande mutaties in
De methode is dezelfde als die van Transacties tabel, er zijn dezelfde kolommen, plus andere
specifiek voor de planning
Mutaties met betrekking tot de toekomst, ingevoegd in de Budget tabel:

Statische waarden (zoals in de Transacties tabel).
Die rekenformules gebruiken, die het programma oplost bij het berekenen van de
prognose.
Repetitieve bewegingen, die het programma gebruikt voor het automatisch maken van
prognoses.

De Budgetwaardes (toekomst)
De geraamde waarde. In de rapporten kunt u de kolom van de te verwachten waarde zien.
Berekend rekening houdend met

Beginbalans (Rekeningentabel)
De mutaties in de Budgettabel (indien aanwezig).
Indien de Budgettabel niet aanwezig is, gebruik dan de waarde die is opgenomen in de
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kolom Budget van de rekeningen- of categorieëntabel.
Rekeningkaart Budget (toekomst)
Dit zijn de transacties van een rekening of groep die op basis van de beginsaldi en de Budget
transacties zijn opgesteld.

Afwijkende waarden

Verschil tussen de begroting en de huidige (werkelijke, definitieve) waarden.
In de rapporten staat de vergelijkingskolom, die de afwijking weergeeft.  

Gemengde projectiewaarden (vanaf een bepaalde datum)

De waarde op een bepaalde datum in de toekomst wordt als volgt berekend:

Tot de aangegeven startdatum op basis van de huidige waarden.
Vanaf de aangegeven datum op de budget waarden.

Gemengde projectiewaarden zijn alleen beschikbaar via scripts en de webserver.

Boekhoudingstypen
Voor het invoeren van boekingen of budgetmutaties wordt de door u gekozen boekhoudmethode
gebruikt

Inkomsten en Uitgaven (Cash Manager en Boekhouding Inkomsten en Uitgaven)
Dubbel boekhouden (Dubbel boekhouden en Boekhouden met vreemde valuta).

Intern gebruikt het programma voor de berekening van de prognoses altijd het systeem op basis van
het Dubbel boekhouden. De resultaten en de rapportage die u krijgt zijn dan ook zeer vergelijkbaar.

Boekhoudings-, planning- en prognoseperiode
De boekhouding of de prognose is altijd gerelateerd aan een periode. De volgende periodes worden
onderscheiden:

Boekhoudperiode
Het is de periode die is gedefinieerd in de bestandseigenschappen, met begin- en einddatum.
Planningsperiode
Dit is de periode waarvoor de planningsgegevens worden ingevoerd.
Prognoseperiode
Dit is de periode die door het programma wordt gebruikt om de prognose te berekenen. Deze
wordt aangegeven op het moment dat een afdruk wordt aangevraagd.

Onderverdeling per periode
Bij de planning, met de Dubbel boekhouden methode, heeft elke operatie zijn eigen datum. Vóór het
afdrukken kiest de gebruiker of hij de prognose per maand, kwartaal, semester of jaar wil hebben en
het programma berekent alles automatisch. Het is niet meer nodig om, zoals bij spreadsheets, aan
het begin te bepalen of er prognoses per maand, kwartaal of jaar moeten worden gemaakt en de
bedragen handmatig in kolommen te verdelen.
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Automatische projecties
Dankzij de mogelijkheid om aan te geven dat bepaalde handelingen in de toekomst worden herhaald,
beschikt het programma over de nodige elementen om de prognoses voor de komende jaren
automatisch voor te bereiden. Zo kunt u zien hoe de inkomsten, kosten, liquiditeit en andere activa
en passiva zich in de komende weken, maanden, kwartalen en jaren zullen ontwikkelen.

Details bij alle bewerkingen
Bij de Dubbel boekhouden methode worden de prognoses voorbereid door het invoeren van
transacties. Het programma is in staat om de rekeningkaart te presenteren met de gedetailleerde
bewegingen voor elke rekening. Deze visie is zeer nuttig voor verdere details en is een ander
voordeel van een liquiditeitsgerichte planning, die moeilijk te bereiken is met spreadsheets.

Het berekeningsjournaal
De basis voor alle boekhouding en budgetverwerking is het berekeningsjournaal. Voor het opstellen
van de balans, de Winst- en verliesrekening, de rekeningkaarten en de BTW-overzichten maakt het
programma een interne gegevensstructuur aan die het berekeningsjournaal wordt genoemd. De
mutaties zijn toegankelijk via de Accounting API met de Journal() functie (Engelstalig).

De logica voor het maken van het berekeningsjournaal is als volgt:

Het wordt aangemaakt op basis van de door de gebruiker ingevoerde gegevens.
Voor elke financiële mutatie, inclusief de openingssaldi, is er een rij, waarin de belangrijkste
elementen staan:

Oorsprong
Geeft aan of de transactie verband houdt met de (lopende) boekhouding of met de
planning (begroting).
Type verrichting
Openingssaldo, mutatie, overdracht, factuurvergoeding.
Datum (de relevante datum)
Beschrijving
Rekening
Type Rekening
Geeft aan of het een normale rekening is of een kostenplaats of winstcentrum.
Bedrag (basisvaluta van de boekhouding)
Positieve waarden duiden op een toename (debet), terwijl negatieve waarden duiden op
een afname (credit).
Bedrag in rekeningvaluta
Andere kolommen

Alle kolommen die aanwezig zijn in de Transacties tabel.
Verschillende andere die worden gebruikt voor berekeningen.

Bij elke herberekening wordt het berekeningsjournaal geleegd en vervolgens worden toegevoegd:

De rijen van de huidige mutaties (met betrekking tot de eigenlijke boekhouding).
De rijen van de budgetbewegingen.
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De rijen van de huidige waarden (effectief)

De rijen voor de huidige waarden worden toegevoegd aan het tijdelijke journaal vanuit:

Beginbalansen in de Rekeningen tabel
Voor elke rekening met een saldo wordt een rij aangemaakt.

De datum is de begindatum van de boekhouding.
De rekening is de rekening.
Het bedrag is het beginsaldo.

Boekhoudmutaties uit de Transacties tabel
Als de mutatie meerdere rekeningen heeft, een Debet rekening, een Credit rekening, BTW-
rekening, kostenplaats, wordt voor elke rekening één rij gegenereerd met het overeenkomstige
bedrag in positief of negatief.

De rijen van de budgetwaarden

De rijen voor de budgetwaarden worden toegevoegd aan het tijdelijke journaal vanuit:

Beginsaldi in de Rekeningen tabel
Zoals met de boekhoudwaardes wordt er voor iedere rekening met een saldo een budgetregel
aangemaakt.

Planning-mutaties (met de Budget tabel)
Net als voor de boekhouding, worden voor elke mutatie op de rekening rijen gecreëerd vanuit
de Budget tabel

De statische, met alle ingestelde waarden.
Herhaalde mutaties

Gedurende de gehele gedefinieerde projectieperiode, gebaseerd op de
herhalingscode, maakt het programma duplicaten aan van de budgetrijen en stelt
het de datum in.
Het programma genereert de herhaalde rijen op basis van de inhoud van de
kolommen Begindatum, Einddatum en Herhalen.
Als de projectieperiode het kalenderjaar is en er in januari de huurbetaling is met
maandelijkse herhaling, maakt het programma duplicaten voor de volgende 11
maanden.
Als de transactie op 31 januari plaatsvindt, voor maanden die geen 31 dagen
hebben, is de dag de laatste van de maand.
Als de eerste transactie op 28 maart plaatsvindt en de herhalingscode als einde van
de maand wordt aangegeven, wordt het in de volgende maanden de laatste dag
van de maand.

Net als bij de boekhoudmutaties wordt er, als er meerdere rekeningen op de rij in
de budgettabel staan, voor elke rekening één rij gegenereerd.

Mutaties vanuit het jaarlijkse budget (indien er geen Budgettabel is)
Als er geen Budgettabel is, worden de budgetrijen gemaakt op basis van de inhoud van de
kolom Budget in de tabel Rekeningen en Categorieën:

Er wordt berekend hoeveel maanden er in de boekhoudperiode zijn.
Voor elke maand wordt een rij aangemaakt.
Het bedrag in de Budgetkolom wordt gedeeld door het aantal maanden.
Als er een afrondingsverschil is, wordt er een extra rij gemaakt voor de laatste maand.

Zodra de aanmaak afgerond is, worden de rijen in oplopende volgorde gesorteerd.
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Berekening Bedrag kolom

Zodra het berekeningsjournaal is aangemaakt, wordt de inhoud van de hoeveelheidskolom van alle
Budgetrijen, die een formule of hoeveelheid of eenheidsprijs bevatten, herberekend.

Risoluzione delle formule in Javascript:

Creatie van een Javascript-interpreter
Elke keer dat het berekeningsjournaal wordt aangemaakt, wordt ook een exemplaar van een
Javascript interpreter, specifiek voor de resolutie van de Budget formules, aangemaakt.

Javascript-interpreter initialisatie
De Javascript interpreter wordt geïnitialiseerd door het uitvoeren van scripts.

De standaard scripts van Banana Boekhouding.
De inhoud van het bestand _budget.js eventueel aanwezig in de Documenten tabel.
Op deze manier kan de gebruiker variabelen initialiseren of zijn eigen rekenfuncties
creëren.
 

Resolutie van formules
De formules in de rijen van het tijdelijke journaal worden één voor één opgelost in de
progressieve datumvolgorde.
De status van de Javascript interpreter blijft na elke bewerking behouden, zodat de
formule kan verwijzen naar variabelen die zijn gedefinieerd in een rij met een eerdere
datum.
De formules in de herhalingsregels worden ook in datumvolgorde uitgevoerd, dus het
resultaat varieert afhankelijk van wanneer het wordt uitgevoerd.

De berekeningsvolgorde is als volgt

De budgetrijen worden in volgorde van datum verwerkt (als ze dezelfde datum hebben in de
volgorde van binnenkomst).
Het bedrag van de transactie wordt met deze prioriteit berekend:

Als er een formule is, door hem op te lossen
Als de hoeveelheid en de prijs aanwezig zijn, door deze te vermenigvuldigen
In het andere geval blijft de waarde in de kolom "Bedrag" behouden.

Bij de vreemde valuta boekhouding wordt eerst de formule "bedrag in valuta" uitgevoerd en
vervolgens de formule "bedrag in basisvaluta"
Als er geen formule "bedrag in basisvaluta" is, hervat het programma de historische wisselkoers
en berekent het de tegenwaarde in de basisvaluta.
Voor de boekhouding met BTW wordt de BTW opnieuw berekend op basis van het bedrag van
de transactie.
De eerder verwerkte rijen worden gebruikt voor de berekening van de volgende rijen.

Het saldo van de rekeningen, op de datum van de budgetrij, zal enkel de eerder
verwerkte bedragen bevatten.
Als u bij een transactie in februari een formule gebruikt om het saldo voor het hele jaar te
berekenen, verkrijgt u toch alleen het saldo tot februari.

Berekening kolom Totaal van de Budget tabel
De kolom Totaal wordt automatisch berekend en bevat het totale bedrag van de begroting voor de
boekhoudperiode zoals aangegeven in de bestandseigenschappen (begin- en einddatum van de
boekhouding).
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Als het om één enkele operatie gaat, is het totaal gelijk aan het bedrag.
Indien het een terugkerende operatie betreft, is het Totaal de som van de bedragen van alle
herhalingen die binnen het boekjaar vallen.
De kolom Totaal is leeg als de datum voor of na de boekperiode ligt.

Berekening van de huidige waarde, budget en vergelijking
Zodra het berekeningsjournaal is gegenereerd, wordt het gebruikt om de balans en alle andere
berekeningen die nodig zijn voor de boekhouding te berekenen.

Voor de in het rapport gedefinieerde periodes berekent het programma:

De huidige waarde (gebaseerd op de Transacties).
De Budgetwaarden

De volgende waarden worden berekend voor actuele en budgetwaarden:

Saldo aan het begin van de periode.
Debet beweging
Credit beweging
Beweging (Totaal)

Saldo op het einde van de periode (begin + mutatie)

Ook worden vergelijkingen tussen Huidig en Budget berekend:

Absolute variatie (Budget - Huidig).
Procentuele variatie

Automatische en handmatige herberekening
De budgetwaarden worden automatisch herberekend:

Als er een wijziging is in de Budget tabel.
 Als er een wijziging is in de begin- of einddatum van de boekhouding.
Als er een wijziging is in de Rekeningen tabel.

Wanneer een rapport wordt opgevraagd en de Transactietabel is aangepast.

Na elke herberekening werkt het programma automatisch bij:

De Budget kolom in de tabel Rekeningen en Categorieën.
De kolom Totaal in de Budget tabel..

Als u de BTW-tabel of het bestand _budget.js of andere Javascript-bestanden die bij de berekening
van de formules worden gebruikt, wijzigt, moet u handmatig een herberekening uitvoeren
(Commando Boekhouding controleren en opnieuw berekenen)

De berekeningssnelheid is afhankelijk van:

Aantal rekeningen en groepen in de tabel Rekeningen en Categorieën
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Aantal rijen ingevoerd in de Budget tabel.
Aantal rijen met herhaling
Aanwezigheid van formules.
Ingestelde planningsperiode. Hoe langer de periode, hoe groter het aantal herhalingsrijen.

Handmatige herberekening

Als de berekening lang duurt, kan het moeilijk zijn om gegevens in de Budget tabel in te voeren. U
kunt overschakelen naar handmatige herberekening door de optie Totalen handmatig opnieuw
berekenen aan te vinken, via Menu Menu Bestand → Bestands en boekhoudingseigenschapen
→ Opties tab.

Om de bijgewerkte waarden te krijgen, gebruikt u het commando Totalen opnieuw berekenen.
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Periode voor de financiële prognose

Met het budgetteringssysteem gebaseerd op de methode van het dubbel boekhouden kunt u
prognoses maken waarbij u aangeeft wanneer de activiteiten plaatsvinden.
In tegenstelling tot Excel, waar u een werkblad opzet met kolommen voor de budgetperiodes (maand,
kwartaal of jaar), kunt u met Banana Boekhouding eenvoudig de verwachte datum van de
gebeurtenis aangeven. De toewijzing aan een periode wordt automatisch gegenereerd door het
programma als het de gegevens verwerkt. U bepaalt of de prognoses worden weergegeven per dag,
week, maand, 2 maanden, kwartaal, halfjaar, jaar, of per 2, 5 of 10 jaar.

Prognose kunnen voor een of meerdere jaren gemaakt worden.
Op basis van de ingevoerde gegevens berekent het programma de verwachte liquiditeit, balans
en resultatenrekening voor de betreffende periode.
Dagelijkse prognoses zijn mogelijk, vooral geschikt voor liquiditeit maar ook per maand of jaar.
Zie  Rapporten financiële prognoses.

Boekhoud-, planning- en prognoseperiode
De boekhouding of prognose is altijd van toepassing op een periode. De volgende periodes worden
onderscheiden:

Boekhoudperiode
Deze wordt gedefinieerd in de bestandseigenschappen, met een begin- en een einddatum.
In het algemeen is deze periode hetzelfde als het kalenderjaar maar kan elke begin- en een
einddatum hebben.
Budgetperiode
De periode waarvoor de budgetgegevens worden ingevoerd.

Voor het budget hoeft geen periode te worden ingesteld.
Er wordt in het algemeen aangenomen dat deze hetzelfde is als de boekhoudperiode.
De planningsperiode kan verschillen van de boekhoudperiode.
In de budgettabel kunnen rijen worden ingevoegd die gevolgen hebben buiten de
boekhoudperiode.

Transacties met data buiten de boekhoudperiode.
Herhalende transacties zonder een einddatum of met een einddatum die buiten de
boekhoudperiode ligt.

Prognoseperiode
De periode die door het programma gebruikt wordt om de prognose te berekenen.

Deze wordt aangegeven wanneer een afdruk wordt gemaakt.
Gebruikt standaard de boekhoudperiode.
De periode kan naar eigen inzicht worden ingesteld en op deze manier kunnen
prognoses worden verkregen meerdere jaren en zelfs voor meerdere decennia.

De boekhoudperiode wordt gebruikt als prognoseperiode voor de berekening van de
inhoud van de kolom Totaal in de budgettabel en van de kolom Budget in de rekeningen-
en categorieëntabellen.

Deze waardes verwijzen daarvoor naar de boekhoudperiode gedefinieerd in de
bestandseigenschappen.
Als u de boekhoud begin- en einddatum verandert worden de budgetten opnieuw
berekend.
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Prognose met maandelijkse logica
Budgetboekingen worden ingevoerd in de budgettabel met een indicatie van de datum waarop de
bijbehorende gebeurtenissen worden verwacht. Voor liquiditeitsprognoses is het belangrijk data voor
inkomsten en uitgaven zo nauwkeurig mogelijk aan te geven.

Voor alle andere inkomsten en uitgaven die op een dag van de maand gebeuren of eigenlijk aan het
begin of het eind, zoals huur, lonen, bankkosten en ander uitgaven of inkomsten, is het belangrijk de
datum aan te geven van de dag dichtbij de feitelijk dag van betaling.

Voor andere inkomsten en uitgaven worden benaderingen gemaakt. Bijvoorbeeld - behalve in speciale
gevallen - voor restaurant inkomsten die dagelijks binnenkomen, is het niet handig dagelijkse
prognoses te maken. In dit geval is het voldoende om de totale omzet aan te geven die in de maand
wordt verwacht. We raden aan om dag 15, het midden van de maand, te gebruiken.

Prognose voor het huidige jaar
Transacties met of zonder herhalingen worden ingevoerd in de budgettabel.

De berekening van de prognose wordt in het algemeen gedaan met de transacties die binnen de
huidige boekhoudperiode, gedefinieerd in de bestandseigenschappen, vallen.

Het totale bedrag voor de huidige periode wordt weergegeven in de kolom Totaal van de
budgettabel.
Het geschatte saldo voor de huidige periode wordt weergegeven in de kolommen Budget van
de rekeningen- en categorieëntabel.
In de diverse afdrukken zijn er prognoses voor de huidige periode als u de hele periode
aangeeft.

Als het bestand ook wordt gebruikt om de boekhouding te doen moet de boekhoudperiode uiteraard
de periode zijn van de boekhouding. Zelfs als het bestand alleen voor budgettering wordt gebruikt is
het beter de boekhoudperiode voor maar één jaar in te stellen. Als een periode van twee jaar wordt
opgegeven in de basisgegevens zijn de bedragen in de kolommen Totaal en Rekening voor twee jaar.
Dit kan leiden tot verwarrende bedragen.
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Prognoses voor meerdere jaren
Wanneer u budgettransacties invoert met een herhalingscode kan het programma prognoses maken
die verder gaan dan de gedefinieerde periode.

Om prognoses voor meerdere jaren te krijgen worden de transacties in de budgettabel ingevoerd.

Beginsaldi
Deze worden ingevoerd in de rekeningentabel.

Budgettransacties van voor de boekhoudperiode.
Voor speciale gevallen is het mogelijk transacties in te voeren met data voor de
boekhoudperiode.
Voorzichtigheid is geboden omdat deze bewerkingen de saldi veranderen op het moment
dat de boekhouding geopend wordt.
Voor deze transacties is de kolom Totaal leeg omdat dit buiten de boekhoudperiode is.

Budgettransacties binnen de boekhoudperiode.  
Transacties worden ingevoerd met een datum die binnen de boekhoudperiode valt.
Als er bewerkingen zijn die zich ook herhalen in de volgende jaren moet de
herhalingscode op  "Y" gezet worden.
Als de herhaling van de bewerking gedurende meerdere jaren voorkomt geef dan het
aantal jaren aan voor de Y, bijvoorbeeld voor iedere 2 jaar geeft u "2Y", 5 jaar "5Y", 10
jaar "10Y".
Als de herhaling niet voorbij een zekere datum moet gaan (bijvoorbeeld de betaling van
een huur) moet de einddatum worden ingevoerd.

Budgettransacties voor de volgende jaren.
De toekomstige datum waarop de transactie wordt verwacht wordt aangegeven.
De herhalingscode en de einddatum kunnen aangegeven worden.
Voor deze transacties blijft de kolom Totaal leeg omdat deze buiten de boekhoudperiode
vallen.

Gebruik van formules
Met formules kunt u afschrijving- en renteberekeningen automatiseren. Wanneer een investering
toeneemt wordt de resultatenrekening meteen bijgewerkt. Formules zijn vooral nuttig bij het maken
van prognoses voor meerdere jaren.

U kunt de formules gebruiken om de bedragen in de herhalingsrijen automatisch aan te passen.

De berekening van de afschrijving kan worden gebaseerd op het saldo van de activa rekening.
Rente kan direct worden berekend vanuit de bankrekening boekingen.
U kunt de ontwikkeling van de verkopen bepalen.
Aankopen kunnen worden gedefinieerd als een percentage.

Afdruk met de prognoseperiode
Omdat de transacties met de herhalingscode of met de datums van de volgende jaren worden
ingevoerd in de budgettabel kan het programma de prognoses voor toekomstige jaren berekenen.
Bij het afdrukken van het overzicht moet u de begin en einddatum aangeven in de sectie Periode van
de instellingen van het afdrukcommando.

Stel dat de begindatum 1 januari 2022 is:
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Als u een 2 jaren prognose wilt geef dan als einddatum 31 december 2024 aan.
Als u een 5 jaren prognose wilt geef dan als einddatum 31 december 2027 aan.
Als u een 20 jaren prognose wilt geef dan als einddatum 31 december 2042 aan.

Bij de volgende afdrukken kan een prognose verkregen worden:

Uitgebreide balans op groepen.
Boekhoudoverzicht.
Rekening/Categorie kaarten.

Alle boekhoudoverzichten kunnen bedragen uit de boekhouding, prognosebedragen of beide
bevatten. De mogelijke parameters zijn dezelfde voor boekhoudrapporten en prognoses.

Dankzij deze overzichten kunt u voor toekomstige periodes de volgende overzichten, en meer
genereren:

Voorlopige balans,
Voorlopige resultatenrekening,
Liquiditeitsplanning,
Investeringsplanning,
Financiële planning.

Kolommen verdeeld per periode
De Sectie Onderverdeling van de instellingen van het afdrukcommando kunt u gebruiken om het
programma kolommen voor de periode te laten genereren..

U kunt hiermee de ontwikkeling per maand, kwartaal of jaar weergeven.

Met Composities kunt u afdrukformaten instellen die u later weer kunt gebruiken. Het is handig om
vooringestelde composities te hebben, algemeen, per jaar, 5 jaar of met de vergelijking tussen de
eindbalans en de schatting die direct opgevraagd kan worden.

Budget - Vier-jaar prognose
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Winst- en Verlies-rekening - Vier-jaar prognose
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Budgettransacties

Bij het maken van financiële prognoses, gebaseerd op de methode van het dubbel boekhouden,
worden transacties ingevoerd in de budgettabel. Hierbij worden de bron- en de
bestemmingsrekeningen voor iedere transactie aangegeven. Het programma heeft de informatie die
nodig is om de balans en de resultatenrekening te maken. Deze hebben echter betrekking op de
toekomst en niet het verleden.

Wanneer men in Excel budgetteert wordt de resultatenrekening eerst opgezet, daarna worden de
inkomsten en kosten opgesomd. In het algemeen worden het liquiditeits- en inversteringsplan pas
later gemaakt en in aparte werkbladen.
Bij het maken van prognoses met de methode van het dubbel boekhouden gaan we te werk alsof we
een boekhouding doen in de toekomst. Alle transacties die naar verwachting zullen plaatsvinden,
zullen worden opgesomd. Het programma maakt dan automatisch de balans en resultatenrekening
voor de aangegeven periode(s).

Structuur van de budgettransacties
Voor het opstellen van een financieel plan gaan we over het algemeen uit van een lijst met de
verschillende elementen in de volgende indeling:

Kapitaalinjecties.
Kapitaalinjecties door derden.
Opstellen van uitgaven.
Investeringen.
In meubilair, gereedschap.
Terugkerende vaste lasten.
Rente, personeel, sociale lasten, energie, abonnementen.
Terugkerende inkomsten.
Variabele inkomsten.
Seizoensgebonden omzet.
Variabele lasten.
Commissies, kosten van de verkochte goederen en andere kosten, die verband houden met de
verwachte omvang van de inkomsten.
Einde jaars transacties.
Afschrijving, belastingen, rente van leningen, dividenden.

Op het moment dat u verkopen en variabele kosten invoert heeft u al de structuur van de kosten en
het kapitaal. U weet dan meteen of het bedrijf met de verwachte omzet genoeg winst en liquiditeit
kan genereren om zijn voortbestaan in de toekomst te garanderen.

Kolommen Bedrag en Formule
In de regel gebruikt u eenvoudig de kolom Bedrag om een budget op te stellen.
Voor uitgebreidere schattingen is er de mogelijkheid om hoeveelheden, eenheidsprijzen of formules
te gebruiken. Het programma rekent automatisch het bedrag uit in de kolom Bedrag.
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Prognoses bijwerken
Dankzij de mogelijkheid om met de methode van het dubbel boekhouden iedere bewerking in detail
aan te geven wordt het makkelijker om de prognose bij te werken en te verbeteren. In het begin
worden schattingen voor verschillende kosten of investeringen ingevoerd. Naarmate u dichter bij de
uitvoeringsfase komt en er meer nauwkeurige gegevens zijn, vervangt u de eerder ingevoerde
gegevens. Zelfs als het bedrijf is gestart en exacte gegevens bekend zijn kan de prognose eenvoudig
worden bijgewerkt.Er zijn daardoor nauwkeurige en betrouwbare indicaties over de winstgevendheid
en de liquiditeit beschikbaar.
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Data en herhalingen in financiële budget
transacties

De Datum kolom
De waarde in de kolom Datum is bepalend voor de prognose.

Als er geen datum is wordt de transactie verwerkt aan het begin van de planning.
Als u een prognose nodig heeft die een periode omvat worden de bedragen bij het begin van de
periode verwerkt in het saldo.
Omdat de datum niet in de periode valt wordt er geen bedrag in de kolom Totaal getoond.
Data in de boekhoudperiode die is ingesteld in de bestandseigenschappen.
Dit zijn de data die gewoonlijk gebruikt worden. Het totale bedrag wordt aangegeven in de
kolom Totaal, waarbij rekening wordt gehouden met herhalende transacties binnen de
boekhoudperiode.
Data vóór de periode.
U kunt transacties invoeren die voorafgaan aan de prognose periode. U moet er echter op
letten dat deze niet in strijd zijn met de beginsaldi die ingevoerd zijn in de rekeningentabel.
Omdat de datum niet in de periode valt wordt er geen bedrag in de kolom Totaal getoond.
Data na de periode.
Als u prognoses maakt voor meerdere jaren kunt u transacties voor het komende jaar invoeren.
Omdat de datum niet in de periode valt wordt er geen bedrag in de kolom Totaal getoond.

De Eind datum
De einddatum wordt gebruikt in combinatie met herhaling om de laatste datum aan te geven waarop
geen herhaling meer is.

Moet in het algemeen leeg gelaten worden.
Als u een datum invoert terwijl het niet nodig is (bijvoorbeeld het einde van de
boekhoudperiode) worden de prognoses voor de volgende jaren niet meegenomen in deze
bewerking.
Voor huurtransacties.
Geef als einddatum aan de datum waarop de betaling van de laatste termijn wordt gedaan.
Voor de aflossing van de lening.
Geef de laatst verwachte betaaldatum aan.
Voor veranderingen in het bedrag op ingestelde tijdstippen.
Bijvoorbeeld in het geval dat het bedrag van een terugkerende transactie wordt aangepast op
een zeker tijdstip (salarisverhoging).

Maak een transactierij aan met herhalingscode "M" en als einddatum de laatste betaling
voor de verhoging.
Maak transactierijen aan met data wanneer de verhoging begint.
Als de verhoging een nauwkeurig en geregeld automatisme volgt kan deze ook worden
geprogrammeerd met formules.
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Herhalingen
Voor terugkerende uitgaven of inkomsten raden we de herhalingscode aan (zie Documentatie over de
kolommen).

Bij het berekenen van de prognose maakt het programma kopieën van de transacties en
verhoogt de datum volgens de opgegeven frequentie.
Als er geen einddatum is ingesteld genereert het programma interne kopieën van de
transacties voor de hele periode van de prognose aangegeven op het moment van het
overzicht bij het berekenen ervan.

Als de begindatum januari is is de frequentie maandelijks.
Als de budgetperiode een jaar is genereert het programma de rijen vanaf februari
automatisch, er is dan 1 oorspronkelijk aangemaakte rij en 11 automatische
aangemaakte rijen, in totaal 12 rijen.
Als de budgetperiode 10 jaar is genereert het programma de rijen vanaf februari
automatisch, er is dan 1 oorspronkelijk aangemaakte rij en 119 automatische
aangemaakte rijen (11 voor het eerste jaar + 12 maal 9 voor de volgende jaren), in
totaal 120 rijen.

Als u wilt dat het programma automatisch prognoses berekent voor volgende jaren.
Voor terugkerende bewerkingen geeft u de bijbehorende herhalingscode aan.
Voor transacties die maar één keer per jaar voorkomen (bijvoorbeeld afschrijving aan het
eind van het jaar) geeft u de herhalingscode "Y" aan zodat de afschrijving ook in de
volgende jaren wordt berekend.
Gebruik de herhaling niet, alleen als de bewerking niet in het volgende jaar gebeurt.

Kolom Totaal van de Budgettabel
De kolom Totaal wordt automatisch berekend en vertegenwoordigt de som van de bedragen in de
huidige rij en de herhalingsbedragen die binnen de boekhoudperiode vallen. De kolom Totaal is leeg
als de transacties een datum hebben die voor of na de boekhoudperiode valt.

Budget met vaste data en maandelijkse logica
Budgettransacties worden ingevoerd in de Budgettabel met een datum waarop deze verwacht
worden.

Het is echter niet altijd mogelijk alle inkomsten en uitgaven met een dagelijkse precisie te
voorspellen. Het is daarom bij het maken van een budget in sommige gevallen handig een
benadering, op maandelijkse basis redenerend, te gebruiken. In ieder geval is het nuttig altijd een
specifieke logica te volgen zodat betrouwbare liquiditeitsprognoses verkregen kunnen worden op
korte termijn:

Handelingen op vaste tijdstippen (kapitaaluitkering, investeringen) worden aangegeven
met de datum waarop ze worden verwacht.
Als er geen precieze datum is is het handig deze op de 15de dag van de maand waarin ze
worden verwacht aan te geven.
Terugkerende kosten die een precieze betaaldatum hebben moeten worden ingevoerd met
de verwachte betaaldatum en de bijbehorende herhalingscode:

Bankkosten, interest, afschrijving moeten worden aangegeven op het eind van de maand,
kwartaal of jaar waarin ze gebeuren.
Rentes op de verplichte, verwachte, betaaldatum.
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Salarissen en sociale lasten.
Voor de berekening en de maandelijkse betaling, op de dag dat de salarissen
worden betaald.
Voor een dertiende maand, bonussen of wat dan ook, op het moment dat deze
worden betaald.
Vooruitbetalingen en aanpassingen van sociale lasten, op van de verwachte
betaaldatum.

BTW betalingen en aanpassingen, op de geëigende verplichte betaaldag.
Inkomsten budgettering.
Het opstellen van prognoses is afhankelijk van het soort activiteit.
Als u geen exacte datum weet maar u weet dat iets in een bepaalde maand gebeurt is het aan
te raden de 15de van de maand te gebruiken.

Inkomsten op vaste tijdstippen.
Deze moeten worden aangegeven op de datum waarop ze verwacht worden of op het
midden van de maand.
Terugkerende inkomsten.
Deze moeten worden aangegeven op de datum van binnenkomst of op het midden van
de maand.
In veel gevallen is een maandelijkse prognose heel geschikt. De opbrengst kan op de
15de van de maand worden aangegeven.

Als de inkomsten terugkerend zijn kunnen deze ingevoerd worden als een
maandelijkse herhaling. Met formules kunt u groei voorspellen.
Als er seizoensverschillen zijn helpt het om een verkoopbudgetrij voor iedere
maand te hebben.

Budgettering voor projecten of omvangrijke werkzaamheden.
Als er een rooster met bonnen is moet er een transactierij ingevoerd worden voor iedere
bon. Dit kan bij benardering gedaan worden door de 15de van de maand aan te geven.
Prognoses voor klanten.
Voor een consultant of commerciële adviseur, die met budgetten en projecten werkt kan
het erg handig zijn om een gedetailleerde inkomstenprognose op te stellen, met
verwachte betaaldagen, voor iedere klant. Deze prognose is ook erg handig om te
controleren of de klant echt heeft betaald.

Variabele kosten.
Vaste uitgaven die met de omzet te maken hebben (in een restaurant bijvoorbeeld)
worden aangegeven met dezelfde datum als de omzet. Met een formule kunt u ook een
percentage van de omzet berekenen.
De kosten kunnen ook worden gekoppeld aan andere elementen, zoals het aantal
werknemers, gehuurde panden of andere.

Prognose met het kasbeginsel
Bij het budgetteren voor kleine bedrijven en voor contante betalingen (zoals winkels of restaurants) is
het handig te werken met het kasbeginsel en vervolgens de inkomsten aan te geven met de datum
waarop ze zullen worden geïnd en de kosten wanneer ze worden betaald.

Voor belangrijke dingen zoals de aankoop van een machine waarvan de betaling wordt gespreid is het
echter handig budget transacties in detail in te voeren:

Aankoop van machines (activa boeking met leveranciers) met de datum van aankoop.
Betaling van de machines met de data waarop de betaling wordt verwacht.
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Prognoses met de toerekeningsmethode
In dit geval wordt bij het invoeren van de transacties rekening gehouden met wanneer de betaling
gedaan zal worden.

Contante transacties.
Deze worden uiteraard op de normale manier geboekt.
Transacties waarvan verwacht wordt dat deze gedaan worden in de nabije toekomst.
Voor de eenvoud kan het handig zijn het kasbeginsel te gebruiken voor operaties die binnen de
budgetmaand, of de direct erop volgende, vallen.
Uitgestelde betalingen.
Als de data niet nauwkeurig bekend zijn kunt u de 15de van de maand gebruiken.

Transacties met precieze betalingsvoorwaarden.
Een boeking geeft de aankoopdatum aan met de tegenboeking op de
leveranciersrekening.
Een van de andere boekingen geeft de betaling op de geplande datum aan.

Uitgestelde ontvangsten.
Met precieze betalingsvoorwaarden, zoals in een project:

Een boeking geeft de datum van de rekening aan en de klantenrekening in de
tegenboeking.
Een van de andere boekingen geeft de betaling op de geplande data aan.

Achterstallige betaling.
Dit is het geval wanneer een deel van de inkomsten op korte termijn wordt ontvangen en
een percentage later. Dit kan als volgt gedaan worden:

Voer de inkomsten in als contante ontvangsten.
Doe een boeking met dezelfde datum die een deel van de ontvangsten op de
klantenrekening boekt.
Op een latere datum worden de inning aangegeven met de klantenrekening als
tegenboeking.

Gebruik van variabelen voor uitgestelde ontvangsten en betalingen. (zie Voorbeeld van
variabelen gebruik)
Als dezelfde waarde opnieuw gebruikt moet worden op het moment van de betaling kan het
heel handig zijn de formulekolom en variabelen te gebruiken.

In de factureringstransactie wordt het bedrag toegekend aan een variabele.
In de betalingstransactie wordt de variabele ingevoerd zodat het bedrag automatisch
wordt overgenomen.
Variabelen kunnen bijvoorbeeld ook worden gebruikt om het percentage van het bedrag
dat wordt uitgesteld te definiëren.
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Voorbeelden van mutaties voor de financiële
prognose

Budget mutaties worden ingevoerd zoals de gewone transacties met de datum, beschrijving, bedrag,
debet en credit rekening.

Bovendien wordt de kolom Herhalen gebruikt waarmee u terugkerende transacties kunt invoeren op
een enkele regel.

Hierna volgen enkele voorbeelden waarbij we gebruikmaken van het volgende model voor de uitleg.

Business plan en budget van een Startup (Dubbel boekhouden) .

Startup budget boekingen
Dit zijn de budget transacties, op dezelfde manier ingevoerd als in die in de transactietabel.

In het volgende voorbeeld gaat het om budgettransacties die niet herhaald worden omdat het om het
opstarten van het bedrijf gaat.

Maandelijks terugkerende transacties
De volgende voorbeelden zijn voor een maandelijks terugkerende transactie, met code 'M'. De kolom
Totaal laat het totale bedrag zien voor het jaar.

De eerste twee transacties hebben betrekking op de rente die van februari tot juni 1000 per maand
is, terwijl deze vanaf juli 1200 is.

De regel met als datum 2024, wanneer de aflossing van de huurovereenkomst moet worden betaald,
wordt ook aangegeven. In deze regel is er geen bedrag in de kolom Totaal omdat de mutatie niet valt
binnen de data van de boekhoudperiode gedefinieerd in de bestandseigenschappen.

De herhalingscode "ME", maand einde, wordt gebruikt voor door de bank gerekende administratieve
uitgaven. Voor volgende transacties wordt dag 28 niet gebruikt maar de laatste dag van de maand,
zoals 31 maart, 30 april, etc.

https://www.banana.ch/apps/nl/node/8082
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Kwartaaleinde
Hier geven we enkele transacties aan die typerend zijn voor herhaling aan het einde van het kwartaal.
We voeren de 3ME herhaling in die betekent dat er iedere 3 maanden een herhaling is op de
einddatum van de maand.

Jaareinde
Aan het eind van het jaar moeten er ook transacties uitgevoerd worden. Gebruik herhalingscode "Y"
zodat deze transacties ook in de volgende jaren worden uitgevoerd.

Prognoses voor inkomsten en inkopen
De prognose voor de inkomsten is specifiek per activiteit. In dit geval wordt de prognose voor de
inkopen per maand getoond met telkens een specifiek bedrag.

Vanaf maart wordt de code voor herhaling per jaar, "Y', gebruikt zodat deze transacties in de
volgende jaren worden herhaald.

https://cdn.banana.ch/portal/repodata/ghba/FinancialPlanning/Italian/images/lucasbar_double_entry_budget_february_it.png
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Inkopen en verkopen voor volgend jaar
De maanden januari en februari van het eerste jaar worden als niet belangrijk beschouwd voor de
volgende jaren en daarom hebben deze heen herhalingscode.
Voor de eerste twee maanden van het tweede jaar moeten we de verkopen opgeven. We gebruiken
ook de jaarlijkse "Y" herhalingscode zodat we het inkomen in de volgende jaren kunnen herhalen.
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Budgettering met hoeveelheid en prijs

Met de kolommen Hoeveelheid, Eenheid en Prijs per eenheid van de Budgettabel kunt u sneller
prognoses maken.

De waarde van de kolom Bedrag wordt berekend door het programma door de Hoeveelheid met de
Prijs per eenheid te vermenigvuldigen (op voorwaarde dat de kolom Formule leeg is).

De kolommen Hoeveelheid en Prijs per eenheid worden zichtbaar in de weergave Formule.

Voordelen van het gebruik van de kolommen Hoeveelheid
en Prijs
De kolommen Hoeveelheid en Prijs zijn nuttig voor het maken van verwachtingen gebaseerd op
hoeveelheden. Bij voorbeeld:

In de kolom Eenheid kunt u aangeven waarop de prijs betrekking heeft.
De kolom hoeveelheid geeft het dagelijkse aantal bediende plaatsen aan.
De kolom Prijs geeft de verwachte inkomsten voor ieder couvert aan.
De kolom Bedrag wordt automatisch berekend op basis van de aangegeven waarden.

Deze benadering biedt diverse voordelen:

Alle elementen van de prognose kunnen precies worden gespecificeerd in het Budget.
We kunnen de hoeveelheden en prijzen die gebruikt werden om de prognose te maken
terugvinden.
Het budget veranderen is erg simpel, u kunt precies het element veranderen dat u wilt.
Hoe de winst veranderd kunt u zien met een verandering in de verkochte hoeveelheden of in de
prijs.
Break-even analyse.

https://cdn.banana.ch/portal/repodata/ghba/FinancialPlanning/Italian/images/formule_quantity_and_price.png
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Javascript formules in de budgettabel

De mogelijkheid om formules te gebruiken is alleen beschikbaar in Banana Boekhouding
Plus met het Advanced plan . Update nu !

Kolom Formule
In de kolom Formule kunt u berekeningsformules invoeren. Daarmee kunnen de budgetbedragen
berekend worden  op basis van andere bedragen in hetzelfde budget (zie Voorbeelden van formules).

Geef de kosten aan van goederen als een percentage van de verkopen.
Verhoog uw verkopen budget als een percentage van de groei.
Bereken aan het eind van het jaar de afschrijving gebaseerd op de waarde van de
investeringen.
Bereken elk kwartaal de rente op de bankrekening gebaseerd op het werkelijk gebruik (dagen /
365).
Bereken elke maand de rente op de bankrekening gebaseerd op het werkelijk gebruik (dagen /
365).

Wanneer u een waarde/formule in de kolom Formule invoert wordt de kolom Bedrag
berekend door het programma gebaseerd op die waarde/formule.

Zoals uitgelegd in de documentatie van de tabel Budget , kunt u ook Javascript formules gebruiken:

In de kolom Formule Begin
In de kolom Omschrijving, voor herhalende rijen.

Voorbeeld bestanden
Voor voorbeelden van de formules zie de uitleg op de volgende pagina's:

Model met transacties die de Hoeveelheid en Formule kolommen gebruiken .
Model voor vreemde valuta boekhouding waarin gebruik gemaakt wordt van de kolom Formule
in basis munteenheid  (Engelstalig).
Zie ook Voorbeelden van het gebruik van formules in financiële prognoses.

https://www.banana.ch/nl/buy
https://www.banana.ch/nl/update
http://www.banana.ch/doc/nl/node/9344
http://www.banana.ch/apps/nl/node/8251
http://www.banana.ch/apps/en/node/8258
http://www.banana.ch/apps/en/node/8258
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Formules om mee te rekenen in Javascript
De formule moet uitgedrukt worden in de programmeertaal Javascript  (niet te verwarren met
de programmeertaal Java).
Als er een formule is (of enige tekst) wordt het resultaat in de kolom Bedrag gezet.
U kunt alle Javascript functies gebruiken en ook de functies die geleverd worden door de API
van Banana.

Decimalen scheidingsteken
Javascript gebruikt alleen de punt "." als scheidingsteken voor de cijfers achter de komma.
Als u een ander scheidingsteken gebruikt, bijvoorbeeld het teken voor getallen in lokaal formaat,
wordt het getal afgebroken.

Bedrag = resultaat van de laatste instructie
In Javascript wordt de puntkomma ";" gebruikt om expressies te scheiden. Als de Javascript formule
meerdere expressies bevat, gescheiden door ";", is de waarde van de kolom Bedrag het resultaat
van de laatst uitgevoerde expressie. Expressies worden van links naar rechts uitgevoerd.

10*3 //30 wordt teruggegeven
Als er een reeks van meerdere operaties is gescheiden door een puntkomma ";" wordt het
resultaat van de laatste operatie teruggegeven.
10*3;7; //7 wordt teruggegeven
Als er een return wordt uitgevoerd wordt waarde van de return teruggegeven.
return 10; // 10 wordt teruggegeven.

Variabelen
Javascript variabelen  zijn de krachtigste programmeerelementen omdat ze u toegang tot het
computergeheugen geven met een naam, u ze kunt opslaan en ophalen met deze naam.
Variabelen bestaan niet in Excel formules maar zijn gelijkwaardig aan de naam van de cellen met het
verschil dat de naam zelf toegekend kan worden.

De variabele wordt aangemaakt door een naam te geven en een isgelijkteken (=) te gebruiken.

U kunt variabelen direct binnen rijen definiëren. Door de variabelenaam in een formule te gebruiken
wordt de opgeslagen waarde overgenomen.

De variabel prijs wordt hier gecreëerd en is en de waarde 10 wordt eraan toegekend.

https://nl.wikipedia.org/wiki/JavaScript
https://www.w3schools.com/js/js_variables.asp


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 695

var prijs = 10;

of eenvoudig

prijs = 10;

hierna maken we variabel totaal aan waaraan de waarde van prijs vermenigvuldigd met 5 wordt
toegekend.

totaal = prijs * 5;

De waarde van de variabele kan worden veranderd.

prijs = 20;

Objecten

Javascipt objecten  zijn variabelen waarin u meerdere waardes kunt opslaan die ieder worden
aangegeven als een eigenschap.
Het object prijzen wordt hierna aangemaakt met lege kromme haken. Om de waardes op te halen en
op te slaan gebruikt u vierkante haken of geeft u de naam van de eigenschap aan achter het object
gescheiden door een punt.

prijzen = {}
prijzen['auto'] = 10;
prijzen.auto = 10;
prijzen['computer'] = 20;
prijzen.computer = 20;

Array

Javascript Arrays  worden gedefinieerd door vierkante haken te gebruiken; daarmee worden ze ook
benaderd.
Het eerste element van het array heeft index 0.

kosten = [1,2,3];
kosten[0]=3;
resultaat = prijzen['car'] - kosten[0];

Herhaling en variabelen
Voor meer informatie over de volgorde van de berekening zie Planning gebaseerd op de Dubbel
boekhouden methode.

Alle rijen (ook die voor herhalingen) worden gesorteerd op datum. Indien er rijen zijn met
dezelfde datum, is de volgorde die van hun invoeging in de tabel.
Na het sorteren worden de rijen (inclusief de formules) herberekend.
In de formules hebt u daardoor alleen toegang tot de begrotingsgegevens tot die datum.
Een variabele moet worden gedefinieerd in een rij waarvan de datum voorafgaat aan de rij
waarin zij wordt gebruikt.
Indien de begrotingspost een herhaling heeft, zal de variabele telkens opnieuw worden
toegewezen.
som = 10;

https://www.w3schools.com/js/js_objects.asp
https://www.w3schools.com/js/js_arrays.asp
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Als u in plaats daarvan het totaal wilt berekenen.
Maak in een eerste regel de variabele met waarde nul.
som = 0;
In de regel die zich herhaalt in de som ook de vorige waarde opnemen.
som = som + 10;
of gebruik de "+="
som += 10

Automatische variabelen
budgetCurrent
Is een tabel die de budgetrijen bevat na de aanmaak van de herhalingen. Deze worden gebruikt
om waardes vast te leggen in samenhang met JRepeatNumber.
DEBUG 
is een variabele die "true" of "false".
Als deze "true" is worden in het berichtenvenster alle resultaten van de formules weergegeven.
row
Is een javascript object dat verwijst naar de huidige rij.

De waarden van de cellen kan worden opgehaald met de functie
value("columnNameXml").
row.value("date") geeft de de datum van de transactie terug.
row.value ("JRepeatNumber") geeft het nummer van de herhaling terug.
De eerste repetitie is 0.

_totalPrice
Dit is de waarde van de kolom Hoeveelheid vermenigvuldigd met de kolom Eenheid.
Equivalent aan de de formule "row.value('Quantity')*row.value('UnitPrice')"

Budget Functies
Naast de budget API die is gedefinieerd in de boekhouding klasse API (Engelstalig) zijn er specifieke
functies.

BudgetGetPeriod(tDate, periode)

Deze functie wordt gebruikt in combinatie met herhaling.
Wanneer herhalingen worden aangegeven is het aan te raden naar een berekeningsperiode te
verwijzen en niet naar een precieze datum.

Parameter tDate.
De datum waarnaar de berekening van de periode verwijst.
Gewoonlijk de datum van de boekingsregel.
Periode parameter.
Afkortingen:

Voor de huidige periode
"MC" de huidige maand.
"QC" het huidige kwartaal.
"YC" het huidige jaar.
"MP" de vorige maand.
"QP" het vorige kwartaal.
"YP" het vorige jaar.

In the Experimental version (starting from version 9.1) can also be used
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"DC" huidige dag
"DP" vorige dag
"WC" huidige week
"WP" vorige week
"BC" huidige twee maandelijks (2 maanden)
"BP" vorige twee maandelijks
"SC" huidige half jaar (semester)
"SP" vorige half jaar (semester)

 Return waarde.
Een object bestaande uit twee datums

startDate
endDate

// example
t = BudgetGetPeriod ('2015-01-01', 'MP') returns
t.startDate // 2014-12-01
t.endDate // 2014-12-31

Specifieke budget functies
De volgende functies zijn gelijk aan degenen die beschikbaar zijn met het object Banana.document,
maar kunnen gebruikt worden zonder het object Banana.document aan te geven.

Houd er rekening mee dat:

In plaats van de startDate parameter kunt u een van de afkortingen "MC", "QC", "YC", "MP",
"QP", "YP" gebruiken die uitgelegd zijn in de functie budgetGetPeriod.
Als de periode wordt gespecificeerd als de datum wordt de datum van de huidige boeking
gebruikt.
Het is zinvol om de einddatum alleen te gebruiken als deze eerder is dan de datum van de rij.
Als deze gelijk of later is heeft dit geen effect omdat de waardes na de huidige rij nog niet
beschikbaar zijn omdat deze rijen nog niet verwerkt zijn.
Als de datum van de transactierij 15 april is:

budgetBalance("1000","MP") geeft het saldo van rekening 1000 aan het eind van maart.
budgetBalance("1000","MC") geeft het saldo op het huidige moment, is hetzelfde als
budgetBalance("1000").
budgetTotal("1000","QP") geeft het totaal van de mutaties van het vorige kwartaal.
budgetTotal("1000","QC") geeft het totaal van de mutaties van het vorige kwartaal tot de
huidige datum.

budgetBalance(rekening, startDate, endDate, extraParam)

Het saldo tot aan de huidige rij.

budgetBalance('1000', 'MP'); //geeft het saldo van 1000 aan het eind van de
vorige maand

budgetOpening(rekening, startDate, endDate, extraParam)

Het saldo aan het begin van de periode.
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budgetTotal(rekening, startDate, endDate, extraParam)

Het verschil tussen de debet en credit mutaties van de periode.

budgetTotal('1000', 'MC'); //geeft het totaal van de mutaties van rekening
1000 voor the huidige maand

budgetInterest( rekening, interest, startDate, endDate, extraParam)

Berekent de rente op een rekening voor de aangegeven periode (tot maximaal de huidige datum).
Als u deze functie gebruikt om de rente op een rekening te berekenen aan het einde van de periode
moet de rij waarin de formule staat altijd de laatste van deze datum zijn.

rekening parameter
Dit is het rekeningnummer waarop de rente van de mutaties wordt berekend.
interest parameter,
Geeft de rente aan in procenten.

Positief (2.5, 4, 10) berekent de rente op de debet mutaties van de rekening.
Negatief (-2.5, -4, -10) berekent de rente op de credit mutaties van de rekening.

credit(bedrag)

Als de bedrag parameter negatief is geeft dit het bedrag positief terug.
credit(-100) // geeft 100 terug
Als de bedrag parameter positief is geeft dit 0 (nul) terug.
credit(100) // geeft 0 (nul) terug

Deze functie is nuttig samen met de andere budgetBalance functies om alleen op de saldi te werken
die u nodig heeft.
Als u het percentage op verkopen wilt berekenen is het makkelijker deze functie te gebruiken.
credit(budgetTotal('1000')) // voer de waarde alleen in als deze negatief is.

debit(bedrag)

Als de bedrag parameter positief is geeft deze functie het bedrag terug.
debit(100) // geeft 100 terug
Als de bedrag parameter negatief is geeft deze functie 0 (nul) terug.
debit(-100) // geeft 0 terug

Nuttig als u berekeningen moet maken met alleen het debet bedrag en het gebruik van het credit
bedrag wilt vermijden.

include

Sluit een javascript bestand in en voert dit uit met de mogelijkheid om eigen functies en variabelen te
creëren die gebruikt kunnen worden in het script.

include "file:test.js" 
Voert de inhoud van het aangegeven bestand uit. De naam verwijst naar het bestand waarin
men aan het werk is.
include "documents:test.js" 
Voert de inhoud uit van het tekst document dat in de documententabel staat.
Dit moet een bestand zijn van het type "text/javascript".
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Functies voor vreemde valuta boekhouding
Deze kunnen ook gebruikt worden voor een boekhouding zonder vreemde valuta; in dit geval is de
rekening altijd in basis valuta.

budgetBalanceCurrency(rekening, startDate, endDate, extraParam)

Het saldo in de valuta van de rekening tot aan de huidige regel.

budgetExchangeDifference (rekening, [datum, exchangeRate])

Deze formule roept de Banana.document.budgetExchangeDifference (Engelstalig) functie aan.

budgetOpeningCurrency(rekening, startDate, endDate, extraParam)

Het saldo in de valuta van de rekening aan het begin van de periode.

budgetTotalCurrency(rekening, startDate, endDate, extraParam)

Het verschil tussen de debet en credit mutaties van de periode.

Door de gebruiker gedefinieerde functies

De gebruiker kan eigen functies definiëren met de taal Javascript en deze aanroepen in formules.
Het is mogelijk functies te definiëren:

Direct in een formule
In een bijlage die de Javascript code bevat; deze bijlage moet als rij-id de naam "_budget.js"
hebben.
In een tekst van de tabel Documenten die ingesloten moet worden met het include commando.

Let op:
In gebruikersfuncties is het nu niet mogelijk functies te gebruiken die huidig boekhoudgegevens
ophalen.
(currentBalance, ...).

function Taxcalculation(winst)
{
   var percentage = 10;
   if (winst > 50000)
      percentage = 10;
   else if (winst > 100000)
      percentage =20;
   return winst * percentage / 100;
}
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Voorbeelden van het gebruik van formules in
financiële prognoses

De mogelijkheid om formules te gebruiken is alleen beschikbaar in Banana Boekhouding
Plus met het Advanced plan . Update nu !

We laten u hier enkele voorbeelden zien van het gebruik van formules om financiële prognoses te
automatiseren.
Zie ook de specifieke documentatie:

Javascript formules in de Budgettabel
Modellen met transacties waarin de kolommen Hoeveelheid en Formule gebruikt worden.

Parameters
Bij het budgetteren kan het handig zijn variabelen te definiëren die later gebruikt kunnen worden.
Het is nuttig om een parametersectie aan te maken met een datum van 1 januari, of met een andere
datum die overeenkomt met de eerste dag van het budget. De parameters worden dan gebruikt in de
volgende rijen.

// 30%
costOfGoodsSold = 0.3
// 5%
interestRateDebit = 0.05
// 2%
interestRateCredit = 0.02
// 10 %
latePaymentPercentage = 0.1

Op deze manier worden alle parameters die ingesteld kunnen worden, direct weergegeven. Als een
parameter wordt veranderd wordt de prognose opnieuw berekend.

Herhalingen van bedragen per maand

Door de kolom "Herhaling" te gebruiken kunt u met één boeking voor het hele jaar budgetteren.

Als het bedrijf echter seizoensgebonden activiteiten heeft wordt het aanbevolen een prognose per

https://www.banana.ch/nl/buy
https://www.banana.ch/nl/update
https://www.banana.ch/apps/nl/node/8251
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maand te maken. Voor iedere maand wordt een boeking gedaan met het bedrag voor die maand.
Als u automatisch prognoses wilt maken voor meerdere jaren is het handig om de herhaling "Y" in
deze rij te gebruiken zodat de rij voor het jaar ook voor het volgende jaar wordt gebruikt.

Prijzen en verkoopaantallen

Bij het maken van een verkoopplanning is het makkelijker de bedragen in te voeren in de kolommen
"hoeveelheid" en "prijs". Bijvoorbeeld, een restaurant kan het aantal maaltijden invoeren per dag,
week of maand en het programma berekent automatisch het bedrag. Als het aantal maaltijden of de
prijs wordt veranderd wordt de invloed op de liquiditeit en het jaarresultaat meteen weergegeven.

Gebruik van formules met variabelen voor groei

Als u formules gebruikt moet u eraan denken dat deze worden uitgedrukt in de Javascript
programmeertaal:

De variabele moet gedefinieerd zijn voordat deze gebruikt wordt. Daarom moet de regel waarin
de variabele gedefinieerd wordt een datum hebben voorafgaand aan de datum van de regel
waarin de variabele gebruikt wordt.
In getallen kunnen duizendtallen niet gescheiden worden door een scheidingsteken.
De decimale punt is altijd de "." (Punt).
Namen zijn verschillend voor hoofd- en kleine letters.

U kunt een waarde aan een variabele (waarvan de naam naar eigen inzicht gekozen kan worden)
toekennen. In de volgende regels kan de waarde gebruikt worden door de naam van de variabele in
te voeren.
Door de waarde, toegekend aan de variabele, te veranderen worden alle regels waarin de variabele
wordt gebruikt automatisch aangepast.

Als voorbeeld, u kunt het verwachte bedrag van de verkopen voor de volgende maanden berekenen
door een formule te gebruiken om het bedrag te verhogen.

Maak een "S" (verkopen) variabele aan door de volgende tekst in de kolom Formule te typen.
Sales=1000
De waarde 1000.00 wordt weergegeven in de kolom Bedrag
In de volgende regels gebruikt u de variabele door de naam ervan gewoon in de kolom Formule
in te voeren:
Sales
De waarde 1000.00 wordt weergegeven in de kolom Bedrag
U kunt 10% bij het bedrag optellen (door het te vermenigvuldigen met 1.1)
Sales*1.1
De waarde 1100.00 wordt weergegeven in de kolom Bedrag (De waarde van de variabele Sales
verandert niet)
U kunt de waarde van S verhogen
Sales=Sales+200
De waarde 1200.00 wordt weergegeven in de kolom Bedrag (De waarde van de variabele Sales
verandert nu wel)
Als de variabele wordt gebruikt in de volgende regel wordt er een nieuwe berekening gedaan
Sales
De waarde 1200.00 wordt weergegeven in de kolom Bedrag

U kunt ook een variabele definiëren om het groeipercentage vast te leggen.
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Percentage=1.1
Amount=200
In formules kunt u de naam van de variabele gebruiken in plaats van het getal

Sales*Percentage
Sales=Sales+Amount

Variabelen en herhalingen

Laten we zeggen dat u verwacht dat de omzet elke maand 5% stijgt.

Voer twee regels in waarin u waardes toekent aan variabelen, zonder enige rekening toe te
voegen, maar met de begindatum van het jaar.
Sales=1000
Increment=5
Maak dan een regel aan met de herhaling per maand waarin u de rekeningen toevoegt en de
formule:
Sales=Sales*(1+Increment/100)

Iedere keer als de rij wordt herhaald wordt de waarde van de variabele Sales met 5% verhoogd en als
gevolg daarvan ook het bedrag van de transactie. Door eenvoudigweg het groeipercentage te
veranderen wordt de prognose opnieuw berekend.

In een regel kunt u ook meerder Javascript instructies plaatsen, gescheiden door een puntkomma ";"
Sales=1000; P=5

Gebruik van budget functies

Er zijn functies waarmee u de saldi en mutaties van de rekeningen kunt benaderen voor het
budgetteren tot aan de regel die wordt berekent. U kunt een formule invoeren die met de budgetTotal
functie de waarde van de rekening "SALES" van de vorige maand ophaalt.

credit( budgetTotal("SALES", "MP") )

De functie budgetTotal heeft rekeningnummers en periodes als argumenten. Een afkorting kan
worden gebruikt in plaats van de periode.

MP betekent vorige maand.
QP betekent vorig kwartaal.

Inkomsten worden getoond in credit, daardoor is de waarde teruggegeven door de functie negatief en
wordt niet geaccepteerd als een bedrag in het dubbel boekhouden.
Gebruik daarvoor de functie credit() die de negatieve waarde gebruikt en deze omzet naar een
positief bedrag.

Variabelen voor maandelijkse verkopen
Verkopen kunnen iedere maand variëren. In dat geval is het nuttig aparte boekingen te gebruiken
voor iedere maand met de variabele naam.

sales_01 = 1000
cost_01 = sales_01 * costOfGoodsSold
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sales_01 = 1100

Uitgestelde betalingen
Als u een heel erg nauwkeurig liquiditeitsplan wilt is het handig om de verkopen die direct betaald
worden te scheiden van de verkopen die later betaald worden.
Een benadering kan zijn om alle verkopen te boeken alsof deze contant betaald worden door de
waarde van de maandvariabele toe te kennen aan het bedrag.

sales_01 = 1000

Voer dan een boeking in die de verkopen omkeert die uitgesteld zijn door het bedrag te berekenen
met de formule.

sales_01 * latePaymentPercentage

Voor de volgende maand wordt dan een betalingsboeking met dezelfde formule ingevoerd.

Verkoopkosten
Er zijn kosten die betrekking hebben op verkopen (kosten van goederen) of andere kosten (sociale
premies met betrekking tot lonen).

Kosten berekening met variabelen

Als de verkopen worden gedefinieerd met variabelen kunnen de verkoopkosten ook aangegeven
worden als een percentage van de verkopen.

U kunt variabele S definiëren voor de verkopen en variabele C voor het percentage van de
kosten.
Sales=1000
Cost=60
De formule voor de berekening is:
Sales*Cost/100

U kunt deze benadering ook gebruiken om sociale lasten te berekenen.
Deze formule kan eventueel in een herhalingsregel worden ingevoerd.

Verkoopkosten berekening met budgetfuncties

Als de kosten betrekking hebben op verkopen kunnen de budgetformules ook worden gebruikt.

credit( budgetTotal("SALES", "MC") )*60/100

De afkorting "MC" staat voor de huidige maand.
Deze formule geeft de waarde van de verkopen van de huidige maand terug, maakt er een positief
bedrag van en vermenigvuldigd dit met 60 gedeeld door 100.

De datum van de regel met de formule moet natuurlijk wel later zijn dan de data van de
verkoopboekingen.
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De formule kan worden gebruikt in een herhalingsrij waarbij de laatste datum van de maand
ingevoerd wordt. Daardoor worden de verkoopkosten automatisch berekend gebaseerd op de
verkopen die bij de transacties zijn ingevoerd.

De formule kan met variabelen worden gecombineerd.

Definieer aan het begin van het jaar het percentage van de kosten.
Cost=60
Daarvoor wordt de variabele Costs gebruikt.
credit( budgetTotal("SALES", "MC") )*Cost/100

Wanneer u het bijdragepercentage of een eventuele verkoop wijzigt, wordt het budget automatisch
bijgewerkt.

Berekening van de verkoopcommissies aan het einde van het jaar

Aan het einde van het jaar berekent u de commissies van 5% op de totale netto verkopen met deze
formule:

credit( budgetTotal("SALES", "YC") )*5/100

De functie bugetTotal() geeft de verandering van de verkopenrekening voor de periode van het
huidige jaar, "YC". Met de functie credit() wordt het bedrag positief gemaakt. Daarna wordt het
vermenigvuldigd met 5 en gedeeld door 100.

Wanneer u prognoses maakt voor meerdere jaren, denk er dan aan de herhalingsopdracht "Y" in de
regel te zetten, zodat de formule ook wordt berekend voor het vorige jaar. Zoals eerder aangegeven
kunt u in plaats van de 5 direct in de formule te gebruiken daar ook een variabele invoeren.

Commission=5
credit( budgetTotal("SALES", "YC") )*Commission/100

Als het percentage van het ene op het andere jaar verandert is het voldoende een transactie in te
voeren met de datum van volgend jaar die de variabele voor de commissies aanpast.

Inflatie met variabelen
Als u voor meerdere jaren wilt budgetteren kunt u ook de inflatie meerekenen.

Ken aan het begin van de budgettering basisvariabelen toe voor prijzen en inflatie (2%).
Base=1;Inflation=2
Als u de Sales variabele gebruikt vermenigvuldigt u deze met het inflatiepercentage
Sales=Sales*Base
Aan het begin van het volgende jaar, met de jaarlijkse herhaling, verhoogt u de basisprijs
Base=Base+Base*Inflation/100

Berekening afschrijvingen
Dankzij formules kan de berekening van afschrijvingen worden geautomatiseerd.
Als u de bedragen van de geplande investeringen veranderd wordt de afschrijving automatisch
opnieuw berekend. Zorg ervoor dat de datum van de regel met de afschrijvingsberekening een datum
heeft die later is dan de datum van de investeringen. De datum is over het algemeen 31 december.
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Afschrijvingsberekening op boekwaarde

Om de afschrijving op de rekening "EQUIPMENT" te berekenen voegt u een regel aan het eind van het
jaar toe met de volgende formule en de debet en credit rekening de juiste manier opgezet om de
afschrijving te boeken.

budgetBalance("EQUIPMENT")*20/100

De functie budgetBalance() geeft het saldo tot op de datum. De afschrijving van 20% wordt dan
hierop berekend.

Gebruik de debit() functie als u denkt dat de activa rekening naar credit kan gaan.

debit(budgetBalance("EQUIPMENT"))*20/100

Berekening van de afschrijving op de beginwaarde

Om de beginwaarde van de investeringen te berekenen is het nodig variabelen te gebruiken om de
waarde ervan vast te leggen.

Equipment=10000

Als de afschrijving wordt gespreid over 5 jaar wordt de formule ingevoerd in de einde-jaar
afschrijvingsregel.

Equipment=10000/5

De jaarlijkse herhaling "Y" en de einddatum, die overeenkomt met de datum van de laatste termijn
van de afschrijving, worden ingevoerd in de rij van deze formule om te voorkomen dat de afschrijving
oneindig lang doorgaat.

Voor iedere investering moet u een variabele aanmaken en een specifieke rij voor de afschrijving. In
namen van variabelen kunnen getallen gebruikt worden.

Equipment1=10000
Equipment2=5000

Renteberekening
Met de functie budgetInterest( account, interest, startDate, endDate) kunt u automatisch
rente berekenen gebaseerd op het werkelijk gebruik van een rekening.
De parameters zijn:

Account
Waarvan de mutaties worden gebruikt om de rente te berekenen, in het geval van de
bankrekening of de lening.
Interest
Het rentepercentage in procenten.
Als de waarde positief is wordt de rente op de debetsaldi berekend.
Als de waarde negatief is wordt de rente op de creditsaldi berekend.
Begin datum, mag ook een afkorting zijn.
Eind datum, mag ook een afkorting zijn.
De teruggegeven waarde is de rente berekend voor 365/365 dagen.
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Rentekosten op de bankrekening

Om de rentekosten voor 5% te berekenen voert u een regel in met de einddatum van het kwartaal en
de herhaling "3ME" die de formule bevat:

budgetInterest( "Bank", -5, "QC")

Het rentepercentage is negatief omdat "QC" het huidige kwartaal betekent. De debet en credit
rekeningen moeten de gebruikelijke zijn voor het boeken van rentekosten. Als de rente daalt wordt
het bankrekeningsaldo ook gebruikt bij de boeking. Echter een andere rekening kan worden gebruikt
als dit met een andere rekening betaald wordt.

Het is belangrijk dat de "3ME" herhaling wordt gebruikt zodat de gebruikte datum altijd de laatste van
het kwartaal is.

Om de rente per maand te berekenen gebruikt u de afkorting "MC".

budgetInterest( "Bank", -5, "MC")

Rente op de bankrekening

Gebruik een positieve rente voor rente inkomsten van 2%.

budgetInterest( "Bank", 2, "QC")

Rente op leningen met een vaste looptijd

Voor leningen met een vaste looptijd wordt de rente berekend en geboekt op een specifieke datum.

Maak een aparte rekening aan voor iedere lening.
Gebruik de budgetInterest functie en geef precies de begin- en einddata aan. Als de datum
wordt aangegeven als tekst moet de notatie "jjjj-mm-dd" worden gebruikt, bijvoorbeeld
"2022-12-31".
Gebruik variabelen.
Zoals uitgelegd voor afschrijvingen kan het leenbedrag worden toegekend aan een variabele.
De renteberekening wordt gedaan met een Javascript berekeningsformule,

Definieer de lening variabele
Loan=1000
5% interest berekening, voor 120 dagen.
Loan*5/100*120/365

Winstbelasting berekening
Winst is de totale ontwikkeling van de groepswinst over de periode.
Om een winstbelasting van 10% te berekenen gebruikt u de volgende formule.

credit(budgetTotal("Gr=Result","MC"))*10/100

Gebruik als budgetTotal functie account parameter "Gr = Result" wat aangeeft dat alle mutaties
van een groep in plaats van een rekening worden berekend.
MC, huidige maand wordt aangegeven als periode.
De budgetTotal functie geeft een positieve waarde terug als er een verlies is en een negatieve
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(credit) als er winst is.
De credit functie accepteert alleen negatieve waarden daardoor is de belasting nul als er een
verlies is.

Betalingen met uitgestelde of andere termijnen
Voor uitgestelde betalingen of betalingen met verschillende termijnen kunt u op twee manieren te
werk gaan:

Gebruik variabelen waaraan te betalen bedragen moeten worden toegekend.
Gebruik de betreffende variabele bij het boeken van de betaling.
Maak klant- of leveranciersrekeningen aan voor verschillende betalingstermijnen.

Andere gevallen
Vertel ons alstublieft over uw andere wensen zodat we meer voorbeelden kunnen toevoegen.
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Rekeningschema voor het Budget

Kolom Opening
Voer het beginsaldo van uw boekhoudperiode in de kolom Opening van de Rekeningentabel in. Dit
dient als:

Beginsaldo voor de boekhouding (Transactiestabel)
Beginsaldo voor de budgetgegevens (Budgettabel).

Kolom Budget
Als er geen Budgettabel is kan de kolom Budget van het Rekeningschema aangepast en gebruikt
worden om de verwachtingen van het huidige jaar in tabelvorm in te voeren.

Als de Budgettabel is ingesteld is de kolom Budget van het Rekeningschema beveiligd en worden
de waarden automatisch berekend op basis van de gebudgetteerde veranderingen zoals vastgelegd
in de Budgettabel voor de boekhoudperiode. De waarde die weergegeven wordt in de kolom Budget is
het saldo aan het einde van de periode en is daardoor inclusief het beginsaldo en de boekingen voor
de periode.

Het Rekeningschema aanpassen
De balans en de winst en verliesrekening worden ingesteld in de Rekeningen- of Categorieëntabel
met het totaal voor de rekeningen en groepen.
De kolommen van de bedragen worden bijgewerkt door het programma zodat de betreffende tabel
een direct beeld geeft van de huidige en de verwachte financiële situatie waarbij het rekeningsaldo,
de verandering, budget en andere belangrijke informatie worden getoond naast iedere rekening en
groep. Met één klik wordt de rekeningkaart weergegeven.

Het rekeningschema wordt opgezet volgens de wensen van de gebruiker. Nieuwe rekeningen en
groepen kunnen worden toegevoegd, hun nummer of beschrijving kan worden veranderd of
verwijderd op elk moment dat u uitkomt.

Doorgaans start u voor uw planning met een paar rekeningen en voegt u nieuwe toe wanneer meer
details beschikbaar zijn en deze nuttig geacht worden.
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Planning met meer detail

Verschillende rekeningtypes kunnen worden ingesteld in het rekeningschema. Bij het boeken kunt u
gedetailleerde bedragen aangeven voor:

Klanten- en leveranciersrekeningen
Maakt het mogelijk een planning voor iedere klant te maken met de bijbehorende omzet en
kosten.
Kostenplaatsen en winstcentra
Maakt gedetailleerde planning voor een specifiek project of de verkopen door individuele
vertegenwoordigers mogelijk.
Segmenten
Beheer winst- en verliesrekeningen per afdeling, vestiging, etc.
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Budget gescheiden van de boekhouding

Het bestand voorbereiden

Als de budgettabel niet zichtbaar is in het boekhoudbestand, geef deze tabel dan weer via het menu
Extra → Functies toevoegen/verwijderen → Budget tabel toevoegen .

De transactietabel blijft bestaan zoals deze is ingesteld. Als u deze niet nodig heeft gebruik dan menu
Gegevens → Tabellen instellen en schakel de transactietabel uit zodat deze tabel niet
weergegeven wordt.

Het proces is hetzelfde of u nu alleen een boekhouding gaat doen, een budget gaat maken of beide:

Maak een boekhoudbestand aan.1.
Stel de bestandseigenschappen in.2.
Zet het rekeningschema op.3.
Voer beginsaldi in (als die er zijn).4.
Voer de budgetbedragen in de budgettabel in.5.

De boekhouding en het budget worden meestal gedaan in hetzelfde Banana Boekhouding bestand.
Als u het budget los van de boekhouding wilt beheren voer dan alleen transacties in de budgettabel
in. In dit geval wordt de transactietabel leeg gelaten.

U gebruikt een bestand met alleen een budget om:

Het budget van een Startup in te stellen:
Bereid de financiële plannen voor van een nieuw bedrijf dat nog niet gestart is.
Als u nog niet direct gedetailleerde plannen heeft kan het nuttig zijn om een model te
kiezen met weinig rekeningen, zonder BTW.
Als u van plan bent ook de boekhouding te gaan doen is het handig om te beginnen met
een van de door ons voorbereide rekeningschema's.

Het budget in te stellen voor een bestaand bedrijf dat de boekhouding met een
ander programma doet:

Het rekeningschema wordt opgezet op basis van de bestaande boekhouding.
Er zijn drie mogelijkheden om een overeenkomst met de bestaande balans te bereiken:

U kunt de budgetgegevens van Banana Boekhouding exporteren naar het andere
boekhoudprogramma.
Als u een vergelijking wilt maken tussen het budget dat gemaakt is met Banana
Boekhouding en de gegevens van uw andere programma moet u de gegevens van
het andere programma exporteren en importeren in de budgettabel van het Banana
Boekhoudbestand.
Gebruik Excel spreadsheets om de gegevens van het Banana Boekhouding budget
en de boekhoudgegevens van uw eigen programma te presenteren.

Meer informatie over budgettransacties kunt u via de volgende links vinden:

Budget toevoegen
Budgettabel
Planning gebaseerd op de Dubbel boekhouden methode
Budget periode.

http://www.banana.ch/doc/nl/node/9356
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Budget periode
Het is niet nodig de budget periode te definiëren. U kunt het budget opzetten voor een jaar en toch
prognoses maken voor de volgende jaren .

Budget voor een jaar

In de regel wordt het budget opgezet voor de boekhoudperiode gedefinieerd in
bestandseigenschappen die in het algemeen gelijk is aan het kalenderjaar.

Voer het beginsaldo aan het begin van de periode in de kolom Opening van de rekeningtabel in.
Voer de verwachte gegevens voor het huidige jaar in de budgettabel in.

Bij het maken van overzichten gebruikt het programma de boekhoudperiode als u geen andere
periode specificeert dan die in de bestandseigenschappen.

Wanneer u een budget wilt maken voor het volgende jaar kunt u een bestand aanmaken voor het
nieuwe jaar. Het programma neemt de budgettransacties over die dan weer aangepast kunnen
worden (zie Een nieuw jaar aanmaken... in menu Acties).

Meerjaren budgettering

Met Banana Boekhouding beschikt u over een planning voor meerdere jaren. De planningsperiode is
zelf in te stellen op het moment dat het overzicht wordt opgevraagd.

Om een budget voor meerdere jaren te maken begint u met het opzetten van het budget voor het
eerste jaar en daarna breidt u het uit voor de volgende jaren.

Technisch gezien gaat u daarvoor te werk alsof u een jaarbudget maakt met een uitbreiding voor de
volgende jaren:

In de bestandseigenschappen worden de begin- en einddatum van het eerste jaar (dat in het
algemeen een kalenderjaar is) aangegeven.
De beginsaldi worden ingevoerd in het rekeningschema.
De budgettransacties worden ingevoerd in de budgettabel

Activiteiten die alleen specifiek zijn voor het eerste jaar worden aangegeven zonder
herhaling.
Geef de herhalingscode voor alle andere activiteiten waarvan u denkt dat ze herhaald
worden in de volgende jaren.
Activiteiten die maar een keer per jaar plaatsvinden worden aangegeven door de jaar
herhaling "Y". Bijvoorbeeld de berekening van de afschrijving die aan het eind van het
jaar gedaan wordt.
Specifieke activiteiten voor volgende jaren worden aangegeven met de bijbehorende
datum waarop ze plaatsvinden.
Voor herhalende activiteiten die beperkt zijn tot een enkel jaar of tot een specifieke
periode (bijvoorbeeld transacties voor vaste termijn huur) wordt de einddatum
aangegeven. Na die datum worden geen herhalingen meer gedaan.
U kunt formules gebruiken om het bedrag van de rij automatisch te laten herhalen.

De berekening van de afschrijving kan worden gebaseerd op het saldo van de
activa rekening.
Over de mutatie op de bankrekening kan direct rente berekend worden.
De vooruitgang van verkopen kan worden gespecificeerd.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 712

Inkopen kunnen worden gedefinieerd als een percentage van de kosten.
Geef de begin- en einddatum van het vereiste budget aan om het budgetoverzicht te zien
(Uitgebreide balans of uitgebreide balans op groepen, rekeningkaarten).

Overgang naar het nieuwe jaar

De Banana Boekhouding functie om een nieuw jaar aan te maken... brengt ook de budgettransacties
over.

Voor elke rij kunt u aangeven of de bewerking overgedragen moet worden of niet an of de
originele gegevens behouden moeten blijven of vervangen moeten worden door die van het
nieuwe jaar.
Het budget voor het nieuwe jaar aanmaken is daardoor heel eenvoudig omdat het alleen maar
een kwestie is van uitgaven en inkomsten te aan te passen waarvan verwacht wordt dat deze
veranderen.
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Rapporten financiële prognoses

Voorlopige balans
Voorlopige winst- en verlies rekening
Liquiditeitsplanning
Verkoopprognose
Prognoses Klanten
Prognose leveranciers
Investeringsplanning
Bedrijfsfinanciering
Projectplanning
Planning met segmenten

Budgettabel: kolom Totaal
De kolom Totaal bevat het totale bedrag van het budget voor de boekhoudperiode aangegeven in de
bestands- en boekhoudeigenschappen (begin- en einddatum van de boekhouding). Dit levert een
direct inzicht in hoeveel een bepaalde uitgave zal zijn voor het lopende jaar.

Zie voor meer informatie Kolommen in de Budgettabel en Data en herhalingen in financiële budget
transacties.

Ontwikkeling in grafieken - Grafieken venster
In elke tabel waar u zich in bevindt ziet u de ontwikkeling van de rekening of groep waar de cursor op
staat in het grafiekenvenster.
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Kolom Budget in de Rekeningen en Categorieën tabel
De rekeningen en categorieën tabel geven de bijgewerkte budgetbedragen voor de
boekhoudperiode aangegeven in de bestands- en boekhoudeigenschappen (begin- en einddatum van
de boekhouding).

Budget kolom
Geeft het totale budget voor de rekening voor de boekhoudperiode.
De aangegeven waarde is inclusief het beginsaldo en de budgetmutaties voor de periode.
Budget verschil kolom
Geeft het verschil tussen de kolommen Budget en Saldo.

Rekeningkaart met budgetgegevens
Met het commando Rekening kaart , of door in de budgettabel op het knopje in het
rekeningnummerveld te klikken, kunt u details krijgen van alle budgetmutaties.

In het Rekening kaart  dialoogvenster
U kunt kiezen voor rekening, kostenplaats, groep of segment waarvan u de mutaties wilt
zien.
U kunt kiezen voor huidige boekhoudgegevens of budgetgegevens.
In de
In the Rekeningkaart per periode kunt u berekeningsperiode aangeven. Als u een

http://www.banana.ch/doc/nl/node/2726
http://www.banana.ch/doc/nl/node/2726
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einddatum voorbij de einddatum van de boekhouding kiest maakt het programma
automatisch een vooruitblik van de aangegeven data.

Door de rekeningkaart te openen vanuit de budgettabel wordt de kaart voor de
budgettransacties getoond.

Uitgebreide balans op groepen
Alle afdrukken die beschikbaar zijn voor de boekhouding kunnen financiële prognoses bevatten.

Het is voldoende om de Budget en Budget verschil kolommen in te stellen.
Geef en de Sectie Periode de gewenste periode aan. U kunt ook een periode van meerdere
jaren aangeven. Het programma berekent dan meteen de prognose en geeft deze weer.
In de Sectie Onderverdeling kunt u kiezen voor een weergave per maand, kwartaal, jaar of per
segment.

Bekijk de video  (Engelstalig) waarin uitgelegd wordt hoe een uitgebreide balans op groepen te
maken en af te drukken.

Alle aanpassingen beschikbaar in de boekhouding zijn ook te gebruiken voor planning:

Keuze van het gewenste groeperingsniveau

https://www.banana.ch/en/node/11490
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Presentatie met boekhouddetails of alleen met groepen.
Keuze van de secties die meegenomen moeten worden.
Alleen balans, resultatenrekening, of kostenplaatsen afdrukken.
Keuze van de boekhoudperiode.
Wanneer u een boekhoudperiode kiest voorbij de data van de boekhouding maakt het
programma automatisch de prognoses aan tot de aangegeven datum.
Onderverdeling per periode (per maand, kwartaal, half jaar, of jaar).
Door de periode van de berekening en de frequentie te combineren kunnen ad hoc overzichten
worden gemaakt.

Door een periode van 1 jaar aan te geven, zonder onderverdeling, wordt de prognose
voor het jaar verkregen.
Door een periode van 1 jaar aan te geven, met een onderverdeling per kwartaal, krijgt u
een afdruk met kolommen voor de kwartalen.
Door een periode van 6 maanden aan te geven, met een onderverdeling per maand, kan
de ontwikkeling per maand in detail worden bekeken.
Door een periode van 5 jaar aan te geven, met een onderverdeling per jaar, zijn de
kolommen met de ontwikkeling in de 5 jaren beschikbaar,

Vergelijking tussen de huidige en budgetbedragen.
Toevoegen van andere kolommen.
Veranderen van afdrukstijl.
Opslaan van afdrukinstellingen.
Afdrukinstellingen kunnen worden opgeslagen als aanpassingen en kunnen later weer worden
gebruikt.
U kunt zoveel aanpassingen maken als u nodig heeft.
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Voorlopige winst- en verliesrekening

In de resultatenrekeningprognose worden de winst, de kosten en het resultaat voor een toekomstige
periode gepresenteerd. Het is een belangrijk instrument om de toestand van het bedrijf te volgen,
waardoor u begrijpt hoe de financiële situatie zich zal ontwikkelen.

Met Banana Boekhouding heeft u dankzij de budgettering met de methode van dubbel boekhouden
volledige prognoses en dat kunt u op verschillende manieren regelen. Het programma kan ook
prognoses over meerdere jaren berekenen.
U krijgt een zeer nauwkeurige visie op de ontwikkeling van de economische situatie.

De structuur van de resultatenrekening is dezelfde als die van het boekhoudbestand. Bij het
afdrukken kunt u aangeven welke bedragen moeten worden weergegeven, die van het eindsaldo, de
raming of beide.

Bij de berekening van de verwachte cijfers wordt rekening gehouden met de in de budgettabel
vermelde openingssaldi en de verwachte ontwikkelingen. Wanneer u een begrotingspost wijzigt,
worden de prognoses onmiddellijk bijgewerkt. U kunt een betaling simuleren en testen, verplaatsen,
een investering toevoegen, verkopen aanpassen en zien hoe het budget in de loop van de tijd
verandert.

De verwachte cijfers in de winst- en verliesrekening kunnen op verschillende manieren worden
weergegeven.

Gebruik van hoeveelheden en formules
Met de hoeveelheid en prijs kolom van de budgettabel kunt u realistischer verwachtingen
voorbereiden, op dezelfde manier als met spreadsheets. Hiermee zijn snellere simulaties mogelijk. U
hoeft alleen de prijs te wijzigen en u krijgt automatisch toegang tot de nieuwe prognoses van de
resultatenrekening en ook die van de balans en de liquiditeitsrekening.

Met de formules kunt u de kostprijsberekening automatiseren zodat u, bijvoorbeeld wanneer u de
verkoop verandert, de aankoopkosten veranderen in procenten. Op deze manier kunt u gebruik
maken van nauwkeurige winst- en verliesrekeningprognoses die automatisch worden bijgewerkt.
Formules zijn vooral nuttig bij het maken van prognoses over meerdere jaren.

Gedetailleerde prognoses
Met de financiële prognose, gebaseerd op de methode van het dubbel boekhouden, kunt u ramingen
krijgen van de lasten en de baten gebruikmakend van dezelfde rekeningen en groepen als die van het
boekhoudbestand. Voor het maken van prognoses worden dezelfde onderdelen gebruikt als in de
boekingen. Cijfers en overzichten kunnen automatisch dagelijks weergeven hoe de liquiditeit zich
ontwikkelt evenals de situatie van de klanten.

De structuur van het Rekeningschema, waarop ook de prognose is gebaseerd, is aanpasbaar. Dit kan
worden gedaan door eenvoudigweg de hoofdgroepen en de rekeningen die er deel van uitmaken te
gebruiken, of op een complexere manier, door ook subgroepen in te voegen, voor een gedetailleerder
beeld.

De structuur van de Winst- en Verliesrekening is stapsgewijs opgebouwd en geeft u de mogelijkheid
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om de tussentijdse en eindresultaten van het jaar na betaling van de belastingen te bekijken.

Resultatenrekening

Inkomsten.
Kosten van goederen.

Bruto bedrijfsresultaat (totaal van opbrengsten en kosten).

Personeelskosten.
Algemene kosten.

Bedrijfsresultaat (totaal van het bruto bedrijfsresultaat, personeelskosten en algemene
kosten).

Financiële kosten.

Gewone operationele bedrijfsresultaten (totaal bedrijfsresultaat en financiële kosten).

Afschrijvingen.

Winst voor belastingen (Totale gewone operationele bedrijfsresultaten en Afschrijvingen).

Belastingen en heffingen

Nettoresultaat over het boekjaar (totaal van het resultaat vóór belastingen en heffingen).

Rekeningen / Categorieëntabel
In de Rekeningentabel , voor dubbel boekhouden, en de Categorieëntabel, voor inkomsten en
uitgaven boekhouding, worden de prognosecijfers voor alle rekeningen en groepen van de
resultatenrekening weergegeven. In een oogopslag heeft u een overzicht van de prognose van de
resultatenrekening. De bedragen hebben betrekking op de boekhoudperiode en de afwijkingen
worden automatisch berekent ten opzichte van het huidige saldo.

Als u meer details nodig heeft kunt u rekeningen of groepen toevoegen.

http://www.banana.ch/doc/nl/node/3826
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Winst en verlies met groepen
Met Uitgebreide balans op groepen kunt u de Prognosebalans bekijken met de weergave die u nodig
heeft.

Geef in de sectie kolommen van het commando Uitgebreide balans op groepen de waarden van
Budget aan.
U kunt de huidige (boekhoud) bedragen aangeven, de verwachte bedragen of beide.
Stel de periode in.
Als een periode wordt aangegeven die buiten de boekhoudperiode valt schakelt het programma
automatisch over naar budgettering voor meerdere jaren.
Geef de gewenste onderverdeling per periode  aan.
In de Rijen sectie kunt u rekeningen uitsluiten en daardoor een weergave van alleen groepen
hebben.
Als u denkt dat u deze afdrukinstelling nogmaals gaat gebruiken maak dan een Aanpassing aan.

Met de verschillende opties kunt u uw afdrukken op maat maken. Hierna volgen enkele voorbeelden.

Jaarprognose voor winst en verlies

Deze afdruk wordt opgezet met de budgetcijfers van alleen dit jaar.
U kunt veranderingen als bedrag of als percentage weergeven.

Prognoseresultatenrekening en vergelijking huidige jaar

De eindcijfers (huidig) worden vergeleken met die van het budget.

http://www.banana.ch/doc/nl/node/3265
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Kwartaalbudget resultatenrekening

Zet in de sectie Onderverdeling de periode op kwartaal en het programma toont de verwachte
resultatenrekening voor de verschillende kwartalen.
De ontwikkeling van het budget in de loop van het jaar wordt nu weergegeven.

Kwartaalbudget met vergelijking

Deze afdruk wordt opgezet om zowel het geschatte als het eindsaldo af te drukken. We hebben
daardoor de verwachte en de huidige toestand aan het eind van ieder kwartaal.
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Driejaarlijks budget winst- en verliesrekening
Wanneer u de budgetboekingen invoert met de herhalingscode kan het programma schattingen
maken voorbij de gedefinieerde periode.

Om prognose over meerdere jaren te krijgen worden de transacties ingevoerd in de budgettabel met
herhalingscode "Y".

Deze afdruk is bedoeld om het driejarige budget af te drukken.

Boekhoudoverzicht
Vanuit het menu Rapporten → Boekhoudoverzicht kunt u overzichten maken van winst en verlies
zoals in de rekeningentabel maar dan met de gewenste kolommen.

De opties zijn hetzelfde als die uitgelegd voor de Uitgebreide Balans op groepen.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 722



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 723

Liquiditeitsplanning

"Cash is King" is het motto dat aangeeft hoe belangrijk liquiditeit is. Het is de belangrijkste motor
voor het uitvoeren van zakelijke activiteiten, het nakomen van verplichtingen en het maken van
winst. Om veilig te investeren is het essentieel om het vermogen om liquiditeit te produceren en de
ontwikkeling ervan in de tijd op een rationele manier te evalueren.

De financiële prognose van Banana Boekhouding is een belangrijk bedrijfsmanagementinstrument,
waarmee u kunt begrijpen of er voldoende financiële middelen zijn om aan de verplichtingen te
voldoen en uw schuldrisico's tot het minimum te beperken.
Liquiditeitsverwachtingen worden berekend op basis van het beginsaldo en de prognoses in de
Budgettabel. Wanneer een budgettransactie wordt veranderd worden de verwachtingen meteen
bijgewerkt. U doet een simulatie, kent een betaling toe, voegt een investering toe, verandert
verkopen en u ziet hoe de liquiditeit zich ontwikkelt.

Liquiditeitscijfers kunnen op diverse manieren worden weergegeven.

Rekeningentabel
Stel rekeningen en liquiditeitsgroepen in de Rekeningentabel in. In de kolom budget ziet u de
bijgewerkte prognosesaldi voor de boekhoudperiode. Aan het einde van het jaar ziet u in een
oogopslag wat de liquiditeit is.

Overzicht in grafieken

Als u het Grafieken venster opent en de cursor op een rekening of een groep zet ziet u de grafiek van
het verloop van de liquiditeit.
In de legenda zijn de teksten Huidig, Vorige of Budget zichtbaar. Door op de teksten te klikken kunt
u de bijbehorende grafiek verbergen of zichtbaar maken.

Rekeningkaart met budget groep gegevens
Met het Rekeningkaart commando van het menu Rapporten kunt u in detail, elke dag, zien hoe de
liquiditeit zich ontwikkelt. U kunt alle mutaties zien die invloed hebben op de liquiditeit.
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Met het Rekeningkaart commando van het menu Rapporten kunt u aangeven of u de huidige of de
budget mutaties wilt zien.

Selecteer budget transacties.
Stel de periode in.
Als u een periode aangeeft die langer is dan de boekhoudperiode genereert het programma
automatisch Prognoses voor meerdere jaren.
Als u een groep aangeeft ziet u de mutaties van alle rekeningen die bij die groep horen.
Als u in de budgettabel staat kunt u de rekeningkaart oproepen met een klik op het icoontje in
de rechterbovenhoek van de cel met de rekeningnaam.

Liquiditeit in Uitgebreide balans op groepen
Met Uitgebreide balans op groepen kunt u werken met cijfers onderverdeeld naar kolom per periode.
Op deze manier kunt de ontwikkeling van de liquiditeit zien per dag, week, maand, kwartaal, halfjaar,
jaar, etc.

Geef in de sectie kolommen van het commando Uitgebreide balans op groepen de aan dat u de
cijfers van Budget wilt zien.
Selecteer de Liquiditeit groep.
U kunt ervoor kiezen ook de liquiditeit rekeningen weer te geven.
Stel de periode in.
Als een periode wordt aangegeven die buiten de boekhoudperiode valt schakelt het programma
automatisch over naar budgettering voor meerdere jaren.
Geef de gewenste onderverdeling per periode  aan.
Als u denkt dat u deze afdrukinstelling nogmaals gaat gebruiken maak dan een Aanpassing aan.

http://www.banana.ch/doc/nl/node/3265
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Boekhoudoverzicht met liquiditeit budget
Het Boekhoudoverzicht is gelijksoortig aan dat voor de Uitgebreide balans op groepen met het
verschil dat de weergave plaatsvindt in de rekeningentabel in kolommen.

U kunt het daardoor gebruiken om direct zicht te krijgen op de ontwikkeling van de
liquiditeitsrekeningen.
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Prognose van de verkoop

Voor een bedrijf is de verkoop de belangrijkste bron van inkomsten en liquiditeit. In tegenstelling tot
kosten die gemakkelijker te plannen zijn, zijn verkopen moeilijker te budgetteren. Als vuistregel geldt
dat u zich kunt baseren op het verkoopcijfer van het voorgaande jaar voor dezelfde periode of op de
mogelijkheid dat er belangrijke gebeurtenissen in de pijplijn zitten die kunnen leiden tot een stijging
van de verkoop of zelfs tot het werven van nieuwe klanten.

Op deze basis kunt u met Banana Boekhouding, dankzij de budgettering met de methode van dubbel
boekhouden, verschillende scenario's simuleren en projecteren in de loop van de tijd. Verander
eenvoudig de gebudgetteerde bedragen voor de verkopen en het programma werkt automatisch de
prognoses bij en geeft gedetailleerde overzichten voor het lopende jaar of toekomstige jaren.

De verkoopverwachtingen worden berekend op basis van de prognoses in de Budgettabel en kunnen
op verschillende manieren worden weergegeven.

Rekeningentabel
Stel de rekeningen en verkoopgroepen in de Rekeningentabel in. In de kolom Budget vindt u de
bijgewerkte prognosesaldi voor de boekhoudperiode. U kunt in een oogwenk controleren wat de
ontwikkeling van de verkopen zal zijn gedurende het jaar.

Grafiek van de verkoopontwikkeling

Als u het Grafieken venster opent en de cursor op een rekening of een groep zet ziet u de grafiek van
het verloop van de liquiditeit.
In de legenda zijn de teksten Huidig, Vorige of Budget zichtbaar. Door op de teksten te klikken kunt
u de bijbehorende grafiek verbergen of zichtbaar maken.

Rekeningkaart met budgetgegevens van de verkopen
Met het Rekeningkaart commando van het menu Rapporten kunt u in detail, elke dag, zien hoe de
verkopen zich ontwikkelen. U kunt alle mutaties zien die invloed hebben op de liquiditeit.
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Met het Rekeningkaart commando van het menu Rapporten kunt u aangeven of u de huidige of de
budget mutaties wilt zien.

Selecteer budget transacties.
Activeer de rekening of de groep van de verkopen.
U kunt ook alle verkopen rekening selecteren.
Stel de periode in.
Als u een periode aangeeft die langer is dan de boekhoudperiode genereert het programma
automatisch Prognoses voor meerdere jaren.
Als u een groep aangeeft ziet u de mutaties van alle rekeningen die bij die groep horen.
Als u in de budgettabel staat kunt u de rekeningkaart oproepen met een klik op het icoontje in
de rechterbovenhoek van de cel met de rekeningnaam.

Resultatenrekening met kwartaalverkoop Budget
Met Uitgebreide balans op groepen kunt u werken met cijfers onderverdeeld naar kolom per periode.
Op deze manier kunt de ontwikkeling van de liquiditeit zien per dag, week, maand, kwartaal, halfjaar,
jaar, etc.

Geef in de sectie kolommen van het commando Uitgebreide balans op groepen de aan dat u de
cijfers van Budget wilt zien.
Kies de groep verkopen. U kunt ervoor kiezen rekeningen ook weer te geven.
Stel de periode in.
Als een periode wordt aangegeven die buiten de boekhoudperiode valt schakelt het programma
automatisch over naar budgettering voor meerdere jaren.
Geef de gewenste onderverdeling per periode  aan.
Als u denkt dat u deze afdrukinstelling nogmaals gaat gebruiken maak dan een Aanpassing aan.

http://www.banana.ch/doc/nl/node/3265


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 728

Boekhoudoverzicht met verkopen prognose
Het Boekhoudoverzicht is hetzelfde als de Uitgebreide balans op groepen met het verschil dat de
gegevens worden weergegeven in kolommen zoals in de rekeningentabel.

U kunt het boekhoudoverzicht gebruiken om een direct inzicht te krijgen in de ontwikkeling van de
verkopen rekeningen.
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Financiële prognose voor klanten

Klantenprognoses vullen de financiële planning aan met klantgegevens. Zo kan een bedrijf
bijvoorbeeld een omzetprognose maken door de rekeningen aan te geven voor de belangrijkste
klanten.

Met budgettering met de methode van dubbel boekhouden kunt u rekeningen aanwijzen voor de
individuele klanten. Afhankelijk van de wensen kan klantenbeheer gedaan worden met de
balansrekeningen, winst- en verliesrekeningen of met kostenplaatsen en winstcentra.

Bij het veranderen van een budgetpost worden de prognoses voor iedere individuele klant ook
bijgewerkt.

Rekeningentabel
Stel de rekeningen voor klanten in de Rekeningentabel in. In de kolom Budget vindt u de bijgewerkte
prognosesaldi voor de boekhoudperiode. U kunt in een oogwenk zien wat de prognose voor de
individuele klant is.

Voortgangsgrafiek

Als u het Grafieken venster opent en de cursor op een rekening of een groep zet ziet u de grafiek van
het verloop van de liquiditeit.
In de legenda zijn de teksten Huidig, Vorige of Budget zichtbaar. Door op de teksten te klikken kunt
u de bijbehorende grafiek verbergen of zichtbaar maken.

Klantrekeningkaart met budgetgegevens
Met het Rekeningkaart commando kunt u in detail alle mutaties voor iedere klant zien.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 730

Selecteer budget transacties.
Geef de klantenrekening aan.
Stel de periode in.
Als u een periode aangeeft die langer is dan de boekhoudperiode genereert het programma
automatisch Prognoses voor meerdere jaren.
Als u een groep aangeeft ziet u de mutaties van alle rekeningen die bij die groep horen.
Als u in de budgettabel staat kunt u de rekeningkaart oproepen met een klik op het icoontje in
de rechterbovenhoek van de cel met de rekeningnaam.

Klanten in de Uitgebreide balans op groepen
Met Uitgebreide balans op groepen kunt u werken met cijfers onderverdeeld naar kolom per periode.
Op deze manier kunt de ontwikkeling van de liquiditeit zien per dag, week, maand, kwartaal, halfjaar,
jaar, etc.

Geef in de sectie kolommen van het commando Uitgebreide balans op groepen de aan dat u de
cijfers van Budget wilt zien.
Kies de groep klanten. U kunt ervoor kiezen rekeningen per klant weer te geven.
Stel de periode in.
Als een periode wordt aangegeven die buiten de boekhoudperiode valt schakelt het programma
automatisch over naar budgettering voor meerdere jaren.
Geef de gewenste onderverdeling per periode  aan.
Als u denkt dat u deze afdrukinstelling nogmaals gaat gebruiken maak dan een Aanpassing aan.

http://www.banana.ch/doc/nl/node/3265


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 731

Boekhoudoverzicht met budget voor klanten
Het Boekhoudoverzicht is gelijksoortig aan dat voor de Uitgebreide balans op groepen met het
verschil dat de weergave plaatsvindt in de rekeningentabel in kolommen.

U kunt het daardoor gebruiken om direct zicht te krijgen op de ontwikkeling van de
klantenrekeningen.
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Voorlopige balans

De balansprognose geeft de balans weer voor een toekomstige periode. Het is een belangrijk
instrument om de toestand van uw bedrijf te volgen en stelt u in staat om na te gaan hoe de
kapitaalstructuur van het bedrijf zal zijn, evenals de staat van de activa, passiva en het eigen
vermogen.

Met Banana Boekhouding heeft u dankzij de budgettering met de methode van dubbel boekhouden
volledige prognoses en dat kunt u op verschillende manieren regelen. Het programma kan ook
prognoses over meerdere jaren berekenen.
U krijgt een zeer nauwkeurige visie op de toekomstige balans.
De structuur van het budget is dezelfde als die van het boekhoudbestand. Bij het afdrukken kunt u
aangeven welke bedragen moeten worden weergegeven, die van het eindsaldo, de raming of beide.

Bij de berekening van de verwachte cijfers wordt rekening gehouden met de in de budgettabel
vermelde openingssaldi en de verwachte ontwikkelingen. Wanneer u een begrotingspost wijzigt,
worden de prognoses onmiddellijk bijgewerkt. U kunt een betaling simuleren en testen, verplaatsen,
een investering toevoegen, verkopen aanpassen en zien hoe het budget in de loop van de tijd
verandert.

Budgetprognose cijfers kunnen op diverse manieren worden weergegeven.

Gedetailleerde prognose
Met de financiële prognose, gebaseerd op de methode van het dubbel boekhouden, kunt u ramingen
krijgen van de balanscijfers gebruikmakend van dezelfde rekeningen en groepen als die van het
boekhoudbestand. Voor het maken van prognoses worden dezelfde onderdelen gebruikt als in de
boekingen. Cijfers en overzichten kunnen automatisch dagelijks weergeven hoe de liquiditeit zich
ontwikkelt evenals de situatie van de klanten.

Banana Boekhouding budget levert de cijfers voor het vaststellen van de financiële en economische
situatie en die van het eigen vermogen. De structuur van het budget is aan te passen. Deze kan
worden gepresenteerd op een eenvoudige manier door de hoofdgroepen en de rekeningen die er deel
van zijn te gebruiken, of op een complexere manier door subgroepen te gebruiken voor meer details.

ACTIVA PASSIVA
Vlottende activa
• Liquiditeit
• Kredieten
• Voorraad
Vaste activa
• Roerende activa
• Onroerend goed

Vreemd vermogen
• Korte termijn schuld
• Lange termijn schuld
Eigen vermogen
• Reserves
• Winst/verlies vorige jaren
• Winst/verlies huidige jaar

Rekeningentabel
In de kolom Budget van de rekeningentabel kunt u de gebudgetteerde bedragen van alle rekeningen
en balansgroepen vinden. In een oogopslag heeft u een overzicht van het budget. De bedragen
hebben betrekking op de boekhoudperiode en de afwijkingen worden automatisch berekent ten
opzichte van het huidige saldo.
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Als u meer details nodig heeft kunt u rekeningen of groepen toevoegen.

Uitgebreide balans op groepen
Met Uitgebreide balans op groepen kunt u de Prognosebalans bekijken met de weergave die u nodig
heeft.

Geef in de sectie kolommen van het commando Uitgebreide balans op groepen de waarden van
Budget aan.
U kunt de huidige (boekhoud) bedragen aangeven, de verwachte bedragen of beide.
Stel de periode in.
Als een periode wordt aangegeven die buiten de boekhoudperiode valt schakelt het programma
automatisch over naar budgettering voor meerdere jaren.
Geef de gewenste onderverdeling per periode  aan.
In de Rijen sectie kunt u rekeningen uitsluiten en daardoor een weergave van alleen groepen
hebben.
Als u denkt dat u deze afdrukinstelling nogmaals gaat gebruiken maak dan een Aanpassing aan.

Met de verschillende opties kunt u uw afdrukken op maat maken. Hierna volgen enkele voorbeelden.

Uitgebreide balans op groepen van budgetgroepen van dit jaar

Deze afdruk is opgezet om alleen de budgetbedragen van het huidige jaar te produceren.

Budget en huidige balans

De werkelijke bedragen worden vergeleken met die van het budget. U kunt het verschil weergeven
als bedrag en als percentage.

http://www.banana.ch/doc/nl/node/3265
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Kwartaalbudget

Om een jaarbudget verdeeld in kwartalen te krijgen moet het kwartaal aangegeven worden in de
sectie Onderverdeling → Onderverdeling per periode. Het programma laat het budget voor het jaar
zien verdeeld in 4 kwartalen.

Kwartaalbudget met vergelijking

Deze afdruk wordt opgezet om zowel het geschatte als het eindsaldo af te drukken. We hebben
daardoor de verwachte en de huidige toestand aan het eind van ieder kwartaal.

Driejaarlijks budget
Deze afdruk is bedoeld om het driejarige budget af te drukken.
Zet in de sectie Periode de periode op drie jaar en in de sectie Onderverdeling op een jaar. In de
Bestandseigenschappen (menu Bestand) moeten er 3 jaren zijn aangegeven in de begindatum en
einddatum velden (bijvoorbeeld begindatum 01-01-2022 - einddatum 31-12-2024).
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Boekhoudoverzicht met budget
Met menu Rapporten → Boekhoudoverzicht kunt u afdrukken maken van de financiële overzichten
zoals in de rekeningentabel met de gewenste kolommen.
De opties zijn gelijksoortig aan die voor de Uitgebreide balans op groepen.
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Financiële prognose voor leveranciers

Leveranciersprognoses vullen de financiële planning aan met leveranciersgegevens. Zo kan een
bedrijf bijvoorbeeld een omzetprognose maken door de rekeningen aan te geven voor de
belangrijkste leveranciers. Het kan zo de relatie met diverse leveranciers analyseren en optimaliseren
en dit mogelijk gebruiken door betalingsuitstel aan te vragen.

Met budgettering met de methode van dubbel boekhouden kunt u rekeningen aanwijzen voor de
individuele leveranciers. Afhankelijk van de wensen kan leveranciersbeheer gedaan worden met de
balansrekeningen, winst- en verliesrekeningen of met kostenplaatsen en winstcentra.

Bij het veranderen van een budgetpost worden de prognoses voor iedere individuele leverancier ook
bijgewerkt.

Rekeningentabel
Stel de rekeningen voor leveranciers in de Rekeningentabel in. In de kolom Budget vindt u de
bijgewerkte prognosesaldi voor de boekhoudperiode. U kunt in een oogwenk zien wat de prognose
voor de individuele leverancier is.

Voortgangsgrafiek

Als u het Grafieken venster opent en de cursor op een rekening of een groep zet ziet u de grafiek van
het verloop van de liquiditeit.
In de legenda zijn de teksten Huidig, Vorige of Budget zichtbaar. Door op de teksten te klikken kunt
u de bijbehorende grafiek verbergen of zichtbaar maken.

Rekeningkaart met budgetgegevens van leveranciers
Met het Budget rekeningkaart commando kunt u in detail alle mutaties voor iedere leverancier zien.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 737

Selecteer budget transacties.
Geef de leveranciersrekening of -groep aan.
Stel de periode in.
Als u een periode aangeeft die langer is dan de boekhoudperiode genereert het programma
automatisch Prognoses voor meerdere jaren.
Als u een groep aangeeft ziet u de mutaties van alle rekeningen die bij die groep horen.
Als u in de budgettabel staat kunt u de rekeningkaart oproepen met een klik op het icoontje in
de rechterbovenhoek van de cel met de rekeningnaam.

Leveranciers in de uitgebreide balans op groepen
Met Uitgebreide balans op groepen kunt u werken met cijfers onderverdeeld naar kolom per periode.
Op deze manier kunt de ontwikkeling van de leveranciers zien per dag, week, maand, kwartaal,
halfjaar, jaar, etc.

Geef in de Sectie aan dat u de cijfers van Budget wilt zien.
Kies de groep leveranciers. U kunt ervoor kiezen rekeningen per leverancier weer te geven.
Stel de periode in.
Als een periode wordt aangegeven die buiten de boekhoudperiode valt schakelt het programma
automatisch over naar budgettering voor meerdere jaren.
Geef de gewenste onderverdeling per periode  aan.
Als u denkt dat u deze afdrukinstelling nogmaals gaat gebruiken maak dan een Aanpassing aan.

http://www.banana.ch/doc/nl/node/3265
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Boekhoudoverzicht met leveranciersbudget
Het Boekhoudoverzicht is gelijksoortig aan dat voor de Uitgebreide balans op groepen met het
verschil dat de weergave plaatsvindt in de rekeningentabel in kolommen.

U kunt het daardoor gebruiken om direct zicht te krijgen op de ontwikkeling van de
leveranciersrekeningen.
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Investeringsplanning

Het investeringsplan geeft de verwachte ontwikkeling weer van het materieel, de
voorraden en de roerende of onroerende goederen die nodig zijn voor de onderneming.

Met Banana Boekhouding kunt u, dankzij de budgettering met de methode van dubbel boekhouden,
de ontwikkeling van de activa volgen. U maakt uitgebreide prognoses die u op verschillende manieren
kunt regelen. Het programma kan ook prognoses over meerdere jaren berekenen.
De structuur van het budget is dezelfde als die van het boekhoudbestand. Bij het afdrukken kunt u
aangeven welke bedragen moeten worden weergegeven, die van het eindsaldo, de raming of beide.

U beschikt ook over de vooruitzichten van de resultatenrekening, zodat u de ontwikkeling van de
afschrijvingen en de rente kunt weergeven. Wanneer een budgetbedrag wordt gewijzigd, worden de
prognoses onmiddellijk bijgewerkt. U kunt simulaties uitvoeren, een betaling toewijzen, een
investering toevoegen, verkopen wijzigen en zien hoe de activarekeningen reageren.

Voor het investeringsplan, beschikt u over dezelfde mogelijkheden als in de Liquiditeitsplanning en de
Voorlopige winst- en verliesrekening.

Formules gebruiken
Met formules kunt u berekeningen van afschrijvingen en rente automatiseren. Wanneer u een
investering verhoogt, wordt ook de resultatenrekening onmiddellijk bijgewerkt. Formules zijn vooral
nuttig bij het maken van prognoses over meerdere jaren.

Rekeningentabel
In de kolom Budget van de rekeningentabel worden de gebudgetteerde bedragen van alle rekeningen
en balansgroepen weergegeven en daardoor ook alles wat met de investeringen te maken heeft. In
een oogopslag heeft u een overzicht van de cijfers die betrekking hebben op de boekhoudperiode.

Als u meer details van de investeringen nodig heeft kunt u rekeningen of groepen toevoegen.
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Voortgangsgrafiek

Als u het Grafieken venster opent en de cursor op een rekening of een groep zet ziet u de grafiek van
het verloop van de liquiditeit.
In de legenda zijn de teksten Huidig, Vorige of Budget zichtbaar. Door op de teksten te klikken kunt
u de bijbehorende grafiek verbergen of zichtbaar maken.

Rekeningkaart met budgetgegevens van de investeringen
Met het Rekeningkaart commando van het menu Rapporten kunt u in detail, elke dag, alle mutaties
voor iedere activa- en afschrijvingsrekening zien. U kunt alle mutaties proberen die invloed hebben op
de investeringen.

Met het Rekeningkaart commando kunt u specificeren of u de huidige of de gebudgetteerde mutaties
wilt zien.

Selecteer budget transacties.
Geef de investeringsrekening of -groep aan.
Stel de periode in.
Als u een periode aangeeft die langer is dan de boekhoudperiode genereert het programma
automatisch Prognoses voor meerdere jaren.
Als u een groep aangeeft ziet u de mutaties van alle rekeningen die bij die groep horen.
Als u in de budgettabel staat kunt u de rekeningkaart oproepen met een klik op het icoontje in
de rechterbovenhoek van de cel met de rekeningnaam.

Uitgebreide balans op groepen voor investeringen
Met Uitgebreide balans op groepen kunt u werken met cijfers onderverdeeld naar kolom per periode.
Op deze manier kunt de ontwikkeling van de investeringen zien per dag, week, maand, kwartaal,
halfjaar, jaar, etc.

Geef in de Sectie aan dat u de cijfers van Budget wilt zien.
Kies de groep investeringen. U kunt ervoor kiezen rekeningen per investering weer te geven.
Stel de periode in.
Als een periode wordt aangegeven die buiten de boekhoudperiode valt schakelt het programma
automatisch over naar budgettering voor meerdere jaren.
Geef de gewenste onderverdeling per periode  aan.
Als u denkt dat u deze afdrukinstelling nogmaals gaat gebruiken maak dan een Aanpassing aan.

http://www.banana.ch/doc/nl/node/3265
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Boekhoudoverzicht met investeringen budget
Het Boekhoudoverzicht is gelijksoortig aan dat voor de Uitgebreide balans op groepen met het
verschil dat de weergave plaatsvindt in de rekeningentabel in kolommen.

U kunt het daardoor gebruiken om direct zicht te krijgen op de ontwikkeling van de activa- en
afschrijvingsrekeningen.
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Bedrijfsfinancieringsplan

Het bedrijfsfinancieringsplan geeft de verwachte ontwikkeling van de cijfers weer vergeleken met de
ontwikkeling van vreemd en eigen vermogen.

Met Banana Boekhouding kunt u, dankzij de budgettering met de methode van dubbel boekhouden,
de ontwikkeling van de passiva en de winst volgen. U maakt uitgebreide prognoses die u op
verschillende manieren kunt regelen. Het programma kan ook prognoses over meerdere jaren
berekenen. De structuur van het budget is dezelfde als die van het boekhoudbestand. Bij het
afdrukken kunt u aangeven welke bedragen moeten worden weergegeven, die van het eindsaldo, de
raming of beide.

U beschikt ook over de vooruitzichten van de resultatenrekening, zodat u de ontwikkeling van de
afschrijvingen en de rente kunt weergeven. Wanneer een budgetbedrag wordt gewijzigd, worden de
prognoses onmiddellijk bijgewerkt. U kunt simulaties uitvoeren, een betaling toewijzen, een
investering toevoegen, verkopen wijzigen en zien hoe de activarekeningen reageren.

Voor het bedrijfsfinancieringsplan beschikt u over dezelfde mogelijkheden als in de
Liquiditeitsplanning en de Voorlopige winst- en verliesrekening.

Formules gebruiken
Met formules kunt u berekeningen van afschrijvingen en rente automatiseren. Wanneer u een
investering verhoogt, wordt ook de resultatenrekening onmiddellijk bijgewerkt. Formules zijn vooral
nuttig bij het maken van prognoses over meerdere jaren.

Rekeningentabel
In de kolom Budget van de rekeningentabel worden de gebudgetteerde bedragen van alle rekeningen
en balansgroepen weergegeven en daardoor ook alles wat met vreemd en eigen vermogen te maken
heeft. In een oogopslag heeft u een overzicht van de cijfers die betrekking hebben op de
boekhoudperiode.

Als u meer details van vreemd en eigen vermogen nodig heeft kunt u rekeningen of groepen
toevoegen.
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Voortgangsgrafiek vreemd vermogen

Als u het Grafieken venster opent en de cursor op een rekening of een groep zet ziet u de grafiek van
het verloop van de financiering van het bedrijf.
In de legenda zijn de teksten Huidig, Vorige of Budget zichtbaar. Door op de teksten te klikken kunt
u de bijbehorende grafiek verbergen of zichtbaar maken.

Rekeningkaart met budgetgegevens van geleend vermogen
Met het Rekeningkaart commando van het menu Rapporten kunt u in detail, elke dag, alle mutaties
voor iedere bedrijfsfinancieringsrekening zien. U kunt alle mutaties proberen die invloed hebben op
de bedrijfsfinanciering.

Met het Rekeningkaart commando kunt u specificeren of u de huidige of de gebudgetteerde mutaties
wilt zien.

Selecteer budget transacties.
Geef de investeringsrekening of -groep aan.
Stel de periode in.
Als u een periode aangeeft die langer is dan de boekhoudperiode genereert het programma
automatisch Prognoses voor meerdere jaren.
Als u een groep aangeeft ziet u de mutaties van alle rekeningen die bij die groep horen.
Als u in de budgettabel staat kunt u de rekeningkaart oproepen met een klik op het icoontje in
de rechterbovenhoek van de cel met de rekeningnaam.

Uitgebreide balans op groepen met budgetgegevens van
geleend vermogen
Met Uitgebreide balans op groepen kunt u werken met cijfers onderverdeeld naar kolom per periode.
Op deze manier kunt de ontwikkeling van vreemd en eigen vermogen zien per dag, week, maand,
kwartaal, halfjaar, jaar, etc.
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Geef in de Sectie aan dat u de cijfers van Budget wilt zien.
Kies de groep van de bedrijfsfinancieringsrekeningen . U kunt ervoor kiezen rekeningen per
fonds weer te geven.
Stel de periode in.
Als een periode wordt aangegeven die buiten de boekhoudperiode valt schakelt het programma
automatisch over naar budgettering voor meerdere jaren.
Geef de gewenste onderverdeling per periode  aan.
Als u denkt dat u deze afdrukinstelling nogmaals gaat gebruiken maak dan een Aanpassing aan.

Boekhoudoverzicht met budget voor geleend vermogen
Het Boekhoudoverzicht is gelijksoortig aan dat voor de Uitgebreide balans op groepen met het
verschil dat de weergave plaatsvindt in de rekeningentabel in kolommen.

U kunt het daardoor gebruiken om direct zicht te krijgen op de ontwikkeling van de
bedrijfsfinancieringsrekeningen.

http://www.banana.ch/doc/nl/node/3265
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Projectplanning met winstcentra en
kostenplaatsen

Door de financiële planning van projecten krijgt u controle over de inkomsten en uitgaven van een
project. Hierdoor kunnen investeringen en rendementen van een project worden geëvalueerd en kan
de uitvoering ervan worden gevolgd.

Ook met budgettering met de methode van dubbel boekhouden, kunt u winstcentra en
kostenplaatsen aanwijzen. U hoeft alleen maar kostenplaatsen op te zetten voor de verschillende
projecten en naast de prognoses voor de balans en de resultatenrekening heeft u ook de prognose
voor elk afzonderlijk project.

Bekijk de video uitleg (engelstalig): Kostenplaatsen en Winstcentra

De vooruitzichten worden berekend op basis van de beginsaldi en de verwachtingen ingevoerd in de
Budgettabel. Wanneer een regel wordt veranderd in het budget worden de verwachtingen meteen
bijgewerkt. U kunt simulaties uitvoeren, een betaling toewijzen, een investering toevoegen, verkopen
wijzigen en zien hoe het budget verandert.

Projectcijfers kunnen op verschillende manieren worden weergegeven.

Rekeningentabel
Winstcentra en kostenplaatsen worden opgezet in de Rekeningentabel. In de Budget kolom ziet u de
bijgewerkte prognosesaldi voor de boekhoudperiode. In een oogopslag weet u wat de liquiditeit is aan
het eind van het jaar.

Voortgangsgrafiek

Als u het Grafieken venster opent en de cursor op een rekening of een groep zet ziet u de grafiek van
het verloop van de liquiditeit.
In de legenda zijn de teksten Huidig, Vorige of Budget zichtbaar. Door op de teksten te klikken kunt
u de bijbehorende grafiek verbergen of zichtbaar maken.

Rekeningkaart met budgetgegevens
Met het Rekeningkaart commando van het menu Rapporten kunt u in detail alle mutaties van ieder
project van dag tot dag weergeven.

https://www.banana.ch/en/node/11496
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Selecteer budget transacties.
Geef de kostenplaats- of winstcentrumrekeningen of -groepen aan.
Stel de periode in.
Als u een periode aangeeft die langer is dan de boekhoudperiode genereert het programma
automatisch Prognoses voor meerdere jaren.
Als u een groep aangeeft ziet u de mutaties van alle rekeningen die bij die groep horen.
Als u in de budgettabel staat kunt u de rekeningkaart oproepen met een klik op het icoontje in
de rechterbovenhoek van de cel met de rekeningnaam.

Uitgebreide balans op groepen
Met de Uitgebreide balans op groepen kunt u ervoor kiezen de bedragen in aparte kolommen te
verdelen voor ieder segment. Daardoor heeft u zicht op de ontwikkeling van individuele projecten per
dag, week, maand, kwartaal, halfjaar, jaar, etc.

Geef in de Sectie aan dat u de cijfers van Budget wilt zien.
Kies de groep projecten. U kunt ervoor kiezen rekeningen per project weer te geven.
Stel de periode in.
Als een periode wordt aangegeven die buiten de boekhoudperiode valt schakelt het programma
automatisch over naar budgettering voor meerdere jaren.
Geef de gewenste onderverdeling per periode  aan.
Als u denkt dat u deze afdrukinstelling nogmaals gaat gebruiken maak dan een Aanpassing aan.

Boekhoudoverzicht
Het Boekhoudoverzicht is gelijksoortig aan dat voor de Uitgebreide balans op groepen met het
verschil dat de weergave plaatsvindt in de rekeningentabel in kolommen.

U kunt het daardoor gebruiken om direct zicht te krijgen op de ontwikkeling van de projecten.

http://www.banana.ch/doc/nl/node/3265
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Planning met segmenten per sector en
branche

De financiële planning met sectoren stelt u in staat om per sector of vestiging van het bedrijf balans-
en resultaatprognoses op te stellen. Met segmenten kunt u dus de verschillende onderdelen van het
bedrijf evalueren en begrijpen welke bijdrage elk van hen levert aan de totale activiteit.

Ook bij het budgetteren met de methode van het dubbel boekhouden kunt u segmenten aanwijzen
die ingesteld worden in de rekeningentabel, aan het eind van het rekeningschema en die gebruikt
worden voor zowel boekhouden als budgettering. Wanneer u de mutaties voor het budget invoert
moeten de rekeningen ingevoerd worden als dit nodig is. Banana Boekhouding produceert de balans
en de verlies- en winstrekening ook met budget met de onderverdeling in segmenten.

Sector- of afdelingsgegevens kunnen met segmenten op verschillende manieren worden
weergegeven.

Rekeningschema
Segmenten worden opgezet in het Rekeningschema. Bij het aanwijzen van de segmenten voor de
balans en de resultatenrekening is het saldo van het segment altijd nul in de rekeningen.

Rekeningkaart met budgetgegevens van segmenten
Met het Rekeningkaart commando van het menu Rapporten kunt u in detail alle mutaties van ieder
segment in detail onderzoeken.

 Met de Rekeningkaart kunt u aangeven
of u de huidige of de budgetmutaties wilt laten zien.
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Selecteer budget transacties.
Geef het gewenste segment aan.
Stel de periode in.
Als u een periode aangeeft die langer is dan de boekhoudperiode genereert het programma
automatisch Prognoses voor meerdere jaren.
Als u een groep aangeeft ziet u de mutaties van alle segmenten die bij die groep horen.
Als u in de budgettabel staat kunt u de rekeningkaart oproepen met een klik op het icoontje in
de rechterbovenhoek van de cel met de rekeningnaam.

Uitgebreide balans op groepen
Met de Uitgebreide balans op groepen kunt u ervoor kiezen de bedragen in aparte kolommen te
verdelen voor ieder segment. Zo beschikt u over de balans en de resultatenrekening van elke sector.

Geef in de Sectie Kolommen aan dat u de cijfers van Budget wilt zien.
In Secties kunt u ervoor kiezen om alleen de balans of de resultatenrekening te bekijken.
Kies de groep projecten. U kunt ervoor kiezen rekeningen per project weer te geven.
Stel de periode in.
Als een periode wordt aangegeven die buiten de boekhoudperiode valt schakelt het programma
automatisch over naar budgettering voor meerdere jaren.
Geef de gewenste onderverdeling in segmenten  aan.
Als u denkt dat u deze afdrukinstelling nogmaals gaat gebruiken maak dan een Aanpassing aan.

Boekhoudoverzicht voor het budget met segmenten
Het Boekhoudoverzicht is gelijksoortig aan dat voor de Uitgebreide balans op groepen met het
verschil dat de weergave plaatsvindt in de rekeningentabel in kolommen.

U kunt het daardoor gebruiken om direct zicht te krijgen op de ontwikkeling van de segmenten.

http://www.banana.ch/doc/nl/node/3265
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Nieuw jaar voor financiële prognose

De Banana Boekhouding functie om een nieuw jaar aan te maken  verwerkt ook de budget mutaties.

Voor iedere regel in de budgettabel kunt u in de kolom Nieuw Jaar het volgende aangeven:

Of de bewerking overgedragen moet worden of niet.
Of de datum hetzelfde gehouden moet worden of vervangen door de datum van het nieuwe
jaar.

Het opstellen van de begroting voor het nieuwe jaar is dus eenvoudig, omdat u de uitgaven- en
inkomstenposten die naar verwachting zullen veranderen, moet wijzigen of toevoegen.
 

http://www.banana.ch/doc/nl/node/3307
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Jaarlijks budget in kolommen (rekeningen-
en categorieëntabellen)

Wanneer u een budget op jaarbasis snel wilt opzetten, zonder details per periode, kunt u de begrootte
bedragen in de kolom Budget van de rekeningen- en/of categorieëntabel invoeren.

Kolom voor het jaarbudget
In de rekeningen- en/of categorieëntabel kan de kolom Budget alleen gebruikt worden als de
budgettabel niet toegevoegd is. Als de budgettabel aanwezig is kan deze als volgt verwijdert worden:

Menu Extra → Functies toevoegen/verwijderen → Budget tabel verwijderen.

Zodra de budgettabel is verwijderd wordt de kolom Budget geactiveerd en kunt u de bedragen van
het jaarbudget invoeren in de weergave Budget van de rekeningen- en/of categorieëntabel.

Als een vuistregel wordt alleen het budget voor de uitgaven en inkomsten (dubbel boekhouden) en
voor inkomsten en uitgaven (inkomsten / uitgaven boekhouding) aangegeven.

De budgetbedragen moeten ingevoerd worden voor iedere rekening en/of categorie. Het programma
berekent de totalen automatisch en leidt daarvan de winst of verlies af.

Rekeningentabel:
Opbrengsten (Credit) moeten als een negatieve waarde worden ingevoerd.
Uitgaven (Debet) moeten als een positieve waarde worden ingevoerd.

Categorieëntabel:
Inkomsten moeten als een positieve waarde worden ingevoerd.
Uitgaven moeten als een negatieve waarde worden ingevoerd.

Budget Verschil kolom
In de Budget Verschil kolom berekent het programma het verschil tussen het saldo en het bedrag
in de Budget kolom. Als een transactie wordt ingevoerd in de de rekeningen- en/of categorieëntabel
dan wordt  deze kolom automatisch bijgewerkt.
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Afdruk per periode
Bij het afdrukken per maand of kwartaal verdeelt het programma de waarde aangegeven in de
Budget kolom in maandelijkse of kwartaal hoeveelheden.

Het programma gaat als volgt te werk voor de onderverdelingen:

Berekent het aantal maanden, gebaseerd op de begin- en einddatum aangegeven in de menu
Bestand → boekhoudingseigenschappen, basis gegevens.
Het begrootte bedrag wordt gedeeld door het aantal berekende maanden.
Eventuele afrondingsverschillen worden opgeteld bij de laatste maand.

Als u bijvoorbeeld een bedrag van 10.000 heeft aangegeven wordt dit verdeeld in 11 maandelijkse
bedragen van 833,33 en een van 833,37.

Als afdrukken per kwartaal is geselecteerd wordt de waarde van het kwartaal de som van de aparte
maanden en niet de waarde van het jaar gedeeld door het aantal kwartalen.

Als u een verschillende planning wilt per maand of per kwartaal moet u de planning met de
Budgettabel gebruiken.

Budget kolommen toevoegen
Met het commando Gegevens → Kolommen instellen → Toevoegen kunt u andere kolommen
toevoegen om andere budget waardes in te voeren.

Stel het gegevenstype in op Bedrag.
Op deze manier kan het programma de totalen berekenen.

U kunt budgetkolommen toevoegen voor:

Het beheren van meerdere Budget waardes (verschillende scenario's).
Het bewaren van een kopie van het initiële budget aangemaakt in de budgettabel:

Maak het budget aan in de budgettabel.
Ga naar de eerste rij in de rekeningentabel en kies de hele kolom (door op de kolomkop
te klikken).
Menu Bewerken → kopiëren.
Ga in de eerste rij van de budgetkolom staan waar de gegevens naartoe gekopieerd
moeten worden.
Menu Bewerken → plakken.
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Importeren

Naar boekhouding importeren
De interne overdrachtsrekening
Paypal transacties importeren
Rijen importeren
Gegevens van andere programma's overdragen
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Naar boekhouding importeren commando

Het commando Importeren wordt gegeven vanuit het menu Acties → Naar boekhouding
importeren. Met dit commando kunt u vanuit bestanden gegevens importeren in de volgende
tabellen:

Transactietabel - Bank transacties
Voor het importeren van bankafschriften in de Transactietabel.
Transactietabel - Algemene transacties
Voor het importeren van algemene transacties in de Transactietabel.
Rekeningen
Voor het importeren van rekeningen in de Rekeningentabel.
BTW Codes
Voor het importeren van BTW Codes in de BTW Codes tabel.
Wisselkoersen
Voor het importeren van Wisselkoersen in de Wisselkoersen tabel.
Bestand
Importeert gegevens in meerdere tabellen en ook in de Bestandseigenschappen. Deze soort
import wordt bijvoorbeeld gebruikt voor het converteren van het rekeningschema.

Om gegevens vanuit andere programma's te importeren bezoekt u de pagina Gegevens van andere
programma's ophalen.

Procedure voor het importeren
Kies de doeltabel voor de gegevens.1.
Kies het bestandstype waarvan geïmporteerd wordt.2.
Geef de bestandsnaam op.3.
Kies welke transacties moeten worden geïmporteerd.4.

Ondersteunde importformaten
Er zijn verschillende importformaten beschikbaar overeenkomstig het type van de doeltabel.

Vanuit andere Banana Boekhouding bestanden (.AC2)
Voorbereid om gegevens vanuit bestanden te converteren.
Tekstbestand met kolomkoppen (CSV/TXT)
Voor bestanden die gegevens exporteren in het formaat vereist voor Banana Boekhouding.
Technische uitleg over hoe dit soort bestanden aangemaakt moeten worden kan gevonden
worden op deze pagina, in het Engels.
Standaard bestandsformaten (algemeen)
ISO 20022 (algemeen).
Formaten die met een import extensie geïmporteerd kunnen worden .
Gebruikelijk voor bank afschriften.
De import extensie is een extra Banana Boekhouding programma dat gegevens van een
specifiek formaat omzet.
U moet de passende extensie installeren.
Wanneer er een gegevens van een ander bestandstype, dat niet in de lijst staat, geïmporteerd
moeten worden, dan kan er een specifieke Banana Import Extensie ontwikkeld worden .

http://www.banana.ch/doc/nl/node/9994
https://www.banana.ch/apps/en/node/9561
https://www.banana.ch/apps/en/node/9561
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Import parameters
Bestandsnaam

Geef de naam aan van het bestand waarvan de gegevens geïmporteerd moeten worden.
Voor sommige soorten bestanden (bijvoorbeeld bankafschriften) geldt het volgende:

Kunt u meerdere bestanden tegelijk aangeven door deze in het dialoogvenster Verkennen
te selecteren of door deze in te voeren gescheiden door een puntkomma ";".
Kunt u een zip bestand aangeven dat meerdere te importeren bestanden bevat.
Moeten alle bestanden van het zelfde soort zijn als u er meerdere tegelijk specificeert.

Gegevens importeren vanuit het klembord (Excel)

Met deze functie worden de gegevens vanuit het klembord gelezen in plaats vanuit een bestand.
Dit wordt gebruikt om gegevens te importeren die niet direct door Banana gelezen kunnen worden,
zoals bankafschriften in Excel formaat of van een ander programma.

Het voordeel van het importeren van gegevens, en niet gewoon de kopiëren en plakken functie
gebruiken, is dat de gegevens worden geconverteerd door de import extensie en automatisch
aangevuld.

Ga als volgt te werk:

Open het bestand met de gegevens in Excel.
Selecteer de gegevens die geïmporteerd moeten worden, inclusief eventuele koprijen.
Voor het kopieer commando uit (Ctrl+C) om de gegevens in het klembord te krijgen.

Deze optie wordt alleen voor sommige import soorten getoond.

UTF-8

Kies of de gegevens die geïmporteerd worden in het UTF-8 formaat is.
Deze optie wordt alleen voor sommige import soorten getoond.

Extensies beheren...

Dit commando brengt u naar het Extensies beheren dialoog venster.
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U kunt dit gebruiken om:

Import extensies te zoeken, toe te voegen of te verwijderen.
De parameters van extensies aan te passen.

U kunt het commando ook gebruiken om de extensie instellingen te veranderen.

Instellingen

Met deze knop kunt u de extensie instellingen veranderen.
De knop is zichtbaar vanaf Banana versie 10.1 en dan alleen als de extensie toestaat parameters in te
stellen.

OK knop

Deze knop start het importeer proces.

Foutmeldingen
Wanneer er fouten worden gemeld tijdens het importeren the moeten de import extensies eerst
worden bijgewerkt.

Wanneer de fouten blijven optreden geef ons dan alstublieft terugkoppeling . Het zou kunnen zijn
dat het bestandsformaat is veranderd door de bank of instelling. Wij zullen ons importfilter dan
overeenkomstig aanpassen.

https://www.banana.ch/nl/feedback_documentation
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Transacties importeren vanuit
internetbankieren

 

Deze pagina beschrijft het importeren van transacties vanuit digitale bankafschriften, de meest
gebruikte en nuttigste functie waarmee u het invoeren van transacties in de transactietabel kunt
automatiseren.
Bestanden met banktransacties worden gedefinieerd als bestanden met inkomende en uitgaande
bedragen op één rekening. De import dialoog vereist de invoer van de rekening en de tegenrekening,
en staat het gebruik van de Regels voor het automatisch categoriseren van geïmporteerde
transacties  toe.

Echter, over het importeren van bestanden die andere soorten transacties bevatten, bijvoorbeeld
vanuit een dubbel boekhouden systeem, vindt u informatie op de pagina Transacties importeren
(algemeen). Voor dit soort bestanden kunnen de Regels voor automatisch aanvullen niet gebruikt
worden.

▶ Video: Importeren van bank transacties  (Engelstalig)

 Import procedure
Vanuit menu Acties → Naar boekhouding importeren → in het veld Importeren kiest u1.
Transacties.
Kies daarna het bestandstype om te importeren.2.
Zie uitleg hierna.
Met de knop Bladeren selecteert u het bestand van waaruit u de transacties wilt importeren.3.
Stel de benodigde parameters in.4.
Zie ook: Naar boekhouding importeren.

https://www.banana.ch/doc/nl/rules
https://www.banana.ch/doc/nl/rules
https://www.banana.ch/en/node/11559
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Volgende stappen
Nadat u met OK heeft bevestigd worden de gegevens gelezen worden de volgende dialoogvensters
weergegeven:

Transacties importeren
Waarin instructies voor het aanvullen van de geïmporteerde rijen worden gegeven kunnen
worden.
Pas Regels toe voor het automatisch categoriseren van geïmporteerde transacties  (alleen
voor het Advanced plan).
Bij het importeren kunnen transacties opgeslagen worden zodat het programma de transacties
automatisch aanvult in alle volgende importacties.

Importformaten voor bankafschriften 
In het dialoogvenster voor het importeren van transacties kunt u kiezen tussen verschillende soorten
bestanden:

Bestanden die geïmporteerd worden met Import extensies voor bankafschriften  (Engelstalig)
(de meeste zijn alleen beschikbaar in het Advanced plan)
Dit zijn extra programma's die door de gebruiker geïnstalleerd moeten worden en die de
gegevens converteren van de formaten die door Banana Boekhouding Plus geleverd worden.
Met de knop Extensies beheren kunt u de extensies installeren die geprogrammeerd zijn om
banktransacties van andere banken, credit kaarten en andere formaten te importeren.
Nadat de extensie is geïnstalleerd verschijnt deze in het menu Extensies, klaar voor het
importeren.

Up to date lijst van Banana Extensies voor het importeren.
Bestanden met een standaard formaat opgenomen in Banana Boekhouding Plus
(Professional plan)
Dit zijn standaard formaten die door banken beschikbaar worden gesteld, opgenomen in
Banana Boekhouding Plus:

MT 940 rekeningafschrift
Algemeen ISO 20022 rekeningafschrift
Diverse banken in Europa gebruiken het rekeningafschrift in het standaard ISO 20022
formaat.

Bestanden met een algemeen formaat met transacties met inkomsten en uitgaven in
platte tekst (Professional plan)
Dit een tekstbestand van het CSV type, waarin de tab als scheidingsteken gebruikt wordt en
waarin de inkomende en uitgaande bedragen van een rekening in kolommen worden
weergegeven.

Zie technische instructies voor het importeren van een inkomsten en uitgaven bestand
(Engelstalig).

Bestandsnaam
Geef een bestandsnaam of zelfs meerdere bestanden, gescheiden door een puntkomma ";". U kunt
ook een ZIP bestand aangeven dat meerdere bestanden die geïmporteerd moeten worden bevat.

Meerdere bestanden tegelijk importeren:

Wanneer uw bank dagelijks camt053 aanlevert kunt u alle bestanden van een maand

https://www.banana.ch/doc/nl/rules
https://www.banana.ch/apps/en/node/9561
https://www.banana.ch/apps/nl/extensions?combine=&country=All&langcode=All&op=Invia&type=265
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selecteren en deze in één keer importeren.
Wanneer uw bank ZIP bestanden aanlevert kunt u het bestand gebruiken dat alle
rekeningafschriften bevat.

De importbestanden moeten uiteraard van hetzelfde type zijn. U kunt geen verschillende formaten
tegelijk importeren.

Importbestand structuur
Het importbestand bevat de typische mutaties van een rekeningafschrift:

Datum
[transactienummer] optioneel
Beschrijving
Inkomend of uitgaand bedrag.

Bij het importeren geeft u aan op welke rekening de transacties moeten worden geboekt, zodat de
Debet- of Creditrekening alvast wordt gemaakt.
Import extensies kunnen worden gemaakt voor elke soort rekeningafschrift.
Zie technische instructies voor het importeren van een inkomsten en uitgaven bestand (Engelstalig).

Vaak gestelde vragen:
Ik zie het formaat van mijn bankafschrift niet bij de extensies. Wat moet ik doen?
Klik op menu Extensions → Extensies beheren... daarna op de Extensions bijwerken knop en
kies dan de extensie voor het gewenst formaat.

Ik zie de extensie voor het Postfinance xml (.tgz file) afschrift niet. Hoe kan ik mijn
mutaties importeren?
Dit formaat wordt niet langer ondersteund. Vraag Postfinance om het afschrift in ISO 20022 formaat
te sturen.

Ik krijg de melding "Dit ISO 20022 bestand bevat geen rekeningafschrift
(camt.052/053/054)". Hoe moet ik verdergaan?
Deze foutmelding wordt weergegeven als het ISO 20022-bestand geen bankafschrift bevat. Het ISO
20022-formaat is een generiek formaat dat verschillende soorten informatie kan bevatten, zoals
bankafschriften en orderbevestigingen. In Banana Boekhouding Plus is het alleen mogelijk om
bankafschriften te importeren (camt.052/053/054).

Mijn bank staat niet in de lijst van ondersteunde formaten. Kan deze worden toegevoegd?
Het is mogelijk nieuwe extensies te maken voor formaten die nog niet geïmplementeerd zijn.
Ondersteuning voor het implementeren voor eigen formaten is beschikbaar voor een vergoeding
(Engelstalig).

Ik kan alleen verzamelopdrachten importeren maar ik kan de details (individuele
transacties) niet zien. Waarom?
Bij digitaal bankieren (bijvoorbeeld Raiffeisen Bank) moet u de optie losse opdrachten kiezen in plaats
van verzamelopdrachten. Alleen op deze manier worden betalingen als aparte opdrachten
geïmporteerd.
 

http://www.banana.ch/en/node/11330
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Transacties importeren dialoogvenster

U opent het dialoogvenster Transacties importeren vanuit het menu:

Acties → Naar boekhouding importeren → Keuzelijst Importeren: Transacties

Inhoud van het dialoogvenster
De weergave van de elementen in het venster hangt af van het soort bestand dat wordt
geïmporteerd:

Transacties op een enkele rekening en bankafschriften 
Alle elementen worden getoond.
Transacties voor dubbel-boekhouden of andere
De volgende elementen worden niet getoond:

Rekening
Tijdelijke tegenrekening
Regels toepassen.

Groepering per factuur
Dit element wordt alleen weergegeven als er inhoud voorkomt in de kolom Factuur in het te
importeren bestand.

Transacties importeren dialoog
Met deze dialoog kunt u aangeven hoe gegevens worden ingevoerd in de rekeningen.

Doelrekening

Deze optie verschijnt wanneer gegevens worden geïmporteerd vanuit een bankafschrift of vanuit de
inkomsten en uitgaven transacties van een boekhouding in tekst formaat.

Voer de rekening van uw rekeningschema in dat bij het geïmporteerde afschrift hoort.
Als u dit veld leeg laat vult het programma de rekening [A] (van Account) in zodat u later kunt

http://www.banana.ch/doc/nl/node/2795/
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aangeven of het een debet of credit transactie is.

Selecteer transacties

Start datum, Eind datum

Voer de start- en einddatum in van de periode die bij de te importeren transacties hoort. De periode
kan ook automatisch worden gekozen in de velden onder het data gedeelte.

Niet importeren indien dezelfde Externe verwijzing, Datum, Bedrag bestaat

Wanneer deze optie actief is kunt u het importeren van reeds geïmporteerde transacties achterwege
laten om te voorkomen dat transacties dubbel geboekt worden. Deze optie kan alleen geactiveerd
worden als in te importeren transacties de kolom "Externe verwijzing" aanwezig is.

Op datum sorteren

Deze optie is standaard actief en daarmee kunnen de geïmporteerde transacties op datum gesorteerd
worden.

De transacties voltooien met

Waarden automatisch aanvullen

Deze optie is alleen nodig voor boekhoudingen met BTW en vreemde valuta. Als deze is geactiveerd
kunnen waardes die ontbreken in de geïmporteerde gegevens automatisch worden aangevuld
(bijvoorbeeld de wisselkoers in de wisselkoerstabel).

Regels toepassen (alleen Advanced plan)

De optie is niet beschikbaar voor het importeren van transacties vanuit een dubbel boekhouden
bestand (.ac2 formaat).

Zie ook: Regels voor automatisch aanvullen van transacties.

Wanneer deze optie is geactiveerd en wanneer u bevestigd met OK wordt de Apply Rules
dialoog  geopend.
Wanneer u deze optie niet heeft geactiveerd kunt u deze ook openen door het commando uit te
voeren vanuit het menu Acties → Terugkerende transacties→ Regels toepassen...
Deze optie wordt standaard geactiveerd als er al import regels in de terugkerende transacties
tabel staan.

Tijdelijke tegenrekening

De optie is niet beschikbaar voor het importeren van transacties vanuit een dubbel boekhouden
bestand (.ac2 formaat).

Er moet een tijdelijke rekening worden aangegeven om een tegenrekening voor de boeking te
hebben. De  rekening moet daarna worden vervangen door de correcte tegenrekening, handmatig of
met de regels voor automatisch aanvullen.
Het programma stelt standaard rekening [CA] (Contra account) voor.
Nadat de boekingen voltooid zijn zou er geen transacties mogen zijn met de tijdelijke rekening.

http://www.banana.ch/doc/nl/node/9973
http://www.banana.ch/doc/nl/node/9973
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Initieel documentnummer

De optie is niet beschikbaar voor het importeren van transacties vanuit een dubbel boekhouden
bestand (.ac2 formaat).
Dit is het documentnummer dat toegekend wordt aan de eerste boeking van de geïmporteerde
transacties. 
Volgende nummers worden automatisch opgehoogd.

Transacties groeperen op factuurnummer

Als het importbestand waarden bevat in de kolom Factuur laat de dialoog ook de volgende opties
zien:

Transacties groeperen op factuurnummer
In dit geval worden de rijen met hetzelfde factuurnummer gegroepeerd zodat er maar één
transactie is voor dezelfde rekening en dezelfde BTW code. Zie uitleg over het importeren van
factuurgegevens (Engelstalig).
 
Doelrekening voor saldiverschillen
Wanneer BTW codes worden gebruikt kunnen er afrondingsverschillen ontstaan van een paar
centen.
In dit geval creëert Banana Boekhouding Plus een extra transactie, waarin dit verschil kan
worden geboekt, voor iedere factuur.
Het is uiteraard nodig er op te letten dat in de gegevens die geïmporteerd worden credit en
debet in balans zijn. Als dit niet het geval is bevat de transactie het verschil tussen debet en
credit.

Bewerken van geïmporteerde transacties
Het programma maakt transacties aan en voegt deze toe aan het einde van de transactietabel.
De transacties kunnen bewerkt worden of verwijderd.
Het programma vult symbolen in de kolommen debetrekening en creditrekening in een dubbel
boekhoudbestand en in de kolommen rekening en categorie in een inkomsten/uitgaven
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boekhoudbestand.
De symbolen moeten vervangen worden door de juiste rekening of categorie.

[A]
Dit symbool wordt getoond als er geen doelrekening is aangegeven in het dialoogvenster.
In plaats van het symbool [A] moet de rekening die hoort bij de bankrekening ingevuld worden.
[CA]
Dit symbool geeft aan dat het juiste tegenrekening nummer ingevoerd moet worden de cel om
de debet- of creditrekening aan te geven.

Voor rijen met slechts één tegenrekening staan zowel de rekening of het symbool [A] als het symbool
van de tegenrekening [CA] op dezelfde rij.
Voor rijen met meerdere tegenrekeningen (transacties op meerdere rijen), zal elke rij het rekening- of
tegenrekening symbool [CA] hebben. Als het symbool [CA] niet zou worden vermeld, zou het
onmogelijk zijn om te zien of de mutatie een debet- of een creditmutatie is.
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ISO 20022 bestand importeren

Met Banana Boekhouding Plus kunt u banktransacties in verschillende formaten importeren.

ISO 20022 is een internationale standaard voor het versturen van financiële gegevens die nu
gebruikt zou moeten worden door alle Europese banken. 

Dit formaat wordt ook wel aangeduid als ISO xml, xml, camt.053, camt.054, en andere. Bij
sommige banken is het ISO 20022 formaat misschien niet standaard beschikbaar maar moet worden
aangevraagd. Het ISO 20022 formaat vervangt de oude MT940 standaard. Met het importeren van het
ISO 20022 formaat kunt u met Banana Boekhouding Plus ook automatisch open facturen van klanten
en leveranciers afsluiten.

De CAMT categorie groepeert de formaten de gebruikt worden voor het rekeningoverzicht, overzicht
van rekeningtransacties en rekening saldo verificatie:

camt052: Rekeningoverzicht
camt053 (inclusief versie 4): Rekeningtransacties
camt054: Credit / Debet bevestiging

Het  ISO-20022 bestand bekijken
Banana Boekhouding Plus biedt de mogelijkheid om de inhoud van een CAMT bestand te bekijken.

Gegevens importeren in de boekhouding
Ga te werk als aangegeven voor het commando Menu>Naar boekhouding importeren.
Gecomprimeerde bestanden kunnen ook worden geopend met deze functie. In dat geval vraagt het
programma aan de gebruiker uit welk bestand de te importeren gegevens gehaald moeten worden.

Technische opmerkingen over het converteren van ISO
20022 bestanden
De ISO 20022-norm codeert de boekhoudkundige gegevens van het bankafschrift zeer nauwkeurig.
Desalniettemin laat zij enige ruimte voor het invoegen van aanvullende informatie over de rekening
en de transacties.
Bij het lezen van het bestand probeert Banana Boekhouding Plus zichzelf aan te passen aan de
manier waarop het ISO 20022 bestand geordend is.

Leest de van toepassing zijnde coderingen voor het openingssaldo
Leest de van toepassing zijnde coderingen voor het eindsaldo
De hele inhoud wordt gelezen en omgezet in transacties

Transactiedatum (Datum)
Valutadatum
Transactiebedrag (positief of negatief)
Beschrijving 
Nu laat Banana Boekhouding Plus de verschillende beschrijvingen als één enkele tekst
zien. In de toekomst is het mogelijk deze informatie gescheiden op te halen kolommen
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aan te geven waar de gegevens terecht moeten komen.
Onderscheid van transacties per regel en transacties over meerdere regels.
Voor transacties over meerdere regels wordt één regel gebruikt voor de totale som en
aparte regels voor transacties die samen het totaal vormen.

Landspecifieke informatie
Ieder land en/of bank heeft de mogelijkheid naar eigen wensen extra informatie toe te voegen in het
ISO 20022 bestand. Banana Boekhouding Plus biedt een algemeen filter bij het programma
(Engelstalig) en meerdere land en/of bank-specifieke filters uitgegeven als Banana Extensie. Om deze
extra informatie in uw boekhouding te importeren moet u het filter installeren  en gebruiken dat het
meest geschikt is voor uw bank en/of land. Bijvoorbeeld filters voor gebruik in Nederland .

https://www.banana.ch/apps/en/node/8226
https://www.banana.ch/apps/nl/node/9295
https://www.banana.ch/apps/nl/extensions?combine=&langcode=nl&country=All&type=265&op=Indienen#
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Transacties importeren

Procedure voor het importeren
Open via Acties → Naar boekhouding importeren → het Naar boekhouding importeren1.
dialoogvenster
Kies het bestandstype van waaruit geïmporteerd wordt (Transacties kasboek, Transacties2.
dubbel boekhouden, ...)
Met de Bladeren knop kiest u het bestand waaruit geïmporteerd wordt.3.

Meer informatie over alle typen Import filters kan gevonden worden op de Banana Extensies zoeken
pagina, onder Type is Import.

Bestandstypes die geïmporteerd kunnen worden
Transacties importeren uit een inkomsten & uitgaven boekhouding.
Om transacties te importeren vanuit een inkomsten & uitgaven boekhouding in een dubbel-
boekhouden bestand moeten de categorieën van de inkomsten & uitgaven boekhouding
overeenkomen met de rekeningen van het dubbel-boekhouden bestand.
Kasboek transacties importeren
Behalve het importeren van de transacties is het ook mogelijk een overzicht per maand of
kwartaal te krijgen.
Zie ook de pagina Gegevens van het Kasboek importeren
Dubbel boekhouden transacties importeren
Om transacties van het ene Dubbel boekhouden bestand te kunnen importeren in een ander
Dubbel boekhouden bestand moeten de rekeningen overeenkomen.
Transacties importeren Rekeningafschrift SEPA/ISO 20022 of MT940
Zie pagina Rekeningafschrift SEPA/ISO 20022
Gegevens importeren in Txt/CSV formaat
Dit formaat moet worden gebruikt voor degenen die gegevens van een andere software willen
exporteren en in Banana boekhouding willen importeren.
Zie technische aanwijzingen om een importbestand voor Banana boekhouding aan te maken
(pagina in het Engels)

https://www.banana.ch/apps/en/extensions?combine=&langcode=All&country=All&type=265&op=Submit#
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Dit bestandstype wordt gebruikt om gegevens te importeren vanuit andere programma's,
bijvoorbeeld:

importeren van maandelijkse transacties van uw salarisadministratie software
importeren van facturen die gemaakt zijn met factureringssoftware
importeren van betalingen gedaan met uw factureringssoftware
importeren van verkooptransacties van uw webshop
importeren van gegevens uit andere boekhoud software
importeren van gegevens van andere kasboek management software (bij voorbeeld van
een restaurant of een hotel).

Banana Extensies voor het importeren
Hiermee kunt u de gegevens die door een ander programma worden geëxporteerd (propriëtair
formaat) transformeren in het importformaat dat door Banana Boekhouding wordt vereist.

Banana maakt de import van verschillende andere formaten mogelijk.
Zie ook de geaktualiseerde lijst van BananaApps voor import
Het is mogelijk eigen scripts te maken die gegevens decoderen in eigen bestanden, meer
informatie vindt u hier (Engelstalig).

Keuze van de rijen die geïmporteerd moeten worden
Nadat het programma heeft uitgewerkt welke rijen geïmporteerd moeten worden laat het een
dialoogvenster zien waarin de gebruiker verdere opties kan aangeven.

Doelrekening

Deze optie is aanwezig wanneer gegevens van een bankrekening, of van transacties in tekst formaat
van een inkomsten & uitgaven boekhouding worden geïmporteerd.
Voer het rekeningnummer in uit het rekeningschema dat bij het geïmporteerde afschrift hoort.

Transacties Selecteren

Startdatum, Einddatum

Deze velden worden door het programma ingevuld uit de vroegste en laatste datum van de
transacties. Hier kan de start- en einddatum ook handmatig ingevoerd worden van de periode waaruit
de transacties overgebracht moeten worden. De periode kan ook automatisch gekozen worden via de

https://www.banana.ch/apps/nl/extensions?combine=&langcode=All&country=262&type=265&op=Indienen#
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uitklapmenu's onder de datumselectie.

Niet importeren indien dezelfde Externe verwijzing, Datum, Bedrag bestaat

Indien geactiveerd voorkomt deze functie dat de gebruiker reeds ingevoerde transacties importeert
zodat transacties niet dubbel opgeslagen worden. Deze optie kan alléén geactiveerd worden als in de
te importeren transacties de kolom Externe verwijzing ("ExternalRef") aanwezig is. Indien niet, is ze
gedesactiveerd.

Transacties op datum sorteren

Deze optie is standaard actief en hiermee worden de geïmporteerde transacties op datum gesorteerd.

Maak transacties compleet met

Waarden automatisch aanvullen

Deze optie is alleen nodig in boekhouding met BTW en vreemde valuta. Als deze actief is maakt deze
het mogelijk waarden automatisch aan te vullen die ontbreken in de geïmporteerde gegevens
(bijvoorbeeld, de wisselkoers en de wisselkoerstabel).

Initieel documentnummer

Deze optie is aanwezig als gegevens van het bankafschrift, of van een inkomen & uitgaven
boekhouding in tekst formaat, worden geïmporteerd. Dit is het documentnummer dat toegekend
wordt aan de eerste geïmporteerde transactie.

Transacties groeperen op rekeningnummer

Als het import bestand de kolom "Docinvoice" bevat, verschijnt een dialoogvenster om de
mogelijkheid aan te geven:

Transacties groeperen op rekeningnummer
In dit geval worden de rijen met hetzelfde rekeningnummer gegroepeerd op een manier zodat
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er één transactie voor dezelfde rekening en dezelfde BTW code is. Zie ook de uitleg over het
importeren van factuurgegevens (Engelstalig, "Importing invoice data").
Doelrekening voor saldiverschillen
Wanneer BTW codes worden gebruikt kunnen er afrondingsverschillen zijn van een paar centen.
In dit geval maakt Banana een extra transactie voor ieder factuur waarin dit verschil kan
worden vastgelegd. Het is natuurlijk wel nodig er aandacht aan te besteden dat de gegevens
die geïmporteerd moeten worden een evenwicht bereiken tussen debit en credit. Als dit niet het
geval is bevat de transactie het verschil tussen debet en credit.

Bewerken van geïmporteerde transacties
Het programma maakt de transacties aan en voegt ze toe aan aan het einde van de Transactietabel.
De transacties kunnen bewerkt of verwijderd worden.
In het Dubbel boehouden - kolommen Debet.Rek en Credit.Rek - en in de Inkomsten & uitgaven
boekhouding - kolommen Rekening en Categorie - voegt het programme symbolen in.
Deze symbolen moeten vervangen worden door de passende rekening of categorie.

[A]
Dit symbool wordt aangegeven wanneer er in het dialoogvenster geen doelrekening wordt
aangegeven.
Op de plaats van de [A] dient de passende bankrekening van de boekhouding ingevoerd te
worden.
[CA]
Dit symbool geeft aan dat in deze cel de tegenrekening ingevoerd dient te worden, zodat de
mutaties in Debet in evenwicht zijn met die in Credit.

Voor rijen met één enkele tegenrekening vindt men op dezelfde rij de rekening of het symbool [A]  en
het symbool CA] van de tegenrekening.
Voor de rijen met meerdere tegenrekeningen, heeft elke rij de rekening of het symbool van de
tegenrekening [CA]. Als het symbool CA niet aangegeven zou worden, zou het onmogelijk zijn te
begrijpen of het om een Debet of Credit beweging gaat.

Vaak gestelde vragen
Ik zie het formaat voor het rekeningafschrift van mijn bank niet
Klik op "Extensies beheren...", gevolgd door "Extensies bijwerken" en activeer het filter voor het
gewenste formaat.

Het volgende bericht verschijnt 'Dit ISO 20022 bestand bevat geen bankafschrift
(camt.052/053/054)'
Deze foutmelding wordt weergegeven als het ISO 20022 bestand geen bankafschrift bevat. Het ISO
20022 formaat is een algemeen formaat dat diverse soorten informatie kan bevatten, zoals het
bankafschrift en de betalingsbevestigingen in Banana Boekhouding. Alleen de bankafschriften kunnen
worden geïmporteerd (camt.052/053/054).

Mijn bank staat niet in de lijst van ondersteunde formaten
Het is mogelijk extensie3s te maken voor formaten die nog niet geïmplementeerd zijn. We hebben
ook betaalde ondersteuning voor het implementeren van aangepaste formaten.

Ik kan alleen collective opdrachten importeren en ik kan niet de details zien (de
individuele opdrachten)
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Bij het uitvoeren van een betaling in electronisch bankieren (bijvoorbeeld bij de Raiffeisen bank),
moet u de optie "individuele opdracht" kiezen in plaats van "verzamel opdracht". Alleen op die manier
kunt u de betalingen als afzonderlijke opdrachten importeren.
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Gegevens van het Kasboek importeren

Bij het doen van uw boekhouding is het mogelijk het kasboek apart te beheren met Cash Manager.
Van tijd tot tijd importeert u de transacties in het hoofd boekhoudbestand, gegroepeerd op een
geselecteerde periode.

In dit geval zijn er twee gescheiden bestanden:

Een bestand dat alle gegevens bevat van de algemene boekhouding, inclusief het kasboek.1.
Een tweede bestand dat alleen de gegevens bevat van het kasboek.2.

Om de gegevens van het kasboek te integreren in het hoofd boekhoudbestand moeten deze
bestanden verbonden worden. Dit kan op twee manieren:

Voeg aan de categorieën van het kasboek bestand dezelfde rekeningnummers (voor Dubbel
boekhouden), of dezelfde categorienummers (voor Inkomsten & Uitgaven boekhouding) toe als
gebruikt worden in het hoofd boekhoudbestand (Dubbel boekhouden of Inkomsten/Uitgaven).

Voer in de Categorie2 kolom van de Categorieën tabel de overeenkomstige rekeningnummers
in van het hoofd boekhoudbestand. Als de Categorie2 kolom niet zichtbaar is moet u deze
zichtbaar maken  Gegevens → Kolommen instellen.

Het opzetten van de interne overdrachtsrekening
Bij het importeren van de kasboek gegevens in het boekhoudbestand zijn bepaalde instellingen
vereist, zodat er geen overlappingen zijn van boekingen voor betalingsverrichtingen tussen de
kasrekening van de hoofdboekhouding en de transacties die worden geïmporteerd uit het Cash
Manager bestand.

In het hoofd boekhoudbestand:

Voeg de overdrachtsrekening in de rekeningentabel in,

In het Cash Manager bestand:

Voer in de categoriëntabel, in de kolom Categorieën in de groep Inkomsten de interne
overdrachtsrekening (hetzelfde nummer als gebruikt in de hoofdboekhouding) in als een
categorie voor betalingen van de rekening courant van de bank.
Als alternatief: voer in de categorieëntabel, in de kolom Categorieën2 in de groep
Inkomsten de interne overdrachtsrekening. In dit geval wordt aan categorie ingevoerd in de
kolom Categorieën om de betalingen van de bank vast te leggen. De interne
overdrachtsrekening, in de kolom Categorieën2 creëert de koppeling wanneer u de
transacties in het grootboek importeert.

Betalingen van de bankrekening aan de contantenrekening
Telkens al een betaling wordt gedaan van de bankrekening aan de kassa wordt de mutatie geboekt in
zowel de hoofdboekhouding als in het kasboek bestand. Om overlap van boekingen te voorkomen bij
het importeren van gegevens van het kasboek wordt het overdrachtsrekening gebruikt.
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De ontvangst van bedragen wordt geboekt in het kasboekbestand met de rekening courant als
categorie of anders de categorie voor betalingen van de bankrekening, als de rekening courant
is ingesteld in de kolom Categorie2.
De uitgaande bedragen worden geboekt in de hoofdboekhouding met de bankrekening in credit
en de interne overdrachtsrekening in debet.

Bij het importeren van de kasboekgegevens in de hoofdboekhouding wordt de rekening courant
gereset.

De kasboekgegevens importeren
Open het hoofdboekhoudbestand
Klik Acties→ Naar boekhouding importeren
Kies in het venster dat verschijnt van het uitklap menu Importeren → Transacties → Cash
Manager (* .ac2)
Gebruik de knop Bladeren om het Cash Manager bestand te selecteren.

De uitleg van dit venster is beschikbaar op de pagina Naar boekhouding importeren .

http://www.banana.ch/doc/nl/node/3328
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In boekhouding

Doelrekening

U moet het kasboek rekeningnummer selecteren dat aanwezig is in de Dubbel boekhouden of
Inkomsten / Uitgaven boekhouding waar de mutaties moeten worden geïmporteerd.

Initieel documentnummer

Een start documentnummer kan worden ingevoerd dat wordt toegekend aan de eerste geïmporteerde
transactie. In de volgende boekingen kent het programma automatisch een oplopend nummer toe,
beginnend met de startwaarde. Als u geen oplopende nummering wilt laat u het veld leeg.

Transacties selecteren

Startdatum / Einddatum

Deze velden worden door het programma ingevuld uit de vroegste en laatste datum van de
transacties. Hier kan de start- en einddatum ook handmatig ingevoerd worden van de periode waaruit
de transacties overgebracht moeten worden. De periode kan ook automatisch gekozen worden via de
uitklapmenu's onder de data selectie.

Transacties groeperen

Door de een van de opties te activeren kunt u specificeren hoe de transacties op periode moeten
worden gegroepeerd:

Niet groeperen op periode
Alle rijen worden geïmporteerd met de bijbehorende inhoud van de kolommen. Het Doc
nummer van het Kasboek wordt ook geïmporteerd.
Als u een ander nummer wilt gebruiken in de hoofd boekhouding en tegelijkertijd het
documentnummer van het Kasboek wilt behouden, voer dan in de DocProtocol kolom van het
Kasboek het documentnummer in.
Per maand - transacties worden gegroepeerd per maand
Per semester - transacties worden gegroepeerd per semester
Per kwartaal - transacties worden gegroepeerd per kwartaal
Per jaar - transacties worden gegroepeerd per jaar
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Een transactie per rekening

Deze cel moet geactiveerd worden als meer dan één categorie wordt gegroepeerd in een enkele
rekening en de gebruiker aparte transacties voor iedere categorie nodig heeft; het programma maakt
dan transacties voor iedere categorie aan. Wanneer BTW codes worden gebruikt worden transacties
niet alleen per categorie aangemaakt maar ook voor iedere BTW code in dezelfde categorie.

Let op

De berekening van de BTW kan enigsins afwijken als de gebruiker werkt met een boekhoudbestand
met BTW. De balans van contante rekening kan afwijken door afrondingsverschillen als de
transactiebedragen zijn ingevoerd als netto bedragen.

Het boekhoudbestand wordt bijgewerkt met de gegevens van het Kasboek.
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Paypal transacties importeren

Op de pagina web filter voor PayPal transacties  (Engelstalig) vind u de informatie over de nieuwe
mogelijkheid alle PayPal transacties direct in Banana Boekhouding te importeren en instructies hoe dit
uit te voeren.

We hebben ook specifieke prototypes voorbereid voor dubbel boekhouden of vreemde valuta
boekhouding die u kunt bekijken als voorbeeld of kunt gebruiken voor een apart boekhoudbestand
alleen voor PayPal transacties.

Meer informatie over import filters kan gevonden worden op de Import filters  pagina en de filter
uitleg en boekhoudbestand voorbeelden:

PayPal Import
PayPal Dubbel boekhouden model
PayPal Vreemde valuta boekhouden model

https://www.banana.ch/apps/en/node/9472
https://www.banana.ch/apps/nl/importfilters
https://www.banana.ch/apps/en/node/9472
https://www.banana.ch/apps/nl/node/5020
https://www.banana.ch/apps/en/node/5019
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Rekeningen importeren

Dit commando importeert de rekeningen van een Dubbel boekhouden of een Inkomsten & Uitgaven
boekhoudbestand (*.ac2) of een tekstbestand (*.txt) en integreert deze automatisch in het bestaande
Rekeningschema.

Ga als volgt te werk om rekeningen uit een ander bestand te importeren:

Via Acties → Naar boekhouding importeren → selecteer Rekeningen in het Importeren1.
veld.
Kies het * .ac2 of tekst bestandstype om de rekeningen te importeren.2.
Kies met de knop Bladeren het bestand waaruit u de rekeningen wilt importeren.3.

Rekeningen of de categorieën kunnen overgedragen worden naar de bestaande boekhouding door de
volgende opties te activeren:
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Opties

Kostenplaatsen opnemen

Als er kostenplaatsen zijn worden deze ook overgedragen.

Nieuwe rekeningen toevoegen

Als deze optie is geactiveerd worden alle nieuwe rekeningen toegevoegd aan het rekeningschema.

Tekstbeschrijving vervangen

Als deze optie is geactiveerd worden, als reeds bestaande rekeningen met afwijkende beschrijvingen
worden geïmporteerd, de bestaande beschrijvingen vervangen door de geïmporteerde.

Beginsaldo vervangen

Met deze optie geactiveerd worden bestaande beginsaldi vervangen door de geïmporteerde
beginsaldi van rekeningen met afwijkende beginsaldi.
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BTW-codes importeren

Deze functie is alleen beschikbaar in Boekhouden met BTW en stelt de gebruiker in staat om BTW
codes te importeren van:

Andere boekhoudbestanden (*.ac2)
Een tekstbestand met kolomkoppen (tekst file *.txt)

Importeren vanuit een boekhoudbestand
Wanneer u meerdere boekhoudingen heeft en aangepaste BTW codes gebruikt kunt u de BTW codes
tabel voorbereiden en dan deze importeren in uw andere bestanden.

Maak een BTW codes tabel aan in uw boekhoudbestand.
Commando Acties > Naar boekhouding importeren > BTW Codes.
Kies de naam van het bestand met de bijgewerkte BTW Codes tabel.
Kies alle rijen vervangen.

BTW Codes Importeren Opties
Bij het importeren vanuit een ander bestand zijn diverse opties beschikbaar.

Nieuwe codes en nieuwe groepen toevoegen

Als deze optie wordt gekozen worden nieuwe codes toegevoegd en blijven bestaande codes
behouden.

Alle regels vervangen

Als deze optie wordt gekozen worden alle bestaande BTW codes vervangen door de geïmporteerde
BTW codes.

BTW rekening niet gevonden melding
Wanneer de melding BTW rekening niet gevonden verschijnt moet de BTW rekening worden
ingevoerd via menu Bestand > Bestandseigenschappen > tabblad BTW.

Voorgedefinieerde Zwitserse BTW codes importeren
Deze procedure laat zien hoe de BTW codes vanuit het model met de standaard BTW Codes 2024, die
zowel de 2024 (BTW 8.1%) en de 2018 (BTW 7.7%) tarieven bevatten geïmporteerd moeten worden.

Zie ook de pagina over de Zwitserse BTW Codes  (Engelstalig)

Ga als volgt te werk om de BTW codes te importeren:

Klik op Acties→ Naar boekhouding importeren.
Selecteer BTW-codes.
Selecteer Zwitserland nieuwe BTW Tarieven: om het bestand dat de nieuwe BTW codes
2024 voor Zwitserland bevat te importeren. Dit bestand wordt automatisch weergegeven in het

https://www.banana.ch/area/en/node/10500
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veld Bestandsnaam. Als u de BTW codes voor een ander land wilt importeren moet u kiezen
voor het bestand met de betreffende BTW codes.
Bevestig door op OK te klikken.

 

Het volgende venster wordt getoond
 

BTW Documentatie
Voor meer informatie zie BTW beheer pagina.
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Bestand importeren
Met deze functie kunt u gegevens uit een ander Banana boekhoudbestand (met ac2 extensie) van het
zelfde type importeren.
 

Ga als volgt te werk om gegevens uit een Banana Boekhoudbestand te importeren:

Kies bestand in het veld Importeren van menu Acties→ Naar boekhouding importeren.1.
Kies het * .ac2 bestandstype om de gegevens van te importeren.2.
Gebruik de knop Bladeren om het bestand te kiezen van waaruit u de gegevens wilt3.
importeren.

Het onderstaande dialoogvenster wordt getoond met verschillende opties waarmee u kunt bepalen
welke gegevens van het bestand geïmporteerd worden



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 782

Bronbestand

Dit is het bestand waaruit de gegevens worden opgehaald.

Doelbestand

Het bestand dat de gegevens "ontvangt".

Opties

Transacties Importeren

Alle rijen van de Transacties tabel die in het bronbestand aanwezig zijn worden geïmporteerd.

Terugkerende transacties Importeren

Alle rijen van de Terugkerende Transacties tabel die in het bronbestand aanwezig zijn worden
geïmporteerd.

Budget transacties importeren

Alle rijen van de Budget tabel die in het bronbestand aanwezig zijn worden geïmporteerd.

Bedragen in de Rekeningen-tabel vervangen

De bedragen van de Opening, Budget en Vorige kolommen van de Rekeningen tabel van het
doelbestand worden verwijderd en vervangen door de bedragen die in het bronbestand aanwezig zijn.

De boekhoudingen moeten overeenkomen doordat ze de zelfde rekeningnummers hebben of doordat
er een vervanging is, in dat geval moet de optie Rekeningnummers converteren gebruikt worden.

Boekhoudingseigenschappen vervangen (basis gegevens)

De Bestand-en boekhoudingseigenschappen van het doelbestand worden vervangen door die van het
bronbestand.

Rekeningnummers converteren

Als deze functie gebruikt wordt worden de geïmporteerde rekeningnummers vervangen door de
nummers aangegeven in de alternatieve kolom. Als u deze functie gebruikt moet u ook de kolom
aangeven die de rekeningnummers bevat die gebruikt moeten worden in de import van de bestaande
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nummers.
Naast de rekeningnummer kolom moet er een kolom zijn die het alternatieve nummer aangeeft dat
gebruikt moet worden bij het importeren. Als er geen nummer wordt aangegeven wordt het
oorspronkelijke nummer van het bronbestand gebruikt.

De rekening-combinaties bevinden zich in het bronbestand
Deze optie moet worden gebruikt als u bijvoorbeeld een boekhoudbestand in een land hebt met
een specifiek nummering systeem en u moet dan regelmatig uw transactie importeren in een
afwijkend boekhoudbestand dat een rekeningschema heeft met ander nummering systeem.

U moet een nieuwe tekst kolom toevoegen in de Rekeningen tabel (Kolommen instellen
comando)
Voor iedere rekening geeft u in de tabel het nummer van het doelrekening aan.

De rekening-combinaties bevinden zich in het doelbestand
Deze optie moet gebruikt worden als u bijvoorbeeld wil overgaan naar een rekeningschema met
een nieuw nummering en groepering systeeem

U maakt een nieuw boekhoudbestand aan met het nieuwe rekeningschema.
In de Rekeningen tabel maakt u een nieuwe kolom waar u de rekening-overeenkomsten
aangeeft (Kolommen instellen comando)
In deze kolom geeft u de rekeningnummers van het bronbestand aan.
Scheid de rekeningnummers met een puntkomma "1000;1001" om aan te geven dat
meerdere rekeningen gegroepeerd moeten worden in deze rekening.

Kolom die de rekening-combinatie bevat (Rekeningen-tabel)
Geef een kolom aan van de rekeningen tabel die door de gebruiker is toegevoegd en die de
rekening-combinaties bevat.

Dit wordt gebruikt als u van het ene rekeningschema naar een ander wil overgaan en een omzetting
van de rekeningnummers nodig is.
 
Voor meer informatie over de omzetting van het rekeningschema zie de pagina over boekhouding
gegevens overzetten naar een nieuw rekeningschema.
 

Resultaten en mogelijke fouten
Het programma heeft alle gegevens van de vorige rekening overgedragen, met conversie van de
rekeningnummers.

Als het programma een fout aangeeft (ontbreken van rekeningen of iets anders) is het nodig de
import operatie te annuleren, de rekening-combinaties compleet te maken en het importeren te
herhalen.

Als het programma afwijkende rekeningschema's vindt kan het niet automatisch uitgebreide controles
uitvoeren om er voor te zorgen dat alle gegevens correct zijn geïmporteerd en gegroepeerd.

Het wordt daarom aanbevolen om de resultaten handmatig te controleren en te verifiëren dat de
Balans en de Winst en Verlies rekening echt correct zijn.

Geavanceerde import opties
Voor andere, ingewikkelder en geautomatiseerde conversies raden we aan scripts te gebruiken
waarmee een volledige aanpassing van de conversie en de import gedaan kan worden.
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Wisselkoersen importeren

Deze optie bestaat alleen in Dubbel boekhouden met vreemde valuta .

Hiermee kan de gebruiker wisselkoersen importeren vanuit een ander bestand:

Zo gaat u te werk:

Kies Wisselkoersen in het veld Importeren van menu Acties→ Naar boekhouding1.
importeren.
Kies Boekhoudingsbestand of archiefbestand wisselkoersen (* .ac2) of Tekstbestand2.
met kolomkoppen (* .txt) om de gegevens van te importeren.
Gebruik de knop Bladeren om het bestand te kiezen van waaruit u de gegevens wilt3.
importeren.

Let op:
Wisselkoers archief bestanden laten alleen de Vreemde valuta wisselkoers tabel zien en houden de
laatste wisselkoersen bij.

Een dialoogvenster met de volgende opties wordt weergegeven:

https://www.banana.ch/doc10/nl/node/2618
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Datum kiezen

Het venster laat data zien met recent gebruikte wisselkoersen. Als u een datum kiest gaat het
programma de koersen van die specifieke datum gebruiken.

Wisselkoersen vervangen

Als u deze optie activeert worden alle wisselkoersrijen in de wisselkoersentabel vervangen door de
geïmporteerde.

Rijen toevoegen

Als u deze optie activeert worden alleen de wisselkoersrijen die afwijkende waarden hebben
bijgewerkt in de wisselkoersentabel.
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Regels voor het automatisch aanvullen van
geïmporteerde transacties

Deze functie reduceert de tijd voor het doen van de boekingen en het aantal fouten drastisch. Met
deze functie verandert de manier waarop u de boekhouding doet omdat het programma de
geïmporteerde transacties aanvult met de nodige informatie (tegenrekening, BTW code,
kostenplaatsen, etc.), als de aanvullingsregels eenmaal ingesteld zijn.

Hoe het werkt

▶ Video: Geïmporteerde transacties automatisch aanvullen  (Engelstalig)

Importeer banktransacties1.
Het programma maakt rijen met transacties aan met datum, beschrijving, bedrag, rekening,
documentnummer, wisselkoersen.
Het Dialoogvenster Regels toepassen  wordt geopend2.

U ziet de transacties die automatisch worden aangevuld.
U kunt bestaande regels aanpassen of verwijderen.
Voeg nieuwe regels toe voor andere transacties.
Voer in de regel de tekst waarnaar gezocht moet worden, de tegenrekening en andere
informatie toe om de transacties aan te vullen.
Klik op de Regels toepassen knop.

In de transactietabel vindt u de transacties, compleet met tegenrekening, btw-code,3.
kostenplaats en andere informatie die u in de regels hebt aangegeven.

Eenvoudig te gebruiken

Met het voorbeeld in het dialoogvenster Regels toepassen heeft u volledige controle over de
transacties die in de transactietabel opgenomen worden.
Regels toevoegen is simpel omdat:

Het programma de regel aanmaakt door de transactiegegevens te gebruiken.
U kunt zien op welke transactie de regel wordt toegepast terwijl u de regel invoert.

Wanneer u twijfelt kunt u de bewerking annuleren en zowel het toepassen van de regel als de
import opnieuw doen.
Reeds aangemaakte regels worden opgeslagen in de tabel Terugkerende transacties en u
kunt deze aanpassen, verwijderen en nieuwe toevoegen.

Voordelen

Transacties voltooien in seconden.
U voorkomt fouten en onachtzaamheden.
Regel maken het makkelijker om het importeren door andere mensen te laten doen.

Commentaar van een van onze gebruikers:

"De automatisch aanvullen regels om banktransacties te importeren werken fantastisch!
    Boekouden was nog nooit zo eenvoudig en snel!"

https://www.banana.ch/en/node/11531
https://www.banana.ch/en/node/11531
https://www.banana.ch/en/node/11531
http://www.banana.ch/doc/nl/node/9973
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 Vereisten

Om de automatisch aanvullen regels te gebruiken moet hebben geïnstalleerd:

Banana Boekhouding Plus
Het Advanced plan

De functie leren gebruiken
Klanten die de functie hebben gebruikt zijn enthousiast en bevestigen ons dat, na een eerste fase die
nodig was om te begrijpen hoe de regels werken en hoe ze het beste kunnen worden toegepast, hun
boekhoudwerk aanzienlijk is verminderd. We stellen graag de volgende documentatie ter beschikking
om het uit te proberen en te oefenen met voorbeelden:

Introductie tot de regels
Aan de slag met het gebruik van de regels

Regels = Basis voor kennis
We hebben van klanten gehoord dat regels, naar het automatiseren van transacties, ook een basis
voor kennis worden waarin de logica vastgelegd wordt waarmee de verschillende transacties moeten
worden geboekt op de rekeningen. Behalve voor het snel en veilig aanvullen van transacties maken
regels het ook mogelijk om:

Gemakkelijk te controleren hoe bepaalde transacties moeten worden vastgelegd. U hoeft niet
meer door vorige bewerkingen te bladeren om te achterhalen hoe ze zijn uitgevoerd.
Mensen die de boekhouding moeten doen uit te leggen hoe ze verschillende transacties moeten
boeken.
Voor de auditor te definiëren hoe bepaalde transacties geboekt worden.

Automatische overdracht van regels naar een nieuw jaar
Bij het aanmaken van een nieuw jaar wordt de inhoud van de tabel terugkerende transacties
overgedragen naar het bestand van het nieuwe jaar zodat de in de regels opgeslagen kennis intact
blijft. Het is daarom ook zinvol om de regels te gebruiken voor bewerkingen die eenmaal of slechts
een paar keer per jaar voorkomen, maar die extra aandacht nodig hebben.

https://www.banana.ch/nl/download
https://www.banana.ch/nl/update
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Hoe de regels voor automatisch aanvullen
van geïmporteerde transacties werken

Het commando Regels toepassen in het menu Acties gebruikt modeltransacties uit de tabel
Terugkerende transacties om automatisch geïmporteerde bank- of creditkaarttransacties aan te
vullen.

De volgende afbeeldingen laten zien hoe de regels werken en hoe deze worden toegepast.
Het proces kan worden samengevat in twee hoofdstappen:

Het importeren van banktransacties in de transactietabel.1.
Automatische aanvulling van transacties gebaseerd op de regels.2.

Het importeren van banktransacties
Bij het importeren van gegevens van banktransacties, doet het programma het volgende:

Transactierijen aanmaken door de gegevens van de bank zoals datum, beschrijving, bedrag en
referentiegegevens over te nemen.
Vult in de transactie de rekening in van de bank waar de mutaties bijhoren die de gebruiker
heeft aangegeven in het transacties importeren dialoogvenster .

Voor mutaties met een totaal uitgaand bedrag en rijen met details van de verschillende
betalingen, waarvoor een transactie met meerdere rijen vereist is, zet het programma
over het algemeen alleen de tijdelijke tegenrekening in de detailrijen.
Echter, als de optie Regels toepassen is geactiveerd in de import dialoog vult het
programma ook de naam van bankrekening in de boekhouding tussen vierkante haken []
in (geannoteerde rekening). Deze geannoteerde rekening wordt gebruikt door de functie
regels toepassen om te weten welke rekening de bronrekening is.

Voor iedere transactie, vult het programma de tijdelijke tegenrekening in [CA] (Contra Account)
aangegeven in de transacties importeren dialoog.

Aanvullen van transacties met de regels
Geïmporteerde transacties worden automatisch aangevuld gebaseerd op regels die ingesteld zijn:

Voor het toepassen van de regels gebruikt het programma de transacties die de tijdelijke
tegenrekening bevatten.
De functie Regels toepassen vervangt de tijdelijke tegenrekening door de aangegeven
rekening en vult de transacties aan met andere waardes die in de regel aangegeven worden
(BTW, kostenplaats, etc.).
Voor transactie zonder een toepasselijke regel:

Kan een regel worden aangemaakt voor transacties die in de loop van de tijd herhaald
worden.
Kan men de transactie handmatig aanvullen.

De functie Regels toepassen stopt wanneer er geen transacties meer zijn die de tijdelijke
tegenrekening bevatten.

http://www.banana.ch/doc/nl/node/9964
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Regels
De regels zijn bestaande model transacties in de Terugkerende transactietabel, waar:

De kolom Beschrijving de tekst bevat (een of meer sleutelwoorden) die in de geïmporteerde
transactie moeten staan.
De Debet en Credit rekeningen de tegenrekeningen bevatten die de tijdelijke
tegenrekeningen vervangen.

Wanneer de beschrijving begint met "+" moeten alle woorden aanwezig zijn in de tekst van
de geïmporteerde transactie op elke positie. In het voorbeeld moet de betaling aan de
verzekeringsmaatschappij geboekt worden op verschillende rekeningen afhankelijk van het
polisnummer.

Aangevulde transacties (het resultaat)
Wanneer er waarden zijn ingevuld in de kolommen van de regel, die overeenkomen met de
geïmporteerde transacties, vervangt het commando Regels toepassen de tijdelijke tegenrekening
en vult de lege kolommen. In dit voorbeeld vult het programma transacties aan door de
tegenrekening en de BTW code in te vullen.

Als er maar één transactie overblijft, zoals in het voorbeeld, om aan te vullen kunt u deze handmatig
boeken of u kunt een speciale regel voor deze transactie aanmaken.
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Andere handmatige aanvulling
Als u, na het toepassen van de regel, transacties verder moet aanvullen of verifiëren kan het handig
zijn deze transacties goed vindbaar te maken:

Geef in de tabel Terugkerende transacties de rij met de regel een kleur. Vervolgens wordt de
kleur bij het importeren toegekend aan de geïmporteerde rij in de transactietabel.
Voer een tijdelijke waarde in in de kolom die aangevuld moet worden. 

Transacties vóór het toepassen van regels (let op de tweede)

In het voorbeeld wordt [Doc] ingevoerd in de kolom Koppeling, wat betekent dat de transactie
gekoppeld moet worden aan een documentatiebestand.

Definitie van de regel

Transacties ná het toepassen van de regel

Regels aanmaken met de dialoog Regels toepassen
Regels kunnen ook worden gemaakt vanuit de Regels toepassen dialoog.
Nadat ze aangemaakt zijn worden ze in de tabel Terugkerende Transacties geplaatst.
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Regels aanmaken vanuit een transactie
Wanneer u in de transactietabel bent kunt u een regel aanmaken:

Vanuit menu Acties > Terugkerende transacties > Regel maken op basis van
transactie
Klik met de rechtermuisknop op de transactie en kies Regel maken op basis van transactie

De transactie rij wordt toegevoegd aan de Terugkerende transactietabel, met de tekst '!Rule' in
de kolom Doc.

Transacties over meerdere rijen
Als de transactie over meerdere rijen gesplitst en geboekt moet worden is het mogelijk '!RuleSplit'
regels te maken.

Transacties vóór het toepassen van regels op meerdere rijen

Regels voor splitsen in meerdere rijen 

Transacties ná het toepassen van de regel voor splitsen in meerdere rijen
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Functies die nu nog niet beschikbaar zijn
Deze functies zijn momenteel niet beschikbaar, hoewel sommige gebruikers hierom vragen:

Mogelijkheid om de tekst van de transactie te wijzigen, in te korten en te vereenvoudigen.
Voor transacties op meerdere rijen, mogelijkheid om formules te gebruiken, die de bedragen
berekenen op basis van het bedrag van de geïmporteerde transactie.
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Aan de slag met regels voor het aanvullen
van transacties

Wanneer u de regels voor de eerste keer gebruikt gaat u als volgt te werk:

1. Geef het commando Naar boekhouding importeren
Gebruik het commando van het menu Acties → Naar boekhouding importeren →
Transacties
Selecteer het juiste formaat en geef het pad aan waar het bestand met uw banktransacties
gevonden kan worden
U ziet dit dialoogvenster verschijnen:

Vul in het Doelrekening veld het rekeningnummer uit de boekhouding in dat hoort bij de
bankrekening waarvan u aan het importeren bent.
Geef de standaard tijdelijke tegenrekening aan "[CA]".
U kunt elke rekening gebruiken, en als u deze insluit in vierkante haken, wordt er niet mee
gerekend
Activeer de Regels toepassen optie.
Bevestig met OK 
Het programma:

Maakt importtransacties
Opent de Regels toepassen dialoog.

 2. Dialoogvenster Regels toepassen
Bovenaan het dialoogvenster ziet u:

De tijdelijke tegenrekening die u in de vorige dialoog ingevoerd heeft.
De rekening voor de bankrekening die u gespecificeerd heeft.

In de secties Inkomstentransacties met regels en Uitgaventransacties met regels ziet u niets
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(want u heeft nog geen regels gedefinieerd).

In plaats daarvan ziet u wel transacties in het gedeelte:

Inkomstentransacties zonder regels
Transacties met inkomsten op de bankrekening
Uitgaventransacties zonder regels
Transacties met uitgaven van de bankrekening.

3. Nieuwe regels toevoegen
Ga op een van de transacties staan waarvoor u een nieuwe regel wilt toevoegen.
Klik met de rechtermuisknop op de regel en
Klik op Nieuwe Regel toevoegen.

De dialoog 'Regel toevoegen' wordt geopend.
Voer in:

De tekst die waarmee de regel overeen moet komen.
Voorbeeld:

Best Insurance 2021 Contract 892-948
is van toepassing op rijen die precies dezelfde tekst bevatten.
+Best Insurance 892-948
is van toepassing op rijen die de woorden "Best", "Insurance" and "892-948" op
elke positie bevatten.

De tegenrekening die gebruikt moet worden om de tijdelijke tegenrekening te vervangen.
Andere informatie (Kostenplaatsen, BTW code, etc.).
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Ga terug naar de Regels dialoog

U ziet nu een of meer gelijksoortige transacties in de sectie transacties mét regels

U ziet dat er nog transacties zijn waarop geen regels zijn toegepast.
U kunt regels aanmaken voor de transacties waarvoor u een overeenkomst ziet..
U kunt ook besluiten later regels aan te maken:

Vul de transacties handmatig aan.
Of voer het Regels toepassen commando opnieuw uit.

4. Bevestig Regels toepassen
Na het creëren van de regels, klikt u op de knop:

Regels toepassen
Het programma plaatst de nieuwe regels in de Terugkerende Transacties tabel.
Voor de geselecteerde geïmporteerde transacties vervangt het programma de
tegenrekening en vult de transacties aan.
Het dialoogvenster blijft open.

OK
Om de aangemaakte regels te bevestigen en het Regels toepassen dialoogvenster te sluiten.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 797

Veranderingen ongedaan maken

Nadat de dialoog is gesloten, ziet u de aangevulde transacties in de Transactietabel.
Als u wilt kunt u de veranderingen die u gemaakt heeft ongedaan maken:

Eerste ongedaan maken (menu Bewerken → Bewerken ongedaan maken of Ctrl+Z toets)
Maakt het schrijven van de regels en het aanvullen van de transacties ongedaan.
Tweede ongedaan maken
Maakt het importeren ongedaan.

Andere transacties met een tijdelijke tegenrekening
aanvullen
Het is de bedoeling dat, na het importeren van bank transacties, deze allemaal aangevuld worden
zodat er geen transacties meer zijn met tijdelijke tegenrekeningen.

U kunt de overblijvende transacties handmatig aanvullen.
Dit is handig voor speciale gevallen die niet de neiging hebben zich te herhalen.
U kunt nieuwe regels aanmaken:

Door het commando Acties → Terugkerende Transacties → Regels toepassen
opnieuw uit te voeren en regels aan te maken voor de overblijvende transacties.
Direct in de Terugkerende Transacties tabel en daarbij '!Rule' aan te geven in de
kolom Doc voor iedere toegevoegde regel.
In de Transactietabel kunt u nieuwe regels toevoegen met het contextmenu commando
Regel maken op basis van transactie (klik met rechts op de transactie rij) of met het
commando Acties → Terugkerende transacties → Regel maken op basis van
transactie. Nadat u de regel heeft aangemaakt moet u deze aanvullen met de gewenste
tegenrekening.

Informatie toevoegen aan met regels aangevulde
transacties
In de Transactietabel ziet u alle transacties en kunt u deze aanpassen.

Er kunnen transacties zijn waarvoor specifieke aanvullende informatie nodig is om de invoer te
voltooien, zoals het toevoegen van de link naar een boekhouddocument.
Omdat dit document uniek is voor iedere transactie is het niet mogelijk een regel hiervoor te
gebruiken.

Om snel de transacties te vinden die aangevuld moeten worden kunt u de regel aanpassen,
bijvoorbeeld:

Door de regel een aparte kleur te geven.
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Door en een specifieke kolom, bijvoorbeeld Link, een tekst zoals [DOC] in te voeren die duidelijk
maakt dat deze transactie aangevuld moet worden.
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Het dialoogvenster Regels toepassen voor
regels voor automatisch aanvullen

Het dialoogvenster Regels toepassen geeft een uitstekende controle over de veranderingen aan
boekhoudtransacties omdat het een voorbeeld van bestaande regels laat zien met een indicatie welke
transacties overeenkomen met iedere regel en welke niet. U heeft hier de optie om nieuwe regels te
creëren of bestaande regels te veranderen of te verwijderen.

De dialoog kan weergegeven worden vanuit:

De Import Transacties  dialoog, als de Regels toepassen optie is aangevinkt.
Regel worden alleen toegepast op geïmporteerde rijen.
 
Het menu Acties → Terugkerende transacties → Regels toepassen...
Regels worden dan toegepast op de hele inhoud van de transactietabel.

Dit dialoogvenster is verdeeld in drie secties:

Pas regels toe op transacties met...

Tijdelijke tegenrekening:
Dit veld is verplicht.
Hiermee worden alle geïmporteerde transacties gefilterd die deze specifieke tegenrekening
bevatten, bijvoorbeeld [CA], die werd aangegeven in de Import transacties dialoog.
Rekening:
Hiermee worden alle geïmporteerde transacties gefilterd die een specifieke rekening bevatten,
in het algemeen een bankrekening of [A], die werd aangegeven in de Import transacties
dialoog.

Het regel gebaseerde automatisch aanvullen systeem gaat er van uit dat er geen transactie meer is
met de tijdelijke tegenrekening wanneer de transacties eenmaal zijn aangevuld.

Geïmporteerde gegevens al of niet overeenkomend met regels

Deze sectie laat alle transacties zien die tijdelijke tegenrekeningen hebben zoals eerder aangegeven
bijvoorbeeld [CA]). Deze zijn gegroepeerd in vier hoofd secties:

http://www.banana.ch/doc/nl/node/9964
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Inkomstentransacties met regels
Transacties met een positieve verandering van de rekening (credit) met de aanduiding van de
regel waarmee deze overeenkomen.
Uitgaventransacties met regels
Transacties met een negatieve verandering van de rekening (debet) met de aanduiding van de
regel waarmee deze overeenkomen.
Inkomstentransacties zonder regels
Transacties met een positieve verandering van de rekening (credit) waar geen regel voor is.
Uitgaventransacties met regels
Transacties met een positieve verandering van de rekening (credit) waar geen regel voor is.

Contextuele commando's
Door met de rechtermuisknop te klikken op een transactie met of zonder regel wordt er een menu
geopend waarmee u de volgende actie kunt doen (afhankelijk van de af/aanwezigheid van een regel):

Regel toevoegen/aanpassen
Regel verwijderen
Overlappende regel aanpassen.

De commando's onderaan het dialoogvenster

Alles uitvouwen/Alles inklappen: laat transacties en regels zien of verbergt ze.
Geef ongebruikte regels weer: door deze optie aan te vinken worden alle regels van de
terugkerende transacties tabel getoond; als de optie niet actief is laat het programma alleen de
regels zien die met transacties overeenkomen.
Toon rijen zonder regels: met deze optie actief worden alle geïmporteerde transacties
getoond; als de optie niet actief is laat het programma alleen transacties zien die bij een regel
horen.
Verwijder accounts tussen [ ]: in transacties over meerdere rijen wordt de geïmporteerde
rekening tussen vierkante haken geplaatst [ ] in de detail rijen. Als deze optie actief is
verwijdert het programma de geïmporteerde rekening van de detail rijen.
Regels met transacties over meerdere rijen kunnen alleen in de Terugkerende transacties tabel
gemaakt worden.
OK: deze knop past de actieve regels toe en sluit het venster.

De tijdelijke tegenrekening wordt vervangen in alle transacties die een overeenkomst met
een regel hebben.
Nieuwe of veranderde regels worden ook opgeslagen in de terugkerende transacties
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tabel.
Annuleren: deze knop sluit het venster zonder de regels toe te passen.

Wanneer er veranderingen zijn in regels wordt u gevraagd het sluiten van het venster te
bevestigen.
U kunt met deze knop het Regels toepassen commando niet ongedaan maken; om dit
te doen moet u het venster sluiten en het commando Ongedaan maken van het menu
Bewerken gebruiken.

Regels toepassen: deze knop past de regels toe zonder het venster te sluiten.
De tijdelijke tegenrekening wordt vervangen in alle transacties die een overeenkomst met
een regel hebben.
Nieuwe of veranderde regels worden opgeslagen in de terugkerende transacties tabel.
Als u de veranderingen ongedaan wilt maken moet u het venster sluiten en het
commando Ongedaan maken van het menu Bewerken gebruiken.

Tips voor het gebruik van het Regels toepassen venster
De beste manier om met het Regels toepassen venster te werken is als volgt:

Controleer dat de regels die met transacties overeenkomen correct zijn.1.
Gebruik de knop Regels toepassen om de transactietabel bij te werken met de2.
geselecteerde regels.
Voeg nieuwe regels toe voor de overgebleven transacties en controleer of deze correct3.
toegepast worden.
Gebruik de knop Regels toepassen opnieuw.4.
Herhaal stap 3 en 4 totdat alle terugkerende transacties zijn zijn gekoppeld aan regels.5.

Terugkerende transacties tabel
Regels worden opgeslagen en kunnen aangepast worden in de terugkerende transacties tabel.

U kunt regels ook aanvullen of toevoegen met transacties over meerdere rijen in de terugkerende
transacties tabel.
In de loop van de tijd zult u zien dat meer en meer geïmporteerde transacties overeenkomsten
hebben met regels; hoe meer regels u toevoegt hoe meer uw boekhoudwerk wordt verminderd.

http://www.banana.ch/doc/nl/node/9974
http://www.banana.ch/doc/nl/node/9974
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Regels toevoegen/aanpassen

In de Regels toepassen dialoog kunt u de Regels toevoegen/aanpassen sectie als volgt open: 

Door met de rechtermuisknop te klikken op een van de transacties or regels:
Voor transacties die al een regel hebben kunt u kiezen uit Regel bewerken of Regel
verwijderen.
Voor transacties die geen regel hebben kunt u kiezen uit Nieuwe regel toevoegen.

Voorbeeld nieuwe regel toevoegen
Het volgende voorbeeld in de dialoog hierna is van een uitgaventransactie voor de betaling van een
zorgverzekering.

Om een nieuwe regel toe te voegen:

Klik met rechts op de transactie en kies Nieuwe regel toevoegen.
Het dialoogvenster Voeg nieuwe regel toe verschijnt.
Vul de benodigde velden in.
Bevestig met OK.

Nieuwe regel toevoegen dialoog
Het Nieuwe Regel dialoogvenster laat de gegevens zien van de transactie waarvoor u een regel aan
het maken bent.

Maak de regel compleet met de parameters voor de overeenkomsten (condities) en de
parameters voor de uitvoering van de regel.
Alle regels worden opgeslagen in de Terugkerende Transacties tabel (regels voor het aanvullen)

, waar u ook kunt:
Regels aanpassen, toevoegen en verwijderen.
Andere kolommen toevoegen voor het aanvullen, die niet beschikbaar zijn in dit
dialoogvenster (bijvoorbeeld kolommen voor notities of voor koppelingen naar
documenten).
De rij een kleur geven wanneer u de geïmporteerde transactie op wilt laten vallen.
Transacties over meerdere rijen toevoegen (!SplitRule in de kolom Doc).

http://www.banana.ch/doc/en/node/9974
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De Regel
Regel type.
Afhankelijk van het soort transactie, credit of debet, geeft het programma het type Geld in of
Geld uit aan de regel.
Regel titel.
Deze is optioneel en wordt weergegeven in de dialoog Regel toepassen.

Condities
Dit zijn de elementen die worden gebruikt om te controleren of er een overeenkomst is voor elke
transactie.

Er is een overeenkomst als aan alle condities wordt voldaan.
Als er een overeenkomst wordt gevonden wordt de transactie weergegeven bij de andere
transacties met overeenkomsten met deze regel.

De beschrijving

Voer in de beschrijving de tekst in waarnaar gezocht moet worden in de geïmporteerde transactie. Als
de tekst wordt gevonden wordt de transactie verder gecontroleerd om te zien of aan alle condities
wordt voldaan.

Exact woord of zin
Als u alleen Best Insurance 982-948 gebruikt als een conditie van de regel worden
alleen transacties die al deze woorden in die exacte volgorde bevatten beschouwd al
overeenkomend.
Als u alleen Insurance gebruikt als een conditie van de regel worden alle transacties die
precies dit woord bevatten beschouwd al overeenkomend.

Alle woorden (beginnend met het "+" teken)
Als u +Best Insurance 982-948 gebruikt als een conditie van de regel worden alle
transacties die exact al deze woorden op elke positie beschouwd al overeenkomend.
Alle woorden moeten aanwezig zijn in de beschrijving van de transactie.
De plaats van de woorden in de zin is niet belangrijk.
Het "+" teken wordt niet meegenomen in het zoeken.

Hoofd en kleine letters
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Bij het zoeken in de tekst wordt geen onderscheid gemaakt tussen hoofd en kleine letters.
De tekst die u invoert wordt toegepast op tekst met zowel hoofd als kleine letters.

Bedrag

Wanneer u een bedrag aangeeft in de regel worden alleen transacties met hetzelfde bedrag, en een
overeenkomst in de beschrijving beschouwd als overeenkomend.
Wanneer u geen bedrag aangeeft wordt elke transactie met elk bedrag die overeenkomt met de
andere condities beschouwd als overeenkomend.

Rekening

In dit veld vind u standaard de rekening waarvoor u de transacties heeft geïmporteerd. Wanneer u
het rekeningveld leeg laat worden alle transacties, geïmporteerd van elke rekening, die aan alle
andere voorwaarden voldoen, beschouwd als overeenkomsten.

Acties
Dit zijn de elementen die worden gebruikt om de transactierij aan te vullen als een overeenkomst is
gevonden.

Wanneer de tegenrekening of andere items die aangevuld moeten worden niet aanwezig zijn kunt u
het commando Regels toepassen annuleren, de ontbrekende rekening toevoegen en het
commando Acties > Terugkerende transacties > Regels toepassen... uitvoeren.

Tegenrekening

Voer de rekening in uw rekeningschema in die in uw regel gebruikt moet worden. In dit voorbeeld is
de correcte tegenrekening de rekening Health Insurance.

BTW

Hier kunt u de BTW code invoeren die het programma moet aanvullen in mutaties die een
overeenkomt hebben.

KP1, KP2, Kp3

Hier kunt u de kostenplaatsen invoeren die het programma moet aanvullen in mutaties die een
overeenkomt hebben.

Door met de knop OK te bevestigen wordt de nieuwe regel opgeslagen. U keert terug naar het vorige
venster waarin de geïmporteerde transacties met en zonder toegepaste regels opnieuw worden
weergegeven.

Overeenkomende transacties
Deze tabel laat alle geïmporteerde transacties zien die geselecteerd zijn in de Regels toepassen
dialoog, die horen bij deze regel.
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Knoppen
Met de knop Annuleren breekt u het toevoegen van de regel af.
Met de knop OK worden de gegevens van de regel opgeslagen.
Let erop dat 
Houd er wel rekening mee dat, zolang u de opdracht Pas regels toe niet geeft, de nieuwe
regels niet worden opgeslagen in de tabel terugkerende transacties.
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Regels in de terugkerende transacties tabel

De terugkerende transacties tabel bevat zowel gegevens voor het terughalen van opgeslagen
transacties (voor alle Banana Boekhouding Plus plannen) als alle regels, inclusief de regels
aangemaakt in het dialoogvenster Regels toepassen (alleen Advance plan). In deze tabel kunt u
bestaande regels aanpassen of nieuwe regels toevoegen. De tabel Terugkerende transacties kan
op de volgende manieren worden weergegeven:

Vanuit het menu Acties → Terugkerende transacties  → Tabel terugkerende transacties
Vanuit de transactietabel, via een transactie zonder regels door:

Menu Acties → Terugkerende transacties → Regel maken op basis van transactie
Met de rechtermuisknop te klikken en te kiezen Regel maken op basis van transactie.

De kolommen gebruikt door de regels
De tabel Terugkerende transacties definieert de regels voor het aanvullen van geïmporteerde
transacties.

Overeenkomsten kolommen 
Kolommen om overeenkomende geïmporteerd transacties te vinden in de dialoog Regels
toepassen.

Doc kolom - Alle regels moeten het woord !Rule bevatten
Kolom Beschrijving
Kolom Bedrag
Debet of Credit Rekeningen kolommen die de bankrekening of de tijdelijke
tegenrekening [CA] bevatten.
In de Inkomsten/Uitgaven boekhouding zijn dit de kolommen Rekening en Categorie.

Vervangingskolommen 
Wanneer u meer details wilt toevoegen aan een regel, die eerder was ingesteld door de dialoog
Regels toepassen te gebruiken, kunnen deze kolommen gebruikt worden bij het vervangen
van kolommen zoals  BTW Code, KP3 , notities.. .

Regels kunnen ook worden ingevoerd of aangepast via de Regels toevoegen/aanpassen dialoog.
Nadat ze toegevoegd zijn worden ze opgeslagen in de Terugkerende transacties tabel.

 Overeenkomsten kolommen

In de tabel Terugkerende transacties zijn een aantal kolommen voor overeenkomsten met regels
die door het programma gebruikt worden om te controleren of een regel toegepast moet worden op
een transactie:
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De Doc kolom

Om een regel te laten bestaan moet er een van de volgende teksten in de kolom Doc staan:

!Rule. 
Om te laten zien dat dit een regel is
!RuleSplit
Om te laten zien dat de regel transacties over meerdere rijen  aanmaakt (gesplitste rijen).

De kolom Beschrijving

De kolom Beschrijving moet de tekst bevatten waarnaar gezocht moet worden in de geïmporteerde
rijen:

Het exacte woord of zin
Als u Best Insurance 982-948 gebruikt als een conditie van de regel worden alle
transacties die precies deze zin bevatten als overeenkomend beschouwd.
Als u alleen Insurance gebruikt as een conditie van de regel worden alle transacties die
precies dit woord bevatten als overeenkomend beschouwd.

Alle woorden (beginnend met een "+")
Als u +Best Insurance 982-948 gebruikt als een condition van de regel, worden alle
transacties die deze woorden bevatten, op elke positie, beschouwd als overeenkomend.

Alle woorden moeten aanwezig zijn in de beschrijving van de transactie.
De positie van de woorden in de zin is niet van belang.
Het '+' teken wordt niet meegenomen in het zoeken.

Hoofd en kleine letters
Er wordt geen verschil gemaakt tussen hoofd en kleine letters bij het zoeken in de tekst.
De tekst die u invoert wordt gebruikt in zowel hoofd als kleine letters.
[Regel naam]
Wanneer een beschrijving begint met tekst in vierkante haken wordt deze gebruikt als de naam
van de regel. Dit wordt gebruikt voor een betere herkenbaarheid van de regels.

De Debet en Credit rekening kolommen

Wanneer de regel werd aangemaakt bij het importeren van transacties (Het dialoogvenster Regels
toepassen), bevatten de kolommen Debet of Credit gewoonlijk de rekening van de bank waarvan
de transactie werd geïmporteerd. Deze conditie is optioneel.

Als de debet of credit rekening niet is gespecificeerd wordt de regel toegepast op alle
geïmporteerde rijen die de aangegeven beschrijving of bedrag bevatten.
Als de regel wordt gevolgd door aanvullende rijen (split over multiple rows) voert u '[ ]' in om
aan te geven dat de tijdelijke tegenrekening vervangen moet worden door een lege waarde.

De kolom Bedrag

De kolom Bedrag kan een exact bedrag bevatten waarnaar gezocht moet worden in de
geïmporteerde transacties. Deze conditie is optioneel.

 Vervangingskolommen

Alle andere kolommen in de Terugkerende transacties tabel worden Vervangingskolommen
genoemd. Als een van deze kolommen een waarde bevat, wordt deze door het programma gebruikt
om de geïmporteerde transactie te voltooien, als die kolom leeg is.

http://www.banana.ch/doc/nl/node/9974#gesplitste_rijen
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Gebruik de kolom BTW Code om de BTW code aan te geven die aangevuld moet worden.
Gebruik de kolommen KP1, KP2 of KP3 om de vereiste kostenplaatsen aan te geven.
Gebruik de kolom DocLink om een notitie in te voeren om rijen aan te geven waarin een
koppeling naar een document moet worden aangegeven.

 Regels om rijen te kleuren
Het is mogelijk om in de tabel Terugkerende Transacties de rijen van de regels een persoonlijke
kleur te geven.
Iedere transactie die overeenkomt met een gekleurde regel krijgt dezelfde kleur in de
transactietabel.

 Transacties over meerdere rijen
U kunt regels aanmaken die transacties toevoegen aan de rij die verwerkt wordt. Deze functionaliteit
is handig voor het boeken van transacties op meerdere rekeningen, zoals bijvoorbeeld:

U krijgt regelmatig een betaling van 550 die geboekt moet worden op twee rekeningen en
daarom drie rijen nodig heeft:

(550) incasso van de appartementskosten (geen tegenrekening omdat dit bedrag
gesplitst moet worden over twee rekeningen)
(500) appartementshuur (tegenrekening huur)
(50) extra kosten (tegenrekening voor extra kosten).

U definieert de verdeling over meerdere rijen:

Extra rijen voor de regel moeten meteen volgen op de rij met !Rule.
De extra rijen worden direct ingevoegd na de geïmporteerde transactie die overeenkomt met
de regel.
De kolom Doc van de extra rijen moet de tekst !RuleSplit bevatten.
In de andere kolommen moet u de waarde aangeven die in de extra rijen aangevuld moeten
worden. In dit voorbeeld hebben we tegenrekeningen "Rent" en "Admin" en de bedragen 500
en 50 toegevoegd.
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Gepersonaliseerde kolommen toevoegen aan regels
Het is mogelijk in de tabel Terugkerende transacties gepersonaliseerde kolommen toe te voegen
waarin een notitie of iets anders standaard weergegeven kan worden. Iedere transactie die
overeenkomt met de regel wordt in de transactietabel getoond met dezelfde kenmerken.

Regels kopiëren van het ene naar het andere bestand
Het is mogelijk regels vanuit de tabel Terugkerende transacties te kopiëren naar een ander
Banana Boekhouding bestand.

Bij het aanmaken van een nieuw jaar worden de regels automatisch overgenomen.
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Automatisch aanvullen regels voor
inkomsten en uitgaven boekhouding

 

In de inkomsten en uitgaven boekhouding en Cash manager werkt de functie voor het aanvullen van
geïmporteerde transacties op dezelfde manier als voor het Dubbel boekhouden.

Het verschil is dat de Rekening en Categorie kolommen worden gebruikt in plaats van de Debet en
Credit rekening kolommen.

De kolom Rekening
Deze hoort bij de bankrekening.
De kolom Categorie
Hier wordt de categorie aangegeven die de automatisch ingevulde tijdelijke tegenrekening
moet vervangen.
De kolommen Inkomsten en Uitgaven
Hier wordt het betreffende bedrag aangegeven. 

De Terugkerende transacties tabel in de Inkomsten en
Uitgaven boekhouding

Als de regels bedragen bevatten worden deze ingevoerd in de kolom Inkomsten of Uitgaven:
De kolommen voor bedragen zijn de Inkomsten en Uitgaven kolommen.
Als geen bedrag is gespecificeerd wordt de regel zowel op de uitgaven als inkomsten
transacties toegepast.

https://www.banana.ch/doc/nl/rules
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De interne overdrachtsrekening

Interne overschrijving is een tegoedrekening, die wordt gebruikt om transacties met terugboeking te
boeken. Zij wordt met name in de volgende gevallen gebruikt:

Naheffings- en terugvorderingsboekingen op de aankoopbelasting (BTW op diensten in het
buitenland).
Gegevens import in de hoofdboekhouding vanuit het kasboek en creditkaarten.
Opname van de nettosalarissen die door de bank worden gedebiteerd, in afwachting van de
volledige opname van de brutosalarissen met de verschillende maandelijkse inhoudingen.

Het gebruik van de interne overdrachtsrekening bij het importeren van
gegevens vanuit het kasboek of credit kaart

Wanneer de kasboek of creditkaart mutaties in aparte bestanden worden bijgehouden wordt deze
rekening gebruikt als een tegenrekening om ervoor te zorgen dat er geen overlappende boekingen in
de import zitten van betalingen van de bank aan kas- of creditkaartrekeningen.

In het kasboek of creditkaart bestand wordt de ontvangst van gelden geboekt (het saldo van de
kasboek- of creditkaartrekening stijgt).
De uitgaven van de bankrekening en de stijging in de kasboek- of creditkaartrekening wordt
geboekt in het hoofdboekhoudingbestand.

De interne overdrachtsrekening moet worden gebruikt als een tegenrekening, zowel bij het boeken
van de opname van de bank (hoofd boekhouding) als bij de betaling vanuit het kasboek of creditkaart
(apart bestand).

Als u de kasboek of creditkaart gegevens importeert in de hoofdboekhouding wordt de interne
overboekingsrekening op nul gezet:

De geïmporteerde gegevens van de kasboek of creditkaartrekening komen in credit van de
interne overboekingsrekening.
De mutaties met betrekking tot betalingen die reeds ten laste van de bankrekening zijn
geboekt, zullen worden gecrediteerd op de interne overboekingsrekening.

Meer details over het importeren met een interne overboekingsrekening vindt u op Gegevens uit het
kasboek importeren.
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Gegevens van andere programma's ophalen

Eenmalig gegevens importeren vanuit andere programma's
met behulp van Excel
Wanneer u begint te werken met Banana en u moet uw gegevens importeren vanuit andere software
kunt u gegevens mogelijk makkelijker overbrengen vanuit elk ander boekhoudprogramma door dit via
Excel te doen.

Exporteer de gegevens met uw oude boekhoud software in een formaat dat gelezen kan1.
worden door Excel (CSV, tekst, ...)
Open het geëxporteerde bestand met Excel2.
Zet in Excel de gegevens (kolommen) in de zelfde volgorde als deze in de Banana tabellen3.
(Rekeningen, Transacties) staan
Open uw nieuwe boekhoudbestand in Banana4.
Voeg net zoveel lege rijen toe in de Rekeningen of de Transacties tabel als er in het Excel5.
bestand zitten.
Selecteer de gegevens die gekopieerd moeten worden in Excel en gebruik daar het Kopiëren6.
commando
Ga naar Banana en voer het Plakken commando uit.7.

Deze methode is handig om gegevens over te dragen vanuit MS-Money, Intuit Quicken en
Quickbooks, en vanuit de meeste andere boekhoudprogramma's.

Banktransacties importeren
In dit geval is het handig om een van de al beschikbare importfuncties te gebruiken.

Zie: Transacties importeren

Regelmatig gegevens importeren vanuit andere
programma's
Zie ook: Naar boekhouding importeren

Het kan voorkomen dat er regelmatig gegevens vanuit andere programma's geïmporteerd moeten
worden:

om maandelijkse transacties van uw salaris software te importeren
om facturen te importeren die met factureringssoftware aangemaakt zijn
om betalingen te importeren die met uw factureringssoftware aangemaakt zijn
om de verkooptransacties vanuit uw webshop te importeren
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om gegevens vanuit andere boekhoudsoftware te importeren
om gegevens vanuit een ander kasboek programma te importeren (bijvoorbeeld van een
restaurant of een hotel).

In deze gevallen kunt u twee verschillende methoden gebruiken:

verzeker u ervan dat uw applicatie de gegevens exporteert in een txt bestandsformaat dat
geschikt is om geïmporteerd te worden in Banana.
Voor meer informatie zie Developer info for importing data in Banana Accounting (Engelstalig).
maak een import script dat de gegevens, die vanuit een ander programma geëxporteerd
worden, omzet zodat deze geëxporteerd kunnen worden naar Banana:

Controleer of er al een extensie is bestaat.
Zie: Import extensions  (Engelstalig).
Maak zelf een importeer extensie.
Zie: Develop an Import Extension  (Engelstalig).

https://www.banana.ch/apps/en/node/9561
http://www.banana.ch/doc/en/node/4731
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Terugkerende transacties

Terugkerende Transacties tabel
In de terugkerende transactietabel kunt u alle transacties invoeren die elke maand herhaald worden.
Om het herschrijven van steeds weer dezelfde teksten te voorkomen is het mogelijk
transactiegroepen op te slaan in de terugkerende transactietabel. Deze groepen worden aangeduid
met een code en kunnen opgehaald en ingevoerd worden in de transactietabel door de
overeenkomstige code in te voeren.

De terugkerende transactietabel wordt geopend met menu Acties → Terugkerende transacties.

Als men dubbel klikt op de Doc kolom van de transactietabel geeft het programma de lijst van
terugkerende transacties, gegroepeerd per code.
Als één van deze codes wordt geselecteerd:

voert het programma de terugkerende rijen in die dezelfde code hebben
vult het programma de ingevoerde rijen aan met de datum en andere gegevens die eerder
ingevoerd zijn
voert het programma het volgnummer in de Doc kolom in (gebaseerd op eerder ingevoerde
gegevens).

Terugkerende transacties invoeren
Voor herhalende bewerkingen kunnen verwijzingscodes worden gemaakt voor het automatisch
ophalen van gegevens.

U moet de transactierijen die regelmatig opgehaald moeten worden invoeren in de
terugkerende transactietabel (of deze kopiëren vanuit de transactietabel).
Er moet een code worden toegekend aan iedere herhalende transactie.
Voer de code die bij de terugkerende transacties groep hoort in de Doc kolom in.
Rijen met dezelfde groep code worden samen opgehaald (transactie in meerdere rijen).

Oplopende nummering van documenten, "docnum"
Als u, tijdens het ophalen van terugkerende transacties, een Doc nummer wilt anders dan het
automatische, moet u boven de terugkerende transacties een rij aanmaken met de code "docnum" in
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de Doc kolom en de tekst die u wenst in de Beschrijving kolom. Voor de volgende rijen wordt de
tekst, gespecificeerd in de Beschrijving kolom, toegepast in de Doc kolom bij het ophalen van de
transacties.

"0" als geen automatische nummering gewenst is
"1" oplopende nummering
"kas-1" oplopende nummering met het voorvoegsel "kas-" (kas-2, kas-3)
Het programma vervangt het nummer aan het eind van de tekst door het oplopende nummer.
Als u wilt dat het programma maar één rij per code voorstelt moet de beschrijving
voorafgegaan worden door:

Een "*": laat alleen deze rij zien en niet de andere met dezelfde code.
Een "**" laat alleen deze rij zien maar haalt deze niet op (alleen titel rij).
Een "\*" laat de gebruiker de beschrijving starten met een ster zonder dat dit wordt
geïnterpreteerd als een commando.

De terugkerende transactietabel heeft niet de mogelijkheid uw eigen weergaven op te slaan maar
gebruikt de weergaven en kolominstellingen van de transactietabel.

De Terugkerende transacties naar de Transactietabel
ophalen

Voer de datum en de informatie van de andere kolommen in die niet gewijzigd moeten worden
Kies in de Doc kolom een van de codes die gedefinieerd zijn in de terugkerende
transactietabel en druk op Enter.

Het programma voert de transacties met dezelfde code in waarbij het de gegevens kolom
en andere reeds ingevoerde waardes herhaalt.
In de Doc kolom wordt een oplopend nummer ingevoerd of niets zoals gespecificeerd in
het docnum.

Of geef de code op in de Doc kolom en druk op F6.

Transactie rijen kopiëren in de terugkerende transactietabel
Om rijen vanuit de Transacties tabel te kopiëren in de terugkerende transactietabel:

Selecteer in de Transacties tabel de rijen die gekopieerd moeten worden;
menu Bewerken → Rijen kopiëren.
Ga in de Terugkerende transacties tabel staan;
menu Bewerken → Gekopieerde rijen invoegen

Kolommen en weergaven formatteren
De Terugkerende transacties tabel gebruikt hetzelfde formaat en weergave als de
transactietabel.
Het is niet mogelijk om een aparte formattering voor de Terugkerende transacties tabel te
hebben.
Het is wel mogelijk om een nieuwe weergave aan te maken en een nieuw formaat in te stellen voor
de kolommen van de Transactietabel en deze te gebruiken in de Terugkerende transacties tabel.
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Boekhouding controleren en opnieuw
berekenen

U kunt uw boekhouding op verschillende manieren herberekenen en controleren:

Met de Shift + F9 toetsen (Windows en Mac) of Cmd + 9 (Mac)
Herberekening en controle van de boekhouding (primair).
Met het commando Acties → Boekhouding controleren
Met de mogelijkheid van uitgebreide controles.
Geef de Saldo kolom weer via het menu Gegevens → Kolommen instellen.

Als er foutmeldingen zijn of verschillen moet u deze corrigeren.

Basis herberekening en controle van de boekhouding
(primair)
Het Boekhouding controleren commando controleert eerst de gebruikte versie en, indien een
bijgewerkte versie beschikbaar is, vraagt het programma u om bij te werken naar de laatste versie.
Wij raden u ten zeerste aan te updaten, aangezien veel functies zijn verbeterd en verschillende
problemen zijn opgelost.

Dit commando voert de volgende bewerkingen uit:

Het zet de saldi van de rekeningen, kostenplaatsen en segmenten op nul
Het controleert de rijen van de diverse tabellen op fouten en rapporteert deze (Rekeningen,
Transacties, BTW codes en Wisselkoersen)
Het voert alle transacties opnieuw in alsof dit voor de eerste keer gebeurt

voor de vreemde valuta boekhouding herberekent het de beginsaldi in basis valuta met
gebruikmaking van de meest recente wisselkoersen
als de transactierijen niet geblokkeerd zijn herberekent het deze

de BTW percentages uit de BTW-codes tabel worden gebruikt om de BTW bedragen
opnieuw te berekenen

het werkt de saldi bij van de rekeningen, kostenplaatsen en segmenten
in de Cash Manager wordt het cummulatieve saldo in de Transactiestabel herberekend.

Het herberekent de totalen van de Rekeningen en Categorieën tabellen (inkomsten en
uitgaven)

het werkt de kolommen Budget verschil en Vorig jaar bij.
in de vreemde valuta boekhouding werkt het de Saldo Berekend kolom bij met de
meest recente wisselkoers en de corresponderende wisselkoersafwijking.

H et Boekhouding controleren venster (uitgebreide
controle)
Naast de primaire herberekening en controle van de boekhouding worden extra controles uitgevoerd.
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Boekhouding opnieuw controleren en extra controles

Dit is een van de nuttigste functies: het hele boekhoudingbestand wordt opnieuw gecontroleerd, alle
saldi worden herberekend en de gebruiker wordt gewaarschuwd als fouten gevonden worden. Het
commando werkt ook de teksten in de kolommen Rekeningomschrijvingen en Categorieën
(Transactietabel) bij, indien deze zijn gewijzigd.

Boekhoudingseigenschappen
Deze optie staat standaard aan. het programma verifieert of de gegevens in de Bestands- en
Boekhoudingseigenschappen overeenkomen met de werkelijke boekhouding (bij voorbeeld: de begin-
en einddatum, de BTW rekening, de rekeningen voor wisselkoersverschillen, etc.).

Transacties
Verschillen binnen de transacties

Als deze optie aanstaat verifieert het programma of er verschillen zijn tussen Debet en Credit in het
Dubbel boekhouden of tussen Rekeningen en Categorieën in de Inkomsten & Uitgaven boekhouding.

De rijen waar de verschillen optreden worden aangegeven in het Meldingenvenster.
De Saldo kolom toont het verschil tussen de debet en credit beweging. Als er een fout is, gaat
het saldo niet naar nul.
Het programma laat ook het totale verschilbedrag zien in het Informatievenster onderaan het
scherm (alleen als men zich in de Transactiestabel bevindt).

Intermediaire verschillen opnemen

Als deze optie wordt geactiveerd verifieert het programma of er verschillen zijn tussen Debet en
Credit in samengestelde transacties (transacties verdeeld over meerdere rijen). Vaak worden
verschillen veroorzaakt door onvolledige invoer of fouten in de bedragen (zoals in het volgende
voorbeeld).
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Saldo controles (#CheckBalance)

Door het activeren van deze optie controleert het programma of het in de beschrijving vermelde saldo
afwijkt van het saldo van de boekhouding op de aangegeven datum.
De #CheckBalance boekingen worden gebruikt om aan te geven dat het rekeningsaldo op een
bepaalde datum juist is.
Aan het eind van de maand, het kwartaal of het jaar is het nuttig om #CheckBalance boekingen te
maken voor de kas- en bankrekeningen. De #CheckBalance boekingen zijn ook nuttig in combinatie
met het Transacties blokkeren commando. Met behulp van #CheckBalance boekingen zult u merken
of u, na het afsluiten van de periode, onjuiste boekingen hebt gemaakt.

Kenmerken van #CheckBalance boekingen:

Datum. Dit moet de datum zijn waarop het saldo betrekking heeft.
De beschrijving moet bevatten:

#CheckBalance, gevolgd door het rekeningsaldo, inclusief decimalen.
#CheckBalance -1200.00
#CheckBalance 0.00

Voor vreemde valuta boekhouding, de woorden #CheckBalance gevolgd door de valutacode en
het rekeningsaldo, inclusief decimalen.

#CheckBalance  CHF -1200.00
#CheckBalance  EUR 0.00
#CheckBalance  -1200.00 Zonder de valutacode wordt de controle uitgevoerd op basis
van het saldo in basisvaluta.

DebetRek.: de rekening aangeven die moet worden geverifieerd.
Bedrag moet leeg worden gelaten.

Het programma ontdekte een verschil tussen het verificatiesaldo en het saldo op de rekening van het
bestand.
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Zelfde document maar andere datums

Als deze optie wordt geactiveerd zal het programma waarschuwen als transacties met hetzelfde Doc
nummer een verschillende datum hebben. Bij samengestelde transacties (=transacties verdeeld over
meer dan een rij), waar geen relatie is tussen Doc nummer en Datum, kan het programma niet de
correcte tegenrekening bepalen.

Rekeningen
Structuur Rekeningschema

Als deze optie wordt geactiveerd controleert het programma of de structuur van de groepen in her
rekeningschema correct is.

Aanwezigheid van wisselkoersafwijkingen

Als deze optie wordt geactiveerd controleert het programma of er niet geboekte
wisselkoersafwijkingen zijn.

Beginsaldi verschillen van saldi van vorig jaar

Als deze optie wordt geactiveerd controleert het programma of de beginsaldi van het nieuwe jaar
overeenkomen met de eindsaldi van vorig jaar. Indien er verschillen zijn tussen de eindsaldi van het
vorige jaar en de openingssaldi van het nieuwe jaar, worden deze als een totaalbedrag in het
Berichtenvenster vermeld.

Gepersonalizeerde controles (Extensies)
Als deze optie wordt geactiveerd voert het programma controles uit op de functies die zijn
toegevoegd door de gebruiker (Extensies) voor aangepaste verificaties.

Extra controles met de sneltoetsen Shift + F9 opnemen
Als deze optie wordt geactiveerd voert het programma alle controles uit die in dit venster geactiveerd
zijn wanneer Shift+F9 ingedrukt wordt. Anders wordt alleen een boekhoudingsherberekening
gedaan. (Voor Mac: Shift + Cmd + 9).
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Saldo kolom om boekhoudkundige
verschillen op te sporen

De Saldo kolom is zeer nuttig om te zien of er verschillen in de boekhouding zijn. Bekijk de video (EN)
!

In de Transacties tabel  kunt u de Saldo kolom zichtbaar maken, via het menu Gegevens →
Kolommen instellen.

Opmerking: bij samengestelde transacties, ingevoerd op meerdere rijen, zal het programma een
verschil tussen debet en credit melden totdat de transactie is voltooid.

Hoe de saldo kolom verschillen kan opsporen
De Saldo kolom bevat het saldo van de op de Debet- en Creditrekeningen geboekte bedragen. De
waarde is het gecumuleerde verschil, berekend in de volgorde waarin de transacties zijn ingevoerd.

Het saldo is leeg (nulsaldo), als de som van de bedragen in Debet en Credit gelijk is (geen
verschil).
Voor transacties op meerdere rekeningen wordt een saldo getoond totdat de transactie op alle
betrokken rekeningen is voltooid. Bij de laatste transactie moet het saldo naar nul gaan.

Indien, na de laatste transactie op meerdere rekeningen, het saldo niet naar nul gaat,  is er
waarschijnlijk sprake van een fout om de volgende redenen:

De Debet- of Creditrekening is per vergissing blanco gelaten of is onjuist (zie voorbeeld Doc. 1
in de bovenstaande afbeelding).
Voor een transactie op verschillende rekeningen zijn de totalen van de Debet- en
Creditbedragen niet gelijk (zie voorbeeld Doc. 2 in de bovenstaande afbeelding).
In een boeking met BTW-code zijn de BTW-opsplitsing of de BTW-rekening niet correct.
Indien de BTW-code niet bestaat, worden de bedragen alleen op de debet- en creditrekening
geboekt en wordt er geen verschil getoond.

In het onderstaande voorbeeld is een verschil van 150 gegenereerd:

In de transactie werd op de rij Doc. 1 rekening 4999 ingevoerd, die in het rekeningschema niet
bestaat, zodat in de Saldo kolom op dezelfde regel een verschil van 100 werd gecreëerd.

https://www.banana.ch/en/node/11369
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In de transactie op meerdere rekeningen, op de rijen Doc 2, is het totaal betaalde bedrag
1.000, maar de laatste transactie zet het totaalbedrag (1.000) niet terug op nul tussen de
Debet- en de Creditkolom, omdat de transacties in de tegenrekening een totaalbedrag van 950
hebben; daarom is er een nog een toegevoegd verschil van 50, wat leidt tot een totaal verschil
van 150.

Controleer uw boekhouding
Zoals hierboven gezien, de Saldo kolom zal bijzonder nuttig blijken voor het identificeren van de rijen
waar boekhoudkundige verschillen zijn ontstaan tussen de Debet kolom en de Credit kolom. Als de
boekhouding correct is, moet het saldo nul zijn wanneer u een transactie op meerdere rekeningen
sluit. Zo niet, dan is er een probleem dat moet worden opgelost:

Als de Saldo kolom niet naar nul gaat, is er een probleem. Zoek de eerste rij waar het verschil
tussen Debet en Credit wordt gegenereerd.

Scroll naar beneden in de kolom om te zien op welke rij de fout werd gegenereerd en
corrigeer deze.
Als alternatief kunt u het commando Boekhouding controleren gebruiken, dat aangeeft
waar het verschil begint.

Het saldo op de laatste rij (150 in dit voorbeeld) moet overeenstemmen met het verschil Debet-
Credit dat in het Infovenster wordt getoond.

Indien deze waarden niet gelijk zijn, moet het Boekhouding controleren commando worden
gebruikt.
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Exporteren

Met Banana Boekhouding kunt u de gegevens van een enkele tabel of van een heel bestand
exporteren naar diverse formaten:

Rijen exporteren
Kies menu Gegevens > Rijen exporteren om de inhoud van een enkele tabel te exporteren.
Als u enkele rijen selecteert voordat u het commando start wordt de optie Alleen selectie
exporteren geactiveerd.

Bestand exporteren
Kies het Bestand exporteren commando van het menu Bestand om meer den één tabel te
exporteren. Na een keuze in een uitklapmenu uit het formaat voor de geëxporteerde gegevens vindt
u In het dialoogscherm dat verschijnt de volgende tabbladen:

Base, om de o.a. de naam van het exportbestand en specifieke dingen per formaat op te geven
Opnemen tabblad , om de tabellen en de rapporten te bepalen die meegenomen moeten
worden in de export
Periode , om te bepalen uit welke periode de gegevens geëxporteerd moeten worden
BTW, (in boekhoudbestanden met BTW beheer)
Compositie , om een vooraf bepaalde instellingen te gebruiken

Export formaten
Er zijn diverse bestandsformaten beschikbaar, ieder met zijn eigen specifieke instellingen.

PDF
Met dit formaat kunt u alle boekhoudbestand inhoud exporteren naar een enkel pdf bestand.
Excel
Met dit formaat kunt u Excel rekenbladen maken, vergelijkingen, begrotingen, index
berekeningen, Balans analyse, grafieken die direct verbonden zijn aan boekhoudbedragen.
HTML
Met dit formaat kunnen de gegevens en boekhoudstaten gemakkelijk benaderd worden met
een internet browser (Explorer, Mozilla, Opera).
Dit formaat voldoet volledig aan de wettelijke eisen met betrekking tot het lange termijn
archiveren van boekhoudgegevens.
XML
Dit is het standaardformaat voor het uitwisselen van gegevens. De boekhoudgegevens kunnen
makkelijk gelezen en opnieuw gebruikt worden door andere programma's of met XSLT
stijlbladen.
TXT
Met dit formaat kunt u tabelrijen exporteren naar een tekst formaat.

https://banana.ch/doc/nl/node/2601
https://banana.ch/doc/nl/node/2602
https://banana.ch/doc/nl/node/2604
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Export bestand naar Excel

Om een bestand naar Excel te exporteren klikt u op het menu Bestand → Bestand exporteren →
Exporteren naar-Excel....

Bestandsnaam

In dit veld moet men de naam van het nieuwe bestand, dat het programma aanmaakt om de
gegevens te exporteren, invoeren. Indien echter een al bestaand bestand gekozen wordt via de
Bladeren toets, overschrijft het programma het bestand met de nieuwe gegevens.

Bestand direct weergeven

Direct na het aanmaken van het MS Excel bestand wordt het programma voor de weergave ervan
geactiveerd. Op deze wijze kan men het resultaat van de export direct bekijken.

Opties
Celnamen aanmaken

Met deze optie geeft het programma automatisch een naam aan elke cel tijdens het exporteren van
het bestand. Bijvoorbeeld, de cel die het saldo van de rekening 1000 bevat, ontvangt in Excel de
naam "Accounts_1000_Balance". Dit maakt het mogelijk elke cel éénduidig te identificeren,
onafhankelijk van de plaats van de cel op het blad en zo Excel rapporten aan te maken die niet
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gecorrigeerd hoeven te worden indien het rekeningplan gewijzigd zou worden. De gebruiker hoeft dan
niet handmatig de boekhoudgegevens in Excel over te brengen.

Tabelnamen aanmaken

Met deze optie geeft het programma tijdens het exporteren van het bestand automatisch een naam
aan de hele zone van cellen die behoren tot een tabel. Bijvoorbeeld, de zone die wordt gevormd door
de cellen die behoren tot de Rekeningentabel wordt geïdentificeerd met de naam DB_Accounts. De
optie is nodig wanneer er bij het aanmaken van rapporten in Excel databank functies worden
gebruikt.

Namen in Xml gebruiken (Engels)

De celnamen kunnen gedefinieerd worden in de oorspronkelijke taal van de boekhouding of met hun
Engelse naam. In de oorspronkelijke taal zijn de namen ook begrijpelijk voor wie geen Engels kent,
maar ze hebben geen universele waarde zoals de Engelse namen.
Met deze optie krijgt men bijvoorbeeld "Accounts_1000_Balance" in plaats van
"Rekeningen_1000_Saldo".

Tabellen beveiligen

De gehele inhoud van de cellen is geblokkeerd wanneer men deze optie selecteert, zodat men alleen
het formaat ervan kan bewerken. Dit voorkomt dat men onopzettelijk veranderingen aanbrengt in de
geëxporteerde gegevens. Men kan de beveiliging te allen tijde verwijderen door het gepaste
commando in Excel te gebruiken.

Andere tabbladen

Voor de uitleg van de andere tabbladen kunt u de volgende pagina's bezoeken:

Tabblad opnemen
Periode
BTW
Aanpassing

Exporteer resultaat
Iedere boekhoudingstabel wordt weergegeven in een ander tabblad in het Excel bestand.

Gebruik de celnamen in plaats van de rij/kolom verwijzingen:

De namen geven de gewenste waarde zelfs wanneer een nieuwe rij of kolom wordt ingevoerd.
De namen zijn makkelijk te onthouden en begrijpen
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"Accounts_1000_Balance" verwijst naar het saldo (Balance) van de rekening 1000
"Accounts_1000_Description" geeft de waarde van de cel die de beschijving (Description) bevat
van de rekening 1000
De namen kunnen worden gebruikt in formules
"=Accounts_1000_Balance" geeft de waarde van de cel die het saldo van de rekening 1000
bevat
"=Accounts_1000_Balance/1000" deelt het saldo van de rekening 1000 door 1000
Door namen te gebruiken kunt u verwijzingen maken naar diverse bestanden.

Een verwijzing naar een cel bestaat uit:

Bestandsnaam
Tabelnaam
Celnaam
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Tabblad opnemen

Via Bestand → Bestand exporteren → Exporteren naar-Excel → tab Opnemen.... opent u het
dialoogvenster waarmee u de tabellen en overzichten kunt kiezen die in het exporteren opgenomen
moeten worden.

Boekhouding opnieuw controleren

Door dit selectievakje aan te vinken wordt de boekhouding opnieuw gecontroleerd voordat deze
wordt geëxporteerd.

Opnemen

Laat de tabellen en overzichten zien die geëxporteerd kunnen worden. De lijst kan anders zijn
afhankelijk van het soort bestand en boekhouding.

Weergave

Het is mogelijk de weergave te kiezen waarvandaan de gegevens geëxporteerd moeten worden. Deze
optie is beschikbaar voor het exporteren naar PDF, HTML en XML formaat.

Periodes

Deze groep laat de gebruiker de boekhoudgegevens exporteren, onderverdeeld in periodes.

Rekeningen/Categorieën op periode

Heeft betrekking op de keuze van de Boekhoudperiode en geeft aan welke herhaling per periode
gewenst is.

BTW-overzicht

Met deze optie kunt u het BTW overzicht exporteren overeenkomstig de geselecteerde periode.

Periodes voor het gehele jaar aanmaken

Door deze functie te selecteren worden de gedeeltelijke overzichten van het hele jaar geëxporteerd
en niet alleen die van de gespecificeerde boekhoud- of exporteerperiode.
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Maximum aantal periodes

Het maximum aantal periodes.
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Export bestand naar Html

Om naar HTML te exporteren klikt u op menu Bestand → Bestand exporteren → Exporteren naar
HTML.

Bestandsnaam

In dit veld moet men de naam van het nieuwe bestand, dat het programma aanmaakt om de
gegevens te exporteren, inbrengen. Indien echter een al bestaand bestand gekozen wordt via de
Bladeren toets, overschrijft het programma het bestand met de nieuwe gegevens.

Bestand direct weergeven

Direct na het aanmaken van het HTML bestand wordt het programma voor de weergave ervan
geactiveerd. Op deze wijze kan men het resultaat van de export direct bekijken. Het is goed in
gedachten te houden dat browsers zoals Mozilla en MS Explorer gebruik maken van een
cachegeheugen voor bestanden. Wanneer men voor een tweede keer een export uitvoert, is het
mogelijk dat men de vorige versie nog te zien krijgt, totdat men drukt op de knop Verversen van de
browser.

Opties voor tabelaanmaak
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Koptekst 1, 2 en 3

Dit zijn de kopteksten van de tabellen.

Andere tabbladen

Voor de uitleg van de andere tabbladen kunt u de volgende pagina's bezoeken:

Opnemen
Periode
BTW
Aanpassing
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Tabblad Html-opties

In het menu Bestand → Bestand exporteren → Exporteren naar Html → Html Opties worde het
tabblad geopend waarmee u opties kunt instellen voor het exporteren van een bestand naar HTML
formaat.

Opmaakmodel in CSS gebruiken

Door het selecteren van deze optie is het mogelijk een opmaakmodel te koppelen aan het
geëxporteerde bestand. Het programma gebruikt automatisch een eigen standaard opmaakmodel en
neemt het op in het bestand.

Vooraf gedefinieerd opmaakmodel gebruiken

Het standaard opmaakmodel van het programma wordt gebruikt. Door het deactiveren van deze
optie, wordt de optie Extern opmaakmodel automatisch geactiveerd. Hierin is het mogelijk de naam
van een persoonlijk opmaakmodel te selecteren,.

Extern opmaakmodel

Bestandsnaam

Als een extern opmaakmodel wordt gebruikt selecteer dan de bestandsnaam van dit opmaakmodel
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met de knop Bladeren.

Opmaakmodel in HTML-bestand opnemen

Wanneer de gegevens in HTML formaat verzonden worden, is het nodig ook het bestand van het
opmaakmodel te versturen. Om te voorkomen dat de twee bestanden apart verzonden worden, kan
de gebruiker het opmaakmodel aan het HTML boekhoudbestand koppelen door het activeren van
deze optie.

Door het selecteren van de opties onderaan dit tabblad, slaat het programma de gegevens op met
verschillende grafische opties:

Alleen zichtbare kolommen exporteren
Tabel met randen
Kolommen met kopteksten
Pagina-einden in de tabel behouden
Als tekst exporteren - de gegevens worden geëxporteerd zonder enige opmaak
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Export bestand naar XML

Om naar XML te exporteren klikt u op menu Bestand → Bestand exporteren → Exporteren naar
XML.

Bestandsnaam

Voer de naam van een nieuw aan te maken bestand in of kies een bestaande met de knop Bladeren.

Bestand direct weergeven

Direct na het aanmaken van het bestand wordt het programma voor de weergave ervan geactiveerd.
Op deze wijze kan men het resultaat van de export direct bekijken. Denk eraan dat browsers zoals
Mozilla en MS-Explorer een document cache mechanisme gebruiken. Als u bij een tweede keer
exporteren niet de Update knop in uw browser gebruikt ziet u mogelijk nog steeds de eerste versie.

Opmaakmodel in XSLT

In dit veld kan de men het opmaakmodel selecteren waarmee het programma de boekhoudgegevens
grafisch moet organiseren. Dankzij de opmaakmodellen is het mogelijk de eigen gegevens conform
aan de print-outs vereist door de autoriteiten weer te geven. Banana Boekhouding stelt geen XSLT
bestanden beschikbaar.
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Opties

Het is mogelijk tussen de volgende opties te kiezen:

Alleen de zichtbare kolommen exporteren
De weergavelijst opnemen
Alle gegevens exporteren

Andere tabbladen

Voor de uitleg van de andere tabbladen kunt u de volgende pagina's bezoeken:

Opnemen
Periode
Aanpassing
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Rijen naar txt exporteren

Om rijen te exporteren gebruikt u menu Gegevens → Rijen exporteren → Export rijen naar Txt.
Er zijn diverse opties beschikbaar:

Bestandsnaam

Voer de bestandsnaam in of kies een bestaand bestand met de knop Bladeren.

Bestand direct weergeven

Direct na het aanmaken van het tekst bestand wordt het programma voor de weergave ervan
geactiveerd. Op deze wijze kan men het resultaat van de export direct bekijken. Denk eraan dat
browsers zoals Mozilla en MS-Explorer een document cache mechanisme gebruiken. Als u bij een
tweede keer exporteren niet de Update knop in uw browser gebruikt ziet u mogelijk nog steeds de
eerste versie.

Opmaak

Kiest de gewenste opmaak Tekst, Ascii of CSV..

Opties

Geactiveerde opties maken de export mogelijk van:

Alleen gesecteerde rijen
Alleen zichtbare kolommen
Kolomkoptekst
Unicode (Utf-8)
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Transacties blokkeren

Banana gebruikt een digitaal certificatie systeem voor de boekhoudgegevens gebruikmakend van de
technologie die nu blockchain  (Engelstalig) genoemd wordt. Deze certificatie methode gebaseerd
op de aaneenschakeling van gegevensblokken, "blockchain", wordt als zo betrouwbaar beoordeeld
dat deze wordt gebruikt om de geldigheid van de bitcoin en alle ander moderne crypto munten vast
te stellen.

Banana.ch was het eerste bedrijf ter wereld dat de blockchain techniek in het boekhouden gebruikte.
Deze methode (US Patent No. 7,020,640 ) werd in 2002 gepatenteerd. Deze methode garandeert
hoge niveaus van gegevens integriteit en overeenstemming met internationale wetsvoorschriften.

Zie voor meer informatie, Blockchain for ensuring the integrity of accounting movements
(Engelstalig).

Het transacties blokkeren commando
Met het Transacties blokkeren commando van het menu Acties worden de boekhoudtransacties
geblokkeerd en gemarkeerd met controlecodes waarmee jarenlang gecertificeerd kan worden dat de
transacties niet veranderd zijn.

De geldigheid van een mogelijk reeds bestaande blokkering wordt geverifieerd
De transacties tot de blokkeringsdatum worden oplopend genummerd en geblokkeerd. Voor
iedere transactie worden de digitale code van de rij en de daarop volgende berekend.
De berekening van de digitale codes wordt gedaan in de volgorde van de kolommen.
In de boekhouding wordt aangegeven dat transacties met een datum eerder dan of gelijk aan
de blokkeringsdatum niet langer worden geaccepteerd.

Datum van nieuwe blokkering (inclusief)

Specificeer de datum tot wanneer de transacties worden geblokkeerd.

Wachtwoord (optioneel)

Het is mogelijk een wachtwoord in te voeren om de transacties te deblokkeren of om een nieuwe

https://www.banana.ch/en/node/11252
https://cdn.banana.ch/accounting/files/USPatent7,020,640.pdf
https://www.banana.ch/en/node/11252
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blokkering in te stellen in de toekomst.
Als het programma geen fouten vindt in de transacties binnen het blokkeringstijdvak dan blokkeert
het de transacties, berekent individuele nummers en codes en kent deze toe voor iedere rij van de
transacties, die bekeken kunnen worden in de Blokkeren weergave van de Transactietabel.

Laatste blokkering

De gegevens van de volgende velden worden automatisch ingevuld door het programma gebaseerd
op de laatst uitgevoerde blokkering.

Blokkering geldig

Een "Ja" wordt getoond als de blokkering geldig is.

Datum blokkering

De datum van de laatst uitgevoerde blokkering wordt getoond.

Nummer blokkering

Dit is de waarde die automatisch door het programma wordt ingevoerd in de laatste rij van de
Blok.Num kolom.
Wanneer de blokkering wordt herhaald en de waarde van het laatste rij blokkeringsnummer is niet
veranderd dan is blokkering geldig en zijn de gegevens niet veranderd; als echter de waarde is
veranderd laat het programma de volgende codes zien:

(-1) als de blokkering ongeldig is vanaf de eerste rij
(-2) als er rijen zijn die hetzelfde Blokkeringsnummer hebben.

Progressieve hash

Dit is de controle code die aanwezig is in de laatste transactie.

Transacties: Weergave Blokkeren
Alle digitale codes worden getoond samen met alle informatie die het programma heeft gebruikt om
de digitale handtekening aan te maken.

Blok.Num: het oplopende nummer dat de rij indentificeert
Blok.Bedr.: het cumulatieve totaal van de transacties, overeenkomstig het totaal aan het eind
van de pagina zoals vereist door sommige nationale regelgevingen
Blok.Regel (verborgen kolom): de digitale code berekend volgens de rij waardes.
Blok.Progr: de globale elektronische handtekening (SHA-256).
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De digitale code Blok.Progr

Dit is het belangrijkste element van de certificatie; het gebruikt de blockchain methode.
De digitale code wordt berekend met de volgende waardes:

De inhoud van de huidige boeking ten tijde van de blokkering, inclusief bedragen, beschrijving
en de rekeningnaam
Het oplopende nummer (Blok.Num)
Het cumulatieve saldo (Blok.Bedr.)
De progressieve code van de voorafgaande boeking (Blok.Progr).

Als de boekhoudgegevens zelfs de kleinste verandering ondergaan (bijvoorbeeld een datum of een
bedrag wordt veranderd) dan is de digitale code anders. Als het controlenummer hetzelfde blijft
betekent dit dat de gegevens origineel zijn en dus niet veranderd.

Blokkering controleren
Met het menu Acties → Transacties Blokkeren → Blokkering controleren commando verifieert
het programma de geldigheid van de blokkering en toont de blokkeringsgegevens.

Het programma herberekent de digitale controle codes en verifieert of deze overeenkomen met
de codes die betrekking hebben op de transacties.

Als de codes overeenkomen wordt de blokkering als geldig beschouwd en zijn de
gegevens dus origineel
Als deze niet overeenkomen betekent dit dat de gegevens zijn veranderd en dat dit niet
de originele gegevens zijn die berekend werden ten tijde van de blokkering.

Transacties vrijgeven
Het commando menu Acties → Transacties blokkeren → Transacties vrijgeven verwijdert de
blokkering en de controle codes. Als de blokkering werd ingesteld met een wachtwoord dan is het
nodig het wachtwoord in te voeren om de blokkering te verwijderen.
De controlenummers zullen hetzelfde zijn als die van de eerdere blokkering. als u de transacties later
weer wilt blokkeren, en ze niet veranderd zijn; de controlenummers zullen echter anders zijn als er
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gegevens veranderd zijn.

Gedeeltelijke blokkering

Het is zelfs mogelijk transacties gedeeltelijk te deblokkeren vanaf een specifieke datum. Als de
blokkering werd ingesteld met een wachtwoord dan is het nodig het wachtwoord in te voeren om de
blokkering te verwijderen.

Waarom de boekhouding deblokkeren?
In principe zou de geblokkeerde boekhouding niet moeten worden gedeblokkeerd. Het zou echter
kunnen dat u fouten vindt in de boekhouding na de blokkering en dat u het nodig vindt correcties te
maken.
Om de mogelijkheid te hebben door te gaan met veranderingen bewaarden gebruikers een kopie van
het bestand van voor de blokkering. Als ze dan fouten vonden herstelden ze de vorige situatie.
Intussen werden er misschien andere transacties gedaan waardoor het kon gebeuren dat het
herstellen van de vorige versie van de boekhouding fout ging. Om deze onnodige tijdsverspilling te
vermijden werd besloten het Transacties vrijgeven commando beschikbaar te stellen.

De certificatie moet niet verward worden met dataveiligheid. De certificatie van gegevens is een
methode die verzekert dat de boekhoudgegevens origineel zijn. Om te voorkomen dat gegevens
veranderd worden is deze methode gerelateerd aan dataveiligheid. Dataveiligheid procedures kunnen
echter alleen geïmplementeerd worden in een omgeving die de toegang tot de gegevens beperkt.

Als het bestand volledig beschikbaar is voor de gebruiker, zoals wanneer het op een PC staat, heeft
men volledige controle over de gegevens. Men kan dus bestanden gemakkelijk vervangen. Met
certificatie kan men niet voorkomen dat gegevens veranderd worden maar het maakt het wel
mogelijk dat u weet of de gegevens origineel zijn.

De persoon die de boekhouding doet is verantwoordelijk en beslist of een verandering toegestaan is.

Het organiseren van de certificatie en de gegevens
verificatie
Nadat u de transacties van de periode hebt geblokkeerd moet u:
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De blokkeringsinformatie afdrukken of de laatste gecertificeerde transactierij met zijn specifieke
certificatienummer (Blok.Progr.) afdrukken.
Deze informatie ondertekenen en opslaan in de boekhouddocumentatie of op een andere
veilige plaats.

Om te controleren dat de boekhoudgegevens de originele zijn moet u als volgt te werk gaan:

Voer het Blokkeringsinfo tonen commando uit.1.
Pak de documentatie erbij die het digitale controle getal laat zien2.
Controleer of de rij in het Blok.Num nog steeds hetzelfde digitale controlegetal heeft3.

Als het getal overeenkomt zijn de boekhoudgegevens hetzelfde als de gecertificeerde
Als het getal niet overeenkomt betekent het dat de boekhoudgegevens zijn veranderd.

Banana werkt aan de ontwikkeling van programma's waarmee twee bestanden vergeleken kunnen
worden en die een indicatie geven dat gegevens zijn veranderd.

Dataveiligheid
Digitale certificatie garandeert dat de gegevens nog steeds de originele zijn. Het voorkomt niet de
verandering van gegevens.
Het is de verantwoordelijkheid van de boekhouder ervoor te zorgen dat de gegevens niet veranderd
worden. Iedere administratie moet overeenkomstig zijn grootte en benodigdheden georganiseerd
worden.
Zij die er zeker van willen zijn dat de gegevens niet veranderd worden door onbevoegde personen
moeten andere methodes en gereedschappen toepassen zoals:

Sla de gegevens op een veilig systeem, beschermd met een wachtwoord, op (beschermde
netwerk drive).
Bewaar kopieën van de gegevens.
Versleutel archieven.

Lange termijn archivering
Het boekhoudbestand bevat de ingevoerde gegevens. Om het bestand te openen en een rapport of
een rekeningkaart weer te geven moet u het programma tot uw beschikking hebben.

Banana Boekhouding heeft de mogelijkheid om alle boekhoudgegevens te exporteren, ook de
afdrukken naar bestand, in Pdf, Html en Xml formaat.
Dit bestand kan opgeslagen worden op een CD en geopend worden op elke computer, ook na vele
jaren, zelfs door personen die niet de Banana Boekhouding software hebben.
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Dialoog - Sectie Periode

Dit tabblad verschijnt in veel dialogen (bijvoorbeeld de rekeningkaart, de balans,....) en dient ervoor
de periode, die getoond wordt of waarvoor gegevens berekend moeten worden, te beperken.
Wanneer bijvoorbeeld een kwartaal wordt geselecteerd: worden in de rekeningkaart alleen de
transacties van het geselecteerde kwartaal vertoond en in de balans worden de resultaten van het
geselecteerde kwartaal meegerekend.

Alles

Alle boekingen van de hele boekhoudperiode worden opgenomen.

Geselecteerde periode

Bepaalt een specifieke periode, aangegeven door de begin- en einddatum.

Transacties zonder datum

Als er transacties zijn zonder datum dan worden deze alleen meegenomen als u kiest voor de hele
periode met de optie Alles.
Als u echter kiest voor een specifieke periode en 1 januari en 31 december als begin- en einddatum
invoert dan worden de transacties zonder datum niet meegenomen in het rapport.
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Functies toevoegen/verwijderen

Banana Boekhouding Plus biedt de mogelijkheid om nieuwe functies aan het bestand toe te voegen.
Zie ook Toevoegen/verwijderen van functies.

Toestaan van hoofdletters en kleine letter in
rekeningnummers en codes
Wanneer de rekeningen in het rekeningschema beschrijvend zijn (bijvoorbeeld contanten) converteert
het programma standaard de lettertekens naar hoofdletters. Door deze functie te activeren staat het
programma toe dat de rekeningen zowel met hoofd- als kleine letters geschreven worden.
In de transactietabel wordt in de kolom Rekening de naam uit de rekeningentabel overgenomen.
Let op dat rekeningnamen in dit geval hoofdlettergevoelig zijn, 'Contanten' is een andere rekening
dan 'contanten'.

Items-tabel toevoegen
Informatie is te vinden in de documentatie over de Items tabel.

Kolom 'Items' toevoegen in transactietabel
Informatie is te vinden in de documentatie over Items kolommen in de transactietabel.

Items tabel en kolommen 'Items' toevoegen in de
transactietabel
Informatie is te vinden in de documentatie over Items tabel en over Items kolommen toevoegen in de
transactietabel.

http://www.banana.ch/doc/nl/node/9129
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Adreskolommen toevoegen in de rekeningentabel
Voor boekhoudbestanden.

Met deze functie kunt u kolommen toevoegen aan de rekeningentabel voor het invoeren van de
adressen van klanten, leveranciers, leden of anderen.

Ga als volgt te werk om deze functie toe te voegen:

Klik op menu Extra
Kies het Functies toevoegen/verwijderen... commando
Kies Adreskolommen toevoegen in de rekeningentabel. (Als deze functie niet wordt
weergegeven betekent dit dat deze al is geactiveerd).

Het programma voegt in de rekeningentabel toe:

De Adres weergave waarin de toegevoegde kolommen zichtbaar zijn.
De kolommen waarin u adresgegevens en andere informatie kunt invoeren.

Om deze kolommen ook in andere weergaven zichtbaar te maken gebruikt u het
Kolommen instellen commando van het menu Gegevens.
Om andere weergaven te maken met specifieke kolommen gebruikt u het commando
Tabellen instellen van het menu Gegevens.

Budget tabel toevoegen
Met deze functie geactiveerd kan in het boekhoudbestand financiële planning gedaan worden doordat
de budgettabel toegevoegd wordt waarin u budgettransacties kunt invoeren.

Zie voor meer informatie de pagina Budget tabel .

Bewerkbare kolom BTW bedrag type in transactietabel
instellen
In boekhoudbestanden met BTW kan met deze functie de kolom Bedragtype (BTW bedrag type)
veranderbaar gemaakt worden.

In deze kolom kunt u, indien nodig, een van de volgende BTW bedrag types invoeren voor iedere
transactie:

0 (of lege cel) = bedrag is inclusief BTW
1 = bedrag is inclusief BTW
2 = BTW bedrag, het bedrag wordt beschouwd als het BTW bedrag
Het programma vult automatisch de standaardgegevens in vanuit de BTW code tabel (voor
iedere code) in de kolom Bedragtype. Als bij uitzondering het bedrag anders is voor een BTW
code kan 1 of 2 handmatig worden ingevoerd.

Let op

Door deze functie te gebruiken ontstaat er enige BTW gegevens incompatibiliteit met vorige versies
die deze functie niet hebben.

http://www.banana.ch/doc/nl/node/9313
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Banana Boekhouding+ grafieken

In Banana Boekhouding Plus is na het openen van een bestand onderaan het scherm het venster
Grafieken beschikbaar, dat een grafische voorstelling biedt van de prestaties van een geselecteerde
rekening, groep, kostenplaats of segment.

De grafiek toont de gegevens van de rekening of een ander geselecteerd item in een tabel, volgens
de instellingen die in het rechter paneel kunnen worden gekozen:

Door de cursor op de curve of balk van de grafiek te plaatsen worden de exacte waarden van
de bedragen getoond.
Door te klikken op een punt in de grafiek wordt de overeenkomstige rekeningentabel geopend
op de bijbehorende positie.

Controle Paneel
In het paneel aan de rechterkant kunnen van de grafiek de weer te geven gegevens en periode, en de
manier van weergeven, geselecteerd worden en het afdrukken of opslaan gestart worden.

Als de controle elementen door de grootte van het venster niet kunnen worden weergegeven worden
alleen de elementen die voor de legenda nodig zijn weergegeven. Om alle controle elementen weer
te geven moet de afmeting van het hoofdvenster van het programma of van het grafiekenvenster
aangepast worden.

Gegevens die weergegeven kunnen worden

De volgende boekhoudgegevens kunnen individueel of tegelijkertijd in de grafieken worden
weergegeven:

Huidig - de actuele gegevens worden getoond.
Budget - de gebudgetteerde gegevens worden getoond.
Vorige - de gegevens van vorig jaar worden getoond.

De betreffende gegevens worden getoond of verborgen door te klikken op de naam (Huidig, Budget of
Vorig).



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 845

Legenda

De optie Legenda optie bepaalt of de weergave van de legenda in het grafieken venster verborgen
wordt. Gewoonlijk is deze verborgen maar u kunt deze weergeven wanneer u de grafiek wilt
afdrukken of opslaan.

Uit - De grafiek heeft geen legenda.
Onderkant - De legenda wordt midden onder de grafiek weergegeven.
Links - De legenda wordt links onderaan weergegeven.
Bovenkant - De legenda wordt boven de grafiek weergegeven in het midden.
Rechts - De legenda wordt rechts onderaan weergegeven.

Periode

De periode in jaren waarvan de gegevens getoond moeten worden.

    1Y, 2Y, 3Y, 4Y, Y (Y geeft jaren aan).

Interval

De ruimte tussen iedere waarde in de as van grafiek kan worden aangepast met de volgende opties:

1D (dag), 1W (week), 1M (maand), 3M (kwartaal), 6M (semester), 1Y (jaar).

Waarde

De grafiek kan het boekhoudsaldo aan het einde van de periode of de financiële mutatie voor de
periode weergeven. Afhankelijk van de gekozen waarde wordt de weergegeven datum
dienovereenkomstig aangepast:

Saldo - de grafiek toont het saldo aan het eind van de periode (bijvoorbeeld 31 jan '22 -
einddatum van de periode).
Mutatie - de grafiek toont de financiële ontwikkeling van de periode (bijvoorbeeld 31 jan '22 -
einddatum van de periode).
Automatisch - de grafiek geeft het saldo voor balansrekeningen weer en voor KP3, en de
financiële ontwikkeling van de inkomsten rekeningen, KP1, KP2 en de segmenten.

Type

De grafiek kan gegevens weergeven op de volgende manieren:

Lijn - de grafiek wordt weergegeven als een lijn.
Area - de grafiek wordt weergegeven als een opgevulde lijn..
Staaf - de grafiek wordt weergegeven als staven.
Auto - de grafiek wordt weergegeven als area voor balansrekeningen en KP3, en als staven voor
inkomsten rekeningen, KP1, KP2 en segmenten.

Afdrukken, Opslaan of de grafiek kopiëren

Deze mogelijkheid bestaat alleen in het Advanced plan van Banana Boekhouding Plus .

https://www.banana.ch/nl/advanced
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Door in de rechterbovenhoek van het grafiekenvenster te klikken op het symbool Kopiëren verschijnt
een menu met de volgende commando's:

Afdrukken - Geeft de voorbeeldweergave van de grafiek.
Opslaan - Slaat de grafiek op als een PNG bestand.
Kopie - Kopieert de grafiek naar het klembord als PNG plaatje. De gekopieerde afbeelding kan in
elke tekstverwerker geplakt worden (Word, Excel, ...).
Gegevens kopiëren - Kopieert de gegevens die gebruikt zijn om de grafiek te maken naar een
tabel die in elke spreadsheet geplakt kan worden (Excel, Numbers, ...).
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Productiviteitstoepassingen

De Banana productiviteitstoepassingen vullen de boekhoudtoepassingen van een bedrijf aan voor het
beheren van alle andere functies buiten de boekhouding. Alles wordt gedaan op een eenvoudige
snelle manier met een direct en professioneel resultaat.

De productiviteitstoepassingen zijn onafhankelijk van de boekhouding alhoewel er functies en
extensies zijn die gecombineerd kunnen worden met het boekhoudbestand om overzichten te maken
en gegevens in het boekhoudbestand te importeren.

Banana Boekhouding Plus heeft de volgende productiviteitstoepassingen:

Offertes en facturen gescheiden van de boekhouding: voor het beheer van offertes en facturen.
Inventaris: voor het beheer van voorraden of inventaris.
Time sheet: om de uren en de gewerkte tijd te registreren.
Register Aktiva: hiermee kunt u de afschrijfbare goederen beheren.
Adresboek: voor het beheren van adressen en etiketten.
Bibliotheek en collecties voor het beheren van boeken of andere objecten (bijvoorbeeld
kunstverzamelingen, juwelen, ...).
Eenvoudige tabel: hiermee kunt u een gepersonaliseerde tabel aanmaken.

Nuttige extra functies voor de productiviteitstoepassingen
De volgende commando's zijn erg handig wanneer ze in deze toepassingen gebruikt worden:

Rijen ophalen en sorteren
Om lijsten van bestaande gegevens aan te maken.
Afdrukken Etiketten
Om etiketten voor adressen of artikelen aan te maken
Nieuwe functies toevoegen

Een nieuwe documenten tabel toevoegen (aanhang aan de balans...)
Een nieuwe eenvoudige tabel toevoegen

Extensies menu
Om gepersonaliseerde rapporten, berekeningen of andere dingen aan te maken.
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Koppeling tussen tabellen
U kunt, met het veld Id, een koppeling aanmaken tussen een veld van de ene tabel en een andere
tabel.
Bijvoorbeeld:

Voeg een nieuwe eenvoudige tabel toe "Projecten" genaamd
Geef in de Id kolom een projectnaam aan en in de kolom beschrijving een korte uitleg.

Voeg in een andere Eenvoudige tabel, de volgende tekstkolommen toe:
ProjectenId (de tabelnaam plus "Id")
Als u in de edit-modus gaat wordt een lijst van beschikbare projecten getoond.
ProjectenBeschrijving (de tabelnaam plus "Beschrijving")
Deze kolom moet beveiligd zijn.
Als u de ProjectenId inhoud verandert wordt de tekst van de beschrijving getoond.

Als u een kolom toevoegt doe dan een controle van de boekhouding of sluit het bestand
en heropen het om de verbinding te activeren.
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Offertes en facturen gescheiden van de
boekhouding

Onderdeel van Banana Boekhouding Plus is een Offertes en Facturen applicatie die zorgt voor het
snel aanmaken, afdrukken en beheer van offertes en facturen. Ideaal ter vervanging van Excel bij het
opstellen van facturen, waarbij u zonder extra kosten overschakelt op een professioneel hulpmiddel.

De applicatie Offertes en Facturen staat los van het boekhoudbestand. Er kunnen geen gegevens mee
worden geïmporteerd in het boekhoudbestand.

Als alternatief voor deze applicatie kunt u gebruik maken van de Geïntegreerde facturatie, waarmee u
de factuurgegevens rechtstreeks in het boekhoudbestand kunt opnemen, zodat u de verzonden
facturen niet hoeft te registreren.

Bekijk de video's (Engelstalig):

▶ Video Hoe te beginnen met offertes en facturen (EN) .
▶ Video Facturen met QR codes in 3 stappen (EN) .
Karakteristieken van Offertes en Facturen.

Offertes en facturen in één oogopslag
Offertes en facturen afdrukken
Facturen aanmaken met een QR code voor Zwitserland
Facturen en offertes aanpassen en dupliceren
Uitstaande facturen bekijken
Facturen archiveren

Om de facturatieapplicatie te gebruiken moet u Banana Boekhouding Plus  downloaden en
installeren, en bij het aanmaken van een nieuw bestand kiest u er een van het type Offertes en
Facturen.

http://www.banana.ch/en/node/11399
https://www.banana.ch/en/node/11510
https://www.banana.ch/nl/node/11181
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Logo
U kunt een gepersonaliseerd logo
gebruiken.
Menu Bestand → Logo-instelling...

 

Koptekst
De koptekst van de factuur is
identiek aan de tekst ingevoerd
in
Menu Bestand → Bestands- en
boekhoudingseigenschappen... →
Adres tab

 

Klantenadres
Het adres van de klant wordt
opgehaald uit de  Contactentabel,
waarin u de adressen van de
klanten opslaat.

 

Factuurgegevens
De inhoud van de factuur moet
ingevoerd worden in het nieuwe
dialoogvenster voor het
aanmaken / aanpassen van een
factuur.
Menu Facturen → Nieuwe factuur

 
Vrije tekst aan het eind
U kunt de de titel, begintekst en
eindopmerkingen definiëren
vanuit de Factuur dialoog

 

Zwitserse QR-Code
De instellingen voor het
automatisch aanmaken van de
QR betalingsstrook kunnen alleen
voor Zwitserland gedefinieerd
worden met alleen de extensie
Formaat met Zwitserse QR code

[CH10] (Engelstalig)

Hoe te beginnen
De stappen om facturen aan te maken zijn de volgende:

Download het factuur model.1.
Voer uw gegevens in.2.
Voer de contact (klant) gegevens in.3.
Voer de factuurgegevens in.4.
Druk de facturen af.5.

Voor meer informatie, bezoekt u de pagina Hoe facturen aan te passen.

Andere functies:

Herinneringen afdrukken
Aflevernota's afdrukken

https://www.banana.ch/apps/en/node/9338
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Karakteristieken van Offertes en Facturen

In Banana Boekhouding Plus  is de nieuwe Offertes en Facturen applicatie opgenomen. Het maken
en afdrukken van offertes en facturen wordt eenvoudig en snel.

Om te beginnen download u de Free Plan versie . U kunt tot een maximum van 20 facturen and 20
offertes invoeren.

Met het jaarabonnement  kunt u een onbeperkt aantal offertes en facturen toevoegen.

Hoe zet u offertes en facturen op
Om offertes en facturen te maken stelt u uw klantgegevens in, goederen of diensten die gefactureerd
moeten woden, eenheidsprijzen en BTW percentages, en het programma doet de rest.

Er zijn veel dingen geautomatiseerd om uw werk eenvoudig te maken en met direct professioneel
resultaat.

Automatisch ophalen van addressen van contacten zodat deze niet opnieuw in de factuur
hoeven worden ingevoerd.
Gegevens importeren vanuit SmallInvoice met een speciale Banana extensie .
Geen handmatige berekeningen. Alle berekeningen gaan automatisch, altijd accuraat en
bijgewerkt.
Gedetailleerde offertes die eenvoudig kunnen worden omgezet in facturen en naar klanten
gestuurd.
Facturen met QR code voor Zwitserland.
Voor iedere factuur kunnen taal, munteenheid, aantal decimalen en afronding worden ingesteld.
Facturen die al naar de klant gestuurd zijn veranderen en/of dupliceren. U hoeft alleen maar
hoeveelheden toe te voegen en de nieuwe factuur is klaar om verzonden te worden.
Aantekeningen voor memo's of iets anders.
Betalingsdatum om bonnen te controleren.
Bekijken van achterstallige facturen om vervaldata te controleren.
Opslaan als PDF en afdrukken op papier.
Archivering van facturen om een overzichtelijke historie te hebben, klaar voor eventuele fiscale
controles.
Nachtmodus op Mac en Windows.

Excel-achtige functies

Voeg zoveel rijen toe als u wilt, of verwijder de rijen die u niet nodig hebt.
U hoeft geen formules in te voeren omdat de berekeningen onmiddellijk worden bijgewerkt en u
een contextuele weergave hebt (zoals in spreadsheets).
De kolommen zijn aanpasbaar, u kunt hun positie veranderen, nieuwe toevoegen en hun
breedte wijzigen..
Werk met het formaat dat u het beste uitkomt.
Geef de rijen een kleur om onmiddellijk de openstaande facturen te identificeren of voor andere
doeleinden.

https://www.banana.ch/nl/download
https://www.banana.ch/nl/buy
https://www.banana.ch/nl/buy
https://www.banana.ch/apps/en/node/9490
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Gebaseerd op spreadsheets
De offerte- en factureringstoepassing is gebaseerd op verschillende tabellen, die op dezelfde manier
worden gebruikt als die van Excel, maar die al volledig zijn ingesteld en geprogrammeerd met alles
wat nodig is om uw goederen op een snelle en veilige manier te beheren.

Tabel Contacten
Dit is de tabel waarin klantgegevens nauwkeurig en overzichtelijk kunnen worden
geregistreerd. De gegevens kunnen altijd worden bijgewerkt en gewijzigd.
Items tabel
Dit is de tabel waarin de gegevens voor het beheer van de te factureren artikelen of diensten
worden ingevoegd. Door een ID toe te kennen kunnen de verschillende categorieën van te
factureren artikelen of diensten worden gegroepeerd. U voert de hoeveelheden, de
eenheidsprijs en de referentierekening in de boekhouding in. Er zijn ook kolommen beschikbaar
voor het invoeren van de datum van binnenkomst en uitgifte van de goederen en voor
aantekeningen.
Facturentabel
Deze tabel dient om de te factureren artikelen in te voeren. Het is de meest geautomatiseerde
tabel.:

Automatische invoer van het adres van de klant door eenvoudigweg de contact-ID van de
klant te gebruiken.
Factuurgegevens worden automatisch opgehaald: door dubbel te klikken op de cel in de
kolom Totalen opent een factuur dialoog  waarin u alle gegevens vindt die in de andere
kolommen van de factuurtabel ingevoerd zijn (klantadres, datum en factuurnummer,
verwijzing, ordernummer, eenheidsprijs, BTW percentage en andere mogelijke gegevens).
Voer gewoon de hoeveelheden in en de factuur is klaar. Hij kan worden opgeslagen als
PDF of afgedrukt op papier.

Tabel Offertes
De offertegegevens worden ingevoerd. Deze tabel is volledig gelijk aan de tabel Facturen, met
dezelfde functies, berekeningen en afdrukmethoden, uiteraard met een andere benaming.
Offertes kunnen op elk moment worden omgezet in facturen, waarbij de gegevens automatisch
worden overgenomen op de factuur, die onmiddellijk kan worden opgeslagen, afgedrukt en
naar de klant gestuurd.
BTW codes tabel
Voor het opstellen van facturen worden BTW-codes ingesteld. Bij het opstellen van de facturen
worden zowel de tarieven als de berekeningen automatisch overgenomen. De tarieven kunnen
worden aangepast als de geldende regelgeving verandert.

Instellen van de boekhouding
Rubrieken en basisgegevens van offertes en facturen ingesteld in één enkel dialoogvenster, dat
hierdoor gemakkelijk is weer te geven.

Kopteksten met eigen tekst
Adres met alle bedrijfsgegevens
Koppeling naar bestaande of aangepaste extensies
Wachtwoordbeveiliging van uw offerte en factuur
U kunt meerdere offertes en facturen maken in verschillende talen.

http://www.banana.ch/doc/nl/node/9763
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Bestands- en gegevensopslag
Al uw gegevens worden opgeslagen in een enkel bestand, waarin u alles gemakkelijk kunt
terugvinden zonder tijd te verliezen.
Geef het bestand een zelf gekozen naam.
U kunt een onbeperkt aantal bestanden beheren.
Gegevens opslaan op elk medium, computer, netwerk, cloud of verzenden per e-mail . U heeft
er toegang toe waar je ook bent.
Gelijktijdige toegang door meerdere gebruikers, waarbij echter slechts één persoon het bestand
kan openen om het te bewerken.
Maak uw boekhouding veiliger door wachtwoordbeveiliging te gebruiken.

Verwerking van offertes en facturen
In de kolommen ziet u de bedragen in het formaat dat uw computer gebruikt.
U kiest zelf de identificatiecode van het artikel (numeriek of alfanumeriek, maximaal 256
tekens).
Saldo, mutaties van artikelen en totalen worden tegelijkertijd weergegeven en altijd bijgewerkt.
In de kolom Koppelingen van de tabel Items kunt u een digitale koppeling voor het
geregistreerde item toevoegen.
In alle tabellen heeft u de beschikking over kolommen die u naar keuze zichtbaar kunt maken.
Met het commando Zoeken kunt u snel factuur- en offertegegevens vinden .
Met het commando Vervangen kunt u automatisch teksten of andere gegevens vervangen in
tabellen .
U kunt regels sorteren volgens verschillende sorteer sleutels .
Exporteren naar PDF formaat voor archivering.
Exporteren naar andere formaten voor gegevens nabewerking.
Gegevens importeren vanuit andere programma's in Tekst, Ascii en CSV formaat .
Gegevens importeren vanuit SmallInvoice  (Engelstalig).

Foutmeldingen en -afhandeling
Command to quickly check accounting.
Melding van iedere verkeerde instelling of fouten.
Iedere melding is gekoppeld aan een help pagina die de oorzaken en oplossingen uitlegt.
Mogelijkheid om op elk moment te corrigeren.

Afdrukken en overzichten
Factuur afdrukken met QR code (voor Zwitserland)
Factuur afdrukken voor alle andere landen .
Factuur op papier afdrukken of in PDF formaat.
Gebruik uw eigen logo in de afdrukken van de facturen.
Overzicht uitstaande facturen.
Op de Factuur afdrukken aanpassen  pagina vindt u alle informatie over het afdrukken en de
instellingen daarvoor.
De afdruk van offertes en facturen aanpassen naar eigen wens.

Met Banana Boekhouding Professional kunt u de standaard instellingen gebruiken en het
afdrukken van offertes en facturen naar wens aanpassen .
Met Banana Boekhouding Advanced kunt u niet alleen het afdrukken van offertes en

https://www.banana.ch/nl/node/11059
http://www.banana.ch/doc/nl/node/2671
http://www.banana.ch/doc/nl/node/2672
http://www.banana.ch/doc/nl/node/2672
http://www.banana.ch/doc/nl/node/2676
http://www.banana.ch/doc/nl/node/3903
https://www.banana.ch/apps/nl/node/9490
https://www.banana.ch/apps/nl/node/9338
http://www.banana.ch/apps/nl/node/9423
http://www.banana.ch/doc/nl/node/9891
http://www.banana.ch/apps/nl/node/9338#personalizzazione_della_stampa_fatture
http://www.banana.ch/apps/nl/node/9338#personalizzazione_della_stampa_fatture
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facturen naar wens aanpassen maar ook extra aanpassingen toevoegen.

Gegevens exporteren en opslaan
Direct vanuit en naar Excel kopiëren.
Exporteer tabellen naar pdf en diverse andere formaten.
Archivering van afdrukken en gegevens naar pdf en diverse andere formaten.
Boekhoudbestanden opslaan op elk medium.

Uitgebreide documentatie
Voortdurend bijgewerkte documentatie voor de offertes en facturen applicatie .
Banana Boekhouding Plus documentatie.
Banana Boekhouding Plus vragen en antwoorden .
Documentatie ook beschikbaar in PDF formaat.

Overzicht van updates
De applicatie Offertes en Facturen wordt voortdurend bijgewerkt en verbeterd.

Zie voor meer details de pagina Versie overzicht van de extensie Offertes en Facturen .

Functie die alleen met het Advanced plan beschikbaar zijn
De korting instellen voor ieder artikel, zowel als een percentage als een eindbedrag.
De datum waarop de service plaatsvond voor ieder item.
Toevoegen van velden aan de factuur voor specifieke extra informatie (project, extra
referenties, etc...).
Aflevernota's afdrukken met of zonder bedragen.
Betalingsherinneringen afdrukken met of zonder Zwitserse QR code
Een tussentotaal toevoegen (Banana Boekhouding+ 10.1.8 of nieuwer)

Enkele aanpassingen van het afdrukformaat CH10 en UNI11 zijn alleen beschikbaar met Banana
Boekhouding Advanced.

Functie die nog niet beschikbaar zijn
De applicatie Offertes en facturen is een van de laatste toevoegingen aan de familie en ondersteunt
momenteel de essentiële functies voor het opstellen en afdrukken van offertes en facturen. De
volgende functies worden nog niet ondersteund:

Het is niet mogelijk factuurgegevens te importeren in het boekhoudbestand.
Verbinding met de applicatie Inventory.
Exporteren van individuele factuurgegevens.
Meer dan één factuur per keer afdrukken.
Geautomatiseerde verzending van facturen per e-mail.
Extra kolommen toevoegen in de factuurgegevens.
Een korting voor een enkel contact instellen.
Een reeks facturen aanmaken.
QR-Code betalingen importeren.

https://www.banana.ch/doc/nl/documentatie
https://www.banana.ch/nl/node/9340
http://www.banana.ch/doc/nl/node/9935
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Een betalingsherinnering versturen.
Adressen afdrukken (etiketten).
Nieuw jaar aanmaken.
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Zo begint u met een factuur

Om de facturatieapplicatie te gebruiken moet u Banana Boekhouding Plus  gedownload en
geïnstalleerd hebben.

Om snel en eenvoudig op gang te komen adviseren we het gebruik van één van onze modellen.

Een facturatiebestand aanmaken
Maak als volgt een facturatiebestand aan met een bestaand model of door een leeg bestand te
gebruiken:

Menu Bestand → Nieuw.
Kies Gebied / taal.
Als Type, kiest u Ramingen en Facturen.
Aan de rechterkant kiest u het gewenste model.
Dubbelklik op de naam van het model of klik op de knop Aanmaken. Het programma opent het
gekozen bestand meteen.
Sla het bestand onder een zelfgekozen naam op.

Basisgegevens invoeren
Via Bestand → Bestands- en boekhoudingseigenschappen... → tabblad Adres, voert u het adres
van uw bedrijf in, dat dan in de kop van de factuur wordt opgenomen.
Als u een logo wilt gebruiken kijkt u op de pagina Logo instelling.

Een nieuwe factuur aanmaken
Via de dialoog Facturen → Nieuwe Factuur ... maakt u een nieuwe factuur aan.

https://www.banana.ch/en/node/11181
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Voer de basisinformatie van de factuur in (factuurnummer, datum, object, begintekst en1.
eindtekst).
Voer het adres van de rekening in (klantadres).2.
Voer de detailgegevens van de factuur in (product, beschrijving, hoeveelheid, bedrag).3.
Controleer sub- en eindtotalen en voer eventuele kortingen in.4.
Voer in Instellingen enkele basis parameters van de factuur in (munteenheid, aantal getallen5.
achter de komma, afronding, betalingstermijn en BTW gegevens).
Sla de factuur op en/of druk deze af.6.

Een factuur afdrukken
Met het menu Facturen → Factuur afdrukken, of door op Afdrukken te klikken in de dialoog voor het
aanmaken of wijzigen van een factuur kunt u het venster voor het afdrukken van de factuur bereiken.

Op de pagina Offertes en Facturen afdrukken vindt u informatie over hoe u facturen aanpast en
afdrukt.

De Tabellen
Het factuurbestand bestaat uit de volgende tabellen:

Contactentabel waarin de klantadressen worden ingevoerd.
Itemstabel waarin de gegevens voor het beheren van de artikelen en het magazijn worden
ingevoerd.
Facturentabel waarin alle gegevens die bij de facturen horen worden ingevoerd.
Offertes tabel waarin alle gegevens die bij offertes horen worden ingevoerd.
BTW Codes tabel waarin de BTW codes met bijbehorende percentages worden ingevoerd.
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Tabel Contacten

In de tabel Contacten staan de kolommen waarin u de adressen van de klanten kunt invoeren.

Contactgegevens zijn hierdoor direct beschikbaar in het dialoogvenster facturen bij het aanmaken of
veranderen van de factuur waardoor gegevensinvoer eenvoudiger is.

De gegevens in bestaande facturen en offertes veranderen niet als u iets in de tabel Contacten
verandert. Als u wilt dat een bestaande factuur of offerte bijgewerkt wordt met de nieuwe
klantgegeven moet u:

De factuur of offerte veranderen in het factuur dialoogvenster .
De klant opnieuw selecteren uit de lijst in de kolom Klantid.

De kolommen
De tabel Contacten heeft veel kolommen. De kolommen weergegeven in de afbeelding zijn die in de
weergave Basis. De complete lijst is te zien in de weergave Compleet. Zie pagina Kolommen
instellen  voor het aanpassen van de kolommen.

Id

Voer hier een klantnummer in.

Organisatie

Voer hier de naam van het bedrijf of organisatie in.

Titel (Voorvoegsel)

Voer hier de titel van het contact in.

Voornaam

Voer hier de voornaam van het contact in.

Achternaam

De achternaam van het contact.

Straat

Voer hier het adres in.

http://www.banana.ch/doc/nl/node/9763
http://www.banana.ch/doc/nl/node/2710
http://www.banana.ch/doc/nl/node/2710
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Adres extra

Voer hier extra adresgegevens in.
Als u het QR factuur formaat nodig heeft kijkt u voor meer informatie naar de pagina Onderdelen van
de QR factuur Zwitserland  (Engelstalig).

Postcode

Voer hier de postcode in.

Plaats

Voer hier de plaatsnaam in.

Landcode

Voer hier de code van het land in.

De landcode bestaat uit twee letters volgens de ISO 3166-1 standaard (bijvoorbeeld CH, LI, AT, DE, IT,
FR).

Taalcode

Voer hier de taal van de klant in.

Factuurteksten worden afgedrukt in de taal van de klant als deze is ingesteld in de overeenkomstige
kolom.
De taalcode is een ISO code , gewoonlijk 2 letters (it=Italiaans, de=Duits, en=Engels, fr=Frans).

Als geen taal wordt gespecificeerd voor de klant wordt de taal van het bestand gebruikt. Deze taal
wordt gedefinieerd in het menu Bestand → Bestandseigenschappen → Andere → Huidige taal.

BTW Code

Voer hier de BTW code van de klant in.

Notitie

Ruimte voor aantekeningen.

https://www.banana.ch/apps/en/node/9388
https://www.banana.ch/apps/en/node/9388
https://www.banana.ch/doc/en/node/en.wikipedia.org/wiki/ISO_639-2
http://en.wikipedia.org/wiki/ISO_639-2
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Items tabel

De Items tabel bevat de kolommen waar de gegevens voor het beheer van de artikelen en het
magazijn bijgehouden worden.

De artikelen kunnen gebruikt worden in de factuurdialoog bij het maken of aanpassen van facturen
waardoor het invoeren van de gegevens gemakkelijker wordt.

De kolommen
De tabel Items heeft veel kolommen. De kolommen weergegeven in de afbeelding zijn die in de
weergave Basis. De complete lijst is te zien in de weergave Compleet. Zie pagina Kolommen
instellen  voor het aanpassen van de kolommen.

De inhoud van elke kolom kan ook worden afgedrukt op de factuur. Zie aanpassing afdrukformaat
detail voor CH10  (Engelstalig).

Koppelingen
Koppeling naar een bestand met een productafbeelding of een beschrijvend PDF bestand.

Id

Voer hier het artikelnummer in.

Beschrijving

Voer hier de beschrijving van het artikel in.

Eenheid

Voer hier de eenheid in waarin het artikel gebruikt/verkocht wordt (onderdelen, uren, kilo, etc.).

Eenheidsprijs

Voer hier de prijs per eenheid in.
Bij de instelling van de factuur geeft u aan of de bedragen exclusief of inclusief BTW zijn.
Let op: als u de instelling wijzigt van exclusief naar inclusief BTW of omgekeerd, wijzigt het
programma de bedragen, zodat dezelfde factuur kan worden afgedrukt met netto- en brutobedragen.

Rekening

Voer hier een rekening in die voor de boekhouding gebruikt kan worden.

http://www.banana.ch/doc/nl/node/2710
http://www.banana.ch/doc/nl/node/2710
https://www.banana.ch/apps/en/node/9365
https://www.banana.ch/apps/en/node/9365
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Notitie

Ruimte voor aantekeningen.

Een catalogus importeren
Met de importfuncties is het mogelijk om het importeren van gegevens uit een bestaande
productcatalogus te automatiseren. Zie Gegevens van andere programma's ophalen.

Het is ook mogelijk productcatalogi te integreren in het factuurprogramma.
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Facturentabel

De tabel Facturen bevat de kolommen waarin alle factuurgegevens die zijn ingevoerd in het
dialoogvenster Facturen automatisch worden weergegeven.

Vanuit deze tabel kunt u:

Nieuwe facturen aanmaken
Bestaande facturen aanpassen
Factuur dupliceren
Facturen verwijderen
Facturen afdrukken
Facturen archiveren

De kolommen
De tabel Facturen heeft veel kolommen. De kolommen weergegeven in de afbeelding zijn die in de
weergave Basis. De complete lijst is te zien in de weergave Compleet. Zie pagina Kolommen
instellen  voor het aanpassen van de kolommen.

Id

Voer hier het factuurnummer in.
Het programma neemt automatisch het nummer over dat in de factuur aanmaken dialoog ingevoerd
is.

Datum

De factuurdatum.
Het programma neemt automatisch het nummer over dat in de factuur aanmaken dialoog ingevoerd
is.

Beschrijving

Het onderwerp van de factuur.
Het programma neemt automatisch het nummer over dat in de factuur aanmaken dialoog ingevoerd
is.
Deze tekst wordt ook gebruikt als de titel van de factuur. Als deze ingevuld is overschrijft dit de titel
die in de instellingen is ingevoerd.

Contact Id

De Id van het contact voor wie de factuur is.

http://www.banana.ch/doc/nl/node/2710
http://www.banana.ch/doc/nl/node/2710
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Het programma neemt automatisch het nummer over dat in de factuur aanmaken dialoog ingevoerd
is.

Adres

Het programma vult automatisch het adres van de klant in gebaseerd op de Contact Id die ingevoerd
is.

Kortingsbedrag

Het bedrag van korting die toegepast wordt op de factuur.
Het programma neemt automatisch het nummer over dat in de factuur aanmaken dialoog ingevoerd
is.

Totaal bedrag

Het programma neemt automatisch het nummer over dat in de factuur aanmaken dialoog ingevoerd
is.

Vervaldatum

De vervaldatum.
Het programma neemt automatisch het nummer over dat in de factuur aanmaken dialoog ingevoerd
is.

Betaaldatum

Voer hier de betaaldatum in.

Notitie

Eventuele notities kunnen hier ingevoerd worden.
Het programma neemt automatisch het nummer over dat in het veld Eindtekst van de factuur
aanmaken dialoog ingevoerd is.
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Offertestabel

De tabel Offertes bevat de kolommen waarin alle offertegegevens die zijn ingevoerd in het
dialoogvenster Facturen automatisch worden weergegeven.

De tabel Offertes heeft veel kolommen. De kolommen weergegeven in de afbeelding zijn die in de
weergave Basis. De complete lijst is te zien in de weergave Compleet. Zie pagina Kolommen
instellen  voor het aanpassen van de kolommen.

De kolommen

Id

Hier kan het offertenummer ingevoerd of veranderd worden.
Het programma neemt automatisch het nummer over dat in de "offerte aanmaken" dialoog ingevoerd
is.

Datum

Hier kan de offertedatum ingevoerd worden.
Het programma neemt automatisch de waarde over die in de "offerte aanmaken" dialoog ingevoerd
is.

Beschrijving

Hier kan het onderwerp van de offerte ingevoerd worden.
Het programma neemt automatisch de waarde over die in de "offerte aanmaken" dialoog ingevoerd
is.

Contact Id

Hier kan de Id van het contact voor wie de offerte is ingevoerd worden.
Het programma neemt automatisch de waarde over die in de "offerte aanmaken" dialoog ingevoerd
is.

Adres

Het programma vult automatisch het adres van de klant in gebaseerd op de Contact Id die ingevoerd
is.

Kortingsbedrag

Hier kan het kortingsbedrag ingevoerd worden.
Het programma neemt automatisch de waarde over die in de "offerte aanmaken" dialoog ingevoerd
is.

http://www.banana.ch/doc/nl/node/2710
http://www.banana.ch/doc/nl/node/2710
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Totaal

Het programma neemt automatisch de waarde over die in de "factuur aanmaken" dialoog ingevoerd
is.

Notities

Eventuele notities kunnen hier ingevoerd worden.
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BTW codes tabel

De BTW codes tabel bevat de kolommen waarin u de BTW codes en de bijbehorende percentages
kunt invoeren.

BTW codes worden automatisch overgenomen in het dialoogvenster Facturen bij het aanmaken of
wijzigen van de factuur waardoor gegevensinvoer eenvoudiger wordt.

De kolommen
De BTW codes tabel heeft veel kolommen. De kolommen weergegeven in de afbeelding zijn die in de
weergave Basis. De complete lijst is te zien in de weergave Compleet. Zie pagina Kolommen
instellen  voor het aanpassen van de kolommen.

Id

Hier wordt de de BTW code ingevoerd.

Beschrijving

Hier wordt de beschrijving van de BTW code ingevoerd.

%BTW

Hier wordt het BTW percentage ingevoerd.

Notities

Ruimte voor aantekeningen.
 

BTW op bruto- of nettobedrag
De instelling voor netto- of brutoberekening gebeurt op het niveau van de individuele factuur, in het
dialoogvenster Factuur-instellingen .

http://www.banana.ch/doc/nl/node/2710
http://www.banana.ch/doc/nl/node/2710
http://www.banana.ch/doc/nl/node/9893
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Facturen maken en wijzigen

Menu Facturen
In het menu Facturen vindt u de commando's:

Nieuwe factuur...
Factuur wijzigen...
Factuur dupliceren...
Factuur verwijderen...
Factuur afdrukken...
Openstaande facturen laten zien...
Facturen van klanten zien...
Archiveren...

Een nieuwe factuur maken
U kunt op twee manieren een nieuwe factuur maken:

Vanuit het menu Facturen
Gebruik het commando Facturen → Nieuwe factuur....
Het dialoogvenster Facturen wordt geopend waarin de gegevens ingevoerd kunnen
worden.
Er wordt een nieuw oplopend factuurnummer toegekend door het programma. U kunt dit
handmatig veranderen.
Voer de factuurgegevens in en sla de factuur op.
 

Rechtstreeks vanuit de tabel Facturen :
Selecteer een nieuwe rij in de tabel.
Klik in de kolom Id (factuurnummer) op het 'Nieuwe factuur' icoontje aan de bovenkant
van de cel.

 
Het dialoogvenster Facturen  wordt geopend waarin u uw gegevens kunt invoeren.
Voer de factuurgegevens in en sla de factuur op.

Wanneer u een nieuwe factuur maakt werkt het programma automatisch de tabel Facturen  bij. De
gegevens van de nieuwe factuur worden toegevoegd in een nieuwe rij in de tabel.

Factuur wijzigen
U kunt op twee manieren een bestaande factuur wijzigen:

Vanuit het menu Facturen:

http://www.banana.ch/doc/nl/node/9758
http://www.banana.ch/doc/nl/node/9763
http://www.banana.ch/doc/nl/node/9758
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Selecteer de regel met de factuur die u wilt wijzigen.
Gebruik het commando Facturen → Factuur wijzigen....
Het dialoogvenster Facturen  wordt geopend waarin de gegevens ingevoerd en
gewijzigd kunnen worden.
Maak de veranderingen en sla de factuur op.
 

Rechtstreeks vanuit de tabel Facturen :
Selecteer de regel met de factuur die u wilt wijzigen.
Klik in de kolom Id (factuurnummer) op het icoontje 'Factuur wijzigen' aan de
bovenkant van de cel.

 
Het dialoogvenster Facturen  wordt geopend waarin de gegevens ingevoerd en
gewijzigd kunnen worden.
Maak de veranderingen en sla de factuur op.

Wanneer u een factuur wijzigt werkt het programma automatisch de tabel Facturen  bij.

Factuur dupliceren
U kunt op twee manieren een bestaande factuur dupliceren:

Vanuit het menu Facturen:
Selecteer de regel met de factuur die u wilt dupliceren.
Gebruik het commando Facturen → Factuur dupliceren....
Er wordt een nieuw oplopend factuurnummer toegekend door het programma. U kunt dit
handmatig veranderen.
Het dialoogvenster Facturen  wordt geopend met daarin de gegevens van de factuur die
u wilt dupliceren.
Maak de veranderingen en sla de factuur op.
Het programma werkt automatisch de tabel Facturen  bij.
 

Rechtstreeks vanuit de tabel Facturen:
Selecteer de regel met de factuur die u wilt dupliceren. U kunt ook meerdere regels
selecteren om meerdere facturen tegelijk te dupliceren.
Gebruik het commando Bewerken → Rijen dupliceren....
Het programma werkt automatisch de tabel Facturen  bij door de gedupliceerde rijen
toe te voegen.
Voor iedere gedupliceerde factuur moet het factuurnummer en de gegevens handmatig
bijwerken.

Factuur verwijderen
Om een factuur te verwijderen:

Ga naar detabel Facturen.

http://www.banana.ch/doc/nl/node/9763
http://www.banana.ch/doc/nl/node/9758
http://www.banana.ch/doc/nl/node/9763
http://www.banana.ch/doc/nl/node/9758
http://www.banana.ch/doc/nl/node/9763
http://www.banana.ch/doc/nl/node/9758
http://www.banana.ch/doc/nl/node/9758
http://www.banana.ch/doc/nl/node/9758
http://www.banana.ch/doc/nl/node/9758
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Selecteer de regel met de factuur die u wilt verwijderen. U kunt ook meerdere regels selecteren
om meerdere facturen tegelijk te verwijderen.
Gebruik het commando menu Bewerken → Rijen verwijderen.
De facturen worden uit de tabel verwijderd.

Facturen afdrukken
Op de pagina Offertes en facturen afdrukken  vindt u informatie over het aanpassen en afdrukken
van facturen.

U kunt op twee manieren een nieuwe factuur afdrukken:

Vanuit het menu Facturen
Selecteer de regel met de factuur die u wilt afdrukken.
Gebruik het commando Facturen → Factuur afdrukken....
 

Rechtstreeks vanuit de tabel Facturen :
Selecteer de regel met de factuur die u wilt afdrukken.
Klik in de kolom Id (factuurnummer) op het 'Factuur afdrukken' icoontje aan de
bovenkant van de cel.

 

Openstaande facturen laten zien
U kunt facturen die nog niet betaald zijn in een tabel weergeven:

Ga naar de tabel Facturen
Gebruik het commando van het menu Facturen → Laat openstaande facturen zien.
Het programma haalt alle rijen met facturen zonder betaaldatum op.

Telkens wanneer een factuur is betaald voert u de datum van de betaling in de kolom Betal. Datum
van de facturen Tabel  in.

Facturen van klanten zien
U kunt de facturen van de klant extraheren in een tabel:

Ga naar de tabel Facturen .
Klik onder de kolom Contact-ID op het klantnummer waarvan u de facturen wilt hebben.
Klik met de rechtermuisknop op het geselecteerde veld en selecteer de opdracht Rijen
extraheren.

Het programma extraheert alle facturen van de klant.

http://www.banana.ch/doc/nl/node/9889
http://www.banana.ch/doc/nl/node/9758
http://www.banana.ch/doc/nl/node/9758
http://www.banana.ch/doc/nl/node/9758
http://www.banana.ch/doc/nl/node/9758
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Facturen archiveren
Met de applicatie Offertes en Facturen:

Kunt u zoveel facturen invoeren als u wilt, er zijn geen beperkingen.
Kunt u facturen van meerdere jaren in één bestand bewaren.
Hoeft u geen bestand voor ieder nieuw jaar aan te maken.

Facturen van vorige jaren kunne op elk moment gearchiveerd worden:

Zie de pagina hoe facturen te archiveren .

http://www.banana.ch/doc/nl/node/9932
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Offertebeheer

Met de applicatie Offertes en Facturen kunt u ook offertes beheren.

Het aanmaken, wijzigen, dupliceren en afdrukken van offertes gaat op precies dezelfde manier
als voor facturen.

Vanuit de tabel Offertes:

Maak een nieuwe offerte aan met menu Facturen → Nieuwe offerte... .
Wijzig een offerte met met menu Facturen → Offerte bewerken... .
Dupliceer een offerte met menu Facturen → Offerte dupliceren... .
Druk aan offerte af met menu Facturen → Offerte afdrukken... .
Maak factuur op basis van een offerte:

Via menu Facturen → Maak offerte op basis van factuur... .
Of door de Factuur aanmaken knop van de dialoog offerte aanmaken / bewerken te
gebruiken.
(Facturen → Offerte bewerken)

De dialoog om een offerte aan te maken of te bewerken is dezelfde als die voor de factuur. Voor meer
informatie zie Factuurdialoog.
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Zo personaliseert u uw factuur

U kunt het afdrukken van facturen gemakkelijk aanpassen aan uw specifieke wensen.

Stel het adres van uw bedrijf in (afzender)
In het menu Bestand > Bestands- en boekhoudingseigenschappen... > tab Adres stelt u het adres van
uw bedrijf in.

De taal van de klant instellen
U kunt facturen afdrukken in de taal van uw klanten. Voor iedere klant stelt u de taal in in de tabel
Contacten . U kunt dit ook veranderen in het dialoogvenster Facturen .

Klantadressen ophalen uit Excel
Als klantgegevens beschikbaar zijn in een Excelbestand kunnen deze eenvoudig naar de tabel
Contacten overgebracht worden.

Ga als volgt te werk:

Selecteer in Excel de kolom met de te kopiëren gegevens en gebruik het commando Kopiëren
(Ctrl+C).
Ga in de Banana tabel Contacten staan in de overeenkomstige kolom en voer het commando
Plakken (Ctrl+V of Paste) in het menu Bewerken uit.
Herhaal deze bewerking voor alle adreskolommen (rekening, voornaam, achternaam,
organisatie, straat, postcode, landcode, taal).
De gegevens uit de betreffende kolommen zijn nodig voor het afdrukken van de factuur.
Wanneer u niet alle kolommen van het Excelbestand heeft moet u de ontbrekende informatie
handmatig toevoegen.

De positie van het logo en het adres van de afzender
Om het logo in te stellen moet u:

De logo afbeelding instellen in het menu Bestand > Logo instellen.
Om het logo in de factuur te gebruiken moet u in de factuur afdruk layout instellingen , te
bereiken via Factuur afdrukken > instellingentandwieltje klikken > klikken op instellingen van
de gekozen layout, het vakje Logo aanvinken en de naam, hoofdlettergevoelig, van de
aanpassing die u gebruikt heeft invoeren in het veld Logo naam.

U kunt bijvoorbeeld het logo links plaatsen en het adres rechts en de grootte van het logo
veranderen.

Het adres wordt automatisch overgenomen van de basisgegevens van het bestand.

Als de standaardinstellingen niet veranderd zijn wordt het adres van de afzender rechts geplaatst,
ongeacht de aanwezigheid van het logo.

http://www.banana.ch/doc/nl/node/9756
http://www.banana.ch/doc/nl/node/9756
http://www.banana.ch/doc/nl/node/9763
https://www.banana.ch/apps/en/node/9365#intestazione
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Wanneer u het adres van de afzender aan de linkerkant wilt plaatsen zonder logo kijkt u op de
volgende pagina:

Factuur zonder logo en het adres links  (Engelstalig)

Wanneer u een ander adres wilt invoeren via de Factuur instellingen :

Voer de gewenste teksten in Regel 1 tekst, Regel 2 tekst, Regel 3 tekst, Regel 4 tekst en
Regel 5 tekst in.

Het logo instellen zonder het adres van de afzender
Op de pagina over Logo instellen  vindt u informatie over hoe u het logo kunt toevoegen en een
plaats kunt geven.

Via Factuurafdruk instellingen :

Vink de Koptekst pagina optie uit om het adres in de kop uit te sluiten bij het afdrukken.
Vink de Logo optie aan om het logo in te sluiten in de afdruk.

Het adres in kop van de factuur aanpassen
De stijl van het adres van de afzender in de factuur kop (kleur, grootte, font...) wordt standaard
ingesteld door het programma.

Met het Advanced Plan van Banana Boekhouding Plus  kunt u de layout van het adres aanpassen.
Zie voor meer informatie de pagina Voorbeelden  (Engelstalig).

Factuurinformatie instellen
Factuurinformatie is informatie over de datum, klantnummer, vervaldatum, etc. die gewoonlijk onder
de koptekst en het klantenadres staan.

Met de CH10  en UNI11  (Engelstalig) layouts kunt u definiëren welke informatie moet worden
meegenomen in de afdruk en welke niet. U vindt instructies hiervoor op de pagina Factuur afdruk
layout instellingen .

In de andere afdruk layouts (CH01-CH09 / UNI01-UNI08) kan de informatie niet worden aangepast.

Een nieuw informatieveld toevoegen aan de factuur
Naast de standaard informatievelden (factuurnummer, datum, klantnummer, etc.) kunt u ook
andere aangepaste velden toevoegen.

In de sectie Factuur van de Factuur dialoog:

Ga bovenin naar weergave Compleet.
Gebruik de velden Extra info. 1 ... Extra info. 8 om uw eigen extra informatievelden toe te
voegen.
Vink in de sectie Informatie van de Factuur layout instellingen  het vakje Gepersonaliseerde
velden aan.

https://www.banana.ch/apps/en/node/9398#invoice_without_logo_and_company_header_on_the_left
https://www.banana.ch/apps/nl/node/9365#header
http://www.banana.ch/doc/nl/node/9182
https://www.banana.ch/apps/en/node/9365#invoice_settings_dialogue
https://www.banana.ch/nl/buy
https://www.banana.ch/apps/en/node/9417
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/en/node/9423
https://www.banana.ch/apps/en/node/9365#print_property
https://www.banana.ch/apps/en/node/9365#print_property
https://www.banana.ch/apps/en/node/9365#information
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De nieuwe extra informatievelden worden toegevoegd aan het eind. Het is niet mogelijk de
volgorde te veranderen.

In de Sectie Instellingen van de Factuur dialoog:

Verander de teksten van de Factuur aangepaste velden naar eigen inzicht.
U kunt voor elke taal vertalingen invoeren.

De betaaltermijn instellen
De betaaltermijn voor facturen is standaard 30 dagen.

U kunt de betaaltermijn op twee manieren veranderen:

Verander de standaardinstellingen voor alle nieuwe facturen.
Ga naar de sectie Instellingen van de Factuur dialoog.
Stel in de sectie Nieuwe documenten > Betalingstermijn de gewenste waarde in
(bijvoorbeeld 10).
De factuur vervaldatum wordt opnieuw berekent met de nieuwe betalingstermijn.

Verander de betaaltermijn voor iedere factuur afzonderlijk.
Ga naar de Factuur dialoog.
Voer in het veld Vervaldatum de einddatum voor de betaling in (bijvoorbeel
31.12.2022).
De vervaldatum van de factuur wordt vervangen door de nieuwe datum.

De positie en de samenstelling van het klantadres instellen
Met de CH10  en UNI11  layouts kunt u definiëren:

De plaats van het klantadres.
De elementen van het adres.

In het scherm Factuur instellen  > sectie Adres klant:

In het veld Adres compositie:
Stel het adres samen door de XML namen van de kolommen in de tabel Contacten in te
voeren.
U kunt alleen de volgende kolommen gebruiken (XML namen):
NamePrefix, OrganizationName, FirstName, FamilyName, Street, AddressExtra,
POBox, PostalCode, Locality, Region, Country, CountryCode.
Verander de plaats van het adres door de velden Horizontaal verplaatsen en Verticaal
verplaatsen te gebruiken.

Voor andere afdruk layouts (CH01-CH09 / UNI01-UNI08), kan de plaats en de samenstelling van het
klantadres niet worden veranderd.

Wanneer u meer dan een regel nodig heeft om het adres van uw klant af te drukken kijk dan op
klant/bedrijf adres over vier regels.

https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/en/node/9423
https://www.banana.ch/apps/nl/node/9365#customer_address
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De titel/object instellen
Om de titel/objectnaam van de factuur in te stellen heeft u twee mogelijkheden:

Voer de tekst in in het Factuur dialoog > Object veld.
Voor ieder factuur kunt u een titel definiëren.
Als u het veld leeg laat wordt de standaardtekst gebruikt.
Deze titel gaat altijd vóór de titel ingevoerd in de layout instellingen (zie volgende punt).

Met de CH10  en UNI11  layouts kunt u de tekst invoeren in het Factuur instellingen  >
Tekst sectie > Factuurtitel.

De titel wordt gebruikt voor alle facturen die worden afgedrukt met deze layout.
De titel wordt alleen gebruikt als er geen titel is gedefinieerd zoals aangegeven in het
eerste punt.

De begintekst instellen
U heeft twee mogelijkheden om de begintekst van de factuur in te voeren:

Voer de tekst in in het Factuur dialoog > Begin tekst veld.
U kunt voor ieder factuur een begintekst definiëren.
Als u het veld leeg laat wordt de standaardtekst gebruikt.
Deze tekst gaat altijd vóór de tekst ingevoerd in de layout instellingen (zie volgende
punt).

Met de CH10  en UNI11  layouts kunt u de tekst invoeren in het Factuur instellingen
>Tekst sectie > Begintekst.

De tekst wordt gebruikt voor alle facturen die worden afgedrukt met deze layout.
De tekst wordt alleen gebruikt als er geen tekst is gedefinieerd zoals aangegeven in het
eerste punt.

De tabel met de factuurdetails instellen
De tabel met factuurdetails is de centrale plaats in de factuur waar de gefactureerde items/diensten
verschijnen met hoeveelheden, eenheidsprijzen, totalen, etc.
Gebruik de factuur dialoog  om de te factureren items in te voeren.

Zie ook de pagina's:

Factuurdetails
Kortingen en totalen
Geavanceerde instellingen

De kolommen van de gefactureerde items instellen
Met de CH10  en UNI11  layouts, kunt u bepalen welke kolommen worden weergegeven in de
afdruk. Op de pagina Factuur instellen > factuur details  kunt u zien hoe dit werkt.

Voor de andere afdruklayouts (CH01-CH09 / UNI01-UNI08) zijn de kolommen niet in te stellen.

https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/en/node/9423
https://www.banana.ch/apps/nl/node/9365
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/en/node/9423
https://www.banana.ch/apps/nl/node/9365
http://www.banana.ch/doc/nl/node/9763
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/en/node/9423
https://www.banana.ch/apps/en/node/9365#invoice_details
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De eindteksten instellen
U heeft verschillende mogelijkheden om de eindteksten van de factuur in te voeren:

Voer de tekst in in de Factuur dialoog > Eindtekst veld.1.
Dit wordt toegepast in elke afdruklayout.
De tekst wordt precies onder de factuurdetails geplaatst.

Voer de tekst in in de Factuurafdruk dialoog > Opties sectie > Definitieve tekst.2.
Dit wordt toegepast in elke afdruklayout.
Als u al een tekst zoals in stap 1 heeft ingevoerd dan wordt deze nieuwe tekst meteen na
de vorige toegevoegd.

Voer de tekst in in de Factuur layout instellingen  > Tekst sectie > Eindtekst veld.3.
Deze tekst gaat boven de tekst ingevoerd zoals in stap 2.
Als u al een tekst zoals in stap 1 heeft ingevoerd dan wordt deze nieuwe tekst meteen na
de vorige toegevoegd.

Het bankrekeningnummer instellen
Als u geen QR code gebruikt moet u het bankrekeningnummer invoeren als referentie voor de
factuurbetaling.

U heeft drie mogelijkheden om het bankrekeningnummer in te voeren als eindtekst:

Factuur dialoog > Eindtekst veld.1.
Het bankrekeningnummer verschijnt alleen in de afdruk van de factuur die u aan het
veranderen of afdrukken bent.
Dit wordt toegepast in elke afdruklayout.
De tekst wordt direct onder de factuurdetails geplaatst.

Factuurafdruk dialoog > Opties sectie > Definitieve tekst.2.
In dit geval wordt het bankrekeningnummer ingevoegd in elke factuur die u maakt.
Dit wordt toegepast in elke afdruklayout.
Als u al een tekst zoals in stap 1 heeft ingevoerd dan wordt deze nieuwe tekst meteen na
de vorige toegevoegd.

Factuur layout instellingen  > Tekst sectie > Eindtekst veld.3.
In dit geval wordt het bankrekeningnummer ingevoegd in elke factuur die u maakt met
deze layout.
Deze tekst gaat boven de tekst ingevoerd zoals in stap 2.
Als u al een tekst zoals in stap 1 heeft ingevoerd dan wordt deze nieuwe tekst meteen na
de vorige toegevoegd.

 

Kleuren en stijlen instellen

Op de Factuur layout instellingen  page vindt u instructies voor het definiëren van:

Lettertype en -grootte.
Kleuren.

https://www.banana.ch/apps/nl/node/9365
https://www.banana.ch/apps/nl/node/9365
https://www.banana.ch/apps/en/node/9365#styles
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Vetgedrukte tekst instellen
Op de Factuur layout pagina  pagina vindt u informatie over het gebruiken van vetgedrukte tekst
in facturen.

Afbeeldingen toevoegen aan offertes of facturen
Met het Advanced Plan van Banana Boekhouding Plus , met de nieuwe applicatie Offertes en
Facturen, kunt u afbeeldingen toevoegen aan offertes en facturen die naar klanten gestuurd moeten
worden.
Deze functionaliteit maakt de factuur nog beter te personaliseren en de klant die deze ontvangt heeft
een completer en duidelijker inzicht in de facturering van de artikelen.

Zie de volgende pagina's met informatie pages over het toevoegen van afbeeldingen:

Met Javascript de afdruk van de factuur personaliseren  (Engelstalig).
Offertes en facturen met productfoto's .

Klant/bedrijf adressen afdrukken over vier regels
Wanneer de geadresseerde een bedrijf is met diverse sectoren/afdelingen of een klant die woont in
een appartementencomplex kan het nodig zijn om meerdere regels te gebruiken voor het afdrukken
van het adres.
Deze optie is alleen beschikbaar met het Advanced Plan van Banana Boekhouding Plus.

Om de mogelijkheid, het ontvangersadres over meerdere regels af te drukken, te activeren gaat u als
volgt te werk:

Werk de extensie bij vanuit het menu Extensies > Extensies beheren > Extensies
bijwerken.
Open de factuur met Bewerken en in de Instellingen dialoog > Adres sectie, maak de velden
Sector 1 ... 4 zichtbaar voor de Basis weergave.

Schakel eventueel over van de weergave Basis naar de weergave Compleet zonder de velden
zichtbaar te maken (in de weergave Compleet zijn alle velden zichtbaar).
Voer in factuur adres de tekst in de sector velden in.
 

https://www.banana.ch/apps/en/node/9365
https://www.banana.ch/apps/en/node/9365#bold_text
https://www.banana.ch/nl/advanced
https://www.banana.ch/apps/en/node/9396#print_images_of_items
https://www.banana.ch/nl/node/11439
https://www.banana.ch/nl/advanced
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In de afdruk layout instellingen , voeg de Sector velden toe aan de klant adres compositie.
De inhoud is als volgt (de Engelse namen moeten gebruikt worden):
<OrganisationName>
<OrganisationUnit>
<OrganisationUnit2>
<OrganisationUnit3>
<OrganisationUnit4>
<NamePrefix>
<FirstName> <FamilyName>
<Street> <AddressExtra>
<POBox>
<PostalCode> <Locality>

Als u deze velden automatisch over wilt laten nemen van de tabel Contacten, voeg dan de
kolommen
OrganisationUnit2, OrganisationUnit3 en OrganisationUnit4 toe aan deze tabel.

https://www.banana.ch/apps/en/node/9365
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Andere informatie
De factuurafdruk personaliseren  (Engelstalig)

https://www.banana.ch/apps/en/node/9514
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Facturen afdrukken

Met de Offertes en Facturen  applicatie, onderdeel van Banana Boekhouding Plus , is het afdrukken
van offertes en facturen goed aan te passen en geschikt te maken voor alle vereisten.

Commando Offerte/Factuur afdrukken
Het afdrukken van facturen wordt gedaan vanuit het menu Facturen → Factuur afdrukken.

Met dit commando wordt een afdrukvoorbeeld van de factuur gemaakt. Direct vanuit het
afdrukvoorbeeld kunt u het volgende dialoogvenster bereiken, door te klikken op het
instellingensymbool (het tandwieltje) in de menubalk:

Dialoogvenster factuur afdrukken. In dit dialoogvenster kunt u diverse dingen doen:
De layout kiezen die gebruikt moet worden voor het afdrukken van de factuur.
Naar de layout instellingen gaan om de afdruk aan te passen.
De afdrukinstellingen veranderen.
De factuur exporteren naar PDF of andere formaten.

Er kan nu maar één factuur tegelijk afgedrukt worden.

Afdruklayout en personalisatie
Het afdrukken van de offerte of factuur is heel goed te personaliseren omdat:

U de Afdruklayout  kunt kiezen.
U kunt de  afdruk van de factuur personaliseren door de layout instellingen aan te passen.
Diverse layouts zijn beschikbaar voor het afdrukken van facturen , de volgende worden
aanbevolen:

De CH10 layout voor alle gebruikers in Zwitserland  (Engelstalig).
Met de optie om de Zwitserse QR-Code in de afdruk te gebruiken.
De UNI11 layout voor alle gebruikers in andere landen .
Hetzelfde als de CH10 layout, maar zonder de QR-Code.

Raadpleeg de volgende pagina's voor meer informatie over personalisatie:

Uw factuurafdruklayout personaliseren  (Engelstalig)
Vind alle informatie die u nodig heeft om te beginnen met het maken van een afdruk naar
wens.
Pas de CH10 layout aan  (Engelstalig) (ook te gebruiken voor de UNI11 layout).

Activeer en personaliseer de QR-Code  (Engelstalig) voor het afdrukken van facturen in
Zwitserland.

Een artikelafbeelding invoegen
Deze optie is alleen beschikbaar met het Advanced Plan van Banana Boekhouding Plus . In de
Offertes en Facturen applicatie is het mogelijk een foto of een afbeelding van het artikel in te
voegen.
Zie voor meer details de pagina Foto afdrukken.

http://www.banana.ch/doc/nl/node/9752
http://www.banana.ch/nl/download
https://www.banana.ch/apps/nl/node/9034
https://www.banana.ch/apps/nl/node/9034
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9514
https://www.banana.ch/apps/en/node/9365
https://www.banana.ch/apps/en/node/9388
https://www.banana.ch/nl/advanced
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De inhoud van tabellen afdrukken
Ga als volgt te werk om de inhoud van de tabellen Contacten, Items, Facturen, Offertes and BTW
Codes af te drukken:

Ga in de tabel staan waarvan u de gegevens wilt afdrukken.
Ga naar het menu Bestand → Afdrukvoorbeeld/Afdrukken.

Er wordt een PDF weergegeven met een lijst van de gegevens die in de verschillende kolommen van
de gekozen tabel staan.
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Dialoog Factuur afdrukken

 U kunt het dialoogvenster factuur afdrukken bereiken vanuit het Afdrukvoorbeeld  door op
Instellingen te klikken (het tandwieltje).

U kunt het afdrukvoorbeeld op drie manieren bereiken:

Vanuit het menu Facturen → Factuur afdrukken commando.
Met de knop Afdrukken van het dialoogvenster Nieuwe factuur/Factuur wijzigen.
Vanuit de tabel Facturen door te klikken op het icoontje Factuur afdrukken aan de
bovenkant van de cel in de kolom Id. (factuurnummer).

Het programma laat direct een voorbeeld zien van de factuur, gebruikmakend van de standaard
layout [CH10] Factuur layout met Zwitserse QR code  (Engelstalig).

U kunt één factuur tegelijk afdrukken, meerdere facturen tegelijk kan niet.

Nadat u de afdrukopties hebt gekozen, wordt met de knop OK een afdrukvoorbeeld van de factuur
gemaakt.

Sectie Afdrukken
Layout

Met deze optie kunt u de layout van de factuur wijzigen. Er zijn een aantal voorgedefinieerde layouts
 beschikbaar.

Layout Voorkeuren

Met deze optie kunt u voorkeuren instellen die door de gekozen layout aangeboden worden.
Deze sectie wordt niet getoond in het dialoogvenster wanneer een layout zonder voorkeuren wordt

http://www.banana.ch/doc/nl/node/3332
https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9034
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geselecteerd.

Afdrukken als
U kunt kiezen welk type document u wilt afdrukken, de keuzes zijn:

Automatisch: Druk het document af in het formaat van de factuur.
Leveringsbon met bedragen: Druk het document af als een afleveringsbon.
Leveringsbon zonder bedragen: Druk het document af als een afleveringsbon zonder
de bedragen en het totaalbedrag.
Factuur: Drukt het document af in het formaat van de factuur.
1e herinnering: Druk het document af als eerste herinnering.
2e herinnering: Druk het document af als tweede herinnering.
3e herinnering: Druk het document af als derde herinnering.

Het gekozen documenttype wordt niet opgeslagen voor een volgende keer maar weer op
"automatisch" ingesteld.

Layout voorkeuren worden aangeboden door de volgende layouts:

[CH10] Layout met QR code voor Zwitserland  (Engelstalig).
[UNI11] Layout 11 Programmeerbare factuur  (Engelstalig).

Vereisten om layout voorkeuren te kunnen gebruiken:

Banana Boekhouding Plus Dev-Channel
Het Advanced plan

Meer layouts...

Deze knop leidt u naar het dialoogvenster Extensies beheren, waar u nieuwe layouts kunt installeren,
bestaande kunt bijwerken met de nieuwste versies, of uw eigen aangepaste layouts kunt toevoegen.

Instellingen

Hiermee kunt u de instellingen van de geselecteerde afdruklayout instellen. Elke layout heeft zijn
eigen aanpasbare instellingen.

Bezoek de pagina Factuur instellingen voor CH10 / UNI11 layout  (Engelstalig) voor meer informatie
over het aanpassen van de UNI11 layout.

Sectie Options
In deze sectie kunt u specifieke teksten voor iedere taal toevoegen, bijvoorbeeld om de
afsluitende tekst of de betalingsdetails aan te geven. Afhankelijk van de taal van de klant laat het
programma onderaan de factuur de opgeslagen teksten voor de aangegeven taal zien.

Er kan één soort tekst worden ingevoerd, voor iedere taal een.

De teksten die in deze sectie worden ingevoerd worden afgedrukt op alle facturen, ongeacht de
afdruklayout die wordt gebruikt.

Om een eindtekst toe te voegen:

https://www.banana.ch/apps/en/node/9338
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/nl/insiderprogram
https://www.banana.ch/nl/update
https://www.banana.ch/apps/en/node/9365
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menu Facturen → Facturen afdrukken.
Voer de gewenste tekst in de sectie Options in.
Bevestig met OK.

De ingevoerde tekst verschijnt in het afdrukvoorbeeld van de factuur.

Factuur opslaan als PDF
Facturen kunnen ook worden opgeslagen in PDF-formaat, zodat ze gemakkelijk per e-mail kunnen
worden verzonden.

Vanuit het Afdrukvoorbeeld (Facturen → Factuur afdrukken → OK)
selecteer PDF aanmaken in de werkbalk.

Factuur afdrukken
Om de factuur af te drukken wanneer het afdrukvoorbeeld wordt weergegeven:

Gebruik het icoon Afdrukken op de werkbalk.
Of sla op als PDF en druk deze af.
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Afleverbon afdrukken

Met Banana Boekhouding Plus kunnen ook afleverbonnen worden afgedrukt met de layout UNI11 .

Vereisten om de lay-outvoorkeuren te gebruiken:

Banana Boekhouding Plus  (Release 10.1.7 of nieuwer).
Het Advanced plan

De gegevens voor de afleverbon worden ingevoerd in de Facturentabel, zoals dat ook gedaan wordt
voor facturen.

Als de gegevens op de factuur overeenkomen met die op de leveringsbon, kunnen dezelfde gegevens
worden gebruikt voor zowel het afdrukken van de leveringsbon als de factuur.

Hoe een afleverbon af te drukken
Selecteer In de Facturentabel de rij waarin de af te drukken leveringsbon staat en ga als volgt te
werk0:

Vanuit het menu Facturen > Facturen afdrukken
Selecteer layout UNI11
Selecteer onder Afdrukken als:

Afleverbon met bedragen
In it geval worden de gedetailleerde bedragen en het totale bedrag opgenomen in de
afleverbon.
Afleverbon zonder bedragen
Alleen de details van de afgeleverde goederen worden weergegeven in de afleverbon
zonder bedragen.

Bevestig met OK.

Personaliseren van de afdruk
Alle instellingen die bij Layout UNI11 horen worden gehandhaafd bij het afdrukken van de afleverbon.

Om de instellingen te veranderen gaat u naar Afdruk Layout Instellingen .

Onder Teksten > Afleverbon  kunt u de begin- en eindteksten van de afleverbon definiëren.

Voorbeeld van een afdruk:

https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/nl/download
https://www.banana.ch/nl/update
https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9365#deliverynote_reminder_texts
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Betalingsherinneringen afdrukken

Met Banana Boekhouding Plus, met de UNI11  layout (Engelstalig), kunt u betalingsherinneringen
afdrukken.

Vereisten om de lay-outvoorkeuren te gebruiken:

Banana Boekhouding Plus (Release 10.1.7 of nieuwer) .
Het Advanced plan

Op basis van de factuurgegevens ingevoerd in de facturentabel, kunnen herinneringen worden
afgedrukt.

Hoe een herinnering af te drukken
Selecteer in de facturentabel de rij van de factuur waarvoor u een herinnering wilt afdrukken ga als
volgt te werk:

In Menu Rapporten > Facturen afdrukken
Selecteer Layout UNI11
Onder Afdrukken als, selecteer een van de volgende opties:

1. herinnering
2. herinnering
3. herinnering

Bevestig met OK

https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/nl/download
https://www.banana.ch/nl/update
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Afdruk personaliseren
Alle instellingen voor de UNI11 layout zitten ook in de afdruk van de herinnering.

Om de instellingen te veranderen gaat u naar Print Layout Settings .

Onder Tekst → Herinnering  kunt u de begin- en eindteksten van de herinnering definiëren .

Afdruk voorbeeld:

https://www.banana.ch/apps/nl/node/9423
https://www.banana.ch/apps/en/node/9423
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Facturen archiveren

Met de toepassing Offertes en facturen kunt u uw offertes en facturen op elk moment van het jaar
archiveren. Het bestand waarin de factuurgegevens worden ingevoerd, blijft in de loop der jaren
hetzelfde.

Archiveer facturen afzonderlijk
Als u een of meer facturen afzonderlijk wilt archiveren, gaat u als volgt te werk:

Ga vanuit de tabel Facturen naar de Archief weergave.
In de kolom Archiefdatum vult u de datum in waarop u de factuur wilt archiveren.
Archiveer de factuur met het commando Facturen > Archiveer gegevens > Archiveer
tabel gegevens.
Ga in het menu Facturen naar de opdracht Archiveren.

Archiveren van facturen voor het jaar
Om facturen voor het hele jaar te archiveren, gaat u als volgt te werk:

Ga vanuit de tabel Facturen naar de Archief weergave.
In de kolom Archiefdatum voert u op de eerste regel de datum 31.12 in en kopieert en plakt u
op alle regels.
Archiveer de factuur met het commando Facturen > Archiveer gegevens > Archiveer
tabel gegevens.
Ga in het menu Facturen naar de opdracht Archiveren.

Factuur archief
In het facturenarchief vindt u alle gearchiveerde offertes en facturen.

Gearchiveerde facturen worden weergegeven in de tabel Archief (Facturen) en verwijderd uit de
facturentabel.

De tabel Archief (Facturen):

Wordt automatisch weergegeven bij het archiveren van facturen.
Als u de tabel sluit kunt u het commando menu Facturen > Archiceren... gebruiken om deze
weer te geven.

Tabel gegevens archiveren
Deze functie is beschikbaar in Banana Accounting+ Dev Channel.

Van de volgende tabellen kunnen gegevens worden gearchiveerd:

Contacten
Items
Facturen

http://www.banana.ch/nl/insiderprogram
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Offertes

Om tabelgegevens te archiveren:

Ga in de tabel staan met gegevens om te archiveren.
Activeer de kolom Datum gearchiv.
Voer de datum waarop u wilt archiveren in de kolom Datum gearchiv.
Kies van het menu Facturen > Archiveer gegevens > Archiveer tabel gegevens en kies
de tabel met de gegevens die gearchiveerd moeten worden.

Het programma creëert de Archief tabel waar alle gearchiveerde gegevens (Contacten, Items,
Facturen of offertes) worden opgeslagen.

Gearchiveerde gegevens bekijken
Deze functie is beschikbaar in Banana Accounting+ Dev Channel.

Gearchiveerde gegevens worden permanent opgeslagen in de Archief tabel.

Om de tabel met gearchiveerde gegevens te bekijken:

Menu Facturen > Archiveer gegevens > Toon gearchiveerde gegevens
Kies de tabel met de gearchiveerde gegevens om weer te geven

Het programma toont de Archief tabel waar alle gearchiveerde gegevens (Contacten, Items, Facturen
of offertes) zijn opgeslagen.

http://www.banana.ch/nl/insiderprogram
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Import

Catalogi gebruiken voor facturering
Het is mogelijk product catalogi te integreren in de Offertes en facturen applicatie. Bedrijven kunnen
catalogussen beschikbaar stellen aan hun dealers zodat deze makkelijker offertes en facturen kunnen
maken.
Als u hierover vragen heeft neem dan contact op met onze klantenservice .

Offertes en Facturen tools
U kunt de Offerters en Facturen Tools  extensie (Engelstalig) gebruiken om de volgende gegevens
van Banana te importeren of te exporteren:

Facturen
Offertes
Contacten
Items

https://www.banana.ch/nl/contact_form
https://www.banana.ch/apps/en/node/9667
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Inventaris

Met de applicatie Inventaris, voor voorraadbeheer, heeft u controle over hoeveelheden, de totale
waarde, en details van verkochte en gekochte goederen. U kunt allerlei verschillende soorten
magazijnen beheren.
Het is ook de ideale oplossing als u goederen online verkoopt, omdat u dankzij virtuele magazijnen de
te verzenden goederen en inkomende voorraad kunt bijhouden en zelfs meer ingewikkelde processen
kunt beheren.

Mutaties boeken

De Transactietabel is het hart van de applicatie, waarmee u inkomende en uitgaande mutaties kunt
invoeren voor ieder item, met hoeveelheid en prijs. U kunt het magazijn specificeren waar het artikel
vandaan komt en het magazijn waar het naar toe moet. U kunt ook beschrijvingen en notities
toevoegen.
Het programma werkt de hoeveelheden bij en als u een fout maakt kunt u de transactie aanpassen
om altijd een correcte weergave van de situatie te hebben.

De tabel Items
Alle items in het magazijn worden vastgelegd in de tabel Items. Ieder item heeft een ID en een
beschrijving. U kunt items groeperen in categorieën en subcategorieën. Het programma geeft in de
items tabel ook de beschikbare hoeveelheden en andere informatie weer die bijgewerkt wordt op
basis van de boekingen.
Er zijn diverse kolommen beschikbaar en de weergave kan worden aangepast. U kunt ook nieuwe
kolommen toevoegen met het menu Gegevens > Kolommen instellen. Er zijn verschillende
parameters gedefinieerd voor ieder item, die weergegeven worden in de transacties tabel.
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Zodra de parameters voor elk artikel zijn gedefinieerd, gaat het boeken van goederenmutaties heel
snel. U hoeft alleen maar de artikel-ID in te voeren in de transactietabel en de aantallen in te voeren.
Alle andere waarden worden automatisch ingevuld.

Klanten, leveranciers en projecten beheren

Met de Inventaris toepassing kunt u kolommen en tabellen toevoegen om informatie in te voeren over
de klanten aan wie de goederen worden verkocht en de leveranciers van wie de goederen worden
ontvangen. Daarnaast kunnen kolommen worden gebruikt om projecten met betrekking tot de
goederen te beheren.

Met de functie Rijen ophalen kunt u bewerkingen op klanten, leveranciers en voor projecten
weergeven.

Kijk voor meer informatie op de pagina Inventaris toepassing uitgebreide functionaliteiten.

Meerdere en virtuele magazijnen

Om goederen te beheren die binnenkomen of worden verzonden vanuit filialen, wordt de Locatietabel
gebruikt, waarin de locatie van elk magazijn wordt aangegeven. Als uw bedrijf magazijnen op
verschillende locaties heeft, kunt u opgeven vanuit welk magazijn de goederen binnenkomen of
vertrekken, of bijhouden vanuit welk magazijn de goederen naar klanten worden verzonden.

De Locatietabel kan ook voor andere doeleinden worden gebruikt door de koptekst te wijzigen. Een
praktisch gebruik zou kunnen zijn om de mutaties van sleutels vast te leggen in het beheer van een
flatgebouw, door de namen van de huurders in te voeren.

Daarnaast kunt u een online winkel beheren en in dit geval wordt de Locatietabel gebruikt om virtuele
magazijnen aan te geven.

Kijk voor meer gedetailleerde informatie op de pagina Inventaris toepassing uitgebreide
functionaliteiten.
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Afdrukken
Alle gegevens in de verschillende tabellen kan worden afgedrukt, in zijn geheel of als selectie. Voor
het afdrukken kunt u de kolommen personaliseren.

Hoe af te drukken:

Journaal
Door de afdruk optie te kiezen van het menu Bestand > Afdrukken, terwijl u in de
transactietabel staat, kunt u alle magazijn mutaties in chronologische volgorde afdrukken.

Itemkaarten
Om artikelgegevens af te drukken klikt u op menu Rapporten > Itemskaarten
Een of meer kaarten kunnen worden geselecteerd om af te drukken. Itemkaarten kunnen
worden afgedrukt volgens de volgende groepering:

Groep
Locatie
Periode

Talloze voordelen
Automatische berekeningen en specifieke functies brengen uw werk terug tot een minimum en
besparen u tijd en energie:

U heeft altijd accuraat voorraadbeheer:
Beginwaardes en hoeveelheden.
Huidige waardes en hoeveelheden.
Gescheiden kolommen voor inkomende en uitgaande items.
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Eenheidsprijzen en totale prijzen.
Bladen per artikel.
Bladen per artikelgroepen.
Artikel- en groepskaarten locatie.

U kunt direct zoeken naar artikelen en als ze niet langer beschikbaar zijn, kunt u ze vervangen
door andere.
Correcties zijn altijd mogelijk.
Aanduiding van welk magazijn goederen binnenkomen of verlaten en de uitwisseling van
goederen tussen locaties.
Exporteren naar PDF voor het archiveren van gegevens.
Importeren van gegevens vanuit andere programma's in Tekst, Ascii en CSV formaat.
Kolommen voor het archiveren van producten die niet langer beschikbaar zijn.

Functies die nu niet beschikbaar zijn
De toepassing Inventaris werd ontworpen als een krachtig maar gebruiksvriendelijk hulpmiddel dat
onafhankelijk van de andere Banana applicaties werkt.

Het belangrijkste element is het gebruiksgemak, dus we hebben het niet overladen met te veel
functies.

Hier zijn enkele functies die, hoewel gewenst door sommige gebruikers, op dit moment niet
beschikbaar zijn:

Berekening van kostprijzen en marges
In de Items tabel moeten eenheidsprijzen handmatig ingevoerd worden.

Gebruikers verwachten dat het programma automatisch kostprijzen en marges berekent.
Er zijn heel verschillende berekeningssystemen (gemiddelde prijs, LIFO, FIFO). We hebben
overwogen om deze functionaliteit te evalueren binnen de Items tabel, maar we zagen
dat dit het programma te complex zou maken en dat het hoe dan ook erg moeilijk zou zijn
om aan alle vereisten te voldoen.
We overwegen om specifieke afdrukken toe te voegen. We verwelkomen suggesties en
mogelijke eenvoudige oplossingen van u als gebruiker. Het zou erg handig zijn als u ons
een Excel bestand kunt sturen met uw wensen voor het rapport en welke methoden en
berekeningen u zou gebruiken om de prijzen te berekenen.

Afdrukken van de voorraad op een bepaald moment (einde van de maand).
Afdrukken van magazijnoverzichten per locatie.
Een bestand voor een nieuw jaar aanmaken.

Het is mogelijk dat bepaalde functies in de toekomst worden toegevoegd.
We stellen uw suggesties altijd op prijs.

Meer informatie:

Hoe te beginnen
Voorraadoverzichten
Voorbeelden van afdrukken
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Zo begint u met een Inventaris bestand

Een nieuw bestand aanmaken
Om een Inventaris bestand aan te maken moet u Banana Boekhouding Plus hebben geïnstalleerd en
de volgende stappen uitvoeren:

Menu Bestand → Nieuw
Kies Gebied en taal
Kies type Inventaris.

Stel de basisgegevens in
Via Bestand → Bestands- en boekhoudingseigenschappen... (Basisgegevens) stelt u de gegevens voor
uw bestand Inventaris in.

De Item(artikelen)tabel instellen
In de Itemtabel maakt u een lijst van al uw artikelen.

Voor ieder artikel moet u invoeren:

De Id om het artikel te identificeren. U kunt cijfers, letters of beide gebruiken.
De beschrijving.
De beginhoeveelheid.
De beginprijs.
De prijs per eenheid.

Nadat de gegevens ingevoerd zijn werkt het programma automatisch de waardes in alle kolommen
van de itemtabel bij.

De Locaties tabel instellen
Als uw bedrijf meerdere magazijnen heeft op verschillende locaties kunt u de inkomende en
uitgaande goederen beheren en de verplaatsing ervan voor alle magazijnen door locaties in te stellen.
U bent in staat uit te vinden hoeveel artikelen met bijbehorende waardes in iedere voorraad zijn en
bepalen of het nodig is goederen van het ene magazijn naar het andere te verplaatsen, afhankelijk
van de voorraad en verkopen.

In de Locatietabel moet u invoeren:

de Id om de locatie te identificeren
de beschrijving

De mutaties van de artikelen invoeren
In de Transactietabel voert u de aankopen, verkopen en alle verplaatsingen van het ene magazijn
naar het andere in.
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Voer de datum in
Voer de Id van het artikel in
Voer de inkomende of uitgaande hoeveelheid in

En alles is klaar! De kolommen van de waardes worden automatisch bijgewerkt en op dezelfde tijd
ook in de Itemtabel.

Itemjournaal en overzichten
Vanuit het menu Rapporten, Inventariskaarten..., kunt u kaarten voor ieder individueel item krijgen
door een selectie te maken of een lijst van alle items.

U kunt ook overzichten krijgen per itemgroep en ook per locatie. U vindt de opties in de dialoog voor
Inventariskaarten.
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Bestandseigenschappen

In het menu Bestand → Bestands- en boekhoudingseigenschappen kunt u de gegevens van uw
Inventaris bestand instellen.

Basisgegevens van het bestand

Voer de kopteksten voor de Inventaris overzichten in.

Adres

Voer het adres van uw bedrijf in.

Andere

Het tabblad Andere heeft de volgende opties:

Huidige taal
De huidige taal van het Inventaris bestand.

Aanmaak taal
De taal waarin het bestand is aangemaakt.

Extensies
Koppeling met extensies voor de maatwerk overzichten.
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Wachtwoord

Voer een wachtwoord in om het bestand veiliger te maken.

Teksten

Om veranderingen te maken in teksten en sleutels van de Inventaris applicatie.
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Itemstabel

In de Itemstabel moeten alle te beheren artikelen van de voorraad worden opgenomen.

De artikelenlijst maken
Alle artikelen in de voorraad moeten, ieder op één regel, van de itemstabel worden ingevoerd. Om de
bedragen van een serie artikelen op te tellen moet een groep worden gemaakt om ze in te
totaliseren.

De groep wordt gedefinieerd in de kolom Groep, aan het eind van de lijst met artikelen van dezelfde
categorie. De naam van de groep moet worden ingevoerd in de kolom Tel op in voor ieder te
groeperen artikel.

Afhankelijk van uw behoefte kunt u  meerdere groepen van artikelen maken.

Om de registratie van de artikelen compleet te maken is het nodig in te voeren:

De Id om het artikel te identificeren.
De beschrijving.
De beginhoeveelheid.
De begin eenheidsprijs.
De eenheidsprijs.

Itemstabel kolommen
Koppelingen
Koppeling naar een digitaal document.
Groep
Kolom en rij waarin het totaal van een gegeven verzameling artikelen (groep) opgeteld wordt.
Id
Identificatie van het artikel, kan uit cijfers, letters of beide, bestaan.
Beschrijving
De beschrijving van het artikel..
Tel op in (in kolommen instellen wordt het geschreven als RijGroepIn)
In deze kolom moet de groepsnaam staan waarin ieder onderdeel van deze rij opgeteld wordt.
Notities
U kunt hier aantekeningen maken voor artikelen of andere dingen.
Rekening
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De rekening in de hoofdboekhouding waar dit artikel bijhoort.
Eenheid
Een afkorting om de eenheden van een artikel aan te duiden (bijvoorbeeld stuk, doos, kg).
Hoeveelheid Begin
De begin hoeveelheid.
Begin Eenheidsprijs
De prijs per eenheid waarmee begonnen wordt.
Beginwaarde
De waarde van het artikel waarmee begonnen wordt (wordt door het programma berekend).
Hoeveelheid Plus
Hoeveelheid inkomende artikelen, gerelateerd aan een aankoop of verplaatsing.
Hoeveelheid Min
Hoeveelheid uitgaande artikelen, gerelateerd aan een verkoop of verplaatsing.
Hoeveelheid Wijziging
Verschil tussen de inkomende en uitgaande artikelen. Deze waarde wordt automatisch door het
programma berekend.
Hoeveelheid Saldo
Hoeveelheid die beschikbaar is van een artikel. Deze waarde wordt automatisch door het
programma berekend en komt overeen met het verschil tussen de inkomende en uitgaande
hoeveelheid opgeteld bij de beginhoeveelheid.
Eenheidsprijs
Prijs per eenheid van het artikel. De ingevoerde waarde wordt gebruikt in de transactietabel
voor de berekening van de totale waarde.
Bedrag Totaal
Bedrag berekend door het programma, gebaseerd op hoeveelheid en eenheidsprijs.
Hoeveelheid Effectief
Prijs Effectief
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Transactietabel

Dit is de tabel waarin de mutaties van de goederen worden geregistreerd:

Aankopen
Verkopen
Verplaatsingen.

Door het invoeren van de mutaties worden in de itemstabel ook automatisch de hoeveelheden en
waardes van de artikelen bijgewerkt.

Als er meerdere magazijnen (hoofdkantoor en vestigingen) tegelijk in bedrijf zijn kunnen de ID codes,
die in de locatiestabel  ingesteld zijn, gebruikt worden. Deze ID's verwijzen naar de plaatsen waar de
magazijnen liggen zodat de verplaatsingen van de artikelen in de gaten gehouden kunnen worden.

De afkortingen van de ID's moeten worden ingevoerd in de kolommen Locatie en Transfer van de
transactiestabel. Als deze niet zichtbaar zijn kunnen ze worden weergegeven met menu  Gegevens →
Kolommen instellen.

Transactietabel kolommen
Koppeling
Koppeling naar een digitaal document.
Datum
De datum van de mutatie.
Doc
Documentnummer (bijvoorbeeld afleveringsnota nummer).
Prod. Id
Numerieke of alfanumerieke waarde om het artikel te identificeren. Deze Id moet in de
itemstabel voorkomen.
Prod. Beschrijving
Tekst met artikelbeschrijving die automatisch wordt overgenomen van de Id kolom van de
itemstabel.
Beschrijving
Beschrijving van de actie in deze mutatie, bijvoorbeeld "verkoop artikelen".
Notities

http://www.banana.ch/doc/nl/node/9769
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U kunt hier aantekeningen maken voor artikelen of andere dingen.
Hoeveelheid Plus
Hoeveelheid inkomende artikelen, gerelateerd aan een aankoop of verplaatsing vanuit andere
magazijnen.
Hoeveelheid Min
Hoeveelheid uitgaande artikelen, gerelateerd aan een verkoop of verplaatsing vanuit andere
magazijnen.
Eenheid
Een afkorting om de eenheden van een artikel aan te duiden (bijvoorbeeld stuk, doos, kg); deze
wordt door het programma overgenomen uit de itemstabel.
Eenheidsprijs
Prijs per eenheid van het artikel waarmee de totale waarde van de artikelen op basis van de
hoeveelheden berekend wordt .
Bedrag Totaal
Totale waarde van de goederen aangekocht, verkocht of verplaatst.
Locatie
Aanduiding van de plaats waar het magazijn zich bevindt en waar de artikelen binnenkomen
of vandaan gaan.
Locatie Beschrijving
Plaatsnaam waar het magazijn zich bevindt.
Transfer
Afkorting van de plaatsnaam waar het magazijn zich bevindt waarvandaan de artikelen
aankomen of vertrekken van of naar een ander magazijn.
Verplaats Beschrijving
Plaatsnaam waar het magazijn zich bevindt waarvandaan de artikelen aankomen of vertrekken
van of naar een ander magazijn.
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Locatiestabel

De locatiestabel wordt gebruikt wanneer het bedrijf meer dan één magazijn heeft op verschillende
locaties. Als u de ID codes voor de bronlocatie en de doellocatie invoert in de transactietabel in de
kolommen Locatie en Transfer, weet u de waardes van alle artikelen, ook voor elk magazijn en de
onderlinge verplaatsingen. Hierdoor kunt u rekening houden met het totale aantal artikelen dat alle
magazijnen in- en uitgaat.

Zie voor meer informatie de pagina Transactietabel.

Locatietabel kolommen
Id
Identificatie van de plaats waar het magazijn zich bevindt.
Beschrijving
Naam van de plaats waar het magazijn zich bevindt.
Notities
Ruimte voor notities.
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Alles opnieuw controleren

Deze functie is te vinden onder Acties menu. Met het commando Alles opnieuw controleren...
berekent en controleert het programma alles opnieuw en geeft eventuele fouten of verschillen weer.

Gebruik dit commando wanneer u twijfelt of er een probleem is.
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Voorraadoverzichten

De inhoud van alle tabellen in Inventaris geeft al overzichten omdat de kolommen voortdurend na
iedere mutatie bijgewerkt worden.

De gegevens uit een tabel kunnen worden afgedrukt met Bestand → Afdrukken. Ze kunnen ook
worden geëxporteerd naar Pdf, Excel, Xml, Html, Txt en JsonCsv.

De volgende overzichten kunnen worden gemaakt met Rapporten → Inventariskaarten:

Een journaal van een of meer geselecteerde artikelen.
Een volledig journaal van alle artikelen.
Een journaal van artikelen van een bepaald magazijn als er meerdere magazijnen zijn.

Inventaris Rapport
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Algemeen

Filter
Door de naam van het artikel in te voeren verschijnt een lijst met artikelen met dezelfde naam. De
artikelen die van belang zijn kunnen worden geselecteerd in de lijst, of, door Alles selecteren te
kiezen, wordt een journaal van alle artikelen getoond.

Groeperen volgens
Item

Als deze optie wordt gekozen worden alle items of alleen de geselecteerde weergegeven.

Location

Als deze optie wordt gekozen worden de inventariskaarten die horen bij de geselecteerde
magazijnlocatie weergegeven.

Alleen totalen

Als deze optie wordt gekozen worden alleen de totalen van de inventariskaarten weergegeven.
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Periode

Alles

Alle artikelmutaties worden meegenomen.

Geselecteerde periode

Dit is voor een gespecificeerde periode, waarbij de begin- en einddatum aangegeven worden.

In dit geval worden de artikelen die in de geselecteerde periode horen weergegeven.
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Aanpassing

Naam

Voer een tekst in om de naam van het maatwerkoverzicht te definiëren.

Beschrijving

Voer een tekst in voor de beschrijving van het maatwerkoverzicht.

Opties
De opties bepalen hoe het maatwerkoverzicht wordt weergegeven:

Dit venster elke keer weergeven

Het maatwerkoverzicht wordt weergegeven in het dialoogvenster en kan aangepast worden..

In menu weergeven

Het maatwerkoverzicht wordt weergegeven in het menu Inventariskaarten.

In het 'Favorieten' menu weergeven

Het maatwerkoverzicht wordt weergegeven in het menu Favorieten.

Alleen lezen

Het maatwerkoverzicht is in alleen lezen modus.
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Voorbeelden van afdrukken

Journaal per artikel

Journaal voor meerdere artikelen

Journaal per locatie

Journaal voor meerdere locaties
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Applicatie Inventaris toepassing met
geavanceerde functies

De applicatie Inventaris kan gebruikt worden voor zeer geavanceerde doeleinden.

Klanten / project beheer
Om uit te zoeken aan welke klanten een product is verkocht of geleverd, kun je als volgt te werk
gaan:

Voeg een kolom toe in de transactietabel, waar u de naam van de klant of project invoert.
Voeg een tabel toe waarin u de klanten invoert en een code toekent.

Voeg een kolom toe in de transactietabel die is gekoppeld aan de klant.

U kunt zoveel kolommen / tabellen toevoegen als u wilt om projecten, leveranciers of andere zaken bij
te houden.

Om uitgevoerde transacties voor een klant te filteren gaat u naar de transactietabel en gebruikt u in
de kolom Klanten de volgende commando's: 
Rijen ophalen en sorteren; klik met rechts op de cel met de klantennaam en kies Rijen ophalen; de
filter functie.

Online shop / virtuele magazijnen
Als u een webwinkel heeft, kunt u de Locaties tabel gebruiken om virtuele magazijnen te definiëren
waar u goederen kunt registreren om te verzenden, die binnen gekomen zijn, gereserveerd, etc.

Hier zijn wat voorbeelden:

Online aankoop van goederen door een klant.
Zodra de bestelling is ontvangen boekt u een mutatie tussen het fysieke magazijn en het
virtuele magazijn genaamd "Expeditie".
Wanneer de goederen fysiek worden verzonden boekt u een uitgaande mutatie vanuit het
magazijn genaamd "Expeditie".

Goederen bestellen bij een leverancier.
Wanneer u goederen bestelt, boekt u een inkomende mutatie naar het virtuele magazijn
met de naam " Ontvangsten".
Wanneer de goederen arriveren, boekt u de mutatie van Ontvangsten naar het hoofd
magazijn.

Door andere virtuele locaties te maken, kunt u ook complexere processen beheren.

Gegevens importeren
Met het commando importeren kunt u gegevens van andere programma's overnemen op een van de
volgende manieren:

Open het bestand in Excel en arrangeer de kolommen zoals u ze in Banana gebruikt en kopieer
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en plak dan de gegevens.
U kunt ook een weergave aanmaken en daarbij de kolommen instellen waarin de mutaties
vastgelegd worden.
Extensies maken die gegevens importeren en converteren vanuit bestaande formaten
(Engelstalig).

https://www.banana.ch/apps/en/node/9561
https://www.banana.ch/apps/en/node/9561
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Banana Timesheet applicatie - gratis

De Banana Boekhouding Time sheet  is een gratis applicatie binnen Banana Boekhouding, waarmee
u uw werktijden kunt plannen en beheren.

Het bestaat uit een tabel met verschillende kolommen en berekeningen die al op alle behoeften zijn
afgestemd. Afhankelijk van ùw behoeften worden de gewenste kolommen weergegeven.

Onmiddellijke start dankzij de modellen
Als u onmiddellijk wilt beginnen kunt u een van de voor-ingestelde modellen met al ingestelde
kolommen:

Eenvoudige registraties    - de dagelijks gewerkte uren worden aangegeven (met verschuldigde1.
uurinstellingen).
Systematische registraties  - begin- en eindtijden van het werk worden aangegeven.2.
Loon in uren - geeft de dagelijks gewerkte uren aan (zonder verschuldigde uurinstellingen).3.

Compleet en flexibel
Met Time sheet plant en beheert u:

Gewerkte uren.
Overwerk uren.
Voorziene uren.
Reizen en vergoedingen.
Afwezigheid, vakantie en verlof.
Verschillen tussen geplande en gewerkte uren.
Overdracht van gegevens naar het volgende jaar (teveel aan vakantiedagen en onbetaalde
tijd).
Afdrukken van maandelijkse en jaarlijkse overzichten.

Om Time sheet te kunnen gebruiken moet u het Time sheet bestand instellen:

https://www.banana.ch/nl/time-sheet
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Kop
De Time sheet koptekst wordt
gehaald uit de teksten die
ingevoerd zijn in
Bestand → Bestands- en
boekhoudingseigenschappen →
Time sheet

 

Werktijden schema

U kunt u werkuren plannen door
de overzichten van het vorig jaar
in te voeren, werkdagen,
vakanties en verschuldigde
werkuren met
Bestand → Bestands- en
boekhoudingseigenschappen →
Begin

 

Datums, vakanties en
feestdagen
U kunt de periode definiëren en
de vakantie- en vrije dagen
aanpassen. Gebruik de
kolom Feestdag van tabel
Journaal van Time sheet

 

Time sheet gegevens
Voer de Time sheet gegevens in
waarbij u uw werkuren en
afwezigheid vastlegt en plan uw
vakantie. Gebruik de
Journaaltabel van Time sheet om
uw gegevens in te voeren.

 

Controle
Houd het overzicht over de
totalen en saldi van gewerkte
uren, verschuldigde betaling,
verlofdagen en vakantie.
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Hoe een Timesheet beginnen

We gaan ervan uit dat u Banana Boekhouding 9 heeft geïnstalleerd. In de Free Version versie werkt
Time sheet zonder beperkingen.

U kunt eenvoudig en snel beginnen met behulp van een van onze voorbeeldmodellen.

Banana Boekhouding bevat drie soorten modellen:

Time sheet - Vereenvoudigde registratie1.
Het totaal aantal gewerkte uren wordt dagelijks bijgehouden
Time sheet - Systematische registratie2.
De begin- en eindtijd van het werk worden bijgehouden (meerdere werkperiodes zijn mogelijk)
en het programma berekent het totaal aantal gewerkte uren.
Time sheet - Salaris per uur3.
De dagelijks gewerkte uren worden bijgehouden (zonder de verschuldigde uren in te stellen).

In ons voorbeeld gebruiken we het model van Time sheet met Systematische registratie.

Uw Time Sheet bestand instellen

Ga als volgt te werk:

Menu Bestand → Commando Nieuw
Kies de Gebied/Taal
Kies de Categorie -> Alles of Ander
Type in het zoekgebied Time sheet of klik onder Type op Time sheet. Het programma laat de
beschikbare modellen zien.
Kies in het gebied aan de rechterkant het gewenste model.
Door dubbel te klikken op de naam van het gekozen model of door op de knop Aanmaken te
klikken opent het programma meteen het bestand.
Sla het bestand met een nieuwe naam op.
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Uw gegevens instellen

Stel uw eigen gegevens in met menu Bestand → Bestands- en boekhoudingseigenschappen
(Basis) → Timesheet.

Voer uw voor- en achternaam in, begin- en einddatum, werk percentage en andere benodigde
gegevens als deze beschikbaar zijn.

Stel werkuren volgen contract in

Stel het aantal wekelijks te werken uren in via Bestand → Bestands- en
boekhoudingseigenschappen (Basis) → Start.

De cellen in de sectie Overbrengen zijn bedoeld voor onbetaalde werkuren of voor ongebruikte
vakantiedagen van vorig jaar.

Voer werkuren voor iedere dag in en definieer werk-, feest- en vakantiedagen. Deze instellingen
worden weergegeven in de tabel Journaal.
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Werktijd registreren

Begin en eindtijd van het werk, uren afwezigheid als gevolg van ziekte, vakantie en verlof worden
geregistreerd in de tabel Journaal.

In de eerste regel van het overzicht in het Journaal worden de uren van niet opgenomen
vakantiedagen van het voorgaande jaar doorgegeven; de uren van jaarlijkse vakanties waar u
contractueel recht op heeft moeten ingevoerd worden in de rij van de eerste dag van de maand.

Niet-werkdagen worden weergegeven in blauw en feestdagen in rood.

Het programma berekent de dagelijkse en maandelijkse totale bedragen gebaseerd op de ingevoerde
gegevens en ook op het verschil tussen gewerkte uren en uren die betaald moeten worden en het
saldo dat overgedragen moet worden.

Verschuldigde en gewerkte weekuren en ook het saldo van de vakantiedagen worden automatisch
gerapporteerd zoals in het voorbeeld hieronder.

Uw maandoverzicht afdrukken

Met het menu Hulpprogramma's → Maandelijks Rapport... kunt direct een compleet maandelijks
rapport van de geselecteerde periode met de belangrijkste kolommen aanmaken, afdrukken en
opslaan.
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Op de volgende pagina's kunt u meer informatie en specifieke voorbeelden van de Time sheet
applicatie vinden:

Time Sheet
Een Timesheet bestand instellen
Tabel Journaal
Project uren beheren
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Karakteristieken van Time Sheet

 Time sheet is de nieuwe Gratis Banana Boekhouding Plus toepassing
waarmee u eenvoudig uw werktijden kunt beheren en direct weet wat de situatie van gewerkte uren,
overuren, vakantie en absentie is.

Om te beginnen download en installeert u Banana Boekhouding Plus  en kiest u bij het aanmaken
van een nieuw bestand het Time sheet model.

Vele mogelijkheden voor het snel en eenvoudig beheren van uw uren.

Gratis software die op elk besturingssysteem werkt, ook op mobiele apparaten.
Eenvoudig te gebruiken en implementeren oplossingen, geen login of wachtwoord nodig.
Iedere medewerker houdt de gegevens op zijn of haar eigen computer of mobiele apparaat.
Volledig aan te passen een de eisen van de medewerker en het bedrijf.
Geen rekenfouten meer en veel tijdwinst.
Modellen met de kalender van het huidige jaar beschikbaar.
Krachtige, geautomatiseerde berekeningen.
Uniformiteit van berekeningen. Alle berekeningen zijn gebaseerd op uren en minuten en
hiermee kan op elk geval en op elke eis ingespeeld worden.
Saldi en totalen worden direct per dag, maand en jaar bijgewerkt.
Gegevens worden ingevoerd in vooraf gedefinieerde kolommen, voor resultaten die altijd netjes
geordend en duidelijk zijn.
Verwachtingen voor gewerkte uren.
Beheer van uren voor projecten.
Indicatie van gewerkte uren en van minder of meer gewerkte uren en een progressief saldo.
Indicatie van opgenomen en resterende vakantiedagen met overdracht naar het volgende jaar.
Mogelijkheid om andere nuttige informatie voor het bedrijf te coderen (projecten, onkosten,
notities).
Voldoet aan de voorschriften van het Europese Hof van Justitie en aan de Zwitserse wetgeving.

http://www.banana.ch/nl/node/11181
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Hoe houdt u de uren bij
Time Sheet ondersteunt verschillende methoden om gegevens in te voeren:

Systematische invoer.
Voer de begin- en eindtijden in en het programma berekent de gewerkte uren. Gebruik hiervoor
de Start1-Stop1, Start2-Stop2, ... , Start5-Stop5 kolommen waarin u de begin- en
eindtijden kunt invoeren.
Vereenvoudigde invoer.
Geef de uren die per dag gewerkt worden aan.
Gebruik hiervoor de Werk1 en Werk2 kolommen om de per dag gewerkte uren in te voeren.
Gemengde invoer.
U kunt zowel de begin- en eindtijden als de totale gewerkte tijd invoeren.
Gebruik hiervoor de Start en Stop, en de Werk kolommen.

Nauwkeurige en eenduidige berekeningen voor elk gebruik
Timesheet gebruikt altijd het uren en minuten formaat (bijvoorbeeld 8:15). Vakantiedagen en
afwezigheid worden ook per dag met uren en minuten aangegeven. Hiermee zijn ongeregelde en
variabele werktijden eenvoudig en accuraat te beheren.

De totalen worden ook getoond in uren en minuten. Met deze eenduidigheid heeft men een exact
overzicht van iemands werkomstandigheden, volledig volgens wettelijke regelingen, en worden
discussies over de berekeningen tussen werknemer en werkgever vermeden.

Hierna vindt u een overzicht hoe gegevensinvoer en berekeningen plaatsvinden.

Verwachtte werktijd (verschuldigde uren)
Voor ieder dag van de week kunnen het exacte aantal uren en minuten van verschuldigd werk
worden aangegeven. Het programma geeft dan het verwachtte aantal uren per week. De
werktijden kunnen ook tijdelijk veranderd worden (bijvoorbeeld een verandering van uren voor
één week).
Gewerkte uren
Het dagelijks aantal gewerkte uren kan ingevoerd worden als begin- en eindtijden, of zelfs als
een totaal aantal uren en minuten, of een combinatie van beide. Het programma berekent dan
het totaal aantal dagelijks gewerkte uren.
Extra uren voor nachtdiensten of vakantie
Deze kunnen worden opgegeven als uren en minuten en als een percentage; het programma
berekent dan het totaal.
Vakantie
Vakantie wordt aangegeven in uren en minuten voor het hele jaar. Het is eenvoudig,
vermenigvuldig gewoon het aantal uren per week met het aantal vakantieweken. Het
programma berekent de overblijvende vakantiedagen tot op de minuut, zelfs als er variabele
werktijden zijn.
Verzuim als gevolg van ziekte, militaire dienst of wat dan ook
Deze worden ook in uren en minuten verwerkt. Het programma berekent het totale verzuim per
dag.
Totaal aantal uren
Dit is de som in uren en minuten van de gewerkte uren, overwerk en afwezigheden. Het
programma berekent het dagelijkse verschil tussen de verschuldigde (verwachtte) uren en het
totaal. Er is ook een oplopend totaal van verschillen zodat u direct inzicht heeft in het
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urensaldo.
Kolommen voor het optellen van de tijden
Het programma berekent het maandelijkse en jaarlijkse totaal, weergegeven in uren en
minuten, zo dat u volledige controle heeft en eenduidigheid van de berekeningen.
Uren in decimaal formaat
Bij het invoeren van uren kunt u ook een decimaal aantal opgeven (8.50). Het programma
converteert dit naar uren en minuten (8:30).
Timesheet laat sommige totalen ook in decimaal formaat zien om de invoer in andere
programma's eenvoudig te maken.
Het maandoverzicht presenteert de totalen van de dagelijkse en maandelijkse uren.
Met afdrukextensies kunt u werktijden optellen en weergeven in elk ander formaat.

Gegevensopslag
Alle gegevens worden opgeslagen in één bestand waaruit u alles eenvoudig op kunt halen
zonder tijd te verspillen.
Geef het bestand de naam die u wenst.
U kunt een onbeperkt aantal bestanden gebruiken.
Sla uw gegevens op elk medium op, computer, netwerk, cloud of verstuur ze per e-mail . U
kunt de gegevens bereiken, waar u ook bent.
Maak uw Timesheet veiliger door wachtwoordbescherming te gebruiken.

Gebaseerd op kolommen zoals in Excel
Timesheet heeft een Journaaltabel  met kolommen die al ingesteld zijn, waarin u uw gewerkte uren
kunt noteren (begin- en eindtijden), vakantie, overuren of ziekteverzuim, elke dag weer.

De kolommen van de Journaaltabel zijn voorgedefinieerd en kunnen naar wens weergegeven
worden.
Voorgedefinieerde kolommen betekent:

Prognose van gewerkte uren.
Werkelijke gewerkte uren.
Verschil tussen gewerkte en verschuldigde uren. Daarvoor worden de overuren of de in te
halen uren gerapporteerd.
Annuleringen en vergoedingen.
Projecturen.

Mogerlijkheid om meerdere rijen voor dezelfde werkdag toe te voegen .
In de kolom Koppelingen kunt u een koppeling naar een document toevoegen (bijvoorbeeld een
medisch verklaring) .
Met het commando Zoeken kunt u gegevens snel opzoeken.

Foutrapportage en -controle
Commando om Timesheet opnieuw te berekenen.
Melding van elke verkeerde instelling, verschil of fout.
Iedere foutmelding heeft een link naar een helppagina die de oorzaak en de oplossing uitlegt.
Mogelijkheid om te corrigeren.

http://www.banana.ch/nl/node/11059
http://www.banana.ch/doc/nl/node/9047
http://www.banana.ch/doc/nl/node/9726
http://www.banana.ch/doc/nl/node/9726
http://www.banana.ch/doc/nl/node/9617
http://www.banana.ch/doc/nl/node/3352
http://www.banana.ch/doc/nl/node/3352
http://www.banana.ch/doc/nl/node/4067
http://www.banana.ch/doc/nl/node/4067
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Maandoverzichten en -afdrukken
De Journaaltabel kan afgedrukt worden zoals deze op het scherm wordt weergegeven, of een
selectie ervan.
Maandoverzicht.

Gegevens exporteren, importeren en archiveren
Direct kopiëren uit en plakken in Excel.
Tabellen exporteren naar pdf en diverse andere formaten.
Archiveren van afdrukken en gegevens in pdf of andere formaten.
Het bestand op elk backup apparaat opslaan.
Timesheet gegevens importeren in andere programma's.

Uitgebreide documentatie
Ieder dialoogvenster en foutmelding heeft zijn eigen documentatie bereikbaar in één klik .
Documentatie die voortdurend bijgewerkt wordt .
FAQ .
Documentatie ook in Pdf formaat beschikbaar.

Functies niet beschikbaar
De volgende functies zouden onze gebruikers graag willen hebben, maar zijn momenteel niet
beschikbaar:

Mogelijkheid om het logo en een notitie voor de handtekening op de afdruk van het
maandverslag te zetten en de af te drukken kolommen te selecteren.

https://www.banana.ch/doc/nl/search?search=fout
https://www.banana.ch/doc/nl/documentatie
https://www.banana.ch/nl/node/9340
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Bestandseigenschappen - Basis

Kies Bestands- en boekhoudingseigenschappen... van het menu Bestand en voer het volgende
in het Urenregistratie tabblad in:

Naam en Achternaam,
Begindatum en Einddatum voor het huidige jaar,
Werk percentage en andere gegevens indien van toepassing.
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Tabel Journaal

In de tabel Journaal van Timesheet kunt u de dagelijkse gegevens naar uw wens invoeren en
aanpassen.
Dankzij de rijen en kolommen met totalen heeft u direct inzicht in uw situatie.

De tabel Journaal heeft diverse kolommen om aan alle behoeften te voldoen. Afhankelijk van uw eisen
kunnen de benodigde kolommen worden weergegeven.

Kenmerken van de rijen, kleuren en formaten
Bij het aanmaken van een nieuw bestand worden de rijen van het Journaal automatisch gegenereerd.
Bij het gebruik van een bestaand model zijn de rijen al ingevuld.

Dagelijkse rijen

Dagelijkse rijen worden gebruikt om uw gegevens in te voeren.

Normale rijen - verwijzen naar rijen voor gewerkte uren.
Rode rijen - verwijzen naar officiële vakantiedagen.
Blauwe rijen - verwijzen naar niet werkdagen.
Geel gemarkeerde rijen - verwijzen naar de huidige datum.

Meerdere rijen voor een dag

Door de dag rij te dupliceren kunt u extra informatie invoeren over dezelfde dag, zoals tijdschema per
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project, aantekeningen of andere dingen.
Om verschil tussen de eerste en de vervolgrijen te laten zien wordt de Dag beschrijving iets naar
rechts verschoven weergegeven.

De rijen Overbrengen, Beginnen, Totaal en Saldo

De rijen Overbrengen, Beginnen, Totaal en Saldo worden vetgedrukt aangegeven.

De rij Overbrengen geeft automatisch de vakantiedagen en uren weer die bij het vorige jaar
horen. Deze gegevens werden ingevoerd via menu Bestandseigenschappen.. → Begin.
De rijen Beginnen worden gebruikt voor het begin van het jaar en de maand. Voer hier de
beginwaardes voor vakantie en uren in.
De rij Totaal wordt gebruikt voor het eind van het jaar en de maand. Het totaal van de
kolommen wordt hier automatisch opgeteld en weergegeven.
De rijen Saldo worden automatisch berekend door het programma geven de voortschrijdende
waarde van de kolommen die waardes bevatten.

Tabel Journaal weergaven
De tabel Journaal wordt aangemaakt met een aantal kolommen dat de meeste van uw eisen dekt.
Vooringestelde kolommen worden weergegeven afhankelijk van de weergave die u kiest:

Basis - geeft de belangrijkste kolommen weer.
Minimaal - geeft de kolommen weer om uw gegevens in te voeren.
Compleet - geeft alle beschikbare kolommen van het Journaal weer.

Journaalkolommen in Basis weergave
De weergave Basis toont de belangrijkste kolommen die in Timesheet gebruikt worden.

Datum

Deze kolom is beveiligd en wordt gebruikt om de datum van de dag weer te geven.

Feestdag

Deze kolom geeft het type (werkdag, feestdag etc) van de dag aan. Als deze cel leeg gelaten wordt
krijgt deze de waarde zoals gedefinieerd in Bestandseigenschappen of zoals de waarde gedefinieerd
met de W code (zie hierna).

Mogelijke waardes zijn:

Leeg - Werkdag
0 - De huidige dag is een feestdag (de rij wordt in rood weergegeven).
Als een dag over het algemeen wordt beschouwd als een "feestdag", maar waarop je wel moet
werken, moet je "werkdag" invullen.
1  - De huidige dag is een niet-werkdag (de rij wordt in blauw weergegeven).
2 - De huidige dag is een werkdag. Dit overschrijft de vooringestelde waarde.
[0] -  Een feestdag, automatisch ingesteld zoals gedefinieerd in Bestandseigenschappen. Er is
geen waarde in de kolom Verschuldigd.
[1]  - Een niet-werkdag automatisch ingesteld zoals gedefinieerd in Bestandseigenschappen. Er
is geen waarde in de kolom Verschuldigd.
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W0 - Definieert  de huidige dag als een feestdag. In opvolgende weken wordt dezelfde dag
ingesteld met de waarde (0) (feestdag).
W1  - Definieert  de huidige dag als een niet-werkdag. In opvolgende weken wordt dezelfde dag
ingesteld met de waarde (1) (niet-werkdag).
W2 - Definieert  de huidige dag als een werkdag. In opvolgende weken wordt dezelfde dag
ingesteld met de waarde (2) (werkdag).
WR - Reset de huidige dag naar de waarde van de instelling van de Bestandseigenschappen.
WA - Reset de huidige dag naar de waarde van de instelling van de Bestandseigenschappen. In
opvolgende weken wordt dezelfde dag ingesteld naar de waarde van de
Bestandseigenschappen.

Dag beschrijving

Deze kolom wordt door het programma gebruikt om de naam van de dag te genereren gebaseerd op
uw gegevens.
Als u een andere tekst wilt gebruiken dan die het programma voorstelt, voert u een tekst in
voorafgegaan door het hekje # (bijvoorbeeld #Kerstmis, #Nationale feestdag).

Start1, Stop1, Start2, Stop2...

In deze kolommen kunt u de begin- en eindtijd van de gewerkte uren invoeren. De kolommen Totaal
en Verschil worden automatisch bijgewerkt door het programma.

Ziekteverlof

Kolom om de uren ziekteverlof in te voeren.

Vakantie

Kolom om vakantiedagen (in uren) in te voeren.

Aanpassing

Kolom om een correctiewaarde in te voeren.

Totaal

Deze kolom is beveiligd. Het programma gebruikt deze kolom om automatisch het totaal van
gewerkte uren, overuren, verlof en correcties weer te geven.

Code verschuldigd

Met deze kolom kunt u, indien nodig, de waarde van de kolom Verschuldigde uren definiëren.

Als de code Verschuldigd leeg gelaten wordt vult de software de waarde in Verschuldigd in
volgens de instellingen van menu Bestand → Bestands- en boekhoudingseigenschappen →
Begin.

Om de waarde van Verschuldigd in de tabel Journaal te veranderen:

Reset Verschuldigd.
Codes die ingevoerd moeten worden in de Code verschuldigd kolom om de dagelijkse
verschuldigde uren aan te passen van de rij waarin u zich bevindt. U moet dan een nieuwe
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waarde invoeren in de kolom Verschuldigd.
DS (Vandaag instellen) de verschuldigde uren voor vandaag zonder de verschuldigde
uren van de andere dagen te veranderen.
WS (Weekdag instellen) stelt de verschuldigde uren in voor een specifieke dag in de week
en voor dezelfde dagen in de volgende weken.
PS (Vooraf gedefinieerd instellen) stelt de verschuldigde uren voor die dag en opvolgende
dagen waarbij dezelfde vooringestelde waarde behouden blijft.

Reset codes voor per dag Verschuldigd.
WR (Weekdag opnieuw instellen).
Stelt de waarde voor de weekdag opnieuw in.
WA (Alle werkdagen opnieuw instellen)
Stelt all waarden voor de weekdagen opnieuw in.
PR (Voorgedefinieerd opnieuw instellen)
Reset de algemene standaardinstelling. Verwijdert de eerder ingestelde
standaardwaarde.
PA (Voorgedefinieerd en weekdagen opnieuw instellen)
Stelt de algemeen voorgedefinieerde waarde en alle waardes van de week.
Dit is alsof u opnieuw begint.

Code om de Voortschrijdende berekening te resetten
RP (Begin progressief opnieuw)
De waarde in de kolom Progressief begint opnieuw vanaf nul. Voer deze code in de eerste
rij van de maand in wanneer alle gewerkte uren, met een uurloon, zijn betaald voor de
voorafgaande maand.

Verschuldigd

Deze kolom is beveiligd. De software berekent automatisch het verschil tussen gewerkte en
verschuldigde uren. Aan het eind van iedere maand wordt het totaal van verschuldigde uren
overgedragen.

Als er geen gegevens staan in de kolom Verschuldigd gebruikt het programma de waardes die
in het Bestandseigenschappen - Begin tabblad staan.
Als er codes worden ingevoerd in de kolom Code verschuldigd worden de berekeningen
uitgevoerd op basis van deze codes (zie vorige paragraaf).
Alle rijen die in de Feestdag cel een 0 (feestdag) of een 1 (niet-werkdag) hebben laten in de
Verschuldigd kolom een lege cel zien.

Verschil

Deze kolom is beveiligd. De software berekent automatisch het verschil tussen gewerkte (Totaal) en
verschuldigde (Verschuldigd) uren. Totalen voor de verschillen worden per maand- en jaareinde
gerapporteerd.

Progressief

Deze kolom is beveiligd. De software berekent automatisch het verschil tussen gewerkte (Totaal) en
verschuldigde (Verschuldigd) uren. Totalen voor de progressieve verschillen worden per maand- en
jaareinde gerapporteerd.
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Kolommen voor het Journal in weergave Compleet
In de weergave Compleet zijn extra kolommen ten opzichte van de weergave Basis beschikbaar.

Sectie

Dit is een beveiligde kolom. Hij wordt gebruikt door het programma om onderscheid te maken tussen
regels die voor gegevensinvoer gebruikt worden en regels die specifiek zijn voor het systeem.

Regels die gebruikt worden voor invoer en verandering van gegevens (gewerkte uren, afwezigheden,
vakantie, etc.) hebben een lege cel in deze kolom.
De rijen die door de software voor berekeningen worden gebruikt hebben een specifieke code in de
kolom Sectie en mogen niet veranderd worden omdat er dan fouten kunnen optreden in de
berekeningen in dit gedeelte.

De gebruikte codes zijn (in dit geval voor het jaar 2020): AllStart, YearStart_2020,
MonthStart_202001, MonthTotal_202001, MonthBalance_202001, SpaceAfterMonth_202001.

De waarde van een code wordt gedefinieerd door verschillende elementen:

Periode

All - Voor alle rijen.
Year - Voor de rijen van het Jaar.
Month - Voor de rijen van de Maand.
Week - Voor de rijen van de Week.
Day - Voor de rijen van de Dag.

Type

CarryForward - Rijen laten een vorig jaar zien. Automatisch gegenereerd vanuit
Bestandseigenschappen.
Start - Beginrijen. Voer begintotalen in (geplande vakantie, gebruikte vakantie etc.).
Total - Rijen gebruikt voor totalen (kolommen voor dagelijkse uren, aanpassingen aan
Beginnen of Overbrengen saldi).
Balance - Voor het saldo van de vakantieuren. De som van de vakantieuren in de rijen
"Overdragen" en "Begin", min de som van de dagelijkse vakantieuren.
SpaceAfterMonth - Hiermee wordt aangegeven dat er een lege rij moet zijn (jaar, maand of
dag waarop de identificatiecode betrekking heeft).

Beschrijving

Kolom om een extra beschrijving toe te voegen.

Code1

Gebruik deze kolom om een klant-, project- of ander identificatienummer toe te voegen.

Werk1 and Werk2

De kolommen Werk1 en Werk2 worden met name gebruikt voor het vastleggen van de werktijden in
het Time sheet - Vereenvoudigde registratie model.  Bovendien kunnen ze in de Experimentele versie
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worden gebruikt om bepaalde werktijden in te voeren (bijv. nachten, vakanties).
Parallel aan deze kolommen worden ook de Toeslag kolommen gebruikt (zie uitleg hieronder).

Gewerkt

Dit is een beveiligde kolom. Deze wordt gebruikt door de software om het totaal aantal gewerkte uren
te berekenen.

Detail

Dit is een beveiligde kolom. Deze wordt door het programma gebruikt om automatisch werkdetails
weer te geven (bijvoorbeeld projecten). Zie pagina Beheer van projecturen in het Timesheet voor
details.

Toeslag

U kunt werktijden met een toeslag invoeren, met een afwijkende betaling in uren en minuten. Dit kan
ook worden gebruikt voor terugvorderingen of boetes voor vertragingen of iets anders.

%Toeslag

U kunt het stijgingspercentage van de werktijd invoeren dat met een andere vergoeding wordt
betaald.
Als u op dezelfde dag uren met en zonder toeslag werkt, dan moet u die uren in twee rijen invoeren:

Voeg een dagrij toe
Op de eerste rij geeft u het werk (begin en eind) normaal aan.
Op de tweede rij, worden de overwerk uren aangegeven en het toepasselijke percentage.
Als u het dagtotaal direct in de tabel wilt hebben moet u een dagtotaal regel toevoegen.

Toeslag berekening

Dit is een beveiligde kolom. Deze wordt door het programma gebruikt om de toeslag voor overwerk,
aangegeven in de Toeslag of %Toeslag kolom, te berekenen.

Toeslag totaal

Dit is een beveiligde kolom. Deze wordt door het programma gebruikt om de totale toeslag voor
overwerk, aangegeven in de Toeslag of %Toeslag kolom, te berekenen.
Deze waarde wordt opgeteld bij de totaal uren kolom.

Dienst

Verplicht verlof, zoals militaire dienst, burgerservice of andere kunnen hier ingevoerd worden.

Overige

Diverse soorten afwezigheid kunnen worden ingesteld. Geef ziekteverzuim of vakantie niet aan in de
kolom Dienst als u deze optie gebruikt.
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Afwezigheid

Dit is een beveiligde kolom. Deze wordt door de software gebruikt om het totale aantal uren
afwezigheid te berekenen.

Onderverdeling 1 en Onderverdeling 2

Deze kolommen kunnen gebruikt worden om onderscheid te maken tussen verschillende projecten.
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De kolommen van de tabel Journaal

De kolommen in de tabel Journaal kunnen naar uw wensen worden aangepast.

Via Data > Columns setup you can display further columns or hide those you don't need, change
existing headers, add your own columns and change the format.

In the columns, the program always works with hours and minutes, eg. 8:30 means 8 hours and 30
minutes:

Internally, the values are saved as seconds and then displayed in the hours and minutes format.
When entering schedules, the times are rounded to the minute.

Section

The column is protected. It is used by the programme to make a distinction between rows used for
data entry and system-specific rows.

Rows used for data entry and editing (working hours, absences, holidays, etc.) have an empty cell in
the Section column.

System-specific rows, used by the programme to make calculations, have a special identification code
in the Section column cell.
This code must not be changed, otherwise the sums may be wrong.
Examples of codes used: AllStart, YearStart_2020, MonthStart_202001, MonthTotal_202001,
MonthBalance_202001, SpaceAfterMonth_202001.

The value is an identification code consisting of several elements:

Period

All - Refers to year rows.
Year - Refers to year rows.
Month - Refers to the month rows.
Week - Refers to the week rows.
Day - Refers to the day rows.

Type

CarryForward - Carry-forward rows of hours and holiday balances from the previous year.
Carryovers are automatically inserted by the programme in the file's Properties, for both
positive and negative values.
Start - Start Rows. To enter start values (planned holidays, holiday adjustments).
Total - Rows where totals are indicated. They are summed in the total rows (daily time
columns, Start and CarryForward adjustments).
Balance - For the holiday balance. This is the difference between the sum of the holidays,
found in the CarryForward and Start rows, and the sum of the daily holidays.
SpaceAfterMonth -To indicate that there should be an empty line (year, month or day to
which the identifier refers).
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Date

Protected column. Is used for entering the date of the day.

Festive

Column for setting the day. If the cell remains empty, the value set in the File Properties is taken
over, or the value defined with the W code (see below).

The possible values are:

Blank - business day.
0 - to set the current day as a holiday (row displayed in red).
If it is a day that is generally considered as a "public holiday", but on which you are required to
work, you must enter "working".
1 - to set the current day as non-working (row displayed in blue).
2 - to set the current day as a working day. Overrides the default value.
[0] - festive day set automatically, as per the File Properties. No value is indicated in the Due
column.
[1] - non-working day set automatically, as per the File Properties. No value is indicated in the
Due column.
W0 - to set the current day as festive. On the same day, in the following weeks it will be
automatically set with the  (0) value.
W1 - to set the current day as non-working day. On the same day, in the following weeks it will
be automatically set with the (1) value .
W2 - to set the current day as a working day. On the same day, in the following weeks it will be
automatically set with the (2) value.
WR - to reset the current day with the value indicated in the File Properties.
WA - to reset the current day with the value indicated in the File Properties. On the same day,
in the following weeks it will be set automatically with the value indicated in the file properties.

Day description

Column used by the program for automatic insertion of the name of the day, based on the date.
If you want a text other than that reported by the program, insert a text preceded by the # character
(eg #Christmas, #National holiday).

Description

Column for entering an additional description.

Code1

Column to indicate any customer, project or other number.

Work1 and Work2

The columns Work1 and Work2 are used in particular to register working hours in the Time Sheet -
Systematic 2023 template. Furthermore, in the Banana Accounting Plus version they can be used to
enter special working hours (e.g. nights, holidays).
Supplement columns are also used in parallel with these columns (see explanations below).
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Start1, Stop1, Start2, Stop2 ...

These columns allow entry and exit times to be entered. There can be several entries and exits on the
same day.
The programme calculates the time of attendance and adds up in the columns Total and Difference.

Sick leave

Column for entering the hours of absence due to illness.

Holiday

Column for entering holiday hours.

Service

Mandatory absences, such as military service, community service or other, can be entered.

Adjustment

Column for entering an adjustment value.

Other

Other types of absence, not indicated in the Service or Sick or Holiday column, may be entered.

Absence

Protected column. It is used by the programme to automatically calculate the sum of absences.

%Surcharge

You can enter the percentage of supplementary work that is paid differently.
If you do both hours without supplement and hours with supplement on the same day, you must enter
the times on two lines:

 Add day row
The first line indicates the work (start and end) normally.
On the second line you indicate the supplementary hours and the appropriate percentage.
If you want the daily total directly in the table, you must add a daily total row.

Surcharge calculated

The column is protected. It is used by the programme to calculate theovertime, indicated in the
Supplement or Supplement % column.

Surcharge total

The column is protected. It is used by the programme to calculate the total additional time, indicated
in the Surcharge or Surcharge % column.
This value is added to the Total Hours column.

http://www.banana.ch/doc/en/node/9617
http://www.banana.ch/doc/en/node/9617
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Total

The column is protected. It is used by the program for automatic entry of the sum of working hours,
overtime, absences and adjustments.

Due Code

The column is used, in case of need, to change the value of the Due (hours of work due).
If it is left blank, the Due value is automatically resumed day by day based on the settings in the File
→ File Properties → Start menu .
If you wish to change the Due value from the Journal table:

Reset due.
Codes to be entered in the Due Code column to reset the daily due from the row in which you
are. The new value must then be entered in the Due column.

DS (Set Today) - Set the due hours of the current day, without changing the other days.
WS (Set Week Day) - Sets the hours due for the day and for the same day of the following
weeks.
PS (Set Predefined) - Sets the due hours for the day and for all subsequent days without a
different setting

Daily Due Reset Codes
WR (Reset Week Day) - Reset the default value for the day of the week.
WA (Reset All Week Days) - Resets all the default values for the days of the week.
PR (Reset Predefined) - Reset general default. Removes the default value set previously.
PA (Reset Predefined and Week Days) - Reset the general default and those of the week.
It is like starting everything anew.

Progressive reset code
RP (Restart progressive) - Restarts the value of the Progressive column from zero. You
insert this code in the beginning of month row, when all hourly salaries, when all the
hours of the previous month have been paid.

Due

The column is protected. The program automatically calculates the difference between the hours
worked and those due. At the end of the month and year, the totals of the Due are also reported.

If there are no values in the Due Code column, the program resumes, the values present in
File Properties - Start in the Due Code column.
If codes are entered in the Due Code column (see previous paragraph), the program calculates
the due based on these codes.
All rows that have 0 (holiday) or 1 (non-working) in the Festive column, the cell will remain
empty in the Due column.

Difference

The column is protected. The program automatically calculates the difference between the hours
worked (Total) and those due (Due). At the end of the month and at the end of the year, the totals of
the difference are also reported.

Progressive

The column is protected. The program automatically calculates the difference between the hours
worked (Total) and those due (Due). At the end of the month and at the end of the year, the totals of

http://www.banana.ch/doc/en/node/9085
http://www.banana.ch/doc/en/node/9085
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the difference are also reported.

Worked

The column is protected. It is used by the program for the automatic calculation of the sum of the
hours worked.

Detail

The column is protected. It is used by the program to automatically display work details (eg projects).
Also see details in Managing projects.

Surcharge

You can enter the additional working time paid differently, in hours and minutes. It can also be used
to manage reclaims or penalties for delays or other.

Split1 and Split1

Columns that can be used to track hours invested in projects.

Hours in decimal format
You can also enter the hours in digital format (1.5 = 1:30).

If you enter a value preceded by the sign ">" or "<" (greater or lesser), the program considers
it as a decimal value and converts it to hours and minutes:

"<1.50" is converted to 1:30
"<1.75" is converted to 1:45 an hour and three quarters.

In the hour counter, enter the number of hours with the decimal separator. For example, if you
enter 1.75, the program displays the value in hours and minutes (1:45).

Display in digital format

The info window also indicates the value of the hours in decimals.
In the monthly printout certain values are also referred to as decimals (this is because payroll
programs often work with decimals).

Speed up insertion
Go to the current day.

The row of the current day is the one marked in yellow.
Actions → Go to today menu.

Enter the time of entry and exit.
With the "." computer time is entered.
If for example, you enter +5 or -5 (or any other number), the program displays the
current time with 5 minus plus minutes to the computer time.

Copy from the previous week.
Using the Actions → Copy menu, the times of the previous week are resumed.
Take over the value of the previous row.
Use the Actions → Copy menu from above (or button F4 or Cmd 4).
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Vacation or Absence Auto-Completion.
Go to cell modification (with a space) and the program suggests the hours due, minus the hours
already performed.

Hour column blocks
The hours columns of the Journal table are organized into blocks, as explained below.

Hours worked columns

These are the columns used to indicate the daily working hours. The working time carried out in the
day can be entered in two ways:

As hours worked - data is entered in the Work1 and Work2 columns.
In the Banana Accounting Plus version, all columns of the hour counter type starting with
TimeWork are considered hours worked.
As time of entry and exit - data is entered in the columns Start1, Stop, Start2, Stop2, etc.
The program will calculate the time elapsed.

Total hours worked

In the Total hours worked column, the hours indicated in the hours worked columns and those
indicated as Start and Stop times are summed.

In the Banana Accounting Plus version there is also the total Detail column. If the Row Type contains
the value "D", the working hours are summed in the Detail column and not in the Total column. 

Extra hours

These columns are only available in the Banana Accounting Plus version.
They are used to insert surcharge hour. For example, in the case of holiday or night work which
involves a surcharge.
The Extra Total is the sum of the extra hours, indicated as hours, and those calculated as a
percentage.

Absences

Absences are entered in the Sickness, Holidays, Service or Other columns, as appropriate.
These hours are totaled in the Absence column (TimeAbsenceTotal) and then in the Total column.
When calculating the difference between the hours due, absences are considered as paid.
In the Banana Accounting Plus version all the time counter columns starting with TimeAbsense are
added to the total absence. The user can add absence columns for other cases.
If you need to keep track of the absences that do not have to be added to the Total hours, you have
to add columns of the Hour counter type.

Adjustments

This column is used for accounting adjustments, as in the case of extra hours having been made and
paid; then to scale them from the total, enter the value with the negative sign in the Adjustments
column.
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The Total hours

Is the sum of the total hours, considered as hours to be counted and as part of the amount due. It
includes the following columns:

Total hours worked.
Total supplements.
Totale absences.
Adjustments.

Hours due

The Spreadsheet allows you to indicate the hours due. In the case of a Fixed rate salary  contract,
the hours of the working days are indicated per contract.
In the case of hourly wages, without a fixed number of hours included in the contract, the hours owed
part is generally not used.

The employee's daily working time is indicated in the Due column. The value is indicated on the basis
of various parameters (see columns of the Journal table ):

The working hours settings, indicated in File properties → Start .
The Festive column.
The program completes the value due only for the days indicated as Business.
The Due Type column
By indicating a code, the content of the Due daily column can be set differently.

Difference and Progressive hours

In the Difference column, the program indicates the difference in hours between the Total and the
Due.
In the Progressive column, the program indicates the cumulative difference.
If no Due has been indicated, the Progressive corresponds to the sum of the hours worked. This value
can be reset by inserting the RP (Progressive Restart) code in the Due Type column.

Split

They are information columns that are used to indicate hours allocated to projects.

Journal Table - Additional Columns
In Banana Accounting Plus  columns have been added for the calculation of the supplement (festive,
night) and for the management of multiple lines for the same day.

Detail

The column is protected. It is used by the program to automatically display work details (eg projects).
See Project management.

Surcharge

You can enter the additional work time paid differently, in hours and minutes. It can also be used to
manage recoveries or penalties for delays or other.

https://old.banana.ch/doc/en/node/9619
https://old.banana.ch/doc/en/node/9047
https://old.banana.ch/doc/en/node/9085
https://www.banana.ch/en/node/11181
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%Surcharge

You can enter the percentage of additional work that is paid differently.
If both hours without supplement and hours with supplement are worked on the same day, the times
must be entered in two lines:

Add day row
The first row will indicate the work (start and end) normally.
The second row will indicate the extra hours and indicate the appropriate percentage.
If you want the daily total directly in the table, you will have to add a row for daily total.

Surcharge calculated

The column is protected. It is used by the program to calculate the overtime, indicated in the
Supplement or Supplement% column.

Total Surcharge

The column is protected. It is used by the program to calculate the total overtime, shown in the
Supplement or Supplement% column.
This value is summed in the total hours column.

New user columns

You can add columns which are then totaled into groups. The Xml name of the column must be of
type time counter and must start as follows:

TimeWork. Added to the total work.
TimeSurchargeManual. Added to the total work.
TimeAbsence. Added to the total absences.
TimeSplit. Summed in the TimeSplitTotal if existing.

You can define the columns to indicate the hours of a project, also added up in the TimeWork, or, the
hours of absences for training or other, considered absences and counted in the total absences.
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Vakanties beheren met het Timesheet

Vakanties worden aangegeven in uren en worden ingevoerd in de kolom Vakantie van het Journaal.

Overgedragen vakantiedagen
Bij het aanmaken van een nieuw jaar via Bestands- en boekhoudingseigenschappen.. → Begin,
moeten vakantiedagen die over zijn van het vorige jaar aangegeven worden. Vakantiedagen die
teveel gebruikt zijn moeten met een minteken aangegeven worden.

De waarde wordt automatisch aangegeven in de rij Overbrengen van de kolom Vakantie.

Betaalde vakantie of betaald verlof, contractueel vastgelegd

Als er al vakantiedagen zijn opgenomen in uw planningen:

Geef het aantal uren betaalde vakantie aan in de Jaar beginnen (bijvoorbeeld, 2020 Beginnen)
rij.
Voer het aantal gecontracteerde betaalde vakantie uren in de kolom Vakantie in.
(bijvoorbeeld, voor 20 dagen van 8 uur voert u 160 in of 80 uren als u voor 50% parttime
werkt).
Betaalde verlofdagen die als vakantie beschouwd worden:
Voer het aantal uren in waarop u recht heeft (dagen maal uren per dag) in de rij Maand
beginnen.

Vakantie en betaalde verlofdagen instellen
De begin rijen worden gebruikt om het aantal toegekende vakantiedagen in uren en minuten in te
voeren. U kunt de vakantie aangeven en de jaar Beginnen of de maand Beginnen rij.

Als een persoon recht heeft op 4 weken vakantie en 40 uur per week werkt: 40 * 4 = 160. Deze
waarde wordt aangegeven in de jaar Beginnen rij.

Als het aantal toegekende vakantiedagen verandert gedurende het jaar voert u het aantal uren
positief of negatief (minteken) in de beschikbare maand beginnen rij, kolom Vakantie in.

De kolom Vakantie wordt ook gebruikt om betaald verlof aan te geven.

Voltooide en betaalde vakanties
Opgenomen of betaalde vakantie uren worden aangegeven in de kolom Vakantie van de dagelijkse
rijen.

Overgebleven vakantie
De uren van overgebleven vakantie worden aangegeven in de kolom Totaal en automatisch
berekend.

Als vakantie wordt betaald:
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Voer de betaalde vakantie uren met een minteken in de begin rij van de volgende maand in.
Vul in de kolom Notities een omschrijving, bijvoorbeeld "Betaalde vakantie", in.
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Timesheet / Aanwezigheden

De Urenregistratie functionaliteit maakt het registreren en de presentatie van de gewerkte uren
eenvoudiger en sneller.
Deze is helemaal gratis, u hoeft alleen maar Banana Boekhouding 9 te downloaden en te
installeren.

Eigenschappen

Ontworpen voor werknemers met variabele werktijden of voor mensen die hun aanwezigheid op het
werk moeten registreren.

Lijkt op Excel, u kunt kopiëren, plakken en corrigeren.
Vastleggen van geplande uren met een aanpasbare weekplanning.
Alle berekeningen, verplichte uren, gewerkte uren, vakantie en ziekteverzuim in uren en
minuten.
Zeer snelle ureninvoer op twee manieren:

Start-en eindtijd met een berekening van het dagelijkse totaal.
Automatische invoer van de huidige tijd
Afwijking + of - van de huidige tijd is mogelijk
Als u eerder aankwam of over korte tijd vertrekt.

Totale aantal dagelijks gewerkte uren
Verschil tussen geplande en gewerkte uren.
Onmiddellijke telling van gewerkte uren, vakanties en afwezigheid.
Totalen en overzichten voor iedere dag, week, maand en jaar.
Overdracht per maand en jaar
Eenvoudig aan te passen, past in alle planningen.
Mogelijkheid om vakanties en betaald verlof in te stellen.
Mogelijkheid om kolommen toe te voegen, kosten te declareren, gereden kms of andere.
Kan gebruikt worden voor het hele jaar of voor specifieke periodes.
Kan een maandoverzicht afdrukken, zelfs met totalen in decimale uren.

Belangrijk om te weten
De urenregistratie wordt gedaan in een tabel "Journaal" genaamd waarin de gewerkte uren en
instellingen worden ingevoerd.
Per dag kan een begin en een einde worden ingesteld.
Vakanties, ziekte, afwezigheid en andere dingen worden aangegeven in uren en minuten.
Het programma laat altijd overzichten gebaseerd op uren en minuten zien.

Voer de dagelijkse werktijden in - tips en trucjes
Open het bestand1.
Ga naar de huidige dag (geel) -> Menu Hulpprogramma's -> "Ga naar vandaag".2.
Stel de begin- en eindtijden in.3.

Druk op de punt "." om de tijd die de computer aangeeft in te voeren.1.
Als u +5 of -5 (of willekeurig ander getal) invoert toont het programma de huidige tijd met2.
5 minuten meer of minder dan de computertijd.
Met het Hulpprogramma's menu, "Week vullen" is het mogelijk de uren van vorige week3.

https://www.banana.ch/nl/download_nl
https://www.banana.ch/nl/download_nl
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over te nemen.
Met de knop "F4" of "Cmd4" (Van boven kopiëren) wordt de waarde in de bovenliggende4.
rij gekopieerd.

Voer vakanties of afwezigheid in.4.
Geef de vakantie- of afwezigheidsuren van de dag aan in de betreffende kolommen.1.
Als u in Edit modus gaat laat het programma de dagelijks geplande/gewerkte uren zien.2.
Als u de uren in decimaal formaat invoert (bijvoorbeeld 1.75) laat de software de waarde3.
in uren en minuten zien (bijvoorbeeld 1:45).

Afdrukken en overzichten
Met het menu Bestand -> commando Afdrukken kunt u:

De tabel afdrukken.
Een gedeelte van de tabel dat u geselecteerd heeft afdrukken

Met Hulpprogramma's -> Maandelijks rapport:
Wordt het maandelijkse rapport afgedrukt.

Omzetten van Uren.decimalen naar Uren:minuten
Het programma werkt altijd met uren en minuten; 8:30 betekent 8 uur en 30 minuten.
Er zijn situaties waarin uren worden gebruikt met decimalen. In dit geval is de waarde 8.50 gelijk aan
8:30 in uren/minuten. Als het aantal uren per dag wordt bepaald op decimale basis (43 uur per week,
verdeeld in 5 dagen), moet u 8,6 uur per dag werken.
Het programma helpt bij conversies

In de "urenteller" kolommen (vakantie, ziekteverzuim, verschuldigd), wanneer u na het uur een
punt en de decimale waarde invoegt, geeft het programma de tijd in uren en minuten bij het
automatisch aanvullen aan. Als u bijvoorbeeld 8.6 schrijft, stelt het programma 8:36 voor.
U moet de voorgestelde waarde overnemen.
Het informatievenster toont ook de waarde van de uren in decimale waarden.
In het maandelijkse rapport worden sommige waarden ook in decimale waarden weergegeven
(omdat loonprogramma's vaak decimale waarden gebruiken).

Specifieke Commando's (Hulpprogramma's menu)

Ga naar vandaag

Zet de cursor op de huidige dag.

Dag vullen

Neemt de gewerkte uren en afwezigheid voor de huidige dag over van dezelfde dag van de vorige
week.

Week vullen

Neemt de gewerkte uren en afwezigheid voor de huidige week over van dezelfde dagen van de vorige
week.
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Maandelijks rapport

Drukt de totalen en rijen van de huidige maand af.
U kunt de af te drukken periode selecteren.

Rijen voor periode aanmaken

Maakt de rijen aan voor iedere dag, vanaf het begin, en het totaal voor het aangegeven jaar.
De rijen van de tabel worden opnieuw in geordend.

Timesheet importeren

Importeert de waardes van een externe urenregistratie.

Geef het bestand aan van waaruit de software de gegevens importeert.
Geef aan welke waardes geïmporteerd moeten worden.

Alleen vakanties importeren.
De software importeert alleen de waardes van de "Vakantie" kolom
De notities die bij de geïmporteerde waardes horen worden ook geïmporteerd.
Alles importeren.
Neemt de waardes over van Vakantie, Notities, Gewerkt, Afwezigheid, Correcties,
Verschuldigd en Onderverdeling.

Het programma kijkt in het geïmporteerde bestand naar rijen met gelijke datum en sectie en
importeert de bijbehorende waardes.
Als er in het geïmporteerde bestand meerdere rijen zijn van dezelfde datum worden waardes volgend
op de eerste rij niet geïmporteerd.
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Commando's Productiviteitstoepassingen

Het werken met het Banana Boekhouding Time sheet kan geoptimaliseerd worden, via verschillende
functies in het Rapporten en Acties menu.

Rapporten menu

Maandelijks Rapport...

Berekent en toont een samenvattend rapport van de geselecteerde periode inclusief de gebruikte
hoofdkolommen.

Acties menu

Ga naar vandaag

Zet de cursor op de regel die bij vandaag hoort.

Alles opnieuw controleren
(F9)
Deze functie is te vinden onder Acties menu. Met het commando Alles opnieuw controleren...
berekent en controleert het programma alles opnieuw en geeft eventuele fouten of verschillen weer.

Gebruik dit commando wanneer u twijfelt of er een probleem is.

Journaal sorteren

Sorteert de rijen op datum.

Inchecken of uitchecken

Voegt de huidige tijd in de geselecteerde cel in. U kunt ook "." (punt zonder aanhalingstekens) in de
geselecteerde begin- of eindcel typen.

Dag vullen (van vorige week)

Vult de gewerkte en afwezigheidsuren van de huidige dag met de waardes van de overeenkomstige
dag van de vorige week.
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Week vullen (van vorige week)

Vult de gewerkte en afwezigheidsuren van de huidige week met de waardes van de overeenkomstige
dagen van de vorige week.

Rij toevoegen dag

Voegt een rij toe na de geselecteerde en met dezelfde datum. Gebruik dit om extra dagwaarden in te
voeren.

Voeg rij Totaal dag toe

Voegt een rij toe, waarbij de dagwaarden worden getotaliseerd.

Rijen voor periode aanmaken ...

Voeg rijen toe (dagelijks, beginnen, totaal, saldi en overbrengen) op basis van de geselecteerde
periode. Alle rijen van het Journaal worden gesorteerd op datum.

Nieuw jaar aanmaken...

Maakt een nieuw Timesheet bestand aan voor het komende jaar. Het programma stelt automatisch
de beginwaarden van het vakantiesaldo en de uren in volgens het voorgaande jaar.
Let op! Bij het aanmaken van een nieuw jaar kunnen de feestdagen afwijken van het voorgaande
jaar - u moet ze handmatig controleren en wijzigen. Als alternatief stelt Banana.ch SA elk jaar
verschillende modellen beschikbaar met nationale feestdagen die voor sommige landen al zijn
ingesteld.

Timesheet importeren...

Importeert de waardes van een extern timesheet.

Geef het timesheet aan dat geïmporteerd moet worden.
Geef de waardes aan de geïmporteerd moeten worden.

Importeer alleen feestdagen.
Haalt alleen de waardes van de Feestdagen kolom op.
Als er een waarde staat wordt ook de waarde van de kolom Notities overgenomen.
Alle gegevens importeren.
Neemt de waardes van Feestdagen, Notities, Werk, Ziekte, Aanpassen,
Verschuldigd en Onderverdeling (splitsing) over

Het programma zoekt in het geïmporteerde bestand naar rijen met dezelfde datum en sectie en
neemt de waardes ervan over.
Als het geïmporteerde bestand meerdere rijen met dezelfde datum bevat worden de waardes na de
eerste rij niet geïmporteerd.
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Afdrukken

Journaal tabel afdrukken
Met het commando Bestand → Afdrukken kunt u:

Alle rijen van de Journaal tabel afdrukken.
Geselecteerde rijen van de Journaal tabel afdrukken.

Maandelijks rapport
Met menu Hulpprogramma's → Maandelijks rapport berekent het programma een overzicht van
de geselecteerde periode en geeft dit weer inclusief de gebruikte kolommen.
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Salaris betaald per uur

Het is eenvoudig en het gaat snel, gegevens invoeren in het gratis Time sheet van Banana
Boekhouding Plus omdat u meteen voorzien wordt van dagelijkse, maandelijkse en jaarlijkse
urentotalen.

Alle uren (verschuldigde tijd, gewerkte uren, afwezigheden en vakanties...) worden ingevoerd en
weergegeven als uren:minuten (10:30).
Hiermee kunnen gegevens snel worden ingevoerd en de automatische controles van het programma
maken correcte overzichten mogelijk.

Met de applicatie kunt u dagen en uren invoeren die contractueel zijn overeengekomen en de
gewerkte uren waarmee verschillen aan het licht komen van wat was overeengekomen en wat is
gewerkt. Het maandoverzicht dat u aan uw werkgever moet overleggen is nu compleet en voldoet
aan wettelijke eisen.

Zie ook de pagina Hoe te beginnen.

Instellen van de wekelijkse te werken uren
Time Sheet is geschikt voor ieder soort werktijdschema, vast, flexibel, parttime of met gecombineerd.

In Bestandseigenschappen → Begin geeft u de werkdagen en de wekelijks te werken uren aan.

Binnen de registratie van salaris betaald per uur worden de werkelijk gewerkte uren gerekend.

Als een zeker aantal uren per dag overeengekomen is is het mogelijk om deze aan te geven als
verschuldigde uren, zoals bij vast salaris. Op deze manier berekent het programma de
verschillen tussen wat is overeengekomen en wat is uitgevoerd en geeft deze weer.
Als de verwachtte werktijd is verschillend of verandert gedurende het jaar kunt u deze
aanpassen zoals uitgelegd in de volgende paragraaf Periode en werktijd instellen.
De geplande vakantiedagen worden daarentegen direct ingesteld in de kolommen van de tabel
Journaal.
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Invoeren van werktijden en afwezigheid
In het systeem van betaling per uur worden de gewerkte uren ingevoerd in de tabel Journaal op een
van de volgende manieren

Voer de begin- en eindtijden in de overeenkomstige kolommen in (systematische registratie).
Het programma berekent de gewerkte uren en minuten in de kolom Totaal.
Voer het totaal aantal gewerkte uren in kolom Werk1 of Werk2 in.

Als de Start, Stop en ook de Werk1 of Werk2 kolommen worden gebruikt telt het programma alle
uren op in de kolom Totaal.

Wanneer verplichte uren zijn aangegeven in de bestandseigenschappen laat de kolom Progressief het
verschil zien tussen gewerkte en verplichte uren.

Het aantal uren afwezigheid wegens ziekte, vakantie of andere redenen, ingevoerd in de betreffende
kolommen, worden opgeteld in de kolom Verschuldigde uren.

Aanpassingen
Wanneer er aangepaste uren nodig zijn moeten deze worden ingevoerd in de kolom Aanpassing met
een positieve of negatieve waarde.
Bijvoorbeeld, als overuren worden betaald worden negatieve uren ingevoerd in de kolom Aanpassing
zodat de uren in de kolom Progressief worden verminderd.

Beginnen met werken in de loop van het jaar
Wanneer de periode van werken begint in de loop van het jaar, ga dan als volgt te werk om de
verschuldigde uren te resetten vanaf 1 januari tot de datum waarop begonnen wordt:

Voer op 1 januari "WA" in de kolom Code Verschuldigd in. Het programma zet het totale
aantal uren voor alle dagen, voor het begin van de periode waarop begonnen wordt met
werken, op nul.

Op de regel van de datum waarop het werk begint en op alle werkdagen van de eerste week
voer WS in in de kolom Code verschuldigd en het aantal te werken uren in de kolom
Verschuldigd. Het programma vult automatisch de verplichte uren in voor alle weken tot het
eind van het jaar.
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Veranderen van werkdagen gedurende het jaar

Als werkdagen veranderen gedurende het jaar moeten de nieuwe instellingen niet gedaan worden in
de bestandseigenschappen omdat de verandering dan helemaal vanaf 1 januari doorgevoerd worden.
Ze moeten gedaan worden direct in de tabel Journaal door de juiste codes te gebruiken. Er zijn
verschillende veranderingen mogelijk gedurende het jaar.

Als een werkdag een niet-werkdag wordt:

Op de regel van de dag die u wilt veranderen (van een werkdag in een niet-werkdag) voert u de
code W1 in in de kolom Vakantie. Om het programma de verandering door te laten voeren
voor alle weken van het jaar voert u WS in de Code verschuldigd kolom in.

Als een niet-werkdag een werkdag wordt:

Op de regel van de dag die u wilt veranderen (van een niet-werkdag in een werkdag) voert u de
code W2 in in de kolom Vakantie. Om het programma de verandering door te laten voeren
voor alle weken van het jaar voert u WS in de Code verschuldigd kolom in.

Voor andere aanpassingen zie de uitleg van de kolommen van de tabel Journaal.

Verandering van het percentage werkuren gedurende het jaar

Als het aantal werkuren gedurende het jaar toe- of afneemt moeten de nieuwe aantallen worden
ingevoerd in de tabel Journaal, in de kolommen Code verschuldigd en Verschuldigd.

Op de datum dat de veranderingen moeten worden ingevoerd (bijvoorbeeld van 5 naar 8 werkuren):

Voer in de kolom Code verschuldigd de code WS in.
Voer in de kolom Verschuldigd het huidige aantal verplichte uren in (8).

Het programma past het nieuwe aantal uren toe op alle weken van het jaar.
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Voor andere aanpassingen zie de uitleg van de kolommen van de kolom Code verschuldigd.

Als vakantie uren veranderen gedurende het jaar moeten de verschillen handmatig worden berekend
en aangepast. Zie Veranderingen gedurende het jaar

Verschil tussen verschuldigde en totaal aantal uren
In de tabel Journaal laat het programma na ieder invoer zien:

Het dagelijks en het voortschrijdend verschil.
Uren meer of minder dan gepland.
Het totaal per jaar, per maand en het totaal gegenereerd door de in de verschillende kolommen
ingevoerde waarden
Het totaal voor vakantiedagen is het verschil tussen de ingestelde en de opgenomen
vakantiedagen, zie pagina Vakanties.
Het overgedragen aantal uren van zowel het eind van de maand als het jaar.
Het overgedragen aantal uren is het totaal van nu inclusief de waardes van vorige periodes.

Aan het eind van de maand worden de uren getoond die gewerkt zijn vanaf het begin.

Het uiteindelijke aantal is gelijk aan het overgedragen aantal.

Progressief saldo opnieuw laten beginnen
Door de afkorting "RP" in de kolom Code verschuldigd in te voeren begint het saldo in de kolom
Progressief opnieuw vanaf 0.

Vakantiedagen
Zie voor het instellen van de vakantiedagen pagina Vakanties beheren.

Afwezigheid en ziekte
Voer de uren van afwezigheid in in de kolommen Ziekteverzuim, Vakantie, Dienst of Overige.

Km en onkosten toevoegen
Om gereden kilometers of onkosten die gedeclareerd kunnen worden te noteren voegt u een speciale
kolom toe in de tabel Journaal met menu Gegevens → Kolommen instellen.
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Als de toegevoegde kolom van het Bedrag type is telt het programma automatisch op in totalen
rijen.

Aanpassingen en uitbetaling van opgebouwde uren en
vakantiedagen
In de kolom Aanpadding kunt u het totaal van de verschuldigde/gewerkte uren veranderen.

Als u uren opbouwt en deze worden aan u uitbetaald, ga dan als volgt te werk in de regel van
de dag waarop u betaald wordt.

Voer in de kolom Aanpassing de betaalde uren negatief in.
Voer in de kolom Notities "Uitbetaling opgebouwde uren".

Als u wordt betaald voor opgebouwde vakantiedagen, ga dan als volgt te werk in de regel van
de dag waarop de vakantiedagen uitbetaald worden.

Voer in de kolom Vakantie de betaalde uren negatief in.
Voer in de kolom Notities "Uitbetaling opgebouwde vakantiedagen".

In beide gevallen wordt het saldo in de kolom Progressief minder.

Meerdere rijen voor dezelfde dagen
U kunt meerdere regels hebben waarop de uren van een dag moeten worden ingevoerd. Om duidelijk
te maken dat de volgende regels voor dezelfde dag zijn wordt de beschrijving ingesprongen.

Er zijn verschillende mogelijkheden om een extra regel voor dezelfde dag te maken:

Vanuit het menu Bewerken → Rijen dupliceren...
Vanuit het menu Bewerken → Rijen toevoegen... voer de datum van de dag in (u moet de
beveiliging van de kolom Datum opheffen).
Vanuit het menu Acties → Rij toevoegen Dag (alleen in de Banana Boekhouding  Plus versie).

Maandelijkse afdruk
De maandelijkse afdruk geeft alle uren weer.
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Beheer van projecturen in het Timesheet

Deze programmamodus is in ontwikkeling en nu alleen beschikbaar in de Experimental
version. Gebruikers die bestanden hebben aangemaakt met oudere versies moeten deze
converteren.

Om projecturen te beheren voegt u de benodigde kolommen in de Journaal tabel toe.

Er zijn twee manieren om projecturen te beheren:

Met de Projecten tabel werken.1.
Met de kolommen Werk1, Werk2, etc. werken.2.

Projecten beheren in de Projecten tabel
Voor deze methode moet u de Projecten tabel toevoegen:

Menu Extra → Nieuwe functies toevoegen → Tabel Projecten toevoegen

De volgende kolommen zijn beschikbaar in de Projecten tabel:

Id - voer een unieke id in voor ieder project.
Beschrijving - voer de naam/beschrijving in van het project.
Notities - voer eventuele extra benodigde notities in..

Door de Projecten tabel toe te voegen worden de Projecten Id en de Projecten Beschrijving
kolommen automatisch toegevoegd aan de Journaal tabel.

Laat de volgende kolommen zien in Journaal tabel met menu Gegevens → Kolommen instellen:

RijType (Type) kolom - voer D in als u de projecturen wilt scheiden van het totaal aantal
gewerkte uren.
TijdDetailTotaal (Detail)- is een beveiligde kolom. Als D is ingevoerd in de Type kolom
berekent het programma de projecturen apart en geeft deze gescheiden weer.
Als de kolom Type leeg is berekent het programma de projecturen in de kolom Totaal en geeft
deze daar weer.

Projecturen invoeren

De uren die aan projecten besteed zijn kunnen worden beheerd in hun eigen werkblad.

Om de werkuren te scheiden van de projecturen is het noodzakelijk om:

Ga op de regel staan van de dag waaraan u het project (of de projecten) toe wilt voegen.
Voeg een nieuwe rij toe met Hulpprogramma's → Rij toevoegen Dag
Voer een D in in de kolom Type als u de projecturen wilt scheiden van de totaal gewerkte uren.
Laat leeg indien u de projecturen opgeteld wilt hebben bij de totaal gewerkte uren (kolom
Totaal).
Voer de Id van het project, zoals ingesteld in de Project tabel. De projectbeschrijving wordt
automatisch weergegeven.
Voer de begin- en eindtijd van het project in.
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Het programma berekent de kolommen Totaal, Verschuldigd, Verschil en Progressief en werkt
deze bij.

Projecten beheren in de Werk1, Werk2 (etc) kolommen
Als een alternatief op de projecten tabel om projecturen te beheren kunt u de kolommen Wer1,
Werk2, etc. gebruiken.

Iedere kolom verwijst naar de uren van een ander project. Het programma heeft twee vooringestelde
kolommen maar u kunt andere kolommen toevoegen als u er maar voor zorgt dat als XML naam van
de kolommen TimeWork3, TimeWork4... wordt ingevoerd in het Nieuwe kolommen toevoegen
venster (menu: Gegevens → Kolommen instellen... → Toevoegen).

Laat de volgende kolommen zien in Journaal tabel met menu Gegevens → Kolommen instellen:

RijType (Type) kolom - voer D in als u de projecturen wilt scheiden van het totaal aantal
gewerkte uren.
TijdDetailTotaal (Detail) - is een beveiligde kolom. Als D is ingevoerd in de Type kolom
berekent het programma de projecturen apart en geeft deze gescheiden weer.
Als de kolom Type leeg is berekent het programma de projecturen in de kolom Totaal en geeft
deze daar weer.

Projecturen invoeren

De uren die aan projecten besteed zijn kunnen worden beheerd in hun eigen werkblad.

Om de werkuren te scheiden van de projecturen is het noodzakelijk om:

Ga op de regel staan van de dag waaraan u het project (of de projecten) toe wilt voegen.
Voeg een nieuwe rij toe met Hulpprogramma's → Rij toevoegen Dag.
Voer een D in in de kolom Type als u de projecturen wilt scheiden van de totaal gewerkte uren.
Laat leeg indien u de projecturen opgeteld wilt hebben bij de totaal gewerkte uren (kolom
Totaal).
Voer de Id van het project, zoals ingesteld in de Project tabel. De projectbeschrijving wordt
automatisch weergegeven.
Voer de begin- en eindtijd van het project in.

Het programma berekent de kolommen Totaal, Verschuldigd, Verschil en Progressief en werkt
deze bij.

Rapport met project- en resourcegegevens
U kunt uw projecten en hulpmiddelen filteren en een rapport maken met gegevens voor elk van
hen.

https://www.banana.ch/apps/en/node/9438
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Informatie over het Timesheet voor
werkgevers

Met Timesheet hebben bedrijven, die geen eigen automatisch tijdsregistratiesysteem hebben, een
modern informatiesysteem.
Dit levert diverse voordelen op:

U voert de gewerkte tijden vlot in en de totalen worden onmiddellijk weergegeven zonder
tijdsverlies.
Nauwkeurige berekening, fouten worden vermeden.
Uitgebreid, hiermee kunt u afwezigheid en vakanties bijhouden.
Planning van werktijden en vakanties.
Verschillen weergeven tussen overeengekomen en echt gewerkte uren.
Flexibel en aan te passen aan elk soort contract.
Uitbreidbaar door kolommen toe te voegen.
Rapporten voldoen aan de wettelijke eisen.
Kan ook gebruikt worden voor projectbeheer.
Helemaal gratis.
Kan gebruikt worden op elke desktop en mobiel operating systeem.

Eigen verantwoording van de gewerkte uren
Met Banana Boekhouding Timesheet kan iedere werknemer de eigen uren individueel invoeren en
altijd de eigen situatie onder controle hebben.
Het einde maand overzicht vat alle nodige informatie samen. U kunt, indien gewenst, ook specifieke
overzichten maken voor specifieke doelen.

Gecentraliseerde gegevensinvoer
Timesheet is ook toepasbaar als de werkgever de gegevens van de door de werknemers gewerkte
uren verzamelt.
Uren kunnen worden toegewezen aan projecten of wat er ook nodig is.

Levert modellen voor de werknemers van uw bedrijf
Ieder bedrijf heeft andere eisen.
Om het uw werknemers mogelijk te maken uren te registreren is het nuttig Timesheet bestanden voor
te bereiden die als model kunnen dienen met voorgeprogrammeerde instellingen.

De jaarlijkse feestdagen
De kolommen voor het soort vereiste gegevens (systematisch, vereenvoudigd, gemengd).
De kolommen voor het soort salaris.
De kolommen voor afwezigheden.
Toegevoegde kolommen voor te declareren uitgaven, projecten en notities over de voortgang
van het werk kunnen ook worden toegevoegd.
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Specifieke rapporten
Met Extensies kunt u specifieke rapporten maken aangepast aan de behoeften van een bedrijf.

Een versie voor werkgevers
We denken erover om een applicatie te ontwikkelen voor werkgevers waarmee ze de gegevens in de
bestanden die door werknemers worden bijgehouden kunnen verzamelen en consolideren voor
statistische of andere doeleinden.

Mocht er een bredere belangstelling zijn voor een dergelijk hulpmiddel, laat het ons dan alstublieft
weten via het contactformulier . Geef dan ook aan welke functies belangrijk voor u zijn.

https://www.banana.ch/nl/contact_form
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Register Aktiva

Voor professioneel beheer van af te schrijven activa met de bijbehorende afschrijvingen,
waardeverminderingen, herwaarderingen en andere wijzigingen. Het programma berekent
automatisch afschrijvingen gebaseerd op parameter instellingen. Historische gegevens worden
bijgehouden en deze kunnen dan worden geïmporteerd in uw boekhouding.

Uw register voor vaste activa beheren
De stappen om uw register te beheren:

Maak een nieuw bestand aan van het type Vaste Aktiva Register.1.
Gebruik het voorbeeldbestand "Vaste Aktiva".
Voer de diverse bezittingen in de Items Tabel in met de diverse waardes en parameters voor de2.
berekening van de afschrijvingen. U kunt groepen aanmaken voor onderdelen die dezelfde
parameters hebben.
Gebruik aan het einde van de periode het commando "Afschrijvingsrijen aanmaken" vanuit3.
menu Hulpprogramma's. Het programma maakt afschrijvingslijnen aan voor iedere bezitting,
gebaseerd op de specifieke parameters.
De afschrijvingen kunnen worden geïmporteerd in de boekhouding met het commando in4.
boekhouding importeren -> transacties commando.

De inhoud van het Vaste Aktiva register
Het Vaste Aktiva bestand heeft de volgende tabellen:

Items tabel - waarin u de lijst van afschrijfbare activa en afschrijvings parameters maakt
Transacties tabel - waarin u de transacties invoert voor de afschrijvingen en herwaarderingen
van goederen
Afschrijv. Type tabel - geeft de diverse soorten afschrijvingen aan.
Trans. Type tabel - geeft de diverse soorten transacties aan.

In tegenstelling tot gewone Excel spreadsheets, die normaliter alleen de veranderingen in de
boekhoudkundige waardes bijhouden, kunt u met deze applicatie bijhouden:

Item op aankoopwaarde
De totale uitgaven voor de aankoop van een bezitting.
Historische waarde (aankoop waarde +/- de op- of afwaardering).
Wordt voor de berekening van de afschrijving op historische waarde gebruikt.
Boekhoudkundige waarde (historische waarde +/- correcties als gevolg van afschrijvingen).
Waarde die in de boekhouding gebruikt wordt.
Fiscale waarde (Boekhoudkundige waarde +/- correcties van de fiscale waarde).
De door de belastingdienst gebruikte waarde.

Om waardeveranderingen te registreren, zoals afschrijvingen, waardeverminderingen en andere
veranderingen, gebruikt het programma een boekhoudkundige logica. Veranderingen van de waarde
van een specifiek item worden getoond in de Transactiestabel:

Er is een historie met alle veranderingen in de waarde van een bezit, van aankoop tot afvoer.
Er is een functie geïntegreerd voor de automatische berekening van periodieke afschrijvingen
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van voorgedefinieerde waardes. Transactiebedragen kunnen handmatig aangepast worden
(bijvoorbeeld in een afwijkende berekening voor het eerste boekhoudkundige jaar).
Transacties kunnen handmatig worden toegevoegd voor de opwaarderingen, buitengewone
afschrijvingen, aanpassing van de fiscale waarde, enz.

Aanwijzingen voor het gebruik

Afschrijving in het jaar van aankoop van de bezitting

Er is een oneindig aantal manieren om te bepalen hoe de afschrijvingswaarde voor het eerste jaar
moet worden berekend.
Het programma geeft deze mogelijkheden:

Het berekent normaliter de afschrijving voor het hele jaar
In de kolom MaandafschrijvingEersteJaar (Maand 1ste Jaar) kunt u aangeven voor hoeveel
maanden de afschrijving moet worden berekend.

Indien u in het eerste jaar slechts 50% van de normale afschrijving wilt berekenen, dan
dient u 6 maanden aan te geven.

Afschrijvingspercentage 2 kolom
Gebruikt voor een extra afschrijving. Er wordt een extra afschrijvingsregel gecreëerd.
Laat het programma voor andere situaties de afschrijvingsrij aanmaken en pas daarna de
automatisch gecreëerde afschrijvingstransactie aan.

Items Tabel
Hierin kunt u afschrijfbare bezittingen, gerelateerde groepen en parameters voor het berekenen van
de afschrijvingen invoeren.
De software gebruikt de parameters van de groep of subgroep als de parameters Afschrijv. Type,
Afschr. %, Rekening of Tegenrekening niet ingevoerd zijn voor een item.

Deze tabel bevat diverse kolommen (niet allemaal zichtbaar - om deze zichtbaar te maken gebruikt u
het commando Kolommen instellen van het menu Gegegevens). De kolommen gemarkeerd met
een ster (*) zijn beveiligd en worden berekend door het programma:

Groep
Als er een waarde aanwezig is betekent dit dat de rij tot een groep hoort.
In deze rij worden de waardes van de items en groepen opgeteld.
Id
De Id van een Item
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Beschrijving
De beschrijving van een item.
In Groep
De groep waartoe de rij hoort. Dit moet een waarde zijn die voorkomt in de Groep kolom.
Rekening
De rekening van het boekhoudingsbestand waarop dit item wordt geboekt.
Deze rekening kan ook een groep zijn.
Tegenrekening
De rekening waarop de afschrijving moet worden geboekt.
De tegenrekening kan ook voor een groep worden aangegeven.
Begindatum
De aankoopdatum van het item (of de datum dat het item is ingevoerd in de boekhouding).
Doc.Datum
De datum van het aankoopbewijs van het item, indien beschikbaar
Begin (waarde)
De aankoopwaarde.
+/- Aankoop (Aankoop variatie)*
De totale aankoopwaarde, positief of negatief, aangegeven in de transactiies.
Aankoop (waarde)*
De beginwaarde plus de Aankoop variatie.
+/- Historisch (Variatie)*
De positieve of negatieve waarde van de historische variatie (herwaarderingen of
afschrijvingen) aangegeven in de transacties.
Historisch (Waarde)*
De aankoopwaarde plus de historische variatie.
+/- Boekwaarde*
De positieve of negatieve boekwaarde (afschrijvingen of afschrijvingsafboekingen) aangegeven
in de transacties.
Boekwaarde*
Historische waarde plus boekwaarde variaties.
+/- Fiscaal (Variatie)*
De positieve of negatieve waarde van de fiscale aanpassingen aangegeven in de transacties.
Fiscaal (waarde)*
De boekwaarde plus de fiscale aanpassingen.
Restwaarde
Een mogelijke minimale restwaarde.
Als de restwaarde gelijk is aan of groter dan de boekwaarde worden geen afschrijvingsrijen
meer aangemaakt.
Schatting
Een mogelijke, geschatte waarde van het item.
Afschrijv. Type
Het afschrijvingstype dat voor dit item gebruikt wordt
Het afschrijvingstype kan ook voor een groep aangegeven worden.
Afschrijv. %
Het afschrijvingspercentage.
Het afschrijvingspercentage kan ook worden aangegeven per groep.
Afschrijvingsbedrag
Een mogelijk afschrijvingsbedrag als de afschrijving niet wordt gespecificeerd als een
percentage.
Afschrijv .2 %
Het extra afschrijvingspercentage dat toegepast wordt op dit item.
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Het commando "Afschrijvingsrijen aanmaken" creëert een extra afschrijvingsrij, de calculatie-
methode is dezelfde.
Het extra afschrijvingspercentage kan ook worden aangegeven per groep.
Maand 1ste jaar
Hoeveel maanden het item in het eerste jaar afgeschreven moet worden.
Serie Nummer
Het serienummer van het item.
Garantiedatum
De einddatum van de garantieperiode.
Verzekeringswaarde
De waarde waarvoor dit item of deze groep is verzekerd.
Verzekering
De naam van de verzekeringsmaatschappij.
Nr. Polis
Het nummer van de verzekeringspolis.
Verv.Verzekering
De vervaldatum van de verzekering.
Opzeg Verzekering
De datum waarop de verzekering opgezegd moet worden om ervoor te zorgen dat de polis niet
stilzwijgend doorloopt.
Datum gearchiveerd en gearchiveerde notities
Kolommen die u zou kunnen gebruiken waneer u het item moet archiveren.

Transactiestabel

Dit is de tabel waarin u de variaties van de waarde van de items invoert. Deze heeft verscheidene
kolommen:

Datum
De datum van de boeking
Transactie Type
Het transactie type, precies zoals in de Transactie Type tabel.
Transactie Type Beschrijving*
De beschrijving van het transactietype wordt getoond.
Prod. Id
Het product (item) Id.
Prod. Beschrijving*
De beschrijving van het item dat uit de Items tabel gehaald wordt.
Notities
Een extra notitie over de transactie.
+/- Aankoop
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De waardeverandering (+/-) van het item vergeleken met de aan- of verkoop.
+/- Historisch
De waardeverandering (+/-) van het item vergeleken met de herwaardering of afschrijving.
+/- Boekwaarde
De waardeverandering (+/-) van het item vergeleken met de boekwaarde.
Dit wordt speciaal gebruikt voor negatieve afschrijvingen.
+/- Fiscaal
Het fiscale variatie bedrag.
Afschrijv. Type
Het Afschrijvingstype zoals getoond in de tabel Afschrijvingstype.
Beschrijving Afschrijv.
De beschrijving van het Afschrijvingstype.
Afschrijv. %
Het toegepaste percentage.
Rekening
De Activa rekening waarop de transactie geboekt moet worden.
Tegenrekening
Tegenrekening (bijvoorbeeld de rekening afschrijvingen) waarop de transactie geboekt moet
worden.
Datum Gearchiveerd en Gearchiveerde notities
Kolommen die u kunt gebruiken als u het item moet archiveren.

Afschrijvingstype tabel
Id
De afschrijvingscode.
Deze codes zijn vast en moeten niet worden veranderd.
Als u het Id nummer verandert werkt het programma niet goed meer.

00 Geen afschrijving. Er wordt geen afschrijving gedaan.
01 Alles ineens afschrijven. Het item wordt in één keer helemaal afgeschreven.
02 Gespecificeerd bedrag. De afschrijving wordt berekend op basis van het ingevoerde
bedrag.
10 Op de historische waarde. De afschrijving wordt berekend als een percentage van de
historische waarde.
11 Op de boekwaarde. De afschrijving wordt berekend op de boekwaarde.

Beschrijving
De uitleg van de code.
 

Transactiestype tabel
Id
De afschrijvingstransactiecode.
Deze codes zijn vast en moeten niet worden veranderd.
Als u het Id nummer verandert werkt het programma niet goed meer.

01    Beginwaarde. Gebruikt om een beginwaarde in te voeren, inplaats van het invoeren
van de beginwaarde in de Items tabel.
11    Aankopen of productie.
15    Verkopen of inventaris vermindering.
21    Revaluatie
25    Devaluatie
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31    Omgekeerde afschrijving
35    Afschrijving
36    Toegevoegde afschrijving
41    Fiscale toename
45    Fiscale afname

Beschrijving
De uitleg van de code.

Hulpprogramma's

Afschrijvingsrijen aanmaken

U geeft aan:

De datum voor de berekening van de afschrijving
De periode van de afschrijvingsberekening, maandelijks, per kwartaal, half-jaar of jaarlijks.

Het programma maakt automatisch de afschrijvingstransacties aan gebaseerd op de parameters die u
eerder invoerde in de tabel Items.

De software gebruikt de parameters van de groep als de parameters Afschrijv. Type, Afschr. %,
Rekening of Tegenrekening niet ingevoerd zijn voor een item om de afschrijvingstransacties aan
te maken.
Automatisch berekende boekingswaardes kunnen handmatig aangepast worden
Boekingen om waardes aan te passen, zoals afwaarderingen of opwaarderingen, moeten
handmatig ingevoerd worden.

Journal weergeven

Dit laat alle bewerkingen zien met de cumulatieve waardeveranderingen.

Items overzicht weergeven

Dit laat de veranderingen voor ieder item zien en de groepen voor de geselecteerde periode.

Het importeren van afschrijvingsrijen in de boekhouding
U kunt ervoor kiezen om de rijen van het Vaste Activa register in de boekhouding met het commando
in boekhouding importeren -> Transacties.
Alleen de rijen van het journaal die binnen de boekhoudingsperiode vallen worden overgenomen.
U kunt dan kiezen om alleen enkele gegevens te importeren.

Toekomstige applicatie ontwikkelingen

Afdrukken

We zijn van plan om nieuwe afdrukmodules te ontwikkelen, binnen de BananaApps (Engelstalig), die
verder gaan dan de bestaande afdrukmodellen en die meer flexibiliteit bieden en op maat gemaakte
oplossingen.

Aarzel niet uw wensen en vereisten aan onze programmeurs te laten weten, zo mogelijk door het
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sturen van het soort rapprt dat u wilt gebruiken, zoals een Excel tabel, met kolommen, totalen,
kopteksten en formattering.

Verschillende soorten afschrijvingen

We zijn ook van plan om modules te ontwikkelen, binnen de BananaApps (Engelstalig), om
verschillende soorten afschrijvingen mogelijk te maken, met het doel u een op maat gemaakte
oplossing te bieden.

Aarzel niet uw wensen en vereisten aan onze programmeurs te laten weten.
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Zo begint u met een register activa

Maak een nieuw bestand aan
Het is over het algemeen makkelijker om te beginnen met een ingevuld voorbeeldmodel dan met een
nieuw leeg bestand.

We adviseren daarom als volgt te werk te gaan:

menu Bestand → Nieuw → Register Activa
Kies een geschikt model en pas de rekeningen en groepen op basis van hun af te schrijven activa.

Stel de itemstabel in
Stel in de Itemstabel, de lijst van goederen en groepen waartoe ze behoren op.

Voer andere transacties in
In de Transactietabel kunt u transacties invoeren om de historische, boekhoud en fiscale waardes aan
te passen .

Maak afschrijvingsrijen automatisch aan
Met het commando Acties → Afschrijvingsrijen aanmaken, maakt het programma de afschrijvingsrijen
aan voor de individuele activa volgens de gespecificeerde parameters. Indien nodig kunnen bedragen
die automatisch zijn berekend worden aangepast.

http://www.banana.ch/doc/nl/node/9722
http://www.banana.ch/doc/nl/node/9722
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Afdrukken
Alles wat u op het scherm ziet kunt u afdrukken, kopiëren en exporteren  in pdf formaat. U kunt ook
specifieke afdrukcommando's gebruiken.

Afschrijving boeken in de boekhouding
De afschrijvingen kunnen als volgt naar de boekhouding overgebracht worden:

Met het commando naar boekhouding importeren → transacties van het menu Acties.
Door ze handmatig over te nemen van een afdruk als u een ander boekhoudprogramma
gebruikt.

In de afdruk van de boekhoud transacties kunt u zien welke waardes belangrijk zijn. Deze afdruk is
ook handig als u andere software gebruikt omdat u hierdoor de transacties eenvoudig in uw andere
programma kunt invoeren.

Historische waarde van een bezit
We laten hierna verschillende mogelijke stappen voor het beheer van een bezit zien:

Aankoop van een nieuw bezit

We nemen het voorbeeld van een dure computer die als bedrijfsserver gebruikt wordt

De aankoop wordt eerst geboekt in de boekhouding op de betreffende rekening (computer,
machines, volgens het rekeningschema voor activa of de specifieke subgroep).
Het gekochte artikel wordt toegevoegd als nieuw item in het af te schrijven goederen register
van de itemstabel met de aankoopwaarde, de afschrijvingsparameters en het rekeningnummer
van de activa en het afschrijving (tegen)rekeningnummer aanwezig in de uitgaven van de
resultatenrekening.
Het wordt aanbevolen om een groep in het vaste activa register aan te maken waarin alle items
van dezelfde soort worden opgeteld in de itemstabel (bijvoorbeeld computer of machine groep
waar de waardes van de computer of machines A, B, C,... worden opgeteld). De totale waarde
van de groep items moet overeenkomen met de totale waarde van overeenkomstige specifieke
rekeningen (computer of machines in de rekeningen). Op deze manier is het mogelijk om te
controleren dat de waardes overeenkomen.

http://www.banana.ch/doc/nl/node/3332
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Afschrijving aan het eind van het jaar (of maandelijks indien gewenst)

Met het commando Afschrijvingsrijen aanmaken creëert het programma een afschrijvingsrij
voor ieder bezit.
Wanneer versnelde afschrijving is gepland voor een bezit wordt een tweede afschrijvingsrij
aangemaakt met een extra afschrijvingsbedrag.
Het afschrijvingspercentage wordt ingesteld in de kolom Afschrijv.2%
(Afschrijvingspercentage2) bij het bezit waarvan de versnelde afschrijving is gepland. Als de
kolom Afschrijv.2% niet zichtbaar is kan deze zichtbaar gemaakt worden met Menu Gegevens
→ Kolommen instellen → optie Afschrijvingspercentage2.
De lijst met afschrijvingen wordt afgedrukt.
In Banana boekhouding worden de afschrijvingen voor het jaar ingevoerd.
Controleer dat de boekwaarde van de computer of de machines groep in de itemstabel identiek
is aan de computer of machines rekeningen in uw boekhouding.
Als er geen overeenstemming is betekent dit dat er aan- of verkopen zijn die niet zijn
geregistreerd.

Ontwikkeling van bedrijfsmiddelen

In het volgende jaar wordt onderdelen gekocht voor een grote uitbreiding van de computer of
van de machines.

De aankoop wordt geboekt op de rekening van de computer of de machines.
Er wordt een rij aangemaakt in de transactietabel van het afschrijvingsregister met de
aankoopdatum, transactietype 11 (voor aankoop) en het aankoopbedrag in de Aankoop
variatie kolom.

Afschrijving aan het eind van het volgende jaar
Met het commando Afschrijvingsrijen aanmaken laat u het programma een
afschrijvingsrij voor ieder bezit creëren.
Als het afschrijvingsbedrag dat door het programma berekend wordt voor de computer of
de machines incorrect is, kunt u de transactie aanpassen en een correct bedrag invoeren.
De lijst met afschrijvingen wordt afgedrukt.
In Banana boekhouding worden de afschrijvingen voor het jaar ingevoerd.
Controleer dat de boekwaarde van de computer of de machines groep in de itemstabel
identiek is aan de computer of machines rekeningen in uw boekhouding.
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Transacties invoeren om andere gegevens te
veranderen

De standaard weergave van de Transactietabel laat de verandering in boekwaarde zien. De complete
weergave laat alle andere kolommen zien om de verandering van andere gegevens mogelijk te
maken.

Transacties om de aankoop-, historische of fiscale waarde te
veranderen
U kunt transacties invoeren die de de aankoop-, historische of fiscale waarde veranderen door de
gerelateerde kolommen te gebruiken.

Voeg een nieuwe rij toe en voer de gegevens handmatig in.
Het bedrag moet handmatig door de gebruiker ingevoerd worden.
Gebruik het juiste transactie type voor de transactie.
Gebruik een afschrijvingstype code als het een afschrijving is.
Kolommen voor veranderingen in bedragen:

+/- Aankoop
Een positief bedrag voor een nieuwe aankoop (transactie type 11).
Een negatief bedrag voor gedeeltelijke of hele verkoop (transactie type 15).

+/- Historisch
Een positief bedrag voor een opwaardering (transactie type 21).
Een negatief bedrag voor gedeeltelijke of hele afwaardering (transactie type 25).

+/- Fiscaal
Een positief bedrag voor een stijging van de fiscale waarde (transactie type 41).
Een negatief bedrag voor een daling van de fiscale waarde (transactie type 45).

Aanpassing van het Beginbedrag
Het beginbedrag in de itemtabel moet niet veranderd worden. Als aanpassingen nodig zijn moet
boekingen worden ingevoerd die één van de volgende gegevens veranderen:

de Aankoop waarde.
of de Historische waarde (op- of afwaarderingen).
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Interne waarde verschilt van de waarde in de boekhouding
Er kunnen situaties zijn waar de marktwaarde van het bezit hoger is dan de boekwaarde zodat er een
interne verborgen reserve bestaat.

Om deze verschillen bij te houden kunt u op twee manieren te werk gaan:

Laat in de itemstabel de kolom Marktwaarde zien en voer het bedrag in.
Met dit systeem moet u telkens de waarde bijwerken wanneer deze verandert als gevolg van de
feitelijke afschrijving.
Gebruik de kolom Fiscale waarde als interne waarde.
Hierbij wordt aangenomen dat de kolom Fiscale waarde niet al gebruikt is en dat daardoor de
fiscale waarde gelijk is aan de boekwaarde.

Vervang in de item- en transactietabel de kolomkoppen, gebruik "Interne waarde" in
plaats van "Fiscale waarde" en "+/-Intern" in plaats van "+/-Fiscaal".
De beschrijving van code 41 en 45 verandert in de transactietype tabel.
Voer de transacties in met code 41 en 45 en geef het verschil als positief aan in de "+/-
Intern" kolom.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 971

Adresboek

Dit is een toepassing voor het beheer van adressen (contacten, leden, etc.) en het afdrukken van
gegevenslijsten en stickers.

Mogelijkheden:

Vrije definitie van de velden
Mogelijkheid alleen geselecteerde rijen af te drukken
Vrijheid om het stickerformaat in te stellen
Kopiëren/Plakken van adressen vanuit andere programma's (Excel en Word).

Het Adresboek heeft drie tabellen:

Groepen tabel 
Contacten tabel
Dagboek tabel 

De gegevens in het adresboek kunnen worden gesynchroniseerd met Google contacten.

Afdrukken van Adressen/Stickers
Voor informatie over het afdrukken van adressen/stickers raadpleegt u de pagina Afdrukken Etiketten.
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Groepen tabel

In de tabel Groepen kan men voor iedere rij in de Id kolom een identificatiecode definiëren voor een
Groep en de overeenkomstige beschrijving in de kolom Beschrijving invoeren (Bijvoorbeeld, kla -
Klanten, lev - Leveranciers, col - Collega's, etc.).
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Contacten tabel

 Contacten
Deze tabel bevat de kolommen waarin de adressen kunnen worden ingevoerd.

De kolommen

Er zijn diverse kolommen. De meeste daarvan zijn onzichtbaar. Met het commando Kolommen
instellen kan men:

Kolommen weergeven
De volgorde van de getoonde kolommen veranderen
Andere kolommen toevoegen

De naam van de kolommen is gebaseerd op de VCard standaard.

Id is het nummer van het contact.
Dit is nodig wanneer u een contact wilt verbinden aan een dagboek, aan een uitleenlijst of een
andere tabel.
Als u in deze kolom staat kunt u door op F6 te drukken een automatisch oplopende nummering
verkrijgen.
Voorvoegsel: u kunt hier "Mw.", "Dhr.", etc. invoeren.
Achternaam of Bedrijfsnaam (als het om een bedrijf gaat).
Als het contact een contactpersoon van een bedrijf is kunt u de bedrijfsnaam of de eenheid
waartoe het contact hoort in kolom Organisatie invoeren.
Door op F6 te drukken in de kolom van de Voornaam of de Achternaam splitst het
programma de voornaam en achternaam of draait deze om.
Als er meer dan twee namen zijn kan deze functie geen onderscheid maken tussen de voor- en
achternamen.
Begroeting: is de begroeting of aanhef die gebruikt wordt aan het begin van een brief. Dit
wordt gebruikt voor mailmerge.
Bijvoorbeeld: Beste Jan of Geachte heer Smit.
Het programma geeft suggesties voor een mogelijke tekst op basis van de inhoud die al in de
kolommen is ingevoerd.

De weergaven

Er zijn diverse weergaven beschikbaar en deze onderscheiden zich van elkaar door de aanwezigheid
van specifieke kolommen; in dit voorbeeld (Adresboek bestand) hebben we de weergaven Basis,
Naam, Adres2, Archief en Compleet (in de weergave Compleet zijn alle kolommen zichtbaar).
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Dagboek tabel

 Dagboek
In de tabel Dagboek kunt u dagelijks allerlei notities vastleggen en verwijzen naar contacten uit de
tabel Contacten.
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(Afgeschreven) Beheer, bewerk en maak een
back-up van Google-contacten

Afgeschreven commando's en functionaliteiten
Waarschuwing: Google stopt met de ondersteuning van de  Contacten-API, die door Banana wordt
gebruikt voor het openen en bewerken van contactgegevens.
De nieuwe, vervangende People API heeft een ander doel en een andere functionaliteit.
Het lezen en bewerken van Google-contacten zal dus ALLEEN beschikbaar zijn ZOLANG Google de
Contacten-API in gebruik houdt. Daarna zullen synchronisatiecommando's een foutmelding geven. De
in het *ac2 bestand opgeslagen gegevens zullen nog steeds toegankelijk zijn. Het is niet bekend hoe
lang de Contacten-API nog beschikbaar zal zijn. Gelieve deze functionaliteit niet langer te
gebruiken.

Documentatie
Met het commando Google contacten kunt u de Google contacten opgeslagen in uw Android telefoon
makkelijker aanpassen, bijwerken en beheren.

Google contacten commando's
Synchroniseer inhoud met Google contacten.

Wanneer u voor het eerst Google contacten synchroniseert:

Verschijnt een venster dat de Chrome browser pagina laat zien in Banana die vraagt om een
Google login.
U moet nu uw emailadres en wachtwoord van uw Google account invoeren..

Banana slaat alleen het emailadres dat bij het Google account hoort op. Sessiegegevens en
wachtwoord worden niet opgeslagen in Banana maar worden beheerd door de Google Chrome
applicatie die gebruikt wordt binnen Banana Boekhouding.

Synchronisatie commando's

Download wijzigingen

Deze functie importeert gegevens uit Google en werkt de waardes in Banana bij.

Als er al gegevens aanwezig zijn in de tabel dan voegt het programma de verschillende
gegevens samen in de tabellen

Groepen
Contacten.

Wijzigingen verzenden

Stuur aangepaste gegevens naar Google en werk uw Google contacten bij.
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Om gegevens te verzenden moet u ze eerst gedownload hebben.
Als u veranderingen hebt gemaakt op uw mobiele telefoon moet u ze eerst downloaden en dan
versturen.

Een venster met de elementen die veranderd, toegevoegd of verwijderd zijn verschijnt.

Het wordt niet aanbevolen om de kolom "Google niet gesynchroniseerd" te gebruiken omdat deze
niet langer gebruikt zal worden in volgende versies. Als hier "Ja" staat wordt het contact niet langer
gesynchroniseerd met Google.

Downloaden en de bestaande contacten vervangen

Banana kan niet altijd alle veranderingen synchroniseren.
Dit commando verwijdert de contacten in de contactentabel en vervangt deze door de bestaande
Google contacten.

Dit commando verwijdert ook de items gemarkeerd als "Google niet gesynchroniseerd".

Omzetting van waardes in de tabel
Google contacten beheert adressen, telefoonnummers en emailadressen op een gestructureerde
manier. In de tabel Contacten worden de gegevens verdeelt in kolommen.

Telefoonnummers en e-e-mailadressen

Met Google kunt verschillende emailadressen en telefoonnummers definiëren. Voor elk is een
standaard label en indicatie ontworpen. In Banana moet u deze aanwijzingen volgen:

Als er verschillende soorten telefoonnummers of emailadressen zijn geeft u deze aan in de
passende kolom (werk, thuis, anders).
Als er voor een type meerdere telefoonnummers of emailadressen zijn geeft u deze aan in de
kolom, gescheiden door een puntkomma ";".
Telefoon werk "+1234567890;+21234567890". E-mail werk
"voorbeeld@gmail.com;voorbeeld@yahoo.com".
Als het telefoonnummer of emailadres een specifiek label heeft wordt dit aangegeven in de
kolom "Anders", met het label gevolgd door een dubbele punt ":".
Als er meerdere nummers of adressen zijn scheidt deze dan met een puntkomma ";".
"Vakantie:+1234567890*;Nicht:+1234566777".
"Tijdelijk:voorbeeld@gmail.com;Mama:voorbeeld@yahoo.com".
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Om aan te geven dat het telefoonnummer het standaardnummer is markeert u het met een
ster "*" na het nummer. Bij verschillende nummers kan er maar één standaardnummer zijn.

Adressen

Google staat toe dat u meerdere adressen voor hetzelfde contact hebt.

Met Banana Boekhouding daarentegen kunt u één adres synchroniseren, het "Thuisadres" als
hoofdadres.

Groepen

In Google gedefinieerde groepen worden geïmporteerd in de tabel Groepen en kunnen eraan
toegevoegd worden.

In de kolom Groepen van de tabel Contacten kunt u meerdere groepslidmaatschappen toevoegen
door deze te scheiden met een puntkomma ";".

Een back-up maken van uw Googel contacten
Maak een nieuw leeg Adressenboek bestand aan.1.
Doe Hulpprogramma's Menu>Google contacten>Download wijzigingen2.
Sla het bestand op uw computer op met in de naam de datum van de dag.3.

Uw Google adressen en contacten beheren
Wanneer u meerdere adressen in uw adresboek heeft is het makkelijker om het Banana adresboek te
gebruiken om uw adressen te beheren. U kunt snel fouten herstellen, informatie toevoegen,
duplicaten verwijderen en nog veel meer.

Download de gegevens van Google contacten1.
Voer uw veranderingen door2.
Let op dat de F6 toets meerdere functies heeft (zie het Info venster onderin het programma).
Keer de waardes in de kolommen Voornaam en Achternaam om.
Verstuur de wijzigingen (Hulpprogramma's Menu>Google contacten>Wijzigingen3.
verzenden.

Contacten die niet langer gebruikt worden archiveren en
verwijderen
U kunt contacten die u niet langer gebruikt opslaan op uw computer en uit uw telefoonboek
verwijderen.

De eerste keer:

Maak een nieuw adresboekbestand aan.1.
Doe Hulpprogramma's Menu>Google contacten>Download wijzigingen.2.
Sla het bestand op uw computer op in de map, bijvoorbeeld "DezeMagNooitVerwijderdWorden",3.
zodat u eraan herinnerd wordt dat dit een belangrijk bestand is .
Laat de weergave Archief zien.4.
Voer in de kolom Datum Gearchiveerd de huidige datum in (type een punt ".") voor alle5.
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contacten die u niet langer nodig heeft.
Doe Hulpprogramma's Menu>Gegevens archiveren>Tabelgegevens archiveren>Contacten.6.
Doe Hulpprogramma's Menu>Google contacten>Wijzigingen verzenden.7.
Uw gegevens worden verwijderd uit het Google adresboek.
Met Hulpprogramma's Menu>Gegevens archiveren>Gearchiveerde gegevens weergeven kunt u8.
uw gearchiveerde contacten terugzien.
Als u deze terug wilt in uw lijst moet u de regels uit de archieflijst naar de tabel Contacten
kopiëren en verwijderen uit het Archief.

Sla uw bestand veilig op. Ga als volgt te werk bij alle volgende keren dat u ongebruikte contacten wilt
archiveren:

Open uw adresboekbestand.1.
Doe Hulpprogramma's Menu>Google contacten>Download wijzigingen, of als er problemen zijn,2.
Download en bestaande contacten vervangen.
Ga te werk zoals hierboven in de Archiveren en Wijzigingen verzenden proceduren3.
Sla de veranderingen op.4.

Gegevens in Excel opslaan
Download gegevens uit Google contacten.
Selecteer alles (klikken op linkerbovenhoek of de toets Ctrl-A)
Kopieer
Plak in Excel.

Synchronisatie problemen en suggesties
Het Google adresboek biedt vele mogelijkheden en kan op veel verschillende manieren gebruikt
worden. We hebben geprobeerd het beter voor u te laten werken, maar er kunnen omstandigheden
zijn waar het programma problemen ervaart met de veranderingen die gemaakt zijn.
In dit het geval zal het nodig zijn om het commando Downloaden en bestaande contacten vervangen
te gebruiken om de twee adresboeken weer helemaal op een lijn te krijgen.

We willen heel graag de functionaliteit van onze software voordurend verbeteren, dus stuur ons een
email met een beschrijving van het probleem en laat ons zien hoe we het probleem op onze
computers kunnen reproduceren. Dit helpt ons om het probleem op te lossen.
Elke suggestie hoe onze software te verbeteren is altijd welkom.

Voor technische details met betrekking tot de verbinding met Google contacten zei de Google API
documentatie.

https://developers.google.com/google-apps/contacts/v3/
https://developers.google.com/gdata/docs/2.0/elements#gdReference

https://developers.google.com/google-apps/contacts/v3/
https://developers.google.com/gdata/docs/2.0/elements#gdReference
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Bibliotheek en collecties

Gebruiksaanwijzing en introductie

Dit is een toepassing waarmee u een lijst kunt bijhouden van boeken, voorwerpen en contacten en
waarmee u uitgeleende en teruggebrachte objecten kunt beheren.

Een nieuw bestand aanmaken
Menu Bestand -> commando Nieuw
Selecteer het type Bibliotheek en collecties en selecteer het model Banana Bibliotheek. U kunt
het model ook direct vinden op deze link: https://www.banana.ch/apps/nl/node/9216

Tabellen
In het bibliotheekbestand zijn er verschillende tabellen:

Groepen tabel - waar u aan elke gebruiker een groep kunt toewijzen, bijvoorbeeld om
kinderen te verdelen tussen kleuterschool- en basisschoolgebruikers, enz.
Contacten tabel - waar u gebruikersgegevens kunt invoeren.
Items tabel - waar u de gegevens van uw artikelen kunt invoeren.
Leningen tabel - waar u de uitgecheckte artikelen, de vervaldatum en de retourdatum kunt
invoeren.
Dagboek tabel - waar u uw dagelijkse notities kunt invoeren en deze kunt koppelen aan een
specifiek contact.

Andere handige functies

Items retourneren

Gegevens archiveren

Afdrukken
Alles wat u op het scherm ziet kan worden afgedrukt of opgeslagen in pdf formaat.

In de BananaApps sectie (Engelstalig), (zoek op library), kunt u uitbreidingen vinden voor specifieke
afdrukken:

afdruk van de complete boeken catalogus in pdf voor publicatie op internet
afdruk van de gebruikerdetails met de boeken die ze hebben geleend en de boeken die nog
teruggebracht moeten worden.

https://www.banana.ch/apps/en/node/8554
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Groepen tabel

In deze tabel kunt u groepen aanmaken bijvoorbeeld voor Docenten, Kinderen uit groep 1 en 2, enz.
U voert een Id in voor de groep in de kolom Id. In de kolom Beschrijving voert u een tekst in die de
groep beschrijft.

Zie de pagina Adresboek voor gedetailleerde informatie over de kolommen,
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Contacten tabel

In de tabel Contacten kunt de gegevens van gebruikers, verdeeld over diverse aanpasbare
kolommen, invoeren. (U kunt alleen degene die u nodig heeft zichtbaar laten en alle andere
verbergen - u kunt ook nieuwe kolommen toevoegen).

Zie de pagina Adresboek voor gedetailleerde informatie over de kolommen.
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Items tabel

In deze tabel kunt u de gegevens van uw objecten invoeren.
Er zijn verschillende manieren om gegevens in te voeren: copiëren en plakken vanuit Excel,
automatisch ophalen van gegevens van internet, enz.
Zie de gedetailleerde uitleg hierna.

Kolommen
Er zijn diverse kolommen en het is mogelijk nieuwe toe te voegen.

Id: het itemnummer dat toegekend moet worden.
De F6 toets voegt een oplopend nummer toe.
Het is mogelijk een voorvoegsel te gebruiken. Bijvoorbeeld: A-001, Het programma stelt dan als
volgende id A-002 voor.
ISBN
Het Internationale Standaard Boek Nummer.
Als na het invoeren van het ISBN in de Id kolom op F6 (⌘+6 op de Mac) gedrukt wordt vult het
programma automatisch alle boekgegevens, die het in de Google database vindt, in de andere
kolommen in. Hiervoor is een internetverbinding nodig.
Alle reeds aanwezige informatie wordt overschreven.
Voor meer informatie zie: Google documentatie  (Engelstalig).

De gegevens in de Google database zijn niet altijd compleet. Bijvoorbeeld, de titel is
aanwezig maar de redacteur of andere gegevens ontbreken.
Als men in dit geval het ontbreken van gegevens wilt controleren ga dan naar de
volgende pagina met uw internet browser
https://www.googleapis.com/books/v1/volumes?q=9025703356 , en voer na de "q=" het
ISBN nummer van het boek in.
Als u "totalitems: 0" betekent dit dat het boek NIET in Google's database zit.
Als u een pagina in JSON formaat wordt ziet (programmeurs formaat) met de gegevens
van het boek betekent dit dat het boek IN Google's database zit.

Titel
De titel van het boek.

https://developers.google.com/books/docs/v1/using?hl=en
https://www.googleapis.com/books/v1/volumes?q=9025703356
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Auteur
De auteur. Er kunnen meerdere auteurs ingevoerd worden, gescheiden door puntkomma's ";".
Uitgever
De uitgever. Er kunnen meerdere uitgevers ingevoerd worden, gescheiden door puntkomma's
";".
Datum terugkomst
De verwachte terugkomstdatum voor dit item.
Deze kolom wordt automatisch aangevuld volgens de gegevens van het uitgeleende item.

Invoeren van boekengegevens
Boekengegevens kunnen op verschillende manieren ingevoerd worden:

Handmatig - U kunt boekengegevens handmatig invoeren in de Items tabel (zie vorige
paragraaf)
Gegevens ophalen uit Excel - Als u al een boekenlijst hebt in een ander programma of Excel
kunt u deze eenvoudig copiëren/plakken.
Om de gegevens te kunnen copiëren/plakken moet u ervoor zorgen dat de kolommen in Excel
in dezelfde volgorde staan als in Banana. Als de kolommen in beide programma's in dezelfde
volgorde staan kunt u een heel blok gegevens copiëren, anders moet u per kolom copiëren.
Deze operatie is mogelijk vanuit Excel of vanuit platte tekst bestanden.
Boekengegevens automatisch ophalen vanuit het internet -  De ISBN is erg handig als
een internetverbinding heeft: ieder boek heeft een ISBN code (internationaal erkend en meestal
afgedrukt op de achterkant van het boek); als u de ISBN code van een boek invoert in de juiste
kolom in Banana en op de F6 toets (of Cmd + 6 op de Mac) drukt, haalt het programma
automatisch de boekengegevens op en voert alle gegevens (titel, auteur, uitgever, enz., zelfs
een korte samenvatting) in.
Als het boek meerdere auteurs of uitgevers heeft moet u de namen scheiden door een punt-
komma ";" - deze worden ook ieder apart gevonden in een zoekopdracht, bijvoorbeeld als u alle
boeken van een zekere auteur moet vinden).
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Leningen tabel

De uitgegeven items kunnen in de Leningen tabel ingevoerd worden met de vervaldatum en de
inleverdatum.

Kolommen
Datum
De datum van de lening.
Prod.Id
Het item nummer. Er kan gezocht worden op titel.
Contact Id
Het contactnummer. Er kan gezocht worden op voornaam, achternaam en plaats.
Vervaldatum
De datum waarop het item terug moet zijn.
Als u "+30" invoert vult het programma een datum in die 30 dagen later dan de huidige datum
is.
Terugkomst
Voer de datum van terugkomst in.

Uitleningen beheren

Uitlenen van een boek

Voeg een nieuwe regel toe en geef de datum aan van de uitlening (handige tip: door de punt "."
in te typen wordt automatisch de huidige datum ingevuld!)
Het programma toont alle boeken die beschikbaar zijn in de database als u begint met het
typen van de titel van het boek in de kolom Prod. Id. Kies het gewenste boek en druk op F6;
het program vult automatisch de Prod. Id en de Beschrijving in.
Het programma vult automatisch een datum 30 dagen later dan de huidige datum in de kolom
Vervaldatum in, maar u kunt deze aanpassen. U kunt ook het aantal gewenste dagen na de
huidige datum invoeren door bijvoorbeeld +40, voor 40 dagen later, in te typen en dan in het
keuzelijstje de gewenste datum te kiezen.
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Dagboek tabel

In de tabel Dagboek kunt u dagelijks allerlei notities vastleggen en verwijzen naar contacten uit de
tabel Contacten.
U kunt bijvoorbeeld the diensten organiseren van de mensen die in de bibliotheek werken, belangrijke
notities of feiten noteren, to do lijstjes, enz.
Iedere rij heeft een kolom voor de datum, beschrijving, vervaldatum, de contact Id van de eigenaar.
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Items retourneren

Teruggave van een boek registreren
Kies van het menu Hulpprogramma's Items retour...
Er verschijnt een venster waar u de naam van de bibliotheekgebruiker intypt. Een lijst van alle
boeken uitgeleend aan deze gebruiker.

U kunt nu alle teruggebrachte boeken aanvinken (de meeste gebruikers brengen al hun
geleende boeken tegelijk terug)
Klik op de knop Toepassen en het programa voert automatisch de terugbreng datum
in in de kolom Datum.
Als er iets fout gaat, ga dan naar de Leningen tabel en druk op het commando
Ongedaan maken van het menu Bewerken.
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Gegevens archiveren

De functie Archiveren voorkomt dat er teveel transacties van uitgeleende en teruggebrachte boeken
blijven staan. Oude gegevens die worden gearchiveerd in verborgen tabellen zonder verwijderd te
worden. Deze gegevens kunnen altijd teruggehaald worden voor statistieken of elk ander gebruik.

Gegevens opslaan van ingeleverde boeken

Kies van het menu Hulpprogramma's Gegevens archiveren en dan Tabelgegevens
archiveren -> Leningen. Het programma verwijdert alle transacties van teruggebrachte
boeken van de Leningen tabel en slaat deze op in de tabel Archief.
Alleen uitgeleende boeken die nog niet teruggebracht zijn worden getoond in de tabel
Leningen.

Niet langer gebruikte contacteninformatie opslaan
U kunt uw oude en niet meer gebruikte contacten archiveren precies zoals uw boeken.

Geef een opslagdatum op voor alle contacten die u wilt archiveren.
Kies van het menu Hulpprogramma's Gegevens archiveren en dan Tabelgegevens
archiveren -> Contacten.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 990

Bibliotheek etiketten afdrukken

Etiketten afdrukken
U kunt twee verschillende soorten etiketten afdrukken:

kleine etiketten (met de code van het boek) voor gebruik op de rug van het boek zodat deze
zichtbaar zijn op de boekenplank
grotere etiketten die gebruikt worden aan de binnenkant van de kaft, bijvoorbeeld om aan te
geven dat het boek op een bepaalde datum teruggebracht moet worden

Etiketten kunnen afgedrukt worden vanuit een Banana bestand waarin u alle boeken in de bibliotheek
hebt geregistreerd of vanuit een leeg bestand als u een lijst met codes wilt afdrukken die u daarna
toekent aan de boeken.

Er is een gratis model dat gedownload kan worden  voor het afdrukken van boeketiketten.

Etiketten voor de rug van een boek afdrukken

U kunt het formaat dat het beste bij uw toepassing past kiezen door de websites van de
etikettenproducenten te raadplegen (bijvoorbeeld A4 bladen, 25,4 mm x 10 mm - Herma 10001 or
Herma 4333 modellen).

Om de etiketten af te drukken kunt u een nieuw leeg bestand, zonder gegevens (menu Bestand ->
Nieuw), openen in Banana. Maar u kunt ook beginnen met een bestand uit uw bibliotheek.

Voor het aanmaken van een groot aantal codes is er een handige Excel functie, inplaats van het
handmatig of met de F6 toets aanmaken ervan. Dat gaat als volgt:

Open een nieuw Excel bestand; voer in cel A1 de bibliotheekcode die geschikt is voor uw
toepassing in (elke combinatie van letters gvolgd door cijfers voldoet) - bijvoorbeeld B1000.
Ga op de rechteronderhoek van de cel staan met de muis (de muisaanwijzer verandert in een
kruis) en sleep met de linkermuisknop ingedrukt naar beneden. Excel genereert dan

https://www.banana.ch/apps/nl/node/6894
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automatisch oplopende codes.

Kopieer nu (Ctrl + C toets) de codes die aangemaakt zijn naar de Id kolom in de Items tabel in
het Banana bestand (Ctrl + V toets).

U kunt nu de etiketten aanmaken. Kies het commando Etiketten -> Afdrukken van het menu
Apps. Het volgende venster wordt getoond:

Het is belangrijk de Items tabel geselecteerd te hebben als de bron voor de Gegevens; 
Nu kunt u uw etiket instellen door op de knop Veranderen... in de Opmaak etiketten sectie
te klikken.
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In het venster dat verschijnt kunt u de marges en andere eigenschappen van het door u
gekozen etiket aanpassen, Herma 10001 in dit geval.

Voordat u op de OK knop klikt opent u de tab Compositie waarin u een naam voor uw
aangepaste instellingen kunt invoeren (zodat deze in de toekomst gebruikt kunnen worden). In
dit geval is dat Boekcodes (Rug boek).
Door op Ok te klikken gaat u terug naar het Etiketten afdrukken venster.
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Nu u de grootte van het etiket heeft gedefinieerd moet u nog de inhoud ervan bepalen. Ga naar
het tabblad Etiket om dit te doen. In het voorbeeld hoeft het etiket alleen de code van het boek
weer te geven, in dit geval de kolom Id (Rij Id). U kiest daarvoor de RijId regel in de lijst van
beschikbare velden en klikt op de knop Veld toevoegen. In Etiketten weergeven wordt nu
RijId getoond.
Door op OK te klikken wordt een afdrukvoorbeeld van uw etiket getoond.

U kunt nu afdrukken op Herma bladen.
 

Etiketten afdrukken voor de binnenkant van de kaft

Kies eerst uw etiketten formaat. In het voorbeeld wordt een 70x36mm (Herma 4630 of Avery 3490)
gebruikt. De stappen die gevolgd moeten worden zijn identiek aan die in het vorige voorbeeld:

Kies van het menu Apps het commando Etiketten -> Afdrukken
Klik op Veranderen in de sectie Opmaak etiketten
Voer de marges voor uw etiket in het Opmaak etiketten venster in.
Voordat u op OK klikt opent u het tabblad Composities waarin u een naam kunt geven aan uw
nieuwe instellingen (bijvoorbeeld Binnenkant kaft etiket). Daarna klikt u op OK.
Kies het tabblad Etiket in het Etiketten afdrukken venster en voeg de inhoud van uw etiket
toe.
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U kunt naast de al beschikbare velden eigen tekst toevoegen.

Door op OK te klikken wordt een afdrukvoorbeeld van uw etiket getoond.

Opmerking:

De modellen die beschikbaar zijn in Banana hebben al de twee aangegeven etiketformaten: een
etiket voor de rug van het boek en een voor de binnenkant van de kaft.

Gerelateerde functies:

Beheer van jaarlijkse lidmaatschapsbijdragen

Als u een bibliotheek beheert waar een jaarlijkse lidmaatschapsbijdrage vereist is of waar bijdragen
voor het lenen van individuele boeken gevraagd worden is het handig de boekhoudfuncties van
Banana Boekhouding te gebruiken.
Zie onze pagina Modellen .

https://www.banana.ch/apps/nl/ac2list
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Eenvoudige tabel

Dit is een tabel die opgezet kan worden overeenkomstig de wensen van de gebruiker. Men kan
kolommen en weergaven toevoegen en deze de meest toepasselijke titels geven met de commando's
Kolommen instellen en Tabellen instellen van het menu Gegevens.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ / BEOKHOUNDING+ - 996

Menu Hulpprogramma's

Het menu Hulpprogramma's heeft diverse commando's die gericht zijn op de Hulpprogramma
toepassingen.
De algemene commando's die beschikbaar zijn in alle Hulpprogramma toepassingen worden hierna
uitgelegd.
Andere commando's specifiek voor het Adresboek en de Bibliotheek applicatie worden in de
betreffende documentatie uitgelegd.

Alles opnieuw controleren...
Controleert alles en geeft een foutmelding wanneer er fouten gevonden worden.

Contacten op naam sorteren
Sorteert de rijen van de tabel Contacten in oplopende volgorde op Naam, Achternaam, Tweede naam,
Plaats.

Menu Gegevens archiveren
Het programma houdt voor iedere tabel een lijst van rijen bij die zijn gearchiveerd.

De gearchiveerde rijen worden getoond in de tabel Gearchiveerde rijen. Kies de rijen die getoond
moeten worden.

Tabelgegevens archiveren

Verplaatst de rijen van een tabel (Contacten, Items, (Uit)Leningen, Dagboek) naar de tabel
Gearchiveerde gegevens op voorwaarde dat:

De kolom Datum Gearchiveerd niet leeg is.
Er voor de Leningen tabel een vervaldatum en een retourdatum is (een "afgesloten" lening)

Er wordt een lijst met tabelnamen getoond. De tabellen die in deze lijst staan bevatten rijen die
gearchiveerd kunnen worden.
Als er geen tabellen zijn met rijen die gearchiveerd kunnen worden dan is het selectievenster leeg.
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Gearchiveerde gegevens weergeven

Laat een lijst met de gearchiveerde rijen zien van een specifieke tabel.
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